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RELEASE NOTES 
 

RELEASE NOTES: 6.3.0 Revision 1.0 

RELEASE DATE: May 2017 

SOFTWARE: buildingEXODUS 

SOFTWARE VERSION: v6.3.0 

RELEASE DATE: May 2017 

USER GUIDE REVISION: 6.3.0 Revision 1.0 

 

The Release Notes are intended to keep buildingEXODUS users up to date with the latest 

improvements in the software, inform users of known software bugs and of corrections to the User 

Guide, Theory Manual and Application Manual. 

 

INTRODUCTION  

Thank you for purchasing buildingEXODUS, the evacuation model for the built environment. 

buildingEXODUS is based on a set of sophisticated sub-models incorporating people-people, 

people-fire and people-structure interactions allowing the safety engineer to perform a range of 

evacuation simulations. buildingEXODUS was developed to provide a design and research tool 

that could be used by those concerned with evaluating the evacuation efficiency of occupied 

structures.  Users should note that the prediction of evacuation performance is not an exact science. 

All evacuation simulation software, including buildingEXODUS, should only be considered an 

aid to evaluating the evacuation performance of a structure.  It is not intended as a replacement of 

accepted good engineering practice, guidelines and judgement. Only those experienced in 

evacuation analysis should make use of the software and only after the user manual has been 

thoroughly studied. The user should pay particular attention to all the assumptions specified in the 

software manual and ensure that none of the conditions or assumptions are violated by their 

intended application. 

 

Version 6.3 of the software includes a number of modifications in relation to the previous general 

release software, Version 6.2. 

 

VERSION 6.3 MODIFICATIONS 

The release of version 6.3 of buildingEXODUS incorporates a number of additions and alterations 

that are designed to make the software more user-friendly, more efficient and more useful.  A list 

of these new features and modifications found in version 6.3 is provided below.  

 

Version 6.3 Modifications 

Functionality (Levels A, B and C) 

 Saving Geometry Boundaries as DXF Files 

 In the new release of buildingEXODUS it is possible to save the boundaries of 

specific floors as CAD DXF files.  Each floor can be saved in a format which 

enables it to be imported into third party software (i.e. CFD fire modelling 

software, 3D visualisation software etc.).  It is important to note that only the 

walls/lines present within the selected floor will be saved to the DXF. Hence all 

text, polygons and EXODUS objects (i.e. nodes, arcs etc.) will not be saved.  All 

walls/lines will be saved within a single layer of the DXF file, with the 

corresponding units being in metres.  All lines/walls saved within the DXF file will 

also be of default colour, hence any colours assigned to them within EXODUS will 

not be saved.  
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User Interface (Levels A, B and C) 

 Updated Data Output Options Dialogue Box 

 The format of the Data Output Options dialogue box has been updated and 

simplified. The data attributes which can be output to the simulation output file 

(.SIM) have been grouped and separated onto different tabs, to make it easier for 

the user to navigate.  In addition, some agent attributes which previously had not 

been available to output to the simulation output file have been added.  These 

include agent travel speeds on stairs and escalators, in addition to agent tolerance 

to each irritant gas (i.e. both instantaneous and dose, Level C only). 

 

Hazard Model (Level C Only) 

 Updated HCN Model 

 The toxicity model defining the effect of HCN on agents within EXODUS has been 

updated in order to ensure compatibility with the most recent version presented in 

the SFPE Handbook, 5th Edition.  The main change is that the HCN expression 

now explicitly incorporates the agent respiration rate during the exposure.  Thus, 

the new HCN equation takes into account the HCN concentration to which the 

agent is exposed, the exposure duration, AND the agent Respiratory Minute 

Volume (RMV).  The time to incapacitation predicted using the previous HCN 

model is similar to the times predicted by the new model for people involved in 

light work with RMV values 25 L/min.  For agents at rest during exposure, the 

previous model is more conservative than the new model, predicting 

incapacitation will occur sooner, but for agents involved in heavy work during 

exposure, the new model is more conservative.  Both models produce 

approximately the same time to incapacitation for those involved in light work. 

 

 Updated Default VCO2*RMV Cap 

 Within previous versions of the EXODUS toxicity model the Respiratory Minute 

Volume, RMV of an adult was by default assumed to not exceed 80 lit/min.  Hence, 

when VCO2*RMV = 80 lit/min, VCO2 was considered to have reached its 

maximum value, and would therefore not increase any further.  Within the updated 

toxicity model the breathing rate is capped at a lower value of 70 lit/min.  The user 

still has the ability to manually change the maximum breathing rate within 

EXODUS. 

 

 Updated the Default PID Distribution (FICO equation) 

 Versions of buildingEXODUS prior to v6.3 had two options for setting the 

Personal Incapacitation Dose (PID) used in the FICO equation.  They could 

provide every member of the population with the same PID (set to 30% COHb) or 

they could assign the population with a uniform random distribution of PID set 

between an upper and lower limit (which was by default set to 25-35% COHb). 

Within the new release there are three options available for setting the PID: 

 

 SFPE PID (Distribution) – Default Option:: 

Each member of the population is assigned a PID from the distribution defined 

within the SFPE Handbook (5th Edition) – values between 5% and 45%. Using this 

approach, each member of the population will have their own unique PID based 

on the SFPE values.  
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 Fixed Value PID: 

Each member of the population is assigned the same single value for PID.   Thus 

each member of the population has an identical PID. The default value is 30% 

COHb,  

 

 User Defined PID: 

Each member of the population is assigned a PID determined by the user. This 

requires the user to populate a distribution table similar to that in option 1. 

 

 New Irritant Model Parameter, Tolerance Factor (TF) 

 The TF attribute is a measure of the concentration of irritant gas (ppm) required 

to cause a given endpoint and is used in the FIC model.  The endpoint can be 

severe mobility impairment or incapacitation depending on the TF selected.  In 

previous versions of buildingEXODUS only the incapacitation endpoint was 

assumed and so the TF was not defined as a variable but simply a value selected 

from a distribution.  A TF is specified for each irritant agent considered in the 

model e.g. TFHCL. 

 

 Updated Agent Irritant Tolerance Concentration Model (FIC) 

 For the purposes of evacuation analysis there are two types of irritant endpoints, 

escape impairment and incapacitation.  Versions of buildingEXODUS prior to 

v6.3 only had the option to represent incapacitation, although this could have been 

changed to another end point by using a user specified value for the TF.  However, 

no guidance was provided, with TF values only specified for incapacitation.  In 

the new release, either endpoint can be specified with the lower threshold of 

escape impairment being the new default setting, with appropriate values of TF 

provided. 

 

Furthermore, in previous versions of buildingEXODUS the Incapacitation TF 

model assumed a random uniform distribution with the range for each irritant 

varying according to values set in the SFPE handbook.  In the new release there 

are five methods for assigning the TF, with the endpoints being either Escape 

Impairment or Incapacitation. 

 

 SFPE Escape Impaired (Distribution) – Default Option: 

Each member of the population is randomly assigned a TF for each irritant 

gas component from an assumed distribution based on data defined in the 

SFPE Handbook for Escape Impairment.  

 

 SFPE Escape Impaired (Fixed): 

Each member of the population is assigned a fixed TF for each irritant gas 

component corresponding to the SFPE Escape Impaired mean values.  

Thus using this approach, each member of the population has an identical 

TF for each irritant. 

 

 SFPE Incapacitation (Fixed): 

Each member of the population is assigned a fixed TF for each irritant gas 

component corresponding to the SFPE Incapacitation mean values.  Thus 

using this approach, each member of the population has an identical TF 

for each irritant. 
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 ISO 13571 Incapacitation (Fixed): 

Each member of the population is assigned a fixed TF for each irritant gas 

component corresponding to the ISO 13571 Incapacitation mean values.  

Thus using this approach, each member of the population has an identical 

TF for each irritant 

 

 User Defined: 

The user can specify the nature of the TF distribution to be applied for each 

irritant.  This can either be a fixed value, a range or a distribution. 

 

 New Irritant Model Parameter, Critical Irritant Incapacitation Factor (CIIF) 

 The CIIF is a new parameter introduced due to the introduction of the new FIC 

option of Escape Impairment. The CIIF attribute defines the FIC value required 

to cause incapacitation.  When the Escape Impairment option is used CIIF = 4.5.  

When Incapacitation model is used CIIF = 1.0. If user defined option is used CIIF 

= 0.0 by default. If the Escape Impairment model is used, exposed agents are 

considered unable to continue when FIC >= 1.0.  In this condition the agent may 

become incapacitated by heat or other toxic gases.  If the irritant concentration at 

their current location decreases so that FIC < 1.0, they will be able to resume the 

evacuation process.  However, if the irritant concentration at their current 

location increases, they may become incapacitated by irritant gases if FIC >= 

CIIF i.e. 4.5.  If Incapacitation model is used, exposed agents are considered 

incapacitated when FIC >= 1.0 = CIIF i.e. 1.0.  Agent cannot recover under these 

conditions.  

 

 New Irritant Model Parameter, Critical Dose (CD) 

 The CD attribute is a measure of the dose of irritant gas (ppm.min) required to 

cause a given endpoint and is used in the FLD model.  The endpoint is considered 

to be fatality, but there are three different CD values that can be used depending 

on the FLD model used.  In previous versions of buildingEXODUS there was only 

one option so the CD was not defined as a variable but simply a value selected 

from a distribution.  A CD value is required for each irritant agent considered e.g. 

CDHCL. 

 

 Updated Agent Irritant Tolerance Dose Model (FLD) 

 In previous versions of buildingEXODUS, if FLD = 1.0 the agent was assumed to 

be incapacitated and not able to continue the evacuation and so were added to the 

mortuary. However, in reality death is not likely to occur during the evacuation 

but may occur several hours or several days after receiving the lethal dose.  In the 

new version of buildingEXODUS FLD has no impact on an agent’s ability to 

evacuate but can be used to assess the likelihood of the exposed agent surviving 

post evacuation.  The FLD is thus not intended to be used as a critical factor 

describing evacuation or as a design limit but for estimations of the extent to which 

post-exposure deaths from lung oedema and inflammation are likely to occur. As 

a result, agents are not incapacitated due to excessive cumulative exposure to 

irritant gases (i.e. FLD ≥ 1.0).  
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Versions of buildingEXODUS prior to v6.3 only had the SFPE FLD Critical Dose 

(CD) option.  These values were arbitrarily distributed with the actual value for 

each individual being selected from a range of 50%*median to 200%*median. In 

the new release there are three options for assigning the CDx values. 

 

 SFPE FLD Critical Dose – Default Option: 

Each member of the population is assigned a CDx for each irritant gas 

component as specified in the SFPE Handbook. Using this approach, each 

member of the population has an identical CDx.  This is based on mean values 

that are likely to cause fatality in 50% of the population.  

 

 AEGL-3 FLD Critical Dose: 

Each member of the population is assigned a CD for each irritant gas 

component from the AEGL-3 distribution specified in the SFPE Handbook.  

Using this approach, each member of the population has an identical CD based 

on the AEGL-3 values and so is very conservative, taking into consideration 

particularly vulnerable members of the public.   

 

 User Defined FLD Critical Dose: 

Each member of the population is assigned a CD for each irritant gas 

component based on the user specification.  

 

 New Heat Model Parameter, Radiant Heat Threshold (RHT) 

 In previous versions of buildingEXODUS, the critical radiative threshold (KW/m2) 

value above which the FIHr is calculated was defined internally and so users 

could not alter this value.  This value was set to 1.7 KW/m2.  In the new release, a 

user defined parameter has been introduced, the Radiant Heat Threshold (RHT) 

measured in units of KW/m2, allowing the user to specify the critical value of 

radiant heat. The default value remains 1.7 KW/m2.  

 

Revisions to User Manual 

 The user manual has been altered to reflect the changes specified above.  

 

REPORTING BUGS 

Any complex software product is likely to contain programming bugs, buildingEXODUS is no 

exception!  While we make every effort to reduce the likelihood of bugs occurring, it is impossible 

to guarantee that bugs will not occur.  In the majority of cases, bugs that occur will be in obscure 

parts of the software that will virtually never appear in normal operation.  When bugs do occur, 

they are likely to either be insignificant or there will be a simple way to work around the bug.  

However, in some cases there will not be a way to work around the bug or the bug may be of a 

serious nature.  It is our intention to report these types of bugs to our users whenever practical.  

Please note that we will endeavour to fix all known bugs however, the more serious bugs will 

obviously take priority. 

 

When reporting bugs please ensure that you take note of the error messages and provide as much 

information about how and under what circumstances the problem occurred.  It is important to 

note all the options that you used in setting up the simulation when reporting the problem. 
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Bugs 6.2.0: 

1.  Fixed an issue with batch mode using a default OpLib if the ESO filename started with 

a string which matched one of the default types.  For instance, if the user loaded a file 

“OpLib DefaultMyOpLibFile”, EXODUS would only see this as "OpLib Default" 

2. Fixed a licence expiry date calculation issue, where a warning message was displayed 

unnecessarily.  Sometimes EXODUS would warn the use that their licence is going to 

expire a month early. This could occur if the current month has more days in it than 

the expiry month and the expiry date was near the end of the month. 

3. Fixed issue with using replay files and source nodes, where source nodes could 

generate different generation rates. 

4. Updated the node dialogue so that the Width value is only shown for attractor nodes, 

since including it for all node types incorrectly gave the impression that nodes have a 

width. For all other node types the Width is merely displayed as "N/A". 

5. Fixed a simulation reset issue which meant that some run time itinerary tasks were not 

being removed from agent's itinerary. This could occur if the agent’s task was not 

originally in the EXODUS target group. 

6. Fixed a bug related to removing unused transit node catchment areas which could 

under certain conditions cause EXODUS to crash. This was for transit node groups, 

and could occur when either the catchment area was not needed during the simulation 

or was zero size. 

7. Corrected a bug related to the use of lifts where the user defined floor sequence started 

with floor zero. 

8. Simplified the auto floor link functionality so that only one transit node is now included 

in each floor link. Previously, separate transit nodes (i.e. stairs) connected to adjacent 

nodes would have been connected to the floor above via the same floor link. This would 

often appear confusing and hence difficult for users to understand how the floors were 

connected. 

9. Added the ability for users to switch arc link order in floor links. 

The reordering of arc links was done to reduce the number of crossing arc connections, 

thereby making it easier for users to see how floors were connected. 

10. Fixed issue with transit node staircases with only 2 risers. Previously, defining transit 

node stair cases with 2 or fewer steps would result in the corresponding height 

information of the stair being lost (i.e. EXODUS would calculate the wrong travel 

length). 

11. Updated the Panel Population dialogue box so clicking Cancel undoes changes related 

to irritant values. 

12. Fixed an issue when non-responding agents failed to move when they should have been 

milling. 

13. Updated the random number generation to avoid duplicate sim seeds being used 

when simulations run in less than a second. 

14. Fixed an error with the lift congestion redirect flag not being reset. As a result, agents 

could be considered as having redirected as a result of congestion when in reality they 

have merely used another lift. 

15. Fixed memory leaks related to minimising the number of vertices for EXODUS 

generated polygon. Previously, vertices were being removed but not deleted. 

16. Updated the % rider condition code, changed from "<" to "<=" in the test to determine 

whether an agent should be a rider on an escalator/travelator.  

17. Fixed issue with escalator "riding" agents using the wrong spacing on entering the 

escalator transit node. 
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Version 6.2.0 Enhancements  

1. All bugs in version 6.2.0 have been addressed. 
 

USER NEWS 

We like to hear about your buildingEXODUS applications. Feel free to send us news about your 

buildingEXODUS applications and experience at exodus@gre.ac.uk. A selection of these could 

be featured on our website at http://fseg.gre.ac.uk.  Also, if you have produced a journal, 

conference or magazine article about your use of buildingEXODUS, send us a copy and we will 

feature them on our web page and other EXODUS related publicity.  

 

SOFTWARE NEWS 

The buildingEXODUS development team is constantly working on developments for future 

releases of buildingEXODUS.  Several of these are already in prototype form and will be included 

in subsequent model releases. These include: 

 

 Enhanced Circulation Model with adaptive itineraries, urgency and emotional 

behaviour.   

 Hybrid representation of space to include Coarse and Fine nodes and Continuous 

representation of space. 

 Spatial navigation, where agents choose sub-optimal routes based on their personal 

preferences.  

 Improved scenario generation tools. 

 Import of OpenStreetMap (OSM) data. 

 Enabling users to write their own lift dispatch algorithms via external Python code. 

 Enhanced vrEXODUS. 

 

If you have any features that you would like to see in buildingEXODUS, drop us a line and let us 

know what they are and why you need them. 

 

EXODUS CONTACT INFORMATION 

 

MAIL: 

c/o Professor E.R.Galea 

Fire Safety Engineering Group, 

University of Greenwich, 

30 Park Row, 

Greenwich SE10 9LS 

London  

U.K. 

 

E-MAIL: 

exodus@greenwich.ac.uk 

 

VOICE (TELEPHONE):  

+44 (0)20 8331 8730/8706 

 

More information regarding buildingEXODUS can be found on the EXODUS Internet pages at: 

http://fseg.gre.ac.uk/exodus 

 

 

mailto:exodus@gre.ac.uk
http://fseg.gre.ac.uk/
mailto:exodus@greenwich.ac.uk
http://fseg.gre.ac.uk/exodus
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PREFACE 
Thank you for purchasing buildingEXODUS, the evacuation model for the built environment. 

buildingEXODUS is based on a set of sophisticated sub-models incorporating people-people, 

people-fire and people-structure interactions allowing the safety engineer to perform a range of 

evacuation simulations. 

 

The buildingEXODUS software is part of the family of EXODUS products that include: 

 

airEXODUS for aviation applications, 

buildingEXODUS for the built environment, 

maritimeEXODUS for the marine environment, and 

vrEXODUS, a post processor facility that creates virtual reality visualisation for all EXODUS 

products. 

 

These products are distributed world-wide by the Fire Safety Engineering Group of the 

University of Greenwich, developers of the software. The EXODUS range of evacuation 

modelling tools is highly regarded throughout the world as one of the most sophisticated human 

behaviour and evacuation modelling tools available. Users of the software can be found in over 

23 countries and its unique abilities have been recognised by learned and professional societies 

such as the British Computer Society (BCS) and the Royal Institution of Naval Architects 

(RINA).  

 

FSEG achievements in developing and applying the EXODUS suite of software has been 

acknowledged through the award of a number of international and national prizes.  These 

include: 

 

 The Royal Institution of Naval Architects Medal of Distinction in 2014. The award was 

made for the best paper to appear in the Transactions of the Royal Institution of Naval 

Architects, International Journal of Maritime Engineering in 2013. The paper covered 

the collection of evacuation data related to the response times of passengers on large 

passenger ships and data suitable for the validation of ship evacuation models. 

 The Guardian University Award for Research Impact in 2014. The award was made for 

FSEG’s work on the development of the Intelligent Active Dynamic Signage Concept 

which utilised buildingEXODUS to identify suitable evacuation routes in faster than 

real time. 

 In 2011 the FSEG publication, “Fire and Evacuation analysis in BWB aircraft 

configurations: computer simulations and large-scale evacuation experiment”, which 

appeared in the Aeronautical Journal 2010, won the Royal Aeronautical Society’s Bronze 

Award for 2010.  

 In 2008 the FSEG a publication, “Signage Legibility Distances as a Function of 

Observation Angle”, which appeared in the Journal of Fire Protection Engineering 2007, 

won the SFPE Jack Bono Engineering Communication Award.  The Jack Bono 

Engineering Communication Award is given to the authors of the paper that during the 

prior year has most contributed to the advancement and application of professional fire 

protection engineering.  

 The European IST prize in 2003.  The EU Commission-sponsored European IST 

(Information Society Technologies) Prize is awarded by the European Council of 

Applied Sciences, Technology and Engineering (Euro-CASE) to entrepreneurial teams 

that excel in generating novel ideas and converting them into marketable products. 
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 The Queen’s Anniversary Prize for Higher Education in 2002. The citation associated 

with the honour recognises FSEG as a ‘world leader in the area of evacuation model 

development.’  

 In 2002, maritimeEXODUS won the CITIS (Communications & IT in Shipping) Award 

for Innovation in IT for Ship Operation.   

 In 2002, maritimeEXODUS won the RINA/LR (Royal Institution of Naval 

Architecture/Lloyds Register) Award for ship safety.   

 In 2001 the EXODUS suite of software was chosen as a medallist in the coveted British 

Computer Society (BCS) IT Awards (the Oscars of the IT industry).  In addition to being 

a medallist, EXODUS was also selected as overall winner.  The Awards are open to any 

project developed in the field of IT in the UK, and are recognised as the most prestigious 

acknowledgement of excellence in the British computer industry. 

 

buildingEXODUS was developed to provide a design and research tool that could be used by 

those concerned with evaluating the evacuation efficiency of occupied structures.  Users should 

note that the prediction of evacuation performance is not an exact science. All evacuation 

simulation software, including buildingEXODUS, should only be considered an aid to 

evaluating the evacuation performance of a structure, not a replacement of accepted good 

engineering practice, guidelines and judgement. Only those experienced in evacuation analysis 

should make use of the software and only after the user manual has been thoroughly studied. 

The user should pay particular attention to all the assumptions specified in the software and 

ensure that none of the conditions or assumptions are violated by their intended application. 

 

The User Guide consists of 7 chapters and 6 appendices: 

 

Chapters: 

Chapter 1 contains information on the hardware requirements, performance capabilities, 

installation instructions and how to report bugs. 

Chapter 2 contains information on how to use buildingEXODUS, the four main modes of 

operation and their corresponding menu and toolbar options. 

Chapter 3 contains information on how to define a geometry within Geometry mode. 

Chapter 4 contains information on how to define a population within Population mode. 

Chapter 5 contains information on how to define a scenario within Scenario mode. 

Chapter 6 contains information on how to run a simulation within Simulation mode. 

Chapter 7 contains all of the references for Chapters 1 to 6. 

 

Appendices: 

Appendix A contains a quick reference guide describing the function of the pull-down menus 

and function buttons. It should be used when first enquiring about a menu option or 

function. 

Appendix B consists of a complete list of the default values used in the buildingEXODUS 

software. It should be consulted when information concerning the default settings 

is required. 

Appendix C contains information concerning the buildingEXODUS movie player utility.  

Appendix D consists of a complete list of files produced by or used by buildingEXODUS. 

Appendix E contains a list of deprecated functionality within buildingEXODUS. 

Appendix F contains a guide explaining script files (SFE) and their associated functions. 

 

Finally, as a responsible user of this software it is strongly recommend that time is taken to 

study this manual thoroughly. Users are encouraged to make use of the software support facility 
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to contact their suppliers or the software developers if they have questions regarding the use of 

the software. 

 

NOTE: 

Some minor modifications to the user interface do not appear in all the screen grabs throughout 

this manual.  Where this is important to the context of the section, this is noted. 

 

Version 6 features 

The release of version 6 of buildingEXODUS incorporates a large number of additions and 

alterations that are designed to make the software more user friendly, more efficient and more 

useful.  A list of these new features and modifications found in version 6 is provided in the 

release notes. 
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CHAPTER 1: GETTING STARTED 
 

1.1 Hardware Requirements 

buildingEXODUS v6.3 can be installed on PCs running Windows XP, Windows Vista, Windows 

7 and Windows 8 in both 32bit and 64bit environments. Furthermore, buildingEXODUS v6.3 is 

supplied in both 32bit and 64bit variants. During installation, the most suitable version will be 

installed on the PC depending on whether a 32bit or a 64bit operating system is detected. The PC 

hardware requirements are shown in Table 1-1. 

 

Table 1-1: Minimum Computer Requirements 
PC Requirement* Processor Speed RAM Hard Disk Space 

Small and medium sized geometries with a 
few hundred agents  

Intel P4 1.5 GHz 1 GB 10 MB 

Large sized geometries with a few 
thousand agents 

Intel Core Duo 
processor or 

better 

2.5  GHz 6 GB 20 MB 

Very large geometries with tens of 
thousands of agents 

Intel i7-950 3.06GHz 12 GB 100+ MB 

*Note: the requirements suggested are only intended as an indication of the MINIMUM computer requirements 

necessary for small, medium, large and very large sized structures. The computer requirements and performance are 

strongly dependent on the physical size of the intended application – both the geometry of the structure and the number 

of people involved. The hard disk requirements refer to the amount of space needed by the simulation data output files. 

 

1.2 Typical Performance Capabilities 

The speed at which buildingEXODUS can perform simulations is dependent on the nature of the 

simulation and the computer used. The primary factors that influence this performance are the size 

of the geometry, number of occupants, computer processor type and amount of RAM memory. 

The nature of the various options selected also affects the run time. For instance, use of batch 

operation, square people icons and even the size of the graphics window displayed all contribute 

to speeding up a simulation. It is worth noting that when run with square people icons (i.e. blocks), 

buildingEXODUS can run faster than the same case with people silhouette icons. 

 

To provide some idea as to how the software performs, two benchmark cases have been 

developed. In each case, the standard population was used with an instant response assigned. 

Each case was run in batch mode.  The times have been presented for each phase of running 

buildingEXODUS v6.3 i.e. loading the geometry and population, calculating the potential map 

and running the simulation. 

 

Note that run times are measured from the start of the simulation execution to the time of the last 

agent to exit the geometry. 

 

It should also be noted that the times for loading the geometry/population and for calculating 

the potential maps are performed once and precede the first run.  Further runs (in the same 

batch) do not require these functions to be recalculated. 
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Benchmark 1 

The first benchmark involves 30,000 agents in a square geometry measuring 60,025 m2 and 

consisting of 28 exit points each 2m in width. The population is assumed to respond instantly. 

Table 1-2 below shows the results obtained after running this case in batch mode on several 

PCs: 

 

Table 1-2: buildingEXODUS v6.3 performance large benchmark1:  

60,025m2 enclosure, with 28 exit points and 30,000 agents. 

Operating 

System 

Machine 

Specification 

Geometry & 

Population 

Loading time 

Calculation of 

potential & 

distance map 

Run Time 

Windows 7 

(64bit) 

Intel Core i7 950  

3.06 GHz 24Gb RAM 

0.03 min 0.52 min 4.7 min 

Windows 7 

(64bit) 

Intel Core i7 950  

3.06 GHz 12Gb RAM 

0.03 min 0.52 min 4.35 min 

Windows 7 

(64 bit) 

Intel Core 2 Duo  

3.33 GHz 8Gb RAM 

0.04 min 0.45 min 5.9 min 

Windows 7 

(64bit) 

Intel Core i7-3930K  

3.2 GHz 32Gb RAM 

0.03 min 0.35 min 4.10  min 

 

Windows 7 

(64bit) 

Intel Core i7-3720QM 

3.6 GHz 16Gb RAM 

0.03 min 0.37 min 4.23 min 

Windows 7 

(64bit) 

Intel Core 2 Quad 

Q9650 

3.0 GHz 8Gb RAM 

0.05 min 0.95 min 13.25 min 

*All times correspond to the 32bit version of buildingEXODUS v6.3 
 

Benchmark 2 

The second benchmark involves 8,120 agents in a 50-storey high-rise geometry covering 89,852 

m2. The population is assumed to respond instantly. Table 1-3 below shows the results obtained 

after running this case in batch mode on several PCs: 

  



Chapter 1 - Getting Started 

© 2017 University of Greenwich 23 

 

Table 1-3: buildingEXODUS v6.3 performance large benchmark2:  

89,852 m2 enclosure, with 8,120 agents. 

Operating 

System 

Machine 

Specification 

Geometry & 

Population 

Loading time 

Calculation of 

potential & 

distance map 

Run Time 

Windows 7 

(64bit) 

Intel Core i7 950  

3.06 GHz 24Gb RAM 

0.07 min 0.12 min 12.68 min 

Windows 7 

(64bit) 

Intel Core i7 950  

3.06 GHz 12Gb RAM 

0.07 min 0.12 min 14.47 min 

Windows 7 

(64bit) 

Intel Core 2 Duo  

3.33 GHz 8Gb RAM 

0.09 min  0.10 min 21.68 min 

Windows 7 

(64bit) 

Intel Core i7-3930K  

3.2 GHz 32Gb RAM 

0.06 min 0.08 min 14.85 min 

Windows 7 

(64bit) 

Intel Core i7-3720QM 

3.6 GHz 16Gb RAM 

0.06 min 0.08 min 16.52 min 

Windows 7 

(64bit) 

Intel Core 2 Quad 

Q9650 

3.0 GHz 8Gb RAM 

0.12 min 0.27 min 38.70 min 

*All times correspond to the 32bit version of buildingEXODUS v6.3 
 

NOTE: 

The time taken to run simulations in non batch mode is largely dependent upon both the size of 

the buildingEXODUS geometry window and the amount of information that is required to be 

displayed within that window. Running simulations with the geometry window maximised and 

with a large amount of information (i.e. lines, nodes people etc.) displayed will therefore 

typically take longer (since more redraw events will be required) than a corresponding 

simulation of the same geometry with a smaller geometry window focused on only a subsection 

of the structure. 

 

1.3 File Compatibility  

All EXO files made using previous versions of buildingEXODUS should be compatible with 

version 6.3 of buildingEXODUS. 

 

1.4 Installation Instructions 

1) The latest version of buildingEXODUS, as well as all the documentation and accompanying 

software and utilities can be downloaded and installed from the following link: 

 
http://fseg.gre.ac.uk/exodus/restricted-area/exodus-users 

 

However, in order to access this page users will first need to register by sending an email 

to that effect to exodus@gre.ac.uk. 

 

NOTE: Do not insert the USB device until EXODUS installation has been completed. 

 

2) Only after buildingEXODUS has been installed should you insert the Hardware Key (dongle) 

into the USB port on your computer. If the dongle is not attached EXODUS will prompt the 

user to attach it to the computer. 

 

http://fseg.gre.ac.uk/exodus/restricted-area/exodus-users
mailto:exodus@gre.ac.uk
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1.5 The buildingEXODUS Hardware Key (Dongle) 

buildingEXODUS will not function without the dongle supplied with the licence.  The dongle 

has a limited life of between three and five years beyond which it requires replacement.  Should 

the dongle be removed or expire whilst buildingEXODUS is in use, an emergency file will be 

saved containing the geometry and will shut down immediately.   

 

1.6 Technical Support 

Users cannot risk using software that cannot be maintained and supported.  For this reason the 

official suppliers of buildingEXODUS provide software support. The objectives of the software 

support agreement are to facilitate a reasonable level of professional on-line (telephone, fax 

and/or e-mail) support for users of buildingEXODUS. Official Software Support can only be 

provided by the developers of buildingEXODUS or their authorised distributors. Software 

support is usually provided by the party from whom the software was purchased. Please refer 

to your license agreement for further details. 

 

A series of regular buildingEXODUS user courses are also offered to users. Please contact the 

developers for more information.  

 

1.7 Reporting Bugs 

All users are encouraged to report software bugs to the developers. Bugs should be reported to 

the developers preferably by e-mail. If you do not have access to e-mail please fax bug reports.  

 

e-mail: exodus@gre.ac.uk 

fax:    +44 (0)20 8331 8925 

 

When reporting bugs please ensure that you take note of the error messages and provide as 

much information about how and under what circumstances the problem occurred.  It is 

important to note all the options that you used in setting up the simulation when reporting the 

problem. 

 

More information regarding buildingEXODUS can be found on the EXODUS Internet pages 

at: http://fseg.gre.ac.uk/exodus 

 

 

mailto:exodus@gre.ac.uk
http://fseg.gre.ac.uk/exodus
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CHAPTER 2: HOW TO USE buildingEXODUS - THE BASICS 
In this chapter the basic procedure of specifying and running an evacuation scenario using 

buildingEXODUS is described. The procedure involves four distinct steps that cover, 

constructing the geometry, defining the population, specifying a scenario, and running the 

simulation. 

 

It is assumed that the user has a basic working knowledge of the Microsoft WINDOWS 

environment. 

 

Throughout the following chapters, many references are made to the various menus and toolbar 

shortcuts.  Wherever possible, these are also clarified in the form  

 

Shortcut: [Menu/Option] 

 

Menu refers to the name of the option on the menu bar, for example File 

Option refers to the item on the pull-down menu originated by Menu 

 

2.1 Modes of Operation 

buildingEXODUS provides four modes of operation to assist the user in simulating an evacuation.  

Each mode must be utilised in turn in order to simulate an evacuation. These modes are: 

 

1. Geometry Mode - this mode allows the user to construct the structure to be modelled.  Several 

methods are available, (a) the enclosure can be constructed from scratch using the interactive 

tools provided, (b) a third party geometry file can be imported (i.e. DXF, IFC, FDS or SMF) 

and (c) a library case can be utilised (see Chapter 3). 

 

2. Population Mode - this mode is used to generate the group of occupants to be used in the 

evacuation study.  As in the Geometry mode, interactive tools are provided to assist with 

population definition. Entire populations or subgroups of people can also be stored and 

recalled from a user-defined library (see Chapter 4). 

 

3. Scenario Mode - this mode is used to control scenario specifics such as exit capabilities, exit 

potentials, fire hazards, structure orientation, etc (see Chapter 5). 

 

4. Simulation Mode - this mode allows a simulation to be run either interactively or in batch 

mode.  The user can also use this mode to specify a range of scenario specific data which can 

be output and stored for later inspection (see Chapter 6). 

 

NOTE: 

The specific capabilities of each mode of operation is dependent upon whether software level 

A, B or C is being used (see the Theory Manual, Section 1.2). 

  



Chapter 2 - buildingEXODUS - The Basics 

© 2017 University of Greenwich 28 

 

2.2 Navigating buildingEXODUS 

Within each mode of operation, the user is presented with a menu bar and a corresponding toolbar.  

The menu bar presents the user with full access to all the functions available within the specific 

mode of operation. These functions are presented in text format and are accessed by the mouse 

pointer. The toolbar is a collection of buttons with small icons that simply represent common 

selections from the menu. The toolbar is intended to make selection of common used functions 

quicker and more efficient. The toolbar can be edited by the user, who has the ability to 

remove/add buttons, in order to better facilitate their use of the model (i.e. it allows the user to 

refine the model to their own requirements more effectively). 

 

The menu system in buildingEXODUS differs slightly from common WINDOWS application 

software in that each mode of operation possesses a slightly different menu bar and toolbar. 

 

The menu system collects functions together in a logical and coherent manner. This enables 

easier navigation and reduces the likelihood of the user omitting the performance of certain 

actions or the setting of certain attributes. Generally this has meant the grouping of specific 

tasks via sub-menus and dialogue boxes. 

 

Figure 2-1 displays the buildingEXODUS application when it is first started and highlights the 

major components.  

 

 
Figure 2-1: The buildingEXODUS application 

 

When first started, buildingEXODUS places the user in GEOMETRY mode. At this point, the 

following major components of buildingEXODUS can be seen: 
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2.2.1 Navigation Window 

The Navigation Window (see Figure 2-2) represents graphically the modelled geometry and 

provides the user with a quick navigation tool for accessing the geometrical and scenario 

components of the modelled geometry. When the model is first opened, this bar will be clear of 

information. Once a file is loaded into the model, or the user has begun using the interactive 

tools to generate a geometry, then information relating to the objects that have been created will 

appear in this window (see Figure 2-2). Once objects have been created, the navigation bar 

allows quick access to the graph windows generated while a simulation is running and any of 

the dialogue boxes that are associated with the objects that have been created. The information 

in the Navigation Window is presented in a tree structure. This structure can be 

expanded/contracted according to the information required by the user and the access they 

require to objects further into the tree structure. Most items in the Navigation Window tree have 

their own context menu that can be accessed by right clicking on each one. The context menu 

items differ depending on the item to which they are referring (see Figure 2-2).  

  

 
Figure 2-2: Navigation Window with several context menu examples. 

 

The Navigation Window consists of three main parts. The first part represents all the major 

features of the geometry including floors, exits and staircase links. By right clicking on one of 

these items the user has access to functions/dialogue boxes that relate to that specific item. 

Available functions include the ability to open the item’s properties or to locate them in the 

geometry (see Figure 2-3). The second part of the Navigation Window includes the scenario 

components such as the hazards and the defined zones (i.e. hazard, compartment, response, 

obstacle and visibility). Finally, the user is able to open the output graph windows generated 

while a simulation is running.  

 

The user has the option to show or hide the Navigation Window by selecting View from the 

menu bar, Interface from the menu and the Navigation Window option from the resulting 

submenu. This action can be performed in all four EXODUS modes. 

 



Chapter 2 - buildingEXODUS - The Basics 

© 2017 University of Greenwich 30 

 
Figure 2-3: The Navigation Window in conjunction with a loaded geometry. 

 

2.2.2 Geometry Window 

The geometry window contains the enclosure to be modelled.  More geometry windows may be 

added by the user to model different parts of an enclosure, for example, a multi-storey structure 

may have each storey specified in separate geometry windows.   

 

2.2.3 Data Window 

At the base of the geometry window, three sub-windows are located (in the form of selectable 

leaf style windows). These sub-windows include the Summary sub-window, the Output sub-

window and the Exit List sub-window. The user is able to control whether the Data Window (and 

all of its sub-windows) is enabled by selecting View from the menu bar, Interface from the menu 

and the Data Window option from the resulting submenu in any of the EXODUS modes. The 

sub-windows are now described: 
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1) Summary 

The function of this window is to display a summary of the geometry, population and scenario 

of the current buildingEXODUS case, for example, the number of nodes and occupants. 

 

2) Output 

This window echoes the information that is generated for the simulation file at the end of the 

simulation. Therefore the data that has been chosen to be generated by the user in Simulation 

mode will be sent both here and to the simulation (*.sim) file. 

 

3) Exit List 

The Exit List space is used to show which occupants used each of the exits whilst the 

simulation is running in Simulation mode.   

 

2.2.4 Menu Bar 

Provides the user with full access to all the functions available within the specific mode of 

operation.  Some options remain the same in all modes of operation.  These are shown in Table 

2-1.  The menu bar for each mode of operation is shown in Section 2.3.  

 

2.2.5 Tabbed Menu Bar 

Enables the user to quickly and easily switch between the four modes available within 

buildingEXODUS (i.e. Geometry, Population, Scenario and Simulation).  This provides an 

alternative method of switching between modes to the existing a) Mode Advance and Mode Back 

chevrons (i.e.  and , see Table 2-1), and b) the Goto option within the Edit menu.  Users 

should be aware that the ability to jump to given modes within buildingEXODUS is dependent 

upon certain actions having been performed (i.e. until the geometry contains various objects).  For 

instance, users will not be permitted to leave Geometry mode until an External Exit has been 

defined within the geometry.  Similarly, users will not be permitted to enter Simulation mode 

until a population has been defined within the geometry.  The user is able to control whether the 

Tabbed Menu Bar is enabled/displayed by selecting View from the menu bar, Interface from the 

menu and the Tabbed Menubar option from the resulting submenu in any of the EXODUS 

modes.  By default the Tabbed Menubar is not displayed. 

 

 
Figure 2-4: The Tabbed Menu bar shown highlighted 

 

2.2.6 Toolbar 

The toolbar is essentially a shortcut to often-used functions, usually accessed from the menu. 

Some functions that are available on the toolbar (and menu) apply to all modes, these are shown 

in Table 2-1. The functions appearing on the toolbar can be chosen by the user via the Toolbar 

Edit dialogue box (see Figure 2-5).  The toolbar for each mode of operation is shown in 

subsequent sections. In the following tables, options that are selectable are marked with an 

asterix to denote that they are optional. 
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Table 2-1: Toolbar buttons common to all buildingEXODUS modes 

Button Name Menu Equivalent Explanation 

 
Abort N/A Cancels the current process.  Should be used with caution. 

 
Mode Back Edit – Goto - X Goes back one mode, X = mode required 

 
Mode 

Advance 
Edit – Goto - X Goes forward one mode, X = mode required 

 
New File - New 

Starts a new buildingEXODUS File.  If the current work has 

not been saved, the user will be prompted to save the work. 

 
Open File -  Open Opens an existing buildingEXODUS file 

 
Save File - Save Saves the current buildingEXODUS file 

 
Zoom In View - Zoom - In Allows the user to zoom in on part of a geometry 

 
Zoom Out View - Zoom - Out Allows the user to zoom out on a geometry 

 
Zoom Reset 

View - Zoom - 

Reset 
Allows the user to reset the zoom on a geometry 

 
Redraw* View – Redraw Allows the user to Redraw the work area 

 
Boundary* View – Boundary Toggles between Boundary view and the nodal view 

 Undo* Edit - Undo Allows the user to undo last task performed 

 

The Toolbar Edit dialogue box can be accessed in any mode by selecting View from the menu 

bar, Interface from the menu and the Edit Toolbar option from the resulting submenu.  The 

Toolbar Edit dialogue box provides a list of function groups appropriate to the current mode.  

Each group in turn consists of one or more functions (see Figure 2-5). 

 

 
Figure 2-5: The Toolbar Edit dialogue box 

 

The function groups currently selected to be on the toolbar appear in the Selected list on the left 

of the screen.  In contrast those not currently selected appear in the Available list on the right 

of the screen.  Users can add to the currently selected toolbar items by first clicking on an item 

within the Available list and then clicking the Add button.  If an item within the Selected list is 

highlighted at the time an item is added, then the item will be added before it in list, otherwise 

the item will be added to the end of the list.  To select all the function groups for display on the 

toolbar the user should click the All button.  Similarly users can remove items from the currently 

selected list of toolbar items by first clicking on an item within the Selected list and then clicking 

the Remove button.  Clicking the Rmv All button will remove all the items from the Selected 

list.  It is important to note that the order in which the function groups appear in the Selected 

list is the order from left to right in which they will appear on the toolbar.  By default only the 

most frequently used groups of functions appear on the toolbar. 

 

Another menu option available in every mode is Help. This gives access to an interactive help 

facility. To access help select Help from the menu bar. Three options are then presented in the 

Help pull-down menu. These are User Guide, Key and About. Accessing the help facility is 
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accomplished by selecting the User Guide option. This presents the user with another window 

that contains the required information. The User Guide environment possesses its own menu 

contents list down the left of the screen and a help window. Clicking on items within the 

contents list will either expand the section further if it contains sub-sections, or else will display 

the corresponding selected section within the help window.  Users can also search for keywords 

within the User Guide, with the corresponding results then being displayed within the Search 

tab. The Key option provides the user with a colour key defining population characteristics and 

information concerning the graphical options, while the About option provides the user with 

information concerning their licence. 

 

2.3 Menus and Toolbars for Each Mode of Operation 

In the following sub-sections, the menu system and toolbar for each mode of operation is 

shown.  For explanation of each item, see the relevant chapter for the mode of operation. 

 

NOTE: 

The menus are generally organised so that the Tools menu refers to objects or processes that 

have not been previously created, the Edit menu lists actions that can be performed on existing 

objects or processes, while the View menu refers to alterations in the graphical interface. 

 

2.3.1 Geometry Mode 

For details on GEOMETRY MODE, see Chapter 3. 

 

 
Figure 2-6: Geometry Mode menu bar and toolbar 
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Table 2-2: Toolbar buttons specific to Geometry Mode 

Button Name Menu Equivalent Explanation 

 
Free Space Node 

Tools – Generate - 

Node 
Creates Default Nodes 

 
Stair Transit Node 

Tools – Generate -  
Transit Node 

Creates a Stair Node. Other types of transit node can 

then in turn be created by simply redefining the Node 

Type of the Transit Node. 

 
Seat Node 

Tools – Generate -  

Node 
Creates Seat Nodes  

 
Exit Node 

Tools – Generate- 

External Exit 
Creates Exit Nodes  

 
Arc 

Tools – Generate - 
Arc 

Creates Arcs Between Nodes 

 
Select 

Edit – Select – 

Rubber Band Select 
Allows User to Select buildingEXODUS Objects 

 
Object Lock Edit – Object Lock Allows the user to enable/disable the movement of 

objects 

 
Node Snap Edit – Node Align - 

Snap 
Allows the user to enable/disable the node snap 

facility 

 Cut* Edit-Cut 
Allows the user to remove an item ready to be pasted 

elsewhere 

 Copy* Edit-Copy 
Allows the user to duplicate an item ready to be pasted 

elsewhere 

 Paste* Edit-Paste Allows the user to paste an item stored in memory 

 Line* 
Tools - Generate - 

Line 
Allows the user to generate a line on screen 

 Polygon* 
Tools - Generate – 

Polygon 
Allows the user to generate a polygon boundary 

 Text* 
Tools - Generate – 

Text Label 
Allows the user to generate a text label 

 

 

 

 

 

 

 
 

Figure 2-7: Menu structure in Geometry Mode 
 

2.3.2 Population Mode 

For details on POPULATION MODE, see Chapter 4. 

 

 
Figure 2-8: Population Mode menu bar and toolbar 
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Table 2-3: Toolbar buttons specific to Population Mode 
Button Name Menu Equivalent Explanation 

 
Occupant 

Tools – Person -

Location 
Creates a single occupant. 

 
Panel Populate Tools - Panel Populate Creates a population using panel builder. 

 
Select 

Occupants 

Edit - Select – People 

Select 
Selects occupants only i.e. not nodes. 

 Find Person View -Find - Person Locates a given person 

 

  

 

 
Figure 2-9: Menu structure in Population Mode 

 

2.3.3 Scenario Mode 

For details on SCENARIO MODE, see Chapter 5. 

 

 
Figure 2-10: Scenario Mode menu bar and toolbar 

 

Table 2-4: Toolbar buttons specific to Scenario Mode 

Button Name Menu Equivalent Explanation 

 
Add Zone 

Tools – Zone - Add 

Zone 
Creates hazard zones. 

 
Zone Editor 

Tools – Zone -Edit 

Zone 
Edits hazard zones. 

 
Hazard Editor Tools - Hazard Creates/Edits hazard definitions. 

 
Edit Scenario Tools – Scenario Creates/Edits scenario definitions. 
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Figure 2-11: Menu structure in Scenario Mode 

 

2.3.4 Simulation Mode 

For details on SIMULATION MODE, see Chapter 6. 

 

 
Figure 2-12: Simulation Mode menu bar and toolbar 
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Table 2-5: Toolbar buttons specific to Simulation Mode 

Button Name Menu Equivalent Explanation 

 
Reset Simulation - Reset Resets a simulation 

 
Play Simulation - Play/Continue Starts/Continues a simulation 

 
Step - Advances simulation one step 

 
Pause Simulation - Pause Pauses simulation 

 
Replay Simulation - Replay Replays simulation to current point 

 
Occupant Select Edit - Select – People Select Selects occupants i.e. NOT nodes 

 
Person Shape* View – Shape -Person 

Changes appearance to person shape 

view 

 Block Shape*  View - Shape – Block 
Changes appearance to block shape 

view 

 
Arrow* View - Shape - Arrow 

Changes appearance to arrow shape 

view 

 
Pop. Density* View – Contour – Pop. Density Displays population density contours 

 
Potential Map* View – Contour – Potential Map 

Displays the spread of the potential 

map 

 

Potential Route 

Map* 

View – Contour – Pot Route 

Map 

Displays the spread of the potential 

map and the direction of movement 

at all nodal locations 

 
Footfall* View – Contour – Footfall Displays the footfall contour 

 
Temperature* View – Contour – Temperature Displays the temperature contour 

 
Smoke* View – Contour – Smoke Displays the smoke contour 

 Congestion* View – Contour – Congestion Displays the congestion contour 

 
VR* Simulation–VR Save Generates a VR output file 

 
Data Output* Rulebase-Data Output Options Access to  the data output controls 

 
Hazard Control* Rulebase–Hazard Options Access to the hazard control options 

 
Behaviour Control* Rulebase–Behaviour Options Access to the behavioural controls 

 
Options Library* Rulebase- Options Library Allows the behavioural controls to 

be saved and used again. 

 

 

 

 

 

Figure 2-13: Menu structure in Simulation Mode 
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2.4 Summary 

To utilise buildingEXODUS, the four modes of operation must be utilised in set sequence. Before 

viewing simulations in SIMULATION mode it is first necessary to specify a geometry 

(GEOMETRY mode), define a population (POPULATION mode) and specify a scenario 

(SCENARIO mode). Only once these steps have been completed is it possible to run the 

simulation.  At any step, the user is permitted to go back to any of the previous stages. 

 

The functions available to the user are selected from the main menu bar and toolbar. With the 

exception of some functions (such as Save and Exit etc), the functions available to the user are 

mode dependent. 
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CHAPTER 3: DEFINING A GEOMETRY (GEOMETRY MODE) 
 

3.1 Geometry Mode Overview 

Structures in buildingEXODUS are modelled as two-dimensional grids of nodes (see the Theory 

Manual, Section 2.2).  Individual floors are made up of separate grids connected by stairs or 

ladders.  The entire enclosure is collectively referred to as the geometry. Three methods may be 

used to generate a geometry: 

 

 Using interactive tools (Section 3.3) 

 Importing a third party geometry (Section 3.4) 

 Selecting a geometry from library (Section 3.5) 

 

The first two methods construct a geometry, which can then be saved into a library for later use.  

The third method simply refers to retrieving previously constructed geometries from the library.  

 

Geometry mode is the first mode encountered when entering buildingEXODUS.  The other 

modes of operation cannot be entered until a geometry has been constructed or retrieved. 

 

3.2 Manipulating Objects 

Whilst in Geometry mode the user is able to interact and interrogate a variety of object types (e.g. 

free-space nodes, exit nodes, arcs, etc.). When doing so the user has two basic options in retrieving 

information in relation to one of these options. The user may double-click (using the left mouse 

button) on the icon representing the object in the workspace, which will produce a dialogue box, 

providing access to the attributes of that object which may be examined and possibly edited. 

Alternatively the user may right click (once) on the object, which will then generate a menu from 

which the user may select information. The nature of this menu may change from object to object 

according to the data available. The method used is entirely down to the preferences of the 

individual. 

 

3.3 Constructing a Single Floor Geometry Using Interactive Tools 

While not normally displayed during a simulation, geometries consist of a group of nodes 

connected by arcs (see the Theory Manual, Sections 2.2 to 2.4). When constructing a geometry, 

the user must not only specify the location of walls, doors and obstacles, but also the network 

of nodes which span the geometry. This section demonstrates how to create a network of 

interconnecting nodes representing the geometry of a structure using the interactive tools 

provided in buildingEXODUS.  

 

In this mode, the toolbar and corresponding menu will look like those shown in Figure 3-1 and 

Figure 3-2. The toolbar contains a number of standard buttons (shown in Figure 3-1). In 

addition, the user now has the option to place additional button icons according to their 

preference. These are available in each of the modes by selecting View from the menu bar, 

Interface from the menu and the Edit Toolbar option from the resulting submenu. They are 

included in each of the explanatory tables, but are marked with an asterix to denote their optional 

status. The available buttons are listed in Table 3-1.  
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Figure 3-1: The building EXODUS toolbar in Geometry mode 

 

 

 

 

 

 

 
 

Figure 3-2: Menu structure in Geometry Mode 
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Table 3-1: Toolbar buttons specific to Geometry Mode 

Button Name 
Menu 

Equivalent 
Explanation 

 
Default Node 

Tools - 

Generate/Node 
Creates Default Nodes (see Section 3.3.1) 

 
Stair Transit Node 

Tools - Generate/ 
Transit Node 

Creates Transit Nodes (i.e. stairs, escalators, travelators, 

corridors and metered gates) (see Section 3.3.1) 

 
Seat Node 

Tools - 

Generate/Node 
Creates Seat Nodes (see Section 3.3.1) 

 
Exit Node 

Tools - Generate/ 

External Exit 
Creates exit Nodes (see Section 3.3.1.7) 

 
Arc 

Tools - 
Generate/Arc 

Creates Arcs Between Nodes(see Section 3.3.1.2) 

 
Select 

Edit – Select – 

Rubber Band Select 
Allows Objects to be selected (see Section 3.3.3.1) 

 
Object lock* Edit – Object 

Lock 

Allows the user to enable/disable the movement of 

objects (see Section 3.3.3.13) 

 
Node Snap* 

Edit – Node 

Align - Snap 

Allows the user to enable/disable the node snap facility 

(see Section 3.3.3.11) 

 
Boundary* 

View - 

Boundary 

Toggles appearance of geometry between nodal and 

boundary mode (see Section 3.3.4.2) 

 
Cut* Edit-Cut 

Allows the user to remove an item ready to be pasted 

elsewhere (see Section 3.3.3.5) 

 
Copy* Edit-Copy 

Allows the user to duplicate an item ready to be pasted 

elsewhere (see Section 3.3.3.4) 

 
Paste* Edit-Paste 

Allows the user to paste an item stored in memory (see 

Section 3.3.3.6) 

 
Line* 

Tools – Generate –

Line 
Allows the user to generate a line on screen (see Section 

3.3.1.16) 

 
Polygon* 

Tools – Generate –

Polygon 
Allows the user to generate a polygon boundary (see 

Section 3.3.1.17) 

 
Text* 

Tools – Generate –

Text Label 
Allows the user to generate a text label (see Section 

3.3.1.18) 

 
Redraw* View - Redraw Redraws the current screen (see Section 3.3.4.1) 

 
Undo* Edit - Undo 

Allows the user to undo last task performed (see Section 

3.3.3.14) 

 

To start a new geometry select File from the menu bar and the New item from the pull-down 

menu. Alternatively, simply press the New button on the toolbar (see Figure 3-1). 

Shortcut: [File/New]  

 

3.3.1 Tools menu 

The Tools menu contains functions concerned with the creation of entities or with factors that 

may relate to the creation of entities (see Figure 3-2). The following features are available via 

the Tools menu and will be instrumental in the generation of new geometries. 

 

3.3.1.1 Node Generation 

Shortcut: [Tools/Generate/Node]  
To start placing nodes on the geometry window select Tools from the menu bar, then from the 

Generate sub-menu select the Node item (see Figure 3-2). Alternatively, simply press the Node 

button on the toolbar (see Figure 3-1 and Table 3-1).  Now, by clicking on the Geometry 

window, single nodes of the default type will be placed at that point.  The initial default node 

type is Free-Space Node. 
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NOTE: 

In this section, “NODE” primarily represents Free-space nodes, but the methods described are 

equally applicable to all buildingEXODUS nodes. 

 

 
Figure 3-3: Dialogue box for filling a region with nodes 

 

To generate a region filled with nodes the user must drag out with the mouse pointer a region 

and release the mouse button. At that moment a dialogue box will appear (the NUMBER OF 

NODES dialogue box) prompting the user to enter the number of rows (“Y direction”) and 

columns (“X direction”) of nodes to generate (see Figure 3-3).  The MAX button generates the 

maximum number of nodes that can fit within the specified region and thus requires no values 

for “X direction” and “Y direction”.  

 

The PACK button generates the number of nodes specified, i.e. X direction multiplied-by Y 

direction with the region being justified to the top-left of the bounding box.  The CONX button 

(“connects”) also performs this action, but additionally, fully connects the nodes, using the 

default arc length in all directions.  

 

NOTE: 

The generation of diagonal arcs requires the default arc setting to be adjusted, to accurately 

represent the distance between the connected nodes. Alternatively the Physical Dist. option can 

be specified, which calculates the distance between nodes and therefore the length of arcs 

automatically. 

 

NOTE: 

The visual spacing between nodes is unrelated to the actual distance between the nodes, this is 

specified by the arc length unless the Physical Dist option has been enabled. 

 

Nodes generated in this manner are by default free-space nodes.  This default can be changed 

to generate other types of nodes, a definitive list of nodes is presented in Table 3-2.  

Furthermore, individual nodes can be changed into other types of nodes (see Section 3.3.3.2).  
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Table 3-2: List of Node types available in buildingEXODUS 

Node Name Colour Purpose 

 
Free Space Green Models free space 

 
Boundary Brown Models free space but forces individuals to use walk speed 

 
Seat Red Model seats 

 
Stair Cyan Models one lane on one riser of a staircase 

 

Discharge 

Node 
Blue 

Used in conjunction with Attractor nodes to manipulate 

individual movement internal exits 

 

Attractor 

Node 
Cyan 

Used in conjunction with Discharge nodes to manipulate 

individual movement internal exits 

 
Landing Green Models free space on staircase landings 

 
Census Region Black 

Does not impact upon individual behaviour, but enables 

extraction of individual flow data. 

 
Internal Exit Red 

Models internal exits, enabling restrictions upon flow, biasing 

of potential routes and the exit availability. 

 
Source Node Grey 

Provide a means of automatically generating people during an 

EXODUS simulation, rather than generating them at the start 

of the simulation 

 

Redirection 

Node  
Purple 

Redirection nodes are decision points that allow the inclusion 

of sub-itineraries into circulating individuals during the 

simulation 

 

Direction 

node 
Purple 

Allows the user to control the direction that an evacuee is able 

to traverse the node 

 
External Exit Red 

Models exits, enabling restrictions upon flow, biasing of 

potential routes, usage and availability. These represent the 

ultimate safety location in the exit chain. 

 

3.3.1.2 Arc Generation 

Arcs are used to link the nodes together (see the Theory Manual, Sections 2.2 and 2.3). Two 

methods of generating arcs are available, Manual and Automatic.  The manual method should 

be used only when small numbers of nodes are to be connected.  For larger areas of regularly 

spaced nodes, automatic arc generation should be used. 

 

NOTE: 

In both methods of generation, the default values for the arc attributes are used.  These can be 

modified by selecting the Arc option from the Defaults menu, as well as by double-clicking on 

the Arc button. 

 

(a) Manual Arc Generation 

Shortcut: [Tools/Generate/Arc]  
To start generating arcs select Tools from the menu bar, Generate from the sub-menu and the 

Arc item from the pull-down menu (see Figure 3-2). Alternatively, simply press the Arc node 

button on the toolbar (see Figure 3-1 and Table 3-1).  
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To connect two nodes the user must click and hold the left mouse button on the starting node, 

and while holding the left mouse button down, move the pointer to the terminal node. Releasing 

the left mouse button over the terminal node will then connect the two nodes.  The attributes of 

the arc will be those specified by the default arc.    

 

(b) Automatic Arc Generation 

Shortcut: [Tools/Auto Connect] 
In order to connect nodes automatically, the nodes to be connected must first be selected using 

the SELECT tool (see Section 3.3.3.1).  The selected nodes are automatically connected by 

selecting Tools from the menu bar and the Auto-Connect option from the pull-down menu.  

From the Auto-Connect sub-menu (Figure 3-4), seven options are available for connecting the 

selected nodes: 

 

 
Figure 3-4: The Auto Connect Sub-menu 

 

1) Vertical : Connects nodes vertically 

2) Horizontal : Connects nodes horizontally 

3) Both V+H : Connects nodes both vertically and horizontally  

4) Diagonal : Connects nodes diagonally 

5) ALL : Connects nodes in all directions 

6) Door: Connects all exit nodes to the geometry 

7) Stairs and Transit Nodes: Connects stair and transit nodes to adjacent nodes 

 

Some of these modes of connection are demonstrated in Figure 3-5. 

 

     
Vertical Horizontal Both V+H Diagonal All 

Figure 3-5: Methods of connection using auto-connect 

 

The Auto-Connect tools assume that the node spacing conforms to an evenly spaced grid.  This 

may not always be the case when, for example, individual nodes may have been manually 

moved in order to match more closely the boundary as defined by an imported third party 

geometry file (i.e. DXF).  In such cases, Auto-Connect may not connect the nodes that have 

been moved, and if connection is possible, the arc length will be incorrect.  In such cases the 

Physical Distance option must be enabled.  This will ensure the correct arc length is calculated, 

according to the distance between the nodes.  To enable the Physical Distance option, select 

Tools from the menu-bar, and the Physical Dist. item from the pull-down menu.  When this 

option is enabled, all arcs drawn either manually or by the auto-connect option are assigned the 
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length attribute dependent upon the actual spacing of the surrounding nodes.  To deselect the 

Physical Dist option, repeat its selection procedure.  

Shortcut: [Tools/Physical Dist] 
 

NOTE: 

By default the Physical Dist option is enabled. 

 

TIP: 

After using Auto Connect to generate arcs throughout an area, check a sample of arc lengths 

to ensure that correct arc lengths have been determined. 

 

(c) Automatic arc length calculation 

Shortcut: [Edit/Node Align/Arcs to Physical Dist] 
If the user moves nodes that are already connected to adjacent nodes, the default setting within 

buildingEXODUS is for the arc length to remain the same; even though the physical distance 

will have changed. In order for buildingEXODUS to re-calculate the arc lengths, the user should 

select the Edit, Node Align, Arcs to Physical Dist option.  Once selected, maritimeEXODUS 

will highlight any nodes whose arcs have been modified. 

 

3.3.1.3 Automatic Generation of Boundary Nodes 

Shortcut: [Tools/Generate/Auto Boundary Nodes/Generate] 
The user is advised to place BOUNDARY nodes in places where individuals may be expected 

to preferentially avoid if possible or if forced to traverse, be expected to travel at a reduced 

travel speed.  An example of this type of movement is in the boundary region close to a wall or 

obstacle.  

 

NOTE: 

Individuals will attempt to avoid traversing Boundary nodes. When an individual is forced to 

travel over a Boundary node their speed is reduced to Walk Speed (which is by default 90% of 

their maximum Fast Walk speed). This is addressed in detail in the Theory Manual. 

 

In most cases, Boundary nodes can be automatically generated. This is achieved by selecting 

the Auto Boundary Nodes option from the Generate sub-menu.  Using this feature, the software 

examines the entire geometry searching for particular nodal formations.  A node is deemed to 

be a Boundary node if it has vertical or horizontal arcs missing from the list of connected arcs. 

The search will therefore highlight nodes in close proximity to walls or insurmountable 

obstacles within the geometry (pillars, etc.). 

 

This feature will only convert Free-Space nodes (and the nodes connected to them) into 

Boundary nodes. This is to prevent anomalies in areas that may satisfy the criteria identified 

above but are otherwise unsuitable such as around Exit nodes, Stair nodes and Seat nodes. Once 

the process is complete, the user has the ability to identify specific nodes and return them to 

free-space (or any other type of node) as described in Section 3.3.3.2. 

 

3.3.1.4 Removing and Regenerating Boundary Nodes 

Shortcut: [Tools/Generate/Auto Boundary Nodes/Remove] 
If the geometry has been altered in some way after the Boundary nodes were originally 

generated then the changed geometry may not include the correct proportion of Boundary 

Nodes. In addition, the user may not be satisfied with the Boundary nodes that have been 
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produced. In either case the user may wish to regenerate the Boundary nodes. To regenerate the 

Boundary nodes, the user should select the Remove option (as indicated in Figure 3-6, via the 

Tools menu and the Generate and Auto Boundary Nodes sub-menus) and then regenerate the 

Boundary nodes by selecting Generate from the same menu, as identified previously. 

 

 
Figure 3-6: Removing Boundary nodes. 

 

3.3.1.5 Regeneration of Boundary Lines 

Shortcut: [Tools/Generate/Regen. Boundary Lines] 
If alterations have been made to the geometry after the user has switched between Node and 

Boundary mode then the changes may not be reflected in the Boundary Line representation of 

the geometry. This will have no impact on the performance of the simulation, but may cause 

some inaccuracies in the graphical portrayal of the geometry. This problem can be rectified by 

selecting Regen. Boundary Lines from the Tools menu via the Generate sub-menu, which will 

then recalculate the Boundary lines according to any changes that have been made to the 

geometry. 

 

NOTE: 

The Boundary lines are only regenerated in the current window. 

 

3.3.1.6 Minimise Boundary Lines 

Shortcut: [Tools/Generate/Minimise Boundary Lines] 
When importing DXF files into buildingEXODUS it is quite common to find that the lines 

within the DXF files while defining the outline of the basic geometry do not do so in the most 

efficient manner possible.  Single walls are often made up from numerous lines, with lines often 

over laying one another for no apparent reason.  While this does not present a problem within 

buildingEXODUS itself it can represent a problem when a simulation is saved for vrEXODUS.  

Since there are restrictions within vrEXODUS on the number of objects (i.e. people, walls etc.) 

that can be loaded, the inclusion of large numbers of unnecessary walls within the simulation 

can result in vrEXODUS being unable to run a simulation.  Although lines can be manipulated 

manually within buildingEXODUS in order to minimise the number of lines, in reality this is a 
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tedious and time consuming undertaking.  Therefore to assist the user in this respect the 

Minimise Boundary Lines function has been included. The Minimise Boundary Lines function 

can be accessed within Geometry mode from the Generate option within the Tools menu item. 

The Minimise Boundary Lines function can be performed on specific individual geometry 

windows via the Current Window submenu item, or on all of the geometry windows via the All 

Windows submenu item (see Figure 3-7). Once the number of boundary lines have been 

minimised the user can then save the geometry.  In this manner the Minimise Boundary Lines 

functions need only ever be performed once on any given geometry.  

 

 
Figure 3-7: Minimise Boundary Lines. 

 

3.3.1.7 External Exit Generation 

Shortcut: [Tools/Generate/External Exit]  
The ultimate destination for all (surviving) individuals in buildingEXODUS is an external exit, 

represented by an External Exit node.  This is intended to represent the final point of safety for 

all individuals.  An individual who reaches an External Exit node is removed from the 

simulation and is considered “safe”.  External Exit nodes provide the seed values defining the 

potential map, enabling individuals to find a route out of the enclosure.   

 

When defining exit nodes two main aspects must be considered, these are the physical and 

performance aspects.  In GEOMETRY MODE only the physical aspects of the exit, i.e. 

connectivity is considered.  Performance aspects, such as the unit flow rate (UFR) and the exit 

availability are defined in SCENARIO Mode (see Chapter 5, Section 5.4).  In this section only 

the physical aspects are described. 
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Figure 3-8: The Door dialogue box 

 

To generate an exit node, select Tools from the menu bar, the Generate sub-menu, and then the 

External Exit item (see Figure 3-2).  Alternatively, press the Door node button on the toolbar 

(see Figure 3-1). Then, generate the External Exit by clicking on the Geometry window in the 

required position.  When this operation is complete, the Title attribute may require modification. 

The model automatically generates the Title with a number attached reflecting the sequence of 

exit generation.  The Title attribute defines the name of the exit as it appears in the geometry 

window and in output files.  To modify, double-click the exit node to get the relevant dialogue 

box (see Figure 3-8) and move the cursor to the appropriate box and modify.  Select OK to 

make the change to the exit. The model automatically generates the Title with a number attached 

reflecting the sequence of exit generation. 

 

3.3.1.8 Defining External Exit Width 

To complete the exit definition, arcs must be connected from the exit to the geometry.  The arcs 

connecting the exit are responsible for defining the width of the exit.  Each arc connected to the 

exit represents 0.5m of exit width, thus a 1.5m wide exit would require 3 connecting arcs 

(Figure 3-9). Each of these nodes provides a lane through which an occupant may have access 

to the external exit. 

 

NOTE: 

Arcs connecting exit nodes to the geometry should have a length of 0.0m. 

 

NOTE: 

The manipulation of the arc lengths connecting the nodes adjacent to an external exit will have 

no direct impact over the flow rates generated through the exit, as this is assumed to be 

calculated on a 0.5m lane basis. It will only affect the distance that the occupant may have to 

cover in reaching the exit. 
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Figure 3-9: External exit connected to three nodes, each of which is 0.5m in width 

producing an exit 1.5m wide. 

 

To delete an exit node, produce the Door dialogue box (see Figure 3-8) by double-clicking the 

exit node on the screen.  The exit can then be deleted by clicking the DELETE button. 

 

3.3.1.9 Transit Nodes 

Shortcut: [Tools/Generate/Transit Node] 
To improve the representation of occupant's performance on staircases, escalators, travelators, 

lift shaft openings, corridors and metered gates, each of these components can be represented 

as a single entity called a Transit Node (see Figure 3-10). The use of Stair Transit Nodes is 

intended to replace the use of Stair Nodes employed in previous versions of the software. Stair 

Node functionality is still available, however, it is not recommended given the advantages 

provided by the Transit Node development. Furthermore, there will be no further development 

of Stair Node functionality. Instructions describing the use of Stair Nodes can be found in 

Appendix E and is provided as a reference to allow the user to manage geometries that utilise 

this feature. It should be noted that the current staircase implementation that is based on the use 

of Transit Nodes is entirely consistent with the performance assumptions made previously. 

 

Transit Nodes are a method of simulating egress components that represent a change in the 

terrain and subsequently influence occupant movement and behaviour. Transit Nodes represent 

a range of components as a single node. This can then be configured by the user as a single 

entity to describe the performance of the agents as they traverse it. Additional functionality has 

been introduced to increase the sophistication of the associated behaviours represented 

(traversal and selection) and increase the number of components that can be represented. 

Furthermore, describing the component as a single entity allows the space used on the geometry 

to better approximate the scaled space being represented. This makes it more likely that the 

node can be positioned in the appropriate location within the geometry. This was very difficult 

to achieve for staircases that were created using the Stair Nodes. 
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Figure 3-10: The new way of representing staircase; right hand side of figure using 

transit nodes and left hand side representing standard nodal approach. Note that the 

thick green line on the staircase icons represents the top of each staircase. 

 

Irrespective of the component being described (e.g. stair, corridor, escalator, etc.), the Transit 

Node represents the space that can be occupied by more than one occupant. For instance, if the 

Staircase type is selected, this represents the staircase rather than the space taken up by the 

stairwell. This should be borne in mind by the user when determining the dimensions used. 

Although, this is different to other nodal representations with the model, no behaviours are lost; 

i.e. the occupants perform (and are recorded as performing) at the same level of detail as with 

other nodes. This approach is purely a means to simplify user activities and allow the 

component being simulated to be represented as a single entity rather than as a collection of 

nodes. Given the nature of the components being simulated, this is a much more intuitive 

approach; e.g. an escalator is thought of as a single entity, rather than a collection of moving 

risers.  

 

The advantages of using Transit Nodes over nodal representations of similar components 

implemented in previous versions of the software are: 

 

 Data can now be collected on the performance of the design components (e.g. flow 

rates,  number of people who used it during egress etc.). This is due to the 

representation of the component as a single entity.  

 Catchment areas can be generated for each design element. This enables a number of 

new behaviours including the ability of agents to identify and select between design 

elements.  

 Improved VR representation, given that all of the available information about the 

component is stored in a single entity, e.g. the dimensions of the steps. 

 A travel direction can be assigned to control people’s movement through the 

component (not relevant for lifts).  

 Simpler generation and manipulation of the design entity. For example, moving and 

rotating staircase locations. 

 The user has a choice of either using individual movement speeds or a capping flow 

rate model. This can be extremely useful depending on whether the user is interested 

in understanding the underlying occupant performance and its impact on the emergent 

conditions produced, or if the user needs to impose higher level conditions on 

component performance (as part of regulatory requirements, for instance). 
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 The ability to represent the component within the body of the geometry. The earlier 

representation of the stairs (see Appendix E) tended to require the positioning of the 

Stair Nodes outside of the main geometry (not in the actual position relative to the 

adjacent spaces), as the Stair Nodes took up more space that than the actual space 

represented.  

 

To generate a Transit Node, the user should select the Generate option via the Tools menu and 

then Transit Node as indicated in Figure 3-11 (Tools>Generate>Transit Node). The user should 

then click in the geometry window in the approximate location of the component. 

 

 
Figure 3-11: Creating Transit Nodes 

 

Once a Transit Node is generated the user can then specify the node type, rotation and attributes 

via the Transit Node dialogue box (See Figure 3-12). The Transit Node dialogue box is accessed 

by double clicking the Transit Node (see Figure 3-12 – in this case, it is the dialogue box for a 

stair).  
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 Figure 3-12: Transit Node dialogue box 

 

For each transit node type, the visual representation is illustrated in Figure 3-13. 

 

Staircase 

 

 

Escalator 

 

 

Travelator 

 

 

Corridor 

 

 

Metered Gate 

 

 

Lift Shaft 

Opening 

 

Figure 3-13: Transit node visual representation of design elements  

 

Key attributes to be determined, irrespective of the type of transit node being represented, are 

the dimensions of the node; i.e. the Width, Height, and Length. The Width applies to all of the 

node types, while the Height only applies to those that move between levels (i.e. stairs and 

escalators). The user can provide the Width of the node in metres. Given that the Transit Node 

is lane-based, with the exception of Lift Shaft Openings, the user should then provide the 

number of Lanes available and the Width of the component - the width of each Lane will then 

be determined. The first estimate for the number of Lanes will be based on the default Lane 

Width. This differs according to the type of Transit Node being represented (see Table 3-3). 
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Table 3-3: Default Transit Node Dimensions. 

Node 

Type 

No. of 

Lanes 

Default 

Lane 

Width 

(m) 

Default 

Width 

(m) 

Length 

(m) 

Lane 

Cap. 

Height 

(m) 

Tread 

Depth/  

Sub-Unit 

Length (m) 

Riser 

Height/ 

Sub-Unit 

Height (m) 

Stair 2 0.76 1.52 3.78 14* 2.942 0.270 0.196 

Escalatorx 2 0.5 1 5.6 14 1.89 0.4 0.21 
Travelator 2 0.5 1 7 14 NA 0.5 NA 

Corridor 2 0.5 1 7 14 NA 0.5 NA 

Gate 1 0.5 0.5 1 1 NA 0.5 NA 

Lift Shaft 

Openingxx 

NA NA 1.4 1.6 NA NA NA NA 

* This means that the stair by default has 14 treads (i.e. 15 risers), unless modified by the user 
x The dimensions of the escalator are derived from the default tread depth and riser heights cited 

within CIBSE [125] (i.e. 0.4 and 0.21m respectively) 
xx The dimensions of the Lift Shaft Opening are derived from those recommended within CIBSE 

[125] for a lift which has a capacity of 13 people (1000kg). 

 

For a detailed description of how to build each Transit Node type and connect the node to the 

surrounding geometry, see Section 3.8.  

 

3.3.1.10 Census Region 

Shortcut: [Tools/Generate/Census Region] 
Census Regions are designed to enable the user to retrieve information concerning important 

areas of the geometry without interfering with the behaviour of the individuals or the outcome 

of the evacuation.  By placing Census Regions within the geometry, information concerning the 

number of individuals that have passed across the Census Region, the time of the first arrival 

and the time of the last arrival, the average flow rate, the flow time, the no flow time and the 

mean non-flow statistic can be generated (the first four of these figures can be viewed via the 

Census Region dialogue box as they fluctuate during the simulation).  A Census Region 

therefore generates the same information as an internal exit.  

 

The Census Region is created by selecting the nodes to be included, using the selection tool  

and then selecting Census Region on the Generate sub-menu of the Tools menu. Once selected 

the nodes within the Census Region will turn black and will record data concerning evacuee 

movement. The nodes selected in this manner will form a single Census Region.  

 

NOTE: 

The visual appearance of the Census Region may be adjusted via the Gra. Control Options 

selected from the View menu, via the Display sub-menu. 
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Figure 3-14: An individual moving across a Census Region. 

 

The Census Region records an individual once the evacuee initially moves onto the Census 

Region. Any movement from one node within the Census Region to another node in the Census 

Region is not recorded. This therefore prevents inaccurate data being recorded, guaranteeing 

that each person is only recorded once.  In Figure 3-14 a single person has moved across the 

Census Region that is located across the geometry. Information can therefore be recorded 

concerning the person’s arrival at this location.  If the individual were to move along the Census 

Region from top to bottom, no additional record of this movement would be produced. The data 

recorded is sent to the output window and to the relevant simulation file (see Chapter 6). 

 

TIP: 

It is recommended that Census Regions are always placed in areas that are modelled using 

Free-Space nodes. By doing so, the imposition of a Census Region will not require the removal 

of a terrain type that might otherwise have influenced evacuee behaviour. 

 

3.3.1.11 Census Lines 

Shortcut: [Tools/Generate/Census Line] 
Census lines are used to collect statistics on the flow of people over a given point, represented 

by the user as a line drawn across the geometry. These can be assigned to record either 

directional or bi-directional data, according to the nature of data in which user is particularly 

interested (see Figure 3-15). As well as being slightly easier to use, the ability to distinguish 

between the direction of travel presents an advantage over the Census Region feature described 

earlier.  However, the user may wish to collect data relating to the performance of area of the 

structure in which case the Census Region may be preferable. 
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Figure 3-15:Census Line Dialogue Box 

 

From Figure 3-15 it is apparent that the Census Line has several important attributes. These 

are:- 

1) A Directional flag which controls whether evacuees are counted according to the 

direction of their travel or whether his factor is ignored. 

2) Several attributes determining the length and the exact location of the line (in metres).  

 

As with the Census Region the Census Line can dynamically generate information, as well as 

dumping relevant summary data at the end of the simulation. This data includes:- 

1) Number through (No Thr): the number of people that have crossed over the line. This is 

either bi-directional or directional depending whether the direction option is enabled. 

2) PPM: The flow rate across the line (in Persons Per Minute)  

3) First / Last: Time – Time of the  first and last person to cross the census line 

 

Note that when a Census Line is assigned as directional an additional central line is drawn on 

its icon showing the direction of data collection (see Figure 3-16). 

 

Census Lines are generated in Geometry mode by selecting Tools->Generate->Census Line. 

They are then generated in a similar way to other lines (i.e. the user left-clicks on an area within 

the geometry, holds down the button and drags out the line). Note that Census Lines can only 

be dragged or rotated if Object Lock is disabled on the Edit menu. To rotate a line/census line, 

click the right mouse button near either end of the line. The line will change colour denoting 

that it can now be rotated. If the right mouse button is now held down the line can then be 

rotated. For this to function the Edit->Object Lock option should be disabled and the Census 

Line objects should be identified as selectable in the View->Display->Gra. Ctrl. Options 

dialogue box. 
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Figure 3-16: Diagram of Census Lines (bottom) with the “equivalent” use of census 

regions (top) 

 

To display Census Lines or to be able to select them in Exodus the user must enable the 

appropriate options in the Display Control dialogue box. This can be accessed in Geometry 

mode by selecting View->Display->Gra. Ctrl Options (see Section 3.3.4.3). 

 

NOTE: 

Information displayed in the data output relates to the Census Line’s Length, Number of Lanes 

and Average Lane Width. This information is not used in the Census Line calculations, but will 

be important for subsequent developments (e.g. the representation of an Internal Exit as a line). 

Also, the exact size of the Census Line may be useful to the user in any subsequent calculations 

that the user might make.  

 

NOTE:  

Census Regions/Lines represent a relatively quick and simple way of collecting information 

during the simulation. For a more comprehensive method of collecting data, where the user 

has more computational power or where the simulation is less intensive, the user may wish to 

use Compartment Zones (see Chapter 5).  

 

3.3.1.12 Internal Exits 

Shortcut: [Tools/Generate/Internal Exit] 
Internal exits are modelled essentially as a collection of free-space nodes.  In some cases, it 

may be desirable to control the flow rate through an internal exit, or control the potential map 

within a compartment if it contains more than one internal exit. Only in these cases should the 

nodal representation be adapted. The representation of internal openings can be achieved in two 

ways. The preferred method makes use of the Internal Exit node. This approach is 

recommended as it affords the user greater flexibility and allows a more detailed output to be 

generated. This can be achieved by selecting the Internal Exit option on the Generate sub-menu 

of the Tool menu.  

 

The second method makes use of Attractor/Discharge Nodes.  Attractor/Discharge nodes are 

primarily designed to manipulate the movement of evacuees through specific areas of the 
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geometry.  It is not recommended that this method is used to represent internal exits, as 

difficulties may occur in situations requiring bi-directional flow.  

 

NOTE: 

As will be seen in Chapters 5 and 6, when used to bias the movement of people around the 

geometry, the manipulation of the Potentials associated with either Internal Exits or 

Attractor/Discharge nodes will only affect those evacuees following the Potential Map. Those 

evacuees following a Distance Map (i.e. those having a Target Exit, using the Local Familiarity 

system or following a pre-defined evacuation procedure) can still be delayed by the flow rates 

restrictions associated with the nodes but will not be influenced by changes in the Potential 

map. 

 

(i)Using the Internal Exit 

The Internal Exit facility has three main capabilities.  First it allows the potential map within a 

sub-compartment to be altered, secondly it provides a means of controlling the flow rate through 

the exit, and thirdly, it allows data concerning exit usage to be recorded. Performance aspects, 

such as the unit flow rate (the UFR attributed to the exit) and the reseeding of the potential map, 

are defined in SCENARIO mode (see Chapter 5).  In this section only the physical aspects 

relating to exits are described.  

 

 
Figure 3-17: Position of Internal exit nodes. 

 

To use this facility, the user selects the area of the geometry required to represent the internal 

exit and then selects the Internal Exit facility, located on the Generate sub-menu option on the 

Tool menu in Geometry mode. This then generates a single internal exit that consists of all the 

nodes identified. Any subsequent actions upon the constituent nodes (or any individual 

node) will then affect the entire Internal Exit. 

 

When selecting nodes to be identified as Internal Exit nodes, it is recommended that nodes 

either side of the exit opening are selected as shown in Figure 3-17.  Any delay that is incurred 

once the evacuee moves from a Free-space node to a node contained within the internal exit is 

incurred on the first movement from Free-space to an Internal Exit node.  This allows the 

Internal Exit to model evacuee movement in two directions (see Figure 3-18) inflicting a 

consistent influence over their movement. 
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Figure 3-18: Bi-directional movement between Free Space nodes and an Internal Exit. 

 

Internal exit nodes should be fully connected (i.e. vertical, horizontal and diagonal 

connectivity) placing no additional constraints upon the evacuee movement. The exact 

dimension of these arcs will not impact upon the flow rate generated through the internal exit 

as exit width is lane based.  Therefore each node is assumed to be wide enough to bear a single 

evacuee (i.e. 0.5m wide). In Figure 3-18 the exit is two lanes wide and hence is able to bear two 

evacuees simultaneously.  

 

(ii)Using Attractor/Discharge nodes 

Attractor/Discharge nodes primarily provide a means of exerting a degree of control over the 

evacuee movement across the potential map as well as a secondary method of representing 

internal exits. Attractor/Discharge nodes allow a localised potential map to be determined 

within the compartment, thus overriding the global potential map and also providing the facility 

to control the flow rate through the exit. Performance aspects, such as UFR, are defined in 

SCENARIO mode (see Chapter 5, Section 5.9.1).  In this section only the physical aspects 

relating to exits are described. 

 

 
Figure 3-19: Attractor/Discharge Nodes required for various internal exit widths 

 

As with normal Free-space nodes, by default each Attractor node and Discharge node 

represents 0.5m of space in each direction, thus a pair of Attractor/Discharge nodes is required 

for each 0.5m of internal exit width. This is shown in Figure 3-19. However, the adjustment of 

the nodal width (through manipulating arc dimensions or substituting the width of an Attractor 

node) will affect the flow rate produced. 
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To place Attractor/Discharge nodes within an internal exit, an Attractor node is placed inside 

the exit (to attract the evacuees) and a Discharge node is placed outside the exit.  This is 

illustrated in Figure 3-20.  

 

 
Figure 3-20: Example use of an internal exit, the four nodes to the left (including the two 

Attractor Nodes) are considered to be inside the compartment, while the four nodes to 

the right (including the Discharge Nodes) are considered to be outside the compartment. 

 

The simplest method to construct an internal exit is to replace existing Free-space nodes with 

the relevant Attractor/Discharge nodes.  The process of replacing node types is described in 

Section 3.3.3.2, while the specification of Attractor/Discharge node potentials is described in 

Section 5.9.1.  It is important to check that the width field in the Attractor node dialogue box is 

correct after the Attractor nodes have been placed, as this field is used in conjunction with the 

UFR field to calculate flow rates. 

 

TIP: 

There is a simple rule to follow in placing Attractor/Discharge nodes in the correct position, to 

exit a compartment, an evacuee must first be attracted to the exit. 

 

NOTE: 

Attractor nodes are connected directly to the corresponding Discharge nodes, diagonal arcs 

are NOT used. 

 

3.3.1.13 Source Nodes 

Source nodes provide a means of automatically generating people during an Exodus simulation, 

rather than generating them at the start of the simulation. To use this feature the user must 

designate a node as type Source. This can be achieved in one of two ways: either double-

clicking on a node and selecting for the Node Type pull down menu the Source option, or by 

selecting the node(s) that you wish to alter, and then selecting Substitute->Nodes from the Edit 

menu and then again selecting Source from the Node Type pull-down menu.  Once this has been 

achieved the node becomes grey in appearance.  

 

There are two ways to use Source nodes. For simple applications of the Source node, during 

Geometry mode, the user is required to specify a Start and End Generation time (Gen. Start (s) 

and Gen End (s)) plus an Interval(s) (see Figure 3-21). The Interval Time indicates the 

approximate time delay between the generation of new people (note that the units are in 

seconds). These values will result in the Source node generating random people between the 

given ranges during the simulation. This method is ideal for testing the model set-up and should 

only be used for simulations that involve very simple populations or for demonstration 

purposes. 
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Figure 3-21: Source node dialogue box in Geometry mode. 

 

For more complex and realistic situations, the user will first need to have defined the nature of 

the populations and any itineraries associated with the Source node (in Population mode). Then 

the user should move to Scenario mode on order to define the manner in which the Source node 

performs; the populations generated, the time during which the Source Node is operational, the 

rates at which specific populations are generated, etc. The user should refer to Chapter 5 and 6 

for more details on this.  Irrespective of the method used, the Source nodes are first created in 

Geometry mode. 

 

3.3.1.14 Redirection Nodes 

Redirection nodes are decision points that allow the inclusion of sub-itineraries into circulating 

individuals during the simulation. To use this feature the user must designate a node as type 

Redirection. This can be achieved in one of two ways: either double-clicking on a node and 

selecting the Redirection option from the Node Type pull down menu, or by selecting the 

node(s) that the user  wishes to alter, and then selecting Substitute->Nodes from the Edit menu 

and then again selecting Redirection from the Node Type pull-down menu.  Once this has been 

achieved the node becomes purple in appearance.  

 

The purpose of the Redirection node is to redirect individuals that have had the Redirection 

node specified as a target. This is achieved by the node having a set of itineraries associated 

with it, with associated probabilities, which passing people will inherit if they cross or approach 

the node in question. The Redirection node also has a specified range of influence (see Figure 

3-22). This range factor controls the distance from the Redirection node that people, who have 

this node as their current target, will inherit one of its itineraries. This is accessible by double-

clicking on the Redirection node, generating the Node dialogue box, where the Range attribute 

is found (the default value of this is 0.5m).  

 

NOTE:  

Any inherited itinerary is inserted in the person’s itinerary just after the redirection node from 

which the sub-itinerary was inherited (see Chapter 6).  
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Figure 3-22: Redirection Node Dialogue box in 

Scenario mode. 

 

3.3.1.15 Direction Nodes 

Direction Nodes allow the user to control the direction of travel that is available to the 

evacuating population. Through the use of Direction nodes, individuals can be forced to 

traverse a section of the geometry in a particular direction.  

 

NOTE:  

Sideways movement from a direction node to another direction node is allowed. 

 

Direction nodes function (when using both the Potential Map is selected, and the Distance Map, 

i.e. Local familiarity or Target Exits have been selected), by preventing the flow of the mapping 

system; effectively severing the ties of the geometry. This then forces the mapping system to 

only be calculated from one direction, forcing the evacuees to move in relation to the map 

calculated. 

 

The Direction Nodes appear as a purple square with a black edge on one side. The location of 

this black edge signifies the direction of movement of the evacuees in relation to the Direction 

Node (see Figure 3-23). The location of this black edge (and therefore the direction of the 

impact of the Direction node) is controlled via the Node Dir. attribute found in the Node 

dialogue box (see Figure 3-24). This is accessed by double-clicking on the Direction node. 
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Figure 3-23: Angular notation used in Direction nodes. 

 

The nodal directions are controlled using angular notation (see Figure 3-23). The angles denote 

the direction of approach that the direction node will allow. Therefore a Direction node with a 

Node Dir. of 90 will allow evacuees to use it from the east. 

 

 
Figure 3-24: The Direction Node dialogue box 

 

In Figure 3-25 Direction Nodes have been implemented to represent two adjoining corridors in 

which people move in different direction.  
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Figure 3-25: Example of direction nodes, central left, used to form two one-way 

corridors.  

 

The impact of these Direction nodes upon the spread of the Potential Map is demonstrated in 

Figure 3-26. It is apparent that in the upper corridor the potential map flows west, while in the 

lower corridor the potential map flows east. 

 

 
Figure 3-26: Potential map of above geometry. 

 

The impact that this implementation can have upon the exit usage is shown in Figure 3-27. It is 

apparent that the usage of Door 1 extends up to the location of the Direction nodes in the north 

corridor while the use of Door 2 extends up to the Direction nodes in the south corridor. 

Therefore although neither exit has been biased, the usage of them by the population is not 

entirely dependent upon their initial distance from them, and is instead reliant upon the 

restrictions placed upon their movement within the geometry. 
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Figure 3-27: Exit usage with direction nodes in place. 

 

3.3.1.16 Line 

Shortcut: [Tools/Generate/Line]  
This function allows the user to add lines on the work area. These lines can form part of the 

boundary that might be used during the Node Flood procedure. This can be achieved by 

selecting Line from the Generate sub-menu on the Tools menu. Once selected a line may be 

initiated by clicking on the work area. The mouse button should then be held down, and the line 

can then be dragged out to an appropriate location. 

 

The attributes of the Line can be altered through selecting it, giving the user access to the Line 

dialogue box (see Figure 3-28). For a Line object to be edited it must first have been made 

accessible (i.e. selectable) through either double-clicking on the  button or enabling the  

select Line tick box in the Gra. Control Options dialogue box, (through the Display sub-menu 

via the View menu). 

 

 
Figure 3-28: The attributes that may impact upon the Line object. 
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Individual lines can also be deleted and their corresponding Line dialogue boxes opened via 

right mouse button pop-up menu. This can be accessed by first moving the mouse pointer over 

the line and then clicking the right mouse button (see Figure 3-29). Users can then either open 

the lines corresponding dialogue box by selecting the Open option, or alternatively can delete 

the line by selecting the Delete option within the resulting pop-up menu.  

 

 
Figure 3-29: Manipulating a Line via the right mouse button pop-up menu. 

 

Users also have the option of splitting the line by selecting the Split option. This option 

effectively cuts the selected line in half, thereby creating two lines of the same colour and height 

as the original. This option is especially useful for creating openings in walls (i.e. doorways) 

without the need to manually create new lines. Finally users also have the option of snapping 

the ends of the selected line to neighbouring lines via the Snap Ends option. 

 

The specified height of the line will have a specific impact on the Visibility Catchment Area for 

signs and hence whether people can see the specified signs. For example, if a line is specified 

to be 3.0m high and is placed between people and an exit having a sign associated with it, the 

people may not be able to see the sign/exit. This will then impact on the occupant behaviour 

when avoiding congestion. If congestion occurs at a door and there is a 3m high line between 

people and the congestion, the people will walk to a point past the line where they can see the 

congestion before starting to re-direct. 

 

NOTE: 

When effectively creating a new geometry boundary from lines, the user must take care when 

then flooding the geometry with nodes. To initiate the Node Flooding procedure a location at 

an extremity of the newly created geometry must be selected. 

 

3.3.1.17 Polygon 

Shortcut: [Tools/Generate/Polygon]  
This feature enables the user to enhance the appearance of the model through the inclusion of 

user-defined shapes on the work area. These will have no impact on the results produced in the 

simulation. 

 

The attributes of the polygon can be altered through selecting it, giving the user access to the 

Poly dialogue box (see Figure 3-30).  For the polygon to be edited it must first have been made 

accessible (i.e. selectable) through either double-clicking on the  button or enabling the 

select Polygon tick box in the Gra. Control Options dialogue box, (through the Display sub-

menu in the View menu). 
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Figure 3-30: The attributes that may impact upon the appearance of the polygon. 

 

NOTE: 

In addition to the features available through the dialogue box, the polygon generated may also 

be moved (using the Move option on the Edit menu). This includes dragging the polygon by 

selecting the central area of the shape and deforming the shape by dragging the periphery of 

the shape. 

 

3.3.1.18 Text Label 

Shortcut: [Tools/Generate/Text Label]  
The user may wish to insert text onto the work area to assist in their understanding of the 

simulation. This can be achieved by selecting the Text Label option from the Tools menu and 

then the Generate sub-menu. 

 

  
(a) (b) 

Figure 3-31: Inserting a Text Label 

 

The attributes of the Text can be altered through selecting it, giving the user access to the Default 

Label dialogue box (see Figure 3-31(a)). For the text to be edited it must first have been made 

accessible (i.e. selectable) through either double-clicking on the  button or enabling the 

select Text tick box in the Gra. Control Options dialogue box, (through the Display sub-menu 

in the View menu). 
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3.3.1.19 Signs 

Shortcut: [Tools/Generate/Sign] 
The user can create sign objects within the model to simulate the presence of physical signs in 

a structure. For each sign placed in the geometry the user can determine the visibility of that 

sign or the visibility of a combination of signs (see Chapter 5). Furthermore, the user can 

determine the impact that signage will have to the evacuating or circulating population.  

 

The visibility of a sign is determined by calculating the Visibility Catchment Area (VCA) of the 

sign (see the Theory Manual). This area represents the physical part of the geometry where a 

sign can be seen by an individual. When calculating the VCA the heights of the internal 

obstructions are taken into account as well as an average occupant height; i.e. the obstructions 

that may impede the spread of the VCA and block the sign from view. The extent of the VCA 

depends on the following factors:  

 

 Location of the sign - this is determined by the user placing the Sign object within the 

geometry 

 Height of the sign from the floor - this directly influences the line of sight calculations 

that establish whether visibility to the sign is blocked by obstacles, etc.. By default, 

signs are assumed to be placed at 2.2m from the floor 

 Assumed maximum Visibility Termination Distance (VTD) - this determines the 

maximum reach of the VCA; i.e. it bounds the VCA. By default this is set to 30m. 

 

Both the Height and the VTD can be altered by the user once a sign is created. The model 

provides three built-in options for the VTD in addition to the default and user-defined options, 

based on the NFPA, BS 5266-4:1999 and BS5266-7:1999 standards [127-130].  Table 3-4 

describes the options available in the model.  

 

Table 3-4: The model provides several readily available options to determine maximum 

visibility distance 

 Visibility 

Termination 

Distance Model 

Use Sign Type Assumed maximum visibility 

distance 

1 

User defined User specific N/A 

User specifies maximum visibility 

distance in metres by default this is 

set to 30.0m 

2 NFPA Full level of lighting Reflective 30.0m per 15.2cm of letter height 

3 

BS 5499-4:2000 Full level of lighting 

Reflective 
13.2m per 6.6cm of graphical 

symbol height 

4 
Self illuminating 

15.2m per 6.6cm of graphical 

symbol height 

5 

BS 5266-7:1999 

Mains failure, 

emergency lighting 

available 

Reflective 
6.6m per 6.6cm of sign height 

excluding white border 

6 
Self illuminating 

13.2m per 6.6cm of sign height 

excluding white border 

 

To create a sign the user should first select from the Tools menu, the Generate item and then 

the Sign option. Then to create the sign the user should click and drag out the sign object. By 

clicking on one of the end points of the sign object the user can rotate the sign. By clicking and 
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dragging near the middle of the sign object the user can move the sign and place it on another 

location. 

 

When creating signs it is important to place them carefully within the geometry so that the VCA 

that is calculated represents the intended visibility of the Sign as accurately as possible. 

Furthermore, when creating sign objects, the tip of the Sign should lie directly on top a node 

(see Figure 3-32). This node is then used as a starting point to calculate the VCA of the Sign. If 

the Sign does not lie on a node, the node from which the VCA of the sign is generated is 

automatically selected.  

 

NOTE:  

It is advisable to intentionally place the Sign in such a way so that the sign tip will reside 

directly on top the desired node from where the VCA will be calculated. This is to ensure an 

accurate representation of the VCA.  

 

 
Figure 3-32: The composition of a sign object. The sign tip resides on a node from where 

the VCA of that sign will expand. 

 

To access and modify the attributes of a Sign the user can double click on the Sign object. This 

will display the Sign dialogue box (see Figure 3-33). When calculating the VCA of a sign the 

only attributes that influence the results produced (i.e. the size and shape of the VCA) are the 

height location (Height) of the sign, the Visibility Termination Distance (VTD) method adopted 

(user-defined, NFPA, BS 5499-4:2000, BS 5266-7:1999) and the height of the elements on the 

sign (e.g. height of letter, height of symbol, etc).  

 

The user can also modify the name label of the sign (Title), the colour of the sign object as well 

as its coordinates (Start X, Y and End X, Y). By changing the coordinates of the sign the user 

can move the sign to a different location or change the size of the sign object as it appears on 

the model window. Note that the colour of the sign only affects its representation on the model 

window and has no relation to a real sign attribute. In the current implementation the width 

(Width) of the sign is ignored. The signs within EXODUS can be either reflective or self 

illuminating. The user can specify the type of sign if the NFPA or BS VTD model is used. 

 

The extent of the VCA can be set by the user directly by modifying the VTD attribute or can be 

calculated by the model based on the height where the sign is located, the lighting conditions, 

the type of the sign selected and the VTD model used (see Table 3-4). Each one of the built-in 

VTD options corresponds to different lighting conditions and type of sign (reflective or self 

illuminating) while the extent of the VCA is calculated using a linear relationship dependent on 

the height of the constituting elements of the sign (height of letters, graphical symbols or sign 

excluding white border). 
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All VTD models assume a linear relationship between element height and observation distance. 

So for example, if the NFPA standard has been chosen, then for every 15.2cm of letter height 

on a sign the VTD will increase by 30m.  

 

 
Figure 3-33:  Double clicking on the sign object reveals the sign’s attributes 

 

NOTE:  

An obstruction will affect the VCA if it is either a boundary edge/line object, or a line of the 

appropriate height. If it is simply an area removed from the geometry, and the boundary has 

not been re-generated, the VCA will see through it (see Figure 3-34).  This can be resolved by 

re-generating the boundary lines as described in Section 3.3.1.5. 

 

NOTE:  

The actual VCA of a sign is calculated in SCENARIO MODE 

  



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 71 

 

 
(a) 

 
(b) 

 
(c) 

Figure 3-34: (a) VCA for an exit sign in a room with an area removed (b) boundary 

lines still not re-generated (c) boundary lines re-generated 
 

Signs in buildingEXODUS can be placed at arbitrary locations within a structure to relay 

information that will aid the way-finding abilities of the simulated individuals. As described in 

the Theory Manual, Section 8.2, signs can be used in two main ways. In Signage Driven 

Behaviour signs allow occupants to learn and use previously unknown exits and also allow 

occupants to follow arbitrary paths defined by the signs. In Occupant Driven Behaviour signs 

can relay information regarding locations that the occupants want to visit. In both systems the 

signage system will typically consist of a series of signs linked with each other and/or pointing 

to a final target location. 

 

In the Theory Manual, Section 8.2 the sign classification system used in buildingEXODUS was 

also described. Within the model signs are classified (referred to as the order) in relation to their 

relative position within the way-finding system and according to their relationship with the 

target of the sign. This classification includes zero order, first order and high order signs. Zero 

order signs are the signs that are located immediately above the object they are pointing to e.g. 

an exit sign located directly above a door. First order signs refer to signs that directly point to 

the target object, but are not located adjacent to that object. To be effective, it is preferable that 

first order signs lie within the VCA of the object to which they are pointing. Higher order signs 

refer to signs that point to other signs in the signage chain that are closer to the target object. A 

higher order sign always points to a sign of lower order (i.e. a fifth order sign will point to a 

fourth order sign, etc). 

 

If the user wishes to represent the visibility of a particular exit then after creating a sign object 

they can manually associate the sign with a particular exit. This is necessary if the scenario 

requires the use of the Congestion Avoidance feature (see the Theory Manual and Chapter 6). 

To associate a sign with an exit the user should select the desired exit from the Target drop 

down list which will contain all the available exits (or other signs) placed in the geometry. It 

should be noted that using this method the user can associate any sign with any exit and that 

the sign does not necessarily have to be adjacent to the exit. When creating sign objects (either 

stand alone signs or those associated with an exit) it is important to locate them accurately 

within the geometry so that the VCA that is calculated represents the intended visibility of the 

sign as accurately as possible. When associated with an exit, the signs should be placed at the 

location where the exit resides on the geometry (see Figure 3-35).  
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Figure 3-35: Sign object placed at the location of Door 1. 

 

Signs can also be used to provide information regarding previously unknown exits, to guide 

occupants within a structure, as well as to provide information regarding various key locations 

within the structure. These more advanced uses of signs are provided by the Signage Driven 

Behaviour and Occupant Driven Behaviour discussed earlier and in more detail in the Theory 

Manual, Section 8.2. Note that both models can coexist within a structure and a sign can provide 

information to the occupants using both systems.  

 

In Sign Driven Behaviour it is assumed that one sign points directly to the next sign. To create 

such a chain of signs the user has to first create the signs and then associate each sign with the 

next sign in the chain of signs. The last sign could be associated directly to an exit if the user 

wishes to guide the occupants to a particular exit or if the user wishes to allow the occupants to 

learn about previously unknown exits. If the last sign does not point to an exit then once the 

simulated occupants reach the last sign they will automatically proceed towards their nearest 

exit according to the navigation system used. The occupants will proceed either towards their 

nearest exit as defined by the potential map, or to their nearest known exit as defined by their 

familiarity with the structure. In effect, the series of signs guides the occupants by instructing 

them to adopt arbitrary paths within the structure or to learn previously unknown exits. The 

manner in which the occupant interacts with the sign is discussed in the Theory Manual and is 

configured in Simulation Mode (see Chapter 6). 

 

 
Figure 3-36: Hypothetical layout of signs that point to signs utilised by the Signage 

Driven Behaviour system 
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To associate a sign with another sign or an exit the user should access the sign’s properties by 

double clicking on the sign and then selecting the Information tab. The user can then click on 

the Target drop down list to select the target of the sign which can be another sign or an exit 

(see Figure 3-36). In the example shown in Figure 3-36 the occupant is directed from one sign 

to another (from high order to lower order) up to the point the occupant reaches the exit.  

 

In Occupant Driven Behaviour the signage system consists of a series of signs where each sign 

contains information relating to one or more targets within the structure plus the direction of 

travel towards these targets. Signs can point to any arbitrary nodal location or exit within the 

geometry. The direction towards these targets is in the form of a nodal position indicating the 

general direction that the occupants should travel in order to reach the desired target. Only 

occupants who incorporate as part of their itinerary the same target as the target contained on a 

sign can utilise this system. Other occupants will ignore this type of sign. For each target that a 

sign points to the user needs to specify a target and a direction. Both are represented as nodal 

locations (see Figure 3-37), the first represents the target that the occupant wishes to reach and 

the second indicates the initial direction towards which the occupant should travel to reach the 

first sign that could be encountered.  

 

 
Figure 3-37: Hypothetical layout of signs providing information for specific targets as 

utilised by the Occupant Driven Behaviour system. Each sign provides, for each target, 

two pieces of information: a) target location and b) initial direction of travel 

 

In the example shown in Figure 3-37 the occupant wants to visit Door 1. Each sign that the 

occupant encounters points towards Door 1 plus it also indicates the direction of travel so that 

the occupant will reach Door 1. Some signs also provide information regarding Door 2 but this 

is ignored by the occupant as their target is Door 1. 

 

To associate a sign with a target or an exit the user should access the sign’s properties by double 

clicking on the sign. New targets can be added using the Auto Insert mode or by clicking the 

Append button. If the Auto Insert check box is enabled then the user can simply click once in 

the structure to indicate the target and then once more to associate that target with the direction 

that the occupants should follow to reach that target. To associate multiple targets to a sign the 

user should repeat these two actions for each target that the sigh should point to. This would 

represent a sign that contains information regarding multiple targets such as for example in an 
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airport terminal where a sign can provide information for various gates, information points, 

exits or access to trains and buses.  

 

An alternative method of creating a target/direction pair would be by pressing the Append 

button which will create an empty target/direction pair, each part being set initially to None as 

show in Figure 3-38. If the user then selects the Auto Insert checkbox and then clicks on two 

locations within the geometry the Target and Direction parts will be set.  

 

    
Figure 3-38: User configuration of sign. 

 

To view graphically the target location and the direction of travel for each piece of information 

relayed by the sign the user can click on one of the targets and then click on the Show button. 

This will display two lines, one green and one blue. The green line indicates the Target that the 

sign points to and the blue line indicates the Direction of travel that the occupants should adopt 

to reach their target. Figure 3-39 demonstrates this functionality by showing sign S1 pointing 

to target T1 using direction of travel D1.  

 

 
Figure 3-39: The occupants want to exit via target T1 (Door 1), Sign S1 points towards 

target T1 and also indicates as direction of travel towards nodal location D1 
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To remove a Target and Direction pair the user should select the pair by clicking on the button 

representing either the Target or the Direction for removal and then click the Remove button. 

To delete all target/direction pairs on a sign the user should click the Clear button. 

 

To ensure that Occupant Driven mode functions properly, the occupants in question need to 

have appropriate itineraries assigned to them. This represents their deliberate attempt to seek 

out information from the sign for specific target locations. This is described in Chapter 5. 

 

3.3.1.20 Primary Link 

Shortcut: [Tools/Generate/Primary Link] 
By selecting the Primary Link option from the Generate menu via the Tools menu, the user is 

able to locate Primary Links on the floor (i.e. in the window) of their choice. This will then 

form one half of the mechanism by which the user can connect floors. 

 

3.3.1.21 Secondary Link 

Shortcut: [Tools/Generate/Secondary Link] 
By selecting the Secondary Link option from the Generate menu via the Tools menu, the user 

is able to locate Secondary Links on the floor (i.e. in the window) of their choice. This will then 

form one half of the mechanism by which the user can connect floors. The Link function 

operates as a queuing system. Therefore a number of primary links could be generated prior to 

the first secondary link. Once generated, the (first) secondary link would automatically be 

associated with the primary link at the head of the ‘queue’ (i.e. the first generated). 

 

3.3.1.22 Ruler 

Shortcut: [Tools/Ruler] 
If the user wishes to determine the scale of the actual dimensions of the geometry, then the 

Ruler function can be used. This is accessed via the Tools menu and then selecting the Ruler.  

 

 

 

 

 

 

(a) (b) 

Figure 3-40: (a) The appearance of the Ruler on the work area. (b) The results of the 

Ruler facility on the Toolbar. 

 

Once selected, the user must click on the location that the measurement starts on the work area. 

Whilst keeping the mouse button depressed, the user should then move the pointer to the 

location depicting the end of the measurement (see Figure 3-40(a)). The result should then 

appear next to the toolbar at the top of the screen (see Figure 3-40(b)). 
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3.3.2 Geometry Defaults 

Shortcut: [Defaults/Door] / [Defaults/Node] / [Defaults/Arc] 
When Nodes, Arcs and External Exits (i.e. Doors) are generated in the geometry window, the 

initial values of their attributes are defined by their default values (see the Theory Manual, 

Sections 2.3, 2.4 and 7.2). To change these default values, select Defaults from the menu bar 

and the geometry item you wish to change i.e. Node, Arc or Door, from the pull-down menu. 

A dialogue box will then be displayed enabling the default settings for the selected type to be 

edited (see Figure 3-41a-c).  

 

After modifying the default values for a particular object, buildingEXODUS must be informed 

that the changes are complete.  In each default dialogue box, the OK button applies the new 

default values and removes the dialogue box from the screen.  The APPLY button also applies 

the new defaults but leaves the dialogue box on the screen.  This is particularly useful when 

frequent changes are required, for example when connecting arcs of different lengths. 

 

 

 

 

 

 

 

(a) 

 

 

 

 

 

 

 

 

(b) 

 

 

 

 

 

 

 

 

 

(c) 

Figure 3-41: Default arc dialogue box for (a) arcs, (b) nodes and (c) 

exits 
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3.3.3 Edit Menu 

The Edit menu contains functions that operate on entities that are already in existence. The 

functions therefore concern the removal, manipulation, replication or selection of existing 

entities (nodes, arcs, etc.). The following sections concern functions from the Edit menu. 

 

3.3.3.1 Selecting nodes/arcs/boundary lines. 

In order to perform any operations on objects (nodes, arcs etc), buildingEXODUS must first be 

informed which object(s) to operate on (see Figure 3-42).  This can be accessed from selecting 

Gra. Ctrl Options from the Display sub-menu via the View menu or by double-clicking on the  

 button (see Section 3.3.4.3.1).  

 

Two methods are then available to select the objects.  The method used depends on the number 

of objects to be selected and the regularity of the objects (in the grid). 

 

(a) Selecting Individual or Small Groups of Objects 

To select a single object, simply click on the object with the left mouse button after the Select 

tool has been enabled. To show the user the object is selected, it becomes highlighted – see 

Figure 3-42. 

 

 
Figure 3-42: Selecting a node with a single click 

 

NOTE: 

Objects selected in this manner may only be selected individually, i.e. any other objects 

previously selected become de-selected. 

 

To form a group of selected objects, the CTRL key can be pressed during this process (see 

Figure 3-43).  

 

 
Figure 3-43: Several selected nodes 

 

TIP: 

When selecting objects individually, zoom in (see Section 3.3.4.5) on the area of interest. 
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(b) Selecting Regular or Large Groups of Objects 

This method allows a rectangular rubber-band to be dragged around the objects of interest.  All 

objects contained within this area become selected (thus highlighted). 

 

 
Figure 3-44: Selecting a group of nodes 

 

To perform this action, the Select menu should be chosen via the Edit menu and then the Rubber 

Band Select tool must be enabled (see Figure 3-44).  The rubber-band is then formed by 

pressing the left mouse-button and dragging the mouse whilst still holding the button down.  

When the required region is drawn, simply let go of the mouse button and the process is 

complete, Figure 3-45 demonstrates this process. 

 

  
Figure 3-45: Rubber band selection 

 

NOTE: 

It is possible to select multiple regions using the rubber band method by holding down the 

control key before dragging the mouse over a new region. 

 

The second method that may be employed to select multiple objects is to select Polygon Select 

from the Select sub-menu via the Edit menu (see Figure 3-45).   This will allow the user to 

select irregular configurations of objects, by clicking on the appropriate locations and dragging 

out the constituent boundary lines of the polygon. To complete this process the initial and 

ultimate points must coincide (forming an enclosed polygon), and the user should double-click 

on the coincident point (see Figure 3-46). 
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Figure 3-46: Irregular group of nodes selected using the Polygon Selection option. 

 

(c) Selecting Boundary Lines  

Double click on the Select icon in the toolbar to display the Display Control dialogue box 

(Figure 3-47). The user is able to select individual lines, either from an imported third party 

geometry file (i.e. DXF, IFC, FDS or SMF) or from a geometry shown in Boundary mode. By 

doing so, the user is able to Delete, Edit or Move the selected line by clicking on lines and 

bringing up the Line dialogue box (see Figure 3-48). This allows the user to manipulate the 

underlying structure of imported third party geometry files. 

 

 
Figure 3-47: The Display Control dialogue box. 

 

The user may also select a collection of Boundary Lines. This is achieved by previously 

selecting the Boundary Line option from the Selectable list and then dragging out a box around 

the appropriate Boundary Lines. These may then be manipulated.  
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Figure 3-48: Line dialogue box  

 

TIP: 

The Select Boundary Line feature is particularly useful when adapting geometries for use with 

vrEXODUS. This feature may be used to assist in the removal of certain sections of the geometry 

in order to aid in the presentation of simulations using vrEXODUS. For instance, the user may 

wish to delete lines located across the locations where individuals leave the geometry to 

improve the graphical appearance of the VR model. 

 

(d) Selecting Queues 

Queuing systems, including servers and routes (constructed using several waypoints defining 

the way to a server), are created within Scenario mode. The server locations for queues can be 

viewed within any mode, including Geometry mode. In order to view queuing locations, the 

standard procedure should be followed by selecting Gra. Ctrl Options from the Display sub-

menu of the View menu and selecting the queue display check box. Servers will be represented 

as shown within Figure 3-49. The route to servers can not currently be displayed within 

buildingEXODUS. It is also worth noting that enabling queues to be selectable within any mode 

does not mean that they can be moved within any mode. By default servers can only be 

moved/relocated within the Scenario mode. 

 

 
Figure 3-49: Five queue servers displayed within simple square room 
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3.3.3.2 Object Attribute Substitution 

Shortcut: [Edit/Substitute] 
To modify the attributes of a group of selected nodes, exits, arcs or lines, select Edit from the 

menu bar and the Substitute item from the pull-down menu (see Figure 3-2). Next, select the 

required type (Nodes, Doors, Arcs, Lines) from the Substitute submenu (see Figure 3-50). A 

dialogue box is then displayed, and the user then specifies the values they wish to apply to the 

group of selected items, for example the length of a group of arcs. When the values are modified 

correctly, click the OK button to apply the values to the selected items, or click the CANCEL 

button to abort the operation. 

 

 
Figure 3-50: The Substitute sub-menu. 

 

3.3.3.3 Object Deletion 

Shortcut: [Edit/Delete/] 
To delete the currently selected nodes, go to the Edit menu and select Node from the Delete 

sub-menu (see Figure 3-51).  
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Figure 3-51: Selection of the Delete function. 

 

(i) Delete Arcs  

Shortcut: [Edit/Delete/Arc] 
To delete the arcs between selected nodes, select Edit from the menu bar and the Arc item from 

the Delete pull-down sub-menu (see Figure 3-2).  The delete arcs sub-menu then presents four 

options, All (delete all arcs), Horizontal (delete horizontal arcs), Vertical (delete vertical arcs) 

and Diagonal (delete diagonal arcs) (see Figure 3-51). 

 

(ii) Deleting Lines 

Shortcut: [Edit/Delete/Line] 
To delete lines either from an imported third party geometry file (i.e. DXF, IFC, FDS or SMF) 

or from the generation of the outline of a geometry in Boundary mode, the user is required to 

select the desired line. This is achieved by the user double-clicking on the appropriate line, 

which will then be selected. The LINE dialogue box will appear enabling the user to delete the 

line (see Figure 3-48). Alternatively the line in question can be selected and then the user can 

go to the Edit menu and select Line from the Delete sub-menu. 

 

(iii) Deleting Nodes 

Shortcut: [Edit/Delete/Node] 
To delete nodes first ensure that they are selected within the geometry window. The nodes (and 

the corresponding arcs connecting them) can then be deleted by selecting Edit from the menu 

bar and the Node item from the Delete pull-down sub-menu (see Figure 3-2). Alternatively the 

nodes can be deleted by simply pressing the Delete button on the keyboard. 

 

3.3.3.4 Copying Objects 

Shortcut: [Edit/Copy] 
To copy the currently selected objects within the geometry window (i.e. nodes, lines, polygons 

etc.), select Edit from the menu bar and the Copy item from the pull-down menu (see Figure 

3-2). The currently selected objects can also be copied by simply pressing the CTRL-C buttons 

on the keyboard. 

 

Alternatively, users can also copy the currently selected objects via the right mouse button pop-

up menu. This can be accessed by first moving the mouse pointer to a clear area in the geometry 
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window (i.e. ensuring that the mouse pointer is not positioned over an object such as a node, 

line etc.) and then clicking the right mouse button. Users can then select the Copy option within 

the resulting pop-up menu (see Figure 3-52). 

 

 
Figure 3-52: Copying the currently selected objects via the right mouse button pop-up 

menu 

 

NOTE: 

Selecting the Copy function will automatically disengage the Object Lock. 

 

3.3.3.5 Cutting Objects 

Shortcut: [Edit/Cut] 
To remove the currently selected objects within the geometry window (i.e. nodes, lines, 

polygons etc.) and store them to memory for later pasting, select Edit from the menu bar and 

the Cut item from the pull-down menu. The currently selected objects can also be cut by simply 

pressing the CTRL-X buttons on the keyboard. 

 

Alternatively, users can also cut the currently selected objects via the right mouse button pop-

up menu. This can be accessed by first moving the mouse pointer to a clear area in the geometry 

window (i.e. ensuring that the mouse pointer is not positioned over an object such as a node, 

line etc.) and then clicking the right mouse button. Users can then select the Cut option within 

the resulting pop-up menu (see Figure 3-52). 

 

3.3.3.6 Pasting Objects 

Shortcut: [Edit/Paste] 
To paste the objects (i.e. nodes, lines, polygons etc.) that are currently in memory into the 

geometry window, select Edit from the menu bar and the Paste item from the pull-down menu. 

The objects currently in the memory can also be pasted into the geometry window by simply 

pressing the CTRL-V buttons on the keyboard. 

 

If the user pastes the objects currently in the memory into a different geometry window from 

that in which they were originally copied then the pasted objects will be simply be placed in the 

same corresponding position as the objects from which they were copied (i.e. the copied objects 

will be pasted in the same x-y coordinates as the original objects). If however the user pastes 

objects into the same geometry window as the objects from which they were originally copied 

then the pasted objects will instead simply be offset in both the x and y directions (see Figure 

3-53). 
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(a) (b) 

Figure 3-53: a) The selected objects copied into memory, and b) the objects pasted into 

the same geometry window. 

 

Alternatively, users can also paste the currently selected objects in the memory at a specific 

location within the geometry window via the right mouse button pop-up menu. This can be 

accessed by first moving the mouse pointer to the clear location within in the geometry window 

at which the user wishes to paste the objects (i.e. ensuring that the mouse pointer is not 

positioned over an object such as a node, line etc.) and then clicking the right mouse button. 

Users can then select the Paste option within the resulting pop-up menu (see Figure 3-54(a)).  

A copy of the objects currently in the memory will then be pasted within the geometry window 

at the mouse location (see Figure 3-54(b)). 

 

  
(a) (b) 

Figure 3-54: Pasting the currently selected objects in the memory at a specific location 

via the right mouse button pop-up menu 

 

In all cases, any objects pasted into a geometry window will automatically be selected. Users 

can then left click with the mouse on one of the selected objects and, while holding the mouse 

button down, simply move the selected objects to their desired location within the geometry 

window. 

 

It is important to note that if the Node Snap function is enabled (see Section 3.3.3.11) any 

objects pasted will automatically be snapped the underlying grid. Users therefore wishing to 

copy and paste objects which are not snapped to the grid should ensure that the Node Snap 

function is disabled prior to pasting to ensure that the position of the objects relative to one 

another is maintained. 
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3.3.3.7 Move To Window 

Shortcut: [Edit/Move To Window] 
To move objects (i.e. nodes, lines polygons etc.) from one window to another, first select the 

objects within their current window. Then select Edit from the menu bar and the Move To 

Window item from the pull-down menu. Upon selecting this option the Window Selection 

dialogue box will be displayed asking the User which window they wish to move the selected 

objects to (see Figure 3-55(a)). Within this dialogue box the user has the ability to select the 

target window by selecting it from the complete list of windows provided within the Window 

list box (see Figure 3-55(b)). Once the target window has been selected the user merely needs 

to click the OK button to confirm the change. Upon confirming the change the selected objects 

will then be removed from their original window and copied into the selected window. It is 

important to note that the position of the objects within the new window will be the same 

location as they were within the original window. Hence if a node was at x-y location 19.5, 20.0 

in its original window it will similarly be positioned at this location within the new window. 

 

  
(a) (b) 

Figure 3-55: Moving objects from one window to another 

 

NOTE: 

The Move To Window function is only available if more than one window exists within the 

current geometry. If only a single window exists the Window Selection dialogue box will not be 

shown in the manner outlined previously, and hence selecting the Move To Window option will 

appear to have no effect. 

 

3.3.3.8 Rotation 

Shortcut: [Edit/Rotate/] 
To rotate the currently selected nodes (and connecting arcs), select Edit from the menu bar and 

the Rotate item from the pull-down menu (see Figure 3-2). Then select the required option from 

the Rotate submenu (see Figure 3-56a).  The three options allow the selection to be rotated 

through 90, 180, 270 or a user specified angle in the clockwise direction.  The latter option 

presents another dialogue box prompting the user to specify the angle of rotation (see Figure 

3-56b and Figure 3-56c).  Using this dialogue box, any angle may be specified.  Clicking the 

ENTER button rotates the selection through the specified angle.  The rotation may be aborted 

by clicking the CANCEL button. 
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(a) (b) (c) 

Figure 3-56: Rotating a selected group of objects (a) the rotate sub-menu, (b) the 

rotation angle dialogue box, and (c) results of rotation by 90 

 

3.3.3.9 Replication 

Shortcut: [Edit/Replicate/] 
The Replicate command copies a section of geometry n times in a given direction and if 

possible, automatically connects these sections together. To replicate the selected region, select 

Edit from the menu bar and the Replicate item from the pull-down menu (see Figure 3-2). Then 

select the replication direction from the Replicate sub-menu (Figure 3-57a).  A dialogue box 

will then be presented, prompting the user to specify the number of replications (see Figure 

3-57b). Clicking the ENTER button replicates the selection in the specified direction.  The 

replication may be aborted by clicking the CANCEL button.  Figure 3-57 shows a selected 

group of nodes that have been replicated to the right five times. 
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(a) (b) 

 
(c) 

Figure 3-57: Replicating a selected group of objects, (a) the replicate sub-menu, (b) the 

replication dialogue box,  and (c) result of replication. 

 

NOTE: 

Once the replication process is complete the user should examine the area of replicated nodes 

to determine whether they are satisfied with their connectivity. 

 

3.3.3.10 Mirror 

Shortcut: [Edit/Mirror/] 
The Mirror function rearranges the selection into a mirror image. To mirror the selected region, 

select Edit from the menu bar and the Mirror item from the pull-down menu (see Figure 3-2). 

Then select the mirror direction from the Mirror submenu (Figure 3-58).   
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Figure 3-58: The Mirror sub-menu 

 

The options presented on the Mirror submenu are: 

 

X : mirror X position of selection about the Y axis 

Y : mirror Y position of selection about X axis 

Both : mirror X and Y positions of selection about the axes 

 

Figure 3-59 demonstrates the Mirror function. 

 

    
(a) (b) (c) (d) 

Figure 3-59: Mirroring a simple geometry, (a) Original geometry, (b) mirror in X , (c) 

mirror in Y, and (d) mirror in both X and Y 

 

3.3.3.11 Node Align 

Shortcut: [Edit/Node Align/] 
Numerous node manipulation functions can be selected from the Node Align sub-menu (see 

Figure 3-60). These functions are concerned with the exact placement of the nodes in relation 

to each other. 
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Figure 3-60: The Node Align sub-menu 

 

(i) Coincide  

Shortcut: [Edit/Node Align/Coincide] 
The Coincide function identifies nodes within the selection that are covering other nodes (also 

within the selection).  It has the effect of nudging the covering node(s) downward and to the 

right. To perform this action on a selection, select Edit from the menu bar, the Node Align sub-

menu and the Coincide item from the pull-down menu (see Figure 3-2 and Figure 3-60).  Figure 

3-61 demonstrates the Coincide function. 

 

(ii) Coincide and Delete 

Shortcut: [Edit/Node Align/Coincide and Delete] 
The Coincide and delete function identifies nodes within the selection that are covering other 

nodes like the Coincide function outlined previously, however instead of nudging the covering 

node(s) this function merely deletes them. To use the Coincide and delete function, select Edit 

from the menu bar, the Node Align sub-menu and the Coincide and delete item from the pull-

down menu (see Figure 3-2). 

 

 
Figure 3-61: (a) Two nodes occupying the same space, (b) result of Coincide function 

 

(iii) Node Snap  

Shortcut: [Edit/Node Align/Node Snap]  
This function forces the placement of nodes to a rigid grid.  If this option is used before any 

nodes are placed into the geometry window, the function Snap Smooth is not required (see 

Section (v) below). To use the Node Snap function, select Edit from the menu bar, select the 

Node Align sub-menu, and then the Node Snap item from the pull-down menu.  To remove the 

Node Snap function, repeat this process.  By default, this option is selected. 

 

TIP: 

Node Snap is a recommended option.  
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(iv) Smooth  

Shortcut: [Edit/Node Align/Smooth] 
This function is similar in essence to Snap Smooth.  In this case, any nodes in the selection are 

aligned according to their connections i.e. any non-horizontal or non-vertical arcs in the 

selection, are made horizontal or vertical by moving the relevant nodes in the required direction. 

To perform this action on a selection, select Edit from the menu bar the Node Align sub-menu 

and the Smooth item from the pull-down menu (see Figure 3-2). Figure 3-62(a) and Figure 

3-62(c) demonstrate the Smooth function. 

 

(v) Snap Smooth 

Shortcut: [Edit/Node Align/Snap Smooth] 
This function forces the selected nodes to conform to a regular grid spacing.  To perform this 

action on a selection, select Edit from the menu bar, the Node Align sub-menu and the Snap 

Smooth item from the pull-down menu (see Figure 3-2).  Figure 3-62a and Figure 3-62b 

demonstrate the Snap Smooth function. 

 

TIP: 

Use snap smooth regularly to produce evenly spaced grids.  Snap smooth is often more useful 

than smooth. 

 

  
 

(a) (b) (c) 

Figure 3-62: Smoothing functions (a) original selection, (b) results using snap smooth 

and (c) result using smooth 

 

(vi) Arcs to Physical Dist 

Shortcut: [Edit/Node Align/Arcs to Physical Dist] 
Within buildingEXODUS the length of the arc connecting two nodes is typically manually 

defined by the user (i.e. if Physical Distance is disabled) or alternatively automatically 

calculated based upon the distances between the centres of the respective nodes (i.e. if Physical 

Distance is enabled). If the user moves nodes that are already connected to adjacent nodes, by 

default the arc length between the two nodes will remain the same; even though the physical 

distance between the two nodes will have changed. In order for buildingEXODUS to re-

calculate the arc lengths, the user should first select both the connected nodes and then select 

the Edit, Node Align, Arcs to Physical Dist option. Once selected this function will 

automatically recalculate the arc lengths between any selected nodes based upon the physical 

distance that exists between the centres of the two nodes. In addition, the nodes connected to 

modified arcs will be highlighted. It is important to note that arcs will only be recalculated 

between selected nodes. Hence if a region is selected, the arcs connecting nodes outside the 

region to nodes within the selected region will not be recalculated since both nodes were not 

selected.  
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3.3.3.12 Scaling Lines 

Shortcut: [Edit/Scale/Lines] 
This function enables the user to scale ALL the current lines within the geometry in order to 

make their respective lengths match some predetermined dimensions. This functionality is 

particularly useful when importing DXF files, the units of which are not known, but the length 

of whose walls are known within the overall structure (i.e. from plans/measurements etc.).  In 

order to scale the lines, select Edit from the menu bar and the Scale option from the resulting 

menu. The user should then select the Lines option within the resulting sub-menu. Once 

selected, the user will then be prompted to enter both an X and Y scale factor.  This enables the 

structure defined by the lines to be scaled differently in the X and Y axis. Once defined the X 

and Y co-ordinates of the ends of each line will then be recalculated by simply multiplying their 

respective X co-ordinates by the defined X scale factor, and their Y co-ordinates by the defined 

Y scale factor. Hence scale factors of 1.0 correspond to no change within the respective co-

ordinate. Consequently all lines are scaled relatively to the origin (i.e. 0,0) which corresponds 

to the top left hand corner of the geometry window.  Having scaled the lines defining the walls 

of a given structure the user is encouraged to check that the lines have been scaled correctly by 

using the Ruler function (see Section 3.3.1.22).  In this manner the lengths of lines can be 

measured and directly compared to corresponding walls of known length, thereby determining 

whether or not the dimensions of the structure within buildingEXODUS matches the 

dimensions of the structure derived from plans, measurements etc. 

 

3.3.3.13 Object Lock 

Shortcut: [Edit/Object Lock]  
This function controls the user’s ability to move objects (i.e. nodes, exits, lines, polygons etc.) 

within the geometry. To move objects, either select Edit from the menu bar and deselect the 

Object Lock item from the pull-down menu (see Figure 3-2), or alternatively deselect the Object 

Lock button on the toolbar. Having deselected the Object Lock the user can then move the 

mouse pointer to an object, click the left mouse button to select the object, and while holding 

the left mouse button down drag the selected object to a new location.  Releasing the mouse 

button will complete the move. Conversely, when selected this option prevents objects from 

being moved. This function therefore acts as a safeguard against the accidental relocation 

objects within the geometry window and aids the process of manipulating objects. By default, 

Object Lock is selected. 

 

NOTE: 

Deselecting the Object Lock in the manner defined above does not necessary mean that users 

will instantly be able to move objects of any type within the geometry, since only objects of the 

types defined as being selectable within the Display Control dialogue box can be selected and 

hence moved (see Section 3.3.3.1).  

 

3.3.3.14 Undo 

Shortcut: [Edit/UNDO]  
If the user makes a mistake in any of the operations available from within the model, it can be 

undone by selecting the UNDO function from Edit menu. Selecting this function will remove 

the last operation performed. The list of available operations to undo are displayed in the Data 

Output Window’s Summary tab. The last operation that can be undone is at the top of this list. 
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Users can also undo their previous actions via the right mouse button pop-up menu. This can 

be accessed by first moving the mouse pointer to a clear area in the geometry window (i.e. 

ensuring that the mouse pointer is not positioned over an object such as a node, line etc.) and 

then clicking the right mouse button. Users can then simply select the Undo option within the 

resulting pop-up menu.  In each case the next action to be undone is appended to the end of the 

Undo option within the pop-up menu, thereby giving the user an indication of exactly what 

action they are undoing (i.e. Undo Cut, see Figure 3-63). 

 

 
Figure 3-63: Undoing a previous action via the right mouse button pop-up menu 

 

3.3.4 The View Menu 

The View menu has several functions that control the manner in which the geometry is displayed 

in the Geometry window (see Figure 3-2). A number of these functions apply in all modes of 

operation but only those most applicable to the geometry mode are discussed in this section. 

 

3.3.4.1 Redraw 

Shortcut: [View/Redraw]  
Occasionally after many operations, a geometry window may become cluttered with extraneous 

graphics.  The Redraw function corrects this.  To operate the Redraw function, select View from 

the menu bar and the Redraw item from the pull-down menu. 

 

3.3.4.2 Boundary 

Shortcut: [View/Boundary]  
The function of the Boundary command is to allow the outline of the current geometry to be 

drawn.  The way in which the boundary is constructed makes this a useful tool to detect missing 

arcs.  A Boundary line is only drawn around two nodes if they are linked with an arc.  Figure 

3-64 demonstrates how this works.  To use the Boundary function, select View from the menu 

bar and the Boundary item from the pull-down menu.  To remove the Boundary function, repeat 

this process. 
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Figure 3-64: Effect of Boundary function on geometry window 

 

TIP: 

Always go to Boundary mode when the geometry has been fully specified. 

 

NOTE: 

The user has control over the type of nodes that are visible during the simulation process. This 

is particularly useful if the user wishes to demonstrate the results in a presentation involving 

the playback of the simulation (see Chapter 6). 

 

NOTE: 

If the user changes the nodal layout they should regenerate the boundary by selecting Regen. 

Boundary Lines from the Generate sub-menu via the Tools menu to update the boundary. 

 

NOTE: 

This process can also be useful for detecting missing arcs. However this option is only available 

if an automatic boundary is used rather than a boundary generated by importing a third party 

geometry file (i.e. DXF, IFC, FDS or SMF). 

 

3.3.4.3 Display 

 

3.3.4.3.1 Selecting Objects. 

Shortcut: [View/Display/Gra. Control Options]  
In order to perform any operations on objects (nodes, arcs etc), buildingEXODUS must first be 

informed which object(s) to operate on.  This can be accessed by selecting Gra. Ctrl Options, 

through the Display sub-menu via the View menu. The user is then able to start Selecting the 

object(s) according to their requirements by flagging which objects are selectable (see Figure 

3-65).  The user is also able to gain access to this dialogue box through double-clicking on the 

 button. 
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Figure 3-65: The Display Control dialogue box. 

 

The user is also able to determine which objects are visible on the screen from this screen 

through the Display check boxes.  

 

This dialogue box enables the user to move targets within the geometry that will influence the 

performance of either individual occupants or procedures (once the user has proceeded to 

Simulation mode and have begun the simulation). When an itinerary is created, the user is 

required to specify a number of target points towards which individuals will head and which 

combine to form the overall itinerary (see the Theory Manual and Chapter 4). These individual 

target points from which the itinerary is formed, can be moved by the user, once the itinerary 

has been created. To do this the user must return to Geometry Mode. The user should then 

double-click on the select button  to gain access to the Display Control dialogue box. Here 

the user should allow the Target Points to be displayed and selectable and disable the 

selectability of nodes. This will prevent the user accidentally moving some of the underlying 

nodal mesh.  

 

Once this has been achieved the target points that constituted the itineraries that had previously 

been created should be visible (see Figure 3-66). Before manipulating the Target Point location, 

the user should ensure that the Object Lock option has been disabled in the Edit menu, whilst 

in Geometry Mode. If this has not been completed, then the user will not be able to move the 

Target Points.  

 

These target points can then be selected by a single click, which will cause the target point to 

change colour. At this point the user can drag the target point to their desired location (see 

Figure 3-66). This change in the location of the target point will influence the itinerary that is 

dependent upon the moved target point. 
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(a) (b) 

Figure 3-66: Change of location of a target point. 

 

3.3.4.3.2 Selecting Arcs/Nodes 

To select an object the Select tool must be enabled.  This can be achieved via the dialogue box 

shown in Figure 3-2 or by double-clicking the SELECT button on the toolbar (see Figure 3-1). 

 

Two methods are then available to select the objects.  The method used depends on the number 

of objects to be selected and the regularity of the objects (in the grid). 

 

(i) Arcs 

Shortcut: [View/Display/Arcs] 
This function allows arcs in a selected area to be viewed.  This function only works when the 

display of Arcs are disabled or when the Boundary function is switched on.  To use this function, 

the area of interest must first be selected (see Section 3.3.3.1).  To view the arcs in a selected 

region, select View from the menu bar, the Display sub-menu and then finally the Arcs item 

from the pull-down menu.  Arcs displayed in this manner will disappear when a mode change 

occurs or when a simulation is started. 

 

(ii) Nodes  

Shortcut: [View/Display/Nodes] 
This function allows nodes in a selected region to be viewed.  This function is only applicable 

when the geometry is being viewed in Boundary mode (see Section 3.3.4.2) or with an imported 

third party geometry file (i.e. DXF, IFC, FDS or SMF, see Section 3.4). To use this function, 

the area of interest must first be selected (see Section 3.4).  To view the nodes in a selected 

region, select View from the menu bar the Display sub-menu and then finally the Nodes item 

from the pull-down menu. The nodes will disappear when a simulation is started. 

 

3.3.4.3.3 Viewing Imported Geometry files 

Shortcut: [View/Display/Imported Lines] 
The user has the option to include boundaries imported from third party geometry files in the 

graphical output of the model (i.e. DXF, IFC, FDS or SMF), or allow the model to generate its 

own geometry boundary. This may be useful for highly detailed imported geometry files 

(particularly DXF files) or files which include a large amount of unnecessary detail. This 

process should only be attempted once the floor has been flooded with nodes (see Section 3.4.7).  
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The display of the imported geometry file boundaries can be enabled or disabled by selecting 

View from the menu-bar, the Display sub-menu and finally the Imported Lines option from the 

pull-down menu. 

 

As can be seen from Figure 3-67 the appearance of the geometry is less satisfactory when the 

imported third party geometry file boundary (i.e. DXF) is removed, as this reflects the 

underlying nature of the nodal mesh. 

 

  
(a) (b) 

 

Figure 3-67: (a) The imported third party geometry file boundary (DXF) is visible. (b) 

The imported third party geometry file boundary can no longer be seen and 

buildingEXODUS has generated its own boundary. 

 

However, in imported third party geometry files where the boundaries are more linear, the 

difference between the appearance of the geometry with and without the imported boundaries 

included may be less obvious. 

 

3.3.4.3.4 Show All Imported Lines 

Shortcut: [View/Display/Show All Imported Lines] 
This enables the user to view all of the imported third party geometry file boundaries in the 

current geometry. This is available by selecting View from the menu bar, the Display sub-menu 

and finally the Show All Imported Lines option from the pull down menu. 

 

3.3.4.3.5 Hide All Imported Lines 

Shortcut: [View/Display/Hide All Imported Lines] 
This option disables the display of all imported third party geometry file boundaries across all 

of the windows that exist. This is available by selecting View from the menu-bar, the Display 

sub-menu and finally the Hide All Imported Lines option from the pull-down menu. 
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3.3.4.4 Find 

 

3.3.4.4.1 Find Person 

Shortcut: [View/Find/Person] 
The Find Person function enables the user to trace the exact location of a specific person. Each 

person has a unique identifying number that is automatically generated by the model. This 

number can be found by examining the Label text box in the PERSON dialogue box (see Figure 

3-68).  

 

 
Figure 3-68: The Unique Person Label highlighted in the Person dialogue box. 

 

The Find Person function works by identifying the exact location of a person through the 

person’s Label. Once Find Person has been selected (by selecting View from the menu, the 

Find sub-menu and then the Person option), the user is asked to supply the Label number for 

the required person. This may be useful, for instance, in locating the exact position of an 

individual during the simulation. 

 

 
Figure 3-69: The Enter Person ID dialogue box.  

 

Once the number has been provided in the ENTER PERSON ID dialogue box, the function will 

search the entire geometry to locate the desired person (see Figure 3-69). Once found the person 

will be highlighted, with a black square appearing around the node in question (irrespective of 

whether the model is in Boundary mode or whether the nodes appear on the screen). In addition, 

the window containing the highlighted person will be automatically opened, its corresponding 

zoom level reset and the window centred on the highlighted person to allow the area in which 

the person is located to be shown.  
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NOTE: 

If the person has either died or successfully evacuated then they will be unable to be located. 

 

3.3.4.4.2 Find Node 

Shortcut: [View/Find/Node] 
The Find Node function enables the user to trace the exact location of a specific node. Each 

node has a unique identifying number that is automatically generated by the model. This 

number can be found by examining the Label text box in the NODE dialogue box (see Figure 

3-70).  

 

 
Figure 3-70: The Unique Nodal Label highlighted in the Node dialogue box. 

 

The Find Node function works by identifying the exact location of a node through the node’s 

Label. Once Find Node has been selected (by selecting View from the menu, the Find sub-menu 

and then the Node option), the user is asked to supply the Label number for the required node. 

This may be useful, for instance, in specifying the exact location of an evacuee’s task. 

 

NOTE: 

When providing the nodal Label that is to be searched for, any two-letter prefix denoting nodal 

type that might be evident (in the Evacuee’s Itinerary List, for instance) should be omitted. 

 

 
Figure 3-71: The Enter Node ID dialogue box. 

 

Once the number has been provided in the ENTER NODE ID dialogue box, the function will 

search the entire geometry to locate the desired node (see Figure 3-71). Once found the node 

will be highlighted, with a black square appearing around the node in question (irrespective of 

whether the model is in Boundary mode or whether the nodes appear on the screen). In addition, 

the window containing the highlighted node will be automatically opened, its corresponding 



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 99 

zoom level reset and the window centred on the highlighted node to allow the area in which the 

node is located to be shown.  

 

3.3.4.4.3 Find Node XY 

Shortcut: [View/Find/NodeXY] 
The Find Node XY function enables the user to identify a given node based on its location. The 

co-ordinates of each node can be found by examining the Position attributes in the NODE 

dialogue box (see Figure 3-72). 

 

 
Figure 3-72: The Node dialogue box. 

 

The Find Node XY function works by identifying a node within a given geometry window based 

on its X and Y co-ordinates. Once Find Node XY has been selected (by selecting View from the 

menu, the Find sub-menu and then the NodeXY option), the user is then asked to supply both 

the X and Y co-ordinates of the node that they wish to locate. Once the X and Y co-ordinates 

have been provided via the ENTER X VALUE and ENTER Y VALUE dialogue boxes (see Figure 

3-73 (a) and (b)), the function will search the currently selected geometry window to locate the 

node with the desired X and Y co-ordinates. Once found the node will then be highlighted, with 

a black square appearing around the node in question (irrespective of whether the model is in 

Boundary mode or whether the nodes appear on the screen). In addition, the window containing 

the highlighted node will be automatically opened, its corresponding zoom level reset and the 

window centred on the highlighted node to allow the area in which the node is located to be 

shown. 

 

  
(a) (b) 

Figure 3-73: (a) The Enter X Value dialogue box and (b) the Enter Y Value dialogue 

box. 
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NOTE: 

If no node within the currently selected geometry window exists within 0.25 metres of the X and 

Y co-ordinates specified by the user then the node search will fail, and hence no node will be 

located. 

 

TIP: 

This function is particularly useful for easily locating the areas of significant congestion 

identified within the simulation file (.SIM) as a result of using the IMO Congestion contour (see 

Chapter 6). 

 

3.3.4.5 Zoom 

 

(i) In  

Shortcut: [View/Zoom/In]  
When constructing or viewing a geometry it is often necessary to magnify a particular region 

in order to get a clearer view of the structure and its connectivity. To magnify a group of nodes, 

select View from the menu bar, the Zoom option and then the In item from the pull-down menu 

(see Figure 3-2). Alternatively, simply press the ZOOM IN button on the toolbar (see Figure 

3-1). The standard method of zooming in uses a rubber band to mark out the area to magnify. 

To achieve this, press and hold down the left mouse button and drag out the required region. 

When the mouse button is released, the nodes/arcs/lines etc. contained in the region are enlarged 

to fill the current geometry window.  This process can be repeated to further enlarge the 

geometry.  Figure 3-74a and Figure 3-74b demonstrate the effect of the Zoom In function.  

 

Alternatively, by double-clicking on the ZOOM IN button a 10% magnification of the screen 

will be automatically produced. Once again, this action can be continually performed until the 

desired level of magnification is achieved.   

 

In addition, the user also has the option of zooming in by using the mouse wheel (assuming of 

course that the mouse that is being used has one). Once the Zoom In function has been selected, 

the user first needs to click anywhere within the geometry window that they wish to magnify, 

in order to select it. Having done so, then moving the mouse wheel down (i.e. rotating the wheel 

away from the user) will also result in the contents of the geometry window being magnified. 

 

(ii) Out  

Shortcut: [View/Zoom/Out]  
This is the reverse process of Zoom In. To reduce the level of magnification on a group of nodes, 

select View from the menu bar, the Zoom option and then the Out item from the pull-down 

menu. Alternatively, simply press the ZOOM OUT button on the toolbar (see Figure 3-74). The 

standard method of zooming out uses a rubber band to mark out the area requiring a reduction 

in the level of magnification. To achieve this, press and hold down the left mouse button and 

drag out the required region. The region marked out is the area that will occupy the entire 

geometry window, in the updated screen. Figure 3-74 demonstrates the Zoom Out function.  

 

Alternatively, by double-clicking on the ZOOM OUT button a 10% reduction in the 

magnification of the screen will be automatically produced. Once again, this action can be 

continually performed until the desired level of magnification is achieved. 
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In addition, the user also has the option of zooming out by using the mouse wheel (assuming of 

course that the mouse that is being used has one). Once the Zoom Out function has been 

selected, the user first needs to click anywhere within the geometry window whose 

magnification they wish to reduce, in order to select it. Having done so, then moving the mouse 

wheel up (i.e. rotating the wheel towards the user) will also result in the magnification of the 

currently selected geometry window being reduced. 

 

 
(a) Original region. 

 
(b) Region after a zoom in operation. 

 
(c) Region after a 

zoom out operation. 

Figure 3-74: The Zoom function 

 

(iii) Reset  

Shortcut: [View/Zoom/Reset]  
This function resets the magnification level of the current geometry window so that the whole 

geometry can be seen in the window. To reset the magnification level of a geometry window, 

select View from the menu bar, the Zoom option and then the Reset item from the pull-down 

menu (see Figure 3-2). 

 

3.3.4.6 Show Grid 

Shortcut: [View/Show Grid] 
This function enables the user to control whether or not the background grid is displayed within 

each of the geometry windows. The background grid itself comprises both light blue and grey 

lines, with the light blue lines being displayed at 1 metre intervals and the grey lines being 

displayed at intervals of 0.1 metres. The background grid is primarily used to assist in both the 

alignment of nodes when constructing geometries and as an aid in the visual calculation of 

distances between nodes. To display the background grid select View from the menu bar and 

then the Show Grid option from the resulting menu. The Show Grid function is available in 

each of the modes associated with the construction and definition of the model (i.e. the 

GEOMETRY, POPULATION and SCENARIO modes), but is not however available within 

SIMULATION mode. Figure 3-75 (a) and (b) demonstrate the effect of enabling the background 

grid. By default the background grid is not displayed. 
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(a) (b) 

Figure 3-75: (a) The Show Grid disabled. (b) The Show Grid enabled. 

 

3.3.4.7 Interface 

 

3.3.4.7.1 Edit Toolbar 

Shortcut: [View/Interface/Edit Toolbar] 
By selecting View from the menu bar, Interface from the menu and the Edit Toolbar option 

from the resulting submenu, the user is able to determine which buttons appear on the toolbar 

within Geometry mode (the functionality is identical within all modes). The user is able add All 

of the buttons available, select them individually and then Add them and also Remove them in 

the same manner (see Figure 3-76). This functionality is described in more detail in Chapter 2, 

Section 2.2. In addition, the toolbar items which can be added in Geometry mode are outlined 

in Section 3.3. 

 

 
Figure 3-76: The Toolbar Edit function. 

 

3.3.4.7.2 Navigation Window 

Shortcut: [View/Interface/Navigation Window] 
By selecting View from the menu bar, Interface from the menu and the Navigation Window 

option from the resulting submenu, the user is able to determine whether the Navigation 

Window is displayed on the left hand side of the workspace (see Figure 3-77 (a) and (b)). The 

Navigation Window provides the user with a quick navigation tool for accessing the geometrical 

and scenario components of the modelled geometry.  The information in the Navigation 

Window is presented in a tree like structure which can be expanded or contracted according to 

the information required by the user and the access they require to objects represented by the 

tree structure. This functionality is described in more detail in Chapter 2, Section 2.2. 
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(a) (b) 

Figure 3-77: (a) Both the Navigation and Data Window enabled. (b) The Navigation 

alone is enabled. 

 

3.3.4.7.3 Data Window 

Shortcut: [View/Interface/Data Window] 
By selecting View from the menu bar, Interface from the menu and the Data Window option 

from the resulting submenu, the user is able to determine whether the Data Window is displayed 

at the bottom of the workspace (see Figure 3-78 (a) and (b)). The Data Window contains three 

tab sub-windows, namely Summary, Output and Exit List. This functionality is described in more 

detail in Chapter 2, Section 2.2. 

 

  
(a) (b) 

Figure 3-78: (a) The Data window is disabled. (b) The data window is enabled. 

 

3.3.4.7.4 View Navigator 

Shortcut: [View/Interface/View Navigator] 
This feature allows the user to see what section of the overall structure is currently displayed 

within the current geometry window, in addition to providing the capability for users to both 

scroll and zoom the current geometry window as required (see Figure 3-79). The View 

Navigator window is available in any mode by selecting View from the menu bar, Interface 

from the menu and the View Navigator option from the resulting submenu (see Figure 3-79).  
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Figure 3-79: The View Navigator window showing what section of the ground 

floor is currently displayed. 

 

The View Navigator window depicts the whole boundary outline of the current floor, together 

with a blue rectangle which indicates the section of the structure that is currently displayed 

within the current geometry window (see Figure 3-80). Users have the ability to scroll the 

current geometry window to display any corresponding location by first clicking with the left 

mouse button within the area defined by the blue box and, while holding the mouse button 

down, dragging the blue box to the desired location (see Figure 3-81). 

 

 
Figure 3-80: Moving the current 

display area. 

 
Figure 3-81: Dragging out an area to  

zoom. 
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In addition, the View Navigator window also provides the ability to zoom into specific areas 

within the current geometry window (see Figure 3-81). This can be achieved by first clicking 

with the left mouse button within the View Navigator window and, whilst holding the mouse 

button down, dragging out a rectangle in the same manner as when zooming in a normal 

geometry window (see Section 3.3.4.5). Once complete, the current geometry window will 

them be resized and positioned as best as possible to accommodate the rectangle indicated 

within the View Navigator window. It is however important to note, that in order to drag out a 

zoom rectangle in the manner defined above, the user must start the zoom rectangle (i.e. initially 

click the left mouse button) outside the blue box indicated within the View Navigator window. 

This is because clicking the left mouse button within the area defined by the blue box is always 

interpreted as a request to move the current view location of the current geometry window. 

 

 
Figure 3-82: The pop-up menu options. 

 

A pop-up menu to control the functionality of the View Navigator is also available by right 

clicking within the View Navigator window itself (see Figure 3-82). The pop-up menu has three 

options: 

 

1. Coordinate Ratio: When this option is enabled the geometry is displayed with both the 

horizontal and vertical dimensions to scale. However, when disabled the geometry is 

instead stretched to fit the View Navigator window. Disabling this feature is useful when 

the geometry is elongated in either the horizontal or vertical directions (see Figure 3-83). 

By default this option is enabled. 

2. Zooming: Enables and disables the ability to control the geometry windows zooming 

from within the View Navigator window. By default this option is enabled. 

3. Update While Dragging: When enabled this function dynamically updates the 

geometry window associated with the View Navigator window while the selected 

display area is being dragged. If disabled the geometry window is only updated after the 

user has stopped dragging the display area represented by the blue rectangle. By default 

this option is enabled. 
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(a) 

 
(b) 

Figure 3-83: Difference between Coordinate Ratio (a) enabled and (b) disabled. 

 

3.3.4.7.5 Tabbed Menubar 

Shortcut: [View/Interface/Tabbed Menubar] 
The Tabbed Menu Bar enables the user to quickly and easily switch between the four modes 

available within buildingEXODUS (i.e. Geometry, Population, Scenario and Simulation).  This 

provides an alternative method of switching between modes to the existing a) Mode Advance and 

Mode Back chevrons (i.e.  and ), and b) the Goto option within the Edit menu (see Section 

3.13).  By selecting View from the menu bar, Interface from the menu and the Tabbed Menubar 

option from the resulting submenu, the user is able to control whether the Tabbed Menu Bar is 

displayed between the menu and the toolbar (see Figure 3-84).  By default the Tabbed Menubar 

is not displayed.  This functionality is described in more detail in Chapter 2, Section 2.2. 

 

 
Figure 3-84: The Tabbed Menu bar shown highlighted 

 

3.3.4.7.6 3D View 

Shortcut: [View/Interface/3D View] 
The 3D View functionality provides the user with a rudimentary three dimensional 

representation of the geometry (see Figure 3-85). This enables users to navigate around the 

structure to either check that it is correctly configured during the design/build phase, or 

alternatively to observe the simulation during run time. This functionality is most useful when 

modelling geometries consisting of multiple floors, especially those containing lifts. As stated 

previously, it is important to note that the 3D View is only intended to be a rudimentary three 

dimensional representation of the geometry. It is therefore not intended to be an alternative to 

the more enhanced representation available within vrEXODUS. Users wishing to generate high 

quality representations of evacuations from structures for demonstration purposes are therefore 

strongly encouraged to use vrEXODUS. Both vrEXODUS and the 3D View functionality are 

only available to Level B and C users. 
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Figure 3-85: An example multi-floor geometry as shown within the 3D View 

 

The 3D View is available in any mode by selecting View from the menu bar, Interface from the 

menu and the 3D View option from the resulting submenu.  

 

Within the 3D View the viewpoint is moved around the geometry using a combination of 

keyboard and mouse movements.  By default the keyboard and mouse controls within the 3D 

View are the same as those used within vrEXODUS.  The rate at which the viewpoint changes 

depends on the time taken to draw the geometry within the 3D View; the larger the simulation 

case loaded the greater the time taken to draw the geometry and hence the slower the movement 

of the viewpoint. 

 

a) Mouse Controls 

Within the 3D View the camera rotation is done by using the mouse.  While the mouse 

is inside the 3D View window clicking and holding the right mouse button and moving 

the mouse left and right will turn the viewpoint left and right.  While still holding the 

mouse button, moving the mouse forwards and backwards will tilt the viewpoint up and 

down respectively.  If the user has a mouse wheel; they can rotate the mouse wheel 

forwards/backwards while the 3D View window is selected to move the view 

forwards/backwards in the direction of the viewpoint, much like zooming in and out.  

This is different to moving forwards and backwards with the keys as they move the 

viewpoint along the world axis; i.e. in the plane parallel to the ground, so the height of 

the view does not change. 
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b) Keyboard Controls 

Movement of the viewpoint using the keys is in world perspective e.g. it is relative to 

the world axes and not the rotation of the viewpoint. So while looking downwards, 

pressing the forward key will make the camera move forward at a constant height and 

not downwards in the direction of the viewpoint.  Table 3-5 shows how the keys on the 

keyboard control the movement of the viewpoint. 

 

NOTE: 

The mouse controls outlined above correspond to the default mouse controls. It is important to 

note that these can be changed via the settings within the Mouse Control options (see Section 

3.3.4.7.6.4).  

 

Table 3-5: The default movement controls within the 3D View 

Action Primary Key Alternate Keys Mouse Control 

Forward W Numpad 8 n/a 

Backward S Numpad 5, Numpad 2 n/a 

Strafe Left A Numpad 4 n/a 

Strafe Right D Numpad 6 n/a 

Up Space bar Numpad 9 n/a 

Down Ctrl Numpad 3 n/a 

Turn Left Left Arrow n/a Mouse Drag Left3 

Turn Right Right Arrow n/a Mouse Drag Right3 

Look Up Up Arrow n/a Mouse Drag Up3 

Look Down Down Arrow n/a Mouse Drag Down3 

Increase Speed1 = Numpad + n/a 

Decrease Speed1 - Numpad - n/a 

Zoom In Page Up n/a Mouse Wheel Forward 

Zoom Out Page Down n/a Mouse Wheel Backwards 

Speed Boost2 Shift n/a n/a 

Increase Floor Separation Shift & = Shift & Numpad + n/a 

Reduce Floor Separation Shift & - Shift & Numpad - n/a 

Rotate Clockwise4 Shift & L n/a n/a 

Rotate Anti-clockwise4 Shift & J n/a n/a 

1  Increasing and decreasing the movement speed does not affect the mouse sensitivity for 

rotating the view. 

2  The speed of the movement will be temporarily increased while the Shift key is held down. 

3  While holding the right mouse button down. 

4  If an EXODUS object (i.e. node, line etc.) is selected within the 3D View then the camera 

will rotate around this point. If no object is selected the camera will simply rotate around the 

centre of the geometry. 

 

As with conventional geometry windows, within the 3D View window, the objects both 

displayed and selectable are controlled via the Display Control dialogue box (see Section 

3.3.4.3.1).  The user is therefore able to control how the geometry is displayed, and hence which 

objects are visible/selectable. Double clicking on objects within the 3D View will display the 

object’s corresponding properties dialogue box in the same manner as double clicking on them 

within conventional geometry windows (i.e. assuming that the given object type is defined as 

selectable within the Display Control dialogue box, see Figure 3-86).  It is important to note 
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that within the 3D View objects cannot be moved.  Hence the position of all objects will remain 

set irrespective of whether Object Lock is disabled (see Section 3.3.3.13). 

 

 
Figure 3-86: Double clicking on a line/wall within the 3D View to display its 

corresponding Line dialogue box (selected wall shown in red) 
 

Within the 3D View the user is also able to control both aspects of the appearance of the 

geometry and the means of navigation within it. This is achieved by right clicking the mouse 

within the 3D View window in order to display its corresponding pop-up menu (see Figure 

3-87).  

 

 
Figure 3-87: The pop-up menu used to control the 3D View 
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Each of the options available within the 3D View pop-up menu will now be discussed. 

 

3.3.4.7.6.1 Floor Layout 

The Floor Layout option enables the user to control how geometries comprising multiple floors 

are displayed within the 3D View. Three options are available, namely Vertical, Offset Y and 

Offset X. The Vertical option displays each of the floors within the structure above one another 

in the conventional and most realistic manner (see Figure 3-88(a)). Using this approach the 

vertical spacing between the floors is in accordance with their corresponding floor heights (see 

Sections 3.4.5and 3.4.9).  In contrast, the Offset Y option displays all of the floors on the same 

level (i.e. all at ground level), with each floor being offset in the Y axis (see  Figure 3-88(b)).  

The Offset X option also displays all of the floors on the same level, however in this instance 

each floor is (as the name suggests) offset in the X axis (see Figure 3-88(c)). The Offset X or Y 

options can be used to better observe the behaviour of the agents on each floor. 

 

  
(a) Vertical (b) Offset Y 

 
(c) Offset X 

Figure 3-88: An example multi-floor geometry displayed via the a) Vertical, b) Offset Y, 

and c) Offset X options 
 

3.3.4.7.6.2 Viewing Angle 

The Viewing Angle option enables the user to automatically jump to fixed viewpoints of the 

structure. Within the Viewing Angle submenu six viewpoints can be selected, namely Top, 

Front, Left, Back, Right and Bottom.  If the geometry can be imagined centrally located within 

a larger imaginary cube then each of the viewpoints of the geometry corresponds to the view 

from one of the six faces of the cube. Each of the six viewpoints of an example multi-floor 

geometry can be seen below in Figure 3-89. 
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(a) Top (b) Front (c) Left 

  

 

 

(d) Back (e) Right (f) Bottom 

Figure 3-89: The view of an example multi-floor geometry from each of the six default 

viewing angles 
 

3.3.4.7.6.3 Display 

The Display option enables the user to control aspects of the appearance of the structure within 

the 3D View. Each of the options available within the Display submenu will now be discussed: 

 

Ground Grid:  
This option determines whether or not the ground grid is displayed within the 3D View (see 

Figure 3-90). The ground grid aids in providing both perspective and a horizon in the 3D View 

window. In addition, each square within the ground grid represents an area 10m x 10m.  Hence 

the ground grid also provides a rudimentary means estimating distance/scale.  Figure 3-90 

below shows a multi-floor geometry in the 3D View with both the ground grid enabled and 

disabled. The ground grid is displayed by default. 
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(a) (b) 

Figure 3-90: The view of an example multi-floor geometry with the ground grid a) 

enabled, and b) disabled. 
 

VR Floor Tile Polygons: 

This option determines whether or not the VR Floor Tile Polygons of each floor are displayed. 

Within buildingEXODUS VR Floor Tile Polygons are used to define the floor tile of each floor, 

thereby enabling its outline and the corresponding holes within it (i.e. resulting from stairwells 

or areas where balconies overlook lower floors) to be accurately depicted within both 

vrEXODUS and the 3D View. VR Floor Tile Polygons can be automatically generated for each 

floor (see Section 3.4.6) or can be manually generated/manipulated by the user (see 3.4.5). 

Figure 3-91 below shows a multi-floor geometry in the 3D View with both the VR Floor Tile 

Polygons enabled and disabled. By default VR Floor Tile Polygons are displayed within the 3D 

View. 

 

  
(a) (b) 

Figure 3-91: The view of an example multi-floor geometry with the VR Floor Tile 

Polygons a) enabled, and b) disabled. 
 

Lift Shafts: 

This option determines whether or not the lift shafts present within the structure are displayed 

within the 3D View.  It is important to note that this option relates only to the display of the lift 

shafts themselves and not the lifts within them. Hence lifts (and the corresponding agents within 

them) will always be displayed irrespective of whether the lift shafts are displayed or not. The 

ability to turn off the display of lift shafts is often useful in structures containing large numbers 
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of lifts.  In these instances the display of lift shafts can obstruct the users view of regions of the 

geometry, thereby obscuring the movement\behaviour of agents.  Figure 3-92 below shows an 

example multi-floor geometry in the 3D View with both lift shafts enabled and disabled. By 

default lift shafts are displayed within the 3D View. 

 

 
 

(a) (b) 

Figure 3-92: The view of an example multi floor geometry with Lift Shafts a) enabled, 

and b) disabled. 
 

Graphics Acceleration: 

This option determines whether or not the objects to be drawn within the 3D View window are 

copied into the memory of the graphics card.  If this option is enabled then all of the objects to 

be drawn within the 3D View are copied into the graphics card memory. Using this approach 

the graphics card merely accesses its own memory in order to obtain the location and type of 

each object and then draw it within the 3D View.  This process is typically very fast, thereby 

resulting in the time taken to draw the objects being minimised, and hence in any movement by 

the user within the 3D View window appearing very smooth and fluid.  

 

In contrast, if this option is disabled then each object is instead sent individually to the graphics 

card to be drawn (i.e. the objects are not stored in the memory of the graphics card). This method 

is typically slower than the graphics card merely accessing its own memory. As a result, the 

disabling of this option may result in the time taken to draw the objects being increased relative 

to the previous method, possibly resulting in any movement by the user within the 3D View 

window appearing more jerky and less fluid. 

 

The ability to use Graphics Acceleration is dependent upon both the number of objects to be 

drawn (and hence the amount of memory it will take to store them on the graphics card) and 

the available memory on the graphics card itself. If the amount of memory taken up by the 

objects exceeds the available memory on the graphics card then it will not be possible to use 

Graphics Acceleration.  In these instances users may therefore be required to disable Graphics 

Acceleration in order to use the 3D View. By default Graphics Acceleration is enabled. 
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Transparent: 

This option enables the user to define whether VR Floor Tile Polygons, walls/lines and/or Lift 

Shafts are displayed in a transparent manner within the 3D View.  Displaying either of these 

objects transparently enables the basic structure of the geometry to still be visible, while at the 

same time not obstructing the user’s view of the objects behind them (e.g. the evacuating 

agents).  Figure 3-93 below shows an example multi-floor geometry in the 3D View with both 

Transparent Walls enabled and disabled. Walls/lines are displayed as opaque by default. 

 

  
(a) (b) 

Figure 3-93: The view of an example multi floor geometry with Transparent Walls a) 

enabled, and b) disabled. 
 

Figure 3-94 below shows an example multi-floor geometry in the 3D View with both 

Transparent VR Floor Tile Polygons enabled and disabled. VR Floor Tile Polygons are 

displayed as opaque by default. 

 

  
(a) (b) 

Figure 3-94: The view of an example multi floor geometry with Transparent VR Floor 

Tile Polygons a) enabled, and b) disabled. 
 

Figure 3-95 below shows an example multi-floor geometry in the 3D View with both 

Transparent Lift Shafts enabled and disabled.  Lift Shafts are displayed as opaque by default. 
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(a) (b) 

Figure 3-95: The view of an example multi floor geometry with Transparent Lift Shafts 

a) enabled, and b) disabled. 
 

Colour: 

This option enables the user to define the colour of the background, walls/lines and VR Floor 

Tile Polygons within the 3D View. In each case, the user can define the colour of the respective 

object via the Colour dialogue box (see Figure 3-96).  The user can select from any one of 48 

default basic colours, or alternatively can create and assign their own custom colours. Any 

changes made to the colour of these objects is automatically stored by buildingEXODUS. 

Hence, the next time the software is used each of the defined colours will be used.  It is 

important to note that these colours only relate to the appearance of the given objects within the 

3D View. Any changes made to the colour of objects via the Colour dialogue box will therefore 

not affect the colour of the respective objects within the geometry windows. 

 

 
Figure 3-96: The Colour dialogue box 

 

3.3.4.7.6.4 Mouse Control 

The Mouse Control option enables the user to control the manner by which mouse movements 

affect the view of the structure within the 3D View. Each of the options available within the 

Mouse Control submenu will now be discussed: 
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Object Control: 

This option determines how moving the mouse with the right mouse button depressed affects 

the view within the 3D View window. If the Object Control option is not enabled then clicking 

and holding the right mouse button and moving the mouse left and right will turn the viewpoint 

left and right. Similarly holding the right mouse button and moving the mouse forward and 

backward will tilt the viewpoint up and down.   

 

However, if the Object Control option is enabled then (as the name suggests) the mouse controls 

are effectively reversed. Consequently, clicking and holding the right mouse button and moving 

the mouse left and right will turn the viewpoint right and left respectively. Similarly holding 

the right mouse button and moving the mouse forward and backward will tilt the viewpoint 

down and up respectively.  By default the Object Control option is not enabled. 

 

Mouse Wheel Zoom: 

This option determines how the mouse wheel affects navigation within the 3D View. If the 

Mouse Wheel Zoom option is enabled then the mouse wheel will control the ability to zoom, 

and will therefore enable the user to either move towards or away from their current focal point 

(i.e. the centre of the 3D View window). Moving the mouse wheel forward will hence move the 

view towards the current focal point (i.e. zoom in), while conversely moving the mouse wheel 

backwards will move the view away from the current focal point (i.e. zoom out). If the Mouse 

Wheel Zoom option is not enabled then the mouse wheel will instead control speed of navigation 

within the 3D View. Consequently, moving the mouse wheel forward will increase the speed of 

navigation, while moving the mouse wheel backwards will instead decrease the speed of 

navigation. Hence when the Mouse Wheel Zoom option is not enabled moving the mouse wheel 

forward or backwards is effectively the same as pressing the + or – keys respectively (see Table 

3-5). By default the Mouse Wheel Zoom option is enabled, hence by default the mouse wheel 

will control zooming within the 3D View window.  

 

3.3.4.7.6.5 Calc. Node Heights 

This option enables the user to calculate the heights of each node within the geometry in order 

to ensure that they are displayed within the 3D View at the correct elevation appropriate to their 

connectivity.  By default, when nodes are added to a geometry window they are assumed to 

have a zero elevation (i.e. they are assumed to be at the same height as the floor area within 

their respective floor). Consequently the heights of nodes which would in reality have an 

elevation (i.e. landings and stairs) are not accurately represented within the 3D View.  Figure 

3-97(a) shows the representation of a typical dog-leg staircase within the 3D View before the 

node heights have been calculated. Here it can clearly be seen that both the landing itself and 

the flight of stairs leading up from the landing have been drawn with no elevation. Hence the 

depiction of the geometry within the 3D View in this case does not accurately reflect the 

connectivity within the structure, and therefore cannot be considered realistic.  In contrast, 

Figure 3-97(b) shows the representation of a typical dog-leg staircase within the 3D View after 

the node heights have been calculated. Here it can clearly be seen that both the landing and the 

flight of stairs leading up from it have now been drawn at the correct elevation, thereby greatly 

enhancing the realism of the geometry within the 3D View. 
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(a) (b) 

Figure 3-97: An example dog-leg staircase a) before calculating the node heights, and b) 

after calculating the node heights 
 

Whenever users modify the dimensions/configuration of staircases involving landings they are 

encouraged to calculate the node heights within the 3D View.  It is important to note that 

calculating node heights only affects the representation of the geometry within the 3D View. 

Consequently, failure to calculate the heights of nodes will not affect either the behaviour of 

the agents or the simulation times produced. Similarly, it is not necessary for the user to 

calculate node heights in order to correctly represent the geometry within vrEXODUS, since 

when a simulation is saved for vrEXODUS the heights of each node are automatically 

calculated.   

 

NOTE: 

In order for nodes representing landings to be displayed at the correct height within both the 

3D View and vrEXODUS their corresponding node type needs to be set to Landing. 

 

3.3.4.7.7 Command Line 

Shortcut: [View/Interface/Command Line] 
The Command Line functionality provides a command line interface to enable the user to 

directly type SFE commands to control both the setting up of the model as well as the conditions 

present during the simulation. The Command Input dialogue box enables individual SFE 

commands to be entered by the user in the correct format. Once a command has been entered 

the user should then press the Enter key. Upon pressing the Enter key the SFE command on 

that line will be executed and hence the geometry, population, configuration, output etc. will be 

modified accordingly. The Command Line interface is available in any mode by selecting View 

from the menu bar, Interface from the menu and the Command Line option from the resulting 

submenu.  It is recommended that only expert users attempt this - the user should be familiar 

with the impact of applying certain commands prior to using the SFE approach. For more 

information on the use of the command line interface and the SFE commands available see 

Appendix F.  
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Figure 3-98: The Command Input dialogue box showing a demonstration SFE command 
 

3.3.4.8 Model Description  

Shortcut: [View/Model Description] 
This feature enables the user to record a detailed description of the simulation and its set-up. 

This option is available via the View menu. The user is able to enter this description in either 

the GEOMETRY, POPULATION or SCENARIO modes via a text box in the MODEL 

DESCRIPTION dialogue box (see Figure 3-99). This text is saved within the EXO or MTA file 

and is therefore retrieved in any subsequent loading of the file. 

 

 
Figure 3-99: The Model Description dialogue box. 

 

This feature is particularly useful if the user has numerous geometry libraries. It enables the 

user to distinguish between particular scenarios without progressing further into problem set-

up.  

 

TIP: 

The user should create a Model Description for any library that is likely to be re-used. This 

should then prevent them mistakenly using or misunderstanding existing scenario libraries. 

 

3.3.5 Saving a Constructed Geometry 

Shortcut: [File/Save As] / [File/Save]  
Once a geometry has been constructed it can be saved into the Geometry Library.  The user has 

a choice of creating either binary or ASCII files.  Binary files have the advantage of being quick 

to load and save.  The standard extension to buildingEXODUS binary files is .EXO.  ASCII 

library files are larger than binary files and take longer to read and write.  ASCII files are required 

to transport library cases from one type of platform to a different type (e.g. PC to workstation).  

They may also be required to use transfer files between different versions of the 

buildingEXODUS model. Binary files CANNOT be transferred in this manner. The standard 

extension to ASCII geometry files is .MTA. To save a geometry select File from the menu bar 

and the Save As item from the pull-down menu.  Subsequent updates to the geometry may be 
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saved by selecting File from the menu bar and the Save item from the pull-down menu. 

Alternatively, press the Save button on the toolbar (see Figure 3-1). 

 

3.4 Importing a Third Party Geometry 

Shortcut: [Tools/Construction/Load Boundary] 
Many buildingEXODUS applications will concern the modelling of structures the overall 

layout of which will have been defined previously within other third party software.  This may 

include structures that have been designed/defined using a CAD (Computer Aided Design) 

system, or those similarly defined via BIM (Building Information Modelling).  Structures may 

also have previously been defined within CFD (Computational Fluid Dynamics) models (i.e. 

SMARTFIRE or FDS) as part of a fire modelling analysis.  To utilise this predefined geometry 

information, the EXODUS Third Party Extras Library provides a set of utilities to directly 

import them, thereby preventing users from having to manually construct the outline of the 

structures they wish to model again from scratch.   

 

In total, four different types of geometry file can be directly read into buildingEXODUS, 

namely: 

1) CAD based DXF files (see Section 3.4.1), 

2) BIM/IFC (Industry Foundation Classes) geometry files (see Section 3.4.3),  

3) FDS geometry files (see Section 3.4.4), and 

4) SMARTFIRE geometry files (see Section 3.4.4). 

 

To import one of these predefined geometry files into buildingEXODUS, the user should first 

select the geometry window into which the floor information will be imported (i.e. by merely 

clicking within the window itself), and then select Tools from the menu bar, the Construction 

sub-menu and the Load Boundary item from the pull-down menu.  Selecting this option will 

then display the OPEN FILE dialogue box, enabling the user to locate the desired geometry 

file.  By default buildingEXODUS will assume that the file to be read in is a DXF file (i.e. 

*.DXF). Users wishing to import alternative geometry files (i.e. .IFC, .FDS or .SMF) can simply 

select the desired file type within the corresponding FILE TYPE list box located in the bottom 

right hand corner of the OPEN FILE dialogue box. Once the user has both defined the type of 

the file that they wish to load in, and identified the specific geometry file, it can then be loaded 

by simply clicking the OPEN button. A window containing a preview of the imported file will 

then be displayed. The information displayed and the actions that the user is required to perform 

varies depending upon the type of file opened.  Each of the possible geometry types will now 

be discussed. 

 

NOTE: 

To import predefined geometry files into buildingEXODUS the User first needs to install the 

EXODUS Third Party Extras Library. These are available for download from the EXODUS 

Licenced Users Area on the FSEG website (fseg.gre.ac.uk). 

 

NOTE: 

If the EXODUS Third Party Extras Library is not installed the user will be warned that this 

functionality is not available and they should install the library. If the User opens a DXF file 

they will be warned the Extra Library is not installed and buildingEXODUS will instead use 

the previous version DXF importer functionality (i.e. the DXF Import Editor outlined in Section 

3.4.1 will not be used). 

 

http://fseg.gre.ac.uk/
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3.4.1 Importing a CAD DXF File 

Once the user has selected to load in a DXF file the corresponding information that it contains 

will then be loaded into the DXF Import Editor (see Figure 3-100).  All of the information 

contained within the DXF file will be imported, with the exception of TEXT, HATCHING, 

DIMENSIONS, SPLINE CURVES, XREF Objects and any layers that are turned off (i.e. 

hidden).  Once loaded, the structure as defined within the DXF file will then be displayed within 

the main window, with its corresponding Layers, Blocks and Entities listed within the left hand 

window.  In addition, the Colours of the corresponding layers contained within the file are also 

displayed.  Double clicking on the Layers, Blocks, Entities and Colours items within the left 

hand window will toggle the display of their corresponding elements.  Once displayed, these 

elements can then in turn be selected by clicking on them in order to highlight them within the 

overall structure. Any selected elements will be highlighted magenta (i.e. selecting a given layer 

will then highlight all the structural information contained within that layer as magenta within 

the main window).  In this manner, selecting elements (i.e. specific Layers, Blocks, Entities and 

Colours) enables the user to know what structural information is included within that element, 

and hence identify which elements are not required for the purpose of evacuation modelling.   

 

If the user is unable to clearly see the information contained within a given layer/block/entity 

etc. as a result of its colour being indistinct from that of the background, then the background 

colour can be changed via the Background slider bar located in the bottom left hand corner of 

the screen (see Figure 3-100).  This slider bar enables the user to define the background colour 

as any shade on the greyscale between black and white. 

 

NOTE: 

Any layers which are empty or consist solely of information which is not displayed (i.e. TEXT, 

HATCHING, DIMENSIONS etc.) will not be shown within the list of layers. 

 

NOTE:  

Switched off (i.e. hidden) layers will not be imported into the DXF Import Editor, however 

layers which are merely frozen will be imported and hence listed. 
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Figure 3-100: The DXF Import Editor. 

 

When imported into buildingEXODUS, any line within the DXF file will be treated as a wall 

(and hence an obstacle). As a result, any lines not directly defining the structure being modelled 

or the obstacles within it (i.e. the overall circulation space) should be removed. Information 

typically removed from DXF files include:  

 Text, (Removed Automatically) 

 Dimensions and associated lines, (Removed Automatically) 

 Hatching, (Removed Automatically) 

 Floor markings, 

 Door sweeps indicating the direction in which doors open, 

 Lines crossing corridors, 

 Markings indicating electrical wiring or mechanical ventilation, 

 Artefacts representing unnecessary levels of detail (i.e. taps, objects on desks such as 

monitors, keyboards etc.), and 

 Individual chairs (i.e. as opposed to rows of seating) 

 

It is important to note that individual seats/chairs should be removed since they represent 

obstacles which can be directly modelled within buildingEXODUS (i.e. via the use of Seat 

nodes). Hence the outlines of any seats/chairs within the DXF file should be removed. The 

seats/chairs can then effectively be added back into the geometry once it has been flooded with 

nodes by simply changing the type of the nodes within the corresponding locations.  
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Within buildingEXODUS the number of walls that it is possible to have within a geometry is 

restricted purely by the memory of the computer. Hence, in most cases it is possible to have 

extremely large numbers of walls without any noticeable detrimental effect on the performance 

of buildingEXODUS.  Despite this, excessive numbers of walls may have a negative effect 

when simulations are either displayed in 3D View or loaded into vrEXODUS. Due to the 

additional rendering required within both 3D View and vrEXODUS, excessive numbers of walls 

may reduce the frame rate, resulting in the user experiencing difficulties when navigating 

around the geometry. For this reason the user is strongly encouraged to remove all unnecessary 

lines from their DXF files. 

 

Once the user has identified elements within the DXF file which contain redundant information 

(i.e. information not required for the purposes of evacuation modelling), these can then be 

deleted.  This can be achieved by either selecting the corresponding element and then pressing 

the DELETE button on the keyboard, or alternatively by right clicking on the element and then 

selecting the DELETE option from the resulting pop-up menu. 

 

The total number of lines present within the structure as currently displayed within the main 

window is provided at the bottom of the DXF Import Editor (see Figure 3-100).  As the user 

deletes elements containing unwanted information, the lines contained within those elements 

will be removed and hence the total number of lines will decrease. 

 

Within the DXF Import Editor the user also has the option of defining a Minimum Line Length.  

Any lines less than this defined length will be deemed unnecessary for the purposes of defining 

the structure, and hence will be removed.  This approach can be useful for removing superfluous 

information on elements which users may still wish to retain (i.e. removing detailed tap or plug 

information on sinks etc.).  By default the Minimum Line Length is set to 0 units (i.e. mm, m, 

inches etc.), thereby indicating that no walls will be removed. As the user changes the Minimum 

Line Length any lines less than the defined length will be removed and the resulting structure 

updated within the main window.  In addition, the total line count will also be updated in order 

to reflect the deletion/removal of any lines.  Users are advised to exercise caution when using 

this capability since defining a line length which is too large may result in important structural 

information being removed.  An appropriate value for the Minimum Line Length may also vary 

from file to file. Hence, while a given value may produce the desired results in one file, the 

same value may not be appropriate in another.  Determining an appropriate Minimum Line 

Length will therefore typically need to be determined by the user via trial and error. 

 

Once the user has removed any redundant information from the DXF file (i.e. by deleting 

elements and defining an appropriate Minimum Line Length) they are then required to define 

the corresponding units of the DXF information via the list box located along the bottom of the 

DXF Import Editor. By default the units of any DXF are merely assumed to be millimetres.  If 

users are unsure of the correct units of the DXF file they can determine the length of specific 

structural elements (i.e. walls/doors etc.) via the corresponding coordinates of their end points 

as displayed within the DXF Import Editor.  Once the length of these elements has been 

determined, they can then be compared to their known length in order to determine the 

corresponding units of the DXF file.  Hence, if a given door is known to be 1m in width and 

the corresponding coordinates of the door in the DXF Import Editor indicate that it is 

approximately 1000 units wide then this indicates that the units of the DXF is millimetres.   
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When the user has defined the units of the DXF file, the resulting structure (i.e. as displayed 

within the main window) can be imported into buildingEXODUS by clicking the OK button.  

buildingEXODUS then converts the remaining DXF lines from their defined units into metres 

and displays the structure within the selected geometry window. It is therefore vital for the units 

of the DXF file to be correctly selected. 

 

It is important to note that the ability to easily strip DXF files of extraneous information prior 

to importing it into buildingEXODUS in the manner outlined previously (i.e. via the DXF 

Import Editor) is largely dependent upon DXF files being layered and arranged in a logical 

manner.  Ideally all information within a given layer should relate to similar structural 

information (i.e. office desks, walls, stairs etc.). If individual layers contain multiple types of 

structural information then it may not be possible to simply delete that layer in order to remove 

unwanted information since that may in turn result in the deletion of other wanted information.  

For instance, if a given layer contained both wall and door sweep information, then deleting the 

layer in order to remove the unwanted door sweeps would also remove the vital information 

related to the walls which define the overall circulation space. In this instance the user either 

has the option of importing the entire layer and then removing the unwanted information within 

buildingEXODUS itself, or alternatively cleaning up the DXF file (i.e. deleting the unwanted 

information) prior to loading it into the DXF Import Editor.  For guidance on how to prepare a 

CAD file within Autodesk AutoCAD for importing into buildingEXODUS see Section 3.4.2. 

 

NOTE: 

Simply importing a DXF file into buildingEXODUS does NOT complete the geometry 

definition. This merely represents the first stage of defining the geometry, since the nodes and 

arcs etc. still need to be specified.  

 

3.4.2 Preparing CAD Files Within Autodesk AutoCAD for Importing into EXODUS 

This section explains how to prepare a CAD file (DWG or DXF) using Autodesk AutoCAD 

software prior to importing it into buildingEXODUS. The amount of work that this will involve 

depends on the quality of the CAD file. 

 

As stated previously (see Section 3.4.1), prior to importing DXF files into buildingEXODUS it 

is necessary to ensure that the DXF file is clean of all artefacts unrelated to defining the 

boundaries of the circulation space (i.e. the area in which agents will be able to move during 

egress).  This will typically mean the removal of dimensions and associated lines, floor 

markings, door sweeps etc.  The following steps outline how to remove unwanted artefacts and 

layers from CAD files and also how to minimise the number of lines that it contains via the 

removal of duplicates. First open the CAD file within AutoCAD and assess what state it is in. 

If all of the objects/lines are contained within one layer then move directly to Step 2. 

 

Step 1 

With a CAD file made from many layers, it is important to strip out all the objects and lines on 

the layers that you do not want to import.  Deleting layers in AutoCAD can be frustrating and 

difficult at times depending on what is on the layer and how it has been used.  It is faster to not 

delete the layer but to delete all the objects on the layer instead.  This can be done smoothly by 

using the Isolate button  found in the Layers Panel from the Home Tab on the Ribbon or 

use the LAYISO command. 
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First turn on and unfreeze all the layers so they become visible within AutoCAD. With nothing 

selected the user should click the Isolate Button and select (i.e. click on) an object that they do 

not want to import and then hit ENTER on the keyboard.  This will turn off all other layers 

except the one on which the selected object was on.  If the CAD file was prepared well, then 

other unwanted objects (i.e. those that the user does not want to import) may also become 

visible, thereby also enabling them to be selected and deleted.  Alternatively the user could 

merely delete just the ones they are sure they do not want.  To reveal all the layers again that 

were previously hidden, click the Unisolate button . 

 

Users can repeat this procedure, selecting other unwanted objects/lines, isolating their layer and 

then deleting the content they do not want.  Users should however be careful not to delete 

everything from a layer if they are not sure that it does not make up some part of the structure 

that is needed to define the overall geometry. 

 

NOTE:  

If users are working with a file that they know well, and it has been labelled well, they can 

select layers they know that they do not need and delete their content.  However, be careful as 

sometimes objects and lines are on layers that they were not expected to be on! 

 

Step 2 

Next remove all duplicate objects and lines by using the Delete Duplicate Object button   

found in the Modify Panel from the Home Tab on the Ribbon or using the OVERKILL 

command. The check can be done so that it ignores layers, line types and other attributes.  So 

identical lines on different layers will be deleted. 

 

With nothing selected, press the Delete Duplicate Object button, or type OVERKILL into the 

command line. Select all the objects in view by clicking top left and then bottom right of the 

window and finally hit the ENTER key.  This will display the Delete Duplicate Object dialogue 

box (see Figure 3-101). 
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Figure 3-101: The Delete Duplicate Objects dialogue box. 

 

Users should utilise the settings above or alter them to suit their needs.  Click OK and AutoCAD 

will then compare all the selected objects/lines and delete any duplications.  This is very useful 

in CAD files where many versions of the walls have been created on many layers. 

 

Step 3 

Within AutoCAD Block References represent objects that are often replicated on one or more 

layers from a master Block. These Blocks can often be very detailed, hence resulting in them 

containing large numbers of lines. In certain circumstances the user may only need to import 

parts of these Blocks and not all of the detail (i.e. only the outline of a desk, but not the all the 

lines representing the computer/phone etc. on it). In order to remove these unnecessary lines 

the user needs to edit the Block within AutoCAD; using the Block Editor, and delete any lines 

that do not make up the outline of the object. Once the changes to the Block have been saved, 

the Block References will update automatically throughout the CAD file wherever the Block 

has been referenced. 

 

Step 4 

CAD files may contain XREF objects and as previously stated these objects will be ignored by 

the DXF importer within buildingEXODUS. If the XREF objects contain information that the 

user wishes to import then they need to be converted into Blocks prior to importing the CAD 

file. Once converted, these Blocks can then be edited as described in Step 3 to remove any 

unwanted detail if desired. 

 

This should produce and clean CAD file that is ready to be saved as a DXF file and imported 

into buildingEXODUS. Once imported into buildingEXODUS the user should then use 

Minimise Boundary Lines function to further reduce the number of lines (see Section 3.3.1.6). 
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3.4.3 Importing a BIM/IFC File 

If the user chooses to import a BIM/IFC file (i.e. *.IFC) then the information the file contains 

will be loaded in and displayed in the IFC Import Editor (see Figure 3-102). Within the IFC 

Import Editor each of the floors/storeys contained within the structure are listed down the left 

hand side of the window, enabling the user to select which of the available floors they wish to 

import into buildingEXODUS.  The floors within this window are sorted in reverse order 

according to their corresponding height, with the lowest floor displayed first in the list and 

selected by default.  Once a given floor is selected the corresponding objects that it contains 

(e.g. beams, doors, walls, etc) are then listed down the right hand side of the window.  These 

objects can in turn be selected or deselected by clicking on them, thereby enabling the user to 

control which elements they wish to import and therefore consider in the definition of the floor’s 

circulation space.  By default, all objects whose name comprises the word “wall” will 

automatically be selected (i.e. Wall Standard Case, see Figure 3-102). Once the user has 

selected the desired IFC objects that they wish to import within their chosen floor they can then 

visualise them by clicking the NEXT button. 

 

NOTE: 

Selecting all of the available objects within a given floor/storey (particularly large ones) may 

result in the visualisation taking some time to complete. This is because of the large amount of 

structural information typically contained within IFC files, resulting in a significant time being 

taken to successfully extract it. 

 

 
Figure 3-102: The IFC Import Editor – Defining the Floor and Objects. 
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Figure 3-103 shows a preview of the selected objects within a given floor as displayed within 

the IFC Import Editor.  Once the structural elements (i.e. objects) have been displayed the user 

can then rotate the view in order to better examine the imported structure.  If the user deems 

that unnecessary structural information has been included within the current floor then they can 

return to the previous screen (see Figure 3-102) by clicking the BACK button. The unnecessary 

objects can then be deselected and the reduced structure can be displayed again by clicking the 

NEXT button.  Similarly, users can also return to the initial screen in order to add structural 

elements (i.e. objects) which had previously not been included.   

 

When the user has determined that the elements selected within the given floor define accurately 

the limits of the circulation space (i.e. the region necessary for evacuation modelling) they are 

then required to define an appropriate cross section. The information from the cross section will 

be used to define the boundary of the circulation area within buildingEXODUS. The cross 

section corresponds to a plane through the structure at a given height. The intersections between 

this plane and the structure are then assumed to correspond to the walls which will be imported 

into buildingEXODUS. Users can define the height of the cross section via the Cross Section 

Position edit box located in the bottom left hand corner of the IFC Import Editor. By default 

this is assumed to correspond to the height of the lowest point of the currently selected floor. 

Hence, if a given floor is assumed to be 3.5m above ground level then its corresponding default 

Cross Section Position will be 3.5m.  To view the boundaries resulting from the intersection of 

the defined cross section and the structure the user can simply click the NEXT button. 

 

NOTE: 

It may take some time to successfully generate the boundaries resulting from the intersection 

of the defined cross section and the structure due to the sizable amount of calculation required. 

This is particularly evident both in large geometries and when the default cross section (i.e. 

that corresponding to the lowest point of the currently selected floor) is not used. 
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Figure 3-103: The IFC Import Editor – Defining the Cross Section. 

 

Figure 3-104 shows the IFC Import Editor displaying a preview of a floor’s boundary (shown 

in yellow) resulting from the intersection of the cross section plane and the structure itself 

(shown as semi-transparent).  
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Figure 3-104: The IFC Import Editor – Previewing the Cross Section. 

 

It is important to note that when defining an appropriate cross section it is necessary to consider 

the heights at which doors/windows start. In many instances, the holes representing door ways 

are assumed not to be flush with the floor itself, but are instead raised slightly (i.e. by a few 

centimetres resulting in a visible lip below the door, see Figure 3-103). In this instance, if users 

were to merely assume a cross section at its default height (i.e. at floor level) the plane would 

not pass through the gap representing the door way, but would instead merely intersect with the 

lip below the door. As a result, a wall would be drawn across where the door is present, and 

hence no space would be left in order to represent the presence of the door (see Figure 3-105(a)). 

Users may therefore need to increase the height of the cross section by a few centimetres in 

order to ensure that door ways are correctly recognised (see Figure 3-105(b)).  Caution should 

however be exhibited when increasing the height of the cross section, since increasing it too 

much may result in the plane passing through windows, in turn resulting in them being 

represented as openings (i.e. doorways) within the structure (see Figure 3-105(c)). 

 

If the user deems that the previewed boundary is not an accurate reflection of the current floor’s 

corresponding boundary then they can return to the previous screen (by clicking the BACK 

button) and redefine the position (i.e. height) of the cross section.  Once the cross section has 

been redefined this can then once again be previewed. This process can be iterated until the user 

is confident that the displayed boundary accurately reflects that of the currently selected floor.  

The FINISH button can then be clicked in order to complete the process, whereupon the 

displayed boundary lines will be imported into the selected geometry window within 

buildingEXODUS. 



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 130 

 

  
(a) 0.0m (b) 0.4m 

 
(c) 1.2m 

Figure 3-105: The Boundaries Resulting from Three Different Cross Section Positions. 

 

NOTE: 

Simply importing a BIM/IFC file into buildingEXODUS does NOT complete the geometry 

definition. This merely represents the first stage of defining the geometry, since The nodes and 

arcs etc. still need to be specified.  

 

3.4.4 Importing a CFD Geometry File 

Selecting to import either a SMARTFIRE file (i.e. *.SMF) or an FDS file (*.FDS) will result 

in all the information that this file contains being loaded and displayed within the CFD Import 

Editor (see Figure 3-106).  Unlike either DXF files (see Section 3.4.1) or BIM/IFC files (see 

Section 3.4.3) the entire geometry will be read in and displayed (i.e. all of the defined floors).  

Hence the user is not initially required to define which particular floor they wish to display or 

work on.  Similarly, the user is not required to define which specific elements are displayed, 

since within these files all elements are assumed to be of the same type. Furthermore, it is 

assumed that the area modelled for the purposes of determining the fire spread will also 

correspond to the circulation area that will be modelled for evacuation purposes. 
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Once the geometry has been loaded the user is required to define an appropriate cross section 

in order to define the boundary of the circulation area.  As with loading BIM/IFC files (see 

Section 3.4.3), the cross section corresponds to a plane through the structure at a given height, 

with any intersections between the plane and the structure itself being assumed to correspond 

to walls which will then be imported into buildingEXODUS. Users can once again define the 

height of the cross section via the Cross Section Position edit box located in the bottom left 

hand corner of the CFD Import Editor. By default the Cross Section Position is assumed to be 

0.0m (i.e. ground level).  By modifying the Cross Section Position the user can effectively 

define which floor they wish to model, and similarly which elements within that floor (i.e. walls, 

tables etc.) will be considered.  To view the boundaries resulting from the intersection of the 

defined cross section and the structure the user can simply click the NEXT button. 

 

 
Figure 3-106: The CFD Import Editor – Defining the Cross Section. 

 

Figure 3-107 shows the CFD Import Editor displaying a preview of a given floor’s boundary 

(shown in yellow) resulting from the intersection of the cross section plane and the structure 

itself (shown as semi-transparent).  

 

As with defining the cross section plane within BIM/IFC geometries (see Section 3.4.3), if the 

user deems that the previewed boundary is not an accurate reflection of the desired floor’s 

corresponding boundary then they can return to the previous screen (by clicking the BACK 

button) and redefine the position (i.e. height) of the cross section.  Once the cross section has 

been redefined this can then once again be previewed. This process can once again be iterated 

numerous times until the user is confident that the displayed boundary accurately reflects that 
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of the required floor.  The FINISH button can then be clicked in order to complete the process, 

whereupon the displayed boundary lines will be imported into the selected geometry window 

within buildingEXODUS. 

 

 
Figure 3-107: The CFD Import Editor – Previewing the Cross Section. 

 

NOTE: 

Simply importing a SMARTFIRE or FDS file (i.e. .SMF or .FDS)  into buildingEXODUS does 

NOT complete the geometry definition. This merely represents the first stage of defining the 

geometry, since the nodes and arcs etc. still need to be specified. 

 

3.4.5 Defining the Appearance of a given Floor/Geometry Window 

Shortcut: [Tools/Floor/Info.] 
The Floor Info. facility allows the user to control various aspects of the appearance of a given 

floor, both within buildingEXODUS and within its virtual reality representations (i.e.  

vrEXODUS and the 3D View (see Section 3.3.4.7.6), Level B and C Users only). This includes 

the ability to change the name of the floor, specify the imported third party geometry file (i.e. 

DXF, IFC, FDS or SMF) used to define the boundaries of the floor and also control the floor’s 

height and its corresponding floor tile within vrEXODUS/3D View. 

 

The Floor Info facility enables users to both determine which imported geometry file is 

currently in use in a particular geometry window, and also assign a different geometry file if 

required. This facility is particularly useful when an imported geometry file has already been 
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loaded into the geometry (e.g. when there are a number of floors in the geometry that require 

different geometry files).  To use this facility, select Tools from the menu bar, the Floor sub-

menu and the Info item from the pull-down menu (see Figure 3-2).  This displays the Floor Info 

dialogue box (see Figure 3-108). Within this dialogue box the name of the imported third party 

geometry file (i.e. DXF, IFC, FDS or SMF) currently assigned to the corresponding 

floor/geometry window is displayed within the Boundary File edit box. It is important to note 

that this edit box is disabled, and hence is merely used to display currently selected imported 

geometry file (i.e. users cannot change the associated geometry file by changing the name of 

the file within the Boundary File edit box). Users wishing to change the imported geometry file 

currently used to define the boundary in a particular geometry window should instead click the 

Load Boundary button. This will then in turn display an Open dialogue box enabling the user 

to navigate their directories and locate the required geometry file. If the user is unable to locate 

the geometry file previously defined then the Open dialogue box will also enable them to search 

for the file.  It is important to note that the importing of geometry files via the Floor Info 

dialogue box achieves the same results as loading them via the Tools/Construction/Load 

Boundary menu option within Geometry mode (see Section 3.4.1). 

 

 
Figure 3-108: The Floor Info dialogue box 

 

When importing a boundary from a third party geometry file (i.e. DXF, IFC, FDS or SMF), 

only the outline (walls and internal compartments) of the enclosure are created. It is still 

necessary to create the two-dimensional grid of nodes and connecting arcs, and to specify exit 

nodes etc. 

 

NOTE:  

The Floor Info facility is particularly useful for replacing existing DXF files with new or 

updated DXF files. 

 

In addition to enabling the user to define the geometry file used to generate a boundary in a 

particular geometry window, the Floor Info dialogue box also enables the user to change the 

name of the corresponding floor/geometry window via the Title edit box (i.e. GroundFloor in 

Figure 3-108).   

 

The Floor Info dialogue box also enables the user to control various aspects of the appearance 

of the floor/geometry window within vrEXODUS/3D View (Level B and C Users only).  The 

physical height of each floor can be defined via the Floor To Floor Height edit box (see Figure 

3-108).  It is important to note that this attribute effectively defines the total vertical distance 

between the corresponding floor and the floor directly above it (see Figure 3-109). It DOES 

NOT merely represent the height between the floor and the ceiling, since this height would not 

include the depth of the ceiling region between the two adjacent floors.  
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Figure 3-109: The Floor To Floor Heights within a simple two floor structure  

 

Similarly the Floor To Floor Height DOES NOT define the overall height at which the floor 

will be depicted within vrEXODUS/3D View.  For example, Figure 3-110 below shows the 

heights of three adjacent floors relative to the lowest floor (i.e. the Ground Floor). In this 

example, the Floor To Floor Height of the Ground Floor would simply be defined as 3m (since 

the First Floor is 3m above that of the Ground Floor), while the Floor To Floor Height of the 

First Floor would in contrast be defined as 2m (since the Second Floor is 2m above that of the 

First Floor). Using this approach the overall height of a given floor can be seen to be the sum 

of the Floor To Floor Heights of all the floors directly below it. By default all floors are assumed 

to have a Floor To Floor Height of 3m. 

 

 
Figure 3-110: The relative heights of three adjacent floors  
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NOTE:  

It is important to correctly define the Floor To Floor Heights of each floor in order to accurately 

represent the height differences between floors within vrEXODUS/3D View. Failure to 

correctly define the Floor To Floor Heights of floors may result in stairs and escalators from 

lower floors protruding through the floor, thereby negatively affectively the realism of the 

representation within vrEXODUS/3D View. 

 

NOTE: 

It is also important to correctly define the Floor To Floor Heights of each floor when modelling 

a structure comprising lifts. Within buildingEXODUS the distance travelled by lifts when 

moving between floors is calculated based upon the Floor To Floor Heights of the 

corresponding floors that it moves between. Failure to correctly define the heights of floors 

may therefore results in the distances lifts are required to travel being incorrect, in turn 

resulting in the time taken for the lifts to move between floors being inaccurate. 

 

NOTE: 

Users wishing to view/edit the heights of multiple floors can also do so via the Floor Heights 

dialogue box (see Section 3.4.9). 

 

In addition to providing the ability to control the heights at which floors are depicted within 

vrEXODUS/3D View, the Floor Info dialogue box also enables users to define polygons 

representing the floor tile of each floor within vrEXODUS/3D View.  By default, no floor tile 

polygons are defined for each floor. Consequently, the floor tile for each floor within 

vrEXODUS/3D View is merely assumed to be a rectangle defined by the minimum and 

maximum X and Y coordinates of the walls within the floor (see Figure 3-111(a)).  In many 

cases the representation of the floor tile of a given floor as a simple rectangle may be deemed 

acceptable by the user. However, in other cases, perhaps those involving multiple floors, 

irregular shaped geometries or the requirement for a greater sense of realism, users may instead 

want the floor tile of each floor to more closely follow the outline of the geometry (see Figure 

3-111(b))  

 

  
(a) (b) 

Figure 3-111: A single floor of a geometry with a) no VR floor tile polygon defined, and 

b) with a VR floor tile polygon closely following the outline of the floor. 
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In order to define the floor tile of a given floor via the Floor Info dialogue box the user must 

first create the polygon (or polygons) defining the required floor tile within the corresponding 

floors geometry window. The generation of polygons defining the floor tile of floors can either 

be done automatically by buildingEXODUS or manually by the user. 

 

Manually generating polygons is achieved in Geometry mode by selecting the Generate option 

within the Tools menu, and then selecting the Polygon option within the resulting submenu. 

Alternatively the user can merely click the Polygon button  on the toolbar (assuming the 

Line/Polygon/Text block has previously been added to the toolbar). Once selected, the user is 

then merely required to define each polygon vertex by clicking within the geometry window at 

the required location. Double clicking a polygon vertex will terminate the polygon creation 

process and result in the polygon being finalised. In this manner, users can manually trace 

around the outer edge of a given floor in order to generate polygons which accurately define 

the floor (see Figure 3-111(b)). It is important to note that when manually generating polygons 

in the manner outlined above the user must ensure that the polygons generated do not self 

intersect (i.e. edges of the polygon do not directly cross other edges of the same polygon). 

Polygons which are self intersecting will not load correctly within vrEXODUS/3D View and 

hence should be avoided. 

 

Having manually generated the polygons defining the floor tile of a given floor the user is then 

required to open the Floor Info dialogue box for the corresponding floor and then click the VR 

Floor Tile Polygons button (see Figure 3-108). Clicking this button will result in the VR Floor 

Tile Polygons dialogue box being displayed (see Figure 3-112). When opened all of the 

polygons within the corresponding floors geometry window will by default appear in the 

Available list located on the right hand side of the dialogue box. Any previously defined 

polygons specifying the floors corresponding floor tile in contrast appear in the Selected list on 

the left hand side of the dialogue box. The user can then select which of the available polygons 

are required to define the floor tile by first selecting them within the Available list and then 

clicking the <-Add button. Clicking the <-Add button will then move the selected polygons 

from the Available list to the Selected list. Alternatively users can add all of the Available 

polygons to the Selected list by merely clicking the <-Add All button. Similarly, the user can 

remove polygons from the Selected list by first selecting the polygons from within the Selected 

list and then clicking the Remove-> button. In this manner the user can manipulate exactly 

which polygons define the floor tile of the floor within vrEXODUS/3D View. Clicking the OK 

button will then confirm the selection made by the user and ensure that both the 3D View and 

any VR files subsequently generated will use the selected polygons to define the floors 

corresponding floor tile. It is important to note that once a polygon has been assigned to the 

floor tile of a given floor it will no longer be displayed within that floors geometry window. In 

order to view/manipulate the polygon(s) defining a floor tile the user is therefore first required 

to remove them from the Selected list within the VR Floor Tile Polygons dialogue box (i.e. 

move them back into the Available list), thereby ensuring that they are displayed within the 

geometry window. 
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Figure 3-112: The VR Floor Tile Polygon dialogue box. 

 

As stated previously, the generation of polygons defining the floor tiles of floors can also be 

achieved automatically by buildingEXODUS. This approach can be a lot quicker than the 

manual approach outlined previously since it negates the need for the user to manually create 

the polygons, which for intricate irregular shaped geometries can be quite fiddly, time 

consuming and often error prone. Within buildingEXODUS users can automatically generate 

the floor tiles for floors via the Tools/Construction/Generate VR Floor Tile Polys menu option 

in Geometry mode. For more information on the automatic generation of floor tiles for floors 

see Section 3.4.6. 

 

The use of both manually defined and automatically generated floor tiles, while in many cases 

improving the general appearance of the geometry within vrEXODUS/3D View, will not on 

their own address all of the issues.  In cases where individuals are required to traverse 

stairs/escalators etc. when moving between floors, their avatars will often appear to merely 

walk through the floors floor tiles (see Figure 3-113(a)). This is because the floor tile of the 

floors extends over the area representing the stairwell (see red area in Figure 3-113(b)). 

Consequently, the floor is being drawn in a region where in reality it would not exist. 

 

 
Figure 3-113: Individuals descending a staircase a) moving through the floors 

corresponding floor tile, and b) the region of the floor tile that is not required (shown in 

red). 

 

To overcome this problem, buildingEXODUS provides the ability to effectively delete areas 

from within polygons. In this manner, areas where floor tiles would not be present (i.e. 

stairwells or areas where balconies overlook lower floors) can be removed, thereby greatly 

improving the realism of the representation within vrEXODUS/3D View. 
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To achieve this, the user must first create the polygon defining the floor tile of a given floor. As 

outlined previously, this can either be generated manually by the user or automatically by 

buildingEXODUS.  Having defined the floor tile polygon the user must then in turn create 

polygons defining the regions which are required to be removed from the floor tile polygon (i.e. 

areas representing stairwells etc.). It is important to note that the polygons defining these 

regions have to be defined manually by the user.  It is NOT currently possible for these regions 

to be automatically identified and the corresponding polygons generated directly by 

buildingEXODUS. As with manually defining the floor tile polygons outlined previously, when 

manually generating polygons the user must ensure that the polygons generated do not self 

intersect (i.e. edges of the polygon do not directly cross other edges of the same polygon).  

 

Having generated polygons defining both the floor tile and the regions to be removed, the user 

can then set about removing the unwanted areas. This can be achieved in two ways. For the first 

method the user must ensure that all the polygons are displayed within the floors corresponding 

geometry window. Hence, if the user has previously assigned a polygon to the floor tile of the 

floor (i.e. by adding it to the Selected list within the VR Floor Tile Polygons dialogue box, see 

Figure 3-112), they must first disassociate it. As outlined previously, this is achieved within the 

VR Floor Tile Polygons dialogue box by moving the polygon from the Selected list back to the 

Available list.  Once the polygons defining both the floor tile and the regions to be removed are 

both displayed within the floors corresponding geometry window, the user should then simply 

right click on the floor tile polygon. This will display the pop-up menu shown in Figure 

3-114(a), from which the Remove Poly From Poly option should then be selected. Having 

selected this option the user will then be confronted with a dialogue box asking them to define 

the Label of the polygon that is to be removed.  If the user is unclear what the Label of the 

polygon to be removed is, they can find out by simply double clicking on the given polygon in 

order to show its corresponding dialogue box in which the Label will be displayed. 

 

 

 

 

(a) (b) 

Figure 3-114: a) Removing the red inner polygon (representing a stairwell) from the 

green outer polygon representing the VR floor tile. 
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Having provided the Label of the polygon to be removed and clicked OK, the polygon will then 

be removed from the floor tile. At first it may appear as if nothing has happened. This is because 

while the area represented by the specified polygon has been removed from the floor tile, the 

polygon defining the region itself is still present. To fully observe the effect of removing the 

polygon from the floor tile the user should therefore simply delete the polygon defining the 

unwanted region. This can be achieved by simply double clicking on the polygon in order to 

display its corresponding dialogue box and then simply clicking the Delete button. Upon 

deletion of this polygon it is immediately apparent that the corresponding region has been 

deleted from the floor tile (see Figure 3-114(b)). Having deleted the required regions from the 

floor tile polygon it then needs to be re-assigned to the floor. Once again this is achieved by 

opening the Floor Info dialogue box, clicking the VR Floor Tile Polygons button and then 

moving the floor tile polygon into the Selected list (see Figure 3-112). 

 

Alternatively, users can remove unwanted regions from floor tile polygons using a second 

simpler method. To utilise this method the user must first ensure that the floor tiles are defined 

within the Selected list of their corresponding VR Floor Tile Polygon dialogue box (i.e. that the 

floor tile polygons are not currently displayed within their corresponding floors geometry 

windows, see Figure 3-112). Having ensured this is the case, the user can then simply right 

click on the polygon defining the region to be removed (which unlike the floor tile polygons 

should still be displayed within the geometry window). Right clicking on the polygon will 

display its corresponding pop-up menu. From this pop-up menu the Remove Poly From VR 

Floor Tile Polys option should then be selected, and the Current Window option then selected 

from within the resulting submenu (see Figure 3-115). Selecting this option will automatically 

remove the polygon from its corresponding floor tile (i.e. the floor tile for the floor in which 

the polygon is located). 

 

 
Figure 3-115: Removing a Polygon directly from its floors VR Floor Tile Polygons.  

 

Utilising this method also enables unwanted regions to be removed from multiple floors 

simultaneously. The regions can be removed from the floor tile polygons of a user defined 

number of floors in either the up or down direction. This can be achieved by right clicking on 

the polygon defining the unwanted region, selecting the Remove Poly From VR Floor Tile Polys 

option within the pop-up menu and then selecting the X Up or X Down options respectively. 

Upon selecting these options a dialogue box will be displayed enabling the user to define the 

number of floors from which the region should be removed. Hence, selecting the X Up option 

and defining three floors will result in the region defined by the selected polygon being removed 
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from the floor tile of both the current floor (i.e. the floor in which the selected polygon is 

located) and the floor tiles on each of the three floors directly above.  The ability to remove 

regions from multiple floors simultaneously is very useful when modelling stairwells which 

traverse multiple floors. 

 

NOTE: 

Selecting either the X Up or X Down options from Remove Poly From VR Floor Tile Polys (see 

Figure 3-115) and defining 0 floors will result in only the selected polygon being removed from 

the current floor (i.e. floor in which the selected polygon is located). Hence this will achieve 

the same as merely selecting the Current Window option. 

 

Having removed any unwanted regions from the floor tile polygons, both the 3D View and any 

VR files subsequently generated will use the selected polygon to define the floors 

corresponding floor tile, and hence the unwanted regions (i.e. stairwells etc.) will not be 

included in the floors corresponding floor tile within vrEXODUS/3D View. Figure 3-116 below 

shows the results in vrEXODUS of removing a stairwell region from the floor tile of a given 

floor. In contrast to the screenshots of the same geometry shown in Figure 3-113, it can clearly 

be seen that the stairwell region has now been removed. Consequently the both the staircase 

and the floor below are visible and the individuals are no longer observed moving through the 

floor tile during their descent to the lower floor. 

 

 
Figure 3-116: Individuals descending a staircase with the region representing the 

stairwell removed from the floors corresponding VR floor tile polygon. 

 

Using this approach, users can delete multiple regions from the floor tiles of individual floors. 

However, while deleting these unwanted regions may increase the realism of the representation 

within vrEXODUS/3D View, it may be quite time consuming. Users will therefore need to 

assess in each case whether the visual gains are worth the extra time and work required. 

 

It is also worth noting that it is only possible to remove one polygon from another in the manner 

outlined previously if there are no intersections between the boundaries of the two polygons. 

Hence, the polygon to be removed must be located entirely within the outer polygon. If any 

boundary intersections exist between the two polygons an error message will be displayed to 

the user informing them of the problem and stating that the requested action could not be 

completed. Figure 3-117 below demonstrates various scenarios related to the attempted removal 

of the green polygon from the larger outer pink one. Here it can clearly be seen that in both 
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Figure 3-117(a) and Figure 3-117(b) the boundaries of the two polygons intersect. 

Consequently, in these two instances the removal of the green polygon from the outer pink 

polygon would not be permitted. In contrast, Figure 3-117(c) shows that the boundaries of the 

two polygons do not intersect, and hence that the green polygon is entirely located within the 

larger outer polygon. In this instance the green polygon could therefore be successfully 

removed. 

 

  
 

(a) (b) (c) 

Figure 3-117: The restrictions ensuring that one polygon can only be removed from 

another if it is entirely located within it (i.e. no intersections exist between the two). 

 

It is worth noting that the removal of a given region is achieved by merely inserting the vertices 

of the inner polygon into the vertex list of the outer polygon. Figure 3-118(a) below shows the 

polygon resulting from removal of the internal region shown previously in Figure 3-118. Here 

it can clearly be seen that the internal region has been removed from the outer polygon simply 

by the insertion of the vertices of the region (i.e. A, B, C and D, see Figure 3-118) into the outer 

polygons vertex list. In addition, the vertices E and F have also been added in order to complete 

the loop, and hence to effectively return to the same point prior to the insertion of the vertices. 

It should be noted that in this example the position of some of the vertices have been shifted 

slightly in order to more clearly demonstrate the manner in which the process works. In reality 

the coordinates of vertices A and E would be the same, and similarly the coordinates of vertex 

F would be the same as the coordinates of the vertex immediately prior to the first inserted 

vertex (i.e. the vertex immediately prior to vertex A). As a result, the boundaries of the polygon 

both to and from the deleted region (indicated by the orange arrows in Figure 3-118 (a)) would 

not normally be visible.  
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(a) (b) 

Figure 3-118: a) The vertices of a polygon after an internal region has been removed, 

and b) removing individual vertices within a given polygon. 

 

If the user wishes to effectively undo the deletion of a given region from a polygon, this can be 

achieved by simply deleting the additional vertices which have been inserted (i.e. vertices A, 

B, C, D, E and F in Figure 3-118(a)). To do this simply right click on each vertex in order to 

display the corresponding Vertex popup menu, and then select the Remove Vertex option (see 

Figure 3-118(b)). 

 

When removing multiple regions from inside a single polygon the user may need to consider 

the order in which the regions are removed. Figure 3-119(a) shows a typical polygon (pink) 

from which two regions (i.e. A and B) are required to be removed. If the user were to first 

remove region B from the polygon, the vertices of region B would be inserted into the polygon 

in the manner outlined previously. Figure 3-119(b) demonstrates the polygon resulting from the 

removal of region B. Here it can clearly be seen that in this instance the insertion of the vertices 

of region B has created two additional boundaries, both two and from the vertices, which go 

directly through the middle of region A (i.e. the other region to be removed). As a result, it 

would not be possible to then remove region A from the resulting polygon. This is because, as 

outlined previously, it is only possible to remove one polygon from another if there are no 

intersections between the boundaries of the two polygons, and hence that the polygon to be 

removed is located entirely within the outer polygon. Consequently, in this instance users 

should first remove region A from the polygon and only then remove region B (see Figure 

3-119(c)). Users therefore need to consider the order in which regions should be removed, and 

bear in mind the additional boundaries created both to and from the deleted region as a result 

of deleting the region. In general, it is advisable to delete the regions located closest to the 

boundary of the given polygon first and then delete the regions increasing closer to the centre 

of the polygon. Regions located in the centre of the polygon should therefore generally be the 

last to be removed. 
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Figure 3-119: a) Removing two regions (i.e. A and B) from inside a given polygon, b) the 

polygon resulting from the removal of region B, and c) the polygon resulting from the 

removal of first region A and then region B. 

 

NOTE:  

The VR Floor Tile Polygons of a given floor do not affect the results generated within the 

simulation. The VR Floor Tile Polygons merely affect the appearance of the floor within 

vrEXODUS/3D View. 

 

3.4.6 Generating VR Floor Polygons 

Shortcut: [Tools/Construction/Generate VR Floor Tile Polys] 
buildingEXODUS provides the facility to automatically generate polygons in order to more 

accurately represent the floor tile of each floor within vrEXODUS/3D View.  By default, no 

floor tile polygons are defined for each floor. Consequently, the floor tile for each floor within 

vrEXODUS is merely assumed to be a rectangle defined by the minimum and maximum X and 

Y coordinates of the walls within the floor (see Figure 3-120(a)).  In many cases the 

representation of the floor tile of a given floor as a simple rectangle may be deemed acceptable 

by the user. However, in other cases, perhaps those involving multiple floors, irregular shaped 

geometries or the requirement for a greater sense of realism, users may instead want the floor 

tile of each floor to more closely follow the outline of the geometry (see Figure 3-120(b))  

 

  
(a) (b) 

Figure 3-120: A single floor of a geometry with a) no VR floor tile polygon defined, and 

b) with a VR floor tile polygon closely following the outline of the floor. 
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Within buildingEXODUS users can automatically generate the floor tile for a specific floor by 

first ensuring that the corresponding floors geometry window is the currently selected window.  

The user should then select Tools/Construction/Generate VR Floor Tile Polys from the menu 

and then select the Current Window option from the resulting submenu. Having selected this 

option buildingEXODUS will then set about analysing the walls within the given floor and then 

using them to generate corresponding VR floor tile polygons. Once the polygons defining the 

floor tile have been generated these are then automatically directly added into the Selected list 

within the floors corresponding VR Floor Tile Polygons dialogue box (see Section 3.4.5). 

Hence, both the 3D View and any VR files subsequently generated will use the generated 

polygons to define the selected floors corresponding floor tile.  Alternatively users can 

automatically generate the floor tiles for all floors within the geometry by selecting 

Tools/Construction/Generate VR Floor Tile Polys from the menu and then selecting the All 

Windows option from the resulting submenu. It is important to note that when generated 

polygons are automatically added to the Selected list within a floors corresponding VR Floor 

Tile Polygons dialogue box (see Section 3.4.5), any existing polygons within the list are deleted. 

As a result, the newly generated polygons effectively overwrite any existing polygons defined 

by the user.  

 

It is important to note that in order to successfully generate the floor tile for a given floor the 

floor must first have a continuous boundary (i.e. the internal region of the floor must be 

completely separated from the corresponding outer region). Hence, there must be no holes 

within the outer boundary of the floor. Figure 3-121 below shows the polygons (shown in green) 

generated as a result of attempting to generate a floor tile for a floor with a hole in its outer 

boundary. Here it can clearly be seen that as a result of the hole in the boundary 

buildingEXODUS has been unable to correctly calculate the floor tile of the floor. 

 

 
Figure 3-121: The VR floor tile polygons (shown in green) generated for a given floor 

with a non continuous boundary. 
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To solve this problem, and hence to ensure that floor tiles are successfully generated, users are 

required to seal all holes within a given floors outer boundary prior to generating its 

corresponding floor tile. Within buildingEXODUS this can be achieved by simply manually 

generating lines in order to seal the offending holes (see Section 3.3.1.16). Figure 3-122 below 

shows the same geometry outlined previously in Figure 3-121. In this instance however the 

offending hole within the outer boundary has been sealed by a single line prior to the generation 

of the floor tile. As a result, buildingEXODUS has been able to accurately determine the regions 

inside and outside of the floor, and hence correctly generate the floors corresponding floor tile. 

Once a floor’s corresponding floor tile has been successfully generated in the manner outlined 

above, the user is free to delete the lines added in order to seal the holes. 

 

 
Figure 3-122: The VR floor tile polygon (shown in green) generated for a given floor 

with a continuous boundary (i.e. spaces sealed via user generated lines). 

 

3.4.7 Flooding an area with nodes using the Node Flood facility. 

Shortcut: [Tools/Construction/Node Flood] 
Once the geometry outline has been specified it is necessary to construct the grid of nodes.  This 

is accomplished by filling an area with nodes. 

  

To fill an area with a particular type of node, select Tools from the menu bar, the Construction 

sub-menu and then the Node Flood item from the Tools menu. Once Node Flood is selected 

click on the geometry window and within the area you wish to fill with nodes. Immediately 

buildingEXODUS will start generating nodes and arcs. Note that the enclosure to be filled using 

this technique must have a closed boundary otherwise nodes will “escape” from the gaps and 

will be generated outside the enclosure as well. To prevent this, the user should manually add 

some nodes (or generate a Line) along the gaps of the boundary to close them.  This technique 

is demonstrated in Figure 3-123.  Node flood attempts to place a grid of 0.5m x 0.5m nodes 

across the enclosure. 
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Figure 3-123: Flood-Filling an imported third party geometry file (DXF) 

 

NOTE: 

Slightly different node distributions can result from flooding the geometry with nodes 

depending on the location of the initial mouse click. In the majority of cases these differences 

will be of no consequence. However, in certain situations such as in narrow regions of the 

geometry (e.g. a narrow corridor or door opening) too few or too many nodes may be created 

for the space available. It is strongly advised that as part of the checking procedure these 

regions are examined after a flood fill to ensure that the correct number of nodes have been 

created. If upon examination an unsatisfactory node distribution has been created within a sub 

region, selectively delete the nodes in that region and repeat the node flood procedure.  Once 

the new region has been flooded, manually connect the nodes in the newly flooded region to the 

previous region.  

 

TIP: 

Disable the display of Arcs to increase the speed of the node flood considerably.  When 

completed, switch on Boundary before attempting any other operations. 

 

TIP: 

When Node-filling a geometry it is recommended that non Free-Space nodes are used to fill in 

potential gaps within a geometry e.g. seat nodes.  The nodes used to plug the gaps in the 

geometry will then appear different to the Free-Space nodes used in the Node Flooding of the 

geometry. This will simplify the removal of unnecessary nodes, once the nodal generation is 

complete. Alternatively, a Line may be drawn across the offending gap preventing the nodes 

leaking out. 

 

3.4.8 Geometry Shift. 

Shortcut: [Tools/Construction/Geometry Shift] 
The Geometry Shift facility allows the user to shift all of the objects (i.e. nodes, lines, people 

etc.) within a particular geometry window by given amounts in both the X and Y directions. To 

shift the objects within a given window first ensure that the window is selected and then select 

Tools from the menu bar, the Construction option and then the Geometry Shift item from the 

pull-down menu (see Figure 3-2). Once Geometry Shift has been selected the user is then asked 

to supply the size of the respective shifts in the X and Y directions via the X SHIFT and Y 

SHIFT dialogue boxes (see Figure 3-124 (a) and (b)). 
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(a) (b) 

Figure 3-124: (a) The X Shift dialogue box. (b) The Y Shift dialogue box. 

 

In both cases these shifts can be either positive (indicating a shift away from the origin) or 

negative (indicating a shift towards the origin), where the origin corresponds to the extreme top 

left hand corner of the screen. Figure 3-125 (a) and (b) demonstrate an example of this function 

being used. 

 

  
(a) (b) 

Figure 3-125: Example of the geometry shift function. In (a) the original location of 

the geometry within the window is displayed. In (b) the location of the geometry 

after a geometry shift of -8.0 and -7.0 metres in the X and Y directions respectively 

is displayed. 

 

TIP: 

This function is particularly useful for aligning multiple floors prior to the generation of a VR 

replay file.  

 

3.4.9 Defining the Height of Individual Floors 

Shortcut: [Tools/Construction/Floor Heights] 
Within buildingEXODUS the accurate definition of the heights of each floor is important in 

order to accurately represent the height differences between floors within both vrEXODUS and 

the 3D View (Level B and C Users only). Failure to correctly define the heights of each floor 

may result in stairs and escalators from lower floors protruding through the floor, thereby 

negatively affectively the realism of the representation within vrEXODUS/3D View.  Within 

buildingEXODUS the user has the ability to quickly and easily define the physical height of 

each floor via the Floor Heights dialogue box (see Figure 3-126). 

 



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 148 

 
Figure 3-126: The Floor Heights dialogue box 

 

The Floor Heights dialogue box is accessible in Geometry mode by selecting Tools from the 

menu bar, Construction from the menu and the Floor Heights option from the resulting 

submenu (see Figure 3-127(a)).  Alternatively the Floor Heights dialogue can be accessed by 

right clicking on the Floors item within the left hand Navigation window and then selecting the 

Floor Heights option from within the resulting pop-up menu (see Figure 3-127(b)). 

 

 

 

(a) (b) 

Figure 3-127: Accessing the Floor Heights dialogue box. 

 

Within the Floor Heights dialogue box the physical height of each floor can be defined via its 

corresponding Floor To Floor Height value.  This value effectively defines the vertical distance 

between the corresponding floor and the floor directly above it. It is important to note that it 

DOES NOT define the overall height at which the floor will be depicted within vrEXODUS/3D 

View (i.e. its height above ground level).  Using this approach the overall height of a given floor 

can therefore be seen to be the sum of the Floor To Floor Heights of all the floors directly 

below it.  For example, consider the floors shown in Figure 3-126. If we assume that Floor_0 

is at ground level (i.e. 0m) then Floor_1 will therefore be 3m above ground level (i.e. the height 

of Floor_0). Similarly, Floor_2 will be at 6m above ground level (i.e. the combined heights of 

Floor_0 and Floor_1) etc. 

 

It is important to note that defining the height of a given floor within the Floor Heights dialogue 

box is an alternative to the method of defining the floor height via the Floor Info dialogue box 

(see Section 3.4.5).  The Floor Info dialogue box is (amongst other things) used to define the 

height of an individual floor.  Consequently users wishing to view/edit the heights of each floor 

using this method would typically be required to open the Floor Info dialogue box for each 

floor in turn, something which can be an extremely tiresome process, especially when the 
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geometry consists of a large number of floors.  For this reason the Floor Heights dialogue box 

was developed in order to enable users to both view and edit the heights of each floor within a 

single dialogue box. 

 

NOTE: 

It is important to correctly define the Floor To Floor Heights of each floor when modelling a 

structure comprising lifts. Within buildingEXODUS the distance travelled by lifts when moving 

between floors is calculated based upon the Floor To Floor Heights of the corresponding floors 

that it moves between. Failure to correctly define the heights of floors may therefore results in 

the distances lifts are required to travel being incorrect, in turn resulting in the time taken for 

the lifts to move between floors being inaccurate. 

 

3.5 Selecting a Geometry From The Geometry Library 

Shortcut: [File/Open]  
To select a previously constructed and saved geometry from the Geometry library, select File 

from the menu bar and the Open item from the pull-down menu (see Figure 3-2) or press the 

Open button on the toolbar (see Figure 3-1).  A dialogue box will appear (see Figure 3-128) 

from which the user can select the case of interest. Once selected, click on the OK button using 

the left mouse button to load the case. 

 

 
Figure 3-128: The open model dialogue box 

 

By default, buildingEXODUS will search for .EXO files, as these are quicker to load.  To search 

for .MTA files (buildingEXODUS ASCII files) simply change the extension in the Files of type 

box, and proceed as normal. 

 

NOTE: 

Larger geometries take longer to load and draw. 

 

NOTE: 

After loading a geometry, buildingEXODUS will automatically change the mode of operation.  If 

a population is present in the geometry (see Chapter 4), this will be SIMULATION mode, 

otherwise POPULATION mode (see Chapter 4). 
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3.6 Importing Geometries into the Current Geometry 

Shortcut: [Tools/Geometry/Import] 
The purpose of importing geometries is to allow existing geometries to be inserted into the 

current geometry.  In this way large geometries may be created from smaller ones.  To insert 

an existing geometry into the current geometry window, select Tools from the menu bar and 

the Import item from the Geometry sub-down menu (see Figure 3-2).  A dialogue box will 

appear prompting the user for a file name, similar to the OPEN FILE dialogue box (see Figure 

3-128). 

 

NOTE: 

Geometries that are imported may overwrite some portions of the current geometries.  It is 

suggested that this option is used with great care. If the geometries are intended to represent 

new floors, then New should be selected from the Floor sub-menu via the Tool menu prior to 

importing the geometry (see Section 3.9.1). 

 

3.7 Exporting Geometries 

Shortcut: [Tools/Geometry/Export] 
The purpose of exporting geometries is to allow a portion of the current geometry to be saved 

in a separate buildingEXODUS geometry file. To export a portion of the existing geometry, 

first select the portion that is to be exported (see Section 3.3.3.1).  Then, select Tools from the 

menu bar, the Geometry sub-menu and the Export item from the pull-down menu (see Figure 

3-2).  A dialogue box will appear prompting the user for a file name, similar to the SAVE FILE 

dialogue box. 

 

3.8 Transit Nodes 

Shortcut: [Tools/Generate/Transit Node] 
As described within Section 3.3.1.9, Transit Nodes can now be used to represent Staircases, 

Escalators, Travelators, Lift Shaft Openings, Corridors and Metered Gates as single entities. 

Transit Nodes are able to represent a greater range of components, more behaviours, produce a 

wider variety of output, and simplify user activities, in comparison with previous comparable 

functionality (e.g. Stair Nodes). The following sections describe how to construct each of these 

nodes, connect them to the adjacent geometry, together with other features specific to the 

Transit Node type. 

 

3.8.1 Generating Transit Nodes 

All Transit Nodes are generated in the same manner, by selecting the Generate option via the 

Tools menu and then Transit Node option as indicated in Figure 3-129. 
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Figure 3-129: Creating Transit Nodes 

 

Each new Transit Node can be generated by clicking in the appropriate location within the 

Geometry Window. As a default, the Transit Node created will be a Stair. The user can modify 

the type of Transit Node by selecting the desired option from the Node Type drop-down list, 

within the Properties tab of the Transit Node dialogue box (see Figure 3-130). 

 

 
Figure 3-130: Transit Node Dialogue box 

 

Once a Transit Node has been generated, the user is then able to modify the key attributes via 

the Transit Node dialogue box (see Figure 3-130). The options available are broadly consistent 

across the different Transit Node variants: Staircases, Escalators, Travelators, Lift Shaft 

Openings, Corridors and Metered Gates. These options are described in Table 3-6.  
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Table 3-6: Transit Node Dialogue Box Attributes 
Attribute Stair Escalator Travelator Metered 

Gate 

Corridor Lift Shaft 

Opening 

Show People 

Icon 

     

 

Hide People 

Icon 

 
Title Name of object 

Label System label 

Node Type Staircase Escalator Travelator Metered Gate Corridor Lift Shaft 

Opening 

Icon Type Choice between a node showing people travelling along the node or a simple counter representation 

that does not show people. 

Position Central X,Y location on the screen. 

Direction Nodal direction in degrees - the direction it is displayed in the geometry window 

Travel 

Direction 

Direction of travel (bi-directional, up/forward, down/backward) NA 

Capacity Maximum number of people simultaneously allowed on the node at any one time. Associated 

Lift Capacity 

Lanes Number of lanes (i.e. number of people that can simultaneously stand side-by-side on the node) 

Riser 

Number/Lane 

Capacity 

Riser 

Number 

Lane Capacity Lane 

Capacity 

Lane Capacity Lane Capacity NA 

Definition Type Enables the dimensions of the component to be defined either by defining the height 

and length of the overall component, or alternatively by defining the dimensions of 

its sub units (i.e. riser height/tread depth or sub-unit height/sub-unit length etc.) 

NA 

Width The physical width of the entire component 

Height Vertical travel distance N/A 

Length Horizontal travel distance 

Riser Height/ 

Sun-Unit 

Height 

Height of Riser (m) N/A 

Tread Depth/ 

Sun-Unit 

Length 

Depth of Tread (m) The length of the Sub-Unit NA 

Nosing The length 

of the step 

over hang 

N/A 

OK Button Close dialogue box and accept new data 

Cancel Button Close dialogue box and lose data settings. 

Apply Button Accepts new data settings without closing dialogue box. 

Restore Button Restores the original data values. 

Delete Button Deletes the transit node. 

Range Button Displays the current catchment area of the component within the geometry. 

Behaviour Tab Accessed in Scenario Mode (see Chapter 5) 

Advanced Tab See below. 

Narcotic / 

Irritants Tabs  

Displays hazard and toxicity data over the environmental region included in the Transit Node.  
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The functionality available to the user for the different Transit node types is described in the 

following sections. Irrespective of the Transit Node type, the process of connecting the node to 

the rest of the geometry is the same. 

 

For all of the Transit Node types, there are two viewing modes: Show People displays the 

occupant population traversing the component in question in a naturalistic manner; and Hide 

People merely displays the number of occupants using the transit node at any one time. The 

simulated conditions are identical in both cases; i.e. the underlying factors, behaviours and 

performance are the same - only the visual representation is different. Both modes may be used 

when the simulation is run; however, Show People should be used when connecting the Transit 

Node in order to ensure the correct level of connectivity.  

 

The viewing mode is accessible by selecting Icon Type within the Transit Node dialogue box.  

In Show People mode the components differ in appearance (see Table 3-6); in Hide People 

mode the components appear the same (see Figure 3-131). The user is therefore not able to 

distinguish between different Transit Node types or their respective dimensions when Hide 

People mode is selected. However, this mode may be useful in particularly large geometries 

where the detailed movement of individuals on the staircase will not be apparent; therefore, 

only the number of people occupying the stair at any one time will be shown.  

 

 
Figure 3-131: The alternative Hide People representation of the transit node (using a 

counter box). 

 

NOTE:  

The Hide People icon is split into two halves - coloured white and yellow, with the number of 

people occupying the node updated in the centre. The yellow half indicates either the upper 

level (for stairs) or the direction of approach (for travelators, gates, and escalators). For Lift 

Shaft Opening transit nodes the yellow half indicates the entrance. 

 

3.8.2 Connecting Transit Nodes 

To connect the Transit Nodes to the adjacent geometry (e.g. a Free-Space node), arcs can be 

dragged between adjacent nodes and the Transit Node lanes. The Transit Node can be viewed 

in two ways: Show People presents the individual movement of the agents, while Hide People 

presents the number of agents occupying the node at any one time. When connecting the Transit 

Node to other nodes, the Show People view should be employed. Note, in all cases the arc length 

should be set to the travel distance between the centre of the connected node and the edge of 

the Transit Node. The user may connect the Transit Node in several different ways to reflect 

the desired level of connectivity. The Transit Node represents the occupiable space associated 

with the component. This should be remembered when connecting the node to the surrounding 

areas and the dimensions employed. Given that the egress components are represented as a 

single entity, this typically allows the Transit Node to be placed in its expected position within 
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geometry. This can aid in the connectivity of the Transit Node as the nodes to which it should 

be connected will be more apparent.  

 

In the following examples, a three lane Stair (as it is the default) is connected; however, the 

process and the results are identical for all Transit Node types, and the principles outlined are 

consistent irrespective of the number of lanes simulated.  

 

Connection to the centre of a Transit Node lane which has two adjacent lanes 

 
Figure 3-132: Central Lane Connection. 

 

Figure 3-133: Lanes to which the agent 

has access. 

 

The user may connect an adjacent Free-Space node to the centre of the Transit Node (see Figure 

3-132). This type of connection allows movement between the connected node and the Transit 

Node lane that is directly connected to the node given the perpendicular length of the connected 

arc. This arc connection also allows movement to any of the lanes adjacent to the connected 

lane (see Figure 3-133), should they exist, with the travel distance being the diagonal distance 

given the arc length and the lane width of the Transit Node. 

 

Connection in between two Transit Node lanes. 

 
Figure 3-134: Connection between lanes. 

 

Figure 3-135:  Lanes to which the agent 

has access 

 

The user may also connect an adjacent Free-Space node in between two Transit Node lanes 

(see Figure 3-134). This type of connection allows movement between the connected node and 

the adjacent Transit Node lanes that are on either side of the arc (see Figure 3-135). The travel 

distance encountered by the agent is the diagonal distance from the Free-Space node to the 

centre of each of the two lanes (i.e. the square root of the sums of the squares of the arc length 

and half the lane width). 
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Connection to the centre of a lane which has one adjacent lane. 

The user may also connect an adjacent Free-Space node to the centre of a peripheral lane (see 

Figure 3-136). This connection allows movement between the connected node and the Transit 

Node lane that is directly connected to the node (with the travel distance being the perpendicular 

length of the connected arc) and to the adjacent lane (with the travel distance calculated as the 

diagonal distance from the connected node to the adjacent lane, see Figure 3-137).  

 

 
Figure 3-136: Central connection with 

one adjacent lane 

 

Figure 3-137: Lanes to which the agent 

has access 

 

The act of connecting Transit Nodes can be quite time consuming. Therefore, an automatic 

method has been provided. This is accessed by selecting Tools > Auto Connect > Stair and 

Transit Nodes from the Tool menu in Geometry Mode (see Figure 3-138). 

 

 
Figure 3-138: Auto-connect menu option in geometry mode. 

 

When connecting the Transit Node to adjacent nodes (e.g. Free-Space nodes) the user should 

first select the Transit Node they wish to connect, together with one set of the adjacent nodes 

to be connected (i.e. on one side of a Metered Gate or at one end of an Escalator etc.), drawing 

a selection box around them, as shown in Figure 3-139. Once the nodes have been selected, the 

user then selects Auto Connect from the Tools menu then Stair and Transit Nodes from this 

submenu (see Figure 3-138). 
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Figure 3-139: Selecting nodes to be 

connected. 

 
Figure 3-140: Checking nodes match in 

the right order. 

 

Before the Auto Connect function can commence the relative position of the adjacent nodes and 

the Transit Node has to be confirmed. One of the adjacent nodes will be automatically 

highlighted (see Figure 3-140). The user is then asked to confirm that this node is correctly 

located on the side of the Transit Node stated. If this is correct the user should confirm this by 

clicking the Yes button. However, if the node is not correctly identified, the user should click 

the No button - the model will then adjust the calculation accordingly. 

 

 

 

Figure 3-141: Connectivity dialogue box. Figure 3-142: The results after the auto 

connect operation has been applied. 

 

An initial calculation will then be performed in order to estimate the arc lengths based on the 

staircase’s Lane Width, travel distance between the end of the Transit Node and the adjacent 

nodes. A dialogue box will then be displayed (see Figure 3-141), that provides these estimates 

and allows the user to adjust the values before the Auto Connect function starts. Once the 

dimensions have been confirmed, the user can then click the Enter button. However, if the user 

clicks the Cancel button then the Auto Connect operation will be terminated. If the user clicks 

the Enter button they will be then prompted as to whether the connection is to be made to the 

top of the Transit Node. If this is correct the user should confirm this by clicking the Yes button.  

However, if the connection is to the base of the transit they should click the No button. After 

the user has confirmed connection to the top or bottom of the transit node the required arcs will 

be generated (see Figure 3-142). 
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NOTE:  

For devices that do not connect different levels (e.g. travelators, corridors, metered gates), the 

end of the transit node with the green line is considered to be the top. 

 

Alternatively, users can connect Transit Nodes to adjacent nodes (e.g. Free-Space nodes) via 

the right mouse button pop-up menu.  This can be accessed by first moving the mouse pointer 

over the transit node to be connected and then clicking the right mouse button. Users can then 

select either the Auto Connect or Auto Connect (this floor only) options from the resulting pop-

up menu.  It is important to note that these two options will only be displayed (and hence 

selectable) within the right mouse button pop-up menu if the corresponding Transit Node is 

completely unconnected (i.e. is not already connected to any adjacent nodes).  

 

 
Figure 3-143: Auto-connecting transit nodes via the right mouse button pop-up menu 

 

It is important to note that when automatically connecting transit nodes via the right mouse 

button pop-up menu users are not required to manually define the adjacent nodes (i.e. Free-

Space nodes) to be connected to the Transit Node. This therefore differs from the method of 

connecting Transit Nodes outlined previously (i.e. Tools>Auto Connect>Stairs and Transit 

Nodes). Instead the adjacent nodes to be connected to the transit node at either end (i.e. at both 

the top and bottom in the case of stairs) are automatically calculated by EXODUS based upon 

the dimensions, position and orientation of the Transit Node itself and the corresponding 

position of the adjacent nodes.  When selecting the Auto Connect option EXODUS will attempt 

to connect the top of the transit node by identifying adjacent nodes on the floor directly above.  

Conversely, when the Auto Connect (this floor only) option is selected EXODUS will attempt 

to connect the top of the transit node by identifying adjacent nodes within the current 

floor/window. This option can therefore be used when for example attempting to connect the 

lower flight of a dog-leg staircase to its upper landing. 

 

In both cases, connecting Transit Nodes via the right mouse button pop-up menu negates users 

having to manually define the adjacent nodes, thereby speeding up the time taken to connect 

them. However, it is important to note that the adjacent nodes identified (and hence 

automatically connected to the Transit Node by EXODUS) may differ from those that the user 

deems should in reality be connected. Users are therefore strongly encouraged to check all the 

connections automatically made when connecting Transit Nodes via this method. 

 

In the next sections, the manipulation of each type of Transit Node is discussed. These sections 

describe operations related to Geometry Mode (i.e. the physical nature of the components). For 

operations related to the performance aspects and associated behaviours, the user is referred to 

equivalent sections in Chapter 5. 
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3.8.3 Stair Transit Nodes 

Figure 3-144 shows the physical space that is represented by the Transit Node component when 

representing a Staircase (i.e. selecting Staircase from the Node Type list). A thick green line is 

used to represent the top of the Transit Node with each thick black line represents the leading 

edge of each step. In Figure 3-144, the green line indicates the top of the stair, with the stair 

ascending from left to right in the diagram. 

 

 
Figure 3-144: The physical space that is represented Transit node (staircase 

representation). 

 

Figure 3-144 illustrates the aspects of the stair represented by the Transit Node component. The 

stair extends from the base of the initial riser on the lower level to the leading edge of the upper 

level.  

 

NOTE: Number of Risers = Number of Steps +1 

NOTE: Staircase Height = (Number of Steps +1) × Riser Height 

 

Once a stair Transit Node is generated (and connected as described in Section 3.8.2) the user 

can then set its Direction (i.e. rotation within the geometry window) and attributes via the 

Properties tab within the Transit Node dialogue box (See Figure 3-130 and Table 3-6). Once 

the attributes for this dialogue box have been configured, the Advanced tab can be accessed to 

address the lower-level attributes of the Stair (see Figure 3-146).  
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Figure 3-145: Transit Node Dialogue box 

 

The Advanced tab allows the user to configure the physical dimensions of the Stair component 

that influence occupant performance (see Figure 3-146). The impact of each attribute that can 

be modified is shown in Table 3-7. 

 

 
Figure 3-146: Transit Node Advanced Dialogue Box 

 

It should be noted that the Performance attributes shown in the Advanced tab (Flow Rate, No. 

Of People, etc.), are outputs rather than user-defined values. As such, they are updated during 

the simulation to reflect current conditions on the component. 
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Table 3-7: Staircase transit advanced tab controls 
Attribute Description 

Hand Rail Check Box Whether a hand rail is present  

Handrail Size The width of hand rail present 

Eff. Width Check Box Whether the effective width of the stair 

component is assumed. 

Reduction Width (m) The reduction in width produced by the 

Effective Width assumption. 

Lane Width (m) The width of each lane (derived from the 

Width of the component and the number of 

Lanes) 

Flow Rate (ppm) Flow Rate produced across the component 

during the simulation. Updated during the 

simulation and echoed to the output file. 

Current No .of People (occ) The number of people occupying the 

component at that particular time. Updated 

during the simulation. 

Total No. of People (occ) The total number of people recorded as using 

the component up to that time. Updated 

during the simulation and echoed to the 

output file. 

First On (sec) The time of the first person entering the 

component. Updated during the simulation 

and echoed to the output file. 

Last On(sec) The time of the last person entering the 

component (either up to that point in time, or 

during the entire simulation). Updated during 

the simulation and echoed to the output file. 

 

3.8.4 Escalator Transit Nodes 

Figure 3-147 shows the physical space that is represented by the new Transit Node escalator 

representation. As with all of the Transit Nodes types, this represents the occupiable space 

associated with the Escalator component. A thick green line represents the top of the Escalator 

and each thick black line represents the leading edge of each step. Therefore, in Figure 3-147 

the top of escalator is the right of Escalator node, which then descends (left) to the level below. 
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Figure 3-147: Physical space represented by an Escalator object. 

 

Figure 3-147  illustrates the aspects of the escalator represented by the Transit Node component. 

The escalator extends from the start of the horizontal run on the lower level, to the end of the 

horizontal run on the upper level. This differs from the Stair representation. The Height of the 

Escalator is  

 

NOTE: Escalator Height = (Number of Steps+1) × Riser Height 

 NOTE: Escalator Length = 2* Level Run + (Number of Steps*Tread Depth) 

 

In reality, there is some variation in the height of each riser as they (mechanically) flatten out 

towards the horizontal run on the lower level. However, in the model the step heights are 

assumed to be the same; e.g. the height of the risers are formed by dividing the total height of 

the escalator by the number of risers. 

 

Once an Escalator Transit Node is generated the user can then set its Direction (i.e. its rotation 

within the geometry window) and attributes via the Properties tab within the Transit Node 

dialogue box (See Figure 3-148). The Transit Node dialogue box is accessed by double clicking 

the Transit Node object.  
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Figure 3-148: Transit Node Dialogue box 

 

The Advanced tab allows the user to configure the physical dimensions of the Escalator 

component that influence occupant performance (see Figure 3-149). The impact of each 

attribute that can be modified is shown in Table 3-8. 

 

 
Figure 3-149: Transit Node Advanced Dialogue Box. 

 

It should be noted that the Performance attributes shown in the Advanced dialogue box (Flow 

Rate and No. Of People, etc.), are output rather than user-defined values. As such, they are 

updated during the simulation to reflect current conditions on the component. 
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Table 3-8: Advanced tab controls (escalator) 

Attribute Description 
Speed (m/s) Height of each riser 

Level Run (m) The level/flat area at the end of the escalator 

Lane Width (m) The width of each lane (derived from the Width of the 

component and the number of Lanes) 

Flow Rate (ppm) Flow Rate produced across the component during the 

simulation. Updated during the simulation and echoed to the 

output file. 

Current No .of 

People (occ) 

The number of people occupying the node at that particular 

time. Updated during the simulation. 

Total No. of People 

(occ) 

The number of people recorded as using the component up to that 

time. Updated during the simulation and echoed to the output file. 

First On (sec) The time of the first person entering the component. Updated 

during the simulation and echoed to the output file. 

Last On (sec) The time of the last person (either up to that point in time, or 

during the entire simulation. Updated during the simulation and 

echoed to the output file. 

 

3.8.5 Lift Shaft Opening Transit Nodes 

Figure 3-150 shows the physical space that is represented by a Lift Shaft Opening Transit Node. 

This represents the occupiable space associated with a Lift Shaft Opening component. It is 

important to note that the Lift Shaft Opening does not represent a lift, instead a series of Lift 

Shaft Openings represent the shaft within which a lift is associated (i.e. a lift moves between 

Lift Shaft Openings transit nodes).  A thick line represents the entrance to the Lift Shaft Opening 

transit node. When a lift moves between floors, the colour of the entrance to the affected Lift 

Shaft Opening transit node changes to indicate whether the lift door is Open (green), Closed 

(red) or the lift is not at the floor in question (black). When a lift is at or passing a given floor, 

then the agents inside the lift will be displayed on the corresponding Lift Shaft Opening transit 

node. Unlike other transit nodes, once agents board or alight a lift, their movement and 

interaction with other agents is not explicitly modelled. Hence whilst on the Lift Shaft Opening 

transit node there is no competing for space between agents and possible agent behaviour within 

the lift is not considered.  

 

 
Figure 3-150: Physical space represented by a Lift Shaft Opening transit node. 
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The Width and Depth of a Lift Shaft Opening transit node should reflect the dimension of the 

lift which moves within the corresponding lift shaft. This helps ensure that the correct number 

of Free Space nodes are connected to the Lift Shaft Opening transit node which influence the 

number of agents that can simultaneously board/alight a lift.  

 

The Number of Lanes for a Lift Shaft Opening transit node is automatically defined according 

to both the Width and Length of the device. The Number of Lanes is calculated by dividing the 

Width and Length of the device by 0.5m (i.e. the default arc length connecting Free Space 

nodes). The Number of Lanes is only used to display the number of agents within a lift but this 

does not influence the number of agents that can actually fit inside a lift (this is defined 

according to the associated lift Capacity). All Lift Shaft Openings transit nodes which form part 

of the same lift shaft are automatically set to have the same dimensions. Hence, if the 

dimensions of one of the Lift Shaft Openings transit nodes is altered then all will change. 

 

Once a Lift Shaft Opening transit node is generated the user can set its Direction (i.e. its rotation 

within the geometry window) as well as other properties via the Properties tab within the 

Transit Node dialogue box (see Figure 3-151). The Transit Node dialogue box is accessed by 

double clicking the Transit Node object.   

 

 
Figure 3-151: Lift Shaft Opening Transit Node Dialogue box 

 

The Advanced tab can be seen in Figure 3-152 and Table 3-9. It should be noted that the 

Performance attributes shown in the Advanced tab (i.e. Boarded, First On, First Off etc.), are 

outputs rather than user-defined values. As such, they are updated during the simulation to 

reflect the actions of agents in relation to the component. Behavioural and scenario based 

attributes are accessible via the Behaviour tab. These are described in Chapter 6 as they are 

applicable to Scenario Mode. 
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Figure 3-152: Transit Node Advanced Tab (Lift Shaft Opening) 

 

The Advanced tab provides additional output during the simulation, with the total number of 

agents boarding the lift via the Lift Shaft Opening transit node and the times of the first and last 

agents to board all being updated during the simulation. In addition, the total number of agents 

alighting from the lift via the Lift Shaft Opening transit node and the times of the first and last 

agents to alight are also updated during the simulation.  

 

Table 3-9: Advanced tab controls (Lift Shaft Opening) 

Attribute Description 
Boarded The total number of agents (either up to that point in time, 

or during the entire simulation) who boarded the lift via 

the Lift Shaft Opening transit node. Updated during the 

simulation. 

First On (sec) The time of the first person entering (i.e. boarding) the lift 

via the Lift Shaft Opening transit node. Updated during the 

simulation. 

Last On(sec) The time of the last person (either up to that point in time, 

or during the entire simulation) entering (i.e. boarding) the 

lift via the Lift Shaft Opening transit node. Updated during 

the simulation. 

Alighted The total number of agents (either up to that point in time, 

or during the entire simulation) who alighted from the lift 

via the Lift Shaft Opening transit node. Updated during the 

simulation. 

First Off (sec) The time of the first person to alight from the lift via the 

Lift Shaft Opening transit node. Updated during the 

simulation. 

Last Off (sec) The time of the last person (either up to that point in time, 

or during the entire simulation) alighting from the lift via 

the Lift Shaft Opening transit node. Updated during the 

simulation. 

 

3.8.6 Corridor Transit Nodes 

The Corridor type of the Transit Node represents connecting horizontal spaces. The Corridor 

differs from those previously described as:  

 (1) it has no vertical component, and  

 (2) as it does not connect adjoining levels, there is no obvious physical top or bottom to 

the component.  



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 166 

 

These differences are reflected in the Corridor object and in the representation of the Corridor 

node on screen (see Figure 3-153); i.e. that there is no indication of changes in Height as were 

evident in the Stair and Escalator nodes in previous sections.  However, as with the other node 

types, the user is able to rotate/position the node on screen as required using the Direction 

attribute (see Table 3-6). For instance, Figure 3-153 illustrates a Corridor with a 90 degree 

Direction. The user's ability to rotate the Corridor node to better represent the real-world entity 

has implications when auto-connecting the node to adjacent Free Space nodes. In common with 

the other Transit Node variants, the auto-connect functionality confirms that it has accurately 

detected the position of the Transit Node with the adjacent nodes. 

 

 
Figure 3-153: The Transit Node dialogue box for the Corridor node. 

 

The Advanced tab allows the user to view the Lane Width. It provides additional output during 

the simulation, with the Flow Rate, Current No. Of People, Total No. Of People, First On and 

Last On updated during the simulation. 

 

Table 3-10: Advanced tab controls (corridor) 

Attribute Description 
Lane Width (m) The width of each lane (derived from the Width of the 

component and the number of Lanes) 

Flow Rate (ppm) Flow Rate produced across the component during the 

simulation. Updated during the simulation and echoed to 

the output file.  

Current No .of 

People(occ) 

The number of people occupying the node at that 

particular time. Updated during the simulation. 

Total No. of People 

(occ) 

The number of people recorded as using the component up 

to that time. Updated during the simulation and echoed to 

the output file. 

First On (sec) The time of the first person entering the component. 

Updated during the simulation and echoed to the output 

file. 

Last On(sec) The time of the last person (either up to that point in time, 

or during the entire simulation. Updated during the 

simulation and echoed to the output file. 
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3.8.7 Travelator Transit Nodes 

The Travelator Transit Node represents a moving horizontal walkway. As with the Corridor 

Transit Node this differs from those previously described as it has no vertical component, 

although it does have a pre-determined direction of movement; i.e. once defined the Travelator 

is moving in a direction. These differences are reflected in the Travelator object and in the 

representation of the Travelator node on screen (see Figure 3-154). As with the other node 

variants, the user is able to rotate/position the node on screen as required using the Direction 

attribute (see Table 3-6). For instance, Figure 3-154 illustrates a Travelator with a 0 degree 

Direction. The user's ability to rotate the Travelator node to better represent the real-world 

entity has implications when auto-connecting the node to the adjacent geometry. In common 

with the other Transit Node types, the auto-connect functionality confirms that it has accurately 

detected the position of the Transit Node with the adjacent nodes. 

 

 
Figure 3-154: The Transit Node dialogue box for the travelator node. 

 

Once a Travelator transit node is generated the user can then set its Direction (i.e. its rotation 

within the geometry window) and attributes via the Transit Node dialogue box (see Figure 

3-154 and Table 3-6). The Advanced tab can be seen in Figure 3-155 and Table 3-11, and allows 

the user to control the speed at which the Travelator moves. Behavioural and scenario based 

attributes are accessible via the Behaviour tab. These are described in Chapter 6 as they are 

applicable to Scenario Mode. 
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Figure 3-155: Transit Node Advanced Tab (Travelator) 

 

The Advanced tab allows the user access to the Lane Width and Speed. It provides additional 

output which is updated during the simulation (e.g. Flow Rate, No. Of People, etc). 

 

Table 3-11: Advanced tab controls (travelator) 

Attribute Description 
Lane Width (m) The width of each lane (derived from the Width of the 

component and the number of Lanes) 

Speed (m/s) Speed at which travelator is moving 

Flow Rate (ppm) Flow Rate produced across the component during the 

simulation. Updated during the simulation and echoed to 

the output file. 

Current No .of 

People(occ) 

The number of people occupying the node at that 

particular time. Updated during the simulation. 

Total No. of People 

(occ) 

The number of people recorded as using the component 

up to that time. Updated during the simulation and 

echoed to the output file. 

First On (sec) The time of the first person entering the component. 

Updated during the simulation and echoed to the output 

file. 

Last On(sec) The time of the last person (either up to that point in 

time, or during the entire simulation. Updated during the 

simulation and echoed to the output file. 

 

3.8.8 Metered Gate Transit Nodes 

The Metered Gate Transit Node represents a set of metered barriers (i.e. ticket gates/turnstiles) 

that need to be traversed for occupants to gain access to the area beyond them. During their use, 

metered gates will constrain the flow of occupants moving through them. Within 

buildingEXODUS two types of metered gate can currently be represented by default, namely 

ticket gates and turnstiles. By default each metered gate is assumed to be a closed ticket gate 

whose performance is defined by an imposed flow restriction. The data defining the default 

flow rate through the device was derived as part of the AVATARS project [165] and is 

described in Chapter 2. Figure 3-156 shows how a metered gate is represented in EXODUS. 
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Figure 3-156: The Transit Node for a single direction metered gate node. 

 

Within buildingEXODUS seven default data sets are provided defining the performance of 

metered gates (see the Theory Manual, Section 7.2.3.11). Each data set relates to a specific type 

of metered gate (i.e. ticket gate or turnstile) modelled using either the Flow or Individual 

Movement Model. Hence each data set is only applicable to a specific combination of both Gate 

Type and Movement Model. Each data set also relates to the operation of the metered gate in 

one of two modes: Open (free admission) or Closed (card/coin operated). The first is suitable 

for emergency situations as it allows the maximum flow of people through the gate while the 

second is used during the normal operation of the structure (i.e. circulation). When configuring 

a Metered Gate users should therefore consider the type of metered gate they are attempting to 

model, its corresponding state (i.e. Open or Closed) and the means by which they wish to 

represent the device (i.e. Flow or Individual model). For more information on Metered Gates 

and the default data sets available see Chapter 2. 

 

As with all other Transit Nodes, the user can set the physical characteristics of a metered gate 

by accessing its properties (see Figure 3-157a). The mode in which the metered gate will operate 

can be accessed by switching to the Behaviour tab (see Figure 3-157b). 

 

  
(a) (b) 

Figure 3-157: (a) The metered gate physical properties (b) metered gate behaviour 

model properties 

 

As with the Corridor and Travelator, Metered Gates have no vertical component, although they 

do have a pre-determined direction of use. Once a Metered Gate Transit Node is generated the 
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user can then set its Direction (i.e. its rotation within the geometry window) as well as other 

attributes via the Transit Node dialogue box.  

 

There are a number of performance related attributes to the Metered Gate that the user can 

examine while the simulation is running. These are accessed by viewing the Advanced tab of 

the Transit Node dialog box (see Figure 3-158).  

 

 
Figure 3-158: Transit Node Advanced Tab (gate) 

 

Table 3-12 provides a list explaining the options available in the Advanced tab.  

 

Table 3-12: Advanced tab controls (metered gate) 

Attribute Description 
Lane Width (m) The width of each lane (derived from the Width of the 

component and the number of Lanes) 

Flow Rate (ppm) Flow Rate produced across the component during the 

simulation. Updated during the simulation and echoed to 

the output file. 

Current No .of 

People (occ) 

The number of people occupying the node at that 

particular time. Updated during the simulation. 

Total No. of People 

(occ) 

The number of people recorded as using the component up 

to that time. Updated during the simulation and echoed to 

the output file. 

First On (sec) The time of the first person entering the component. 

Updated during the simulation and echoed to the output 

file. 

Last On (sec) The time of the last person (either up to that point in time, 

or during the entire simulation. Updated during the 

simulation and echoed to the output file. 

 

3.8.9 Grouping of Transit Nodes 

A Transit Node group is a group of any set of Transit Nodes which form a single transitional 

group; i.e. that present the occupants with a choice for moving between two adjacent spaces. 

For example, if a building entrance leads to a group of two ascending escalators, one descending 

escalator along with a staircase this would form one Transit Node group (see Figure 3-159). 

 



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 171 

 
Figure 3-159: Stair and Escalator Bank 

 

The user should be aware of the grouping of Transit Nodes during construction of the geometry. 

The user should show care in the positioning and connectivity of the nodes such that the 

grouping makes sense both in terms of the choices faced by the occupants and the conditions 

subsequently produced; i.e. that a genuine choice is faced by the occupants when confronted by 

the grouped Transit Nodes. Transit Nodes are grouped within Scenario Mode, described in 

Chapter 6.  

 

3.9 Constructing Multi-level Geometries 

Multi-level geometries are in essence the same as single level geometries.  The difference 

between them is simply that multi-level geometries have more than one geometry window, 

usually one per floor.  When constructing multi-level geometries, each level should be 

considered a separate entity until the levels require joining. Connecting different levels of the 

geometry can be achieved automatically or manually. 

 

Joins between levels are usually passageways of some description, for example stairwells or 

escalators.  Thus, when joining levels it is important to maintain the concept of the width of the 

passageway. 

 

3.9.1 Creating New Floors 

Shortcut: [Tools/Floor/New] 
To create additional geometry windows, select Tools from the menu bar, the Floor sub-menu 

and the New item from the pull-down menu (see Figure 3-2). A new geometry window will 

appear where the new level can be created.  

 

After constructing the geometry for each level, the separate geometries require linking.  

 

3.9.2 Linking Levels of the Geometry 

There are three distinct methods for connecting staircases within buildingEXODUS, using the 

old nodal method and using the Transit Nodes as described within Section 3.8. There are also 

a number of different types of transit nodes that can now be created, including staircases, 

escalators, corridors, travelators, and metered gates.  

 Auto-Connect stairs/escalators.  

 Original method. 

 Floor Link method. 

 



Chapter 3 - Defining A Geometry 

© 2017 University of Greenwich 172 

The Auto-Connect stairs is an automatic method for connecting stairs, escalators, corridors etc. 

to adjacent nodes and saves the user from having to calculate all the individual arc lengths and 

connecting them manually. The other two methods, Floor Links and Original, provide a manual 

method of connecting levels; the latter being specifically for the connection of geometry 

windows.  The Original method has been used in all previous versions of EXODUS and 

requires considerable user intervention to fully utilise.  Because of the amount of user 

intervention required, the Original method is prone to user errors and should be only used by 

expert users.  The Floor Link method, was developed to simplify the process of linking stairs 

to other geometry windows (floors). The difference between the various methods relates to the 

user interface rather than functionality; therefore assuming the connectivity between the 

levels/floors in question is the same, the occupant behaviour will also be consistent regardless 

of which method is used.  The earlier two methods are included in the current release to maintain 

continuity for existing users.  

 

For simplicity and ease of use, it is recommended that Transit Nodes are used for the creation 

of all staircases, escalators, corridors, travelators, and metered gates. It is also recommended 

that the user adopt the Auto Connect method whenever possible to connect Transit Nodes to the 

local geometry, between levels, and between geometry windows, as this ensures the correct 

connectivity and arc lengths are generated (for a description of how this is done, refer to Section 

3.9.2.1). In situations where the Auto Connect method cannot be used to connect 

floors/geometry windows, it is recommended that the Floor Link method be used as it is 

somewhat easier to use than the Original method. The Floor Link and Original methods for 

linking floors are described for node based stairs within Appendix E. The following section 

describes the linking of geometry windows using the Auto Connect approach and Transit Nodes. 

 

3.9.2.1 Auto Connecting Geometry Windows using Transit Nodes 

The staircase and escalator Transit Nodes are created as described within Section 3.8. When 

created, the arcs linking the Transit Node to the main geometry are not automatically created 

and this must be done as specified within Section 3.8.2. 

 

The manual generation of arcs that connect Transit Nodes and separate floors can be time 

consuming. For this reason, it is recommended that the Auto Connect method is employed.  

 

TIP: 

Even though the Auto Connect option may be used, it is recommended that the user check the 

lengths of the generated arcs to ensure that they are appropriate.  

 

The use of the Auto Connect “Stairs and Transit Nodes” function (see Section 3.8.2) is exactly 

the same whether the nodes to be connected are in the same geometry window or different 

geometry windows. However, if the nodes are in a different geometry window a Floor Link will 

also be auto generated. For example, in Figure 3-160 a connection between a staircase (left of 

Figure 3-160) is to be connected to another floor and geometry window (right of Figure 3-160). 

The user selects the two sets of nodes and as specified within Section 3.8.2 runs the Auto 

Connect “Stairs and Transit Nodes” function. The new arcs and Floor Links that are generated 

are shown in Figure 3-161.  
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Figure 3-160: Selecting nodes to be connected between two windows in exodus 

 

 
Figure 3-161: The arcs and Floor Links generated by auto connect stairs 

 

The Floor Links, that are generated, are positioned automatically and the user may wish to move 

them to a more convenient location once generated. To do this the user should check that the 

Floor Link selection is enabled, (see Section 3.3.4.3), and that Object Lock is disabled (see 

Section 3.3.3.13). The user can then simply select each Floor Link and move them to a better 

location. 

 

3.9.2.2 Auto Link Floors 

Shortcut: [Tools/Construction/Auto Link Floors] 
This feature converts simple arc based connections between floors to the Floor Link 

representation. This will then allow the additional graphical information available with this 

representation to be accessed.  
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3.9.2.3 Removing All Floor Links 

Shortcut: [Tools/Construction/Remove All Floor Links] 
This feature effectively reverses the action of the Auto Link Floors function (see Section 

3.9.2.2). As a result, any Floor Links within the structure will be automatically converted simple 

arc based connections. This option may be selected if the user simply wants to remove the 

display of Floor Links, or alternatively if they wish to regenerate the Floor Links via the Auto 

Link Floors option. 

 

3.9.2.4 Renaming Census Regions and Internal Doors 

Shortcut: [Tools/Construction/Rename Census/InDoors] 
Inserts the floor name on which census regions and internal doors are located into their name 

in order to simplify locating the object within the geometry. 

 

3.9.2.5 Deleting Floors 

Shortcut: [Tools/Floor/Delete] 
To remove a window, effectively deleting a level, the window must be clear of all nodes. Once 

the window is entirely empty the user must select Delete from the Floor sub-menu. The window 

will then be removed. 

 

3.9.2.6 Replicating Floors 

Shortcut: [Tools/Floor/Copy] 
If the user wishes to replicate a floor, then the user must access the Copy function via the Floor 

option in the Tools menu. The user must have the window containing the floor that requires 

duplication active (i.e. the window must be at the fore and will have had the mouse clicked 

within its borders). Once this is the case, the Copy function should be selected. Once selected 

the Floor Copy Control dialogue box will be displayed (see Figure 3-162). This dialogue box 

enables the user to define how many times they wish to duplicate the currently selected floor 

and also whether they wish to maintain the floors existing Floor Connections, Transit Node 

Groups (see Chapter 5) and Lift Connections within the duplicated floors. 

 

If the Floor Connections option is selected then any connections to adjacent floors that existed 

within the currently selected floor will be maintained within the duplicated floors. Hence 

duplicated floors will be automatically connected meaning that the user will not be required to 

manually connect them, thereby saving them valuable time. Similarly, if the Transit node 

Groups option is selected any transit node groups which exist within the currently selected floor 

will also be replicated within the duplicate floors. Hence, transit node groups will automatically 

be generated containing the equivalent transit nodes within each of the duplicate floors, thereby 

saving the user the effort of having to manually create the transit node groupings for each floor.  

Finally, if the Lift Connections option is selected then any Lift Shaft Opening transit nodes 

replicated within the duplicate floors will automatically be added to their corresponding lift 

shaft (if the lift shaft already exists). This therefore saves the user the effort of having to 

manually add each newly generated Lift Shaft Opening transit node to its corresponding lift 

shaft. 
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Once the user has defined the number of times they wish to copy the currently selected floor, 

and whether they wish to maintain floor connections, transit node groups and lift connections 

they should click the OK button. Upon clicking the OK button the defined number of duplicate 

floors will automatically be created. Despite the automatic connection of floors and generation 

of transit node groups the user is always encouraged to rigorously check their geometry after 

floor duplication to ensure that the no errors have been made and hence that the structure is 

connected/defined as required. By default the Floor Connections, Transit Node Groups and Lift 

Connections options are selected. 

 

 
Figure 3-162: The Floor Copy Control dialogue box 

 

3.9.2.7 Destroy Floors 

Shortcut: [Tools/Floor/Destroy] 
This enables the user to remove a floor and the associated window without previously having 

deleted the geometry within it. This is accessible via the Tools menu, the Floor sub-menu and 

then the Destroy option.  

 

3.9.2.8 Swap Floors 

Shortcut: [Tools/Floor/Swap] 
This enables the user to swap the positions of two floors within the floor list in the left hand 

Navigation window. In this manner, the user can control the way in which floors are ordered. 

Once selected, the user will be required to enter the Floor ID’s of the two floors that are required 

to be swapped. 

 

3.10 Constructing Queues 

Queuing systems, including servers and routes (constructed using a number waypoints defining 

the way to a server), can be created within Scenario mode (see Chapter 6). However, the server 

locations for queues can be viewed within any mode, including Geometry mode. In order to 

view queue server locations, the standard procedure should be followed by selecting Gra. Ctrl 

Options from the Display sub-menu of the View menu and selecting the Queue display check 

box. Servers will be represented as shown within Figure 3-163. The route to servers can not 

currently be displayed within buildingEXODUS. It is also worth noting that enabling queues to 

be selectable within any mode does not mean that they can be moved within any mode. By 

default servers can only be moved/relocated within the Scenario mode. 
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Figure 3-163: Five queue servers displayed within simple square room 

 

3.11 Changing the Background Colour of a Geometry Window 

This feature enables the user to change the background colour of the geometry windows from 

their default white. This function is defined via the right mouse button pop-up menu. This is 

accessed by first moving the mouse pointer to a clear area within the geometry window whose 

background colour the user wishes to change (i.e. ensuring that the mouse pointer is not 

positioned over an object such as a node, line etc.) and then clicking the right mouse button. 

Users can then simply select the Window Colour option within the resulting pop-up menu (see 

Figure 3-164(a)). 

 

 

 
 

(a) (b) 

Figure 3-164: Defining the colour of a geometry window via the right mouse button pop-

up menu. 
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Once selected the Colour dialogue box will then be displayed, enabling the user to select from 

any one of 48 default basic colours, or alternatively create and assign their own custom colours 

(see Figure 3-164(b)). Figure 3-165 below shows the effect of changing the background colour 

of a typical geometry window. 

 

  
(a) (b) 

Figure 3-165: A typical geometry window with a) its default white background colour, 

and b) a light green background colour 

 

3.12 Saving Geometry Boundaries as CAD DXF Files 

This feature enables users to save the boundaries of specific floors/windows as CAD DXF files.  

In this manner, each floor can be saved in a format which enables it to be imported into third 

party software (i.e. CFD fire modelling software, 3D visualisation software etc.).  It is important 

to note that only the walls/lines present within the selected floor will be saved to the DXF. 

Hence all text, polygons and EXODUS objects (i.e. nodes, arcs etc.) will not be saved.  All 

walls/lines will be saved within a single layer of the DXF file, with the corresponding units 

being in metres. 

 

In order to utilise this functionality the user must first select the floor/window whose boundary 

they wish export to a DXF file, by right clicking on it in the Navigation window located down 

the left hand side of buildingEXODUS interface (see Figure 3-166(a)).  Once the floor has been 

selected, the user should then select the Save as DXF option from the resulting pop-up menu.  

Upon selecting this option the user will then be presented with a Save As dialogue box enabling 

the user to locate both where they want the resulting DXF file to be saved, in addition to defining 

its corresponding name.  By default, the name of each DXF file saved is simply 

Exodus_<Floor_Name>.dxf. 

 

It is important to note that the Save as DXF file option will only be available for a given 

floor/window if it contains lines/walls.  If no lines/walls are present in the selected floor then 

there is effectively nothing to save to the DXF file and hence the option will be disabled (i.e. 

greyed out) within the resulting pop-up menu (see Figure 3-166(b). 
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(a) (b) 

Figure 3-166: Saving the geometry boundary contained within a given floor/window as a 

DXF file via the Navigation Window 

 

3.13 Leaving Geometry Mode 

Shortcut: [Edit/Goto/Population Mode]  
Once a geometry has been created, buildingEXODUS will allow the user to progress to the 

Population mode where the population to be examined may be created. To move to the 

Population mode, select Edit from the menu bar, Goto from the menu and then the Population 

Mode item from the sub-menu (see Figure 3-2). Alternatively, press the MODE ADVANCE 

button on the toolbar (see Figure 3-1). 

 

TIP: 

Always save the geometry before advancing to other modes. 
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CHAPTER 4: DEFINING A POPULATION (POPULATION MODE) 
After the geometry is complete, the next step is to define a population. This process is performed 

in POPULATION MODE. 

 

4.1 Population Mode Overview 

A population in buildingEXODUS is made up of individuals. Each individual has a set of 

attributes, used to define and track each individual throughout the simulation (see the Theory 

Manual). Some of the attributes are fixed (e.g. Gender, Age etc.) whereas others are dynamic, 

changing as a simulation progresses (e.g. Distance Travelled, Personal Elapsed Time etc.).  It 

is also possible to assign individuals within the population with a list of tasks to perform prior 

to exiting and with a detailed knowledge of the location and nature of the various external 

EXITs within the structure. Dedicated libraries of tasks have also been included to represent 

the procedures that might be utilised on various types of structure.  

 

In this section, the methods used to define a population are described. A description of the 

individual attributes can be found in the Theory Manual and in the quick reference guide. 

 

The methods available to define a population: 

 

 Automatic Occupant Definition (Section 4.3) 

 Manual Occupant Definition (Section 4.4) 

 Selecting Library Cases (Section 4.5) 

 Modifying Attributes for Existing Occupants (Section 4.6) 

 Deleting Occupants (Section 4.7) 

 

The first two methods (Sections 4.3 and 4.4) rely on the user to construct a population that can 

then be saved into a population library. Both these methods use interactive tools provided in 

buildingEXODUS. The third method to generate a population (Section 4.5) simply retrieves 

previously stored populations. 

 

 
Figure 4-1: Population Mode toolbar 

 

Table 4-1: Toolbar buttons specific to Population Mode 
Button Name Menu Equivalent Explanation 

 
Person 

Tools-Person-

Location 
Creates a single person (see Section 4.3.3) 

 
Panel Build Tools-Panel Populate Starts population panel editor (see Section 4.4.1) 

  
Select People 

Edit-Select-People 

Select 
Selects individuals only i.e. not nodes (see Section 4.6.1) 

 Find Person View-Find-Person Locates a given person (see Section 3.3.4.7) 

 
Boundary View 

(Toggle)* 
View- Boundary Toggles between Boundary and Nodal view 

 Undo* Edit - Undo 
Allows the user to undo last task performed (see Section 

4.8) 

 
Redraw* View – Redraw Redraws the geometry window 
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Figure 4-2: Menu items specific to Population Mode 

 

The remainder of this manual uses the following convention to refer to buildingEXODUS 

populations: 

 

Person or 

Occupant  

Collection of attributes used to describe an individual (see the Theory 

Manual, Chapter 3) 

Group Collection of persons (i.e. more than one) with similar range of 

attributes 

Sub-Population Collection of one or more groups 

Population Collection of one or more sub-populations which combined make up the 

entire contingent of evacuees 

 

4.2 Manipulating Objects 

Whilst in Population mode the user is able to interact and interrogate with objects. When doing 

so the user has two basic options in retrieving information in relation to one of these options. The 

user may double-click (using the left mouse button) on the icon representing the object in the 

workspace, which will produce a dialogue box, providing access to the attributes of that object 

may be examined and possibly edited. Alternatively the user may right click (once) on the object, 

which will then generate a menu from which the user may select information. The nature of this 

menu may change from object to object according to the data available. The method used is 

entirely down to the preferences of the individual. 

 

4.3 Automatic Occupant Definition 

Automatic occupant definition should be used only when defining small numbers of people or 

when the user is not concerned with the specific values of the individual attributes. Using this 

technique, the attributes for the evacuees are NOT set by the user but are defined either as 

default values or set randomly. There are three methods for positioning automatically defined 

people within a geometry.  The first requires that each occupant is placed individually within 

the geometry at specific nodal locations (see Section 4.3.3), the second method involves 

randomly placing the occupant on a free-space node anywhere within the geometry (see Section 

4.3.3). The final method involves mapping out an area and randomly locating the occupants 

within the defined region (see Section 4.3.4). 

 

4.3.1 Occupant Defaults in Automatic Generation Mode 

When defining occupants automatically the attribute defaults are set in one of two ways 

depending on whether (a) an individual occupant, or (b) a group of occupants are being defined. 
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(a) When automatically defining occupants one at a time, each person is generated with an 

identical set of person attributes. These attributes are set to the default values specified 

in the Theory Manual, Chapter 3. An individual generated in this manner is known as a 

Default Person. Table 4-2 lists the attribute settings for the default person. 

 

Table 4-2: Initial person attribute settings for the Default Person 

Attribute 
Applicable 

Levels 
Default Value 

Gender A,B,C Male 

Age A,B,C 25 years 

Weight A,B,C 80.0kg 

Height A,B,C 1.80m 

Response Time A,B,C 0.0s 

Mobility A,B,C 1.0 

Agility A,B,C 5 

Fast Walk Speed A,B,C 1.5m/s 

Walk Speed A,B,C [90% of Fast Walk Speed] 1.35m/s 

Leap Speed A,B,C [80% of Fast Walk Speed] 1.20m/s 

Crawl Speed A,B,C [20% of Fast Walk Speed] 0.30m/s 

Up-Stair Speed A,B,C 0.67m/s 

Down-Stair Speed A,B,C 1.01m/s 

Up-Escalator Speed A,B,C 0.509m/s 

Down-Escalator Speed A,B,C 0.583m/s 

RMV C only 22 l/min 

PID C only 30 

Drive A,B,C 10 

Patience A,B,C 1000 

Target exit A,B,C Nearest exit 

Familiarity A,B,C Nearest exit 

Itinerary A,B,C Null 

Gene A,B,C 0 

Leader A,B,C No 

 

(b) When automatically defining a group of occupants simultaneously, the attributes for 

each person within the group are assigned randomly. The value for each attribute is 

selected from a range of possible values. Table 4-3 lists the range of possible values for 

each attribute. 

 

NOTE: 

The default values for the stair travel rates are largely derived for the work of Fruin [19], 

collected from movement within buildings. If the user has data which they feel is more 

appropriate this may be used. 
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Table 4-3: Attribute ranges for randomly generated occupants 

Attribute 
Applicable 

Levels 
Default Value Range 

Gender A,B,C Male, Female 

Age A,B,C 20 - 60 years 

Weight A,B,C 50 – 85 kg 

Height A,B,C 154 – 183 cm 

Response Time A,B,C 0.0 – 30.0 

Mobility A,B,C 1.0 

Agility A,B,C 3 - 7  

Fast Walk Speed A,B,C Random 0.8 - 1.5 

Walk Speed A,B,C 90% of Fast Walk Speed 

Leap Speed A,B,C 80% of Fast Walk Speed 

Crawl Speed A,B,C 20% of Fast Walk Speed 

Up-Stair Speed A,B,C see table 2.5 

Down-Stair Speed A,B,C see table 2.5 

Up-Escalator Speed A,B,C see table 2.5 

Down-Escalator Speed A,B,C see table 2.5 

RMV C only see table 2.8 

PID C only 5 - 45 

Drive A,B,C 
[female]1 – 10 

[male] 5 – 15 

Patience A,B,C 0-1000 

Target Door A,B,C Nearest Exit 

Familiarity A,B,C Nearest Exit 

Itinerary A,B,C Null  

Gene A,B,C 0 

Leader A,B,C No 

 

4.3.2 Changing Occupant Defaults for Individual Occupant Generation 

Shortcut: [Defaults/Person] 

In some cases, it is desirable to create individuals that are not clones of the default person.  To 

achieve this, the default settings of the attributes of the default person may be modified. 
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Figure 4-3: Dialogue box to modify the base attributes of the default person. 

 

To modify the default settings, select Defaults from the menu bar and the Person item from the 

pull down menu (see Figure 4-2). A dialogue box will be displayed allowing the attributes of 

the default person to be modified (see Figure 4-3). 

 

At this stage, the base attributes for the default person may be modified. These are: Name, 

Label, Gender, Age, Height, Weight, Target exit, and Colour. To modify these attributes, move 

the cursor into the relevant box and modify. To accept the modifications, press the OK button. 

 

 
Figure 4-4: Dialogue box to modify toxicity attributes for the default person. 

 

 
Figure 4-5: Dialogue box to modify irritant attributes for the default person. 

 

Further attributes of the default person may be modified by pressing either the Gases (Figure 

4-4 and Figure 4-5), Fam (Occupant Exit Knowledge), O.I.L. (Occupant Itinerary List), or 
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Attrib (Figure 4-6) button. Also the use of the Occupant Itinerary List is enabled by checking 

the Has Tasks tick-box.  

 

 
Figure 4-6: Dialogue box to modify attributes for the default person. 

 

The attributes that may be modified by using the Attrib button are shown as the darker text in 

Figure 4-6. To modify these attributes, place the cursor in the relevant box and modify. To 

accept the changes, press the OK button. The attributes that cannot be manipulated are dynamic 

attributes that are calculated during the simulation. 

 

The attributes that may be modified using the Gases button comprise only the four RMV 

attributes and the PID attribute (see Figure 4-4). To modify these values, place the cursor in the 

relevant box and modify. To accept the changes, press the OK button. In addition, the sensitivity 

of the individuals to both the concentration and the exposure to irritant gases can be determined 

by supplying values to the Default Person Gases dialogue box (see Figure 4-5). 

 

To edit the values of the default individual’s sensitivity to the level of irritant gases present in 

the environment, the user should select Defaults from the menu bar and the Person item from 

the pull down menu (see Figure 4-2), select the Gases button from the dialogue box that appears 

and then the user can gain access to the denominators for the individual gases by clicking on 

the Narcotic button (causing the buttons appearance to change to Denominators signifying that 

the dialogue box now represents the irritant information), determining their impact upon the 

individual and the status of that individual in relation to any of the irritant (or narcotic) gases 

(see Figure 4-7-Figure 4-9). It should be noted that the person’s Irritant Status values, and the 

associated dialogue box changes, are only visible during Simulation mode, as outside of this 

context, the values produced will always be zero. 
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Figure 4-7: Person’s Narcotic Values 

 

 
Figure 4-8: Person’s Denominators Values. This is reached by clicking on the Narcotic 

button shown in Figure 4-7 

 

 
Figure 4-9: Person’s Irritant Status Values. This is reached by clicking on the 

Denominators shown in Figure 4-8. 

 

NOTE: 

Attributes modified for the default person do not take a range of values. The user will therefore 

have to specify the exact value that will be adopted. 

 

The majority of the default attributes that can be edited by the user are either through the 

provision of figures or the selection of an item from a provided list of options. Defining itinerary 

lists and Occupant Exit Knowledge are slightly more complicated and so are covered in more 

detail later. 
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4.3.2.1 Creating an Itinerary for a Default Person   

An Occupant Itinerary List (O.I.L.) can be formed from several tasks each of which represents 

some aspect of the evacuation process. If a specific procedure is desired such that the entire 

population (or the vast majority of them) will follow a particular set of tasks, then pre-defined 

‘itineraries’ can be created. These are described in Chapter 6. Otherwise the user is able to 

control the movement of evacuees to reflect specific behaviours, implicitly represent staff 

activities or procedural factors. 

 

To define the O.I.L., the DEFAULT PERSON dialogue box must be accessed.  Select Defaults 

from the menu bar and the Person item from the pull down menu (see Figure 4-2).  A dialogue 

box will be displayed allowing the attributes of the default person to be modified (see Figure 

4-3). By clicking on the O.I.L. button (the Has Tasks box must also be checked) the EDIT 

DEFAULT PERSON ITINERARY dialogue box is displayed.  It is now possible to construct 

an itinerary list that will be issued to all generated default persons. 

 

The itinerary list consists of a range of nodal locations or compartments that the occupant will 

visit.  To define a node where the occupant will visit, select the required node within the 

geometry by moving the mouse cursor to the required location and left click on the desired 

location.  If the user wishes to add a nodal location to the end of the list of itinerary locations, 

once the nodal location is selected the APPEND button should be clicked. If it is necessary to 

insert the nodal location above a predefined location on the Occupant Itinerary List, select the 

node immediately below the location you wish to insert the new node location (move mouse 

cursor to location and left click).  If the INSERT button is now depressed the newly selected 

nodal location will appear above the previously selected location.  If a list of nodal locations is 

to be appended to the Itinerary List, the AUTO INSERT box may be checked prior to any 

selection. Nodal locations can then be added to the itinerary simply by clicking on them 

(without requiring the APPEND button to be clicked each time).  If it is necessary to insert a 

list of nodal locations above a specified location on the Itinerary list, the Auto Insert option can 

be used once the desired insertion location is highlighted. 

 

To define a Compartment Zone that the occupant will visit as part of an itinerary, the user must 

first create Compartment Zones in Scenario Mode (see Chapter 5). Once created, the user should 

return to Population Mode and then select a nodal location (using the instructions provided 

above) that falls within the desired Compartment Zone; i.e. the zone that is to be associated with 

the itinerary. A number of the itinerary tasks (e.g. Delay Zone and Wait Zone) make use of 

Compartment Zones. Therefore, once one of these itinerary tasks has been selected and a nodal 

location associated, it will automatically search for a Compartment Zone; i.e. a Compartment 

Zone in which the associated nodal location falls. To ensure that the correct Compartment Zone 

is allocated (for instance, when a nodal location falls within several Compartment Zones), the 

user is able to specify the associated Compartment Zone. This can be done by double-clicking 

on the nodal pane associated with the task, which produces a list of the Compartment Zones. 

The user can then select the desired Compartment Zone. 

 

To remove a nodal location from the EDIT ITINERARY dialogue box the location should be 

selected within the EDIT ITINERARY Window (the button representing the nodal location 

should be clicked thereby highlighting the whole row) and then the REMOVE button should 

then be clicked. To remove all of the nodal locations from within the Edit Itinerary dialogue 

box, the CLEAR button should be clicked (see Figure 4-10). 
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The user may also Import previously defined Itineraries though clicking on the IMPORT button. 

This will allow the user to gain access to the Itinerary SELECTION dialogue box. Here, 

itineraries that have previously been created will be accessible and can be selected for the 

individual occupant. The creation of itineraries as distinct entities from the evacuee are usually 

confined to use with Population Panels and so the creation of this type of itinerary is discussed 

in Section 4.4.2.1. 

 

The Label button provides an indication of the exact nodal location. Once a location is selected 

and the Label button is pressed, a small red number will appear above it within the geometry. 

The number displayed indicates the nodes position in the Task List. 

 

TIP: 

The numbers generated by clicking the Label button are very small. To use this facility it is 

advised to Zoom into the areas of interest.  

 

The Occupant Itinerary List (O.I.L.) is made up from a number of pre-defined tasks that are to 

be performed prior to exiting the structure.  They can be selected from the Task combo box 

within the Edit Itinerary dialogue box (see Figure 4-10). For default occupants, the tasks to be 

carried out must be specified manually by the user.  The occupant can be supplied with a 

specific itinerary that can involve visiting several nodal locations. 

 

 
Figure 4-10: The task list, available from the Edit Itinerary dialogue box. 

 

Once the nodal locations appear in the default itinerary, the task associated with each of the 

locations may then be supplied by the user (see Figure 4-11).  
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Figure 4-11: The user has selected two nodes that the occupant will visit. The delay times 

are also specified, in this case between 0-10 seconds and 0-20 seconds. 

 

The user has a number of different tasks that can be assigned to an occupant's itinerary. These 

include  

 

 Delay / Delay Zone 

 Wait / Wait Zone 

 Way Point 

 Queue 

 Remove  

 Discount / Discount Mill 

 Lift Bank 

 Lift Wait 

 Form Group / Form Group Zone 

 Leave Group / All Leave Group 

 Wait For 

 Find via Signage 

 Collect Person 

 Drop Off Person 

 Coordinated Delay 

 

There is no probability of execution associated with tasks produced in this manner. Therefore, 

once the Default occupant has been attributed with a task, the subsequently generated occupants 

will attempt to complete the tasks, through visiting the nodal locations specified within the 

itinerary. The outcome of this attempt at visiting the nodal locations will be dependent upon the 

environmental circumstances and the Patience of the generated occupants (i.e. whether the 

generated occupants are able to achieve the desired location without accumulating a wait time 

greater than their Patience level).  If during the execution of any task on their Itinerary List, an 

occupant becomes impatient (i.e. the occupant has been waiting longer than their Patience 

attribute) they will ignore the remainder of their Itinerary List and will proceed to evacuate.  
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NOTE: 

The issue of an individual ‘losing’ a task is of great importance if the user is interested in 

evacuees following the tasks they have been given. Due to this importance, the ‘Maintain Target 

LSA’ and ‘Maintain Itinerary’ options in Route tab of the Behaviour Options dialogue box 

(available via the Rulebase menu in Simulation mode) are enabled by default, during these pre-

defined evacuation procedures. 

 

NOTE: 

The exact locations visited during an itinerary may be altered (dynamically) according to the 

experiences of an evacuee during a simulation. For instance, if an evacuee’s itinerary includes 

visiting a Redirection node, then if additional tasks are associated with that node, then they will 

be inserted into the individual’s itinerary. 

 

The occupants generated using the default settings are automatically associated with the task, 

with no stochastic processes involved.  The only way that a task can then be disassociated from 

a generated occupant is to REMOVE the task from the individual occupant (see Section 

4.4.2.1), to CLEAR all of the associated tasks from an individual occupant or to disable the Has 

Tasks check box on the PERSON dialogue box (from an individual). This will automatically 

remove all of the associated tasks (see Figure 4-3 and Figure 4-11). The default occupant can 

also be edited in the manner previously described. However, these changes will not affect those 

occupants that have already been generated, unless these changes have been made prior to the 

generation of new occupants. 

 

Once created, the Occupant Itinerary List is available for all occupants subsequently created 

using individual random placements and therefore using the default occupant definition. 

 

NOTE: 

Once tasks have been created the user may relocate them in Scenario mode. This can be 

achieved through first making sure that the target points are visible and selectable and then 

dragging them from their current to their desired locations. 

 

These various tasks and means of assigning them are now described. 

 

Task: Delay 

The default task for occupants following an itinerary is the Delay task, where a person will be 

delayed at the target node for a specified period of time. This can be employed to implicitly 

represent an action being performed at a location; e.g. collecting belongings, shutting down a 

computer, etc. It has no direct impact on other objects within the simulation other than those 

produced by the occupant being delayed. 

 

This requires the minimum (Min) and maximum (Max) expected delay times (seconds) to be 

specified by the user. A random delay time will then be assigned between the Min and Max 

values in accordance with a random uniform distribution.  To guarantee the length of the delay 

time that the occupant will experience on reaching the associated nodal location, the Min and 

Max delay times should be made the same.  
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To generate a Delay task (see Figure 4-12) the user should therefore  

(1) Create a task and associate a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). 

(2) Identify the range of possible delay times associated with tasks provided in the [Min] - 

[Max] fields. The dialogue box should then be closed. 

(3) During the simulation, occupants with this task move towards and then occupy the nodal 

location for a specified time before moving off. They are able to mill around within a 

specified range until they move off. The Milling Range (i.e. the distance from the target 

node within which the occupant can mill) is accessible by clicking on the node panel 

associated with the Delay task. 

(4) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 

 

 
Figure 4-12: Delay task. 

 

Task: Delay Zone 

The Delay Zone works in a similar manner to the Delay task, except that it operates over a pre-

specified compartment zone (see Section 4.3.2.1), as opposed to a single node. The user must 

initially generate a node within the Compartment Zone that is then associated with the itinerary 

in the standard manner. 

 

NOTE:  

If the selected node is not located inside the compartment, then the assigned occupant will have 

to then visit the node instead of the zone. 

 

The node pane can be double-clicked producing the list of Compartment Zones already created. 

One of these can then be selected. During the simulation, occupants attempt to reach the nodal 

location or are deemed to have reached the location when within the Compartment Zone and 

having experienced congestion (i.e. if their Wait count is greater than zero). 

 

To generate a Delay Zone (see Figure 4-13) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). It is recommended that the nodal location 

falls inside the compartment to be associated with the task (see Figure 4-13). 

(2) Associate a previously defined Compartment Zone with the task, via clicking the Node panel 

in the Itinerary Window (see Section 4.3.2.1) and selecting a compartment from the list 

presented. The compartments must already be generated.  

(3) Identify the range of possible delay times associated with tasks provided in the [Min] - 

[Max] fields. The dialogue box should then be closed. 

(4) During the simulation, the occupant will move into the compartment and head towards the 

specified target nodal location. The occupant then remains at the location for a specified 

time on reaching the nodal location or alternatively when experiencing congestion within 

the compartment (i.e. if their Wait count is greater than zero). 

(5) The occupant then moves off. 
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(6) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 

 

 

Figure 4-13: Delay Zone task. 

 

The Wait/Wait Zone tasks (similar to the Delay/Delay Zone tasks) exist to force occupants to 

wait until a specified time, rather than delay for a period of time; i.e. the task implicitly 

represents an occupant performing a task and the simulated time of completion. This might be 

used where occupants have to move to a refuge and move off at a specific time. Wait/Wait Zone 

tasks operate at a nodal or compartment-based level in an identical manner to the Delay 

functionality, and are created in a comparable manner. 

 

Task: Wait 

To generate a Wait task (see Figure 4-14) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). 

(2) Specify the time at which the Wait is over (seconds). People occupy nodal location until the 

time specified in Time(s) text box is reached, and then move on.  

(3) Users can set the range from the nodal location within which individuals are assumed to be 

waiting (Range (m)).  

(4) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 

 

 
Figure 4-14: Wait task. 

 

Task: Wait Zone 

To generate a Wait Zone task (see Figure 4-15) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). It is recommended that the nodal location 

falls inside the compartment to be associated with the task. 

(2) Associate the Compartment Zone with the task, via clicking the Node panel in the Itinerary 

Window (see Section 4.3.2.1) and selecting a compartment from the list presented. The 

compartments must already be generated. The dialogue box should then be closed. 

(3) During the simulation occupants move into the compartment and head towards the target 

nodal location specified. The occupants will remain at the location until the time specified 

in Time(s) text box on reaching the nodal location or alternatively when experiencing 

congestion within the compartment. 

(4) Occupants are able to mill around within the specified range until this time. 
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(5) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 

 

 
Figure 4-15: Wait Zone task. 

 

NOTE:  

The user may have to manipulate the dialogue box to ensure that all of the information available 

can be viewed.  

 

Task: WayPoint 

WayPoints are used to modify the route adopted by an occupant without incurring additional 

delays; i.e. allows an occupant's egress routes to be modified without an associated delay. An 

occupant can either be sent via a (Free-space) node or through a component, such as an Internal 

Exit, a Transit Node, etc. On reaching a node that has specific performance attributes (e.g. a 

Stair Transit Node) the occupant's performance is governed by the attributes of the egress 

component.  

 

This might be used in representing numerous situations where occupants are expected not to 

move directly to an exit during their movement; e.g. procedural guidance, route preference, etc. 

WayPoints can supersede any catchment areas associated with specific components types. For 

instance, if an occupant has a WayPoint task to use a specific Transit Node (i.e. the task location 

is on the Transit Node itself), the associated catchment area is ignored, as the instructions have 

already been provided. In contrast, if the Waypoint is designed to make an occupant use a 

specific group of Transit Nodes (i.e. nodes that have been deliberately grouped by the user), the 

task location could be positioned within the catchment area of the Transit Node grouping, 

allowing the occupant to then choose between the grouped nodes. 

 

Generally, given that WayPoints can be shared between group members (see Form Group 

below), group members can inherit movement tasks. However, they act differently according 

to the target.  

 

If the target node is a Gate, the occupant does not share this task. This is to prevent unrealistic 

overloading of specific Gate objects; e.g. where an entire group selects a single gate where 

adjacent gates are not being used.  

 

WayPoints are also created dynamically by the model as part of the selection between grouped 

Transit Nodes. For instance, if several Transit Nodes are grouped, and an occupant is instructed 

to make use of a particular node, then a WayPoint will be inserted into their itinerary to guide 

them to that particular node.  

 

WayPoints also interact with Internal Exits. Should a WayPoint be associated specifically with 

an Internal Exit, occupants will be able to use the entire width of the exit rather than just the 

node identified. This is to be consistent with the use of Transit Nodes, where the entire node 

can be used. This may be used to distribute the flow of occupants across the width of a corridor, 

etc. 
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To generate a WayPoint (see Figure 4-16) task the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). The dialogue box should then be closed. 

(2) During the simulation, an occupant is deemed to have travelled via the nodal location if 

they fall within a specified distance of the location (within Range(m)), then move on. 

(3) If they are being guided towards an egress component, then they will then use this 

component according to the attributes associated with that component (e.g. flow rates, 

adjusted travel speeds, capacity, etc.), and then continue. 

(4) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). The 

exception is when the group members are using a Gate.  

 

 

Figure 4-16: WayPoint task. 

 

Task: Queue 

The Queue task instructs the occupant to seek and use a pre-defined Queue/Server (see Chapter 

5). It requires that a Queue/Server has already been created. This simulates the existence of a 

queuing system within the geometry. The performance at the Queue/Server is determined by 

the attributes associated with the Queue/Server (see Chapter 5) rather than the task.  

 

To generate a Queue task (see Figure 4-17) the user should 

(1) Create a task by associating an arbitrary nodal location within the current geometry window. 

This should be selected to enable the itinerary task to be produced (e.g. by using the Auto 

Insert flag and then selecting a node, see Section 4.3.2.1).  

(2) The user should then select the Queue option from the list of available tasks.  

 

 

Figure 4-17: Queue task. 

 

(3) To complete the definition of the queuing task the user must define which specific Queue 

the individual should use. To achieve this, the user should double-click on the node button 

of the respective queuing task to bring up the Queue Selection dialogue box (see Figure 

4-18). The Queue Selection dialogue box contains a list of all the queues previously created 

by the user (in Scenario Mode) within the Queue Editor dialogue box, from which the user 

can select the desired queue. Figure 4-18 below shows an example containing three queues 

(i.e. queue_1, queue_2 and queue_3) of which queue_1 is currently selected. 
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Figure 4-18: The queue selection dialogue box. 

 

(4) Having selected the desired queue from the Queue Selection dialogue box the name of the 

queue is placed within the node button.  

(5) During the simulation, the occupant will head towards the server location (via pre-

determined approach, see Section 5.22). Occupants will then perform in accordance with 

the specified attributes of the Queue / Server being used. 

(6) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. It may also represent the situation where 

group members are queuing for a particular service, rather than selecting between entirely 

different services. It should be remembered that there may be multiple queue/server 

combinations associated with each queue from which a group member could choose (see 

Chapter 5). 

 

The previous examples assume that queuing system to be used by an occupant is known prior 

to them arriving. During a simulation occupants may need to choose between several queuing 

systems; e.g. between different groups of route/server configurations. For instance, this may be 

selecting between different facilities (such as a cafe, a ticketing system, washrooms, etc.) each 

of which may have its own queuing system in operation. This is achieved by adding tasks that 

are associated with each queue to the itinerary list of a Redirection Node (created in Geometry 

Mode). To enable the Redirection Node to select which queue people will be sent to based on 

the current queue length or queue speed, the user should select either the Pop. Size or Queue 

Speed option within the Allocation list box in the Itinerary Selection dialogue box (see Figure 

4-19).  

 

NOTE:  

It should be noted that given that a queue is selected by an occupant based on the size of the 

queue population or the speed at which the queue is moving, the probabilities associated to 

each of the tasks have no impact. 
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Figure 4-19: Redirection node Itinerary control dialogue box 

 

The user should refer to the description of Redirection Nodes in Chapter 5 to get more detailed 

guidance on configuring their use. 

 

Task: Form Group 

The Form Group functionality allows occupant groups to be formed at a pre-defined location 

and then move off as a group (i.e. moving in the same direction and with the speeds being 

adapted to cope with slower moving group members). This can be used to represent specific 

procedural instructions provided to individuals performed independently of other evacuees or 

pedestrians; for instance, emergency tasks (pre-sweep meeting for fire wardens) or non-

emergency tasks (meet friends at a landmark).  

 

Group members can be defined in two ways: using existing Gene attributes that they share, or 

using the GroupID associated with the Form Group task. Effectively, once an occupant has 

been given the Form Group task, they will head towards the indicated node (as previously 

described), and then remain at that location until the specified number of group members arrive. 

If no GroupID has been set by the user, the model will wait for other occupants with the same 

Gene as the current occupant. If a GroupID is specified, this will overwrite any Gene attribute, 

once the task has been commenced and the individual starts to move towards the indicated node. 

Once the specified number of occupants have arrived (as defined by the Size attribute), the 

occupants will move off to their next target having their Gene attribute changed to the GroupID. 

 

To generate a Form Group task (see Figure 4-20) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action.  

(2) The user is able to provide the GroupID. This will override any existing Gene attributes of 

the group members on their arrival; i.e. their Gene attribute will take on the GroupID value. 

If no GroupID is provided, then arriving occupants should have an existing Gene attributes 

to be counted as part of a group. If there is a mismatch between the number specified to 

form a group and the number of group members available, the task will fail and the 

individuals will move off having not formed a group. 

(3) The number of people in the group is specified by the Size attribute.  

(4) During the simulation the occupants will head to the specified target nodal location. When 

this number of people arrive at the location (within 2m of the nodal target), the group is 

deemed to be formed and they then move off to perform the next task. 
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(5) This task is NOT shared with other occupants (e.g. group members); i.e. as part of the 

process enabled by the Social Movement flag (see Chapter 6). 

 

 
Figure 4-20: Form Group task. 

 

Task: Form Group Zone 

The Form Group Zone is comparable to the Form Group task, except it occurs over an 

associated compartment zone, as with Delay Zone and Wait Zone. 

 

To generate a Form Group Zone task (see Figure 4-21) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). It is recommended that the nodal location 

falls inside the compartment to be associated with the task. 

(2) A Compartment Zone is assumed to have already been created. 

(3) Associate Compartment Zone with the task, via clicking the Node panel in the Itinerary 

Window (see Section 4.3.2.1) and selecting a compartment from the list presented. The 

dialogue box should then be closed. 

(4) The user is able to provide the GroupID this will override any existing Gene attributes of 

the group members on their arrival. If no GroupID is provided, then arriving occupants 

should have existing Gene attributes to be counted as part of a group. 

(5) The number of people in the group is specified by the Size attribute. When this number of 

people arrive within the associated compartment zone (i.e. reach the nodal location or 

experience congestion greater than zero seconds at any location within the compartment 

zone), the group is deemed to be formed and they then move off to perform the next task. 

(6) The Form Group Zone is NOT shared with other occupants (e.g. group members); i.e. as 

part of the process enabled by the Social Movement flag (see Chapter 6). 

 

 
Figure 4-21: Form Group Zone task 

 

NOTE:  

The behavioural flags Social Movement and Social Response have no impact on the Form 

Group itineraries (see Chapter 6). 

 

The group will remain intact until they are given instructions to leave the group. This can be 

done on an individual basis (Leave Group) or as a group (All Leave Group). Effectively, either 

an individual or the group have to visit the specified location.  

 

Task: Leave Group 

The Leave Group task is NOT shared between group members. This task is only available to a 

group leader who was either pre-determined or calculated by the model. An individual who has 

this task will leave the group on enacting the task; the other group members will not be affected.  
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To generate a Leave Group task (see Figure 4-22) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action.  

(2) Once the task is enacted, the individual is assumed to leave the group. 

(3) This task and any subsequent task associated with an individual will NOT be shared with 

other group members. 

 

 
Figure 4-22: Leave Group task 

 

Task: All Leave Group 

The All Leave Group task can be communicated to other group members by the group leader, 

allowing the entire group to disband; i.e. all members to leave the group. Given that the group 

has been formed previously, the All Leave Group task will be shared amongst the group; i.e. to 

ensure that the entire group is disbanded. When the group members reach that task on their 

itinerary, they will immediately leave the group. 

 

To generate an All Leave Group task (see Figure 4-23) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action.  

(2) Once an individual comes to the All Leave Group task in their itinerary they will then leave 

the group and continue on with either their own tasks or move off to an exit. This task will 

be shared with other group members; i.e. the fact that this task can be shared (as opposed to 

Leave Group, which cannot), enables the entire group to be disbanded. 

 

 
Figure 4-23: All Leave Group task 

 

Task: Wait For 

The Wait For functionality is similar to the Form Group task in that the occupant has to wait 

for a specified number (defined by the Number attribute) of group members (i.e. occupants that 

share the same Gene as the occupant in question). There is no overriding of the Gene attribute 

in this task. The arriving occupants have to pass within a specified distance of the nodal location 

(specified by the Range (m)). Once the specified number of group members have passed within 

this distance of the nodal location, then the occupant who has the Wait For itinerary will then 

move off.  

 

To generate a Wait For (see Figure 4-24) task the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action.  

(2) The user should specify the number of people that the individual is waiting for (Number) 

and the Range within which they can mill while they are waiting (Range (m)). 

(3) During the simulation, the individual will wait for the specified number of other group 

members to arrive.  
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(4) Once the specified number of people arrive, the individual moves off. 

 

 
Figure 4-24: Wait For task 

 

NOTE:  

The user should take care and ensure that the Number of people for whom the individual is 

waiting and the number of group members moving towards the individual is the same. If this is 

not the case then the results produced may not be predictable. 

 

Task: Remove 

The Remove task can be used to remove an occupant from the simulation on completion of their 

task; i.e. they effectively have no further impact on the simulation. This might represent 

emergency responders who perform an action within the simulation, but whose activities after 

their interaction with evacuees are not represented (searching, suppression, etc.).  

 

To generate a Remove task (see Figure 4-25) the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action. The dialogue box should then be closed. 

(2) The occupant moves to the nodal location.  

(3) On occupying the nodal location, the occupant leaves the simulation and is assumed not to 

have any further influence. They are recorded in the output file under the section 'People 

Removed or Still in Structure'. The time recorded is the time at which they were removed 

from the geometry. 

 

 
Figure 4-25: Remove task. 

 

Task: Discount 

The Discount task effectively removes an occupant from being recorded as an active participant 

in the simulation, without removing them from the physical space. Therefore, once the Discount 

is encountered, the occupant may still continue performing tasks and moving within the 

simulation; however, their time to evacuate will not be recorded as part of the normal overall 

evacuation time. For instance, in an evacuation they would not be counted as contributing to 

the overall evacuation time. Instead, their performance is recorded in the output file under the 

section 'People Removed or Still in Structure'. It should be noted that their actions may cause 

delays that may influence those evacuating, indirectly affecting the overall evacuation time; 

however, their performance will not be recorded as influencing the overall statistics recorded. 

 

 
Figure 4-26: Discount task. 
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For the Discount task (see Figure 4-26) to function, the user should 

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action. The dialogue box should then be closed. 

(2) Once the task is reached on the Itinerary list, the occupant immediately ceases to be 

recorded as part of the evacuation. They are recorded in the output file under the section 

'People Removed or Still in Structure'. The time recorded is the time at which they were 

removed from the geometry. 

(3) Typically, this task can be shared between group members during the communication 

process. 

 

Task: Discount Mill 

Some tasks can have milling actions associated with them (e.g. Wait, Delay, Delay Zone, etc.). 

The Discount Mill task can end the milling activity without the occupant being required to move 

on and prematurely ending the task in which they are involved.  

 

For the Discount Mill task (see Figure 4-27) to function, the user must initially  

(1) Create a task by associating a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). There are no delays associated with this 

action. The dialogue box should then be closed. 

(2) As with the Leave Group functionality, the occupant enacts the task when it is first reached 

in the itinerary list of tasks, and does not need to physically visit the nodal location. 

 

 
Figure 4-27: Discount Mill task. 

 

Task: Collect Person 

The Collect Person functionality allows a person classified as a leader (or group of people) to 

collect an individual at a pre-defined location and then move off as a group (i.e. moving in the 

same direction and with the speeds being adapted to cope with slower moving group members). 

It is important to note that this task will only work when assigned to leader occupants or groups 

which themselves contain a leader. Assigning this task to occupants who are not leaders will 

not work since it is deemed that the occupant in question does not have the authority to collect 

individuals. This task can be used to represent specific staff actions such as collecting a 

vulnerable/mobility impaired individual and escorting them to a location of safety in either 

emergency or non-emergency conditions.  

 

Once an occupant classified as a leader has been given the Collect Person task, they will head 

towards the indicated node (as previously described). If the specified node is unoccupied at the 

time the individual arrives the task will fail, since it is deemed that there is nobody to collect at 

the specified location. In these instances, the individual will simply abandon the Collect Person 

task and commence the next task within their itinerary. If however the specified node is 

occupied at the time the individual arrives they will then remain at that location until the 

specified number of people arrive. Any individuals arriving at the specified node and targeting 

the node via a Collect Person task will be included in the number count, as will the individual 

located on the target node (i.e. the person to be collected). Once the specified number of 

occupants have arrived (as defined by the Size attribute), the collected occupants itinerary will 

be updated by adopting the leaders itinerary tasks. All tasks between the current Collect Person 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 201 

task and the next Drop Off Person task within the leaders itinerary will automatically be inserted 

into the collected individuals itinerary. In this manner, the collected individual (and hence the 

group itself) will follow the actions of the group’s leader. In addition, all occupants within the 

group will have their Gene attribute changed to the GeneID specified by the user. The occupants 

will then move off to perform their next task. 

 

To generate a Collect Person task (see Figure 4-28) the user should therefore  

(1) Create a task and associate a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). 

(2) The number of people in the group is then specified by the Size attribute. 

(3) The Gene ID value then needs to be defined by the user. This value defines the Gene ID of 

the person to be collected at the designated nodal location. 

(4) During the simulation the occupants will head to the specified target nodal location. When 

the required number of people arrive at the location, the group is deemed to be formed. At 

this point the itinerary of the collected individual is updated and the Gene attributes of all 

group members changed to the Gene ID value specified by the user. The occupants will 

then move off to perform the next task. 

(5) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 

 

 
Figure 4-28: Collect Person task. 

 

Task: Drop Off Person 

The Drop Off Person functionality allows a person classified as a leader (or group of people) 

to drop off a previously collected individual at a given location. The Drop Off Person task is 

therefore designed to work in conjunction with the Collect Person task (see above). The Collect 

Person and Drop Off Person tasks can be used to represent specific staff actions such as 

collecting a vulnerable/mobility impaired individual and escorting them to a location of safety 

in either emergency or non-emergency conditions. 

 

As outlined previously, the Collect Person task enables an individual to be collected from a 

given location by a person classified as a leader or a group of people (which contains a leader). 

Once collected, a group will be formed which will move together (i.e. move in the same 

direction and with the speeds being adapted to cope with slower moving group members) and 

escort the collected individual through the structure. The collected individual will remain with 

the group until a Drop Off Person task is performed. When a Drop Off Person task is performed 

the group will head towards the specified node. Once the collected individual reaches the 

specified node they are then removed from the group. Each of the remaining occupants within 

the group will then move off to perform their next task. 

 

To generate a Drop Off Person task (see Figure 4-29) the user should therefore  

(1) Create a task and associate a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). 
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(2) During the simulation all individuals within the group formed as part of the Collect Person 

task will head to the specified target nodal location. When the collected individual arrives 

at the location, they are then removed from the group. Each of the remaining occupants 

within the group will then move off to perform their next task. 

(3) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 

 

 
Figure 4-29: Drop Off Person task. 

 

Task: Coordinated Delay 

The Coordinated Delay functionality allows a group of people to experience a simultaneous 

delay at a pre-defined location. Using this approach the delay experienced by the group of 

individuals does not commence until the defined number of individuals within the group have 

all arrived. This can be used to represent the time taken by staff to undertake collaborative 

actions such as preparing a vulnerable/mobility impaired individual for evacuation in either 

emergency or non-emergency conditions.  

 

Once an occupant has been given the Coordinated Delay task, they will head towards the 

specified node. Once the individual arrives at the node they will then remain at that location 

until the defined number of people arrive. Any individuals arriving at the specified node and 

targeting the node via a Coordinated Delay task will be included in the number count. Once the 

specified number of occupants have arrived (as defined by the Size attribute), a delay will then 

be randomly calculated between the minimum and maximum delay times defined by the user. 

Each individual with a Coordinated Delay task will then experience the same random delay. It 

is important to note that each individual does not start experiencing the delay until ALL the 

required number of people have arrived. Once each individual has experienced the delay they 

will then move off to perform their next task. It is important to note that the Coordinated Delay 

task differs significantly from simply assigning each individual a Delay task, where the delay 

is calculated and experienced for each individual independently of each other. 

 

To generate a Coordinated Delay task (see Figure 4-30) the user should therefore  

(1) Create a task and associate a nodal location with the task (e.g. by using the Auto Insert flag 

and then selecting a node, see Section 4.3.2.1). 

(2) The number of people in the group is then specified by clicking the tasks corresponding 

Node button (i.e. FS_2 in Figure 4-30). 

(3) Identify the range of possible delay times associated with the task provided in the [Min] - 

[Max] fields. The dialogue box should then be closed. 

(4) During the simulation the occupants will head to the specified target nodal location. When 

the required number of people arrive at the location, they then all experience a random delay 

(between the minimum and maximum times defined by the user). Once each individual has 

experienced the delay they will then move off to perform their next task. 

(5) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produced undesirable group dynamics. 
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Figure 4-30: Coordinated Delay task. 

 

Task: Find via Signage 

The Find via Signage task represents an occupant intentionally seeking out a sign in order to 

guide them to their objective (see the Theory Manual, Section 8.2.2 for description of Occupant 

Driven Behaviour) - the route/location of which is unfamiliar to that occupant. The use of the 

Find via Signage itinerary assumes that the objectives (e.g. signs, exits, etc.) have already been 

created within the model (see the Theory Manual and Chapter 5).  

 

For the Find via Signage task to function, each occupant should have a pair of tasks. The first 

task represents the initial direction of travel towards the first sign that the occupant will 

encounter. The direction of travel is indicated by a nodal location that the user selects which is 

associated to the Find via Signage task. The second task represents the nodal location of the 

eventual target, typically represented by a Delay or WayPoint task. The assumption is that by 

making the individual move towards the sign they will eventually fall into the VCA of a sign 

that will then provide further information relating to the correct direction of travel towards the 

desired target (see the Theory Manual). This movement towards their desired target can include 

the initial movement towards the next sign in a signage chain. It is recommended that the nodal 

location indicating the direction of travel is set at the far side of the VCA in respect to the initial 

location of the occupant to ensure that the occupant will have a chance of passing through the 

VCA. However, local conditions such as crowding may cause an individual to miss the VCA. 

This broadly reflects the general directional guidance (e.g. an arrow) that a sign may provide, 

and an individual's attempt to follow it. 

 

Therefore, for each target that the individual wishes to visit the user should specify a pair of 

itineraries that include the following information: 

 

a) Initial direction of travel towards a sign defined as a nodal location assigned to a Find 

via Signage task  

b) The target location plus a task to perform on arrival, typically a Delay action 

 

To generate a Find Via Signage task (see Figure 4-31) the user should 

 

(1) Create the first part of this task (itinerary) by associating a nodal location with the task (e.g. 

by using the Auto Insert flag and then selecting a node). This represents the direction that 

the occupant will move to find a sign. To function, this location should take the occupant 

through the VCA of the desired sign. It is recommended that this node should be located on 

the far side of the VCA from the occupant's initial location, encouraging the occupant to 

pass through the VCA of the sign.  

(2) Create the second part of this task. The second task indicates the final objective (target) of 

the occupant; i.e. where they want the sign(s) encountered to eventually lead them.  

 

 
Figure 4-31: Find via Signage task 

 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 204 

An example of this is presented in Figure 4-32. Here, there are four tasks in the Itinerary 

Window representing two distinct task pairs to seek out signage and then be directed to two 

different objectives (targets); i.e. the occupant has to find two distinct locations using the signs 

available. Task 1 informs the occupant to move towards Node FS77 and seek information from 

the sign encountered. This takes them towards a sign (S1) positioned at the T-junction shown 

in Figure 4-33. The occupant reaches the VCA of sign S1, receives information and is given a 

route to reach their first target (i.e. Node FS437, as indicated in Task 2). This route is defined 

in the Sign object itself having been specifically associated with this objective (target). Once 

this location has been reached the occupant experiences a delay (between 5 and 10 seconds 

produced by enacting the Delay task identified in Task 2) and then moves onto the next Find 

via Signage pair of tasks (i.e. Tasks 3 and 4). 

 

 
Figure 4-32: Example of a set of itineraries indicating that the occupant wants to reach 

the locations indicated by tasks 2 and 4. 

 

Task 3 indicates that the occupant should move off towards Node FS215 in order to seek 

information from a sign (see Figure 4-32). This takes them towards Sign S3 (see Figure 4-33). 

Once they fall into the VCA of Sign S3 information (i.e. a nodal direction indicating direction 

of movement) is provided that guides them towards Sign S4; on falling into the VCA of S4, 

information (i.e. a nodal direction indicating direction of movement) guides them to Sign S5. 

Similarly, Sign S5 guides the occupant to Door1, which is indicated as their final objective 

(Task 4 in Figure 4-32). The complex path produced is shown in Figure 4-33, where the path 

of occupant P1 follows the signage which guides them to the two objectives (Tasks 2 and 4 in 

Figure 4-32) before leaving. Note that in the example presented here the occupants who observe 

the signs follow them because they relay information regarding the targets these occupants wish 

to visit. Also, continuity in the signage chain is ensured by having the signs pointing to the same 

target (e.g. signs S1 to S5 point to Door1). 

 

NOTE:   

When an occupant adopts new information from a sign a representative WayPoint task is added 

to their itinerary. 
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Figure 4-33: Route adopted by occupant P1 given use of two Find via Signage tasks. 

 

It should be noted that occupant P1 is not simply guided to Door_1 in a manner similar to a 

Target Exit. They are assumed to have no understanding of the route to Door_1, and without 

the piece-meal guidance provided by the signage they will not be able to reach the objective. If 

they are not able to reach their objective, as a result of not seeing the signs they proceed to their 

next task in their itinerary list. If no more tasks exist then they move towards their nearest exit. 

The exiting behaviour is governed by the navigational model used (i.e. potential map or local 

familiarity). This is a mechanism that allows the user to examine the effectiveness of signage 

to impart information regarding previously unfamiliar routes. 

 

Task: Lift Bank 

The Lift Bank task is used to assign an occupant to a lift bank by assigning any of its constituent 

Lift Shaft Opening transit node. Only Lift Shaft Opening transit nodes which form part of a 

transit node group should be associated with a Lift Bank task. If the assigned Lift Shaft Opening 

transit node is not part of a transit node group then the occupant will treat the Lift Bank task as 

a waypoint (i.e. since no lift waiting area will be defined) and will attempt to reach the Lift Shaft 

Opening transit node. 

 

It is important to note that agents who are assigned Lift Bank tasks may not actually use the 

lift/lift bank to which they have been assigned. Whether or not agents will use their designated 

lift is dependent upon both whether or not the lift they are targeting has a defined floor sequence 

(see Chapter 5), and whether the agent has tasks within their itinerary following the Lift Bank 

task (i.e. whether the agent is attempting to undertake circulation as opposed to merely 

evacuation). The resulting action undertaken by agents for each combination of these factors is 

outlined in Table 4-4 below: 
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Table 4-4: The actions undertaken by agents with Lift Bank tasks 
Does the Lift 

have a defined 

floor sequence? 

Additional tasks 

following the 

Lift Bank task? 

 

Agent Action 

YES 

(Evacuation) 

YES 

Upon entering the lift waiting area (i.e. catchment area) the agent 

will immediately abandon their Lift Bank task and redirect to the 

stairs as an alternative means of reaching their next itinerary task. 

This is because since the lift the agent is targeting has a defined 

floor sequence it is assumed that the lift is intended to be used for 

evacuation and not circulation, and hence might not provide a 

viable means of reaching the agent’s next task. 

NO 

When an agent enters into the waiting area (catchment area) of the 

assigned lift bank, the agent will first check its corresponding 

congestion level. If the congestion level within the catchment area 

exceeds the agent’s defined Congestion Threshold value (occ/m2) 

they will drop the Lift Bank task and either follow the potential 

map to their nearest exit or automatically be redirected to stairs on 

the floor (depending on the behavioural settings).  However, if the 

congestion level within the catchment area does not exceed the 

agent’s defined Congestion Threshold value they will then check 

to see if a lift in the bank will still service the floor.  If no lift in 

the bank services the agent’s floor or the lift has already serviced 

that floor, then the agent will drop the Lift Bank task and either 

follow the potential map to their nearest exit or automatically be 

redirected to stairs on the floor (depending on the behavioural 

settings). If however a lift in the bank does service the agent’s 

floor they will then automatically be assigned a Lift Wait task (see 

below).  This Lift Wait task randomly assigns agents to one of the 

Lift Shaft Opening transit nodes within the lift bank. This Lift 

Shaft Opening transit node defines which lift the agent will 

initially wait by whilst waiting for a lift.  

 

If the amount of time the agent has been waiting for the lift 

exceeds their defined Wait Time they will abandon the Lift Wait 

task and redirect to the stairs. Assuming the agent’s Wait Time is 

not exceeded the agent will then board the lift when it arrives and 

then travel in the lift to its designated drop off floor, where upon 

they will then alight and continue their evacuation. Hence these 

agents do not directly consider where the lift is going before 

boarding it, since they automatically assume that the lift’s 

corresponding drop off floor is closer to a point of safety (i.e. an 

available exit). This is typically the case involving agents 

automatically assigned to use lifts as part of a lift evacuation. 
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NO 

(Circulation) 

YES 

Upon entering the lift waiting area (i.e. catchment area) the agent 

will consider the floors serviced by the lift. If the target of their 

next task (i.e. the task immediately following the Lift Bank task) 

is on a floor directly serviced by the lift (i.e. if a Lift Shaft Opening 

transit node on the target floor is defined within the lift’s Nodes 

tab, see Chapter 5) then the agent will deem that the lift will take 

them to where they need to go. Conversely, if the lift the agent is 

targeting does not service their required floor then upon entering 

the lift waiting area the agent will abandon the Lift Bank task and 

redirect to the stairs as an alternative means of reaching their next 

itinerary task. 

 

If the lift does service the agent’s required floor, they will then 

consider the congestion within the waiting area. If the congestion 

level exceeds the agent’s defined Congestion Threshold they will 

abandon the Lift Bank task and redirect to the stairs. If however 

the Congestion Threshold is not exceeded the agent will then be 

assumed to call the lift. The lift dispatch algorithm will then 

register the request and set about sending a lift from the 

designated lift bank to the appropriate floor. The agent will then 

automatically be assigned a Lift Wait task (see below) and will 

wait for the lift to arrive. This Lift Wait task randomly assigns 

agents to one of the Lift Shaft Opening transit nodes within the lift 

bank. This Lift Shaft Opening transit node defines which lift the 

agent will initially wait by whilst waiting for a lift.  

 

If the amount of time the agent has been waiting for the lift 

exceeds their defined Wait Time they will abandon the Lift Wait 

task and redirect to the stairs. Assuming the agent’s Wait Time is 

not exceeded the agent will then board the lift when it arrives and 

then travel to their required floor (i.e. the floor on which their next 

itinerary task is located). Upon reaching their required floor the 

agent will then alight and set about undertaking the next task 

within their itinerary.  

NO 

The lift will not be used by the agent, this is because the lift has 

no defined floor sequence and the agent is unable to determine 

whether the lift will take them to the nearest exit. Hence upon 

entering the lift waiting area (i.e. catchment area) the agent will 

abandon the Lift Bank task and instead redirect to the stairs. It is 

important to note that agents without additional itinerary tasks 

being assigned to lifts without defined floor sequences will only 

occur where Lift Bank tasks have been assigned manually by the 

user. This is because if no floor sequence is defined for a given 

lift then it will be assumed not to represent an evacuation lift but 

a circulation lift. Consequently, agents will not be automatically 

assigned itinerary tasks to use a lift that has no floor sequence 

assigned to it as part of a lift evacuation. 
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In summary, if a lift is assigned a floor sequence it is assumed to be used only for evacuation. 

As a result, only agents who have no other tasks within their itinerary following the Lift Bank 

task will use the lift. Agents who do have tasks within their itinerary following the Lift Bank 

task are assumed to be undertaking circulation actions, and hence will not use a lift that is used 

to evacuate the agents from a structure.  

 

Conversely, if a lift does not have a defined floor sequence it is assumed to be used only for 

circulation. Consequently, agents who have no tasks within their itinerary following the Lift 

Bank task (and hence are attempting to evacuate) will not use the lift. Only agents who do have 

tasks within their itinerary following the Lift Bank task, and hence are assumed to be 

undertaking circulation actions, will use the lift. 

 

To generate a Lift Bank task (see Figure 4-16) the user should 

(1) Create a task by associating a Lift Shaft Opening transit node and assign it the Lift Bank 

task (e.g. by using the Auto Insert flag and then selecting a Lift Shaft Opening transit 

node, see Section 4.3.2.1).  

(2) Set the Wait Time. This defines the total amount of time an agent will wait for a lift 

before dropping the task and either following the potential map to their nearest exit or 

automatically being redirected to stairs on the floor (depending on the setting of the 

Even Stair Redirection flag within the Behaviour Control dialogue box, see Chapter 7). 

(3) Set the Congestion threshold. This defines the levels of congestion in occ/m2 in the 

transit node catchment area which would cause the occupant to redirect away from the 

lifts and move towards the stairs (i.e. they are not prepared to wait in such high levels 

of congestion). If this value is set to 4 or more occ/m2 then the agent will by default not 

consider the congestion (since greater densities are not achievable in buildingEXODUS 

if the default 0.5m node spacing is assumed) thereby causing the agent to wait 

irrespective of the congestion levels. The dialogue box should then be closed. 

(4) During the simulation, an occupant is deemed to have reached the Lift Shaft Opening 

when they enter into the associated transit node’s catchment area. 

(5) Typically, this task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). 

This is because the sharing of this task does not detract from the group movement or 

potentially produce undesirable group dynamics. 

 

 

Figure 4-34: Lift Bank task. 

 

Task: Lift Wait 

The Lift Wait task is assigned automatically to occupants who have previously been assigned a 

Lift Bank task and entered into the transit node’s catchment area of the associated Lift Shaft 

Opening transit node. The Lift Wait task is only assigned to occupants if upon entering the 

catchment area its corresponding congestion level is less than their defined Congestion 

Threshold value. If upon entering the catchment area its congestion level exceeds the occupants 

defined Congestion Threshold value (occ/m2) they will drop the Lift Bank task and either follow 

the potential map to their nearest exit or automatically be redirected to stairs on the floor 

(depending on the behavioural settings). If no lift in the bank services the occupant’s floor or 

the lift has already serviced that floor, then the occupant will also drop the Lift Bank task and 
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not be assigned the Lift Wait task (i.e. agents will not wait for a lift which will never come). It 

is important to note that the Lift Wait task should NOT be manually assigned by users. 

 

The Lift Wait task randomly assigns agents to one of the Lift Shaft Opening transit nodes within 

the lift bank. This Lift Shaft Opening transit node defines which lift the agent will initially wait by 

whilst waiting for a lift. The Wait Time associated with the Lift Wait task defines the amount of 

time an occupant is prepared to wait to use a lift before dropping the task and either following 

the potential map to their nearest exit or automatically being redirected to stairs on the floor 

(depending on the behavioural settings).  The Wait Time value associated with the Lift Wait task 

will by default always be assigned to the same value defined within the preceding Lift Bank 

task (see Figure 4-35). 

 

 
Figure 4-35: Lift Wait task. 

 

If a lift within the defined lift bank arrives before the total time the occupant has been waiting 

exceeds their defined Wait Time and there is sufficient capacity within the lift then the occupant 

will be assigned to use the lift. This is achieved by the occupant automatically being assigned 

a Way Point task to the specific Lift Shaft Opening transit node within the lift. The agent’s 

itinerary list will be updated to reflect this (see Figure 4-36). This automated Way Point task 

will by default have a Range of 0m.  

 

 
Figure 4-36: The automatic addition of a Way Point task. 

 

Typically, the Lift Wait task can be shared between group members during the communication 

process; i.e. as part of the process enabled by the Social Movement flag (see Chapter 6). This is 

because the sharing of this task does not detract from the group movement or potentially 

produce undesirable group dynamics. However, it is important to  note that while the Lift Wait 

task is shared between group members the allocation of the subsequent Way Point task to board 

a lift will not be shared. Consequently agents within a given group will target the same lift bank 

(i.e. Lift Bank task) and will initially commence waiting around the same Lift Shaft Opening 

transit node (i.e. Lift Wait task) however they may not catch the same lift. 

 

4.3.2.2 Naming of Itineraries 

It was felt that as itineraries became increasingly complex that it would be easier to keep track 

of the itinerary that an individual was following if the name associated with the itinerary could 

be changed to suit the actions being modelled. The name of the itinerary is accessible from an 

additional text box located on the top right hand side of the Edit Itinerary dialogue box (see 

Figure 4-37 and Figure 4-38). This box is generated by double-clicking on the itinerary panel, 

from the particular dialogue box within which it is being displayed. 
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Figure 4-37: The inclusion of the text box enabling the itinerary to be re-named. 

 

 
Figure 4-38: How the itinerary appears to the user in the Itinerary Selection dialogue 

box. 

 

4.3.2.3 Creating Exit Awareness for a Default Occupant 

The Occupant Exit Knowledge is used in conjunction with the Local Familiarity navigation 

system. For default occupants, their exit knowledge must be specified manually by the user.  

The default occupant can be supplied with specific exit familiarity that can involve any 

combination of the available exits. 

 

To define the default Occupant Exit Knowledge, the DEFAULT PERSON dialogue box must 

be accessed.  Select Defaults from the menu bar and the Person item from the pull down menu 

(see Figure 4-2).  A dialogue box will be displayed allowing the attributes of the default person 

to be modified (see Figure 4-3).  By clicking on the FAM button the EXIT AWARENESS 

dialogue box is displayed. 

 

Exits can be added to the default Occupant Exit knowledge (Known Exits) through highlighting 

specific exits in the Available Exits list and then clicking on the ADD button (see Figure 4-39). 

Exits can be removed from the default occupant’s familiarity in a similar process, except this 

time identifying the specific known exit (from the Known exits list) and then clicking the 

REMOVE button. To reduce the user workload in creating occupant familiarity, complete exit 

lists can be added to or removed from the occupant’s awareness using the ADD ALL and the 

REMOVE ALL buttons respectively. 
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Exits attributed in this fashion are guaranteed to appear in the eventual default occupant exit 

list and therefore in the exit list of any subsequently generated occupants. The creation of this 

form of exit list in POPULATION mode will supersede any subsequent methods to generate 

occupant exit lists (i.e. those that are dependent upon automatic processes in SIMULATION 

mode). Once created, these exit lists will then remain constant between simulation runs. 

 

 
Figure 4-39:The user may specify the exit awareness individually. In this case the 

occupant is aware of Door_3.  

 

Once created, the exit list is available for all occupants subsequently generated using individual 

random placements, using the default occupant definition. These will be available for editing 

by double-clicking on the individual occupants (see Section 4.6.2.3) and making the necessary 

alterations. 

 

4.3.3 Placing individuals 

Individuals can either be placed at an exact location or randomly within a geometry window. 

 

Shortcut: [Tools/Person] 

To generate and place a single default (see Section 4.3.1) occupant, the following procedure 

must be followed. Select Tools from the menu bar, the Person item from the pull down menu 

(see Figure 4-2) and either (a) the Location or (b) the Random Location item from the sub-

menu. 

 

(a) Shortcut: [Tools/Person/Location]  
The Location item allows an individual occupant to be placed in a geometry window by 

clicking in the required location. Each click will generate a default occupant. The 

required number of default occupants may be generated by continuing to click at the 

required locations. To cease generating occupants in this manner, the Select/People 

Select item must be selected from the Edit submenu or the PERSON SELECT button 

should be depressed on the tool bar. 

 

(b) Shortcut: [Tools/Person/Random Location] 
The Random Location item generates a single (default) person in a random location 

within a geometry window. Note that the Random Location item must be re-selected for 

each occupant to be generated using this method. 

 

In either case, the attributes for occupants generated in this manner, can either be modified after 

generation (see Section 4.6) or pre-defined by modifying the default values for occupants (see 

Section 4.3.1). 
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4.3.4 Placing multiple individuals 

Shortcut: [Tools/Person/Random Block] / [Tools/Person/Random Generate] 
This method is most appropriate when the user is unconcerned with the specific population 

characteristics. Using this method, occupants can be placed in the geometry window in either 

random locations or in fixed blocks. To place multiple occupants in a geometry window the 

following procedure must be followed. First select the required area of geometry (see Section 

3.3.3.1). Then, select Tools from the menu bar, the Person item from the pull down menu (see 

Figure 4-2) and either (a) the Random Block item, or (b) the Random Generate item.  

 

(a) The Random Block item generates one occupant for every node in the selection (excluding 

exits) (see Figure 4-40). 

 

  
(a) (b) 

Figure 4-40: Selection of the area to include the Random Block. (b) The results of 

selecting the Random Block function. 

 

(b) The Random Generation item generates a number of occupants in random locations within 

the selection. In this case, the user is prompted for the number of occupants to generate 

inside the selection. 

 

  
(a) (b) 

Figure 4-41: Selection of the area to include the randomly generated population and the 

size of the population. (b) The results of selecting the Random Generate function. 

 

NOTE: 

If the number of occupants specified in the RANDOM GENERATE dialogue box is equivalent 

to the number nodes selected then the results will be equivalent to the Random Block function. 

 

4.4 Manual Population Generation 

This facility allows the user to specify a (sub-) population with control over the attributes 

assigned to each occupant. This method should be used when the user is concerned with the 

specific values of the individual occupant attributes. Using this technique the user has access to 

and must set the defining occupant attributes. 

 

To generate (sub-) populations in this manner, the area in which the occupants are to be placed 

must first be selected (see Section 3.3.3.1). The POPULATION PANEL dialogue box (see 

Section 4.4.1) is then used to define all the groups (see Section 4.4.2) within the (sub-) 

population. When the user is satisfied with the (sub-) population profile, the occupants are then 

placed randomly within the selected nodes (excluding exit nodes). In this manner, sub-

populations may be built in certain areas of a geometry or a whole population may be built in a 

single step (by selecting the whole geometry). 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 213 

 

4.4.1 The Population Panel Dialogue Box 

Shortcut: [Tools/Panel Populate]  
The Population Panel dialogue box represents the POPULATION (or SUB-POPULATION) to 

be defined (see Figure 4-42). Within a POPULATION, there are GROUPS of individuals with 

varying abilities and attributes. These groups are identified as Panels, and a POPULATION 

consists of one or more panels. Each panel describes the physical and psychological profile of 

a particular kind of person (see Section 4.4.2). The user can then identify the number of 

occupants within the population belonging to each GROUP, either as a percentage or as an 

absolute number.  

 

For example, consider a population of 60 individuals comprising two distinct GROUPS. The 

GROUPS may be identified as "YOUNG MALES" (40 individuals) and "OLD MALES" (20 

individuals). This POPULATION would be defined by using two panels, one for the "YOUNG 

MALES" and one for the "OLD MALES". The panel describing the "YOUNG MALES" would 

account for 40 individuals or 67% of the POPULATION while the panel describing the "OLD 

MALES" would account for 20 individuals or 33% of the POPULATION. 

 

To access the POPULATION PANEL dialogue box, select Tools from the menu bar and the 

Panel Populate item from the pull down menu (see Figure 4-2). Alternatively, press the PANEL 

POPULATE button on the toolbar (see Table 4-1).  

 

NOTE: 

Each panel definition can be saved as a panel file (.PAN) and each population (collection of 

panels) can be saved as a population file (.POP). 

 

The POPULATION PANEL dialogue box has five main areas (see Figure 4-42), (a) population 

size controls, (b) the panel list, (c) allocation, (d) node types and (e) the control buttons. 

 

a) Population Size Controls - There are two parameters which can be specified to control 

the population size, the (i) Total Population Size, and (ii) Fix Population size. These 

parameters have the following functions, 

 

(i) Total Population Size: Specifies the total number of occupants to generate in this 

population. 

 

(ii) Fix Pop Size: Keeps the population size fixed. If this option is not selected, the Total 

Population Size will alter when modifying the percentages for each panel. 
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Figure 4-42: Population panel dialogue box 

 

(b) The Panel List - This is a list of profiles for different groups of occupants. Within each 

panel, occupant characteristics can be specified, see Section 4.4.2. Panels can be created, 

deleted, added and removed from a population using the control buttons. The percentage 

box specifies the percentage of the overall population size attributed to each panel. The 

absolute number box performs the same function, but as an absolute number. The user can 

specify one or the other but not both. The number of panels that can be specified for a 

population is limited only by the available memory, however only a selection of panels is 

visible at any one time. To view other panels in the list, the panel list scroll-bar must be 

used. 

 

NOTE: 

When altering the percentages or absolute numbers for an individual panel, keep the population 

size fixed option checked to prevent the population size from changing. 

 

(c) Allocation – This section enables the user to control where the defined population will be 

initially generated and located within the geometry.  Four separate allocation options are 

available, namely Global, Selection, Zone and Floor.   

 

(i) Global – If this option is selected then when the Populate button is clicked the 

population will be generated throughout the entire structure in accordance with the node 

types selected by the user (see Node Types section below).  Hence if only Free Space 

nodes were selected, then generating the population with the Global allocation system 

defined would ensure that agents could be randomly placed on any Free Space node 

within the entire geometry (i.e. within any region and on any floor).  If the Global 

allocation system is selected then the Assign button is disabled since for this allocation 

system it is not required. 
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(ii) Selection - If this option is selected then when the Populate button is clicked the 

population will be generated within the region (or regions) currently selected by the user 

in accordance with the node types selected by the user (see Node Types section below).  

Hence if only Free Space nodes were selected, then generating the population with the 

Selection allocation system defined would ensure that agents could be randomly placed 

on any Free Space node within the selected region.  If the Selection allocation system 

is selected then the Assign button is disabled since for this allocation system it is not 

required. If the user attempts to select the Selection allocation system without already 

having a region of the geometry selected then the allocation system will automatically 

default back to Global. 

(iii)Zone - If this option is selected then when the Populate button is clicked the population 

will be generated within the currently selected Compartment zone.  Upon selecting the 

Zone option within the allocation list box the Assign button will become enabled.  

Clicking this button will in turn display the Zone Selection dialogue box showing all the 

Compartment zones currently within the geometry (see Figure 4-43(a)).  Using this 

dialogue box the user can select a Compartment zone, thereby controlling the region 

within the geometry that will be populated.  If the user selects the Zone allocation system 

but fails to select a Compartment zone prior to clicking the Populate button then a 

message will be displayed informing them to specify a zone. It is important to note that 

the allocation of agents to zones is done in accordance with the node types selected by 

the user (see Node Types section below). 

(iv) Floor - If this option is selected then when the Populate button is clicked the number of 

agents generated on each floor will be in accordance with that defined by the user.  Upon 

selecting the Floor option within the allocation list box the Assign button will become 

enabled.  Clicking this button will in turn display the Floor Assignment dialogue box 

(see Figure 4-43(b)). Within this dialogue box the user can specify the number of agents 

to be populated on each floor. Once this has been done, clicking the Calc.% button will 

automatically update the corresponding % Size values for each floor. By default the 

Total Population Size defined within the Population Panel dialogue box (see Figure 

4-42) is evenly distributed to each of the floors within the geometry.  It is important to 

note that the allocation of agents to floors is done in accordance with the node types 

selected by the user (see Node Types section below). 
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(a) (b) 

Figure 4-43: Defining the region to be populated via a) a zone, and b) floors 

 

(d) Node Types – This section enables the user to define what types of node the agents will be 

placed upon when the population is generated.  This therefore enables the user the ability to 

deselect certain node types, thereby ensuring that agents are not initially placed upon those 

nodes.  In total, nine different types of node can be selected/deselected, namely Seats, Stairs, 

Boundary nodes, Free Space nodes, Landing nodes, Attractor nodes, Discharge nodes, 

Census Regions and Internal Doors. 

 

(e) The Control Buttons - Each of the buttons performs an action on the population panels, 

according to Table 4-5. 

 

Table 4-5: Control buttons for the Population Panel dialogue box 

Button Name Explanation 

REMOVE Removes selected panel from panel list 

CREATE Creates a new panel 

LOAD PANEL Loads a previously defined panel into the panel list 

CLEAR Removes all population panels from panel list 

LOAD POP. Loads a previous population definition 

SAVE POP. Save the current population definition 

EDIT Edit the currently selected panel 

STAN. POP Re-creates the STANDARD population (see Appendix B) 

CALC% 
Calculates % of population for all panels from given number of occupants 

supplied by the user 

NORM% Normalises the percentages 

ADV. GLOBAL 

OPTIONS 

Allows the user to define additional population parameters such as Target 

LSA, Colour, Gene Response time distribution, Familiarity and Itinerary 

POPULATE Creates population 

CLOSE Closes the dialogue box 
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(i) Modifying/Adding/Removing Panels: To add a new panel, click the CREATE 

button. This will add a new panel at the end of the current list, called PANELX, 

where X = the number of newly created panels. The panel can then be edited and 

saved to the panel library (see Section 4.4.2). 

 

To add existing panels to the current list, click the LOAD PANEL button. The user 

is then prompted to supply a panel name. By default, panel files are saved as .PAN. 

 

To modify the attributes in any panel, double-click the required panel to retrieve 

its dialogue box (see Figure 4-44), and modify as required (see Section 4.4.2). 

 

To remove a panel from the list, select the panel by clicking the panel once (see 

Figure 5.7). The highlighted panel can then be removed by clicking the REMOVE 

button. 

 

All panels may be removed by clicking the CLEAR button. 

 

 
Figure 4-44: Highlighted Panel, ‘Males 17-29’ 

 

NOTE: 

Removing a panel from a population does not delete the panel from the hard-disk. 

 

(ii) Saving/Loading (sub-)Populations: A (sub-)population is a collection of panels. 

A (sub-) population can be saved by clicking the SAVE POP button. The user is then 

prompted to supply a name for the population. Do NOT supply an extension for the 

file as this will be done automatically. This process will create a .POP file. 

 

To load existing .POP files, click the LOAD POP button. The user is then prompted 

to select a .POP file. 

 

(iii) Controlling the (sub-)Population Size: The size of the (sub-)population is 

controlled by the Total Pop. Size field (see Figure 4-42). However, this value 

changes as the percentage (or absolute number) assigned to each panel changes. To 

prevent this from happening, ensure that the Fix Pop Size box is selected. 

 

When the Fix Pop Size box is selected, the percentages (or absolute number) 

assigned to each panel may be modified without changing the overall population 

size. However, during modification, the running totals (see Figure 4-42) may not be 

the same as the (sub-) population. Once modified, the actual percentages can be 

calculated by clicking either the CALC% or NORM% button.  

 

Use the CALC% button if the absolute numbers attributed to each panel have been 

modified and use the NORM% button if the percentages have been modified and do 

not sum to 100%. 
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TIP: 

Modify the percentages wherever possible, as modification of these is immediately reflected in 

the absolute numbers box. 

 

NOTE: 

A (sub-) population will not be accepted if the absolute running total does not equal the total 

(sub-) population value. 

 

(iv) Adv. Global Options. 

Some options such as Target Exit, Colour, Gene and Response Curve Distribution, 

Familiarity and Itinerary can be applied to the entire population using the Advanced 

Global Option dialogue box (see Figure 4-45). The Target, Colour, Gene and 

Response Curve Distribution attributes override any values set within individual 

panels. However, global Itineraries and Familiarity are appended to each 

occupant’s itineraries/exit list, which are generated within each panel. To access the 

Advanced Global Options dialogue click on the “Adv. Global Options” button on 

the Population panel dialogue box. This dialogue box is used in a similar fashion 

to the Advanced option dialogue box.  

 

 
Figure 4-45: Advanced Global options dialogue box 

 

(v) Accepting a (sub-) Population: To accept a (sub-) population, click the OK button. 

This will then distribute the required number of occupants throughout the selected 

area. More occupants from the same population (or other populations) may be added 

by repeating the population panel editing process. 

 

4.4.2 Group Panels 

Group panels allow profiles of occupant types to be specified. In each panel, occupant attributes 

are assigned according to the user’s specification. Figure 4-46 displays a typical group panel, 

and highlights the eight major parts of the dialogue box. 

 

The attributes describing the profile of a occupant group are categorised into four groups, Travel 

Speeds, Psychological, Toxicity and Physical. In the main POPULATION PANEL dialogue 

box (as shown in Figure 4-46), only the Physical and Psychological attributes may be altered 

directly. The Travel Speeds and Toxicity attributes are modified in separate dialogue boxes 

(Figure 4-47 and Figure 4-48 respectively), and are accessed by clicking the TRAVEL SPEEDS 

and TOXICITY buttons.  The ADVANCED button allows access to the ADVANCED PANEL 

dialogue box (Figure 4-54), which allows the Target, Colour, Gene and Response Curve 

Distribution of the people drawn from the panel to be specified and access to the FAMILIARITY 

and ITINERARY dialogue boxes. 
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NOTE: 

Engineering occupant familiarity is only necessary if the Local Familiarity system is to be used. 

 

NOTE: 

Engineering the Itinerary dialogue box is only necessary if the performance of tasks is to be 

modelled. It should be borne in mind that evacuees that are attributed with an itinerary will not 

follow a pre-defined evacuation procedure. 

 

NOTE: 

If a Response Curve Distribution is selected for a given panel within its corresponding 

ADVANCED PANEL dialogue box then the Response Time attributes (i.e. the Min, Max and 

Default button, see Figure 4-46) present within the Psychological section will be disabled. In 

these instances, individuals generated from these panels will have their response times 

generated according to the selected response curve distribution as opposed to merely being 

generated according to a uniform random distribution between limits defined by the Min and 

Max attributes. 

 

TIP:  

By changing the colour of a sub-population it makes tracing the sub-population easier through 

a simulation. 

 

All the attributes may be modified by placing the cursor in the relevant box and typing 

appropriate new values. Most of the attributes have an upper and lower (Min and Max) value. 

When buildingEXODUS creates each occupant from the profile, the attributes assigned will 

take a random value between the limits described by the minimum and maximum values. 

 

 
Figure 4-46: Edit Panel dialogue box 

 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 220 

 

 

Figure 4-47: Travel speeds dialogue box Figure 4-48: Toxicity attributes dialogue 

box 

 

Also associated with each attribute category, is a range of default buttons. Each default button 

provides the default values for the attribute next to it as described in Table 4-6. Appendix B 

gives a comprehensive list of the occupant attributes and their default values. 

 

The other four areas highlighted on the POPULATION PANEL dialogue box are Panel name, 

Number Of People, Panel Control buttons, and Advanced Options.  

 

The panel name allows a 19-character description of the panel. The first eight characters of the 

panel name are used in the panel list and to save the panel to disk. The default name is PanelX, 

where X = the number of newly created panels -1. 
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Table 4-6: Evacuee profile attribute default values 
* refer to Table 2.7 

** refer to Table 2.9 

Category Attribute Unit 
Default Value 

Min Max 

Physical Mobility - 1.0 1.0 

  Age  years 20 60 

  Weight  kg 50 183 

  Gender - Male Male 

 Agility - 3 7 

 Height m 1.54 1.83  

 Leader - No No 

Psychological Response Time  S 0 30 

  Patience  S 1 5 

  
Drive: [female] 

 [male] 
- 1 

5 

10 

15 

Travel 

Speeds 

Fast Walk  
m/s 0.80 1.5 

  Walk  m/s 0.72 1.35 

  Crawl  m/s 0.16 0.30 

  Leap  m/s 0.64 1.20 

  Stair-Up  m/s * * 

  Stair-Down  m/s * * 

 Escalator-Up m/s * * 

 Escalator-Down m/s * * 

Toxicity PID  % 5 45 

  Fast Walk RMV  l/min ** ** 

  Walk RMV l/min ** ** 

  Rest RMV l/min ** ** 

Advanced Target Exit - Nearest Exit 

 Colour - Default 

 Gene - 0 0 

 Response Curve  Null 

 Familiarity - Nearest Exit 

 Itinerary - Null 

 

NOTE: 

Spaces should be avoided in Panel Names. 

 

The number of occupants reflects the current number of occupants in the (sub-) population to 

be generated from the current panel. This figure may not be altered in the Panel dialogue box. 

 

The panel control buttons allow the defined panel to be saved. To cancel any modifications, 

click the CANCEL button. 

 

Finally, the Advanced options allow the Colour of the occupants drawn from the panel to be 

specified, manipulation of their Target attribute, their Occupant Itinerary List (accessible 

through the ITINERARY button) and their Occupant Exit Knowledge (accessible through the 

FAMILIAR button). The ability to define the response curve distribution from which 
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individuals will have their response times generated is also provided. The default colour for a 

panel is “Default”, i.e. specify colour according to age.  The default value for the Target 

attribute is “Nearest Exit”, i.e. follow the potential map. The default value for the Occupant 

Itinerary List and the Occupant Exit Knowledge are null. 

 

TIP: 

To fix population attributes to a single value, set the minimum and maximum values to be the 

same. 

 

TIP: 

When using the Population Panels to populate an entire geometry it is vital that the user makes 

sure that no nodes have previously been selected. If a node has been selected, the model will 

report that there is not enough space to position the new population. 

 

From the Population Panel facility select the TOXICITY ATTRIBUTES button from the 

Population Panel dialogue box to display the Toxicity dialogue box (see Figure 4-49). This 

dialogue box enables to user to define the corresponding RMV (i.e. breathing rate, l/min) for 

each of the three main activity levels that agents can undertake (i.e. resting, walking and fast 

walking).  In addition the user can also define the distribution of PID% within the sub-

population.  By default the allocation of PID% follows the SFPE distribution [173], which 

randomly allocates agents within the sub-population PID values between 5% and 45%.  

However, it is also possible for users to either allocate all agents a fixed PID of 30% (i.e. all 

agents will all have identical PID values) or alternatively manually define their own PID 

distribution should they so wish.  Once a user defined PID distribution has been defined this 

can then automatically assigned to all the other current population panels within the overall 

population by simply clicking the Apply to All button.  This therefore removes the need for the 

user to have to manually define the same PID distribution for each sub-population, thereby 

saving time.  For more information on the default SFPE distribution used to define agent PID 

please refer to Chapter 6 of the Theory Manual. 

 

 
Figure 4-49: Toxicity dialogue box 

 

When generating evacuees, the denominators used in the functions determining the sensitivity 

to the irritant toxins to which the individual is exposed can also be defined.  To achieve this the 

user can click on the IRRITANTS button on this dialogue box to display the irritant attributes. 

This will give the user access to the distributions and ranges of values from which the 

individual’s FIC and FLD denominators will be generated. The user can switch between these 

values by clicking on the DOSE or the CONC button (see Figure 4-50 and Figure 4-51). It 
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should be noted that the units when dealing with the irritant dose (i.e. FLD) are in ppm.min, 

while when dealing with irritant concentration (i.e. FIC), the units are in ppm.   

 

When defining agent tolerance to both irritant concentration (i.e. FIC) and dose (FLD) users 

can select from a number of predefined distribution/range models, in addition to having the 

option of manually defining the distribution/range for each irritant.  By convention the 

denominators relating to agents tolerance to instantaneous irritant exposure (i.e. concentration) 

are referred to as Tolerance Factors (TF).  In contrast, the denominators relating to agents 

cumulative exposure to irritants (i.e. dose) are referred to as Critical Doses (CD).  In both cases, 

the user can select the tolerance factor/critical dose model to be applied to the agents via the list 

boxes at the top of the respective dialog boxes (i.e. Critical Dose (CD) Model and Tolerance 

Factor (TF) Concentration Model, see Figure 4-50 and Figure 4-51 respectively).   

 

In the case of irritant concentration, five model options are available. Three of these relate to 

applying fixed irritant tolerance factors to the entire population (thereby ensuring that each 

member of the population will have identical tolerance factors TF). These correspond to the 

SFPE Escape Impaired, SFPE Incapacitation and ISO 13571 Incapacitation data sets [173]. In 

contrast, one model option relates to randomly allocating the irritant tolerance factors according 

to assumed distributions (i.e. agents are NOT assigned identical tolerance factors, thereby 

reflecting the fact that individuals within a population may be more or less tolerant to the irritant 

gases).  When this option is selected irritant concentration tolerance factors are allocated to the 

population according to distributions, where the distribution for each irritant is based around 

the corresponding SFPE Escape Impaired values [173], with the lower and upper tolerance 

factor (TF) values following SFPE guidance.  Hence, the lower range of each distribution is 

therefore 0.3 times the mean value and the upper range is 2 times the mean value. The final 

option enables users to manually define the distribution of tolerance factors for each irritant.  

By default, agent tolerance factors (TF) for irritant concentration (FIC) are allocated according 

to the distribution based around the SFPE Escape Impaired data. 

 

In the case of irritant dose, three model options are available.  Two of these relate to applying 

fixed irritant critical doses to the entire population (thereby ensuring that each member of the 

population will have identical critical doses CD).  These correspond to the SFPE Critical Dose 

and AEGL-3 data sets [173].  In addition, the user once again has the option of manually 

defining the distribution of critical doses for each irritant.  By default, agent critical doses (CD) 

for irritant dose (FLD) are allocated according to the SFPE Critical Dose dataset. 

 

For more information on the default distributions used to define agent tolerance factors for both 

irritant dose and concentration please refer to Chapter 6 of the Theory Manual. 
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Figure 4-50: Description of the Irritant 

Dose data. 

Figure 4-51: Description of the Irritant 

Concentration data. 

 

4.4.2.1 Creating Occupant Itinerary Lists for Population Panels  

Shortcut: [Tools/Itinerary Window] 
Specifying Occupant Itinerary Lists for Population Panels is very similar to that described 

previously for individuals (see Section 4.3.2.1).  The primary difference is that for Population 

Panels the itinerary (i.e. list of tasks) must be created prior to their attachment to the Population 

Panel (whereas for the individual occupant the itinerary may be created specifically for the 

occupant or may have been defined as a separate entity). This is required, as several itineraries 

may be associated to a single panel. Each itinerary list has an associated probability determining 

which itinerary list will be associated with the individuals generated. This method also enables 

the itinerary lists to be re-used and hence associated with a number of different Population 

Panels. 

 

 
Figure 4-52: Selecting the Itinerary Window option from the Tools menu.  

 

The user must initially select the Itinerary Window option from the Tools menu (see Figure 

4-52). This brings up the Itinerary Selection dialogue box (see Figure 4-53(a)). If itineraries 

have already been created they will appear as buttons in the work area of the dialogue box.  An 

itinerary must be created (by clicking on the CREATE button) prior to editing (see Figure 

4-53(a)). The existing itineraries may be edited (EDIT button) or removed (REMOVE button) 

as described in Section 4.3.2.1. 
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(a) (b) 

Figure 4-53: (a) The Itinerary Window dialogue box, selected from the Tools 

menu.(b)The Edit Itinerary dialogue box .  

 

Double-clicking on an itinerary launches the EDIT ITINERARY dialogue box (see Figure 

4-53(b)), which operates in an identical fashion to the process described in Sections 4.3.2.1 and 

4.6.2.2. Therefore nodal locations can then be added as a task to an existing itinerary through 

either individually selecting nodes and Inserting (or Appending) them into the nodal list, or 

automatically inserting nodal selections, using the Auto Insert facility. 

 

Once the itineraries have been created they can then be associated with individual Population 

Panels or the Adv. Global Panel Options.  The Population Panel in question (e.g. “Males 17-

29”) is clicked to launch the POPULATION PANEL dialogue box (see Figure 4-46). The 

ADVANCED button is pressed to spawn the ADVANCED PANEL dialogue box, where the 

ITINERARY and  FAMILIAR buttons are accessible (see Figure 4-54).  

 

 
 Figure 4-54: Advanced Panel dialogue box  

 

The ITINERARY button then launches the ITINERARY EDITOR associated with the specific 

Population Panel. This is similar to the dialogue box described in Figure 4-53, except that in 

this case only existing itineraries can be added to the list. Numerous itineraries, each of which 

may consist of a number of nodal locations (implicitly representing separate tasks), can be 

included in this list. Each of these itineraries has an associated probability of being adopted. In 

this manner, a single Population Panel may have several potential itineraries from which the 

eventual itinerary of each constituent member will be selected. An occupant generated by the 

Population Panel will be assigned only one of these itineraries, although as highlighted 

previously, this may be built up from numerous nodal locations.  Thus, people generated from 

a single population panel will not necessarily all be assigned the same itineraries. 
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Figure 4-55: The Itinerary Selection dialogue box. Here two alternative tasks are 

associated to the specific Population Panel. Each of these has a 50% probability of being 

adopted. 

 

The probabilities associated with each of the itineraries can be provided by the user, or can be 

calculated by the model so that each of the itineraries has an equal likelihood of being adopted 

(using the NORM button). Irrespective of the method used, the model will not proceed until 

these probabilities add up to 1.0 (this can be set use the NORM button). The sum of all of the 

associated itinerary probabilities is displayed in the Tot. Prob. text box. 

 

NOTE: 

Unlike the specification of itineraries to occupants, it is not necessarily the case that the user 

has control over the exact nature of their performance given the introduction of associated 

probabilities. However, once an itinerary has been allocated, it will not change between 

simulations. 

 

NOTE: 

If the user wishes some members of a Population Panel to have the possibility of having no 

itinerary, they should create a ‘dummy’ itinerary, i.e. an itinerary that includes no nodal 

locations.  

 

4.4.2.2 Creating Occupant Exit Knowledge for Population Panels 

The OEK is created using the EXIT AWARENESS dialogue box. This is available via clicking 

the FAMILIAR button within the ADVANCED OPTIONS dialogue box (see Figure 4-54). As 

before (see Sections 4.3.2.3 and 4.6.2.3) exits can be added to the occupant familiarity through 

highlighting specific exits and then clicking on the ADD button (see Figure 4-56). Exits can be 

removed from the occupant’s familiarity in a similar process, except this time identifying the 

specific known exit and then clicking the REMOVE button. To reduce the user workload in 

creating occupant familiarity, complete exit lists can be added or removed using the ADD ALL 

and the REMOVE ALL buttons respectively. 

 

 
Figure 4-56: Addition of exits to the Population Panel Exit list, with 

associated probabilities. 
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Exits attributed in this fashion are not necessarily guaranteed to appear in the eventual occupant 

exit list. The user provides a probability (ranging from 0-1.0) that is associated with each exit, 

describing the possibility that members of the Population Panel will be familiar with a 

particular exit (this is achieved by double-clicking the probability in question). The user can 

then control the distribution of exits with which occupants generated via the Population Panel 

will be familiar. The user can guarantee the awareness of specific exits, by providing a 

probability of 1.0. The creation of the exit list at this stage will supersede any subsequent 

methods to generate occupant exit lists (i.e. those that are dependent upon automatic processes). 

Once created the occupant exit lists will not alter between simulation runs. 

 

NOTE: 

It should be remembered that once created, the Occupant Itinerary List and the Occupant Exit 

Knowledge (if defined manually for the entire population) remain constant between 

simulations. 

 

NOTE:  

Methods to describe exit awareness are available that allow occupant exit knowledge to 

fluctuate between simulations. These are described in Chapter 5. 

 

NOTE: 

It should be noted that the impact of both the Occupant Itinerary List and the Occupant Exit 

Knowledge will be dependent upon the procedure selected in Simulation mode (see Chapter 6). 

 

4.4.3 Panel Populations  

Shortcut: [Tools/Panel Populations] 
This feature is accessed from the Population menu bar under Tools -> Panel Populations or by 

clicking a previously generated population panel associated with the source node from the 

Source Node Control Dialogue box (an option only available in Scenario mode). Once selected, 

the Population Selection dialogue box is produced (see Figure 4-57). This feature allows the 

user to specify the populations to be used in association with the Source nodes (see Chapter 3 

and 5).  

 

 
Figure 4-57: Population Selection dialogue box 

 

The Create button generates a new population and the Remove button deletes the selected 

population. If the user selects Edit or clicks on a selected population the population panel for 

that population is displayed. 

 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 228 

The Title edit box (top right of dialogue box) allows the user to change the title of the currently 

selected population (see Figure 4-58(a)). Each of the buttons performs an action on the 

populations, according to Table 4-7. 

 

Table 4-7: Control buttons for the Population Selection dialogue box 

Button Name Explanation 

CREATE Creates a new population 

EDIT Edit the currently selected population 

REMOVE Removes selected population from population list 

CLEAR Removes all populations from population list 

GEN. POP 
Generates the number of people assigned within the Pop Size attribute according to the 

currently selected population. 

ASSIGN 
Assigns the currently selected population panel attributes to all selected individuals. 

Note if this function is used then the Pop Size attribute is not considered. 

OK Closes the Population Selection dialogue box 

 

If the user clicks Edit or double clicks on a given population the population panels for that 

population is displayed (see Figure 4-58(b)). 

 

 

 

 

 

 
(a) (b) 

Figure 4-58: (a) A new Panel Population generated (i.e. Pop_1) (b) This is formed from 

several constituent panels 

 

All of the functionality available when creating and manipulating the group and population 

panels (see Sections 4.4.1 and 4.4.2) is also available when utilising panel populations. This 

functionality therefore enables the user to create numerous populations (each of which can be 

constructed from numerous panels) for use with Source Nodes. This is particularly useful when 

modelling situations where distinct populations appear and certain periods of time and have 

specific tasks associated with them. An example of this would be within a transport terminal. 
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NOTE: 

A Source Node can be associated with a specific population, as mentioned above. This 

population should include at least one population panel describing the characteristics of the 

people that will be generated by the source node at run time. When creating the population 

panels the user should specify the percentage of the people that will be generated according to 

each population panel. If the user fails to specify a percentage for a particular population panel 

then EXODUS will generate random people instead of the people described in that population 

panel. If a percentage less than 100 is provided (e.g. either a single panel is associated with a 

percentage of less than 100, or several panels are provided which in total do not add up to 100) 

then the remaining percentage of the population is randomly generated. 

 

NOTE: 

As with other EXODUS applications, the user is able to build up more complex population sub-

categories through using the Population Panel facility. This can be achieved through first 

generating the appropriate population built up of standard population panels, saving the 

population using the ‘Save Pop.’ button on the Pop Setup dialogue box and then creating a 

newly associated Panel Population to the Source Node. The newly created empty population 

can then have the previously created population entered into it, by double-clicking on the panel, 

clicking on ‘Load Pop. button on the Pop Setup dialogue box and then selecting the previously 

saved population. 

 

4.5 Importing and Exporting Populations 

The Population Panel allows the user to create general populations. buildingEXODUS offers 

another method for storing population libraries that is geometry specific. Each population that 

is built for a geometry may be EXPORTED for later use. To use such a population, it must be 

IMPORTED.  This allows a large number of specific populations to be built for a geometry 

without having to specify profiles and locations each time they are generated. 

 

4.5.1 Exporting a geometry specific population 

Shortcut: [Tools/Populations/Export] 
To export a population that is specific to a geometry, select Tools from the menu bar, the 

Populations sub-menu and the Export item from the pull down menu (see Figure 4-2). 

buildingEXODUS will automatically assign a name to the exported population according to the 

following key : 

 
  abcdefXYsiz.epf 

 

where   abcdef = the first 6 characters of the geometry name 

  XYZ = the version of population (AAA, AAB, AAC etc. - ZZZ) 

 siz = size of population (for populations > 999, population size is rounded to 

nearest  1000 and represented as 1k, 2k, 3k etc) 

 

For example, the population file for a model of an enclosure that includes 250 occupants named 

TestCase.MTA will be saved using a similar name to TestcaAAA250.epf. Subsequent 

population files will be TestcaAAB250.epf, TestcaAAC250.epf etc. 
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4.5.2 Importing a geometry specific population 

Shortcut: [Tools/Populations/Import] 
To import a geometry specific population, select Tools from the menu bar, the Populations sub-

menu and the Import item from the pull down menu (see Figure 4-2). buildingEXODUS will 

provide a list of populations applicable for the current geometry. 

 

NOTE:  

Exported populations are specific to a geometry. Do NOT attempt to import populations that 

are specific to geometries other than the current one - the results may be unpredictable as 

occupants will be assigned to locations that may not exist. 

 

4.6 Modifying Attributes for Existing Occupants 

Rather than specifying an entire new population, on occasions, it may be easier to modify the 

attributes for an existing population. There are two cases to consider: single occupant 

modification (see Section 4.6.2) and multiple occupant modification (see Section 4.6.3). 

However, before an individual or group of people can be modified they must first be selected 

(see Section 4.6.1). 

 

4.6.1 Selecting Occupants 

Shortcut: [Edit/Select/People]  
To select occupants for modification, select Edit from the menu bar, Select from the menu and 

the People Select item from the pull down menu (see Figure 4-2). Alternatively, press the 

PEOPLE SELECT button on the toolbar (see Table 4-1). To select individual occupants, simply 

click on the required occupant. To select multiple occupants, a rectangular rubber-band must 

be drawn, by clicking and then dragging. All people inside the rubber-band become selected. 

 

If a group of occupants that do not fall into a regular area are to be selected then the user should 

first select Edit from the menu bar, the Select sub-menu and then the Polygon Select item from 

the pull down menu. Next, the user should click on the screen and drag out the polygon 

surrounding the occupants that require editing. Once the task of editing/altering the occupants 

has been completed, the Polygon Select tool should be deselected (by clicking on the People 

Select option).  

 

In addition to simply enabling users to select individuals based on their physical location within 

the structure, buildingEXODUS also provides the ability to locate individuals based on their 

given attributes. Two different methods of locating people based on their individual attributes 

are provided, namely Attribute Select (see Section 4.6.1.1) and Range Select (see Section 

4.6.1.2). Attribute Select enables individuals with specific attribute values to be located. In 

contrast, Range Select enables individuals with attribute values within a specific user-defined 

range to be located. 

 

4.6.1.1 Selecting Individuals with Specific Attributes 

Shortcut: [Edit/Select/Attribute Select] 
To select individuals with specific attribute values select Edit from the menu bar, Select from 

the menu and the Attribute Select item from the pull down menu (see Figure 4-2). Once the 

Attribute Select option has been selected the user is presented with the Person Search dialogue 

box (see Figure 4-59). This dialogue box resembles the existing Person dialogue box, with the 

exception that by default each attribute value is set to NULL. The Person Search dialogue box 
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enables the user to define the combination of specific attribute values that are required to be 

located within the overall population, and hence define the search criteria used in locating the 

people. The attributes can be defined by the user by either typing specific values (as in the case 

of the Name, Label, Age, Height and Weight attributes), clicking the corresponding check box 

(as in the case of the Has Tasks attribute) or alternatively by selecting from the corresponding 

list of options provided (as in the case of the Gender, Target, Colour and Type attributes). 

Attributes can also be left as NULL thereby indicating that the user has no desire to search 

according to the values of those attributes.  

 

 
Figure 4-59: The Person Search dialogue box. 

 

Having defined one or more of the attribute values required to be located within the overall 

population the user can then commence the search by clicking the OK button. Once initiated 

the function will then search every person within the entire geometry to identify (and hence 

locate) those people whose attributes match ALL of those specified by the user. If for example 

the user wanted to identify all males aged 45, then within the Person Search dialogue box they 

would define the Gender attribute as male and the Age attribute as being 45 while leaving all 

other attributes as undefined (i.e. NULL). Once identified each person whose attributes match 

the specified criteria are then highlighted, with a black square appearing around their 

corresponding node (irrespective of whether the nodes are displayed on the screen or whether 

the model is in Boundary mode). 

 

The various buttons which normally enable the user to access the dialogue boxes containing 

additional person attributes (i.e. the O.I.L, Fam, Attrib, Path and Gases buttons) have been 

disabled within the Person Search dialogue box to restrict the search facility to only the most 

basic of person attributes. 

 

NOTE:  

Using the Attribute Select function to search for individuals based purely on their LABEL 

attribute effectively performs the same function as the Find Person utility (see Chapter 3). 
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4.6.1.2 Selecting Individuals With Attributes Within a User-Defined Range 

Shortcut: [Edit/Select/Range Select] 
To select individuals with attribute values within specified user-defined ranges select Edit from 

the menu bar, Select from the menu and the Range Select item from the pull down menu (see 

Figure 4-2). Once the Range Select option has been selected the user is presented with the 

Person Range Search dialogue box (see Figure 4-60). The Person Range Search dialogue box 

enables the user to define the combination of ranges within which individuals specific attribute 

values are required to fall, and hence define the search criteria used in locating the people. Each 

attribute range can be specified by the user by defining both the corresponding minimum and 

maximum attribute values. Attribute ranges can also be left as NULL thereby indicating that 

the user has no desire to search according to the values of those attributes.  

 

 
Figure 4-60: The Person Range Search dialogue box. 

 

Having fully defined one or more of the range of attributes required to be located within the 

overall population the user can then commence the search by clicking the OK button. Once 

initiated the function will then search every person within the entire geometry to identify (and 

hence locate) those people whose attributes fall within ALL of the ranges specified by the user. 

If for example the user wanted to identify all 20-30 year olds with response times between 30 

and 60 seconds, then within the Person Range Search dialogue box they would define the Age 

attribute as having a minimum value of 20 and a maximum value of 30 and the Response 

attribute as having minimum value of 30 and a maximum value of 60 while leaving all other 

attribute ranges as undefined (i.e. NULL). Once identified each person whose attributes match 

the specified criteria are then highlighted, with a black square appearing around their 

corresponding node (irrespective of whether the nodes are displayed on the screen or whether 

the model is in Boundary mode). Defining an invalid range for any given attribute (i.e. defining 

the Min value as being greater than the Max value etc.) will result in no search being performed 

on that attribute. Each invalid range will automatically be ignored and hence the search will be 

conducted in the same manner as if the Min and Max values for that attribute had remained 

undefined (i.e. NULL).  

 

4.6.2 Single Occupant Modification 

To modify the attributes of a single occupant, double click on the occupant using either the right 

or left mouse button. This will present a dialogue box for an occupant that may be modified in 

exactly the same manner as the default person dialogue box (see Section 4.3.1). The majority 

of the details that are available for editing are relatively simplistic or self-explanatory, involving 

either the provision of simple data or the selection of an option from a list. Due to the more 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 233 

complex nature of the definition of the Occupant Itinerary list and Occupant Exit Knowledge, 

additional details are provided in Sections 4.6.2.2 and 4.6.2.3.  

 

4.6.2.1 Locating an Occupant 

Shortcut: [View/Find/Person] 
If the user wishes to locate an occupant within a geometry in order to edit them then they should 

either select View from the menu bar, the Find sub-menu and then the Person item from the 

pull down menu or simply click the Find Person  button on the Population toolbar.  This 

will enable the Enter Person ID dialogue box. The user should then supply the Label attribute 

of the occupant that is being sought. Once provided the view will alter and the occupant will be 

highlighted (see Chapter 3 for further details).  

 

4.6.2.2 Editing an Itinerary for an Individual Occupant 

To define or edit the O.I.L. for an individual occupant, double click on the evacuee to reveal 

the PERSON dialogue box.  By clicking on the O.I.L. button (after the Has Tasks box has been 

checked) the EDIT ITINERARY dialogue box is displayed.  It is now possible to construct an 

itinerary list that will be used by the identified occupant.  Proceed in the same manner as 

described in Section 4.3.2.1. 

 

4.6.2.3 Editing Exit Awareness for an Individual Occupant 

To define or edit the exit awareness for an individual occupant, double click on the occupant to 

reveal the PERSON dialogue box.  By clicking on the FAM button the EXIT AWARENESS 

dialogue box is displayed.  It is now possible to construct O.E.K. that will be used by the 

identified occupant.  Proceed in the same manner as described in Section 4.3.2.3. 

 

4.6.2.4 Relocating an occupant 

In some circumstances the user may wish to relocate specific occupants in a controlled manner. 

Therefore, the user may wish to change an occupant’s location but remain in control over the 

occupant’s future location. 

 

 
Figure 4-61: Initially (right) occupant is selected. Occupant is in transit between nodal 

locations (centre). Occupant is deposited in new location (left). 

 

This can be achieved by first clicking on the SELECT PERSON button  on the toolbar. 

Once this has been completed the user should click and hold down the left mouse button on the 

desired occupant.  This occupant should then ‘stick’ to the cursor allowing the user to move the 

occupant throughout the geometry.  During the relocation process, the occupant will appear as 

a black circle (see Figure 4-61). Once the relocation node has been found, the user should 

position the black circle over the centre of the node and release the mouse button. The occupant 

will then appear at the new location and will have been deleted from the previous position.   
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NOTE: 

When moving an occupant to a new location, ensure that the pointer is located over a nodal 

location, otherwise the process will be cancelled and the occupant will appear in their original 

location. 

 

4.6.3 Multiple Occupant Modification 

There are two different methods of modifying the attributes for a group of selected occupants, 

Attribute Substitution (see Section 4.6.3.1) and Range Substitution (see Section 4.4.2.2).  

Attribute Substitution enables each attribute of a group of selected occupants to be set to a single 

value.  In contrast Range Substitution enables each occupant’s attribute to be assigned randomly 

within a user defined range. 

 

4.6.3.1 Attribute Substitution 

Shortcut: [Edit/Substitute/People] 
To modify the attributes for a group of selected occupants to a single value, select Edit from 

the menu bar and the Substitute item from the pull down menu. The user should then select the 

People option from the Substitute sub-menu.  This will present a dialogue box in exactly the 

same form as when changing the default person.  In this case however, only attributes showing 

NULL may be modified by the user.  Any modifications made in this manner will apply to ALL 

the selected occupants.  For example, if all of the people are selected in the geometry, the 

Response Time attribute may be substituted for 0.0.  This would result in all occupant’s 

Response Time attribute being set to 0.0 and hence in all the people responding instantly within 

the simulation. 

 

NOTE: 

Population attributes modified through group selection (i.e. using the rubber-band method to 

select a group) may only be given single values, NOT a range to be assigned randomly. Users 

wishing to modify population attributes by means of a range should use Range Substitution (see 

Section 4.6.3.2) 

 

4.6.3.2 Range Substitution 

Shortcut: [Edit/Substitute/Range] 
To modify the attributes for a group of selected people to a random value within a user-defined 

range, select Edit from the menu bar and the Substitute item from the pull down menu.  The 

user should then select the Range option from the Substitute sub-menu.  This will present the 

first of three Person Range Update dialogue boxes (see Figure 4-62 (a)). Two further boxes can 

be obtained by selecting either ‘Attributes’, ‘Movement’, or ‘Gases’ within the dialogue box. 

Each of the people’s attributes that are permitted to be modified are displayed along with their 

corresponding upper and lower (Min and Max) value.   By default each Min and Max value is 

set to NULL.  When buildingEXODUS modifies an attribute for each selected occupant, the 

assigned attribute will take a random value between the limits described by the minimum and 

maximum values. Any modifications made in this manner will apply to ALL of the selected 

people.  For example, if all the people are selected in the geometry, the Response Time attribute 

may be defined within a minimum of 60 seconds and a maximum of 120 seconds.  This would 

result in each evacuee being randomly assigned a new Response Time between 60 and 120 

seconds.  Defining invalid Min and Max values for an attribute (i.e. Min being greater than Max 

etc.) will result in no updates in that attribute occurring.  
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NOTE: 

By setting the minimum and maximum values to the same value it is possible to use the Range 

Substitution to set the value of a particular attribute to a single defined value.  This is NOT 

advised.  Users wishing to set an attribute of a group of selected occupants to a single value 

are advised to use the Attribute Substitution method defined earlier (see Section 4.6.3.1). 

 

   

(a) (b) (c) 

Figure 4-62: Person Range Update dialogue box 

 

4.6.3.3 Randomising Person Locations 

Shortcut: [Edit/Relocate/Randomise] 
A factor that may affect an evacuation simulation significantly is the starting location of the 

individuals.  To cope with this factor buildingEXODUS offers a simple method to randomise 

the starting locations of the individuals, either across the whole geometry, or by selecting groups 

of individuals.  To randomise the starting location of ALL individuals in a geometry, ensure 

that no areas/people are selected and then select Edit from the menu bar, the Relocate item from 

the pull-down menu and then select the Randomise option from within the Relocate submenu 

(see Figure 4-2).  Figure  4-63(a) and (b) demonstrate an example of this function being used.   

 

To Randomise the starting locations for a group of evacuees, first select the group that is to be 

randomised, by dragging a box around the evacuees (see Figure  4-63(c)).  Now repeat the 

randomisation function as described above.  The selected evacuees will now randomise their 

starting locations INSIDE the selected area. Figure  4-63 (a) and (c) show an example of this 

function being used in this manner, note that in (c) the eight evacuees on the right hand side 

have maintained their original locations. 
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(a) (b) 

 
(c) 

Figure  4-63: Example of randomisation function. In (a) the original location of the 

individuals are displayed. In (b) the location of all of the individuals in (a) have been 

randomised. In (c) only a selected group of the individuals in (a) has been randomised. 

 

4.6.3.4 Randomising the Locations of Seated People 

Shortcut: [Edit/Relocate/Randomise On Seats] 
In many instances involving the modelling of large numbers of seated people (i.e. restaurants, 

cinemas, concert halls etc.) users may wish to observe the effect of changing the starting 

locations of those seated individuals, while simultaneously maintaining the starting locations 

of all other individuals within the geometry. To assist users in accomplishing this task 

buildingEXODUS has therefore, in addition to the general randomisation function detailed 

previously (see Section 4.6.3.3), also provided a more specialised randomisation function 

designed to affect only people in seats. As with the general randomisation function detailed 

previously, this function offers a simple method to randomise the starting locations of seated 

individuals, either across the whole geometry, or by selecting groups of individuals. 

 

To randomise the starting locations of ALL seated individuals in a geometry, ensure that no 

areas/people are selected and then select Edit from the menu bar, the Relocate item from the 

pull-down menu and then select the Randomise on Seats option from within the Relocate 

submenu (see Figure 4-2). Figure 4-64 (a) and (b) demonstrate an example of this function 

being used. Here it can be seen that even though the operation was performed on the entire 

geometry only the starting locations of the five individuals originally situated within seats have 

been randomised. In each case the seated individuals have been randomly relocated to other 
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seats within the geometry, while in contrast the four standing individuals on the right hand side 

(i.e. those not situated within seats) have maintained their original locations. 

 

To Randomise the starting locations for a GROUP of seated individuals, first select the group 

that is to be randomised by dragging a box around the evacuees (see Figure 4-64 (c)). Now 

repeat the randomisation function as described above. The selected seated individuals will now 

randomise their starting locations to alternative seats INSIDE the selected area. Figure 4-64 (a) 

and (c) show an example of this function being used. Here it can be seen that even though the 

operation was performed on a selected region containing five individuals, only the starting 

locations of the three seated individuals within the selected region have been randomised. In 

each case the seated individuals have been randomly relocated to other seats within the selected 

region, while in contrast the two standing individuals also within the selected region have 

maintained their original locations. 

 

  

(a) (b) 

 
(c) 

Figure 4-64:  Example of Randomise on Seats function. In (a) the original location of 

the individuals are displayed. In (b) the location of all of the seated individuals in (a) 

have been randomised. In (c) only a selected group of the seated individuals in (a) has 

been randomised. 

 

4.6.3.5 Swapping Occupant Locations 

Shortcut: [Edit/Relocate/Swap Locations] 
In certain circumstances the starting locations of people within the geometry may be well 

defined.  For instance users modelling the evacuation from a hotel at night would typically 

know how many people were within each room.  However since the attributes of each occupant 

are different, situating different people in different rooms may significantly affect the results of 

the evacuation simulation.  Situating a disabled/immobile occupant in a room a long distance 
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from an exit and an able bodied occupant in a room close to an exit will produce drastically 

different results than vice versa.  To cope with this buildingEXODUS offers a simple method 

to randomly swap the starting locations of occupants, either across the whole geometry, or by 

selecting groups of people.  To randomly swap the starting locations of ALL the occupants in 

a geometry, ensure that no objects are selected and then select Edit from the menu bar and the 

Relocate item  from the pull-down menu. The user should then select the Swap Locations option 

from the Relocate sub-menu (see Figure 4-2).  At first glance it may appear that nothing has 

happened, since the starting locations remain fixed and the people merely swap between them. 

 

To Swap Locations for a group of people, first select the group that are to swap places, by 

dragging a box around the occupants (see Figure 4-65a).  Now repeat the Swap Locations 

function as described above.  The selected people will now randomly swap places.  Figure 4-65 

(a) and (b) show an example of this function being used, note that in (b) the four selected people 

on the left of the screen have randomly swapped places, while the three unselected people on 

the right of the screen have maintained their original locations. 

 

 
Figure 4-65: Example of the Swap Locations function. In (a) the original locations of the 

occupants are displayed. In (b) the occupants within the original region have swapped 

places. 

 

The functionality of this feature is identical to that available in Simulation mode (see Chapter 

6). 

 

4.6.3.6 Swapping the Locations of Seated People 

Shortcut: [Edit/Relocate/Swap Locations On Seats] 
In addition to the general Swap Locations function detailed in Section 4.6.3.5 

buildingEXODUS also provides a more specialised Swap Locations function designed to affect 

only people in seats.  As with the general Swap Locations function detailed previously, this 

function offers a simple method of swapping the locations of seated individuals, either across 

the whole geometry, or by selecting groups of individuals. 

 

To randomly swap the starting locations of ALL seated individuals within a geometry, ensure 

that no areas/people are selected and then select Edit from the menu bar, the Relocate item from 
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the pull-down menu and then select the Swap Locations on Seats option from within the 

Relocate sub-menu (see Figure 4-2). Having selected this function it may at first glance appear 

that nothing has happened, since the starting locations remain fixed and the people merely swap 

between them. Figure 4-66(a) and (b) demonstrate an example of this function being used. Here 

it can be seen that even though the operation was performed on the entire geometry only the 

five individuals situated within the seats have swapped places. In each case the seated 

individuals have randomly swapped places with other seated people within the geometry, while 

in contrast the four standing individuals on the right hand side (i.e. those not situated within the 

seats) have maintained their original locations. 

 

To Swap Locations for a group of seated people, first select the group that are required to swap 

places by dragging a box around the individuals in question (see Figure 4-66(c)). Now repeat 

the Swap Locations on Seats function described above. The selected seated individuals will 

now randomly swap places. Figure 4-66(a) and (c) demonstrate an example of this function 

being used. Here it can be seen that even though the operation was performed on a selected 

region containing five individuals, only the three seated individuals within the selected region 

have swapped places. In each case the seated individuals have swapped places with other seated 

individuals within the selected region, while in contrast the two standing individuals also within 

the selected region have maintained their original locations. 
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Figure 4-66:  Example of the Swap Locations on Seats function. In (a) the original 

location of the individuals are displayed. In (b) the location of all of the seated 

individuals in (a) have been swapped. In (c) only a selected group of the seated 

individuals in (a) has been swapped. 

 

4.6.4 Distribution Curves 

Shortcut: [Tools/Distribution Curves] 
The Distribution Curves function allows the user to assign either the entire population, or 

selected individuals, with a range of response times based on a user-defined distribution. This 

enables users to either define a response time distribution manually or alternatively select a 

distribution from a variety of predefined types. In total, four different types of distribution have 

been provided, namely the uniform distribution, the normal distribution, a distribution defined 

by a polynomial equation and finally the log-normal distribution.  

 

Defining distribution curves within buildingEXODUS is achieved via the Distribution Curve 

Editor dialogue box (see Figure 4-67). This is displayed by selecting the Distribution Curves 

option from the Tools menu in Population mode (see Figure 4-2). The Distribution Curve 

Editor comprises three main areas, namely the List of Curves, the Control buttons and the Sel. 

Title text box.  
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(a) (b) 

Figure 4-67: The Distribution Curve Editor. 

 

The List of Curves displays all of the curves previously defined by the user. Individual curves 

can be selected by clicking on their corresponding button within the List of Curves. When 

selected a pair of inverted commas “” will appear around the distribution curve name, for 

example “Dist_1” in Figure 4-67(b). Once selected, the Sel. Title text box will automatically 

change to the name of the selected distribution curve, thereby enabling the user to modify its 

name. The Distribution Curve Editor also has a number of buttons which allow the user to 

create, delete and edit the distribution curves, in addition to defining which sections of the 

population they should be applied to. The following list outlines the functionality of each of the 

controls present within the Distribution Curve Editor shown in Figure 4-67. 

 

Button Description 

Create Creates a new distribution curve. 

Edit Edits the currently selected distribution curve. 

Remove Deletes the currently selected distribution curve. 

Clear Deletes all distribution curves. 

Export Curve Saves the currently selected distribution curve as an editable text file 

(.DAT). 

Import Curve Loads a previously defined distribution curve (.DAT). 

All People Applies the selected distribution curve to the entire population. 

Sel. People Applies the selected distribution curve to only the currently selected 

population. 

OK Exits the Distribution Curve Editor. 

 

Clicking the Edit button within the Distribution Curve Editor results in the Distribution Editor 

dialogue box being displayed, enabling the user to define the time distribution for the currently 

selected distribution curve (see Figure 4-68(a)). For example, Response Time distributions can 

be defined manually by defining a series response time ranges/intervals and associated 

probabilities, where each probability represents the likelihood of an individual having a 

response time within the corresponding range. To assist the user in defining distributions, a 

Graph is provided as a quick indication of the shape or format of the distribution data entered 

(see Figure 4-68(b)). This graph is not intended to be used for evaluating the distribution curve 

but exists merely as an aid for entering the data. Errors or omissions in the distribution data will 

show up as spikes or gaps within the distribution curve, thereby alerting the user to potential 

problems within their overall distribution. 
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(a) (b) 

Figure 4-68: The Response Distribution Editor dialogue box with a) no response curve 

distribution defined, and b) with a simple response curve distribution defined. 

 

The Distribution Editor dialogue box also has a number of buttons which allow the user to 

generate and manipulate the corresponding distribution data (i.e. the time ranges/intervals and 

associated probabilities). The following list outlines the functionality of each of the controls 

present within the Distribution Editor shown in Figure 4-68. 

 

Button Description 

Append Appends a new data entry to the end of the distribution curve. 

Insert Inserts a new data entry above the currently selected data entry in the distribution 

curve. 

Up Moves the currently selected data entry up one location in the distribution curve data 

set. 

Down Moves the currently selected data entry down one location in the distribution curve 

data set. 

Remove Deletes the currently selected data entry in the distribution curve data set. 

Clear Clears all the data entries from the distribution curve data set. 

Norm. Redistributes the probability values of the data entries so they total one. 

Default Resets the distribution curve to the default distribution. 

OK Exits the Distribution Editor. 

 

In addition to permitting the user to manually define the response distribution curve the 

Distribution Editor also permits the user to allocate distributions of specific pre-defined types. 

In total four different types of distribution have been provided, namely the uniform distribution 

(see Figure 4-69(a)), the normal distribution (see Figure 4-69(b)), a distribution defined by a 

polynomial equation (see Figure 4-69(c)) and finally the log-normal distribution (see Figure 

4-69(d)). 
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(a) (b) 

  

(c) (d) 

Figure 4-69: The Response Distribution Editor dialogue boxes of a) the uniform 

distribution, b) the normal distribution, c) the polynomial distribution and d) the log-

normal distribution.  

 

The user can specify the required distribution via the Distribution list box located at the top of 

the screen. Selecting any of the alternative pre-defined distributions results in the format of the 

Response Distribution Editor changing, with the user-defined response time ranges/intervals 

and associated probabilities being removed and instead replaced with a variety of text boxes 

through which the various distribution attributes can be defined. These attributes include a 

method of defining both the minimum and maximum limits between which a response time is 

to be selected, the mean and standard deviation of the respective distribution, and the 

coefficients for each of the terms within the polynomial equation (i.e. C0, C1, C2, C3, C4 and 

C5).  

 

The ability to define the minimum and maximum limits between which response times are 

selected enables the user to control which section of any given distribution is to be used for the 

generation of response times, and hence provides the ability to truncate distributions. All 

distributions truncated in this manner are automatically normalised prior to the generation of 

response times. In each case, the distribution is scaled to ensure that the area under the curve 

within the specified region is equal to one, thereby ensuring that only the response times within 

the user defined range can be generated. 
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Figure 4-70(a) below shows a typical normal distribution with a mean and standard deviation 

of 50.0 and 15.0 respectively, between the minimum and maximum response time limits of 0 

and 100. Figure 4-70(b) in contrast shows the same distribution outlined in Figure 4-70(a) 

between the minimum and maximum response time limits of 30 and 70. It can clearly be seen, 

that in this case large sections of distribution have been truncated as a result of the defined 

minimum and maximum response time limits. It is worth noting that although the shape of the 

overall distribution appears to have changed as a result of the truncation, in reality this is not 

the case. Any apparent changes in the shape of the distribution after truncation are instead 

merely graphical distortions resulting from the distribution being stretched to fit the Graph 

window. 

 

  

(a) (b) 

Figure 4-70: The Response Distribution Editor dialogue boxes of a normal distribution 

between the minimum and maximum limits of a) 0 and 100, and b) 30 and 70. 

 

An Offset attribute enabling the log-normal distribution to be shifted along the x-axis is also 

provided within the Distribution Editor. Shifting a given log-normal distribution along the x-

axis via the Offset attribute allows the user to increase the response times generated by the 

distribution, while simultaneously maintaining the overall shape (and hence mean and standard 

deviation) of the defined response time distribution. Although users are not required to modify 

either the mean or standard deviation of a log-normal distribution when imposing an offset, 

they may however be required to modify both the minimum and maximum response time limits 

(see above). Shifting a log-normal distribution in the manner outlined may in many cases result 

in a significant section of the distribution being shifted beyond the maximum response time 

limit defined by the user, and hence result in a significant truncation of the overall response 

time distribution. In these circumstances, the user may therefore be required to modify both the 

minimum and maximum limits accordingly, in order to ensure that the response time region 

defined by the user covers the section of the distribution required to generate the desired results. 

 

Figure 4-71(a) below shows a typical log-normal distribution with a mean and standard 

deviation of 3.4 and 0.5 respectively, between the minimum and maximum response time limits 

of 0 and 100. No offset has been defined (i.e. Offset=0.0), and hence no x-axis shift has been 

imposed upon the distribution. Figure 4-71(b) in contrast shows the same distribution outlined 

in Figure 4-71(a), with the exception that the distribution has been shifted along the x-axis via 

the definition of an offset (i.e. Offset=40.0). It can clearly be seen that shifting the log-normal 

distribution along the x-axis via the definition of an offset has not affected the overall shape of 

the response time distribution, or its corresponding mean and standard deviation. The shifting 
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of the distribution has however resulted in a section of the distribution falling outside the 

minimum and maximum response time limits set by the user, and hence in the partial truncation 

of the distribution. As stated previously, when shifting distributions users may be required to 

modify the minimum and maximum response time limits accordingly. By default the Offset 

attribute is equal to zero (i.e. no x-axis shift is imposed). 

 

  

(a) (b) 

Figure 4-71: The Response Distribution Editor dialogue boxes of a log-normal 

distribution with a) no Offset defined (i.e. Offset=0) and b) an Offset defined (i.e. 

Offset=40).  

 

In addition to the attributes outlined an Interval attribute and a Convert to Int. button are also 

provided. To enable users the complete flexibility to both define and edit response distributions 

a facility has been provided to convert any distribution into a series of response time 

ranges/intervals, each with an associated probability, which can then be manipulated by the 

user. Converting any given distribution to a series of response time ranges/intervals and 

probabilities can be easily achieved by clicking the Convert to Int. button. Clicking this button 

will result in the distribution type automatically returning to User Def. mode and a series of 

response time ranges (each equivalent in size to the value of the Interval attribute) being created 

which accurately define the given distribution (see Figure 4-72). It is important to note that the 

Interval attribute is only used for defining the size of the ranges/intervals when converting 

distributions to range data in the manner defined above. Hence the value of the Interval attribute 

has no effect on the response times generated directly from a given distribution. 

 

 
Figure 4-72: A normal distribution converted into interval data (with an interval of 0.1). 
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When selecting a distribution of a given type only the attributes directly applicable to that 

distribution (or its conversion to range data in the case of the Interval attribute) are enabled. 

Hence, both the mean and standard deviation are disabled when either a uniform or polynomial 

distribution are specified by the user, and the six polynomial coefficients (C0, C1, C2, C3, C4 

and C5) are only enabled only when a polynomial distribution has been selected. Similarly, the 

Offset attribute is also only enabled when a log-normal distribution has been selected by the 

user. The buttons used to manipulate the response time ranges/intervals and associated 

probabilities are also disabled when selecting a predefined distribution type. 

 

NOTE: 

In the case of the log-normal distribution both the mean and standard deviation refer to the 

mean and standard deviation of Ln(x) and not of x itself.  

 

4.7 Deleting Occupants 

There are three methods to delete occupants from the geometry: 

 

(1) Deleting Individual Occupants (see Section 4.7.1) 

(2) Deleting Multiple Occupants (see Section 4.7.2) 

(3) Deleting All Occupants (see Section 4.7.3) 

 

4.7.1 Deleting Occupants 

To delete an individual occupant, first double-click the occupant to produce the Person dialogue 

box. To complete the operation, click the DELETE button on the dialogue box (see Figure 

4-73(a)). 

 

 

 

(a) (b) 

Figure 4-73: (a) Deleting an individual. (b) Deleting a selected population. 

 

4.7.2 Deleting Multiple Occupants 

Shortcut: [Edit/Delete/People] 
To delete multiple occupants from a geometry the occupants to be deleted must first be selected 

(see Section 4.6.1). To complete the operation, select Edit from the menu bar, the Delete sub-

menu and the People item from the pull down menu (see Figure 4-73(b)). 

 



Chapter 4 - Defining A Population 

© 2017 University of Greenwich 247 

4.7.3 Deleting All The Occupants 

Shortcut: [Edit/Delete/Everyone] 
To delete all of the occupants from a geometry select Edit from the menu bar, the Delete sub-

menu and the Everyone item from the pull down menu (see Figure 4-2). 

 

4.8 Undoing Previous Actions  

Shortcut: [Edit/UNDO] 
If the user makes a mistake in any of the operations available from within the model, it can be 

undone by either clicking on the  button on the toolbar or selecting the UNDO option from 

the Edit menu. Selecting this function will remove the last operation performed. The list of 

available operations to undo are displayed in the Data Output Window’s Summary tab. The last 

operation that can be undone is at the top of this list. 

 

4.9 Population View 

The View functionality is identical to that described in Chapter 3, relating to the GEOMETRY 

Mode (see Figure 4-74). 

 

 
Figure 4-74: The Population View menu. 

 

These functions are specifically designed to affect the graphical appearance of the interface. 

These functions will have no impact upon the occupant definition, although may assist in their 

manipulation. Briefly the View functions are: 
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Boundary The function of the boundary command is to allow an outline of 

the current geometry to be drawn. 

Find This function allows the user to locate either nodes or people 

within the geometry. 

Shape This function merely allows the user to control the manner in 

which agents are drawn within the geometry (i.e. Person, Block 

or Arrow shape, see Chapter 6). 

Display This function allows the identified objects in a selected area to be 

viewed 

Interface This function allows the user to control the appearance of the user 

interface within buildingEXODUS. 

Model Description This function allows the user to define a description of the 

geometry/scenario in order to easily differentiate from others. 

Redraw The redraw function corrects the geometry window that has 

become cluttered with extraneous graphics 

Zoom This function allows changes in the level of magnification on a 

particular region 

Area Summary This function calculates the approximate area (in square metres) 

of a selected region, as well as the number of people that it 

contains (see Chapter 5).   

Show Grid This function draws the grid within each geometry window. in 

order  

 

4.10 Leaving Population Mode 

Shortcut: [Edit/Goto/Scenario Mode]  
The next stage in specifying a simulation involves defining the scenario. This must be done in 

SCENARIO mode. To move into SCENARIO mode, select Edit from the menu bar, Goto from 

the menu and then the Scenario Mode item from the sub-menu (see Figure 4-2). Alternatively, 

press the MODE ADVANCE button on the toolbar (see Figure 4-1). 
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CHAPTER 5: DEFINING A SCENARIO (SCENARIO MODE) 
After completing the population set-up process, it is necessary to define the evacuation scenario. 

This involves defining which exits will be available and when, the delay characteristics of the 

exit and whether or not smoke, heat and toxic gases are to be considered. 

 

5.1 Scenario Mode Overview 

In buildingEXODUS, an evacuation scenario comprises three main components: 

 Population characteristics/behaviour (see Chapter 4) 

 Fire Atmosphere (see Section 5.3) 

 Exit Performance Aspects (see Section 5.8) 

 

Population characteristics are set in POPULATION mode (see Chapter 4).  The behaviour of 

the evacuees is directly related to their individual characteristics, attributed tasks and 

understanding of the geometry. 

 

NOTE: 

Certain behavioural aspects, such as the ability to jump over seats, may be controlled in 

SIMULATION mode through options in the Rule Base (see Chapter 6). 

 

The presence of fire hazards such as smoke, heat and toxic gases can have a major impact on 

evacuation dynamics. While buildingEXODUS does NOT possess a fire model (zone or field 

model) capable of predicting the generation and spread of fire hazards, SCENARIO mode does 

provide several methods for defining these developing hazards, as well as the ability to load 

predictions of fire hazard spread generated using either SMARTFIRE or the zone model 

CFAST (versions 4.0 up to 7.0.1).  The ability to define and include the effects of fire hazards 

within a buildingEXODUS simulation is restricted to software level C. 

 

Exit capabilities are a primary factor in determining evacuation performance.  In 

buildingEXODUS, the SCENARIO mode offers several methods to vary the performance of 

exit components, such as the associated delays and opening/closing times. 

 

 
Figure 5-1: Scenario mode menu bar and toolbar 
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Table 5-1: Toolbar buttons specific to Scenario Mode 

Button Name Menu Equivalent Explanation 

 
Add Zone 

Tools – Zone - Add 

Zone 
Creates hazard zones (see Section 5.3.1) 

 
Zone Editor 

Tools – Zone - Edit 

Zone 
Creates/Edits hazard zones (see Section 5.3.2) 

 
Hazard Editor Tools - Hazard Creates/Edits hazard definitions (see Section 5.3.3) 

 
Scenario Editor Tools – Scenario Creates/Edits scenario definitions (see Section 5.3.10) 

 
Redraw* View – Redraw Redraws the current screen 

 
Boundary* View – Boundary Toggles appearance of geometry between nodal 

and boundary mode. 

 
Undo* Edit - Undo Allows the user to undo the last task performed 

 

 

 

 
Figure 5-2: Menu items specific to Scenario mode  

 

5.2 Manipulating Objects 

Whilst in Scenario mode the user is able to interact and interrogate a variety of object types. When 

doing so the user has two basic options in retrieving information in relation to one of these options. 

The user may double-click (using the left mouse button) on the icon representing the object in the 

workspace, which will produce a dialogue box, providing access to the attributes of that object, 

which may be examined and possibly edited. Alternatively the user may right click (once) on the 

object, which will then generate a menu from which the user may select information. The nature 

of this menu may change from object to object according to the data available. The method used 

is entirely down to the preferences of the individual. 

 

5.3 Fire Hazard Definition 

Users with level A or B software licences may skip this section as they do not have access to 

this feature (see the Theory Manual, Section 1.2). 

 

buildingEXODUS is capable of including three types of fire hazard, SMOKE, HEAT, 

IRRITANT and TOXIC GASES, but does NOT currently include a fire model (i.e. zone or field 

model) component capable of  predicting the generation and spread of fire hazards.  However, 

within SCENARIO Mode, the user has access to tools that enable the specification of fire hazard 

evolution, as well as the ability to load predictions of the environment resulting from fire(s) 

within a multi-compartment structure as calculated using the CFAST zone model and the 
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SMARTFIRE fire field model.  Loading CFAST generated environment predictions requires 

the CFAST model to be run prior to the use of buildingEXODUS and a CFAST data file 

generated recording the outcome of the simulation. Similarly, the SMARTFIRE model must 

also be run prior to the use of buildingEXODUS in order to generate a corresponding 

SMARTFIRE  data file (*.DAT file).  Once generated, a data file can then be imported into 

buildingEXODUS as a fire hazard, which then requires association with an area within the 

geometry (i.e. a zone). It is however important to note, that it is the user’s responsibility to 

ensure that the associations between imported fire hazards and zones is undertaken 

correctly (i.e. that any zone associated with an imported hazard directly corresponds with 

the physical region that the hazard itself represented within the CFAST or SMARTFIRE 

models).  If this is not the case then anomalous results may occur. 

 

Regardless of which of the above methods is used, there are three stages to follow when defining 

fire hazard evolution within buildingEXODUS.  Firstly, it is necessary to define the physical 

extent or Zone over which the hazards will operate, using the Zone Editor (see Section 5.3.1).  

Secondly, the rate at which the various hazards change must be defined using the Hazard Editor 

(see Section 5.3.3).  Finally, the actual fire scenario is defined by attaching specific hazards to 

particular zones using the Scenario Editor (see Section 5.3.10). 

 

5.3.1 Definition of Hazard Zones 

Shortcut: [Tools/Zone/Add Zone]  

A hazard zone is simply a region of space, (i.e. a collection of nodes), over which specified fire 

hazards are active.  In specifying a hazard zone, it is necessary to specify the nodes that are to 

be included in the zone, and label it with a meaningful name. 

 

To define a hazard zone, two steps are required.  First the user must select the nodes that make 

up the zone. This may be as small as a single node or as large as the entire geometry.  Selecting 

nodes for this task is no different from selecting nodes for other purposes (i.e. an area is dragged 

out covering the constituent nodes, or nodes are identified individually and grouped using the 

CTRL key).  Once the region is selected, a hazard zone is created by selecting Tools from the 

menu bar followed by Zone from the pull-down menu and finally the Add Zone item (see Figure 

5-2).  Alternatively, press the ADD ZONE button on the toolbar (see Table 5-1). 

 

NOTE: 

To select nodes for hazard zones, the actual nodes to be selected do not need to be viewed, i.e. 

this process may be used in boundary view. 
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Figure 5-3: Zone Info dialogue box 

 

When this button is pressed, the ZONE INFO dialogue box will appear (see Figure 5-3).  In this 

dialogue box, three components can be identified: 

 

(a) Zone Name (default “ZONE_xx” where xx = number of new zones) - This field allows a 

meaningful name to be assigned to the zone.  This is useful for identification purposes when 

constructing a Fire Scenario. 

 

(b) Zone Type - This field provides a choice of different zone types (‘hazard’, ‘response’, 

‘compartment’, ‘visibility signs’, ‘obstacle’). For a Fire Hazard zone, the default option of 

‘hazard’ should not be changed. 

 

(c) Zone Controls - These buttons allow simple editing to be performed on the extent of the 

zone. 

“+” 
Allows the currently selected nodes to be added to the zone definition, this is 

particularly useful in defining zones of irregular shape. 

“-”  
Allows the currently selected nodes to be removed from the zone definition, this 

is particularly useful in defining zones of irregular shape. 

SET  Replaces the current nodes in the zone definition with the selected nodes. 

OK  Accepts the current definition and closes the dialogue box. 

DELETE Closes the dialogue box, deleting the selected area and not creating a zone. 

 

TIP: 

It is easier to define all the zones in succession before defining the fire scenario. 

 

TIP: 

Plan fire hazard zones carefully as re-selecting exactly the same nodes for another zone at a 

later point can be difficult in large geometries. 

 

5.3.2 Zone Editing 

Shortcut: [Tools/Zone/Edit Zone]  
Once a set of zones have been defined for a geometry it may be necessary to modify them at a 

later stage.  To modify a zone, buildingEXODUS provides a tool called the Zone Editor.  Using 

this tool, it is possible to view the extent of each zone, and add or remove nodes as necessary. 
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Figure 5-4: Zone Editor dialogue box 

 

To start the Zone Editor, select Tools from the menu bar, Zone from the menu and the Edit 

Zones item from the sub-menu (see Figure 5-2). Alternatively, press the ZONE EDITOR button 

on the toolbar (see Table 5-4).  The ZONE EDITOR dialogue box will now appear, as depicted 

in Figure 5-4.  It should be noted that when the zone editor is activated, the user is at liberty to 

select nodes in the usual fashion. 

 

It can be seen in Figure 5-4 that there are two main areas in the Zone Editor: the Zone List and 

the Control Buttons.  The Zone List contains all the zones currently defined for the geometry 

for the specific zone ‘type’.  To perform any modifications on a zone, the zone must first be 

selected by clicking on the button.  When selected a pair of inverted commas “” will appear 

around the zone name, for example see “Zone 1” in Figure 5-4.  

 

The Control Buttons in the Zone Editor allow a number of modifications to be made to the list 

or to the currently selected zone: 
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CREATE  Creates a new zone in the list.  Note that the zone initially contains no nodes 

unless nodes are already selected within the geometry; in which case, these 

will form the zone. 

COPY Creates a new zone with the shape and type of the selected zone. 

EDIT Allows the name of the selected zone to be modified and the node type to be 

changed (see Figure 5-5). This Zone Info box also shows whether or not the 

zone is related to a polygon and provides the approximate and true area of 

each zone. 

REMOVE Deletes the selected zone from the zone list. 

CLEAR Deletes all the zones from the zone list. 

SHOW Shows the physical extent of a zone (see Figure 5-6(a)). 

SET NODES Replaces the selected zone with the currently selected nodes. 

ADD NODES  Adds the selected nodes to the selected zone. 

REM. NODES Removes the selected nodes from the selected zone. 

SHOW ALL Shows the physical extent of all zones (as node outlines). 

HIDE ALL Hides the physical extent of all zones (as node outlines). 

SHOW POLYS Shows the polygon outline of the selected zone.  Used in conjunction with 

the Zone Contour function (see Chapter 6) 

RECALC. 

POLYS 

Recalculates the polygon outline of the selected zone. Useful if alterations 

are made to the nodes included inside a particular zone.  Used in conjunction 

with the Zone Contour function (see Chapter 6). 

AREA Calculates and displays the area that lies within a specific zone (see Figure 

5-6(b)). 

LABEL Inserts a label within the geometry identifying the location of all zones. 

SORT Sorts the zones within the Zone List alphabetically (i.e. as opposed to merely 

in the order in which they were created). 

NOT ZONE Displays all the nodes not currently assigned to a zone of the selected Type. 

(i.e. if the Hazard zone type was selected then clicking the Not Zone button 

would highlight all nodes not currently assigned to a Hazard zone). 

OK Closes the zone editor. 

MERGED Enables the Show, Area and Show Polys buttons to be used for multiple 

selected zones at the same time. 

 

 
Figure 5-5: Zone Info dialogue box 

 

The user should note the ability to create zones through the ZONE EDIT dialogue box. Each 

time the CREATE button is clicked a new zone appears in the ‘Zones’ area of the dialogue box 

(i.e. forming a list of zones as highlighted in Figure 5-6), each of which will be numbered 

incrementally. Each zone can be manipulated by first highlighting the zone (single-clicking on 

the button representing the zone of interest, see Figure 5-6) and then adjusting the nodal 

formation of the associated nodes as described above (e.g. selecting nodes within the geometry 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 256 

and then clicking the ADD NODES button). It should be noted that double-clicking on any of 

the zone buttons launches the ZONE INFO dialogue box described in Figure 5-5. This process 

therefore provides a shortcut to creating and naming zones for the more experienced user. 

 

 

 

 

 

  
(a) (b) 

Figure 5-6: (a) Using the Show function on Zone 1. (b) Using the Area function. 

 

The user has the ability to ‘Show’ all of the zones simultaneously by selecting the MERGED 

check-box. Once this has been done and the SHOW button has been clicked then all of the zones 

will appear on the screen (irrespective of the method used to display them). 

 

5.3.3 Using The Hazard Editor 

Shortcut: [Tools/Hazard]  
There are essentially four ways of specifying fire hazards within buildingEXODUS: manually 

importing explicit data for use at given times (see Section 5.3.4), utilising a user defined 

function to determine hazard evolution over a specified time period (see Section 5.3.5), 

importing a CFAST (version 4.0.1 up to 7.0.1) data file (see Section 5.3.6) and the importation 

of a SMARTFIRE data file (see Section 5.3.7). 

 

TIP: 

Using the function method to define fire hazards involves less effort than explicitly defining fire 

hazard values. 

 

NOTE: 

It must be remembered that fire hazards within buildingEXODUS operate at two heights: an 

upper and lower height.  The definition of the upper and lower height is dependent on the 

approach used to specify the hazards.  When using the user-defined option, evacuees are 

continually exposed to hazards at the upper height while they assume the standing position.  

The hazards defining the upper height conditions should represent those hazards existing at a 

nominal head height e.g. 1.7m.  When evacuees are forced to crawl, they are then exposed to 

the hazard values at the lower height and so lower height hazard values should represent those 

hazards existing near the floor e.g. about 1.0 m above the floor.  However, when CFAST 

generated hazards are used, the height of the upper hazard layer is also determined, thus the 

height of the upper layer changes with time as do the hazard values.  In this case evacuees do 

not typically come into contact with the upper layer until it has descended to a distance equal 
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to their height (see Section 5.3.6). When using the SMARTFIRE defined hazards, the rationale 

used is similar to that used when making use of user-defined data.  When people are standing 

they are continually exposed to the environmental conditions that exist at the upper height.    

When evacuees are forced to crawl, they are then exposed to the hazard values at the lower 

height and so lower height hazard values should represent those hazards existing near the floor.  

The position and depth of both the upper and lower regions are defined, by the user, within 

SMARTFIRE prior to running the simulation. Hence it is up to the user to ensure that the upper 

and lower regions are representative of the regions to which standing and crawling people 

would be exposed.  The exception to this is the exposure to radiative flux, which is provided as 

constant in both the upper and lower regions (see the Theory Manual).  It is suggested that the 

hazards defining the upper height conditions should represent those hazards existing at a 

nominal head height e.g. 1.7m while those for crawling individuals should represent a height 

of about 1.0 m above the floor (see Section 5.3.7).   

 

In all four cases, the Hazard Editor is used to specify hazard values.  To initiate the Hazard 

Editor, select Tools from the menu bar and the Hazard item from the pull-down menu (see 

Figure 5-2). Alternatively, press the HAZARD EDITOR button on the toolbar (see Table 5-1).  

At this point, the HAZARD EDITOR dialogue box should appear, as shown in Figure 5-7. 

 

 
Figure 5-7: Hazard Editor dialogue box  

 

The purpose of this dialogue box is to allow a list of hazards to be created.  The hazard controls 

allow the list to be modified.  The purpose of each button is listed below: 

  



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 258 

 

Button Description 
CREATE This creates a new hazard named “HazX”, where X = the number of new 

hazards. 
COPY   This duplicates the selected hazards and adds to list of hazards. 
REMOVE  This removes the currently selected hazard. 
CLEAR   This removes ALL the hazards from the list. 
IMPORT HAZARD 

FILE 
Loads the hazards associated with each sub-volume stored within a specified 

CFAST or SMARTFIRE data file. (Note: buildingEXODUS can only load 

CFAST History files generated using CFAST versions 4.0.1 to 5.1.1, see Section 

5.3.8). 
OK   Closes the Hazard Editor dialogue box. 

 

Figure 5-7 depicts the situation when a single hazard has been created, i.e. after the CREATE 

button has been clicked. It should be noted that clicking the CREATE button relates to the 

creation of a user-defined hazard, and not a CFAST/SMARTFIRE hazard.  Once created, the 

hazard has three parts that may be modified, the Hazard Name, Lower Values and Upper 

Values.  To modify the hazard name, the hazard must first be selected, by clicking on the button 

containing the default name.  Once selected, a pair of inverted commas appear around the name, 

as shown in Figure 5-8. 

 

 
Figure 5-8: Selecting a hazard 

 

To modify the name, the same button must be clicked again to retrieve the dialogue box shown 

in Figure 5-9. In this dialogue box, it is possible to modify the name of the hazard and also to 

attach a short description.  This feature is included in order to distinguish the various hazards. 

 

 
Figure 5-9: The hazard information dialogue box 

 

The upper and lower definitions of the hazard actually store the individual fire hazard values, 

at the respective heights.  The dialogue boxes for both cases are virtually identical, the only 

difference being a change in one of the control buttons. In the dialogue box relating to the lower 

height, a button ASUPPER appears to convert the definitions to those entered for the upper 

height, while in the dialogue box relating to the upper height, a button ASLOWER appears, to 

convert the definitions to those entered for the lower height.  An example is depicted in Figure 

5-10 for the upper values.  To retrieve this dialogue box, or the corresponding dialogue box for 

the lower hazard values, the UPPER (or LOWER) button in the Hazard Editor must be clicked. 
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Figure 5-10: The dialogue box for defining upper hazard values 

 

Figure 5-10 illustrates five important areas in the hazard definition dialogue box.  On the left 

side of the box, each of individual fire hazards can be seen (e.g. HCN, CO etc).  For each of 

these hazards, four values must be supplied (see Table 5-2). 

 

Table 5-2: Hazard Definition dialogue box controls 
Value Label Explanation 

Initial Value INIT Starting value of hazard when hazard definition becomes active. 

Gradient GRAD Gradient of a polynomial type equation (see Section 5.3.5). 

Power POW Power of a polynomial type equation (see Section 5.3.5). 

Limit LIMIT Maximum limit hazard can obtain. 

 

NOTE: 

The function of the Hazard Limit differs, according to the nature of the function describing the 

hazard. If the function has a negative gradient then the limit provides a minimum, whereas if 

the function has a positive gradient then the limit provides a maximum. 

 

The function of the control buttons in this dialogue box are described below: 

 
RESET  Restores the values of the hazard definitions to their original values 

AS LOWER 
This changes all the values to be the same as those in the lower definition.  In the lower 

definition dialogue box, this control is changed to AS UPPER. 

DEFAULT This changes all the values to the default values, as shown in Table 5-3. 

OK  Accepts any modifications and closes the dialogue box. 

CANCEL Cancels any modification and closes the dialogue box. 

IRRITANTS Enables the irritant gases to be defined for the corresponding upper or lower layer. 

 

As with the narcotic gases, the levels of the irritant gases must be set by the user in Scenario 

mode. This is achieved though accessing the Hazard dialogue box and then creating a new 

hazard panel in the standard manner. Once created, the user should double-click on the newly 

created panel. From here the irritants can be accessed via the IRRITANTS button.  The user may 

toggle between the irritant and narcotic gases by clicking on the IRRITANTS or the 

NARC/TEMP buttons, which will become visible according to the dialogue box being viewed.  

This will then allow the user to set the development of the irritant gases in the same manner in 

which they manipulate the narcotic gases. 

 

The default values of the hazard definition values are outlined in Table 5-3. 
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Table 5-3: Default zone hazard values 

  Default Values 

Hazard Name/Unit Initial Gradient Power Limit 

T Temperature ( oC) 20.0 0.0 2.0 2000.0 

HCN Hydrogen Cyanide (ppm) 0.0 0.0 2.0 2000.0 

CO Carbon Monoxide (ppm) 0.0 0.0 2.0 2000.0 

CO2 Carbon Dioxide ( %) 0.0 0.0 2.0 100.0 

O2 Oxygen ( % ) 21.0 0.0 2.0 100.0 

Smk Smoke (/m) 0.0  0.0 2.0 2000.0 

Rad Radiative Flux (kW/m2) 0.0  0.0 2.0 10.0 

HCL Hydrogen Chloride (ppm) 0.0 0.0 2.0 5000.0 

HBr Hydrogen Bromide (ppm) 0.0 0.0 2.0 5000.0 

HF Hydrogen Fluoride (ppm) 0.0 0.0 2.0 5000.0 

SO2 Sulphur Dioxide (ppm) 0.0 0.0 2.0 666.67 

NO2 Nitrogen Dioxide (ppm) 0.0 0.0 2.0 1944.44 

CH2CHO Acrolein (ppm) 0.0 0.0 2.0 111.11 

HCHO Formaldehyde (ppm) 0.0 0.0 2.0 166.67 

 

NOTE: 

The Smoke attribute is measured in units of extinction coefficient (K). In order to convert from 

extinction coefficient to optical density per metre (OD/m), multiply OD by 2.3 [25],  i.e. K = 

OD/m * 2.3. 

 

NOTE: 

The radiative flux is measure in kW/m2. 

 

5.3.4 Defining Hazard Evolution Explicitly 

Defining fire hazards explicitly requires the user to specify the precise values of the hazards to 

be active throughout the defined zone. This approach is desirable when the user has access to 

hazard evolution data derived from (i) experimental data, (ii) zone fire model data (other than 

CFAST versions 4.0.1 up to 7.0.1) or (iii) fire field model data (other than SMARTFIRE version 

4.0). Alternatively, the user may wish to specify an arbitrary hazard evolution.  

 

Using this approach the user specifies the evolving fire atmosphere in terms of step functions.  

Each “step” is active over a time period specified in the fire scenario definition and corresponds 

to a single hazard definition, thus new hazards must be defined for each step.   

 

As an example of explicitly setting fire hazards, consider an enclosure consisting of two 

compartments, one of which contains a fire. The user wishes to specify the spread of smoke 

from the compartment containing the fire, to the adjoining compartment and so defines two 

physical regions (zones), one covering each compartment.  In each physical region (zone), he 

decides to use two steps to represent the changing smoke concentration (see Figure 5-11).  

Effectively, the user must specify four hazard definitions.  In this example the smoke 

concentration within each physical region is assumed to be uniform and so the upper and lower 

values for smoke concentration are equal. 
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Figure 5-11: Defining fire hazards using a step function 

 

At time = t1, the smoke level in zone 1 (compartment with fire) is set to 0.2 /m.  It remains at 

this level until time = t3, when it increases to 0.4 /m.  In zone 2 (adjoining compartment), the 

smoke concentration does not register until time = t2, and increases at time = t4.  To represent 

this in buildingEXODUS, four hazard definitions would be required, two for each zone.  Table 

5-4 shows the relevant values for each hazard definition in this instance, i.e. the values placed 

in the upper and lower hazard definitions. 

 

NOTE: 

In Table 5-4 the upper and lower smoke concentration values are assumed to have been set to 

the same value. 

 

NOTE: 

When using step functions to define fire hazard evolution, the gradient of each hazard should 

be set to 0.0. 

 

Figure 5-12 depicts the Hazard Editor, with these four hazard definitions complete, and the 

corresponding UPPER VALUE dialogue box for hazard definition 4.  Note in this figure, that 

the Limit attribute has not been modified.  As the smoke is to remain at a fixed value, i.e. there 

is no polynomial increase (see Section 5.3.5), then this attribute is meaningless. 

 

Table 5-4: Example zone definition for smoke attribute 

Zone Hazard Def Zone Attribute 
Attribute 

Value 

1 1 Smoke 0.2 

1 1 Smoke Gradient 0.0 

1 1 Smoke Power 0.0 

1 2 Smoke 0.4 

1 2 Smoke Gradient 0.0 

1 2 Smoke Power 0.0 

2 3 Smoke 0.1 

2 3 Smoke Gradient 0.0 

2 3 Smoke Power 0.0 

2 4 Smoke 0.3 

2 4 Smoke Gradient 0.0 

2 4 Smoke Power 0.0 
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(a) (b) 

 
(c) 

Figure 5-12: The hazard editor when implementing the hazards in Table 5-4: (a) the 

hazard editor with all four hazard definitions, (b) the upper Narc/Temp values and (c) 

the upper Irritant values for one of the hazard definitions 
 

As with the narcotic gases, the levels of the irritant gases must be set by the user in Scenario 

mode. This is achieved though accessing the Hazard dialogue box and then creating a new 

hazard panel in the standard manner. Once created, the user should double-click on the newly 

created panel. From here the irritants can be accessed via the IRRITANTS button (see Figure 

5-13 and Figure 5-14).  The user may toggle between the irritant and narcotic gases by clicking 

on the IRRITANTS or the NARC/TEMP buttons, which will become visible according to the 

dialogue box being viewed.   
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Figure 5-13: Setting the levels of the 

Narcotic gases. 

Figure 5-14: Setting the levels of the 

Irritant gases. 

 

5.3.5 Defining Hazard Evolution using User Defined Functions 

Within each hazard zone it is possible to specify the evolution of fire hazards using an arbitrary 

polynomial function of the type, 

 

Hazard=initial hazard + m*t p 

 

where m = the gradient 

 t = time (seconds) 

 p = power 

 

By setting the gradient and power to zero, only the initial values are used throughout the time 

period for the zone (see Section 5.3.4).  By modifying the gradient and power, different rates 

of increase/decrease for each hazard can be set. In the EDIT ZONE dialogue box, each hazard 

may have its own defining equation in this manner. 

 

Figure 5-15 demonstrates the effect of increasing the gradient and power of the function.  In 

Figure 5-15a  p=0 and m takes the values m=0,1,2 and 3.  In Figure 5-15b, p = 1 and m takes the 

values m=0, 1, 2 and 3.  Finally, in Figure 5-15c, p = 2 and m takes the values m=0, 1, 2 and 3. 
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(a) (b) 

 
(c) 

Figure 5-15: Effect of gradient and power on hazard calculation 

 

As with the explicit definition of fire hazard evolution, each hazard may have different 

characteristics over several time periods.  This is treated as in the previous section with 

additional hazard definitions being added for the same zone. 

 

5.3.6 Defining Hazard Evolution using CFAST 

CFAST is a two layer zone model used to predict the evolving distribution of smoke, heat and 

toxic gases resulting from fire(s) within multi-compartment structures.  CFAST was developed 

by the Building and Fire Research Laboratory within the National Institute of Standards and 

Technology (NIST).  Within CFAST, each compartment (or sub-volume) is divided into two 

layers – an upper layer and a lower layer.  Each layer is assumed to be internally uniform i.e. 

the values of smoke, heat and toxic gases are assumed to be the same at every point within a 

given layer.  The division of rooms in this manner is done to replicate the two layer stratification 

often observed in some compartment fire situations. 
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Figure 5-16: The movement of layers between CFAST compartments 

 

Hot gases rise from the fire to the ceiling where they collect and form an upper layer.  The build 

up of hot gases causes the upper layer to expand in volume resulting in the gradual descent of 

the boundary between the upper and lower layer (i.e. the interface) with time.  The expansion 

of the upper layer in this manner results in the lower layer being forced down and into 

neighbouring compartments.  Similarly the descent of the interface beneath the tops of 

doors/windows causes the flow of upper layer gases into neighbouring compartments, resulting 

in the formation and subsequent expansion of their upper layers.  The expansion of the upper 

layer within these compartments results in the flow of gases into their neighbouring 

compartments etc. (see Figure 5-16). In this way CFAST attempts to model the environment 

within multi-compartment structures.  CFAST generates predictions for temperature, smoke 

density and toxic gas concentrations within both the upper and lower layer of each compartment 

at regular user-defined time intervals.  A prediction for the height above the floor of the 

boundary between the upper and lower layer (i.e. the interface) for each compartment is also 

supplied. 

 

For a detailed explanation of the CFAST model and its equations see [60,61] 

 

 
Figure 5-17: The expansion of the upper layer with a CFAST compartment 

 

It is important to note that although both user-defined and CFAST hazards can be specified in 

the upper and lower layers, the layer concept in these two approaches are quite different.  These 

differences have important implications regarding the interaction of the upper layer with the 

simulated individuals.  When using user-defined hazards, individuals are exposed to the upper 

height hazards while they are standing and the lower height hazards when they assume the 

crawling position.  Users set upper height hazard values assuming that individuals are exposed 

to the specified hazard values while standing.  In this case the upper height values are assumed 

to represent the time evolution of the hazards at a fixed height i.e. the nominal average head 

height. When employing hazards determined using CFAST, as CFAST is capable of 

determining the height of the upper layer, the depth of the upper layer varies over time as does 

the actual hazard values.  Using this approach, the individual is not exposed to the upper height 

hazards until the upper layer has descended to a height equivalent to the height of the evacuee. 
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Using CFAST hazards, the layer that evacuees are exposed to varies with time, and is dependent 

upon the height and stance of the evacuee and the height of the boundary between the upper 

and lower layer (see Figure 5-17).  The heights of the evacuee stances (i.e. standing/crawling) 

used in the simulation is dependent upon the status of Person Heights option (specified within 

the Rule Base Hazard options (see Chapter 6)).  If enabled, each person is assumed to have a 

standing height equal to their individual height as defined by their population characteristics 

(see Chapter 4).  Crawling height is assumed to be one third of their standing height.  If disabled, 

all evacuees are assumed to have standing heights of 1.7m and crawling heights of 1m (see 

above).  By default Person Heights is disabled. 

 

The variation in the height of the boundary between the upper and lower layers with time also 

has implications regarding the temperature to which an evacuee is exposed.  Evacuees are 

assumed to be exposed to the temperature of the lower layer until the upper layer has descended 

to a height equivalent to the height of the evacuee. At this point the evacuee is then assumed to 

be exposed to the temperature of the upper layer, irrespective of the fact that a large part of their 

bodies may be exposed to the cooler lower layer. 

 

NOTE: 

CFAST has only a limited ability to generate irritant toxins (i.e. HCL). 

 

5.3.7 Defining Hazard Evolution using SMARTFIRE 

The SMARTFIRE V4.0 [88-94] software is used to perform the numerical modelling of the fire 

scenario.  SMARTFIRE is an open architecture CFD environment, written in C++, comprising 

four major components: the CFD numerical engine, various Graphical User Interfaces, an 

automated meshing tool and the Intelligent Control System.  The SMARTFIRE software has 

been developed by FSEG of the University of Greenwich and is capable of simulating fire in a 

variety of enclosure types, including buildings, aircraft and ships.  

 

SMARTFIRE can be used to generate fire hazard data relating to temperature, smoke 

concentrations and thermal radiation.  The temperature and smoke concentration that the 

occupant is exposed to will vary depending on whether the person is standing or crawling, as 

EXODUS will make use of the appropriate upper or lower values (see Figure 5-18(a)).  

However, the radiative flux values generated by SMARTFIRE are considered to be constant 

regardless of whether the individual is standing or crawling and so within EXODUS the values 

used in the upper and lower levels are effectively the same (see the Theory Manual for an 

explanation). The position and depth of both the upper and lower region for each zone are 

defined, by the user, within SMARTFIRE prior to running the simulation. Hence it is up to the 

user to ensure that the upper and lower regions are representative of the typical regions to 

which standing and crawling people would be exposed. 

 

Depicted in Figure 5-18(b) is an example where a poor choice has been made for the upper and 

lower regions. In this example the upper region has been set far above the level of standing 

individuals, resulting in the upper region containing values of temperature and smoke 

unrepresentative of those that a standing individual would be exposed to. Similarly the lower 

region has also been set far above the level of crawling people, resulting in the lower region 

containing values of temperature and smoke unrepresentative of those to which crawling 

individuals would be exposed to.  It is important to note here that in this instance the standing 

person would still be exposed to the upper region hazards and the crawling person would still 

be exposed to the hazards in the lower region, but these values would not be representative of 
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the real hazards. The exposure of individuals to unrealistic hazards (i.e. temperature and smoke 

gases) in this manner leads to unrealistic results being produced and must therefore be avoided.  

To further ensure consistency the user should also ensure that the position and depth of both 

the upper and lower regions should be the same within all the zones. 

 

  
(a) (b) 

Figure 5-18: The application of SMARTFIRE sub zone data within the 

buildingEXODUS model. 

 

5.3.8 Converting CFAST Data (> Version 5.1.1) to the SMARTFIRE File Format 

At present buildingEXODUS is capable of importing hazards from both the SMARTFIRE V4.0 

fire field model and the CFAST (version 4.0.1 to 7.0.1) zone model. Although 

buildingEXODUS is capable of importing data generated using a number of different CFAST 

versions, it is important to note that the format of the CFAST data that buildingEXODUS 

requires varies depending upon the CFAST version used to generate it. Currently 

buildingEXODUS only has the ability to directly load hazard data contained within binary 

History files (.HI) generated using CFAST versions 4.0.1 to 5.1.1. Any History files (.HI) 

generated using CFAST versions greater than 5.1.1 can therefore NOT be used within 

buildingEXODUS.  

 

For CFAST versions greater than 5.1.1, buildingEXODUS instead utilises the data contained 

within the ASCII output files (.OUT) produced automatically by CFAST upon completion of 

any given simulation. These output files typically contain information about all aspects of any 

given CFAST simulation (including those aspects not relevant to buildingEXODUS) in a text 

based format designed to be read by people, as opposed to computers. To overcome the un-

optimised format and excess simulation information that these output files (.OUT) contain, a 

conversion utility was produced to convert their relevant hazard data into corresponding 

optimised data files in the existing SMARTFIRE file format. The conversion utility to convert 

ASCII data output files (.OUT) generated using CFAST versions greater than 5.1.1 to 

SMARTFIRE data files (.DAT) is called CFAST2SMF, and can be located within the 

buildingEXODUS sub-menu within the Windows Start menu. Once selected, the user will then 

be confronted with both a console, used to display information to the user, and an OPEN FILE 

dialogue box through which the user can identify the CFAST data output file (.OUT) to be 

converted (see Figure 5-19). 
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Figure 5-19: The CFAST2SMF conversion utility showing the console and OPEN FILE 

dialogue box. 

 

Having identified an appropriate CFAST data output file, the file and its complete pathname 

will then be output to the corresponding console. In addition, the user will then be provided 

with a SAVE AS FILE dialogue box, through which they can specify both the name and 

location of the SMARTFIRE data file (.DAT) into which the CFAST hazard data will be 

converted (see Figure 5-20). 

 

 
Figure 5-20: The CFAST2SMF conversion utility showing the console and SAVE AS 

FILE dialogue box. 

 

Once the user has specified both the name and location of the SMARTFIRE data file data 

conversion will then be performed. If an existing SMARTFIRE data file (.DAT) is specified by 

the user, then the file will be overwritten with the corresponding converted hazard data. 

Conversely, if a new filename is defined by the user then a new file will simply be created in 

the required location. Upon successful completion of the data conversion procedure, the 

conversion utility CFAST2SMF will then simply require the user to press any key in order to 

close. Once converted into a SMARTFIRE data file, the hazard data originally generated using 

CFAST can then be loaded into buildingEXODUS in the same manner as conventional 

SMARTFIRE generated data (see Section 5.3.10). 
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It is however important to note, that converting CFAST hazard data into SMARTFIRE 

data files does NOT affect the way in which buildingEXODUS handles its corresponding 

layer information. While both the CFAST and SMARTFIRE models produce hazard data at 

both an upper and a lower layer within each corresponding sub-volume (i.e. compartment 

within CFAST), the layer concept within each model is quite different (see Sections 5.3.6 and 

5.3.7). SMARTFIRE assumes that all standing individuals are exposed to the environment (i.e. 

heat, smoke and toxic gases) within the upper layer, while all crawling individuals are 

conversely exposed to the lower layer atmosphere (see Section 5.3.7). In contrast however, 

CFAST, due to its ability to predict the varying height of the boundary between the upper and 

lower layers, assumes that individuals are not exposed to the environment within the upper layer 

until the upper layer has descended to their respective heights. As a result, the layer that 

individuals are exposed to varies with time, and is dependent upon the height and stance of the 

individual (i.e. standing/crawling) and the height of the boundary between the upper and lower 

layer (see Section 5.3.6). 

 

Although the SMARTFIRE model is currently unable to produce the kind of layer height 

information generated by CFAST, the SMARTFIRE data file format is however capable of 

storing it. As a result, SMARTFIRE data files have the ability to retain the CFAST layer height 

information after conversion, and hence maintain the CFAST layer concept. SMARTFIRE data 

files therefore differ in the layer concept that they apply depending upon how the data that they 

contain was generated. SMARTFIRE data files generated directly from the SMARTFIRE fire 

field model therefore continue to use the existing SMARTFIRE layer concept (see Section 

5.3.7), while files generated by converting CFAST output files (.OUT) conversely use the 

existing CFAST layer concept (see Section 5.3.6). Users loading hazard data in the 

SMARTFIRE file format should therefore consider the source of the data, and hence the layer 

concept that will be employed, when assessing its impact upon the population. 

 

5.3.9 Loading Existing CFAST and SMARTFIRE Hazards 

To load hazards from CFAST (version 4.0.1 to 5.1.1) history files into buildingEXODUS it is 

necessary to click the IMPORT HAZARD FILE button (see Figure 5-21). CFAST history files 

(.HI) are loaded in the usual manner via an OPEN FILE dialogue box, which allows the user to 

navigate through their directory structure searching for .HI files. Likewise, to load hazards from 

SMARTFIRE data files (.DAT) into buildingEXODUS click the IMPORT HAZARD FILE 

button (see Figure 5-21). An OPEN FILE dialogue box will then enable the user to navigate 

through their directory structure searching for SMARTFIRE data files (.DAT). 

 

NOTE: 

buildingEXODUS currently only has the ability to directly load History files (.HI) generated 

using CFAST versions 4.0.1 to 5.1.1. History files generated using CFAST versions greater 

than 5.1.1 can therefore NOT be used within buildingEXODUS. Users wishing to load hazard 

data generated using CFAST versions greater than 5.1.1 are instead required to convert the 

ASCII data output file (.OUT) (produced automatically by CFAST upon completion of any given 

run) into a corresponding data file in the SMARTFIRE file format prior to loading. The 

conversion of the CFAST ASCII data output file (.OUT) into a corresponding SMARTFIRE data 

file can be easily achieved using the purpose built conversion utility CFAST2SMF provided 

with buildingEXODUS (see Section 5.3.8). Once converted into a SMARTFIRE data file, the 

hazard data can then be loaded into buildingEXODUS in the same manner as conventional 

SMARTFIRE generated data by clicking the IMPORT HAZARD FILE button. 

 

NOTE: 
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The 64 bit version of buildingEXODUS is not capable of loading binary history files (.HI) 

generated using CFAST versions 4.0.1 to 5.1.1. Consequently only hazard data generated from 

CFAST versions greater than 5.1.1 can be loaded into the 64 bit version of buildingEXODUS. 

As outlined previously, when loading this CFAST hazard data, the data contained within the 

CFAST ASCII data output file (.OUT) must first be converted to the SMARTFIRE file format 

prior to loading via the purpose built conversion utility CFAST2SMF provided with 

buildingEXODUS (see Section 5.3.8). 

 

 
Figure 5-21: Hazard Editor dialogue box with CFAST/SMARTFIRE hazards 

 

Figure 5-21 depicts the situation when a typical data file (be it CFAST or SMARTFIRE) has 

been loaded. Once loaded, a hazard is created for every sub-volume/compartment contained 

within the specified data file.  Hazards generated from imported data files are instantly 

distinguishable from user-defined hazards by the fact that their corresponding UPPER and 

LOWER buttons are disabled. The disabling of the UPPER and LOWER button’s ensures that 

the user is unable to edit the predictions of smoke, heat and toxic gases contained within the 

data file.  By default, imported hazards are named "Sub-volumex", where x equals the sub-

volume/compartment number that the created hazard relates to within the data file. The hazard 

name can be modified in the same way as user-defined hazards. 

 

  
(a) (b) 

Figure 5-22: The hazard information dialogue box for (a) CFAST or (b) SMARTFIRE 

hazards. 

 

To aid the user, and to help avoid confusion, a default description is added to all imported 

hazards, as shown in Figure 5-22. The HAZARD INFO dialogue box is available through 

double-clicking on one of the SUB-VOLUME buttons. The default description typically 

contains three pieces of information.  The first part simply states what type of data file the 

hazard in question was imported from (i.e. CFAST or SMARTFIRE), the second states the full 

path and filename of the corresponding data file, while the third states the corresponding sub-
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volume/compartment number. It should be noted that both the hazard name and the information 

contained within the description are for display purposes only, and as such do not affect the 

data to which the hazard relates. Hence a CFAST hazard which is initially created as relating 

to Compartment1 within a specified data file will always relate to Compartment1 within that 

data file, even if for example its name was changed to Compartment2, or similarly if the 

path/filename within the description changed to that of another data file. It is therefore strongly 

recommended that in order to avoid confusion that the user should not alter the default 

description. 

 

NOTE: 

The hazards corresponding to given sub-volumes/compartments are required to be associated 

with the relevant zones. It is the responsibility of the user to make sure that the zones used in 

buildingEXODUS accurately reflect the original zones (i.e. sub-volumes/compartments) used 

in the CFAST/SMARTFIRE analysis. The association between a zone and an imported hazard 

is achieved in an identical fashion to the user-defined hazards within buildingEXODUS (see 

Section 5.3.10). 

 

5.3.10 Fire Scenario 

Shortcut: [Tools/Scenario]  
In order to complete a fire definition in buildingEXODUS, a Fire Scenario must be defined.  

Essentially this process links the fire hazards with the zones.  The tool provided for this process 

is termed the Scenario Editor.  To start the Scenario Editor, select Tools from the menu bar and 

the Scenario Editor item from the pull-down menu (see Figure 5-2). Alternatively, press the 

SCENARIO EDITOR button on the toolbar (see Table 5-4).  The SCENARIO EDITOR dialogue 

box will now appear, as depicted in Figure 5-23. 

 

There are essentially three areas in the Scenario Editor.  The first is made up of individual 

scenario components, where each component comprises of a zone, a start time, an end time and 

a hazard.  Secondly, a box is supplied where a brief description of the scenario may be given.  

This is simply to aid the user in identifying different fire scenarios.  The final area is made up 

the control buttons, described below. 

 

 
Figure 5-23: The Scenario Editor dialogue box displaying user-defined hazards 
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The minimum specification required to define a fire scenario is a single scenario component, 

i.e. one zone, one hazard definition, a start time and an end time.  The start time of a component 

represents the time at which the hazard definition becomes active over the zone, i.e. calculation 

of hazard values in the component will not commence until the simulation clock reaches the 

start time.  The end time represents the time at which the scenario component becomes inactive, 

i.e. when the simulation clock reaches the end time, the scenario component is no longer active.  

It should be noted that this does not mean that the nodes inside the zone no longer have any 

hazards - it simply means that the values no longer change.  Illustrated in Figure 5-23 are some 

end times where a large value is used.  Such values should be used when the hazard definition 

is valid for the remainder of a simulation. The following list describes each of the SCENARIO 

EDITOR control buttons: 

 

Button Description 
CREATE Creates a new scenario component. 
AUTO LINK Scenarios are automatically created by linking the existing predefined hazards 

with the corresponding zones. Using this approach, the first hazard within the 

hazard list is assigned to the first zone in the zone list, the second hazard is 

then assigned to the second zone etc. It is important to note that it is up to the 

User to ensure that the correct hazards are assigned to each zone (i.e. that each 

zone is assigned the hazard predictions corresponding to the physical region 

that it represents). 
REMOVE Removes the currently selected scenario component. 
CLEAR  Removes all the scenario components. 
LOAD SCEN. Loads a scenario file (see below). 
SAVE SCEN. Saves a scenario file (see below). 
SET ZONE Modifies the zone of the currently selected scenario component.  This initiates 

the Zone Select dialogue box, from which a Zone may be selected. 
SET HAZ Modifies the hazard of the currently selected scenario component.  This 

initiates the Hazard Select dialogue box, from which a Hazard may be 

selected. 
OK Closes the Scenario Editor. 
INTERPOLATE 

ALL 
If checked, this ensures that linear interpolation is used to calculate smoke, 

heat and toxic gas concentration for all times between time steps for all 

imported hazards (i.e. CFAST/ SMARTFIRE), else linear interpolation is only 

performed on those imported hazards where interpolation has been specified 

(see below). 

 

The basic process of creating a fire scenario involves specifying which zone is to be exposed to 

which hazard, as well as defining the period in time over which the exposure is to take place. 

Differences between user-defined and imported hazards are reflected in the manner in which 

the hazards are displayed within the Scenario Editor (see Figure 5-23).  User-defined hazards 

only require the definition of a start and end time.  However, as imported hazards are defined 

using an external data file, there is no reference to the internal time stepping used within 

buildingEXODUS, nor which portion of the CFAST/SMARTFIRE simulation is actually 

relevant to the evacuation simulation.  As a result, additional information is required in order 

to utilise CFAST/SMARTFIRE data.  The assigning of a CFAST/SMARTFIRE hazard to a 

zone therefore results in the Start and End times being replaced by a DETAILS button (see 

Figure 5-24). 
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Figure 5-24: Appearance of Scenario Editor during when linking CFAST or 

SMARTFIRE hazards. 

 

Clicking this button retrieves the DATA FILE SCENARIO dialogue box shown in Figure 5-25. 

 

  
(a) (b) 

Figure 5-25: The Data File Scenario dialogue box (a) CFAST hazard (b) SMARTFIRE 

hazard 

 

Figure 5-25 depicts the Data File Scenario dialogue box used to define the manner in which 

imported hazards are assigned to specific zones. CFAST data files contain predictions for the 

heat, smoke and toxic gases contained within both upper and lower layers for each compartment 

of a multi-compartment geometry at regular time intervals (see Section 5.3.6).  The time interval 

between successive data points is referred to as the time increment.  The time increment is 

defined by the user within CFAST prior to the generation of the CFAST data file, and can 

therefore vary from simulation to simulation (i.e. data file to data file).  The time increment 

specific to the data file from which the selected CFAST hazard is obtained is displayed at the 

top of Data File Scenario Dialogue box (see Figure 5-25a). This cannot be altered within 

buildingEXODUS.  While SMARTFIRE data files contain predictions for the heat and smoke 

within both upper and lower layers, unlike CFAST data files they do not necessarily do so at 

regular time intervals.  Within SMARTFIRE the user has the ability to control the time 

increment used throughout the duration of a simulation.  Hence while the time increment within 

a CFAST data file is static, in contrast within a SMARTFIRE data file it can be dynamic.  Since 

the time increments within SMARTFIRE data files are not necessarily constant throughout a 

given simulation, the time increment for SMARTFIRE hazards are deemed not applicable (see 

Figure 5-25b). 
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As hazards defined using CFAST/SMARTFIRE data files obtain their data from an external 

source, it is necessary to provide a method of defining the time region within the data file that 

is relevant to the evacuation simulation.  This is achieved through specifying the File Start and 

File End options in the DATA FILE SCENARIO dialogue box (see Figure 5-25).   

 

By default the File Start and File End values are set so as to make use of all the environmental 

data for the corresponding sub-volume/compartment.  However by altering these values it is 

possible to select a time subinterval within the complete range of values as shown in Figure 

5-27.  In this example, CFAST data has been generated over the time span of 0 to 1200 seconds 

with a time increment of 100 seconds (see Figure 5-25 (a) and Figure 5-26).  The internal 

highlighted region has been selected by setting File Start to 360 seconds and File End to 780 

seconds. 

 

 
Figure 5-26: The Data File Scenario dialogue box 

 

NOTE: 

When using CFAST or SMARTFIRE data files, it is often necessary to specify File Start and 

File End times as the CFAST/SMARTFIRE simulation produces hazard information from the 

start of the fire, not the start of the evacuation simulation, which usually occurs sometime after 

the fire has initiated.  This allows the fire an amount of time equivalent to the File Start time to 

develop before the evacuation simulation begins. 

 

Selecting a File Start time between two data points results in the values of the data point 

immediately prior to stated File Start time being used.  In this example, the temperature 120oC 

would be assigned to the zone for 40 seconds subsequent to the hazard becoming active over 

the zone (up to the 400 second mark).  Therefore, at 300 seconds the temperature would be 

120°C and at 400 seconds would rise to 200°C. The temperature value of the next data point 

would then be assigned to the zone, where it would remain unchanged for the full duration of 

the time increment (i.e. 100 seconds), before the value of the next data point would be adopted 

etc.  The updating of the temperature values would continue in this manner until the File End 

time is reached, where upon the scenario component becomes inactive.  In the same way as for 

scenarios specified using user-defined hazards, this does not mean that the nodes inside the 

zone no longer posses any hazard values, but that the values no longer change.  In the example 

discussed previously, the temperature of the upper layer of the specified sub-

volume/compartment remains at 210oC indefinitely after the specified File End time. 
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Figure 5-27: Upper layer temperature profile generated by a typical 

CFAST/SMARTFIRE simulation (Interpolation off) 

 

It should be noted, that while in the current example only temperature was used to demonstrate 

the hazard variable, the functionality described applies to all other environment variables within 

the imported data file (i.e. smoke, toxic gases etc.) at both the upper and the lower layers.  

 

When using user-defined hazards, the Start Time is intended to represent the time at which the 

specified hazard becomes active over the specified zone.  When using imported hazards, a 

similar feature is provided in the DATA FILE SCENARIO dialogue box, this is the EXODUS 

Start Time (see Figure 5-25).  Using the EXODUS Start Time the user can specify when the 

specified hazard takes effect.  In most cases, the imported hazards (over the selected time sub-

interval) will take effect at the start of the evacuation simulation, i.e. EXODUS Start Time equal 

to zero.  By default, the EXODUS Start Time is set to zero. 

 

NOTE: 

When using imported hazards, the File Start facility in the Data File Scenario dialogue box is 

intended to allow the user to off-set the start of the hazard data within buildingEXODUS to the 

start of the evacuation simulation, instead of the start of the fire. 

 

When using imported hazards, the time evolution of the smoke, heat and toxic gases hazards is 

represented as a step function, where the duration of the step is equal to the time increment (see 

Figure 5-27).  Smoke, heat and toxic gas concentrations stay constant for the duration of the 

time increment before instantaneously rising/falling to a new value.  This is somewhat 

unrealistic, implying that the environment variables remain unchanged in the intervening time 

between data points taking no account of the continual evolution of the fire.  This in turn implies 

that for large amounts of time the values of smoke, heat and toxic gases assigned to the zones 

are substantially greater or less than would be the case in reality.  This is particularly true in 

instances where large time increments are used.  In an attempt to overcome this, the ability to 

use linear interpolation between data points has been provided. 

 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 276 

 
Figure 5-28: Upper layer temperature profile of a typical sub-volume/compartment 

(Interpolation on) 

 

The results of using linear interpolation on the imported temperature data of our current 

example are depicted in Figure 5-28.  Instead of the environment variables remaining constant 

throughout the time increment, as was previously the case, they now change linearly with time.  

In this manner it is hoped that smoke, heat and toxic gas concentrations in the intervening time 

between data points will more closely resemble reality.  By default linear interpolation is 

disabled.  Linear interpolation can be enabled for individual scenario components via the 

Interpolate checkbox in the DATA FILE SCENARIO dialogue box (see Figure 5-25). If the 

Interpolate box is checked, all hazards (i.e. smoke, heat, toxic gases) within the current scenario 

will have linear interpolation applied to them.  Alternatively, linear interpolation can be enabled 

for all scenario components via the Interpolate All checkbox within the SCENARIO EDITOR 

dialogue box (see Figure 5-24). 
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Figure 5-29: Linear interpolation between two data points (dashed) compared to 

constant imported values (solid) and actual values (red). 

 

While in the majority of cases linear interpolation maps the behaviour of environment variables 

well, there are instances when this is not the case.  Figure 5-29 shows the predicted temperature 

variation for a sub-volume/compartment between four data points (i.e. at 0, 400, 800 and 1200 

seconds), in contrast to the actual temperature. 

 

It can be seen that the degree of success of linear interpolation varies between different data 

points.  Between the third and fourth data points (i.e. 800 and 1200 seconds) linear interpolation 

maps the variation in temperature well in comparison to reality.  However between the first and 

second data points (i.e. 0 and 400 seconds) the mapping is less good.  Here large differences 

exist between the predicted sub-volume/compartment temperature (as predicted using linear 

interpolation) and the actual temperature.  However even though large differences exist, using 

linear interpolation is still preferable to using a constant value throughout the whole of the time 

increment (i.e. interpolation off).  Between the second and third data points (i.e. 400 and 800 

seconds) linear interpolation fails to detect the peak in the actual data.  Here linear interpolation 

forecasts a slow reduction in temperature, while the actual temperature first rises and then falls 

steeply. Hence the linear interpolation underestimates the sub-volume/compartment 

temperature and therefore the temperature to which the zone, and its associated occupants are 

exposed.  This is not desirable since it increases occupant’s chances of survival above the level 

that it would be in reality and hence increases the likelihood safe-passage.  There is a similar 

problem when values are used throughout the whole of the time increment (i.e. interpolation 

off), in this instance, the values significantly under estimate the impact of the temperature. It 

should also be noted that in this example, CFAST (the package used to generate the results) has 

not been used efficiently. A smaller time interval should have been used to more accurately 

represent the evolving situation. This will not always be the case. Indeed, with large time 

intervals the impact of using non-interpolated and interpolated techniques is difficult to 

determine.  

 

The problem is more likely to occur when large time intervals between successive data points 

are used.  Users are therefore advised to be extremely careful when setting time increment 

values within both CFAST and SMARTFIRE data files. 

 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 278 

Finally, the APPLY TO ALL button in the DATA FILE SCENARIO dialogue box assigns all the 

settings within the current dialogue box (i.e. File Start, File End, EXODUS Start Time and 

Interpolate) to all scenarios containing hazards loaded from the same data file.  

 

NOTE: 

It must be remembered that each CFAST/SMARTFIRE hazard loads its associated environment 

data from its corresponding external file at each data point.  The process of loading data from 

an external file has an associated time overhead.  In instances where large numbers of 

CFAST/SMARTFIRE hazards are used, and the time increments of their associated external 

files small, the cumulative effect of these time overheads can cause a slowdown in the running 

of buildingEXODUS.  Similarly, the additional calculations required in using linear 

interpolation may also result in a slight slowdown occurring. 

 

NOTE: 

Clicking the DEFAULT button on the DATA FILE SCENARIO dialogue box will reassign the 

File Start and File End to include all the environment data within the identified sub-

volume/compartment, as well as setting the Start Time to zero and Interpolation to off. 

 

5.3.11 Scenario Files 

Scenario files allow a library of fire scenario definitions to be constructed for a geometry.  As 

such, they are geometry dependant, and loading a scenario file for a different geometry should 

be avoided as unpredictable results may occur. 

 

A scenario file comprises not only those components used in the scenario description, but also 

a list of all the defined hazards, i.e. a list of hazards is not stored in a separate file.  However, if 

the user wishes to store a library of hazards, this is possible using the SAVE SCEN button.  This 

allows details concerning the hazards within the current scenario to be stored in a user defined 

.SCE file.  Previously stored scenario files can then be loaded into the current geometry using 

the LOAD SCEN button. Once loaded using the controls in the Scenario Editor, the user has 

access to a list of pre-defined hazards, but no zones.  In this manner, more hazards may be added 

and saved to the default scenario for later use. 

 

NOTE: 

Saving an .EXO file does not guarantee that the external data file (i.e. .HI or .DAT) will 

automatically be associated with it. If the .EXO is saved and then prior to the next use of the 

file, the external data file and the .EXO file are moved relative to each other, then the .EXO file 

will not be able to locate the external data file and will therefore not be able to load the relevant 

fire scenarios. The user will then have to manually locate the data  file and reload it. If the files 

are not moved then any subsequent use of the .EXO file will automatically locate and load the 

data file. This is different from the use of the user-defined fire scenarios solely defined within 

buildingEXODUS as these are stored within the .EXO file. 

 

5.4 Response Zones  

This function allows the user to force sub-sections of the population to respond according to 

the Response Zones generated. An individual’s Response Time will be ignored and instead they 

will respond according to the Response Time associated with the zone in which they start, 

assuming that the Response Time attributed to them by the Response Zone is shorter than that 

which they currently have. For instance, if an individual has a Response Time of 30 seconds 

and they are situated in a Response Zone with a Response Time of 20 seconds, then they will 
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ignore their original Response Time. If in contrast their original Response Time was 15 seconds, 

then they will still respond after this amount of time as it is shorter than that which was to be 

attributed to them from the Response Zone. If an individual does not start within one of the 

defined Response Zones, then they will revert to their own Response Time attribute. Before this 

can occur the zones that define these responses require definition.  

 

5.4.1 Creating a Response Zone  

To create a Response Zone the user is first required to open the Zone Editor dialogue box in the 

same manner as when creating conventional Hazard Zones (see  Section 5.3.2).  Within the 

Zone Editor dialogue box the user is first required to define the type of zone to be created. To 

create Response Zones, the user should therefore merely set the Zone Type to Response. Any 

zones subsequently created (i.e. by clicking the Create button) will then be Response Zones. As 

with Hazard Zones, the user defines Response Zones by selecting a group of nodes and 

associating it to a specific Response Zone panel. These panels can be edited such that the nodes 

associated with them can be increased, displayed and removed (see Figure 5-30). 

 

 

 

 

 
Figure 5-30: Response Zone Editor dialogue box. 

 

Once the user has created a Response Zone then the zone has to have an Activation Time (i.e. 

the associated response time) assigned. 

 

5.4.2 Associating a Response Time to the Response Zone 

Once the Response Zone has been created then it has to have an activation time associated to it. 

This is done by clicking on the ATTRIBUTES button, which displays the Edit Response Zone 

Time dialogue box (see Figure 5-31). 

 

 
Figure 5-31: The Edit Response Zone Time dialogue box. 
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The time provided in the text box acts as the response time for the evacuees that start within the 

associated zone. 

 

The user has the ability to ‘Show’ all of the zones simultaneously by selecting the Merged 

check-box. Once this has been done and the SHOW button has been clicked then all of the zones 

will appear on the screen (irrespective of the method used to display them). 

 

NOTE: 

Response Zones will not have any effect during a simulation unless they have first been enabled 

within buildingEXODUS. This is achieved by selecting the Zone Events option within the 

Behaviour Options dialogue box (see Chapter 6). 

 

5.5 Compartment Zones  

This function enables the user to group together sets of nodes into a single zone of interest; i.e. 

that is collected together to influence performance in a consistent manner, or collect information 

across the set of associated nodes. Once a set of nodes have been assigned to a Compartment 

Zone then buildingEXODUS either (1) allows specific itinerary tasks to interact with the 

defined compartments (see Chapter 4), or (2) collects data relating to the movement of people 

over those nodes (and hence the zone) during the simulation. In both cases, the Compartment 

Zone must first be created before it is associated with an itinerary task (and then influence agent 

performance), or used to collect data (when it does not influence agent performance). From the 

people movement data gathered throughout the simulation three different types of graphs can 

be generated, namely a graph of the Arrival of individuals within the zone (see Figure 5-32(a)), 

a graph of the Departure of individuals from the zone (see Figure 5-32(b)) and finally a graph 

of the Pop. Size (i.e. the number of individuals) within the zone (see Figure 5-32(c)).  
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 (a) (b) 

 
(c) 

Figure 5-32: The (a) Arrival, (b) Departure and (c) Pop. Size graphs generated by 

Compartment Zones. 

 

The graphs generated for each Compartment Zone can be viewed directly within 

buildingEXODUS while the simulation is running or alternatively can be saved to the 

simulation output file for later analysis (see Chapter 6). Once Compartment Zones have been 

created then they are automatically added to the Navigation window within the existing tree 

structure. By default all Compartment Zones are grouped together within the Compartments 

sub-section within Zones (see Figure 5-33). Right clicking on individual Compartment Zones 

within the Navigation window enables each objects corresponding context menu to be 

displayed detailing the functions available to the user. Within the context menu the user has the 

ability to display either the Arrival, Departure or Population graph corresponding to the 

selected Compartment Zone, however only one type of graph (i.e. Arrival, Departure or 

Population) can be displayed for a given Compartment Zone at any one time.  Other available 

functions also include the ability to Open and hence modify the zones properties (i.e. its name) 

or to locate (i.e. Go to) the zone within the geometry. An additional function also enables the 

user to Delete the selected zone entirely, however this function is only available within Scenario 

mode. 
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Figure 5-33: The Compartment Zone context menu within the Navigation window. 

 

5.5.1 Creating a Compartment Zone  

To create a Compartment Zone the user is first required to open the Zone Editor dialogue box 

in the same manner as when creating conventional Hazard Zones (see Section 5.3.2). Within 

the Zone Editor dialogue box the user is first required to define the type of zone to be created. 

To create Compartment Zones, the user should therefore merely set the Zone Type to 

Compartment. Any zones subsequently created (i.e. by clicking the Create button) will then be 

Compartment Zones. As with Hazard Zones, the user defines Compartment Zones by selecting 

a group of nodes and associating it to a specific Compartment Zone panel. These panels can be 

edited such that the nodes associated with them can be increased, displayed and removed (see 

Figure 5-34). As mentioned previously, these compartments may be used to collect data or can 

be used in conjunction with itineraries to define a particular task. 

 

 

 

 

 
Figure 5-34: Compartment Zone Editor dialogue box. 
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5.6 Obstacle Zones 

This function enables the user to group together sets of nodes into zones in order to dynamically 

alter the Obstacle values of their connecting arcs during the simulation. Changes within the 

Obstacle value of each connecting arc within the zone are defined by the user specifying a series 

of Obstacle Zone Events comprising a list of Obstacle values and corresponding trigger times. 

The trigger times specify when changes in the associated zones connecting arcs Obstacle values 

should take place, while the Obstacle values specify the values that they are required to adopt 

at those times. The arc Obstacle values within each Obstacle Zone can be updated either in 

discrete steps or by using linear interpolation between adjacent values within the list.  

 

5.6.1 Creating an Obstacle Zone 

To create an Obstacle Zone the user is first required to open the Zone Editor dialogue box in 

the same manner as when creating conventional Hazard Zones (see Section 5.3.2). Within the 

Zone Editor dialogue box the user is first required to define the type of zone to be created. To 

create Obstacle Zones, the user should therefore merely set the Zone Type to Obstacle. Any 

zones subsequently created (i.e. by clicking the Create button) will then be Obstacle Zones. As 

with Hazard Zones, the user defines Obstacle Zones by selecting a group of nodes and 

associating it to a specific Obstacle Zone panel. These panels can be edited such that the nodes 

associated with them can be increased, displayed and removed (see Figure 5-35).  

 

 

 

 

 
Figure 5-35: Obstacle Zone Editor dialogue box. 

 

5.6.2 Defining Obstacle Zone Events 

Once the user has created an Obstacle Zone then the zone has to have its corresponding Obstacle 

Zone Events defined. This is achieved by first selecting the required Obstacle Zone from the 

available list and then clicking the ATTRIBUTES button to display its corresponding Obstacle 

Zone Event dialogue box (see Figure 5-36). The Obstacle Zone Event dialogue box allows the 

user to enter a list of times together with the specified arc Obstacle values. The time and its 

corresponding arc Obstacle value are entered in groups of two in the times(s)+obstacle list. For 

example, the times(s)+obstacle list “2.30 3.40 5.00 5.00 7.00 1.00” means that 2.30 seconds 

into the simulation the connecting arcs within the given zone will adopt an Obstacle value of 

3.40. Then at 5.00 seconds they will adopt an Obstacle value of 5.0 and finally from 7 seconds 
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onward they will have an Obstacle value of 1.00 etc. It is important to note that at the start of 

each simulation the connecting arcs within any given Obstacle Zone will adopt an initial default 

Obstacle value of zero. If however, the user wishes to override this initial default value of zero 

they should enter the first event time as 0.0 together with the required initial Obstacle value.  

 

 
Figure 5-36: Obstacle Zone Event dialogue box. 

 

The Interpolate check box also allows the user to control how the arc Obstacle values change 

over time. If this check box is left unchecked then the Obstacle values experience stepped 

changes at the specified times (see Figure 5-37). However, if the Interpolate option is selected, 

then the arc Obstacle values instead change linearly over time between the specified values (see 

Figure 5-38). 

 

  
Figure 5-37: Interpolate option off 

resulting in stepped changes in obstacle 

value over time. 

Figure 5-38: Interpolate option on 

resulting in linear changes in obstacle 

value over time. 
Green Lines: The current Obstacle value. 

Red Lines: The user-defined Obstacle value event change. 

 

NOTE: 

Obstacle Zones will not have any effect during a simulation unless they have first been enabled 

within buildingEXODUS. This is achieved by selecting the Zone Events option within the 

Behaviour Options dialogue box (see Chapter 6). 
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5.7 Visibility Catchment Area of Signs 

The ability of individuals to be able to interact with a signage system or to be able to view the 

conditions around an exit can be simulated by the use of Sign objects placed at appropriate 

locations within the geometry (see Chapter 3).  

 

The ability to determine the visibility of signs can be of use in itself but most importantly it can 

be used in combination with advanced behaviours such as Signage Behaviour and the 

Congestion Avoidance Behaviour (see Chapter 6 and the Theory Manual). The Visibility 

Catchment Area (VCA) of a sign refers to the region from where a sign is visible. The VCA of 

a sign is then used to determine the locations from where an occupant can see that sign. The 

approach used to implement this functionality considers the visibility issue from the sign’s 

viewpoint. This is in contrast with the most apparent method, which would normally consider 

it from the occupant’s viewpoint. The latter method, although being more intuitive, is 

computationally too expensive. However, the adopted method for determining signage 

visibility can not only produce identical results relating to the level of visibility, but can 

additionally offer a range of statistics and further information relating to the efficiency of the 

signage system.  
 

To calculate the sign visibility within a geometry the user must be in SCENARIO mode and 

within the Zone Editor (see Section 5.3.2). The user should then select Visibility Signs from the 

Zone Type pull down menu (see Figure 5-39 (a)). This will bring up a new set of Control Buttons 

within the Zone Editor, together with a window for the visibility zones (see Figure 5-39 (b)).  

To calculate the VCA for all signs within the geometry the user should click on the Calc. Viz 

Signs button. This will calculate the VCA for each available sign and create a coresponding 

zone (see Figure 5-39 (c)). These zones are identical in functionality to the Hazard zones, the 

only difference being that in this instance they are used to describe the visibility level of a 

particular sign. Therefore, the method used to generate a zone remains consistent irrespective 

of the type of zone being generated. 

 

   
(a) (b) (c) 

Figure 5-39: (a) Selecting the Visibility Signs menu within the Zone Editor; (b) Calculates 

the Visibility Sign Zones (c) Visibility zones (for this geometry, there were three signs 

present) 

 

To create the VCAs for all signs present in a structure the user must press the Calc. Viz Signs 

button. As the VCAs of each sign will be calculated the user will see the Zones section being 

populated with the zones representing the VCAs of the signs that have just been created. The 
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time needed to calculate all the VCAs depends on the size and complexity of the structure. The 

larger and more complex the structure is the longer it will take to compute the VCAs of the 

signs. As an indication of the progress the first node of the currently calculated VCA is 

highlighted. 

 

To view the calculated VCA the user must firstly select a zone from the Zone List and then click 

on the Show button. As the VCAs are based on the standard EXODUS Zones i.e. they are a 

region of space represented as a collection of nodes, they can be further manipulated by the user 

in the same fashion as the Hazard Zones. Thus, if the VCA region of a particular sign has to be 

manually modified the user can use the available zone tools to add or remove nodes. Also, as 

with Hazard Zones the Zone Edit dialogue box can provide statistics such as the area covered 

by a particular VCA and its percentage of the total floor area (by clicking the Area button).  

This can be seen in Figure 5-40, where an example of the Area dialogue box relaying 

information relating to the coverage of a particular VCA is presented. Combined results can be 

obtained if the user first selects the Merged option. In this case the user can select any number 

of Visibility Zones and retrieve the available statistics for the selected Visibility Zones.  

 

 
 

Figure 5-40: Area and percentage coverage 

 

Figure 5-41(a) shows an example geometry that will be used to demonstrate the VCA 

functionality.  
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(a) Example geometry 

 
(b) VCA of exit 1 

 
(c) VCA of exit 2 

Figure 5-41: Exit visibility in a simple geometry. Note that the internal lines are 

below ceiling height.  

 

In this example a sign is assumed to be positioned at the exit location. After the VCAs are 

calculated the user can examine these VCAs by highlighting the appropriate Visibility Zone 

through the Zone Edit dialogue box. In this case the Show Polys has been used to highlight the 

VCA regions (see Figure 5-41 b and c). 

 

When calculating the VCA of a particular sign the heights of the exit sign, shelving and observer 

are taken into account (see Chapter 3). For the occupants an average height (by default a value 

of 1.75m) is assumed; however, this value is user-definable. The relative heights between 

observer, sign and obstacles can, and in many cases will, create a non-visibility shadow region 

behind obstacles. This can be seen in Figure 5-41. Point A is within the non-visibility shadow 

region of obstacle O whereas point B is within the VCA of Sign 1. Figure 5-42 shows the 

relation between observer, obstacle and exit sign in determining the visibility of a particular 

exit sign.  

 

  
Figure 5-42: Exit sign visibility behind an obstacle 
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By default every boundary line in buildingEXODUS is assumed to represent a wall that doesn’t 

allow the observer to see over or through it. This is because EXODUS does not import any 3D 

information from third party geometry files (i.e. DXF, IFC, FDS or SMF). Therefore, the user 

has to assign the heights of the obstacles in buildingEXODUS (within buildingEXODUS, 

shelving and other obstacles can be represented by lines of chosen height; see Chapter 3). If the 

obstacle heights have been specified then they will be taken into account as described earlier.  

 

The maximum physical extent of a VCA is based on the distances set down by standards or 

regulation. This distance however can also be a user definable quantity that can be changed 

according to the nature of the local regulations and the nature of the signage system being 

simulated. As an example of this, the NFPA Life Safety Code Handbook suggests that when 

the exit lettering has a height of 15.2 cm it is legible for up to a distance of 30m [105]. To extend 

the visibility of a sign the letter height can be increased (see Chapter 3). The NFPA Life Safety 

Code [105] suggests that the relationship between the lettering height and the visibility distance 

is linear, so if the lettering height of the sign is doubled the visibility distance doubles as well.  

It is worth noting that these regulations and standards inherently assume that the visibility 

distance is the same (and at a maximum) irrespective of the observation angle to the sign i.e. 

the angle between observer and sign.  When calculating a VCA buildingEXODUS uses the 

observation distances suggested by the regulations and standards only to determine the 

maximum observation distance but not the actual size and shape of the VCA. Research 

conducted by FSEG [131] has shown that the size and shape of the VCAs is ultimately 

dependent on the observation angle. The size and shape of a VCA for a particular sign assuming 

that there are no obstacles limiting the VCA has been determined to be circular, tangent to the 

centre of the sign and with a diameter equal to the visibility distance that the regulations and 

standards suggest. Figure 5-43 demonstrates the different VCA regions calculated by the two 

methods. The regulations assume that observation angle has no impact on VCA size and shape 

represented in the diagram by area M1. However, the experimental study conducted by FSEG 

indicated a strong dependence to the observation angle. The sign can be seen from the maximum 

visibility distance when observed from 0 degrees. As the angle increases, so the occupant needs 

to be closer to the sign in order to discern the information relayed by the sign. This reliance to 

observation angle is represented on the diagram by area M2.  
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Figure 5-43: The composition of a sign object and the VCA produced.  

 

Furthermore, one of the factors affecting the extent of Visibility Catchment Areas for a 

particular geometry is the value assumed for the average occupant height. By default the 

average occupant height is set to 1.75m; however, the user can additionally either specify an 

average occupant height or can allow buildingEXODUS to calculate the actual average 

occupant height based on the population residing within the structure. While the later method 

represents the characteristics of the current population allowing the user to enter their own value 

has the advantage of determining possible minimum and maximum boundaries for the VCAs. 

By entering either a low or a high value the user can determine the respective minimum and 

maximum extent of the visibility of the signage system. To access this option the user must 

select the Avg. Occupant Height button located on the Zone Editor dialog box. This will bring 

up the Average Population Height dialogue box (see Figure 5-44). Initially a default value of 

1.75m will appear. The user can either enter a value manually or alternatively press the 

Calculate button and let buildingEXODUS determine the average occupant height from the 

current population. Once buildingEXODUS determines the average height the Calculate button 

will be disabled indicating to the user that the operation has taken place. Manually changing 

the average height will enable again the Calculate button.  

 

 
Figure 5-44 The Average Population Height dialogue box 
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5.8 Exit Performance Characteristics 

Exit operating characteristics are an important factor influencing evacuation performance. 

These characteristics can be specified and modified in scenario mode. Exit operating 

characteristics cover four main areas, namely,  

 

 Flow capabilities (see Section 5.8.1) 

 Exit Event Times (see Section 5.8.2) 

 Exit Potentials (see Section 5.8.3) 

 Exit Attractiveness (see Section 5.8.4) 

 

To specify or modify any of these characteristics it is first necessary to open the Exit dialogue 

box by double-clicking on the exit (see Figure 5-45). 

 

 
Figure 5-45: Exit Dialogue Box 

 

5.8.1 Exit Flow Capability 

In buildingEXODUS, both external and internal exit flow capability (measured in 

occupants/second) is determined by exit width and the behaviour rules.  The maximum 

allowable exit flow capability is prescribed by the product of the width of the exit and the user 

assigned UFR, measured in occupants/metre width/second (occ/m/s, see the Theory Manual). 

 

Indicated in Figure 5-45 are the three areas associated with the UFR.  The exit UFR has been 

characterised and measured by a number of researchers and several accepted values appear in 

the literature, including those specified by Hankin, Polus and Fruin (see the Theory Manual). 

Furthermore, acceptable exit UFRs are often specified by building regulatory authorities as part 

of the national building codes (e.g. HMSO). 

 

The user may select any one of these accepted values by clicking the unit flow rate list box.  

The values attributed to each item on the list are then displayed on the left hand side of the 

dialogue box - marked “Flow Rate” (see Figure 5-45).  The values shown are an upper and 

lower bound (maximum and minimum).  In most cases these two bounds are identical.  The 

user then has the option of modifying the literature value adding a percentage to the upper and 

lower bounds - marked Flow Rate Modifiers (see Figure 5-45).  The actual UFR then used for 
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the exit is then displayed as Actual Flow Rate (see Figure 5-45).  This is simply the UFR with 

the percentage modifiers taken into account.   

 

NOTE: 

The default setting for exit UFR is HMSO (1.33 occ/m/s). 

 

The user also has the option of defining a completely new UFR.  To accomplish this, select 

User Defined from the UFR list box. 

 

When the minimum and maximum flow rate values differ, buildingEXODUS assigns a random 

number between the specified values when each occupant uses the exit.  For this reason, it is 

suggested that the percentage modifiers be used as this situation is more realistic than simply 

specifying a constant flow rate. 

 

5.8.2 Exit Opening/Closing Times 

The user has the option of specifying opening and closing times for each exit.  Connected with 

this is the ability to make an exit active or inactive.  Occupants will queue at an active exit 

regardless of whether it is open or not.  Similarly, occupants will ignore an inactive exit 

regardless of the opening status of the exit.  To control the opening dynamics of an exit, three 

attributes must be addressed, namely, 

 

(a) Exit Status, 

(b) Exit Activity, and 

(c) Opening/Closing Times. 

 

(a)  Exit Status (default - OPEN):  

This attribute sets the INITIAL status of the external exit. Three options are available, OPEN, 

CLOSE and OFF.  If set to OFF, the exit effectively does not exist throughout the simulation 

i.e. all opening/closing times will be ignored. If set to CLOSED, occupants will not be able to 

pass through the exit.  When set to OPEN, any occupants queuing may pass through.  In 

simulation mode, this attribute is dynamic, changing as a result of any opening/closing times 

set by the user.  To change the initial status of the exit, simply click on the status list box (see 

Figure 5-45) and select either OPEN or CLOSE. 

 

(b)  Exit Activity - ACTIVE attribute (default - YES) -  

Two options are available for this attribute - YES and NO.  If NO, (i.e. exit inactive), an exit 

will be ignored by occupants i.e. occupants will not be attracted to the exit.  If the active attribute 

is YES (i.e. exit is active), occupants will be attracted to the exit and queue, even if it is closed. 

It is only possible to set the initial exit status, using this attribute.  To set the exit status, simply 

click on the status list box in the exit dialogue box (see Figure 5-45) and select the appropriate 

option.  It should be noted that an interaction exists between exit opening/closing times and exit 

status.  The nature of this interaction is explained in the Theory Manual. 
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Figure 5-46: Exit Opening/Closing times dialogue box 

 

(c)  Opening/Closing Times (Event Times) - (default - undefined) -  

To gain access to the Times dialogue box, click the TIMES button on the exit dialogue box (see 

Figure 5-45).  This produces the dialogue box illustrated in Figure 5-46. 

 

The Event Times box allows a list of times to be given, separated by either spaces or commas.  

As the simulation clock reaches each event time, the exit changes its status.  If closed, the exit 

becomes open, and vice versa.  Thus if the initial status of an exit is "open", the first event time 

will cause the exit to close, the second to open and so on. 

 

To accept the list of event times, click the ENTER button. 

 

The other fields in the EDIT DOOR TIMES dialogue box are used in Simulation mode only.  

They are dealt with in Section 6.7.3.  

 

NOTE: 

It should be remembered that the External and Internal Exits are lane based and therefore 

function according to lanes of 0.5m. 

 

NOTE: 

The user is only able to impose the Exit activity at the beginning of the simulation.  However, 

the status of the Exit Activity may alter during the simulation due to the Opening and Closing 

times attributed by the user.  

 

TIP: 

Keep the number of event times for each exit down to a minimum as each event requires the 

potential map to be re-calculated - a substantial overhead in large geometries. 

 

5.8.3 Potential (Using the Potential Map System) 

The exit potential for an external exit seeds the overall potential map - it reflects the catchment 

area of the exit on the potential map (see the Theory Manual). The seeding of the potential map 

will have no impact upon the use of the Target Exit system or the use of the Local Familiarity 

system.  For internal exits, the exit potential can be used to control the potential map within the 

compartment concerned.  The higher the exit potential, the less attractive the exit becomes, as 

occupants head for positions of lower potential (see the Theory Manual).  The default value for 

the exit potential of all exits is 100.0 i.e. all exits are equally attractive.  To make an exit more 

attractive, its exit potential must be decreased relative to the other exits. 
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Figure 5-47:  Example geometry consisting of four exits 

 

To alter the exit potential of an exit, place the cursor in the exit potential box in the exit dialogue 

box (see Figure 5-45) and modify.  For example consider the geometry shown in Figure 5-47. 

 

In this geometry there are four exits, each with an equal exit potential.  This can be demonstrated 

using the MAP function found in the external door dialogue box in SCENARIO mode.  The 

map function allows the catchment area of an exit to be viewed.  To see the catchment area of 

an exit, click the MAP button on the exit dialogue box (see Figure 5-45).  When the map 

function is accessed for an exit, an outline is drawn around each node in the catchment area of 

the exit.  In Figure 5-48, the map function has been accessed for Exit1 and Exit4.  Note that the 

catchment areas are the same size.  In Figure 5-48b, the exit potential for Exit1 has been 

decreased to 95.0, thus making the catchment area for Exit1 far larger.  This process is called 

biasing an exit. 

 

 
Figure 5-48: Map functions when (a) four exits with identical -potentials and (b) one exit 

(exit 1) has a biased potential 

 

5.8.4 Exit Attractiveness (Using the Local Familiarity) 

The Exit Attractiveness attribute refers to the probability that an occupant will be aware of the 

existence of this exit (see Figure 5-45).  This feature is only used if Local Familiarity option 

(Rule Base Switch set via the BEHAVIOUR CONTROL dialogue box in SIMULATION mode, 

see Chapter 6) is selected and the occupant has not had an Occupant Exit Knowledge manually 

assigned to them in Population Mode (see Chapter 4 and the Theory Manual).  The Exit 

Attractiveness figure is interrogated by each occupant individually to determine whether they 

are aware of a particular exit.  The decision to assign an exit to an occupant's exit knowledge is 

based on comparing the Exit Attractiveness for the exit with a random number generated for 

each occupant and for each exit.  If the Exit Attractiveness is greater than the random number, 
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the exit is assigned to the occupant.  This process is conducted prior to each simulation. As a 

result of this method of assigning exit knowledge, the occupant’s familiarity will fluctuate from 

simulation to simulation, according to the results of this comparison.  

 

NOTE: 

The interrogation of the Exit Attractiveness will only occur if the Local Familiarity switch has 

been activated in Simulation Mode, and the occupant has not been attributed with an exit 

knowledge previously. 

 

NOTE: 

If the occupants in a simulation have not had an Occupant Exit Knowledge manually assigned 

to them and the default Exit Attractiveness has not been altered and the Local Familiarity 

option has been selected, then the resulting behaviour will resemble that observed under 

nearest exit usage.  

 

If the occupant is aware of the exit, it will appear in their exit list and will provide a viable 

option during the simulation (see Chapter 4). The larger the Exit Attractiveness figure assigned 

to an exit by the user (to a maximum of 100), the more likely that the occupant population will 

be aware of the exit.  A figure of 0 will prevent any of the occupant population from being 

aware of the exit. The eventual likelihood of adopting the exit as a target will then be dependent 

upon the occupant’s initial distance from the exit, the exit type and the occupant initially being 

aware of the exit.  

 

 
Figure 5-49: Exit attractiveness in simple geometry. 

 

Unlike the type of catchment area generated in examples such as that seen in Figure 5-48, the 

exit adoption exhibited whilst using the Local Familiarity (based on the Occupant Exit 

Knowledge) system is not entirely dependent upon the occupant’s initial location. If the exits 

within a geometry are defined as in Figure 5-49, then far more complex modes of behaviour are 

exhibited.  This reflects the fact that the occupant’s decision, although still based upon their 

distance from the exit is primarily affected by their knowledge of the existence of the exits.  

From Figure 5-50, there are no distinct catchment areas visible that describe the exit usage.  

Instead, exit usage is initially dependent upon the occupant being aware of the exit and then 

their proximity to the exit. 
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(a) Usage of Door_1 (b) Usage of Door_3 

  
(c) Usage of Door_2 (d) Usage of Door_4 

Figure 5-50: Exit usage displayed using the Locate Button, accessible via the exit 

dialogue box. Each square denotes the starting location of an evacuee using the exit. 

 

Generally, the extent of the exit usage reflects the attractiveness of the exit. The correlation of 

the exit’s attractiveness and the exit’s use will be dependent upon the specific scenario being 

examined. However, the likelihood of the occupants using each exit will be affected by but not 

determined by their initial location. 

 

NOTE:  

Negative numbers will not be accepted within the Attractiveness text box. Numbers greater than 

100 will automatically be converted to 100, effectively guaranteeing the awareness of the 

evacuee population. 

 

NOTE:  

The Exit Attractiveness attribute will only have an impact on the occupant exit choice if the 

Local Familiarity is enabled in the BEHAVIOUR OPTIONS dialogue box, selected from the 

RuleBase menu in SIMULATION mode. If the potential map system is used, or the occupant is 

attributed with a target exit, this figure will have no effect. 

 

5.8.5 Internal Exits  

In some enclosures containing internal compartments, the global potential map may not be 

sufficient to control the exiting behaviour within the internal compartment.  For example, 

occupants may be forced to use an unlikely internal exit.  Furthermore, the flow rate through 

the internal exit may require some control, as is provided with external exits.  The user may 

also wish to restrict the availability of internal exits during the simulation. These facilities are 

provided through the use of Internal Exit nodes, defined within the internal exit opening. These 

are specifically designed to represent internal exits in a manner consistent with the 

representation of External exits.  It is also possible to represent internal exits using 

Attractor/Discharge nodes (see Section 5.9.1).  However, this approach is not recommended as 

they have a reduced level of functionality and this method is not consistent with External exits.  
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5.8.5.1 The Performance of Internal Exit Nodes 

Initially, internal openings are essentially free-space nodes. To model internal exits, the user 

must replace each of the normal free-space nodes in the internal exit with a pair of Internal Exit 

nodes as described in Chapter 3, using the Generate/Internal Exit function in Geometry mode. 

This will then be the area in which the potential may be modified, the availability can be 

manipulated and a UFR can be specified, restricting evacuee flow.  

 

(a) Internal Exit Potential 

By using a pair of Internal Exit nodes and thereby biasing the internal door, behaviour within a 

compartment may be modelled more realistically. Internal Exit nodes function by redefining 

the potential map in their area. However in this case, two nodes are required to model the exit.  

In the example shown in Figure 5-51, two internal exits can be seen, both 1m wide (two nodes 

across the width). This process is described in more detail in Chapter 3. The Exit Potential that 

is applied to the internal exit will spread across the entire exit.  Once a constituent node has 

been selected and the INTERNAL EXIT dialogue box is open, any changes made will affect the 

entire internal exit. This is true of all of the performance related attributes described in this 

section. Through biasing the potential map on internal exits in such a manner, it will be possible 

for the user to make an internal exit less/more attractive to the evacuees within a compartment. 

For instance, in Figure 5-51, although Internal Exit 1 is closer to the external exit, its potential 

may be raised so that the localised potential map is altered, encouraging evacuees in the 

compartment to use Internal Exit 2. It is recommended that the Internal Exits are fully 

connected (i.e. horizontal, vertical and diagonal arcs are connected), providing the evacuee with 

a greater degree of movement through the exit. 

 

 
Figure 5-51: Internal Exits in buildingEXODUS 

 

NOTE:  

Biasing the potential map within an internal compartment through the use of Internal Exits will 

only affect evacuee navigation if the Potential Map system is used and if the Local Potential 

option is enabled in the Behaviour Control dialogue box, see Chapter 6. 

 

(b) Internal Exit UFR 

The maximum allowable exit flow capability is prescribed by the product of the width of the 

exit and the user assigned UFR, measured in evacuees/metre width/second (occ/m/s). There are 

three areas associated with the UFR of an internal exit (the Unit Flow Rate, the Minimum (Min) 

and Maximum (Max) flow rate fluctuations).  The exit UFR has been characterised and 

measured by a number of researchers and several accepted values appear in the literature 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 297 

including those specified by Hankin, Polus and Fruin (see the Theory Manual). Furthermore, 

acceptable exit UFRs are often specified by building regulatory authorities as part of the 

national building codes (e.g. HMSO).  

 

 
Figure 5-52:The Internal Exit dialogue box.  

 

The user may select any one of these accepted values by clicking the unit flow rate list box.  

The values attributed to each item on the list are then displayed on the left-hand side of the 

dialogue box - marked Flow Rate (see Figure 5-52).  The values shown are an upper and lower 

bound (maximum and minimum).  In most cases these two bounds are identical.  The user then 

has the option of modifying the literature value adding a percentage to the upper and lower 

bounds - marked Min and Max flow rate modifiers (see Figure 5-52).  The actual UFR then 

used for the exit is then displayed (to the far right of the Min and Max values, see Figure 5-52) 

and simply the UFR with the percentage modifiers taken into account.  The user also has the 

option of defining a completely new UFR.  To accomplish this, select User Defined from the 

UFR list box. 

 

When the minimum and maximum flow rate values differ, buildingEXODUS assigns a random 

number between the specified values when each evacuee uses the exit.  For this reason, it is 

suggested that the percentage modifiers are used as this situation is more realistic than simply 

specifying a constant flow rate. 

 

(c) Internal Exit Availability 

Again, control over the opening and closing times of an Internal Exit constructed using Internal 

Exit nodes are established in an identical fashion to external exits. The user has the option of 

specifying opening and closing times for each internal exit.  Connected with this is the ability 

to make an exit active or inactive.  Evacuees will queue at an active internal exit regardless of 

whether it is open or not.  Similarly, evacuees will ignore an inactive internal exit regardless of 

the opening status of the exit.  To control the opening dynamics of an exit, three attributes must 

be addressed, namely, 

 

(i) Exit Status-(default - OPEN): This attribute sets the initial status of the internal exit. Three 

options are available, Open, Close and Off.  If set to OFF, the exit effectively does not exist 

throughout the simulation i.e. all opening/closing times will be ignored. If set to CLOSED, 

evacuees will not be able to pass through the exit.  When set to OPEN, any evacuees queuing 

may pass through.  In simulation mode, this attribute is dynamic, changing as a result of any 

opening/closing times set by the user.  To change the initial status of the exit, simply click on 

the Status list box (see Figure 5-52) and select either OPEN or CLOSE. 
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(ii) Exit Activity- - ACTIVE attribute (default - YES) - Two options are available for this 

attribute - YES and NO.  If NO, (i.e. internal exit inactive), an internal exit will be ignored by 

evacuees i.e. evacuees will not be attracted to the internal exit.  If the Activity attribute is YES 

(i.e. internal exit is active), evacuees will be attracted to the internal exit and queue, even if it 

is closed. It is only possible to set the initial exit status.  To set the exit status, simply click on 

the Status list box in the Internal Exit dialogue box (see Figure 5-52) and select the appropriate 

option.  It should be noted that an interaction exists between exit opening/closing times and exit 

status. 

 

(iii) Opening/Closing Times- (Event Times) - (default - undefined) - To gain access to the 

DOOR TIMES dialogue box, click the TIMES button on the INTERNAL EXIT dialogue box (see 

Figure 5-52 ). This spawns the Internal Exit Times dialogue box (see Figure 5-53). The Event 

Times box allows a list of times to be given, separated by either spaces or commas.  As the 

simulation clock reaches each event time, the internal exit changes its status.  If closed, the exit 

becomes open, and vice versa.  Thus if the initial status of an exit is open, the first event time 

will cause the exit to close, the second to open and so on. 

 

 
Figure 5-53: Internal Exit event time dialogue box. 

 

To accept the list of event times, then user must click the ENTER button. The CANCEL button 

simply ignores any of the times entered in the Event times text box and removes the dialogue 

box from the screen. 

 

(d) Direction 

One of the features of the Internal Exit is that they allow evacuees to traverse them in both 

directions. This is particularly useful if the user is interested in examining numerous circulation 

patterns within a structure. However, this does not represent simultaneous bi-directional flow. 

The user may control the direction in which evacuees are attracted towards Internal Exits, 

through the use of the Direction attribute. This determines the manner in which the Internal 

Exit affects the spreading of the Potential Map. By altering the direction of evacuee attraction 

from Forward to Reverse (or visa versa) the direction in which the evacuees use an internal exit 

can be manipulated.  

 

NOTE: 

Simultaneous bi-directional flow through an Internal Exit can occur but will involve the use of 

more than one navigational system. There are no circumstances in which simultaneous bi-

directional flow can occur when using the Potential Map alone. 
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Figure 5-54: Control of flow direction. 

 

Evacuee movement is calculated according to the evacuee's distance from Internal Exits and 

from External Exits. This calculation takes into consideration the direction of the Internal exit. 

Evacuees move towards the nearest exit point (Internal or External) that flows away from them. 

Therefore by manipulating the direction of the flow of the Internal Exit, the user can determine 

the members of the population who are affected by an Internal Exit. This can be explained 

through the following example. The geometry in Figure 5-55(a) is separated into two rooms 

connected by two Internal exits. Each of the rooms has an external exit connected to it. (In this 

example all of the exits are equally biased.) If the Local Potential option is disabled the 

evacuees move directly towards their nearest exit. If the Local Potential option is enabled, the 

presence of the Internal Exits will affect the potential map. If the Internal exits are both 

attributed with the Forward direction then the evacuees move as described in Figure 5-55(b). 

The evacuees move towards the nearest exit point (be it an Internal or external) that is flowing 

away from them. (An External exit always flows away from an evacuee). If the direction of the 

northern Internal Exit is reversed, then the catchment area affected by the exit is altered (see 

Figure 5-55(c)). 

 

   
(a) (b) (c) 

Figure 5-55: Internal exit example. (a) The geometry. (b) Forward movement. (c) The 

northern exit with the direction reversed. 

 

NOTE: 

The impact of the direction of Internal exit usage is scenario specific. 

 

Once Internal Exits are created and the simulation is started, the model estimates the flow 

Direction of Internal Exits according to their distance and location to External exits. The initial 

Direction of an Internal exit will be towards the nearest External exit. In the vast majority of 

cases this will satisfactorily represent the expected evacuee movement. However, it is 

recommended that the user examines this process. If the model generates anomalous evacuee 
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behaviour or behaviour that is not consistent with the requirements of the user, then the user is 

advised to reverse the Direction of the Internal Exit. 

 

The Direction can be used in conjunction with the biasing of the exit potential. Therefore not 

only can the user manipulate the direction of the exit's influence, but can also determine the 

extent of the exit's influence. 

 

5.9 Metered Internal Door Flow 

The Metered door flow option prevents more than one person at a time using an internal exit, 

thereby simulating specific types of exit. To enable this option the user should select either For. 

Meter (Forward metered) or Rev. Meter (Backward metered) from the internal door’s Direction 

attribute (see Figure 5-56). The forward and backward metered options are similar to the normal 

Forward and Backward options for internal doors, however, in addition they also restrict the 

use of the door to one person at a time.  

 

 
Figure 5-56: Internal exit dialogue box. 

 

Note that the Forward and Backward options only affect the potential map. Therefore this 

aspect of the functionality will be ignored if the population is not following the potential map 

during the simulation (e .g. if the population has an itinerary associated to it). The metered 

aspect of the component will function irrespective of the navigational system used.  
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Figure 5-57: An example of the application of metered flow. 

 

An example of the application of metered flow to internal doors is shown in Figure 5-57 (in this 

case used to simulate ticket gates). From this diagram it is apparent that only one person at a 

time is occupying the internal doors, as anticipated. 

 

5.9.1 The Performance of Attractor/Discharge nodes 

These are essentially Free-Space nodes where a modified potential and a UFR can be specified. 

To manipulate the movement of evacuees or to model internal openings, the user must replace 

the normal free-space nodes with a pair of Attractor/Discharge nodes.  

 

The primary role for Attractor/Discharge nodes is to manipulate the movement of evacuees 

through complex areas of a geometry, or through areas where the evacuee movement is not 

satisfactorily represented by the potential map. However, Attractor / Discharge nodes can also 

be used in much the same way as Internal Exit nodes to control evacuee movement through 

internal openings. Attractor/Discharge nodes work by redefining the potential map in their area, 

much the same as an External exit point and Internal Exit nodes. A simple rule can be applied 

when creating internal exits using Attractor/Discharge Nodes, “Evacuees travelling out of a 

compartment must be ATTRACTED to the exit point.”  Attractor nodes are shown in 

buildingEXODUS as dark-blue rectangles, and Discharge nodes as red rectangles.  When 

connecting Attractor nodes to Discharge nodes, it is essential that diagonal arcs are not used 

(in contrast to when using Internal Exit nodes where full connectivity is recommended). The 

use of Attractor/Discharge nodes is not limited to internal exits but are primarily designed to 

re-seed the potential map, enabling more realistic behaviour. 

 

NOTE: 

Evacuees will always attempt to find a Discharge node when standing upon an Attractor node 

- it is vital that all Attractor nodes have a Discharge node attached. This presents limitations 

in bi-directional flow that are discussed in the Application Manual, Chapter 2. 

 

(a) Potential manipulation using Attractor/Discharge nodes. 

Although both Discharge and Attractor nodes are required to exert control over evacuee 

movement, only the Attractor nodes are modified to control the potential map.  This can only 

be modified in SCENARIO MODE.  The potential of an Attractor node can be modified by 

double-clicking on it. It should be noted that each Attractor node can have its potential adjusted, 

even if a number of them are adjacent to each other. This differs from the Internal Exit nodes 

that, once connected, form a single entity. Note that the changes are only made when the OK 
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button is clicked. The individuality of Attractor/ Discharge nodes is particularly useful in 

modifying the potential map in corridors, where Attractor/Discharge nodes can be stretched 

across, encouraging evacuees towards the centre of the corridor. This might not necessarily be 

the case if left entirely to the potential map.  

 

 
Figure 5-58: Attractor Node dialogue box  

 

NOTE: 

The Attractor Node potential is entirely independent of any other potentials that are set.   

 

NOTE: 

The Attractor node potential is ignored and lost if the Local Potential option is switched off in 

the BEHAVIOUR OPTIONS dialogue box (see Chapter 6). 

 

 
Figure 5-59: Biasing of the Attractor nodes. 

 

An important difference exists between the manipulation of the Potential of Attractor nodes 

and that of Internal Exit nodes.  The Attractor node can be biased individually so as to control 

evacuee movement at a small scale. This might involve keeping the evacuee towards the centre 

of a corridor, rather than allowing the global potential map dragging towards one side of a 

corridor. The Internal Exit nodes are used to represent the attractiveness of exits rather than 

areas within the exit. Therefore within each Internal Exit, every node is equipotential, allowing 

comparison to be made between internal exits but not within internal exits. This is more clearly 

evident if Figure 5-59 is examined. In it the biasing of the Attractor nodes has encouraged the 

evacuee movement towards the centre of the corridor. 
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(b) Unit Flow Rates applied to Attractor nodes. 

As with the application flow rates in other areas, unless the flow rate is capped, the flow 

capability (measured in OCC/M/S) is determined by the opening width and the behaviour rules.  

This leads to the so-called free-flow condition.   

 

However, in addition to the free-flow condition, it is possible to specify the maximum allowable 

exit flow capability for the opening or corridor. This can be prescribed by the product of the 

width of the opening and the user assigned UFR, measured in occupants/metre width/second 

(occ/m/s) (see the Theory Manual, Section 7.2.3.6.2). 

 

However, unlike Internal Exit nodes, pre-defined UFRs are not provided. The user must specify 

the desired maximum and minimum UFR to be imposed. When the minimum and maximum 

flow rate values differ, buildingEXODUS assigns a random number between the specified 

values when used.  

 

The UFR is specified on each of the Attractor nodes.  This can only be achieved in Scenario 

mode.  To specify the UFR, double-click each Attractor node and specify the Min and Max 

UFR fields as required (see Figure 5-58).  Note that the changes are only made when the OK 

button is clicked. 

 

NOTE: 

In order to correctly limit the maximum flow rate through an opening, it is important that the 

Width field in the Attractor nodes across the exit are checked for accuracy in GEOMETRY 

MODE (see Section 3.2 and Section 5.16.1). It should be remembered that if not specifically 

assigned, the width of each of the Attractor nodes will be automatically calculated as being the 

average of the vertical and horizontal connected arcs. 

 

5.10 The MAXP Function and the associated Estimated Travel Time 

buildingEXODUS produces statistics relating to the maximum path that an individual might be 

expected to travel and the time that it might take him to do so. This calculation is conducted 

before the simulation is performed, although the relevant procedures will have previously had 

to have been set (i.e. the user will have previously moved to Simulation mode, selected the 

procedure and then returned to Scenario mode). The figures generated represent estimates for 

the eventual times that will be produced and should be regarded as such. The maximum travel 

distance might be considered in deciding whether a structure meets or fails the safe egress 

requirement or may be of interest when comparing different structure designs. It is available 

from the MaxP button from the External Exit dialogue box (see Figure 5-60). The nature of this 

calculation is dependent upon the procedure implemented.  
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Figure 5-60: The MAX PATH dialogue box 

 

buildingEXODUS uses this calculation to then estimate a value for an arrival time at the point 

specified. Again, this calculation will depend on the procedure chosen in Simulation mode.  

 

buildingEXODUS is capable of estimating the maximum travel distance in an arbitrarily 

complex structure (e.g. several floors with many internal compartments). Due to the nature in 

which the maximum travel distance is calculated, this distance can be over estimated by as 

much as 4%. Once the maximum travel distance is calculated in this manner, the calculation 

may be refined (clicking on the REFINE button), thus decreasing the error.  As the compartment 

has an exit point with a connectivity to a single node (i.e. an effective ‘width’ 0.5m), the 

maximum travel distance for this compartment is the hypotenuse of a triangle with opposite 

side 4.75m and adjacent side 12m, i.e. 12.91m. Thus the actual maximum travel distance for 

this compartment is determined to be 12.91m. 

 

NOTE:  

The Refine option is only available when the geometry is viewed in Boundary mode. 

 

The refined maximum distance calculation can only be used in situations where the node 

spacing on the grid is to scale - for example when the Node Flood function has been used, or a 

regular mesh geometry has been made.  The maximum error that might be accrued is dependent 

upon the number of changes in direction of the path and the length of each part of the path.  

Typically, the longer the path, the smaller the relative error.  

 

TIP: 

The refined estimate of maximum travel distance is best used where the boundary of the 

structure has been imported from third party geometry files (i.e. DXF, IFC, FDS or SMF). 

 

5.10.1 Maximum Travel Distance Calculation. 

In most prescriptive building codes, the maximum travel distance is considered a key factor in 

deciding whether a building meets or fails the safe egress requirement. For this reason, 

buildingEXODUS locates the most remote location within the geometry and estimates the 

travel distance to the nearest exit. This value is known as the maximum travel distance (see 

Figure 5-61) i.e. the maximum travel distance to the nearest exit. Using the most remote 

location, buildingEXODUS also calculates the distance to each of the other exits. These are 

also displayed in the MAXP dialogue box (see Figure 5-61). This information is of interest 

should the nearest exit become inaccessible.  buildingEXODUS also displays the path from the 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 305 

most remote location to the nearest exit, an example for a simple square enclosure is shown in 

Figure 5-61. 

 

 
Figure 5-61: An example of maximum travel path. 

 

buildingEXODUS is capable of estimating the maximum travel distance in an arbitrarily 

complex structure (e.g. several floors with many internal compartments). Due to the nature in 

which the maximum travel distance is calculated, this distance can be over estimated by as 

much as 4%. 

 

Once the maximum travel distance is calculated in this manner, the calculation may be refined, 

thus decreasing the error.  Consider the example shown in Figure 5-62.  In this example, the 

enclosure measures 5m x 12m with a 0.5m wide door in the bottom right hand corner of the 

room.  

 

Using conventional measurement procedures, the maximum travel distance is calculated from 

the most remote location (in this case the corner of the room) to the centre of the door. As the 

compartment has a door of width 0.5m, the maximum travel distance for this compartment is 

the hypotenuse of a triangle with opposite side 4.75m and adjacent side 12m, i.e. 12.91m. Thus 

the actual maximum travel distance for this compartment is determined to be 12.91m. 

 

As can be seen in Figure 5-62, buildingEXODUS estimates the maximum travel distance to be 

13.36m, an error of 3.5%.  By clicking the REFINE button a more accurate estimate is 

calculated which is 12.85m, producing an error of 0.4%. 

 

The refined maximum distance calculation can only be used in situations where the node 

spacing on the grid is to scale - for example when the Node Flood function has been used, or a 

regular mesh geometry has been made.  An example of this function being used on a real 

geometry - a hospital, can be found in Figure 5-63. The maximum error in this case is dependent 

upon the number of changes in direction of the path and the length of each part of the path.  

Typically, the longer the path, the smaller the relative error.  

 

TIP: 

The refined estimate of maximum travel distance is best used where the boundary of the 

structure has been imported from third party geometry files (i.e. DXF, IFC, FDS or SMF). 
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Figure 5-62: Maximum travel distance refinement 

 

 
Figure 5-63: Refined maximum path function applied to a complex geometry 

 

NOTE:  

The Refine option is only available when the geometry is viewed in Boundary mode. 

 

5.10.2 Estimation of Evacuation Time. 

buildingEXODUS offers the user an estimation of the total evacuation time (ETET) - without 

the need to run a simulation.  This calculation uses a conventional engineering approach and as 

such generally under-predicts the actual total evacuation time. To estimate the evacuation time, 

buildingEXODUS uses the following formulation,  

 

ETET = Tdist + Tflow 

Where, 

Tdist = the time taken for the slowest occupant to traverse the maximum travel distance, 

and  

Tflow = the time taken for the entire population to pass through the available exits. 

 

To determine Tdist, the previously calculated maximum travel distance (see Section 5.10.1) is 

divided by the travel speed of the slowest person in the population. 

 

To calculate Tflow, buildingEXODUS simply takes the UFR for each external exit (measured in 

occupants/metre width/second) and multiplies this figure by the corresponding exit width.  Thus 

the overall flow capability of the enclosure can be calculated by summing the flow capability 

for each exit (measured in occupants/second).  For example, consider an enclosure with two 

exits, one being 4m in width with a UFR of 2.0 occ /m/s and the other 2m wide with a UFR of 
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1.5 occ/m/s.  The flow capability of the first exit can be calculated as 4.0 * 2.0 = 8 occupants/s, 

and the second as 2.0 * 1.5 = 3 occupants/s.  Thus the total exit capability for such an enclosure 

would be 8 + 3 = 11 occupants/s.  Finally, Tflow is determined by dividing the total flow 

capability by the total population size.  For example, if the enclosure described above had 40 

occupants, Tflow = 40 / 11 = 3.64s. 

 

The Tflow calculation takes no account of occupant-occupant interactions during the evacuation. 

It also assumes perfect queuing at each exit and that the population is perfectly distributed 

between each exit so that all exits finish at the same time. 

 

NOTE: 

Where UFRs have different upper and lower values, the average of the two values is taken. 

 

NOTE: 

Where UFRs > 10 occ/m/s are specified (effectively free-flow conditions), the Tflow calculation 

assumes the HMSO UFR, i.e. 1.33 occ/m/s. 

 

5.11 Source Nodes 

With the introduction of the Source node into the model, the user is now far better placed to 

represent circulation behaviour, rather than being limited to emergency/non-emergency egress. 

The Source node capability enables the user to dynamically generate individuals at any stage 

of the simulation. Coupled with the ability to end the simulation when desired (see Chapter 6) 

this provides a powerful new mechanism by which to extend, contract and control the 

movement of the simulated individuals. 

 

A simplistic means by which to implement Source nodes was described in Chapter 3. This 

mechanism provided a limited amount of control for the user over the population being 

generated; the population generated contained default occupants. In the proceeding section, a 

more complex mechanism is described whereby the user has a much greater control over the 

nature of the population being generated, the actions that they are expected to perform and the 

frequency with which they are generated. 

 

NOTE; 

A consequence of the introduction of the Source node capability is that it is no longer necessary 

for the user to generate occupants in Population mode before progressing onto Scenario mode.  

 

The user is required to have generated Source Nodes in the appropriate locations whilst still in 

Geometry Mode (see Chapter 3). In addition any of the Panel Populations that are to be 

associated with the Source Nodes should have already been generated in Population Mode (see 

Chapter 4). The Source Node Control dialogue box allows the user to assign populations, 

together with their associated set of itineraries, the minimum and maximum generation rate, 

plus start and end times of the generation period (see Figure 5-64).  
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Figure 5-64: Source Node Control Dialogue Box 

 

The user should click on the Source node, giving them access to the Source Node Control 

dialogue box. The Adv button (advanced features) should be clicked to gain access to the Source 

Node Control dialogue box. Clicking the Append button generates an empty scenario (i.e. one 

that has not had a panel population or an itinerary associated to it). To assign a panel population 

the user should click on one of the ‘Pop’ panels, which will then cause the Pop Selection 

dialogue box to be displayed. The user then has to select one of the panel populations from the 

list of those previously generated in Population mode.  If the user doesn’t specify one of these 

panel populations the default random person is used to generate individuals from the Source 

Node. Each panel population can have a number of itineraries associated to it; a single 

population can have a number of itineraries associated with from which they will have an 

associated probability of being allocated one of them. To access the Itinerary Control dialogue 

box click on a itinerary panel, in much the same manner as the user gained access to the Pop 

Selection Control dialogue box earlier.  

 

NOTE: 

A Source Node can be associated with a specific population in the Source Node Control 

dialogue box. This population should include at least one population panel describing the 

characteristics of the people that will be generated by the source node at run time. When 

creating the population panels the user should specify the percentage of the people that will be 

generated according to each population panel. If the user fails to specify a percentage for a 

particular population panel then EXODUS will generate random people instead of the people 

described in that population panel. If a percentage less than 100 is provided (e.g. either a single 

panel is associated with a percentage of less than 100, or several panels are provided which in 

total do not add up to 100) then the remaining percentage of the population is randomly 

generated. 

 

The Itinerary Selection dialogue box then appears. The user may then click on Add button, 

gaining access to a list of itineraries previously created in Population Mode. Any number of 

these may be added. Each itinerary that subsequently appears in the Itinerary Selection dialogue 

box will have a probability associated with it. This controls the likelihood of an individual 

generated having the itinerary in question associated with it. The model will not allow the user 

to progress any further unless the total probability adds up to one (see Figure 5-65). Indeed this 

function can be performed by the model, by clicking on the Norm button. 
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Figure 5-65: The model prevents the user progressing if the probabilities do not add up 

to 1.0. 

 

The Itinerary Selection dialogue box has several buttons associated with it. The user may Add 

in new itineraries, Remove identified itineraries from the list, Clear all itineraries from the list, 

Normalise the probabilities so that they automatically add up to 1.0, Show the details of the 

selected itineraries and final agree (OK) to proceed. The Tot. Prob. text box indicates the total 

calculated probability summed from the probabilities associated with itineraries. 

 

When a scenario has an assigned itinerary (or set of itineraries) the itinerary button displays the 

word “Set” in the Source Node Control dialogue box (see Figure 5-66). If no itinerary is 

associated with a population panel then they will be assumed to evacuate immediately. 

 

  
(a) (b) 

Figure 5-66: Source Node Control dialogue box before panels have been associated. (b) 

After the panels have been associated. The panels are now renamed appropriately 

 

The Source Node Control dialogue box has several buttons associated with it: Append adds a 

new source node scenario, Copy replicates the selected scenario, Remove removes the selected 

scenario and Clear, clears all of the scenarios from the work area. The Event Time Unit (Evt. 

Units) button allows the user to toggle the time units in the dialogue box between seconds, 

minutes and hours. These units only apply to the time range units; the generation rate times are 

always people per minute. The generation times of scenarios within a source node can overlap. 

The source node will try and generate the two populations at their respected rates, congestion 

permitting.  

 

A few things should be noted when utilising Source nodes in this way: 
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1) The specified generation rate of people supplied indicates the maximum rate that may 

be achieved. However this rate may not always be achieved during a simulation. A 

Source node will not generate a new person if it is already occupied by another. The 

process will be delayed until the individual occupying it moves off, before generating 

another person. The user should therefore ensure that the Source Node is sufficiently 

connected to allow sufficient space for new occupants to be generated. If extremely high 

generation rates are required, then multiple Source Nodes may be required. 

2) The maximum rate a Source Node can generate people is limited by the ability of 

occupants within the simulation to move off the node. Therefore, if the user wishes to 

achieve higher generation rates they should use a multiple number of Source Nodes. 

3) Each Source node can generate many different populations simultaneously. It should 

be borne in mind that the Source Node generating people according to all of the rates 

applied to each of these populations. 

 

 
Figure 5-67: The generation of people via Source Nodes. The six source nodes, grey, 

are at the top of the geometry. 

 

NOTE:  

The Response time attribute of a person, who was generated by a Source Node, is in fact that 

person’s generation time. Therefore, the Response time attribute should be considered as the 

person’s time of entering the system. 

 

NOTE: 

A Panel Population may already have an itinerary associated with it before it is associated with 

the Source Node. Once associated with the Source node it may then have further itineraries 

associated with it (as described above). In this case, the individuals generated will first follow 

the itinerary associated with the population panel and then follow the itinerary associated with 

Source node. This is described in the tutorial related to Source Nodes (see the Application 

Manual, Tutorial 13), as well as in the next section. 

 

5.12 Redirection Nodes 

Redirection nodes enable the user to redirect specific evacuees. The use of Redirection nodes 

will only influence those individuals that have to visit the corresponding node as part of their 

itinerary. Redirection nodes must first have been located within the structure whilst in Geometry 

mode (as described in Chapter 3). Once they are in place, then the user may manipulate them 

in Scenario mode. A key benefit of Redirection Nodes is the ability to allocate itineraries 

dynamically, either according to probability or conditions, allowing occupant tasks to be 

assigned during the simulation. 
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Once created the Redirection nodes are manipulated in a similar manner to the Source nodes 

described in the previous section - itineraries are assigned and are then allocated to occupants 

who have been previously instructed to visit the Redirection Node (i.e. with an existing task 

instructing them to visit the node). The assignment of itineraries to Redirection nodes is done 

in Scenario mode. The user double-clicks on the node and then on the Adv button that becomes 

available from the Node dialogue box (see Figure 5-68(a)). This then gives access to the 

Itinerary Selection Control dialogue box. This dialogue box is identical to the one used by the 

population panel (see Figure 5-68(b)). 

 

 

 

(a) (b) 

Figure 5-68: (a) Redirection Node Dialogue in Scenario mode. (b) The Itinerary Selection 

dialogue box. 

 

Each of the itineraries in the list will have an associated probability designating the likelihood 

of this itinerary being adopted. The probability values are represented by numbers adjacent to 

the list of itineraries. The model will not allow the user to proceed until this is the case.  

 

The user also has an option to choose alternative criteria for people to adopt an itinerary. These 

criteria are Pop. Size, Queue Speed, and Group and can be adopted by clicking on the Allocation 

pull down menu. If the Density selection is enabled, the itinerary which has the lowest density 

at the first node in its itinerary is selected. If the densities are the same, for more than one 

itinerary, then the nearest one is chosen. If the densities are the same and the distances are the 

same, then a random choice is made. If the Queue selection is enabled then the queue with the 

shortest estimated queue time is selected. The estimated queue time is calculated from the 

equation - "Average Service Time" X "Queue length." If the estimated queue time is the same, 

for more than one queue, then the nearest queue is selected. However if the estimated queuing 

time and distance are also equal then a queue is chosen at random.  

 

NOTE: 

If the Queue Length selection is enabled and the itineraries are queuing based itineraries then 

the queue length is used, instead of density at first target node in each itinerary 

 

NOTE: 

When choosing the Pop. Size or Queue Speed options, the numbers adjacent to the itineraries 

will be greyed out or will not be present. 
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If the Group selection is enabled, people within each group (i.e. containing the same Gene 

allocation) will act as a single unit and decide upon an itinerary to follow in a similar way to 

the Probability approach to allocation (see Figure 5-69 (a)). An additional feature of the Group 

allocation functionality is illustrated by Figure 5-69 (b). Within this itinerary list, a number of 

panels have been given the number ‘1’ by the user, whilst others are given the number ‘2’. If 

this is done, the assigned  group Leader will randomly choose between the itineraries with the 

number ‘1’ (in this example Option_1, Option_2, and Option_3), whilst the less senior members 

of the group will randomly choose between the itineraries with the number ‘2’. 

 

  
(a) (b) 

Figure 5-69: Example of itinerary list using the Group allocation approach 

 

NOTE:  

The values associated with each task in the Itinerary window are labels. Given this, the value 

n the Total text box is meaningless in this context. 

 

Whichever allocation method is adopted, the user may then manipulate the itineraries in the 

standard manner (see Chapter 4). The user may therefore Add existing itineraries previously 

generated in Population mode, Edit the constituent parts of itineraries previously included, 

Remove identified itineraries from the list, Clear all itineraries in the list, Normalise the 

probabilities of the itineraries in the list so that the overall probability sums to 1.0 (the model 

will not allow the user to proceed until this is the case.), Show the paths resulting from the 

selected itineraries and finally accept the manipulations by clicking OK. 

 

A small example will now be presented to demonstrate the use of Redirection nodes (see Figure 

5-70). This example also includes Source nodes generating individuals who have itineraries 

associated with them. 

 

 
Figure 5-70: Simple case with one source node, bottom left, and a redirection node, 

bottom right. 
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A simple geometry is generated which includes a Source node and a Redirection node (see 

Figure 5-70).In this case the Source node generates people who have a Redirection node in their 

itinerary. This is apparent in Figure 5-71 where the Redirection node appears in the list of nodes. 

 

 
Figure 5-71: Dialogue box associated with source node. 

 

At this stage any individual generated by the Source node will visit the Redirection node before 

visiting the free space node FS 2 (as shown in Figure 5-72). They have no further instruction 

provided by the Redirection Node (as it currently does not have an associated itinerary). 

Therefore, the occupants are initially instructed to visit the Redirection Node, and then visit FS2 

- no additional tasks are provided by the Redirection Node. 

 
Figure 5-72: The path adopted by an individual generated by the Source Node. 

 

NOTE: 

The type of navigation system used (e.g. whether it uses the potential map or the distance map) 

will have no impact upon the movement of the individual. This will only affect their movement 

towards an exit once the itinerary has finished. 

 

The Redirection Node is now assigned an itinerary. 

 

 
Figure 5-73: Itinerary associated with the redirection node. 
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In Population Mode, the user can associate the appropriate itineraries to the Redirection Node. 

The itineraries adopted by the occupant will be inserted into their existing list of itineraries. The 

Itinerary Selection dialogue box specified within this example for the Redirection node is 

illustrated in Figure 5-73 and only has one itinerary associated with it, which therefore has a 

probability of 1.0. This means that all people who visit this Redirection Node will inherit this 

task. The path of “Itin_1”, the task associated with the Redirection Node, is displayed in Figure 

5-74(a) and its Edit Itinerary dialogue box (see Figure 5-74(b)). 

 

Redirection Node Itinerary Path. 
 

The Itinerary associated with the 

Redirection node. (Task 3) 

(a) (b) 

Figure 5-74: (a) The path that would be adopted by those visiting the Redirection node 

with no previous itinerary tasks (b) The dialogue box associated with the Redirection 

node. 

 

The outcome of visiting the Redirection node can clearly be seen in Figure 5-74(b). Here the 

new itinerary (and hence tasks) that would be attributed to an individual are described, assuming 

that the individual had no previous tasks associated. However, in this instance, an individual 

generated from the Source node, will already have a simple itinerary associated to them (see 

Figure 5-71). Therefore, once the individual arrives at or near (within the specified Range) to 

the Redirection node the itineraries associated with that node will take immediate effect and 

will then be followed by those tasks that had previously been associated with the individual. 

This is apparent from Figure 5-75(a) where the path adopted by the occupant can be seen to 

initially follow that attributed by the Source node. On arrival at or near to the Redirection node, 

the itinerary associated here takes over. Once this has been exhausted then the individual 

continues on the path indicated by the itinerary attributed at the Source node. The dialogue box 

of the itinerary associated with the individual reflects these changes (see Figure 5-75(b)). 

 

 
 

 

Person’s Itinerary path after visiting the 

Redirection node. 

 
Itinerary dialogue box of a person after 

they have visited the Redirection node. 

Note that the Redirection node’s itinerary 

has been inserted after itinerary entry “RE 

201” which is the Redirection node. 

(a) (b) 
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Figure 5-75: The interaction between the itineraries generated. (a) the path of the 

itinerary (b) the itinerary of the individual. 

 

5.13 The Range Function 

The Range function displays a radius around a selected node for a specified distance.  To access 

the Range function, double-click any node in SCENARIO MODE and click the RANGE button 

(see Figure 5-76).   

 

 
Figure 5-76: Use of the Range function. 

 

A dialogue box will prompt for the desired radius to display (measured in metres).  The default 

figure for this value is 6m. When the OK button on this dialogue box is clicked, each node 

around the selected node within the radius is displayed.  An example is shown in Figure 5-77, 

where a radius of 5m is shown around a particular node.  The range function prematurely 

terminates when it encounters a wall. 

 

 
Figure 5-77: Range function with 5.0m radius around two selected nodes. 

 

5.14 Transit Node Performance Attributes 

The performance of the Transit Node objects can be further configured in Scenario Mode by 

accessing the Behaviour tab of their corresponding Transit Node dialogue box. The nature of 

the attributes available for user-modification is dependent upon the type of Transit Node being 

manipulated and the Movement Model selected from the drop-down list (i.e. whether Flow 
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Model or Individual Model is selected). The Movement Model determines whether the 

movement of individual agents are used to establish performance, or whether performance is 

dictated by the flow rate assigned to the component. 

 

If the Individual Model is selected then performance is established in the same way elsewhere 

in the model i.e. performance levels emerge through the movement and interaction of the agents 

within the space available. Individual attributes (i.e. local to the agents) govern their maximum 

achievable speeds. The Flow Model treats the component as a single entity and enforces a flow 

cap ensuring that a flow rate is not exceeded given the dimension of the component. Individual 

occupant attributes are not examined during this calculation. In effect, the Transit Node 

determines performance given the number of occupants making use of the component, rather 

than their attributes or the interaction between occupants. To enable this, a flow rate is required 

to limit the flow through the component, along with an assumed travel speed for anyone 

traversing the space.  

 

Given that in the Flow Model the user is effectively dictating performance levels, there are 

typically more attributes that can be modified. In many of the Transit Nodes, these attributes 

are influenced by the direction of movement - typically those where movement is between 

levels (e.g. stairs, escalators, etc.). The user can select the direction being accessed by first 

switching back to the Properties tab on the Transit Node dialogue box. The user can then 

manipulate the Travel Dir. attribute between the Up/Forward and Down/Backward options. 

Once selected, the user should then move back to the Behaviour tab and the data presented (and 

accessible depending on the options selected) will relate to the direction of travel specified. 

 

Some nodes can be accessed in either direction (e.g. a stair), while others may only be accessed 

in one direction (e.g. a moving escalator). Default data is provided indicating the expected 

performance (i.e. achieved flow) of individuals in either direction. Hence, if the Travel 

Direction of the component is assigned as being Up/Forward then the flow rate is assigned to 

the default Up/Forward flow rate. Conversely, if the Travel Direction of the component is 

assigned as being Down/Backwards then the flow rate is assigned to the default 

Down/Backwards flow rate. However, in the case of both stairs and escalators if the user assigns 

the Travel Direction of the component as being Bidirectional, the flow rate defaults to the 

corresponding flow rate for the Up/Forward direction. This is because the flow rate of people 

going onto a stair going up (i.e. Up/Forward) is typically lower (i.e. more conservative) than 

the flow rate of people going down a stair (i.e. Down/Backwards). However, when Bidirectional 

stairs/escalators are being used the assigned flow rate is applied in both directions. That is to 

say it restricts the flow of people both going on to the component going up and similarly restricts 

the flow of people onto the component going down. It is generally advised that conservative 

values are used to account for the different performance levels expected. 

 

Several of the Transit Node attributes that can be edited allow the user to provide a range of 

values; i.e. a minimum and maximum associated with flows, travel speeds, delays, etc. In doing 

so, the user is also able to configure the nature of the distribution within this range. The user 

should first provide the Minimum and Maximum values defining the range in the main Transit 

Node dialogue box. The user can then edit the distribution associated with this range if they 

select User-Defined (as opposed to Default) from the related drop-down list (see Figure 5-78). 

This will provide access to a dialogue box where the User-Defined distribution can be edited. 
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Figure 5-78: Example of selecting User-defined from the Model drop-down list. 

 

The user can select one of the following options 

(1) Uniform - this will provide a uniform distribution between the Minimum and Maximum 

values provided. Once selected, no further action is required. 

(2) User-defined - this allows the user to provide a number of sub-ranges and associated 

probabilities that piece together to produce the distribution. The Minimum and 

Maximum values are then recalculated based upon the minimum and maximum values 

within the distribution.  The user can Append or Insert new sub-ranges and then 

associate the required probability with them. The overall set of probabilities can be 

normalized by clicking on the Norm button (see Figure 5-79). 

 

 
Figure 5-79: Defining the distribution. 

 

In addition, the user also often has a third option of selecting distribution data corresponding to 

the specific type of transit node derived from analysis of experimental trials.  This data 

corresponds to a distribution defined in the same manner as the User Defined option outlined 

previously (i.e. via the definition sub-ranges and associated probabilities). However, unlike the 

User Defined distributions this type of data cannot be modified by the user and hence is read 

only. 

 

The Behaviour options for each of the Transit Node types will now be briefly discussed. It is 

highly recommended that the user experiments with this functionality (and the associated 

tutorials) in order to familiarize themselves with the performance of Transit Nodes. 
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5.14.1 Stair 

The key Behaviour attributes available on the Stair Transit Node are shown in Figure 5-80. If 

Flow is selected from the Movement Model drop-down box, then the attributes described in 

Table 5-5 are available. These relate to the achievable flow rates and the travel speeds that are 

assumed. These are determined according to the data-set imposed by the user; i.e. whether 

people or ascending or descending.  
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Figure 5-80: Behaviour tab for Stair Transit Node. 

 

Table 5-5: Flow Model Attributes for Stair Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Catchment 

(m) 

Influences point at which 

occupants can receive 

information from the 

component, allowing 

selection to be made 

7.5m User-Defined 

Movement Model Selects between Flow and 

Individual model 

Individual 

 

Flow 

Model Selects the data set 

defining the performance 

of the stair. 

Default User Defined 

Flow  

[Min - Max] 

/UP  

(occ/m/s) 

Minimum/Maximum 

Flow cap applied to 

occupants as they ascend 

the component 

0.94 - 1.16 occ/m/s 

(SFPE [34]) 

 

User-defined - 

allowing user to 

provide own value via 

the Flow Rates 

dialogue box, 

accessible from the 

Distribution button 

under the Flow 

attributes. 

Flow  

[Min - Max] 

/DOWN  

(occ/m/s) 

Minimum/Maximum 

Flow cap applied to 

occupants as they descend 

the component 

0.94 - 1.16 occ/m/s 

(SFPE [34]) 

 

Travel Speed  

[Min-Max] 

/UP 

(m/s) 

Minimum/Maximum 

travel speed applied to 

occupants as they ascend 

the component 

0.49-0.67m/s 

([19]) 

User-defined - 

allowing user to 

provide own value via 

the Travel Speeds 

dialogue box, 

accessible from the 

Distribution button 

under the Travel Speed 

attributes. 

Travel Speed  

[Min-Max] 

/DOWN 

(m/s) 

Minimum/Maximum 

travel speed applied to 

occupants as they descend 

the component 

0.60-1.01 m/s 

([19]) 
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If Individual is selected from the Movement Model drop-down box, then the attributes shown 

in Table 5-6 are available. These govern the manner in which occupants traverse the stair 

component and the spacing maintained between occupants in close proximity to each other. If 

User-Defined is selected on the Step-Usage Model, then the user is able to determine the space 

that is needed for an individual to move forwards: the space ahead of the occupant. As described 

in the Theory Manual, the Staggered and Packed regimes (determined globally via the 

Behavioural Options dialogue box in Simulation Mode), determines the lateral space required: 

Packed typically allows people to be adjacent to each other on a step, while Staggered requires 

a lateral space to be maintained. 

 

Table 5-6: Individual Model Attributes for Stair Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Step Usage Model Determines number of 

steps ahead of occupant 

required for them to move 

Pauls/Fruin  

([19,34]) 

User-Defined 

Staggered Requires occupant to be 

only person on a step. 

2 User-Defined 

Packed Allows occupant to share 

step 

2 User-Defined 

 

5.14.2 Escalator 

The key Escalator attributes are shown in Figure 5-81. If Flow is selected from the Movement 

Model drop-down box, then the attributes described in Table 5-7 are available. These relate to 

the achievable flow rates and the travel speeds that are assumed. Similar to the Stair Transit 

Node, these are determined according to the data-set imposed by the user; i.e. whether people 

or ascending or descending. 

 

 
Figure 5-81: Behaviour tab for escalator transit nodes. 
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Table 5-7: Flow Model Attributes for Escalator Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Catchment 

(m) 

Influences point at which 

occupants can receive 

information from the 

component 

7.5m User-Defined 

Movement Model Selects between Flow and 

Individual model 

Individual Flow 

Model Selects the data set 

defining the performance 

of the escalator. 

Default User Defined 

Flow  

[Min - Max] 

/UP  

(occ/m/s) 

Minimum/Maximum 

Flow cap applied to 

occupants as they ascend 

the component 

1.25 occ/m/s 

[124] 

User-defined - 

allowing user to 

provide own value via 

the Flow Rates 

dialogue box, 

accessible from the 

Distribution button 

under the Flow 

attributes. 

Flow  

[Min - Max] 

/DOWN  

(occ/m/s) 

Minimum/Maximum 

Flow cap applied to 

occupants as they descend 

the component 

0.783 occ/m/s 

[124] 

Travel Speed  

[Min-Max] 

/UP 

(m/s) 

Minimum/Maximum 

travel speed applied to 

occupants as they ascend 

the component 

0.32-1.51 m/s 

[124] 

User-defined - 

allowing user to 

provide own value via 

the Travel Speeds 

dialogue box, 

accessible from the 

Distribution button 

under the Travel Speed 

attributes. 

Travel Speed  

[Min-Max] 

/DOWN 

(m/s) 

Minimum/Maximum 

travel speed applied to 

occupants as they descend 

the component 

0.38 - 1.67 m/s 

[124] 

 

If Individual is selected from the Movement Model drop-down box, then the attributes shown 

in Table 5-8 are available. These govern the manner in which occupants travel across the 

component and the spacing maintained. If User-Defined is selected on the Step-Usage Model, 

then the user is able to determine the space that is needed for an individual walker or rider to 

move forwards: the space ahead of the occupant.  
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Table 5-8: Individual Model Attributes for Escalator Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Step Usage 

Model 

Determines number of 

steps ahead of occupant 

required for them to 

move 

Al-Sharif [132] Pauls/Fruin, User-

Defined 

Walkers Space taken up by those 

intending to move. 

3 User-Defined 

Riders Space occupied by 

those standing still. 

2 User-Defined 

Walker   [124]  

Up% Likelihood of an 

occupant walking 

upwards 

27 User-Defined 

Down% Likelihood of an 

occupant walking 

downwards 

21 User-Defined 

Riders  [124]  

Rider Bias Preference for people 

standing. 

Right Left, None 

Compliance % Likelihood of someone 

following bias 

89.1 User-Defined 

Entry Delay  Fruin [19]  

 Male (s)  

(Min-Max) 

Minimum delay on 

entering the device for 

men 

0.95-1.16s User-Defined 

Female (s)  

(Min-Max) 

Minimum delay on 

entering the device for 

women 

1.06-1.18s User-Defined 

 

A key factor in the individual performance on escalators is whether the individual is walking 

(i.e. moving in addition to the motion of the escalator) or riding (i.e. standing still and allowing 

the escalator alone to move them forward). This factor determines the spacing required, with 

the likelihood of adopting the behaviour dependent upon the direction of travel. Riding an 

escalator is typically biased to one side of an escalator, in accordance with local preferences. 

The likelihood of an individual favouring a particular side of the escalator on which to stand 

can be set (through manipulating the Bias and Compliance attributes). Finally, on first accessing 

the escalator, individuals will typically hesitate and experience a delay. This is represented by 

the Entry Delay attribute. From the data collected by Fruin, the extent of this delay is influenced 

by gender [19]. The user is able to counter this assertion (i.e. set the Male and Female delays) 

should these values not be consistent with their expectation. 

 

NOTE:  

In both the Flow and Individual model, the travel speeds relate to the speed along the horizontal 

distance, rather than along the incline. 
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5.14.3 Travelator 

The key Travelator attributes are shown in Figure 5-82. If Flow is selected from the Movement 

Model drop-down box, then the attributes described in Table 5-9 are available. These relate to 

the achievable flow rates and the travel speeds that are assumed.  

 

 
Figure 5-82: Behaviour tab for travelator transit nodes. 

 

Given the nature of the Travelator, these attributes are not influenced by the direction of travel; 

for instance, there is no difference in the flow or travel speeds according to direction. 
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Table 5-9: Flow Model Attributes for Travelator Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Catchment 

(m) 

Influences point at which 

occupants can receive 

information from the 

component 

7.5m User-Defined 

Movement Model Selects between Flow and 

Individual model 

Individual Flow 

Model Selects the data set 

defining the performance 

of the travelator. 

Default User Defined 

Flow  

[Min - Max] 

/UP  

(occ/m/s) 

Minimum/Maximum 

Flow cap applied to 

occupants as they ascend 

the component 

1.0 occ/m/s 

[125] 

User-defined - 

allowing user to 

provide own value via 

the Flow Rates 

dialogue box, 

accessible from the 

Distribution button 

under the Flow 

attributes. 

Flow  

[Min - Max] 

/DOWN  

(occ/m/s) 

Minimum/Maximum 

Flow cap applied to 

occupants as they descend 

the component 

1.0 occ/m/s 

[125] 

Travel Speed  

[Min-Max] 

/UP 

(m/s) 

Minimum/Maximum 

travel speed applied to 

occupants as they ascend 

the component 

1.2-1.5 m/s 

[Default EXODUS] 

User-defined - 

allowing user to 

provide own value via 

the Travel Speeds 

dialogue box, 

accessible from the 

Distribution button 

under the Travel Speed 

attributes. 

Travel Speed 

[Min-Max] 

/DOWN 

(m/s) 

Minimum/Maximum 

travel speed applied to 

occupants as they 

descend the component 

1.2 - 1.5 m/s 

[Default EXODUS] 

 

If Individual is selected from the Movement Model drop-down box, then the attributes shown 

in Table 5-10 are available. These govern the manner in which occupants travel across the 

component.  

 

Table 5-10: Individual Model Attributes for Travelator Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Walker % Likelihood of an occupant 

walking 

20 User-Defined 

Riders    

Rider Bias Preference for people 

standing. 

None Left, Right 

Compliance % Likelihood of someone 

following bias 

100 User-Defined 

Entry Delay  Fruin [19]  

 Male (s)  

(Min-Max) 

Min/Max delay on 

entering the device for 

men 

0.95-1.16s User-Defined 

Female (s)  

(Min-Max) 

Minimum delay on 

entering the device for 

women 

1.06-1.18s User-Defined 
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A key factor in the individual performance on travelators (like escalators outlined previously) 

is whether the individual is walking (i.e. moving in addition to the motion of the travelator) or 

riding (i.e. standing still and allowing the travelator alone to move them forward). Riding a 

travelator is typically biased to one side, in accordance with local preferences. The likelihood 

of an individual favouring a particular side of the travelator on which to stand can be set 

(through manipulating the Bias and Compliance attributes). Finally, on first accessing the 

travelator, individuals will typically hesitate and experience a delay. This is represented by the 

Entry Delay attribute. From the data collected by Fruin, the extent of this delay is influenced 

by gender [19]. It should be noted that the Entry Delays are, by default, the same as for 

escalators given the absence of specific data relating to travelator use. The user is able to counter 

this assertion (i.e. set the Male and Female delays) should these not be consistent with their 

expectation.  

 

Unlike movement on stairs or escalators, movement on travelators is on the level. Therefore (in 

the absence of other data or theory), the spacing required is assumed to be comparable to that 

required when moving on Free-Space nodes, with no additional behavioural calculations 

required. 

 

5.14.4 Corridor 

The Corridor Transit Node only has one attribute on the Behaviour tab that can be modified: 

Catchment. Occupants of a corridor are otherwise assumed to perform as if they were traversing 

Free-Space nodes. The primary purpose of the Corridor is to provide alternative parallel routes 

when travelators are used; for instance, often the path between two operating travelators 

connecting two sections of free-space nodes on the same level.  

 

Table 5-11: Behaviour Attributes for Corridor Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Catchment 

(m) 

Influences point at which 

occupants can receive 

information from the 

component 

7.5m User-Defined 
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5.14.5 Metered Gate 

The Behaviour tab for a Metered Gate Transit Node is shown in Figure 5-83.  

 

 
Figure 5-83: Behaviour tab for metered gate transit nodes 

 

Within buildingEXODUS two types of metered gate can be represented by default, namely 

ticket gates and turnstiles. As with the other types of Transit Nodes the performance of a 

Metered Gate can be represented by either a Flow or an Individual model.  In the Flow 

Movement Model a flow rate is applied on the gate. This caps the maximum flow that can be 

achieved by the gate during a simulation. As the simulation is running the achieved flow can 

be lower but it can never exceed the capping value.  

 

In the Individual Movement Model the time each agent takes to traverse the device is comprised 

of both an Entry Delay and a Travel Time. Using this approach the Entry Delay is intended to 

represent the time (in seconds) between the pedestrian inserting and retrieving their ticket from 

the machine. Similarly, the Travel Time is assumed to be the time (in seconds) between the 

pedestrian collecting their ticket and exiting the device by placing their first foot past the 

metered gate. Within buildingEXODUS, both the Entry Delay and Travel Time for a given 

metered gate are defined by either uniform or user defined probability distributions. Each agent 

traversing the metered gate is then randomly assigned both an Entry Delay and a Travel Time 

according to their corresponding distributions. In this manner the total time taken for each agent 

to traverse the metered gate can be defined. If no Entry Delay data is available for a given 

metered gate then the time taken to traverse the entire metered gate can be defined purely by a 

Travel Time distribution (i.e. with the Entry Delay and Travel Times are effectively Combined). 

 

Within buildingEXODUS seven default data sets are provided defining the performance of 

metered gates. Each data set relates to a specific type of metered gate (i.e. ticket gate or turnstile) 

modelled using either the Flow or Individual Movement Model. Hence each data set is only 

applicable to a specific combination of both Gate Type and Movement Model. Consequently 

only the default data sets appropriate to the currently selected Gate Type and Movement Model 

will be displayed within the Model list box. For more information on Metered Gates and the 

default data sets available see the Theory Manual. 
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In addition to the default Metered Gate data sets the user also has the ability to define additional 

metered gates by manually defining their operating characteristics. The user can define the 

performance of a metered gate either via the Flow or Individual based model. If the metered 

gate is defined via the Flow based model then the user is required to define both the metered 

gate’s length (m) and the flow rate obtainable through the device (i.e. by defining the Flow Min 

and Flow Max  fields (occ/s)). Conversely, if the metered gate is defined via the Individual 

based model then the user is required to define either both the Entry Delay and Travel Time 

distributions, or alternatively merely a Travel Time distribution defining the total time for the 

agent to traverse the entire device. In addition the user should also define the length of the 

metered gate. It is important to note that when the metered gate is defined via the Individual 

based model its length is not used in the calculation of the time taken for the agent to traverse 

the gate. Despite this it is important to define the length of the metered gate in order to both 

accurately represent the distance traversed by the agent and hence their corresponding speed 

through the device. 

 

By default, Metered Gates are assumed to be ticket gates defined via the Flow Movement Model 

(via a flow rate) derived from work conducted as part of the AVATARS project [165]. The 

ticket gates analysed as part of the AVATARS project represented a Closed Ticket Gate that 

required a person to enter a ticket, retrieve the ticket and move through the device. 

 

The key Flow Model attributes available on the Metered Gate Transit Node Behaviour dialogue 

box are shown in Table 5-12. As stated previously, it is important to note that both the Model 

options and default minimum and maximum flow rates vary depending not only on the 

Movement Model selected, but also on the Gate Type being modelled (i.e. ticket gate or 

turnstile). The data shown below in Table 5-12 therefore corresponds to a ticket gate. For more 

information on Metered Gates and the default data sets available see the Theory Manual. 

 

Table 5-12: Flow Model Attributes for Metered Gate Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Catchment 

(m) 

Influences point at which 

occupants can receive 

information from the component 

7.5m User-Defined 

Gate Type Defines the type of metered gate 

being modelled 

Ticket Gate Turnstile 

Movement Model Selects between Flow and 

Individual model 

Flow Individual 

Model Selects the data set defining the 

performance of the metered gate 

type currently being modelled. 

Closed Station User-Defined 

Flow [Min - 

Max] (occ/s) 

Minimum/Maximum Flow cap 

applied to component. 

0.211 - 0.277 occ/s 

[165] 

User-defined 

minimum and 

maximum flow 

values  

 

If Individual is selected from the Movement Model drop-down box, then the attributes shown 

in Table 5-13 are available. These govern the manner in which occupants travel across the 

component. Once again, it is important to note that the Model options, Entry Delays and Travel 

Times all vary depending not only on the Movement Model selected, but also on the Gate Type 

being modelled (i.e. ticket gate or turnstile). The data shown below in Table 5-13 therefore 
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corresponds to a ticket gate. For more information on Metered Gates and the default data sets 

available see the Theory Manual. 

 

Table 5-13: Individual Model Attributes for Metered Gate Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Model Selects the data set defining the 

performance of the metered gate 

type currently being modelled. 

Closed Station 

 

Closed Station 

(Combined),  

User-Defined 

Entry Delay  

[Min - Max]  

(s) 

Min/Max delay on entering the 

device 

0.0 – 5.5 s 

[165] 

User-defined 

minimum and 

maximum entry delay 

values 

Travel Time 

[Min - Max]  

(s) 

Min/Max travel time taken to 

move through the device 

0.0 – 5.5 s 

[165] 

User-defined 

minimum and 

maximum travel time 

values 

 

5.14.6 Lift Shaft Opening 

The Lift Shaft Opening Transit Node only has one attribute on the Behaviour tab that can be 

modified: Catchment (see Table 5-14).  

 

Table 5-14: Behaviour Attributes for Lift Shaft Opening Transit Node. 

Attribute Impact Default Value 

(source) 

Alternatives 

Catchment 

(m) 

Defines the waiting area for a lift/ 

elevator, or is used in conjunction with 

the catchment areas of other Lift Shaft 

Opening transit nodes to define the 

waiting area for the combined lift bank 

3.0m User-Defined 

 

For Lift Shaft Opening transit nodes the catchment area defines the region within which agents 

will wait for a given lift (see Figure 5-84(a)). In instances where the lift forms part of a bank of 

lifts the waiting area is defined by the collective catchment area of all lifts within the lift bank 

(see Figure 5-84(b)). The catchment area/waiting area also defines the region assessed by each 

agent when considering their designated Congestion Threshold value. When entering a lift 

waiting area agents will initially consider its corresponding level of congestion (occ/m2). If the 

level of congestion within the lift waiting area exceeds their designated Congestion Threshold 

value agents will abandon attempting to use the lift and will instead evacuate via the stairs. 
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(a) (b) 

Figure 5-84: The catchment area (represented by red dots) of a) a single Lift Shaft 

Opening transit node, and b) a bank of Lift Shaft Opening transit nodes 

 

NOTE: 

Within buildingEXODUS banks of lifts are effectively defining by grouping the corresponding 

Lift Shaft Opening transit nodes on each floor together (see Section 5.17.1). 

 

5.15 Lifts/Elevators 

Lift Shaft Opening transit nodes are used to define a lift shaft and its corresponding lift/elevator. 

Lift Shaft Opening transit nodes that form part of a lift shaft should be located in the same 

position (i.e. x, y coordinates) on all of the floors through which the lift passes. Initially the Lift 

Shaft Opening transit nodes need to be positioned and connected to the adjacent Free Space 

nodes on the floors serviced by the lift. A lift shaft and associated lift can then be created by 

right clicking on any of the Lift Shaft Opening transit nodes and selecting the Create Lift Shaft 

option from the pop-up menu (see Figure 5-85). Multiple lift shafts (and associated lifts) can 

be created simultaneously by right clicking on any of the Lift Shaft Opening transit nodes within 

a given group, then selecting the Create Lift Shafts for Group option from the pop-up menu 

(see Figure 5-85). Conversely lift shafts can be removed by clicking on either the Remove Lift 

Shaft or Remove Lift Shafts from Group options in the right-click dialogue box. 

 

Upon selecting either the Create Lift Shaft or Create Lift Shafts for Group options the user will 

be asked “Do you wish to automatically rename the lift’s corresponding Lift Shaft Opening 

transit nodes?”. If the user clicks No the names of all the Lift Shaft Opening transit nodes will 

remain unchanged. Conversely, if the user clicks Yes the names of each Lift Shaft Opening 

transit node will automatically be updated to reflect both the name of the lift of which they are 

a part and the floor on which they are based (i.e. <LiftName>_<FloorName>).  To aid in the 

identification of both lifts and the Lift Shaft Opening transit nodes from which they are formed 

it is advised that the user always answers Yes to this question.  
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Figure 5-85: The Create Lift Shaft option within the pop-up menu 

 

5.15.1 Attributes  

Once a lift shaft and lift have been created, a user can view and edit the lift attributes by right 

clicking on any of the Lift Shaft Opening transit nodes and selecting the Lift Properties option 

from the pop-up menu (see Figure 5-85). This will display the Lift Properties dialogue box (see 

Figure 5-86). 

 

 
Figure 5-86: Lift Properties dialogue box 

 

In the Lift Properties dialogue box the attributes are grouped into five tabs (see Table 5-15).  
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Table 5-15: Lift Properties dialogue box attributes 

Tab Attribute Description 

Attributes 

Title The name of the lift. 

Current Floor 
The Lift Shaft Opening transit node and 

Floor that the lift is currently at. 

Start Floor 

The Lift Shaft Opening transit node and 

Floor that the lift starts at the beginning 

of the simulation. 

Status 
The status of the door (i.e. Open or 

Closed). 

Direction 
The direction the lift is currently 

travelling in (i.e. Up, Down or Waiting).  

Capacity 
The maximum number of agents that can 

simultaneously occupy the lift. 

Occupancy 
The number of agents currently inside the 

lift. 

Start Delay (s) 

The delay time before a lift begins 

servicing its floor sequence at the 

beginning of a simulation. 

Is in service 
Defines if a lift is in service or not (i.e. if 

it is used within a simulation). 

Movement 

Max Speed (m/s) The maximum speed the lift can travel at. 

Acceleration (m/s2) 
The rate at which the lift accelerates 

towards the maximum speed. 

Deceleration (m/s2) 
The rate at which the lift decelerates from 

the maximum speed. 

Opening Time (s) 

The time the lift door takes to open from 

being closed (agents cannot board a lift 

until the door is fully opened). 

Closing Time (s) 

The time the lift door takes to close from 

being open (agents cannot board a lift once 

the doors have begun to close). 

Dwell Time (s) 

The time the lift doors remain open after 

opening once no agents in the transit node 

catchment area are targeting the lift bank. 

Sensor adjusted 

Dwell Time (s) 

The time the lift doors remain open after 

an agent boards the lift and no agents in 

the transit node catchment area are 

targeting the lift bank. 

Motor Delay (s) 
The time it takes a lift motor to start 

moving the lift after the doors have closed. 

Nodes - 

The Lift Shaft Opening transit nodes that 

define the lift shaft within which the lift is 

assumed to move  (see Section 5.15.2). 

Sequence - 

The defined sequence of floors a lift will 

service during an evacuation simulation 

(see Section 5.15.3). 
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Floor 

Requests 
- 

The sequence of floors that that the lift 

currently still has to service (see Section 

5.15.4). 

 

Once the lift attributes have been specified/edited they can be assigned to the selected individual 

lift (by clicking the OK button), all lifts in the geometry (by clicking the Apply to all button) or 

to all lifts in the current lift’s transit node group (by clicking the Apply to group button) (see 

Figure 5-86). 

 

5.15.2 Nodes 

The Lift Shaft Opening transit nodes that define the lift shaft within which the lift is assumed to 

move can be viewed and edited in the Nodes tab of the Lift Properties dialogue box. It is 

important to note that when a lift traverses between Lift Shaft Opening transit nodes the floor 

height is used as the travel distance and not the height of the transit node. The Add and Remove 

buttons allow additional Lift Shaft Opening transit nodes to be manually added to and removed 

from the list.  

 

 
Figure 5-87: Defining the Lift Shaft Opening transit nodes and hence floors that a given 

lift will service via the Nodes tab in the Lift Properties dialogue box  

 

5.15.3 Sequence  

The sequence of floors a lift will service during an evacuation simulation are defined in the 

Sequence tab of the Lift Properties dialogue box. Floors can be added/removed from the 

sequence by using the Add or Remove buttons and selecting the desired floor from the opened 

dialogue box. Once a single floor has been added to the sequence, it can be edited by selecting 

its corresponding Floor ID within the list and typing its new floor number. New floors can also 

be added after a given floor by again selecting its corresponding Floor ID within the list and 

pressing the Enter key.  
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Within buildingEXODUS the type of lift sequence employed by a given lift is defined by the 

Procedure list box in the Lift Properties dialogue box on the Sequence tab (see Figure 5-88). 

 

There are three types of lift sequence that can be defined: 

 Floor sequence  

 Shuttle Floor sequence 

 Sky Lobby sequence  

 

Floor Sequence 

Using a floor-sequence, a user explicitly specifies the sequence of floors a lift will service 

during the simulation. The assigned lift will serve each of the floors specified in the sequence 

irrespective of whether agents are waiting for the lift on each of the floors.  

 

Shuttle Floor Sequence 

Using a Shuttle-floor sequence, a user specifies a paired-sequence of pick-up/drop-off floors 

where the lift could pick agents up from and shuttle them to. This shuttle process repeats until 

there are no more agents in the catchment area of the Lift Shaft Opening transit node on the 

pick-up floor. The process is then repeated for the next pick-up/drop-off floor in the sequence 

(i.e. once the lifts have dropped off agents and there are no more agents waiting, the lifts will 

move to the next pair of pick-up/drop-off floors). If the lift is on the pick-up floor and is ready 

to leave (i.e. no more agents are waiting for the lift and is not full to capacity), it will directly 

move to the next pick-up floor to collect more agents (it will not drop-off agents first with a 

partially full lift). In Figure 5-88 an example of a Shuttle-floor sequence can be seen where the 

lift shuttles between progressively lower floors and the ground floor (i.e. Floor_0).  

 

 
Figure 5-88: Lift Properties Shuttle Floor Sequence Example 
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The ability of lifts assigned Shuttle Floor sequences to return to pick-up floors after they have 

been cleared (i.e. once all the agents waiting in the lift catchment area on the pick-up floor have 

been collected) is controlled via the Shuttle Floor Return option in the Lifts tab of the Behaviour 

Control dialogue box (see Chapter 6). 

 

If the Shuttle Floor Return option is disabled then once a given pick-up floor has been cleared 

the lift will then move onto the next pick-up/drop off pair within the sequence. Consequently, 

once a given pick-up floor has been cleared the lift will therefore not return to it, even if agents 

subsequently turn up on that floor hoping to catch the lift. In this case, the agents arriving within 

the catchment area of a lift on a floor already cleared will be deemed to have missed the lift and 

will therefore redirect to use the stairs. This represents the influence of either dynamic signage 

or a communication system informing the agents that the lift has already serviced their floor 

and that they should use the stairs instead. This system prevents agents from waiting indefinitely 

for a lift that will not arrive. 

 

However, if the Shuttle Floor Return option is enabled then lifts assigned Shuttle Floor 

sequences can return to previously cleared floors. As a result, agents arriving within the 

catchment area of a lift on a previously cleared pick-up floor will not redirect to the stairs, but 

will instead commence waiting for the lift in the conventional manner. The pair of pick-up/drop 

floors corresponding to the previously cleared floor on which an agent has arrived will then be 

added back into the lifts Floor Requests list (see Section 5.15.4).  The lift will then return to the 

previously cleared floor in order to collect the agents waiting for the lift.  Once all the agents 

on that floor have then been collected the lift will then move onto the next pair of pick-up/drop 

off floors etc. Hence, when the Shuttle Floor Return option is enabled pairs of pick up/drop off 

floors can be both dynamically added (i.e. as agents arrive within the lift catchment areas of 

previously cleared floors) and removed (i.e. as all the agents waiting for the lift on a given pick-

up floor are collected) from lifts corresponding Floor Request lists throughout the simulation.  

 

NOTE: 

By default the Shuttle Floor Return option is disabled (i.e. lifts assigned Shuttle Floor sequences 

will not return to previously cleared floors). 

 

Sky Lobby Sequence 

Using a Sky-lobby sequence, a user specifies a pair of floors defining a single pick-up (sky-

lobby) and drop-off floor where lifts pick agents up from and shuttle them to.  Unlike the Shuttle 

floor-sequence system outlined previously the lift will always return to the pick-up floor to 

collect more agents irrespective of whether any agents are waiting.  

 

Whether agents seek to use a lift assigned a Sky lobby procedure is dependent upon the agent’s 

initial floor, the pick-up floor of the lift and the number of floors the agent is prepared to travel 

up in order reach the lift.  The number of floors an agent is prepared to travel up in order to 

reach a sky lobby lift is controlled via the Sky Lobby Up Floors variable in the Lifts tab of the 

Behaviour Control dialogue box (see Chapter 6). By default the Sky Lobby Up Floors variable 

is set to zero, thereby implying that agents are not prepared to move up in order to reach a sky 

lobby lift. As a result, an agent will only move towards a lift assigned a Sky lobby procedure if 

the agent’s initial floor is the same as the lift’s pick-up floor, or the floor on which the sky lobby 

is located (i.e. its pick-up floor) falls between the agent’s initial floor and their exit (i.e. if an 

agent’s exit is located below them they will only consider moving down to a sky lobby, not up).  

 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 335 

If the value of the Sky Lobby Up Floors variable is greater than zero then agents can additionally 

travel up to the sky lobby lift.  However agents can only do this if the number of floors they are 

required to traverse in or to reach the sky lobby lift is less than or equal to the value of the Sky 

Lobby Up Floors variable. In addition, agents will still only travel up to the sky lobby lift if the 

number of floors that they are required to traverse is less than the number of floors they would 

traverse in travelling down to either another sky lobby lift or an exit (i.e. agents will not travel 

up if there is an alternative down option that is closer in terms of the number of floors they are 

required to traverse). 

 

Figure 5-89 below shows an eight floor structure comprising two sky lobby lifts. 

Sky_Lobby_Lift_A picks agents up from Floor_3 and drops them off at the ground floor (i.e. 

Floor_0), while Sky_Lobby_Lift_B conversely picks agents up from Floor_8 and drops them 

off at Floor_3. 

 

Figure 5-89(a) shows the floor number and direction that agents initially located on each floor 

will travel to if the Sky Lobby Up Floors variable is set at its default value of 0. In this scenario, 

agents will not consider travelling up in order to reach a sky lobby lift. As a result, the agents 

initially located on the ground floor will merely travel directly to the exit located on their floor, 

while those initially located on floors 1 and 2 will descend via the stairs to the ground floor (i.e. 

Floor_0) before similarly evacuating via the exit. None of these agents will therefore use a lift 

during their egress. The agents initially located on Floor_3 will merely catch Sky_Lobby_Lift_A 

to the ground floor before evacuating via the exit, while the agents initially located on floors 4-

7 will descend via the stairs to Floor_3 before similarly catching Sky_Lobby_Lift_A to the 

ground floor and evacuating. Agents initially located on Floor_8 will first catch 

Sky_Lobby_Lift_B to Floor_3 before then catching Sky_Lobby_Lift_A to the ground floor and 

evacuating. 

 

Figure 5-89(b) in contrast shows the floor number and direction that agents initially located on 

each floor will travel to if the Sky Lobby Up Floors variable is set to 1. In this scenario, agents 

will only consider travelling up a single floor in order to reach a sky lobby lift.  Here it can be 

seen that the direction and floor number targeted by agents on each floor is the same as those 

shown previously in Figure 5-89(a), with the exception of those agents initially located on floors 

2 and 7.  Agents initially located on Floor_2, who previously merely descended the stairs to the 

ground floor, now instead move up one floor to Floor_3 before then catching Sky_Lobby_Lift_A 

to the ground floor and evacuating. Similarly, agents initially located on Floor_7, who 

previously descended the stairs to Floor_3, now instead move up one floor to Floor_8 before 

then catching Sky_Lobby_Lift_B to Floor_3. These agents then catch Sky_Lobby_Lift_A to the 

ground floor before evacuating in the same manner as outlined previously. 

 

Figure 5-89(c) in contrast shows the floor number and direction that agents initially located on 

each floor will travel to if the Sky Lobby Up Floors variable is set to 2. In this scenario, agents 

will only consider travelling up two floors in order to reach a sky lobby lift.  Once again, it can 

be seen that the direction and floor number targeted by agents on each floor is the same as those 

shown previously in Figure 5-89(b), with the exception of those agents initially located on 

Floor_6. Agents initially located on Floor_6, who previously descended the stairs to Floor_3, 

now instead move up two floors to Floor_8 before then catching Sky_Lobby_Lift_B to Floor_3. 

These agents then catch Sky_Lobby_Lift_A to the ground floor before evacuating in the same 

manner as outlined previously. It is important to note that agents initially located on Floor_1 

did not travel up two floors to the sky lobby lift on Floor_3 (i.e. Sky_Lobby_Lift_A) since for 

these agents the exit was closer (i.e. only 1 floor away). 
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(a) (b) (c) 

Figure 5-89: The direction/floor number agents on given floors will travel to if the Sky 

Lobby Up Floors attribute is defined as a) 0, b) 1 and c) 2 

 

Agents that select to use a Lift Shaft Opening transit node (representing the pick-up floor of a 

sky lobby lift) that is not on their initial floor, are randomly assigned a Stair transit node to use 

prior to being assigned a Lift Shaft Opening transit node on the sky lobby floor. This ensures 

that individual staircases are not disproportionally used by agents travelling to the sky lobby. 

This assumes the stairs on the agent’s initial floor lead to the sky lobby. If the stairs do not lead 

to the sky lobby then the agent will follow the distance map to the assigned Lift Shaft Opening 

transit node.  

 

By default agents who choose to use a lift will randomly choose to move towards a lift bank 

(containing the Lift Shaft Opening transit node). This means an approximately even number of 

agents from a given floor should elect to use each of the available lift banks on the service floor 

(i.e. no single lift bank should be disproportionally used by agents). Agents will only move 

towards lifts assigned a Shuttle floor procedure if the agent’s initial floor is part of the lift’s 

sequence. Similarly, agents will only move towards lifts assigned a Sky lobby procedure if the 

agent’s initial floor is part of the lift’s sequence or the floor in which the sky lobby is located 

falls between the agents initial floor and their exit (i.e. if an agents exit is located below them 

they will only consider moving down to a sky lobby, not up). 

 

It is important to note that if no floor sequence is defined for a given lift then it will be assumed 

not to represent a viable egress route during a lift evacuation.  Consequently, agents will not be 

automatically assigned itinerary tasks to use this lift during their evacuation. However, agents 

who have been manually assigned to the lift (i.e. via the user manually assigning them Lift Bank 

tasks within their itinerary) can still use the lift if the Lift Bank task is followed by subsequent 

tasks within the agent’s itinerary (i.e. if the Lift Bank task is not the agent’s last task). In these 

instances, when the agent enters the waiting area (i.e. catchment area) they will consider the 

floors serviced by the lift. If the target of their next task (i.e. the task immediately following the 

Lift Bank task) is on a floor directly serviced by the lift (i.e. if a Lift Shaft Opening transit node 
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on the target floor is defined within the lift’s Nodes tab, see Section 5.15.2) then the agent will 

deem that the lift can take them to where they need to go. In this case, the agent will then be 

assumed to call the lift. The lift dispatch algorithm will then register the request and set about 

sending a lift from the designated lift bank to the appropriate floor. In this manner, not defining 

a floor sequence for a given lift means that the lift will not be used as part of a lift evacuation, 

but that it can instead be used to dynamically model the circulation of agents within the 

structure.  

 

5.15.4 Floor Requests 

The sequence of floors that a lift currently has to service are displayed within the Floor Requests 

tab of the Lift Properties dialogue box.  During the simulation the lift will set about servicing 

the floors within the Floor Requests list in order. Hence the lift will initially service the first 

floor within the Floor Requests list. Having serviced the first floor request the given floor will 

then be removed from the Floor Requests list, where upon the lift will then set about servicing 

the next floor within the list etc. In this manner, the Floor Requests list can be seen to display 

a complete list of the floors that the lift is intending to service and the order in which it intends 

to service them.   

 

If a given lift contains a pre-defined floor sequence (see Section 5.15.3) then the lift is assumed 

to be used purely for evacuation (i.e. not for circulation). As a result the lift’s corresponding 

Floor Requests list will initially default to its defined floor sequence (see Section 5.15.3).  If 

however the lift has no pre-defined floor sequence then the lift is assumed to be used purely for 

circulation (i.e. not evacuation). As a result the lift’s corresponding Floor Requests list will 

initially be empty. During a simulation, as agents enter the waiting area (i.e. catchment area) of 

a their target lift bank they are automatically assumed to call a lift. When initially calling the 

lift the agent is assumed to inform the lift only of their intended direction of travel (i.e. Up or 

Down). As a result, the lift is initially unaware of the specific floor that the agent intends to go 

to. Once an agent calls a lift the lift dispatch algorithm then sets about determining which lift 

within the lift bank should be sent to service the boarding request (i.e. which lift within the lift 

bank should be sent to collect the agent from their current floor and take them in their required 

direction of travel).  For more information on the lift dispatch algorithm see the Theory Manual, 

Chapter 9.   

 

Once the lift dispatch algorithm has determined which lift within the lift bank is best placed to 

service the agents boarding request the agents corresponding boarding floor is then 

added/inserted into the lift’s corresponding Floor Requests list (see Figure 5-90).  The agent 

will then wait within the lift bank’s catchment area for a lift travelling in their required direction 

of travel to arrive. Once a lift travelling in the required direction arrives at the agents floor the 

agent will then enter the lift. Upon entering the lift the agent is then assumed to inform the lift 

which floor they wish to go to (i.e. the agent’s corresponding alighting floor). The agents 

corresponding alighting floor is then added/inserted into the lift’s corresponding Floor Requests 

list (see Figure 5-90).  Hence, when modelling a lift used for circulation its corresponding Floor 

Requests list will (in contrast to lifts with pre-defined floor sequences) be dynamically updated 

during the simulation based on the boarding and alighting requests made by the agents. 
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Figure 5-90: The floor requests for a given lift (i.e. Lift1) as displayed within the Floor 

Requests tab of the Lift Properties dialogue box. 

 

5.16 Edit Menu 

The following sections concern functions from the Edit menu. 

 

5.16.1 Substituting Node Attributes 

Shortcut: [Edit/Substitute/Nodes] 
The Substitute Nodes function performs an identical task to Substitute/Nodes in Geometry mode 

(see Chapter 3).  In SCENARIO MODE only the Potential, Min/Max UFR, and Width attributes 

may be substituted.  Furthermore, these substitutions only apply to Attractor nodes.  To 

substitute attributes on Attractor nodes, first select the nodes to be modified and then select 

Substitute from the Edit menu, and then Nodes from the Substitute submenu (see Figure 5-2), 

and fill out the dialogue box as required. This is particularly useful if UFR are applied to the 

Attractor nodes as the width of the exit affects the flow calculations. For this reason it is 

recommended that the user always examines the arcs around Attractor and Discharge nodes 

once manipulation is complete to confirm that they are suitable. 

 

5.16.2 Substituting Exit Attributes 

Shortcut: [Edit/Substitute/Doors] 
In SCENARIO MODE numerous attributes available within the exit node, can be modified.  

This is achieved by supplying the values in the appropriate box and then either clicking the 

Apply button (to allow the box to remain open), or the OK button to complete the task and to 

close the dialogue box (see Figure 5-91). 
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Figure 5-91: The dialogue box that appears when the Substitute Exit nodes option is 

selected 

 

5.17 Tools Menu 

The following sections concern functions from the Tools menu. 

 

5.17.1 Transit Node Grouping 

Shortcut: [Tools/Transit Node Grouping] 
A Transit Node group is a group of any set of Transit Nodes which form a single transitional 

group; i.e. that present the occupants with a choice for moving between two adjacent spaces. 

For example, if a building entrance leads to a group of two escalators going up, one going down 

and a staircase this would form one Transit Node group (see Figure 5-92). 

 

 
Figure 5-92: Stair and Escalator Bank 

 

Grouping Transit Nodes together enables the user to manage the relative use of each of the 

Transit Nodes within a particular group. For example, a user may wish 60% of the occupants 

arriving at a Transit Node group to use the Escalators, while the rest use the Stairs. It also 

allows the user to manage how decisions are made, or for people to make a decision based upon 

the congestion levels and their quickest journey times. Transit Nodes are created within 

Geometry Mode (see Chapter 3) and, if required, are grouped within Scenario Mode as 

described below.  
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To create a Transit Node group, the user should first select the Transit Nodes that they require 

to be within the group (see Figure 5-93).  

 

 
Figure 5-93: Example escalator and stair transit nodes being grouped 

 

The user should then select the Transit Node Grouping option from the Tools menu (see Figure 

5-94(a)). This will bring up a Transit Node Subgroup Editor (see Figure 5-94(b)) which allows 

the user to create a Transit Node group by clicking on the Create button. Within the Transit 

Node Subgroup Editor, the user can also change the name of a group using the Description box, 

Remove groups or alternatively delete all groups by clicking the Clear button. Before changing 

the name of a group or removing a group, the specific group must firstly be selected by left-

clicking on the group button within the Transit Node Group List so that inverted commas “” 

appear around the group name. 

 

  
(a) (b) 

Figure 5-94: Transit Node Grouping 
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Double clicking on a specific Group within the Transit Node Group List (see Figure 5-94(b) 

will bring up the Transit Node Grouping Box (see Figure 5-95 (a)) where the specific transit 

nodes that have been highlighted previously can be added to the group and scenarios specified. 

To add a transit node to the group, the user should select the transit node within the Transit 

Node list (located on the right of the dialogue box) and then click on the <-ADD button. This 

has been done for both selected transit nodes within Figure 5-95(b). 

 

  
(a) (b) 

Figure 5-95: Transit Node Grouping 

 

NOTE: 

An alternate method for grouping transit nodes is, after selecting the desired transit nodes, 

right click on one of the transit nodes then select the Group option in the resulting pop-up menu. 

This will automatically create a new transit node group with the selected transit nodes included. 

 

5.17.1.1 Managing Transit Node Groups  

After creating the Transit Node Group and including the desired transit nodes, the user then 

needs to define the approach employed to determine which of the Transit Nodes an occupant 

will use during the simulation. 

 

There are three options to choose from when determining how people should make decisions 

as they arrive at a Transit Node group. These three approaches are Assessed, Proportion and 

Hybrid and are defined via the Selection System list box and the Congestion Threshold value 

(see Figure 5-95(b)).  

 

In the Proportion approach the user is required to define the proportion of occupants that will 

use each transit node component within the group. This approach is most appropriate for 

scenarios where lower levels of crowding occur at the entrance to the components, or where the 

user has specific information on the expected use of the components. This approach relies on 

the user providing data that is representative of the scenario being considered.   Using this 

approach, when an agent enters the catchment area they are assigned a component based on the 

assigned probabilities and will use this component regardless of the conditions faced (i.e. 

irrespective of whether serious congestion is faced).  

 

NOTE: 

If Proportion is selected from the Selection System list box this will automatically set the 

Congestion Threshold to 100%. 
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An example of using the Proportion approach is shown in Figure 5-96, where 100% of the 

population will use Escalator_1 and conversely 0% of the people will use the staircase within 

the group (i.e. Staircase_2). This approach could be used if the user has specific knowledge of 

the use of the group or wishes to manage the use to establish the impact. 

 

 
Figure 5-96: The use of the Proportion approach assigning 100% of people to 

Escalator_1. 

 

NOTE:  

When the Proportion approach is selected, the Penalty boxes for each transit node within the 

group will be disabled and the values assigned to them ignored. 

 

The Assessed approach relies on each occupant making a decision as to which device to use 

based on their perception of local conditions.  This decision is based on the assumption that the 

main motivation of the agent is to reduce their overall travel time through using a component.  

This approach is most appropriate for scenarios involving motivated occupants,  where high 

levels of congestion occur at the entrance to the component (where there is the potential and 

desire for occupants to optimize the travel times by moving between components), and/or when 

the user is not aware of the expected use of the components.  This is determined by the agent 

initially estimating the time it would take to travel to the component (i.e. distance / projected 

travel speed), the estimated congestion that will be encountered before reaching the component 

(current wait time of people directly between the occupant and component) and the projected 

time to traverse the component (based on the distance to be travelled and the occupant's 

component travel speed). 

 

If the Assessed approach is selected, people arriving at the transit node group will (individually) 

assess the conditions and make a decision based upon how long it will take them to traverse the 

component. An example of this is shown in Figure 5-97, where approaching occupants will 

assess the conditions on the escalator and staircase before selection. The decision people make 

can also be influenced by the user by changing the Penalty of each Transit Node: the higher the 

relative Penalty of a node, the less likely people will choose that option. The Penalty acts in the 

same manner as the Potential attribute for External Exits: the value increasingly makes the 

target appear further away and consequently less attractive. 

 

NOTE: 

If Assessed is selected from the Selection System list box this will automatically set the 

Congestion Threshold to 0%. 
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Figure 5-97: The use of the Assessed approach. 

 

NOTE:  

When the Assessed approach is selected, the Proportion boxes for each transit node within the 

group will be disabled and the values assigned to them ignored. 

 

The user can also employ a mixture of the two previous approaches (i.e. Proportion and 

Assessed) by selecting the Hybrid approach (i.e. by selecting Hybrid from the Selection System 

list box). Each component (and consequently the group) has a catchment area within which 

information on the group conditions can be collected. The congestion levels within this area 

can be established by the occupant. Once the Hybrid approach is selected the Congestion 

Threshold percentage edit box will become enabled. The Congestion Threshold percentage 

reflects the levels of congestion required for the occupant to assess the use of the components. 

The Congestion Threshold percentage therefore indicates the percentage of the catchment area 

occupied before occupants deem it to be congested and start assessing conditions. For instance, 

a Congestion Threshold of 30% indicates that 30% of a catchment area needs to be occupied 

before occupants start assessing the conditions. Higher values (e.g. 70%) indicate that the 

conditions need to be more severe before conditions are assessed (a smaller proportion of 

occupants will therefore assess the conditions).   

 

NOTE:  

The usual measure of Population Density was not employed given that the catchment areas are 

likely to vary in size and shape, such that measures of density may be misleading. 

 

Lift Shaft Opening transit nodes can also be grouped but only with other Lift Shaft Opening 

transit nodes. Agent behaviour in these transit node groups makes use of the values specified 

in the Lift Usage Control dialogue box instead of the values specified in the Transit Node Group 

dialogue box (see Section 4.6.5). Transit node groups can be created for all Lift Shaft Opening 

transit nodes for a given bank of lifts by right clicking on a Lift Shaft Opening transit node and 

selecting the Replicate Group Vertically option from the pop-up menu (see Figure 5-98). This 

will replicate the transit node group on all of the floors that the lift can service. This requires 

the selected Lift Shaft Opening transit node to be part of a transit node group (since this is the 

group that will be replicated on the other floors). 
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Figure 5-98: The Replicate Group Vertically menu option for Lift Shaft Opening transit 

nodes. 

 

5.17.2 Transit Node Control 

Shortcut: [Tools/Transit Node Control] 
The Transit Node Control function enables the user to view a list of transit nodes meeting user 

defined criteria. The Transit Node Control dialogue box can be accessed by selecting Tools 

from the menu bar, and the Transit Node Control option from the resulting menu (see Figure 

5-99).  Within the Transit Node Control dialogue box the user can control the transit nodes 

displayed via both the Node Type and Window list boxes. The Node Type list box controls the 

type of transit node currently displayed within the Transit Node Control dialogue box. Within 

the Node Type list box each of the six available types of transit node can be selected (i.e. 

Staircase, Escalator, Travelator, Corridor, Metered Gate and Lift Shaft Opening) in addition 

to an all option. Selection of the all option within the Node Type list box means that transit 

nodes will be displayed irrespective of their given type. The Window list box conversely 

controls on which floor the transit nodes must be located. Only transit nodes located on the 

specified floor will then be displayed. Within the Window list box each of the floors within the 

structure can be selected in addition to an all option. Selection of the all option within the 

Window list box means that transit nodes will be displayed irrespective of the floor on which 

they are located. When Transit Node Control dialogue box is opened both the Node Type and 

Window list boxes will be set to all, thereby ensuring that all transit nodes currently within the 

structure will initially be displayed, irrespective of both the floor they are on and their given 

type. 

 

 
Figure 5-99: The Transit Node Control dialogue box 
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5.17.3 Lift Control 

Shortcut: [Tools/Lift Control] 
The Lift Control function enables the user to quickly and easily substitute the attribute values 

from a given lift to other selected lifts, thereby preventing the user from having to manually 

update the attributes of multiple lifts individually – a time consuming and potentially error 

strewn process. The Lift Control dialogue box can be accessed by selecting Tools from the menu 

bar, and the Lift Control option from the resulting menu (see Figure 5-100).  Within the Window 

list box each of the floors within the structure can be selected in addition to an all option. When 

the Lift Control dialogue box is opened the Window list box will be set to all, thereby ensuring 

that all lifts currently within the structure will be displayed. If a specific floor is selected within 

the Window list box then only the lifts that service that floor will be displayed.  Hence a lift will 

only be displayed if its Nodes list contains a Lift Shaft Opening transit node on the selected 

floor (see Section 5.15.2). 

 

 
Figure 5-100: The Lift Control dialogue box 

 

To assign the attributes of a given lift to other lifts within the structure the user is first required 

to select which lifts are to be updated. Within the Lift Control dialogue box lifts can be selected 

individually by simply clicking on them within the Lift table, resulting in them becoming 

highlighted blue (see Figure 5-101). Multiple lifts can be selected simultaneously by holding 

down the CTRL key while selecting the lifts. Similarly, all lifts in the list between two given 

lifts can be selected by selecting the first lift within the Lift table and then while holding down 

the SHIFT key selecting the last lift.  

 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 346 

 

 

 

 

 

Figure 5-101: Assigning Lift attribute values via the Lift Control dialogue box 

 

Having selected the lifts the user is then required to define which individual lift’s attribute 

values they are to assume. This is achieved by simply right clicking the mouse button while the 

cursor is over the lift to be copied within the Lift table. Upon doing this a pop-up menu will be 

displayed (see Figure 5-101). From this pop-up menu the Assign to others option should then 

be selected.  Once this option is selected a dialogue box will then be displayed informing the 

user of both the lift whose attributes have been copied, and the number of lifts that they have 

been copied to (see Figure 5-101). 

 

In addition to substituting lift attribute values the Lift Control dialogue box also enables the 

user to both view and delete lifts.  The attributes of a lift can be viewed by simply double 

clicking on the lift within the Lift table, in order to display its corresponding Lift Properties 

dialogue box (see Section 5.15).   

 

NOTE: 

Within the Lift Control dialogue box only a single Lift Properties dialogue box can be opened 

at any given time. Hence if the user opens a lift’s corresponding Lift Properties dialogue box, 

then this dialogue box must be closed before another Lift Properties dialogue box can be 

opened. 

 

Users can also delete lifts within the Lift Control dialogue box, by first selecting them within 

the Lift table (in the same manner outlined previously) and then clicking the Delete button. The 

user will then be asked to confirm the deletion of the selected lifts.  It is important to note that 

deleting lifts in this manner will only delete the lift itself and not the Lift Shaft Opening transit 

nodes which effectively define the shaft within which it operates. Deleting lifts via the Lift 

Control dialogue box is therefore the same as right clicking on one of the lifts corresponding 

Lift Shaft Opening transit nodes and then selecting the Remove Lift Shaft option from the 

resulting pop-up menu. 
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5.17.4 Lift Usage Control 

Shortcut: [Tools/Lift Usage Control] 
The percentage of agents on each floor that use a lift can be specified in the Lift Usage Control 

dialogue box. This can be accessed by selecting Tools from the menu bar, and the Lift Usage 

Control option from the resulting menu (see Figure 5-102(a)).  Alternatively the Lift Usage 

Control dialogue box can be accessed by right clicking on the Floors item in the left Navigation 

window and selecting the Lift Usage Control option from the pop-up menu (see Figure 5-

102(b)). 

 

 

 

 

 

 

(a) (b) 

Figure 5-102: Accessing the Lift Usage Control dialogue box 

 

Selecting either of these options will display the Lift Usage Control dialogue box (see Figure 

5-103). This displays a number of fields related to how agents interact with a lift for a given 

floor. The default values for these fields are defined according to data collected via an 

international lift/stair usage survey conducted by FSEG [124, 166]. It is important to note that 

the default data applies to buildings up to 60 floors. User discretion is advised when applying 

the data to buildings greater than 60 floors. A description of each field can be seen below: 

 

 Consider Lift (Default-‘Default’): this defines the overall proportion of agents that 

would consider using a lift. If this is set to DEFAULT then the Consider Lift Value is 

set to 100%. This means that all agents on lift service floors would consider using a lift. 

If this is set to UNFAMILIAR then the Consider Lift Value is set to 50%.This means that 

approximately half of all agents on lift service floors will consider using a lift. If this is 

set to FAMILIAR then the Consider Lift Value is set to 33%. This means approximately 

a third of all agents on lift service floors will consider using a lift. If this is set to USER 

DEF then the Consider Lift Value is enabled and the user can specify the approximate 

percentage of agents that will consider using a lift. The UNFAMILIAR and FAMILIAR 

percentage values are based on data collected via an international lift/stair usage survey 

conducted by FSEG [124, 166] (Initial lift area assessment, see Theory Manual, Section 

2.3.11.2). 

 Consider Lift Value (%) (Default-100%): this defines the approximate percentage of 

agents that will consider using a lift. It is important to note that this relates to agents that 

would consider using a lift i.e. will make a choice of whether to use a lift or not at the 

start of a simulation. It does not mean the percentage of agents that will actually use a 
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lift: agents may redirect from the lift waiting areas due to congestion or lift wait time. 

A flow-chart showing agents decision making process with regards to using a lift and 

the associated dialogue boxes which control each stage can be seen in Figure 5-103. The 

Consider Lift option must be set to USER DEF in order to explicitly state this value.  

 Floor: the name of the floor that the other attributes are applied to. 

 % Choose Lift: the percentage of agents that will choose to use a lift at the beginning 

of the simulation. This value can be entered manually for each floor or the user can 

specify a regression formula located just below the main table. If an equation is used to 

define the percentage of people on each floor who will choose to use the lift then the 

corresponding % Choose Lift cells will be disabled. 

 Min-Max Wait Time / Distribution: agents are assigned a time (measured in seconds) 

that they are prepared to wait for a lift. This value is taken according to a probability 

distribution which can be accessed and modified for each floor by clicking on the 

corresponding Edit button in the first Distribution field. If a user defined distribution is 

specified then the Min and Max lift wait time values are automatically set according to 

the upper and lower the limits of the distribution and are also disabled. However, if a 

Uniform distribution is used then the Min and Max values can manually be set. Within 

the model the wait time for an agent starts from the moment they enter into the lift 

waiting area until the time the agent decides to leave the area (not the time the agent 

actually leaves the area). It is important to note that if the agents lift wait time has not 

expired and a lift in the bank starts to service the agent’s floor then their lift wait time 

will increase by a half. This is intended to represent an assumption that agents who see 

a lift servicing their floor are prepared to wait longer in anticipation that they will be 

able to board a lift soon. 

 Min-Max Congestion Threshold / Distribution: agents are assigned a lift congestion 

threshold. This is the maximum level of congestion that an agent will tolerate while 

waiting for a lift in the lift waiting area (measured in occ/m2).  While in the lift waiting 

area agents will constantly assess its corresponding level of congestion. If at any time 

the level of congestion exceeds the agent’s designated threshold the agent will redirect 

(i.e. use stairs). This threshold value is taken according to a probability distribution 

which can be accessed and modified for each floor by clicking on the corresponding 

Edit button in the second Distribution field. If a user defined distribution is specified 

then the Min and Max congestion threshold values are automatically set according to 

the upper and lower the limits of the distribution and are also disabled. However, if a 

Uniform distribution is specified then the Min and Max values can manually be set. 

 %Choose Lift Definition: this enables the user to specify if they wish to define the 

percentage of people who will choose to use the lift on each floor either via an equation 

or manually (i.e. User Def.). By default the percentage of people who will choose to use 

the lift on each floor is assigned according to an equation derived from an international 

lift/stair usage survey conducted by FSEG [124, 166, 167]. When the percentage of 

people on each floor who will choose to use the lift is defined by an Equation the 

corresponding % Choose Lift cells will be disabled, thereby preventing the user from 

modifying their values. 

 Regression input fields A-G: the % Choose Lift field can be automatically set for each 

floor by entering a regression formula by altering the field values A-G (the ‘X’ variable 

being the floor number). The regression formula is a generic but complex formula that 

can take the form of a constant, linear, quadratic, logarithmic or exponential form. The 

formula takes the floor number as a variable and then calculates the percentage of agents 

to choose a lift on each floor. The Max Floor field defines the maximum floor the 
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regression formula will be applied to. All floors higher than Max Floor will be assigned 

the same proportion as the one calculated for the maximum floor.  

 

 
Figure 5-103: Consideration to use a lift flow chart and Lift Usage Control dialogue box 

 

5.17.5 Queue Window 

Within Scenario Mode, the user is able to generate a number of different queuing systems, 

including single-queue/single-server, single-queue/multi-server and multi-queue/multi-server. 

Once queues are created, it is necessary to direct the appropriate number of people to these 

queues within Population Mode (see Chapter 4), using the appropriate itinerary task (i.e. a 

Queue task). 

 

Each queuing system is formed from one route (along which people queue) and at least one 

server (where the occupant is processed, potentially experiencing a delay). An example of the 

relationship between routes and servers is shown in Figure 5-104. 
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Figure 5-104:  The routes (Q1-Q3) along which occupants queue to reach the associated 

servers (S1-S3) where a delay is experienced. 

 

This may represent a range of different real-world activities including waiting for a cashpoint, 

buying a ticket, or any event for which an individual will queue and which can be represented 

by a delay. 

 

5.17.5.1 Basic Queue Definition 

Queues are defined via the Queue Editor dialogue box, obtained by selecting the Queue Window 

option from the Tools menu (see Figure 5-105). 
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Figure 5-105: The Tools menu from which the Queue Window can be selected. 

 

Once selected, the user will be presented with the Queue Editor dialogue box (see Figure 

5-106). It is via this dialogue box that the user can both create and remove individual queues as 

well as editing their elements; namely, the location and performance of its associated servers, 

the route that occupants queuing are required to follow, as well as the name of the queue itself.  

 

 
Figure 5-106: The Queue Editor dialogue box. 

 

Figure 5-106 depicts a single queue (i.e. queue_1) after the CREATE button has been clicked. 

To modify the queue name, the queue must first be selected, by clicking on the button 

containing the default name. Once selected, a pair of inverted commas will appear around the 

name. To modify the name, the same button must be clicked again to retrieve the Queue Info 

dialogue box shown in Figure 5-107. Alternatively, the same effect could have been achieved 

by first selecting the queue in the manner defined above and then clicking the EDIT button. 
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Figure 5-107: The Queue Info dialogue box. 

 

To define the server(s) associated with a given queue, the queue panel must first be selected in 

the manner defined above and then the SERVERS button clicked in order to bring up the Servers 

dialogue box (see Figure 5-108). To create a Server the user is first required to enable the Auto 

Insert checkbox before clicking on the desired nodal location (in a manner similar to that used 

when defining itinerary tasks, see Chapter 4). Successfully creating a server in this manner will 

in turn result in a Server being added to the server list within the Server Editor dialogue box.  

 

Each created server comprises three essential parts; namely, the server button (which is used to 

both display the name of the server and select it), and the Min and Max edit boxes (which are 

used to define the time range in seconds between which the time taken to serve each occupant 

utilising that server is calculated). Figure 5-108 below shows an example where two servers 

have been defined by the user, each with a service time of between 20 and 60 seconds. Servers 

can be selected in the same manner as queues within the Queue Editor dialogue box, enabling 

them to be individually removed by clicking the REMOVE button, or alternatively enabling the 

user to jump to their given location within the geometry by clicking the SHOW button. In an 

attempt to prevent confusion in instances where multiple queues are being defined, the name of 

the queue to which the server(s) relates is also stated along the top of the dialogue box (i.e. the 

servers shown in Figure 5-108 both relate to Queue_1).  

 

 
Figure 5-108: The Server editor dialogue box. 

 

NOTE: 

Each queue must contain at least one server. 

 

Each server in the queue can either be assigned a delay between user-defined values using a 

uniform random distribution, or according to a user-configured delay distribution. For instance, 

in Figure 5-108 Server 1 has a uniform random delay distribution, whereas Server 2, which has 

the greyed out range values, has been assigned a delay distribution. To access the delay type 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 353 

for a particular server simply select the server, via the Server button, and then click the Delay 

Type dialogue button. This will display the Server Delay Editor (see Figure 5-109). 

 

 
Figure 5-109 : Server Delay Type Control Dialogue Box 

 

The Server Delay Editor (see Figure 5-109) allows the user the ability to assign sophisticated 

delay ranges to each server. There are five types of distribution for the user to choose from, as 

listed within Table 5-16. 

 

Table 5-16: Options for server delay distributions 

Type Description 

uniform A standard uniform distribution between the min and max 

attributes provided (default) 

user-defined A user-defined delay distribution. The user will need to 

assign the distribution manually. 

tmstandard A delay distribution for normal Ticket Machines that accept 

coins, bank notes and cards and provide change. [144] 

tmnochange A delay distribution for Ticket Machines that accept coins, 

bank notes and cards, but do not provide change.[144] 

tmgeneral A distribution which combines data from the tmstandard and 

tmnochange delay distributions. 

 

The small Graph in the top right hand corner of Figure 5-109 is provided as a quick indication 

of the shape or format of the data entered. The graph itself is not intended to be used for 

evaluating the curve, but merely as an aid for entering the data. For example, typing errors in 

entering the data may show up as gaps or spikes in the curve. 

 

The buttons on the Server Delay Editor provide the options listed within Table 5-17. 
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Table 5-17: Options within Server Delay Editor 

Button Description 

Append/Insert Inserts a new data entry after (Append) or before (Insert) the currently 

selected data in the delay curve 

Remove Deletes the currently selected data entry in the delay curve 

Clear Clears all the data entries from the delay curve. 

Norm. Redistributes the probability values of the data entries so they total one 

OK Exit the Server Delay editor 

 

In order for a queue to be used, a route has to be associated with it. To define/edit the route 

associated with a given queue the queue must once again first be selected within the Queue 

Editor dialogue box (see Figure 5-106) and then the Route button clicked in order to bring up 

the Edit Route dialogue box (see Figure 5-110). Within this dialogue box the user has the ability 

to define the nodal locations or Waypoints along the queuing route between which occupants 

within the queue are required to wait. Figure 5-110 shows an example where three nodal 

locations have been defined by the user. 

 

 
Figure 5-110: The Edit Route dialogue box. 

 

NOTE:  

For the use of waypoints within regular itineraries the user to referred to Chapter 4. 

 

The waypoint at the top of the list (i.e. node CE 866) represents the location of the front of the 

queue, with each subsequent waypoint representing a location nearer the back of the queue. The 

last waypoint (i.e. node CE 835) represents the back of the queue. The ability to provide several 

nodal locations enables the production of relatively complex queue designs.  

 

NOTE:  

These WayPoints do not appear in an occupant's individual list of tasks. 

 

Waypoints can be selected, in the same manner as queues within the Queue Editor dialogue 

box, enabling them to be Appended/Inserted or Removed. In an attempt to prevent confusion 

where multiple queues are defined, the name of the queue to which the current route relates is 

also stated within the dialogue box (i.e. the route defined in Figure 5-110 relates to Queue_1). 

Having defined the waypoint list the user can check the route graphically by clicking the Label 

button. Figure 5-111 below shows a graphical representation of the Route defined previously in 

Figure 5-110. Here, waypoint 1 (representing the front of the Queue) corresponds to the node 
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CE 866, while waypoint 2 corresponds to the node CE 863 and waypoint 3 (representing the 

back of the queue) corresponds to the node CE 835. The location of the server is also visible. 

 

 
Figure 5-111: The display of a given route. 

 

Although queues (i.e. the locations of the servers) will by default be displayed while defining 

the queues via the Queue Editor dialogue box, outside of this both the display and selectability 

of queues is controlled by the Graphical Control dialogue box (see Figure 5-112) which is 

available within any mode.  It is worth noting however that enabling queues to be selectable 

within any mode does not mean that they can be moved within any mode. By default servers 

can only be moved/relocated within the Scenario mode.  

 

NOTE:  

The user is able to move the nodal locations forming a route while in Scenario Mode assuming 

that the locations have already been created and that Queues are Displayed and Selectable. 

However, the user is only able to add nodal locations to the route directly from the Edit Route 

dialogue box. 
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Figure 5-112: The graphical control dialogue box. 

 

Having defined all aspects of the queues the user can send occupants to them in the conventional 

manner via the use of itineraries. The itineraries for individual occupants are created via the 

Itinerary dialogue box within Population Mode (see Chapter 4). There are a range of route / 

server configurations that can be produced. The manner in which people are associated to each 

server is associated in Chapter 4. 

 

Several different queue/server configurations can be produced. A single-queue/single-server 

requires people to queue along one route and use one server (see Figure 5-113(a)). No decisions 

are then available to those following this route. A single-queue/multi-server requires people to 

queue along one route, but on reaching the front of the queue (i.e. the end of the route) they are 

able to select between several servers (see Figure 5-113(b)) 

 

  
(a) (b) 

Figure 5-113: Representation of (a) single-queue/single-server and (b) a single-

queue/multi-server. 
 

When an occupant is faced with multiple servers, they will wait for the first server to become 

free, and then use it. If several servers are free, they will move towards the nearest server. If 

none are free, they will wait at the closest point of the route until one becomes free. 
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5.17.6 Potential Assignment 

Shortcut: [Tools/Potential Assignment] 
A potential node summary dialogue box can be displayed by selecting Tools then Potential 

Assignment from the menu in scenario mode. This provides a quick way of changing potential 

values for all internal exits, external exits and Attractor nodes. This is illustrated within Figure 

5-114, where a simple geometry has two external doors and one internal door. 

 

 
Figure 5-114: Using the Potential Assignment option to control internal/external exit 

potential values 

 

5.17.7 Auto Find Compartments 

Shortcut: [Tools/Auto Find Compartments] 
The Auto Find Compartments function analyses the Internal Exits present within a geometry to 

identify rooms and then automatically generates the corresponding Compartment zones (see 

Section 5.5).  To utilise this function, select the Auto Find Compartments option from the Tools 

menu (see Figure 5-2). To demonstrate the effect of the Auto Find Compartments function, 

consider the simple geometry shown in Figure 5-115. This geometry comprises seven 

rectangular rooms connected to a central corridor leading directly to an exit. Across the entrance 

to each of the seven rooms Internal Exits have been placed (shown as red nodes in Figure 

5-115). 

 

 
Figure 5-115: An example geometry with Internal exits placed across the entrance to 

each of the seven rooms located off of the main corridor 

 



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 358 

Upon selecting the Auto Find Compartments option from the Tools menu a message will be 

displayed on the toolbar confirming that the function has finished generating the Compartment 

zones (see Figure 5-116). 

 

 
Figure 5-116: Conformation that the Auto Find Compartments function has finished 

 

The Compartment zones generated as a result of the Auto Find Compartments function can be 

viewed in the Zone Editor dialogue box, either by selecting the Zone option from within the 

Tools menu, and then selecting the Edit Zone option from the resulting submenu, or 

alternatively merely clicking on the Edit Zone button on the toolbar . Within the Zone Editor 

dialogue box the Compartment zones generated can then be viewed by selecting the 

Compartment option within the Zone Type list box.  Figure 5-117 below shows the eight 

Compartment zones automatically generated from the geometry show previously in Figure 

5-115.   

 

 
Figure 5-117: The Zone Editor dialogue box displaying the Compartment zones 

generated by the Auto Find Compartments function 

 

The areas corresponding to each of the eight Compartment zones automatically generated from 

the geometry shown in Figure 5-115 can be seen below in Figure 5-118. 
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Figure 5-118: The areas corresponding to each of the eight Compartment zones 

automatically generated from the geometry shown in Figure 5-115 

 

5.17.8 The Local Potential Option 

Shortcut: [Tools/Local Pot.] 
The Local Potential option allows the Attractor/Internal Exit nodes to modify the global 

potential map.  If this option is not selected, the potential set on Attractor / Internal Exit nodes 

is ignored and reset when the potential map is calculated.  To switch this option on and off, 

select the Local Pot. Item from the Tools menu (see Figure 5-2). 

 

5.17.9 The Floor Potential Option  

Shortcut: [Tools/Floor Pot.] 
This option allows the user to control the potentials generated on a floor by floor basis. It 

effectively means that evacuees navigate according to the connectivity of the floors rather than 

the location of the exit points. 

 

5.18 View Menu 

The following sections concern functions from the View menu. 

 

5.18.1 Contour 

Within Scenario mode two basic contours are available, namely the Potential Map contour and 

the Potential Route Map contour. Each of these contours are designed to view the spread of the 

potential map throughout the geometry and are explained in the following sections. 

 

5.18.1.1 Potential Map Contour 

Shortcut: [View/Contour/Potential Map] 
The Potential Map Contour function allows the potential map to be viewed as a coloured 

contour map, without examining the catchment area for each exit individually (see Section 

5.8.3).  Two example maps are shown in Figure 5-119.  To view the potential map contour, 

select the Contour option from the View menu,  and then Potential Map from the resulting 

Contour submenu (see Figure 5-2). 
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Figure 5-119: Two potential map contours of the same geometry, one with a single exit, 

and one with two exits. 

 

5.18.1.2 Pot. Route Map Contour  

Shortcut: [View/Contour/Pot. Route Map] 
The functionality of this feature is identical to that provided in Simulation mode (see Chapter 

6). It is included here to enable the user to examine the spread of the potential map whilst they 

may be editing aspects of the geometry that may impact upon its spread.  

 

This feature demonstrates the direction that the potential map flows. This is achieved by 

displaying arrows pointing towards the locations with a lesser potential value. The same colour 

scheme is used as in the standard Potential Map Contour (see Section 5.18.1.1). To view this 

feature, select the Pot. Route Map option on the Contour sub-menu from the View menu. 

 

 
(a) 

 
(b) 

Figure 5-120: a) Potential Map contour b) Potential Route Map contour. 

 

TIP: 

Viewing the global potential map is very useful when attempting to understand the behaviour 

of an individual or when attempting to set exit potentials. 

 

NOTE: 

The Potential Map and Potential Route Map contours also display the potential in regions 

modified by Attractor nodes. 

 

NOTE: 

The Potential Map and Potential Route Map contours are accessible in both Scenario and 

Simulation modes. 

  



Chapter 5 - Defining A Scenario 

© 2017 University of Greenwich 361 

 

5.18.2 Optimum Exit Statistic 

Shortcut: [View/Optimum Exit Stat] 
The model provides an estimate of the number of people that should be assigned to each exit to 

achieve the maximum flow rates out the enclosure. This is a crude statistic that doesn’t take 

into account travel times or the response times of the individuals. It is therefore based on the 

assumption that the individuals arrive at the exits simultaneously, the calculation is then made 

according to the widths of the exits and the flow rates applied to them and is therefore totally 

dependent upon the levels of congestion that would be generated around the exit.  

 

NOTE: 

If free flow conditions are applied to an exit (i.e. the flow rates are calculated rather than 

imposed), then the calculation will not be able to be made. 

 

To access the Optimum Exit Usage Dialogue select Optimum Exit Stats from the Tools pull 

down menu in Scenario Mode.  

 

 
Figure 5-121: Optimum Exit Usage Statistic 

 

The Optimum Exit Usage dialogue box lists all the exits together with two values (see Figure 

5-121). The first of these values is the number of people that should be assigned to the exits 

from the current population to produce an optimal result. The second value is the overall 

proportion of the population that is assigned to the exit. These values are calculated as follows: 

A number of variables are utilised 

 

n=total number of exits  

P= total number of occupants in structure  

Exits are labelled {E1, E2, E3 ...... En} 

Flow Rate attached to exit {f1, f2, f3.....fn}  

Width if each exit {w1, w2, w3.......wn}  [i.e. number of arcs connected to exit]  

 

The capacity of each exit {C1,C2, C3.....Cn} is then calculated, where  

C1=f1 x w1, C2 = f2 x w2.... 

 

The total capacity for the structure can then be calculated as 

Total capacity Tc = C1+C2+C3....+Cn. 

 

The proportion of the population that should then be assigned to each exit to achieve optimal 

results is then calculated as 
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p1 = C1/Tc 

p2 = C2/Tc 

p3 = C3/Rc........... 

 

Eventual number of occupants assigned to each exit (where P is the total population size) 

E1 Population = P x p1 

E2 Population = P x p2 

… 

En Population = P x Pn 

 

This calculation is based on the assumption that the exits have a flow rate restriction associated 

with them and that the overall evacuation time is entirely dependent upon the performance of 

the exits (i.e. that the experiences of evacuees en route to the exit were not as consequential as 

the experiences at the exit. Obviously the validity of these assumptions will depend upon the 

scenario being examined. Indeed in the majority of cases, especially those with complex 

response time distributions and exit usage, these assumptions may not necessarily be valid. The 

user should only use this tool as an indicator and then only at their discretion. 

 

5.18.3 Area Summary 

Shortcut: [View/Area Summary] 
The Area Summary function calculates the approximate area in square metres of a selected 

region, as well as calculating the number of people that it contains.  To utilise this function, first 

select an area using the Select tool, and then select the Area Summary option from the View 

menu (see Figure 5-2). This will then provide an approximation as to the area within the selected 

region and the number of people within this area (see Figure 5-122). 

 

 
Figure 5-122: The result of the Area Summary function. 

 

NOTE: 

The Area Summary function calculates the area of the selected region by determining the 

number of nodes used to define the area. Thus the area may be slightly different from that 

specified in the actual CAD drawing. 
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5.18.4 VCA Summary 

Shortcut: [View/VCA Summary] 
The VCA Summary function calculates both the size (in m2) and percentage of the overall 

structure covered by the Visibility Catchment Area of signs within the geometry. The Visibility 

Catchment Area (VCA) of a sign refers to the region from where the sign is visible. It is 

important to note that in order for the VCA Summary function to work correctly the user needs 

to have previously calculated the VCA of each sign, and hence generated each sign’s 

corresponding Visibility Sign zone (see Section 5.7). To utilise this function, select the VCA 

Summary option from the View menu (see Figure 5-2). Once the VCA Summary function is 

selected a message will be displayed informing the user that the information relating to the 

VCA of each sign has been added to the Output tab of the Data Window (see Figure 5-123).  

 

 
Figure 5-123: The message displayed once the VCA Summary function has been 

selected. 

 

NOTE: 

To display the Data Window select the Interface option from the View menu in any mode, and 

ensure that the Data Window option in the resulting submenu is selected. 

 

Figure 5-124 below shows an example of the VCA Summary produced within the Output tab. 

The VCA Summary consists of two main sections. The first section contains a summary of the 

Visibility Catchment Area (VCA) of each of the signs within the structure. For each sign, the 

total area (m2) covered by its VCA is stated, along with the percentage that the area represents 

of the entire geometry. The second section contains a summary of both the total area within 

each of floors from which signs are visible and the percentage of the entire geometry that the 

given area represents.   

 

 
Figure 5-124: The VCA Summary displayed within the Output tab of the Data Window 

 

It is important to note that within a given floor the total area from which signs are visible is not 

necessarily the sum of the VCA areas of the all the signs on that floor.  This is because areas 

within a given floor from which multiple signs are visible (i.e. nodes which appear in the VCA’s 

of multiple signs) are only counted once.  To demonstrate this point consider a simple example. 

Figure 5-125 below shows a square geometry (10m x 10m) comprising two signs, namely 

Sign_1 and Sign_2.  The geometry includes a square room (5m x 5m) within the bottom right 
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of the structure with a 1m wide exit to the outer area. The VCA of Sign_1 is shown in yellow, 

while the VCA of Sign_2 is shown in red.  It is important to note that the VCA’s of each sign 

shown in this example are not intended to be accurate, merely to demonstrate a point. In this 

example, the total area of the VCA of Sign_1 would be 50m2 (i.e. 5m x 10m), while the 

percentage that it represents of the entire geometry would be 50% (since the area of the entire 

structure is 100m2). Similarly, the total area of the VCA of Sign_2 would also be 50m2, with 

the percentage that it represents of the entire geometry also 50%.  However, if we consider the 

area within the floor from which signs are visible, then the area would only total 75m2, and 

hence would not be merely the sums of the VCA’s for Sign_1 and Sign_2 (i.e. NOT 50m2 +50m2 

= 100m2). 

 

 
Figure 5-125: The VCA of two signs within a simple square geometry 

 

In addition the VCA Summary function also produces a summary of both the total area within 

the entire geometry from which signs are visible and the percentage of the entire geometry that 

the given area represents.  It can therefore be seen that the VCA Summary produces useful 

information regarding the degree of coverage provided by the signage system present within 

the structure, and hence provides an indication of its potential effectiveness. 

 

NOTE: 

The VCA Summary function calculates the area of each sign’s VCA based upon the number of 

nodes within its corresponding Visibility Signs zone (see Section 5.7). Thus in each case the 

size of the VCA area and the percentage of the entire structure that it represents should only be 

considered approximate. 
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5.19 Miscellaneous Functions 

Numerous other functions are available in Scenario mode. These functions are consistent with 

the previous definitions in Chapters 3 and 4. These functions are specifically designed to affect 

the graphical appearance of the interface, to undo functions or to navigate between modes. 

Briefly these functions are 

 

View/ 

Boundary 

The function of the boundary command is to allow an outline of the 

current geometry to be drawn. 

View/ 

Find 

This function allows the user to locate either nodes or people within 

the geometry. 

View/ 

Display 

This function allows the identified objects  in a selected area to be 

viewed 

View/ 

Interface 

This function allows the user to control the appearance of the user 

interface within buildingEXODUS. 

View/ 

Model Description 

This function allows the user to define a description of the 

geometry/scenario in order to easily differentiate from others. 

View/ 

Redraw 

The redraw function corrects the geometry window that has become 

cluttered with extraneous graphics 

View/ 

Zoom 

This function allows changes in the level of magnification on a 

particular region 

View/ 

Show Grid 

Determines whether the grid is displayed in each of the geometry 

windows. 

Edit/ 

UNDO 

This function cancels the last action performed by the user 

Edit/ 

Goto 

This function allows the user to move between the buildingEXODUS 

modes 

 

5.20 Leaving Scenario Mode 

Shortcut: [Edit/Goto/Simulation Mode]  
On completing the scenario definition the simulation is ready for execution. This is achieved in 

SIMULATION mode. To move to SIMULATION mode, select Edit from the menu bar, Goto 

from the menu and then the Simulation Mode item from the pull-down menu (see Figure 5-2). 

Alternatively, press the MODE ADVANCE button on the toolbar (see Figure 5-1). 
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CHAPTER 6: EXECUTING A SIMULATION (SIMULATION MODE) 
 

6.1 Simulation Mode Overview 

In Simulation mode, the user starts the evacuation and may interactively view the evacuation.  

A number of controls are provided so that a simulation can be paused, replayed, jogged etc. 

enabling the evacuation to be examined in detail. Simulation mode also provides several 

graphical indicators to monitor the progress of the evacuation. The user also has the option of 

dumping evacuation data to an output file for subsequent analysis and for later replays.  In 

software levels B and C, the user can also generate a file to be input into vrEXODUS. 

 

Executing a simulation typically involves five basic steps, 

 

1. Setting RuleBase options (Section 6.4) 

2. Randomising/Swapping locations (Chapter 4) 

3. Running the simulation (Section 6.7) 

4. Interrogating objects (Section 6.8.3) 

5. Viewing results (Section 6.8) 

 

The user also has the option of executing a simulation in Batch Mode (see Section 6.7.2).  In 

this mode, simulations are executed without the interactive graphics and without requiring user 

activity. As graphics are suppressed in Batch Mode, run times can be considerably less than 

those for the identical case in interactive mode. 

 

 
Figure 6-1: Simulation mode menu bar and toolbar 
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Table 6-1: Toolbar buttons specific to Simulation Mode 

Button Name Menu Equivalent Explanation 

 
Reset Simulation - Reset Resets a simulation 

 
Play Simulation - Play/Continue Starts/Continues a simulation 

 
Step - Advances simulation one step 

 
Pause Simulation - Pause Pauses simulation 

 
Replay Simulation - Replay Replays simulation to current point 

 
Person Select Edit - Select – People Select Selects a person i.e. NOT nodes 

 
Person Shape* View - Shape – Person Changes appearance to person shape view 

 Block Shape* View - Shape – Block Changes appearance to block shape view 

 
Arrow* View - Shape - Arrow Changes appearance to arrow shape view 

 
Pop. Density* 

View – Contour – Pop. 

Density 
Displays population density contours 

 
Potential Map* 

View – Contour – 

Potential Map 
Displays the spread of the potential map 

 
Potential Route 

Map* 

View – Contour – Pot Route 

Map 

Displays the spread of the potential map 

and the direction of movement at all nodal 

locations 

 
Footfall* View – Contour – Footfall Displays the footfall contour 

 
Temperature* 

View – Contour – 

Temperature 
Displays the temperature contour 

 
Smoke* View – Contour – Smoke Displays the smoke contour 

 Congestion* 
View – Contour – 

Congestion 
Displays the congestion contour 

 
VR* Simulation–VR Save Generates a VR output file 

 
Data Output* Rulebase-Data Output 

Options 

Access to data output controls 

 
Hazard Control* Rulebase–Hazard Options Access to hazard control options 

 
Behaviour Control* Rulebase–Behaviour 

Options 

Access to behavioural controls 

 
Options Library* Rulebase- Options Library Allows the behavioural controls to be 

saved and used again. 
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Figure 6-2: Menu items specific to Simulation mode 

 

6.2 Manipulating Objects 

Whilst in Simulation mode the user is able to interact and interrogate a variety of object types. 

When doing so the user has two basic options in retrieving information in relation to one of these 

options. The user may double-click (using the left mouse button) on the icon representing the 

object in the workspace, which will produce a dialogue box, providing access to the attributes of 

that object which may be examined and possibly edited. Alternatively the user may right click 

(once) on the object, which will then generate a menu from which the user may select information. 

The nature of this menu may change from object to object according to the data available. The 

method used is entirely down to the preferences of the individual. 

 

6.3 Edit Menu 

The Edit options relate to the movement between modes (see Chapter 3), the method of 

selecting objects within buildingEXODUS (see Chapter 3) and the ability to relocate 

individuals (see Chapter 4). In addition, the Edit options also provide the ability to clear both 

the Data Window and Main Graph of results from previous simulation runs. 

 

6.3.1 Clearing The Data Window 

Shortcut: [Edit/Clear/Data Window] 

As simulations are run within buildingEXODUS their results are automatically added to the 

Output tab within the Data Window located across the bottom of screen (see Chapter 2). Within 

the Output tab new simulation results are appended to the end of results generated previously. 

Consequently, at any given time the Output tab may contain results from multiple simulation 

runs. The number of lines available to display information within the Output tab is limited. 

Consequently as new simulation results are added to the Output tab previous results may be lost. 

To clear all previous simulation results from the Data Window select Edit from the menu bar 

and the Clear item from the pull-down menu, then select the Data Window option from within 

the Clear submenu (see Figure 6-2). 

 

NOTE: 

The Data Window can be enabled in any mode by selecting the Interface option from the View 

menu and then selecting the Data Window option from the resulting submenu.   
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6.3.2 Clearing The Main Graph 

Shortcut: [Edit/Clear/Main Graph] 

The buildingEXODUS graphs are drawn as the simulation progresses.  The previous five graphs 

are maintained even when new geometries are loaded.  To clear the graphs, select Edit from the 

menu bar and the Clear item from the pull-down menu, then select the Main Graph option from 

within the Clear submenu (see Figure 6-2). 

 

NOTE: 

The Clear Main Graph function only works at the end of a simulation. 

 

NOTE: 

If the user has the Navigation window enabled, then they may gain access to the main graph 

simply by selecting the Main Graph option from the tree of options available. 

 

6.4 Simulation Menu 

The Simulation options relate to the control of the execution of the current simulation, the 

exporting of virtual reality files (see Section 6.4.7) the import or export of replay files, which 

are addressed in Section 6.4.6 as well as several features that assist in the generation of results. 

 

6.4.1 Begin / Pause / Reset / Replay / Stop 

These options replicate the functionality of the toolbar in SIMULATION MODE. Their 

functionality is summarised in Table 6-2. 

 

Table 6-2: Functionality of simulation options. 

Option Functionality 

Begin Starts simulation 

Pause Pauses simulation 

Reset Resets simulation 

Replay Replays the previous 

simulation* 

Stop Halts simulation 

*The simulation must be completed before this function can be used. 

 

6.4.2 Speed Control 

Shortcut: [Simulation/Speed Control] 

This enables the user to control the speed at which the simulation runs (i.e. slow it down), 

thereby enabling the movement of the agents within the structure to be more easily observed. 

By selecting the Enable Speed Control checkbox (see Figure 6-3), the simulation will not 

merely run as fast as possible.  Instead, the speed of the simulation will be dependent upon the 

value defined within the Rate text box. This value defines the desired speed of the simulation 

relative to real time. Once defined, buildingEXODUS will then ensure that the simulation runs 

at (or as close as possible) to the defined speed. Hence, defining a Rate value of 1.0 will mean 

that the simulation will attempt to run at real time (i.e. 1 second of simulated time will be 

displayed every second of real time). Similarly, defining a Rate value of 2.0 will mean that the 

simulation will attempt to run at 2 times real time (i.e. 2 seconds of simulated time will be 

displayed every second of real time). The default Rate value is 2.0.  
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Figure 6-3: The Speed Control dialogue box. 

 

The speed that a simulation is currently running at (relative to real time) can be viewed on the 

far right of the toolbar during run time (i.e. 29.87x real time, see Figure 6-4). 

 

 
Figure 6-4: The toolbar showing the speed that the simulation is currently running at 

relative to real time. 

 

NOTE:  

The speed control functionality in versions of buildingEXODUS prior to v6.1 differed slightly 

from the implementation outlined above. Within these versions, users were instead effectively 

required to define a delay in order to control the speed of the simulation. 

 

6.4.3 Simulation Control 

Shortcut: [Simulation/ Simulation Control] 

This feature enables the user to set an artificial time limit on the length of the simulation. This 

is particularly useful when examining scenarios that involve Source nodes and which may not 

normally have a natural end to the simulation.  

 

Selecting the Enable Max. Sim. Time option (see Figure 6-5) will force the model to refer to the 

maximum simulation time provided by the user. The user must provide this figure by entering 

a value in the Max. Sim. Time edit box specifying the end point of the simulation (in seconds).  

Once this point is reached in the simulation, the simulation will end and all of the data that has 

been specified to be generated at the end of the simulation will then be created in the usual 

manner. By default the Max. Sim. Time is 3600 seconds (i.e. the simulation will terminate after 

one hour). 

 

 
Figure 6-5: The Simulation Control dialogue box. 

 

Once the specified point is reached the data that the user has specified to be generated will be 

created as if the simulation had finished in a normal fashion. 

 

6.4.4 Person Scroll 

Shortcut: [Simulation/Person Scroll Control] 
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This feature enables the user to scroll through the population present within the geometry to 

locate their current positions.  To access the Person Scroll function, select Simulation from the 

menu bar and the Person Scroll item from the pull-down menu (see Figure 6-2).  Once the 

Person Scroll option has been selected the user is presented with the PERSON SCROLL 

dialogue box (see Figure 6-6). 

 

 
Figure 6-6: The Person Scroll dialogue box. 

 

The PERSON SCROLL dialogue box allows the user to scroll through each person still present 

within the geometry in sequence using the PREV and NEXT buttons.  When toggling between 

people the node occupied by the currently selected person is highlighted to indicate their 

position and the title of the dialogue box is updated to indicate their corresponding unique Label 

number. In addition, the window containing the highlighted node will be automatically opened, 

its corresponding zoom level reset and the window centred on the highlighted node to allow the 

area in which the node is located to be shown. This feature is particularly useful for locating 

small numbers of people within large complex geometries. 

 

NOTE: 

The Person Scroll function only works while a simulation is playing or paused and while people 

are present within the geometry.  Attempting to access the Person Scroll function either before 

the commencement of a simulation or after its completion will result in the Person Scroll 

dialogue box not being displayed.  

 

6.4.5 PAX Follow 

Shortcut: [Simulation/Pax Follow Control] 

This feature enables the user to automatically follow a given individual as they make their way 

through the structure. To use the Pax Follow feature (and hence to follow a given agent) the 

user needs to firstly enable the Pax Follow feature itself and then identify the person required 

to be followed. To enable the Pax Follow feature the user is required to select the Enable Pax 

Follow check box within the Pax Follow Control dialogue box (see Figure 6-7). Once selected, 

the Person ID edit box will become enabled, enabling the user to identify the required person 

by specifying their corresponding unique Label number (see Figure 6-7). 

 

 
Figure 6-7: The Pax Follow Control dialogue box.  

 

Having both enabled the Pax Follow feature and defined the person to be followed 

buildingEXODUS can then be run as normal. When running a simulation, the window 
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containing the specified individual will be automatically opened, its corresponding zoom level 

reset to the default setting, and the window centred on the person to allow the area in which the 

person is located to be shown. In addition, the person will also be highlighted, with a black 

square appearing around their currently occupied node. As the individual moves through the 

geometry, the window will automatically re-centre on the specified person, thereby keeping 

them fixed within the centre of the current window at all times. As the specified individual 

moves between floors/ windows buildingEXODUS will also automatically detect the specified 

persons current window and bring it to the front of the screen (i.e. in front of all the other 

windows that are currently open). At any time during the running of the simulation the user has 

the ability to disable the PAX Follow function, or alternatively change the person that is required 

to be followed by changing the Person ID value in the manner defined previously. 

 

NOTE: 

The Pax Follow function will only automatically follow a specified individual if that individual 

can be located within the geometry. Individuals who have already exited the simulation (i.e. 

who have either successfully evacuated or died) will therefore be unable to be located, and 

hence cannot be tracked using the Pax Follow function. 

 

6.4.6 Replay files 

 

6.4.6.1 Movie And Movie-Replay Files 

Simulations saved to disk may take one of two forms, either a Movie File or a Movie-Replay 

File (in this instance, they are collected together under the general term Replay files).  While 

both file types allow a simulation to be replayed at a later time, the information contained in 

each file type is different.  When replaying a Movie File (.EMX files), it is NOT possible to 

interrogate the objects in the simulation.  However, an advantage of this format is that the speed 

of the replay may be controlled, e.g. twice, three, four, etc times the normal speed.  For this 

reason, Movie Files (.EMX files) are best suited for presentation purposes.  In contrast, Movie-

Replay Files (.RUX files) allow full interrogation facilities of the objects in the simulation, 

thereby allowing an in-depth analysis.  The disadvantages with this file format are that the 

replay speed cannot be controlled.  

 

NOTE: 

The user is now able to control the speed of a RUX file by using the SPEED CONTROL, 

described in Section 6.4.2. However the maximum replay speed of the RUX is limited by the 

simulation’s maximum speed where the EMX doesn’t have this limitation. 

 

NOTE: 

Movie (.EMX) and Movie-Replay (.RUX) Files are available in all levels of buildingEXODUS 

(i.e. levels A, B and C). 

 

NOTE: 

When replaying a Movie (.EMX) file at speeds greater than normal, graphical information is 

lost as some of the frames are dropped out of the playback. Thus, if very high playback speeds 

are selected, individuals may appear to jump from one location to another. 
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6.4.6.2 Saving Movie And Movie-Replay Files In Simulation Mode 

Shortcut: [Simulation/Replay File/Save] 

When a simulation has completed, it is possible to save the simulation for later viewing as a 

Movie-Replay File (.RUX file) or a Movie File (.EMX file) (see Section 6.7.3).  To generate 

either type of file, the simulation MUST have finished – but the RESET button NOT pressed.  

Both kinds of file are generated using the same method, the only difference being the extension 

supplied to the file. 

 

To save a Movie-Replay File, wait until the simulation has finished and select the Save item 

from the Replay File sub-menu available via the Simulation menu.  A dialogue box appears 

prompting for the name of the file.  The extension name given to the file must end in .RUX, for 

example “MYFILE.RUX”.   

 

To save a Movie File, repeat the same procedure, but ensure the extension given to the file name 

is “.EMX”, for example “MYFILE.EMX”. 

 

Both Movie-Replay (.RUX) and Movie (.EMX) files may be played either within Simulation 

Mode (see Section 6.7.3) or using the EXODUS Movie Player Utility (see Appendix C). 

 

6.4.6.3 Replaying Movie-Replay Files And Movie Files In Simulation Mode 

Shortcut: [Simulation/Replay File/Load] 

Movie-Replay (.RUX) Files and Movie (.EMX) Files are essentially recordings of simulations, 

generated either in Simulation mode (see Section 6.1) or in Batch Mode (see Section 6.7.2).  

 

To view either a Movie-Replay (.RUX) File or a Movie (.EMX) File, the geometry used to 

generate the file must first be loaded.  If the geometry corresponding to the Movie-

Replay/Movie File is not loaded, the results are meaningless. 

 

When the geometry has loaded, put buildingEXODUS into Simulation mode.  To load a Movie-

Replay/Movie File for the geometry, select Simulation from the menu bar, the Replay File 

option and the Load item from the pull-down menu (see Figure 6-2).   

 

NOTE: 

When loading a Movie-Replay/Movie File for a geometry the current population in the 

geometry will be automatically deleted. 

 

TIP: 

When wishing to view movies, it is suggested that a version of the geometry is loaded that 

contains only a single evacuee, as this saves a considerable amount of time deleting the 

evacuees when loading the movie file. 

 

A dialogue box will be presented, prompting the user to open a file.  Simply type in the name 

of the Movie-Replay/Movie File, remembering to provide the correct extension, and click the 

OK button.  If the selected file is a Movie-Replay (.RUX) File, buildingEXODUS will 

automatically pause the replay at the start of the simulation.  To view the complete file, press 

the PLAY button. If the selected file is a Movie (.EMX) File, buildingEXODUS will first prompt 

for a replay speed before starting the replay.  The number given represents a factor in terms of 
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time-steps, thus “2” would represent twice the normal number of time-steps.  The maximum 

limit for the replay factor is scenario dependent, but typically lies between 30 and 50. 

 

6.4.6.4 Restart Files 

Shortcut: [Simulation/Save Restart File] 

The user can now save an “rux” or “run” file during the simulation by selecting Save Restart 

File from the Simulation menu. The restart file can then be loaded as a normal rux/run file 

where the simulation clock is set to zero and the starting locations of the people are where they 

were when the original simulation was saved. All previous movement history is lost (person’s 

path). Their door vector and itinerary will remain, however, they will redo all items in their 

itinerary regardless of whether they had completed that task in a previous simulation. 

 

6.4.7 VR Files  

In Levels B and C of buildingEXODUS the user has the option of saving the simulation so that 

it can be replayed in a 3D virtual reality environment using the vrEXODUS post processor.  

When saving simulation files for replay in vrEXODUS the user has the option to either save 

the entire geometry (see Section 6.4.7.1) or alternatively only saving a selected region of the 

geometry (see Section 6.4.7.2). 

 

6.4.7.1 VR Save  

Shortcut: [Simulation/VR Save]  

The VR Save option enables the user to save the entire geometry to enable it to be replayed 

within vrEXODUS. Once the VR Save option has been selected from the Simulation menu the 

user is presented with the VR FLOOR CONTROL dialogue box (see Figure 6-8). This controls 

the output options for the vrEXODUS files. The VR Floor Control dialogue allows the user to 

perform three functions.  Firstly, the user is able to control the correlation of the floors in 

buildingEXODUS (each being represented in a separate window) with the floor representation 

in the VR file.  Secondly, the user is able to determine whether the whole geometry or only 

selected floors are to be saved to the VR file.  Finally, the user is able to set the time interval 

over which the simulation is saved.  These last two functions are particularly useful when 

modelling large geometries, enabling a faster reproduction of the results, and when it is 

necessary to concentrate attention on a particular floor(s) at a particular time. 

 

 
Figure 6-8: The VR Floor Control dialogue box. 

 

The main selection window lists the floor (i.e. window) names that are in the current 

buildingEXODUS geometry file in order from the top floor to the bottom floor. If the user 

wishes to change the order of the floors this is achieved by using the UP and DOWN buttons 

on the left hand side of the dialogue box to move the currently selected floor up or down in the 
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selection box. To select a floor the user simply clicks on the floor’s name with the left mouse 

button. To select multiple floors hold down the Control key. 

 

The user also has the option of being able to only save a selected interval of time for the 

simulation. This option is controlled by the Start and End fields. Here the user can either leave 

the default values of 0 and -1 to save the simulation from start to finish or they can enter their 

own values, in seconds, to save the simulation for only a period of time. 

 

Once the user is content with the order of the floors and the time interval, they have the option 

to save the complete simulation (i.e. including the entire geometry) as a VR file or as a 

simulation of a single chosen floor (i.e. the user has the option of selecting a single floor or the 

entire geometry). Click the left mouse button on either the SAVE option to save the entire 

simulation or the SEL. ONLY option for the selected floor only.  If either of these buttons are 

selected the user is presented with a file selection dialogue box to save a vrEXODUS .VRS file.  

Once the user has chosen a filename and location for the VR simulation file, the model generates 

the .VRS file (relating to the scenario and the movement of the evacuee population) and a .VRG 

file (relating to the geometry in which the simulation took place).  Both of these files are 

required to view the simulation in VR format. 

 

NOTE: 

For hints on generating .VRG and .VRS files for vrEXODUS refer to the vrEXODUS manual. 

 

6.4.7.2 VR Selected Region 

Shortcut: [Simulation/VR Selected Region] 

In levels B and C of buildingEXODUS the user also has the option to save just a selected region 

of the simulation. After the simulation is complete, drag a box around the region and select VR 

Selected Region from the Simulation menu. The user will be asked to enter a start time and end 

time that they want to save the simulation over (see Figure 6-9(a) and (b)). Once the time 

interval has been chosen the user will be asked to enter a filename and location for the VR files. 

Remember you need both the .VRS and the .VRG files to replay a simulation in VR. 

 

  
(a) (b) 

Figure 6-9: (a) The Enter Start Time dialogue box (b) The Enter End Time dialogue box 

 

6.4.7.3 VR Replay 

To replay vrEXODUS files it is necessary to run vrEXODUS, which is available from the user 

download area with Levels B and C of buildingEXODUS. For a detailed explanation on how 

to run and use vrEXODUS refer to the vrEXODUS manual. 

 

NOTE: 

The VR  facility is available in levels B and C of buildingEXODUS. 

 

NOTE: 
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.VRS and .VRG  files cannot be loaded into buildingEXODUS for replay, they can only be used 

with vrEXODUS. 

 

6.5 View Menu 

The View menu has several functions that control the manner in which the geometry is 

displayed. 

 

6.5.1 Running A Simulation Without Graphics 

Shortcut: [View/Batch] 

The time taken for a simulation to execute can decrease significantly if the graphics are 

switched off.  This is especially apparent in geometries with large populations.  While all the 

graphical data is generated in the usual manner, this option has the drawback of not allowing 

the user to view the simulation interactively.  To switch off the graphics for a simulation, select 

View from the menu bar and the Batch item from the pull-down menu (see Figure 6-2).  To 

switch the graphics back on, repeat this process.  

 

NOTE: 

The user must remember to calibrate the model, so that the desired behavioural and 

environmental settings are set prior to the running of the scenario using the Batch facility. 

 

6.5.2 Display Options 

Shortcut: [View/Display] 

These options control the graphical interface of the model and therefore the manner in the user 

perceives the simulation. 

 

6.5.2.1 Analysis Options 

Shortcut: [View/Display/Analysis Options] 

The Behavioural Analysis Tool is an aid to the interpretation of simulation behaviour and 

results. This is enabled by the Analysis option and enables the user to control the appearance of 

individuals, according to their experiences during the evacuation and their behavioural response 

(see Figure 6-10). The events that may influence the evacuee’s appearance on the screen are: 
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Event Notes Default Colour 

Extreme The evacuee becoming Extreme RED 

FIN Level The evacuee’s FIN level reaches a user-defined level YELLOW 

Smoke 

Redirection 

Status 

The evacuee has redirected due to smoke. 

To be used in conjunction with the Smoke Redirection 

behavioural option. 

DARK 

MAGENTA 

Smoke Level The evacuee being located in a smoke-filled environment 

where the smoke has an extinction coefficient greater 

than a user-defined level 

DARK GREY 

Group status The evacuee is a member of a group. CYAN 

Using The evacuee has signage related itineraries and may be 

guided by signs 
RED 

Detected The evacuee has seen a sign, hasn’t left the VCA and 

hasn’t engaged in Searching or Backtracking 
GREEN 

Searching The evacuee has failed to follow the sign indicated and is 

Searching. 
CYAN 

Backtracking The evacuee has failed to follow the sign indicated and is 

Backtracking. 
MAGENTA 

Used Lift The evacuee has used a lift (i.e. actually been assigned to 

board a lift). It is important to note that agents are not 

classified as having used a lift merely because they have 

been assigned a Lift Bank task. 

YELLOW 

Missed Lift The evacuee has missed a lift (i.e. no lifts within the 

defined transit node group/lift bank will service the 

evacuees floor). 

RED 

Congestion 

Redirect 

The evacuee has redirected from a lift because the 

congestion experienced within the corresponding transit 

node group catchment area has exceeded their defined 

congestion threshold. 

GREY 

Wait Redirect The evacuee has redirected from a lift because the time 

they spent waiting for the lift exceeded their defined lift 

wait time. 

BLUE 

 

Once these events occur, the individual’s colour will automatically change according to the 

conditions. The user can manipulate these colours according to their needs, although default 

colours are provided. The colour of the individual will remain altered while the conditions 

remain satisfied. Once they are no longer satisfied the individual's colour will return to normal.  
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Figure 6-10: The Analysis dialogue box. 

 

NOTE: 

The Analysis tools are ordered according to precedence, allowing the options to be enabled 

simultaneously. The order of precedence moves from top (most important) to bottom (least 

important). Therefore if the options are enabled simultaneously the top option will supersede 

all the other options. 

 

NOTE: 

To have the entire individual coloured according to the conditions currently satisfied, as 

opposed to merely their body, the user should display the people as Block icons (see Section 

6.5.5).  

 

6.5.2.2 Gra. Ctrl Options 

Shortcut: [View/Display/Gra. Ctrl Options] 

The Gra. Ctrl Options enables the Display Control dialogue box (see Figure 6-11), which 

controls the appearance of the geometry within the buildingEXODUS model. This enables the 

user to determine which nodal types are visible to the user in Boundary mode whilst the 

simulation is running.  
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Figure 6-11 : Display dialogue box 

 

This dialogue box also controls which of these nodal types are selectable. 

 

If the user is interested in the behaviour exhibited by the evacuees over particular terrain then 

it may initially be advantageous to see nodes of that type to aid their location within the 

geometry and therefore their exact effect upon the evacuating evacuee population. 

Alternatively, the user may be demonstrating a large geometry that has a number of terrain 

types and a large population. Under these circumstances, they may wish to allow a less cluttered 

view of the evacuee movement, whereby all of the terrain types may be removed from view. 

 

By default the Seat nodes, Stair nodes, Attractor nodes, Discharge nodes, Source nodes, 

Redirection nodes, Free Space nodes, Arcs, Lines, Polygons, Text, People, Signs and Floor 

Links are all visible. 

 

NOTE: 

It should be noted that the impact of the node upon evacuee behaviour is not removed if the 

node is removed from sight through the use of the Gra Ctrl Options.  This feature only impacts 

on the appearance of the graphical interface. 

 

NOTE: 

The user now has the option to edit aspects of the evacuation procedure through this dialogue 

box. The user has to be in Geometry mode for this to be available. This is described in Section 

3.3.4.3.1. 

 

NOTE: 

This feature is also accessible by double-clicking on the Select tool . 
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6.5.2.3 Exit Queue Display (Default-ON) 

Shortcut: [View/Display/Exit Queue] 

Simulation speed may be further increased and memory requirements reduced by switching off 

the Exit Queue display at the foot of the main geometry window.  To switch off, deselect the 

Display/Exit Queue option on the View menu.  Note that if switched back on during a 

simulation, only the occupants who have exited during the period that the queue display is 

activated are shown. 

 

6.5.2.4 Graphs 

Shortcut: [View/Display/Graphs] 

This automatically displays the graphs for all of the exits within the geometry. In addition the 

Main Graph and All Exits graphs are also displayed. 

 

6.5.3 Contour Options 

Shortcut: [View/Contour/] 

The graphical interface may be adapted so as to convey certain information graphically through 

the use of coloured contours. 

 

NOTE: 

The use of any of the contour options will increase the simulation run time. This is due to the 

increased amount of graphical updating required to generate the contour. The user may also 

experience some flickering when running any of the contouring features. This is due to the 

constant updating of the graphical image on the screen. 

 

6.5.3.1 Viewing Population Densities 

Shortcut: [View/Contour/Pop. Density]  

In large geometries where a low degree of magnification is selected, it can be difficult to 

interpret the movement of individuals.  Furthermore, in many situations it is useful to be able 

to estimate the level of crowding in an enclosure rather than to track individuals.  As an 

alternative, a Population Density Contour may be viewed (see Figure 6-12).  In this view, each 

region is coloured according to the population density. The density is calculated according to 

how occupied a nodal region is.  A node region is considered fully occupied if a node and all 

its connecting nodes are occupied. If the nodal mesh is generated using the Physical Dist option 

in GEOMETRY mode, the maximum population density approximates 4 individuals/m2.  A 

fully occupied region is coloured red, and the minimum occupation is coloured blue. The 

colouring follows the order Red, Magenta, Yellow, Green, Light Blue and Blue.  An example 

is illustrated in Figure 6-12.  To view a simulation in this format, select the Contour option 

from the View menu and then the Pop. Density switch (see Section 6.9.2.1 for information 

concerning the scale used in the Pop Density).  To switch back to the non-contoured mode, 

reverse this procedure. 

 

NOTE: 

When running a simulation in contour mode, the map is updated every ten time-steps. 
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TIP: 

A Help facility is provided to clarify the data being presented in the Population Density Contour 

Map (see Section 6.9.2.1). 

 

  
Figure 6-12: Example population density contour map (lighter regions show higher 

areas of population density) 

 

6.5.3.2 Viewing The Potential Map In Contour Format  

Shortcut: [View/Contour/Potential Map]  
The Potential Map Contour function allows the Potential Map to be viewed as a coloured 

contour map, without examining the catchment area for each exit individually.  The reader 

should refer to Section 5.7.3 for examples.  To switch on this view in SIMULATION mode, 

firstly pause the simulation and then select the Potential Map option on the Contour sub-menu 

from the View menu.   

 

 
Figure 6-13: Potential Contour demonstrating the catchment areas of two exits. 

 

This mapping function is similar to that provided by the Potential Route Mapping system 

described in Section 6.5.3.5, except in this instance no direction of movement is indicated. 

 

NOTE:  

The Contour Map only demonstrates the impact of the Potential Map and will not demonstrate 

the impact of the Local Familiarity system or an individual’s Target exit upon movement. 
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NOTE: 

This Potential Map Contour feature is particularly useful in examining the connectivity of 

complex geometries (irrespective of the navigational system), as the potential map will not flow 

across unconnected regions. 

 

6.5.3.3 Viewing the Temperature In A Contour Format 

Shortcut: [View/Contour/Temperature]  
The Temperature Contour function (only available in Level C) allows the temperature within 

the geometry to be viewed as a coloured contour map. For the temperature to be recorded, the 

Hazard model must be enabled (see Section 6.6.3).  This is particularly useful if the user is 

interested in the development of the temperature within the geometry, allowing for instant 

comparison between the fatality rates of areas of varying temperatures. 

 

 
Figure 6-14: The temperature spread is visible using the temperature contour. 

 

Effectively the redder the appearance of the temperature contour, the higher the temperature 

(see Figure 6-14). For a more detailed understanding of the scale used and the availability of a 

key, the user is referred to Section 6.9.2. 

 

6.5.3.4 Viewing the Smoke Level In A Contour Format 

Shortcut: [View/Contour/Smoke Level]  
The Smoke Contour function (only available in Level C) allows the smoke-level in the 

environment to be viewed as a coloured contour map. For the temperature to be recorded, the 

Hazard model must be enabled (see Section 6.6.3). As in Section 6.5.3.3 the representation of 

the level of smoke in the environment as a contour can be useful in itself (enabling the 

progression of the smoke throughout the geometry to be traced), but is also particularly useful 

in that the individual’s behaviour in response to the smoke levels can be placed into context. 
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Figure 6-15: The smoke spread is visible using the temperature contour. 

 

Effectively the darker grey the appearance of the smoke contour, the higher the extinction 

coefficient of the smoke (see Figure 6-15). For a more detailed understanding of the scale used, 

the user is referred to Section 6.9.2.1. 

 

6.5.3.5 Potential Route Map 

Shortcut: [View/Contour/Pot Route Map]  
Another way of displaying the Potential Map is by using the Potential Route Map Contours. 

This demonstrates the direction that the potential map follows. This is achieved by displaying 

arrows pointing towards the locations with a lesser potential value. The same colour scheme is 

used as in the standard Potential Map Contour. To view the Potential Route Map select the Pot. 

Route Map option on the Contour sub-menu from the View menu. 

 

 
(a) 

 
(b) 

Figure 6-16: a) Potential Map contour b) Potential Route Map contour 

 

Using this option enables the user to examine the flow of the potential map much more 

accurately and easily locate any problematic areas. Under certain circumstances and depending 

on the values selected Internal Exits can cause the potential map to grow incorrectly. Using the 

Pot. Route Map the user can easily identify the problematic areas and correct the potential map 

accordingly. Figure 6-16 (a) shows the potential map of a simple geometry. Both methods are 

displayed to compare the results. Note that in Figure 6-16(b) it is much easier to determine 

where the border lies between the catchment areas of the two exits. The line in Figure 6-16(b) 

highlights that border. 
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Figure 6-17: The demonstration of the erroneous spread of the potential map. 

 

In the case where the potential map is calculated incorrectly circles instead of arrows will 

represent the area with the inappropriate potential flow. To illustrate this, the geometry in the 

previous example was modified to include two internal exits (IE1 and IE2, see Figure 6-17) in 

the lower corridor (see Figure 6-17). The internal exits are indicated by the red rectangles. The 

direction of the internal exits (IE) was modified so that they would point towards each other. 

This prevents the potential map from flowing correctly towards the exits and thus it cannot be 

correctly calculated.  

 

6.5.3.6 Footfall Contour 

Shortcut: [View/Contour/Footfall]  
The footfall contour displays the level of use of each of the nodal locations within the geometry. 

This provides an indication as to the level of usage of particular locations identifying particular 

problem areas. The function is based on the number of people within the geometry and produces 

a contour in relation to this value (see Figure 6-18). 

 

 
Figure 6-18: Example of the Footfall contour. 

 

Generally, the redder the contour displayed, the greater the level of usage of a particular 

location. The routine that calculates footfall contours uses a value that is normalised between 0 

and 1.  The function to calculate the Footfall contour is  

 

Value = Number of people that walked over node / max(1,Population size/2) 

 

The output of the function is described in Table 6-3. 
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Table 6-3: Displayed colours using  

Calculated Footfall Value Contour on screen 

Value < 0.0001 White 

Value < 0.11 Grey 

Value < 0.22 Blue 

Value < 0.33 Light Blue 

Value < 0.55 Green 

Value < 0.66 Yellow 

Value < 0.88 Magenta 

Otherwise Red 

 

6.5.3.7 Congestion Contour 

Shortcut: [View/Contour/Congestion]  
The Congestion Contour function provides the ability to identify the areas within a structure at 

which “significant” congestion was experienced during the simulation. Congestion is deemed 

“significant” if the local population densities exceed 4 people/m2 and if the congestion itself 

persists continuously for longer than 10% of the overall simulation time. 

 

To use the Congestion Contour function the user first needs to enable the facility within 

buildingEXODUS to gather the congestion data during the running of the simulation. Since the 

gathering of this congestion data requires additional calculations during the running of the 

simulation, its collection therefore has the effect of slowing down (albeit only slightly) the 

running of buildingEXODUS. To prevent users who therefore have no interest in identifying 

significant areas of congestion having their simulation run times needlessly extended the 

capability to disable this new feature has been provided. To enable the congestion data 

collection select View from the menu, the Contour option and then the Generate Congestion 

Data option from the pull down menu. By default this option (and hence the congestion data 

collection to which it relates) is disabled. Users wishing to identify significant areas of 

congestion within any given structure are therefore required to enable the Generate Congestion 

Data option in the manner shown above prior to the running of the simulation. Once enabled, 

the simulation can then be run in the normal manner. 

 

Having successfully completed a simulation the user can then view the areas (i.e. nodes) within 

the building at which severe congestion was continuously observed for longer than 10% of the 

Total Evacuation Time (TET) by enabling the Congestion contour. As with the other contours, 

this is enabled by selecting View from the menu, the Contour option and then the Congestion 

option from the pull down menu. It is important to note that this contour requires the simulation 

to be complete before it can be viewed, since it is obviously necessary to know the simulation 

duration (i.e. the TET) before it is possible to indicate areas exceeding 10% of it. Once the 

simulation has been completed and the Congestion contours enabled in the manner defined 

above then areas at which severe congestion exceeded 10% of the TET will be displayed (see 

Figure 6-19). Since each of these areas corresponded to an area of congestion 4 people/m2 

they are therefore coloured red, thereby making them consistent with the existing Population 

Density contours (see Section 6.5.3.1). 
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Figure 6-19: The significant congestion identified within an example building. 

 

To further assist the user, the ability to interrogate the individual areas of congestion has also 

been provided. By moving the mouse over the red congested areas a pop up window will be 

displayed, similar to those used for the Node Tips, displaying the duration of the congestion at 

that location (i.e. node) as a percentage of TET (see Figure 6-20). In this manner, the user can 

scan around each area of congestion and identify exactly which area was subjected to the most 

prolonged period of congestion, as well as identifying exactly how long that congestion lasted. 

It is important to note that it is not necessary to enable the Node Tips facility in order to view 

this additional congestion data (see Section 6.9.3). This data is displayed only while the 

Congestion contour is displayed, during which time it takes precedence over the existing Node 

Tips. Hence if a user has the Node Tips facility enabled, then enabling the Congestion contour 

will result in the congestion data being displayed instead of the Node Tip data. However when 

the Congestion Contour is then disabled the Node Tips will again be displayed in the 

conventional manner. 

 

 
Figure 6-20: The congestion experienced within a specific location, stating the duration 

of the congestion expressed as a percentage of the Total Evacuation Time (TET). 
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NOTE: 

If the Generate Congestion Data option is selected in the manner defined above then data 

relating to each significant area of congestion identified within any given simulation will also 

be outputted within the simulations corresponding output file (.SIM) (see Section 6.8.2) 

 

6.5.3.8 Distance Route Map 

Shortcut: [View/Contour/Dist Route Map] 
In addition to providing users with contour functions to view the spread of the potential map 

throughout structures, buildingEXODUS also provides a function to view the distance map to 

each corresponding target. To display the Distance Route Maps, select View from the menu, the 

Contour option and then the Dist Route Map option from the pull down menu (see Figure 6-2). 

Once selected the Potential Route Map for the structure will be automatically displayed by 

default. Arrows are drawn at each node pointing directly towards the neighbouring location 

with the lowest Potential value (see Section 6.5.3.5). In addition, the Target Selection dialogue 

box will also be displayed listing each of the target points within the current structure (see 

Figure 6-21). The target points within this list includes each of the exit points from the structure 

(i.e. External Doors) in addition to the nodal location of each individual task defined within the 

itineraries of the population. 

 

 
Figure 6-21: Target Selection dialogue box. 

 

The user has the ability to display the Distance Route Map for any given target by selecting it 

within the Target Selection dialogue box. Once a target has been selected from the available 

list, arrows will then be drawn at each node instead indicating in each case the direction closest 

to the given target. The colour scheme used within the Distance Route Map is the same used 

within both the Potential Route Map (see Section 6.5.3.5) and the standard Potential Map 

contours (see Section 6.5.3.2). Using this option enables the user to examine the shortest route 

to a given target from any region within the geometry, and hence examine the routes individual 

people will adopt in reaching the target (deviations due to congestion not withstanding).  

 

Figure 6-22 below shows the route maps for a simple square room with two available exit points 

(i.e. DOOR_1 and DOOR_2). Figure 6-22(a) shows the Potential Route Map initially displayed 

by default upon selection of the Distance Route Map function, while Figure 6-22(b) and (c) 

show the Distance Route Maps for the exit points DOOR_1 and DOOR_2 respectively. 
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(a) (b) (c) 

Figure 6-22: a) The Potential Route Map and The Distance Route Maps for a) DOOR_1 

and b) DOOR_2 within a simple square room geometry. 

 

6.5.4 Zone Contour Options 

The Zone Contour functions provides similar functionality to the Contour functions described 

previously except that the image that is generated on the screen is not dependent upon  the nodal 

location but is instead calculated according to a polygon generated around the peripheral nodes. 

This allows for a clearer image to be generated. 

6.5.4.1 Temperature 

Shortcut: [View/Zone Contour/Temperature] 
As with the function described in Section 6.5.3.3, the Temperature Zone Contour function 

allows the temperature within the geometry to be viewed as a coloured contour map. However, 

the Zone Contour version of this function presents a much crisper image that is drawn according 

to the entire area occupied by the zone, rather than on a nodal basis. This function is only 

available in level C. 

 

6.5.4.2 Smoke 

Shortcut: [View/Zone Contour/Smoke] 
As with the function described in Section 6.5.3.4, the Smoke Zone Contour function allows the 

smoke level within the geometry to be viewed as a coloured contour map. However, the Zone 

Contour version of this function presents a much crisper image that is drawn according to the 

entire area occupied by the zone, rather than on a nodal basis. This function is only available in 

level C. 

 

6.5.5 Viewing Different Person Shapes 

Shortcut: [View/Shape/Person]  /  

Shortcut: [View/Shape/Block]  /  

Shortcut: [View/Shape/Arrow]  

In the current implementation of buildingEXODUS, each individual is considered to occupy 

the same physical space and can thus be represented by the same icon.  During a simulation, 

three different person shapes are available from the View/Shape menu these are Person, Block 

and Arrow.  Each icon is shown in Table 6-4. 
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Table 6-4: Person icons in buildingEXODUS 

Icon Name 

 

 

Person 

 

 

Block 

 

 

Arrow 

 

The purpose of the Person and Arrow icons is to provide the direction of travel to the user.  

With the former, the “red nose” indicates the direction and in the latter the pointed section of 

the arrow provides the same function.  The square icon has no direction indicator but has the 

advantage of being faster to draw than the other two icons.  This difference will only become 

apparent in geometries with large populations. 

 

The Person is the default icon, it appears in the View/Shape menu with a tick mark ().  To use 

the Arrow icon, select View/Shape from the menu bar and the Arrow item from the pull-down 

menu (see Figure 6-2).  To use the Block icon, select View/Shape from the menu bar and the 

Block item from the pull-down menu (see Figure 6-2). 

 

6.5.6 Zoom Lists 

 

 (i) In 

Shortcut: [View/Zoom Lists/In] 
After having run a simulation it is often necessary to magnify the Exit Lists section of the Output 

window in order get a clearer view of either the exits, the mortuary, or the individual people 

associated with them. To magnify the Exit Lists, select View from the menu bar, the Zoom Lists 

option and then the In item from the pull down menu (see Figure 6-2). Each time a Zoom In 

function is performed on the Exit Lists a 10% magnification will be automatically produced. 

This action can be continually performed until the desired level of magnification is achieved. 

Figure 6-23(a) and Figure 6-23(b) demonstrate the effect of the Zoom In function. 

 

 (ii) Out 

Shortcut: [View/Zoom Lists/Out] 
This is the reverse process of Zoom In. To reduce the magnification level of the Exit Lists, select 

View from the menu bar, the Zoom Lists option and then the Out item from the pull down menu 

(see Figure 6-2). Each time a Zoom Out function is performed on the Exit Lists a 10% reduction 

in the magnification will be automatically produced. This action can be continually performed 

until the desired level of magnification is achieved. 

 

 (iii) Reset 

Shortcut: [View/Zoom Lists/Reset] 
This function resets the magnification level of the Exit Lists to the default level (see Figure 

6-23(a)). To reset the magnification level of the Exit Lists, select View from the menu bar, the 

Zoom Lists option and then the Reset item from the pull down menu (see Figure 6-2). 
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(a) 

 
(b) 

Figure 6-23: The Exit Lists displayed (a) at default magnification and (b) after a zoom in 

operation.  

 

6.5.7 Locate Person/Time 

Shortcut: [View/Locate Person/Time] 
This feature enables the user to identify which members of the population managed to evacuate 

before a given time. Once Locate Person/Time has been selected (by selecting View from the 

menu bar and then the Locate Person/Time option), the user is then asked to supply the time (in 

seconds) before which people are required to have evacuated. Once the time has been provided 

in the Locate Person/Time dialogue box (see Figure 6-24) the search can then be initiated by 

clicking the LOCATE button. The function will search the entire population, identifying those 

individuals who managed to evacuate before the specified time limit and highlighting the nodes 

corresponding to their respective starting locations. 

 

 
Figure 6-24: The Locate Person/Time dialogue box. 

 

Figure 6-25 demonstrates an example of this function being used. Figure 6-25(a) shows the 

initial starting locations of people within a typical geometry, while Figure 6-25(b)–(e) show the 

starting locations of those individuals who managed to evacuate in under 2, 5, 10 and 18.4 

seconds respectively. Here it can be seen that the first people to successfully evacuate from the 

geometry where those initially located closest to the available exit points (see Figure 6-25(b)). 

As the simulation progressed, people initially located increasingly greater distances from the 

exit points also managed to evacuate (see Figure 6-25(c) and (d)), until after 18.4 seconds the 

entire population had successfully exited the structure (see Figure 6-25(e)). This feature is 

particularly useful for observing the order in which individuals managed to evacuate a given 
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geometry, their respective starting locations and hence identifying the areas within a structure 

from which people may have difficultly evacuating.  

 

 
(a) 

 
(b) 

 
(c) 

 
(d) 

 
(e) 

Figure 6-25: An example of the Locate Person/Time function, showing (a) the starting 

locations of the people within the geometry, the starting locations of the people who 

people who evacuated before (b) 2 seconds, (c) 5 seconds, (d) 10 seconds and (e) 18.4 

seconds. 
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6.6 RuleBase Menu 

RuleBase options are used to control which aspects of individual behaviour are active during a 

simulation.  In addition, information printed out to the output files can be controlled.  Before 

executing a simulation, a number of RuleBase options may need modification. These are 

broadly separated into four categories: File Options, Hazard Options, Behaviour Options and 

Option Libraries. These options are available from the Simulation menu and each accesses a 

dialogue box allowing the user control on a specific area of the simulation process (see Figure 

6-2). 

 

6.6.1 Data Output Options 

Shortcut: [RuleBase/Data Output Options]  
At the end of each simulation, buildingEXODUS offers the option to save an output file, termed 

Simulation File.  The Data Output Options allow the data making up a simulation file to be 

configured.  When selected, this option produces the dialogue box shown in Figure 6-27.  The 

options in the dialogue box can be broken down into six categories:  

 

(a) Person Attributes - these are the key evacuee attributes and travel speeds. Each attribute 

selected is produced in the output file.  To select or de-select any of the attributes listed, 

simply click the check box to the left of the required attribute (see Figure 6-27(a)).  

 

(b) Person Variables - these are the evacuee attributes that are dynamic, i.e. they are modified 

during the course of a simulation (see Figure 6-27(b)).  To select or de-select any of the 

variables listed, click the box to the left of the required variable. It should be noted that 

options will affect the data recorded for exits. Most of these variables are self-explanatory. 

However, it does include the Route option, which provides information on the Internal 

Exits, Census Nodes and exits that an individual has visited during the simulation. This 

enables the user to trace the path adopted by an evacuee and their time of arrival at specific 

locations. An example of the type of output that might be expected is presented below. 

 
The Variables section also includes the Floor Path option which when selected produces a 

summary of the PET and CWT experiences (i.e. minimum, maximum and average) of agents 

separated according to their initial floor (see Section 6.8.2).  For each starting floor the 

summary also provides data indicating both how long on average agents from that floor spent 

on each of the floors within the building, and similarly how long on average they spent 

waiting on each of the floors. This therefore enables the user to quickly and easily view the 

experiences of the agents as they move through the building. 

 

The PEE value for each agent is calculated according to the equation 1 – CWT/PET.  Agents 

who therefore encountered no congestion during their evacuation (i.e. CWT=0s) will 

consequently have PEE values of 1, thereby indicating that their evacuation was optimally 

efficient.  The larger the amount of congestion experienced by the agent during egress, the 

less efficient their evacuation and hence the lower their PEE value. 
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In addition, the Response Ratio, CWT Ratio and Travel Ratio options provide information 

on the amount of time each individual spent respectively Responding, Waiting and 

Travelling during their evacuation, expressed as a ratio of their individual overall evacuation 

time. The Response Ratio is therefore calculated as the time each individual took to respond 

(and hence commence evacuation) divided by their corresponding overall evacuation time 

(i.e. Response Time/PET), while the CWT Ratio is calculated as the total amount of time 

each individual spent in congestion during their evacuation divided by their corresponding 

overall evacuation time (i.e. CWT/PET). In contrast, the Travel Ratio is calculated as the 

total amount of time each individual spent actively travelling during their evacuation divided 

by their corresponding overall evacuation time (i.e. 1 - (Response Time/PET) - (CWT/PET)).   

 

It is also possible for the user to output to the simulation file (.SIM) the total amount of time 

(in seconds) each individual spent on specific terrains (i.e. types of nodes) during their 

evacuation from the structure. In total, four different types of terrain are defined, and are 

classified as follows: 

 

Options Node Types 

Horizontal Free Space, Seat, Boundary, Attractor, Discharge, Redirection, 

Direction and Source nodes plus Census Regions, Internal Exits in 

addition to Travelator, Corridor and Metered Gate Transit nodes. 

Stairs Stair nodes and Stair Transit Nodes. 

Vertical Stair nodes, Stair Transit Nodes, Escalator Transit Nodes and Lift 

Shaft Opening Transit nodes. 

Landings Landing nodes. 

 

Hence, enabling the Horizontal option will output the total amount of time each individual 

spent on horizontal components during their entire evacuation (i.e. the total amount of time 

each individual spent on Free Space, Seat, Boundary, Attractor, Discharge, Redirection, 

Direction and Source nodes, plus Census Regions and Internal Exits in addition to 

Travelator, Corridor and Metered Gate Transit nodes). By default none of the different 

node type options are enabled. 

 

(c) Person Fire Hazard Effects - these are the attributes associated with the toxicity sub-model 

(see the Theory Manual, Chapter 6) and are only utilised in software level C (see Figure 

6-27(c)). 

 

(d) Controls - to accept any selection modifications made to the dialogue box click the OK 

button.  Conversely, to reject any selection modifications made to the dialogue box click 

the CANCEL button. Attribute selections can also be saved to a .INI file by clicking the 

SAVE button and specifying both the filename and its desired location within the Save 

dialogue box provided. By default all attribute selections are named TABLE.INI. To load a 

user-defined .INI file click the LOAD button and select the required file using the OPEN 

dialogue box provided. Each attribute setting will then automatically be updated in 

accordance with the selections within the saved file. Saving the attribute settings required 

for output in this manner should significantly reduce the amount of time the user spends 

engineering a simulation, and will also ensure consistency in the data output within each 

corresponding simulation file (.SIM). Attribute selections saved within .INI files can also 

be loaded into Batch Mode. A simulation file may also be Generated or Saved or any 

combination of both.  The Generate option simply generates the data and places it in the 

Output Window (see Section 6.8.2).  The SAVE option will only work when the Generate 
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option is also enabled.  Its purpose is to prompt the user with a message, asking if the 

simulation file generated should be saved. 

 

(e) Graphical Data - some graphical data is automatically generated by buildingEXODUS 

during the course of a simulation.  The GRAPHS button allows separate data to be generated 

for post-processing using external packages, such as Microsoft EXCEL.  When this option 

is selected, another dialogue box is displayed as shown in Figure6-26.   

 

 
Figure6-26: The dialogue box to configure graphical data output. 

 

The graph data generated represents the number of people who successfully evacuate as a 

function of time. There are two ways in which this data can be produced, namely the 

Continuous and Time Span options.  Using the Continuous option, time data is produced 

every n seconds where n is the specified time interval.  With each interval, the total number 

of evacuees out is displayed.  For example, “0.0 ; 0” would represent at time 0.0, 0 evacuees 

would have escaped.  Similarly, “12.5 ; 24” represents a case where at 12.5 seconds, 24 

evacuees have escaped.  This kind of data is used to produce evacuation curves, an example 

of which can be seen in Figure 6-46a.  With the Time Span option, time data is produced in 

the form of time segments, e.g. 1 - 10, 10 - 20 etc. again using the specified time interval.  

In this case, only the number of evacuees out during the specified time segment is produced.  

For example, “0.0 – 5.0 ; 7” would represent 7 individuals evacuating in the first 5 seconds.  

This kind of data is used to produce flow-rate graphs, an example of which can be seen in 

Figure 6-46b.  In both the Continuous and Time Span methods, the data can be produced 

either over the whole simulation i.e. all exit points combined, per exit, per Internal Exit, per 

Census Region, for all of them or for any combination of them. Additional data can also be 

gathered for Compartment Zones. Each Compartment Zone can generate data relating to 

either the Arrival of people within the zone (i.e. Arr.), the Departure of people from the 

zone (i.e. Dep.) or the Population count of people within the zone (i.e. Pop.).  To select 

these options, simply click the relevant box in the dialogue box.  Details on interpretation 

of such results can be found in Chapter 3.  
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(a) (b) 

 

 

(c) (d) 

Figure 6-27: The Output Control dialogue box, (a) the Attributes tab, (b) the Variables 

tab, (c) the Hazards tab and (d) The Input Parameters dialogue box. 
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(f) Params (Input Parameters) – this button allows a summary of input parameters to be 

generated in the ASCII output, through the spawning of the Input Parameters dialogue box 

(see Figure 6-27(d)).  There are four options that may be selected for a summary: Population 

Summary, Fire Scenario, Hazard Summary and Behaviour Options.  The Population 

Summary produces the range of values for each of the major population attributes.  A Fire 

Scenario summary consists of the list of Fire Scenario Components, i.e. which zones are 

linked to which hazards.  The Toxicity Summary simply lists the options that are set in the 

toxicity tables (see part 2 below).  The Behaviour Options lists the RuleBase switches and 

their values, i.e. ON or OFF.   

 

6.6.2 Trace Control 

Shortcut: [RuleBase/Trace Control] 
In addition to enabling users the ability to output the selected attributes of all individuals at the 

end of a simulation (see Section 6.6.1), buildingEXODUS also enables users the ability to 

output the selected attributes for user-defined groups of individuals throughout the simulation. 

This provides the ability to observe the attributes for each of the selected individuals as they 

evolve throughout the entire simulation (as opposed to merely viewing their values at the end 

of the simulation), thereby giving the user a better understanding of the conditions each evacuee 

encountered during their egress. The attribute values of each individual can either be outputted 

at regular fixed time intervals (i.e. every 10 seconds) or alternatively every time an individual 

moves within the structure. Outputting attribute data every time an individual moves results in 

data being generated for each selected person when the simulation is started, when they change 

nodes and when they either expire or exit the structure. The ability to output the evolving 

attributes of individuals throughout the simulation in the manner defined above is achieved 

within buildingEXODUS via the Trace Output Control dialogue box (see Figure 6-28), which 

can be accessed by selecting the Trace Control option from within the Rulebase menu in 

Simulation mode.  

 

 
Figure 6-28: Trace Output Control dialogue box. 
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The following list outlines each of the areas and controls within the Trace Output Control 

dialogue box shown in Figure 6-28. 

 

Enable Option: This option controls whether or not the Trace Control facility is enabled within 

buildingEXODUS, and hence whether or not the specified data output file, containing the 

evolving attribute values for each of the selected individuals, is generated. By default the Trace 

Control facility is not enabled. 

 

Filename Button: This option enables the user to define both the name of the data output file 

to be generated, and its corresponding location (i.e. drive and path). By default all data output 

files are named trace.out and are generated within the directory containing the current 

buildingEXODUS geometry file (.EXO). 

 

Over Write Option: If this option is selected then the filename specified by the user (i.e. 

trace.out) is overwritten every time the simulation is run. If not selected, then if the specified 

file already exists a number will be appended to the filename to distinguish the simulations 

results from the previous existing files. For example, if the specified output filename was 

trace.out and trace.out already exists at the location specified by the user, then 

buildingEXODUS will instead attempt to generate a file called trace0.out. If however 

trace0.out similarly already exists, then buildingEXODUS will instead attempt to generate 

trace1.out etc. By default the Over Write option is not selected. 

 

Trace Control List: This section merely lists the Names of all the individuals selected by the 

user whose attributes will be output to the specified data output file throughout the simulation. 

Individuals may be selected by clicking on their corresponding Names within the Trace Control 

List. Once selected, these individuals can then be removed from the Trace Control List (see 

Remove button). 

 

Remove Button: This option enables the user to remove the currently selected person (or 

people) from within the Trace Control List, thereby ensuring that their attributes are not 

included within the specified output file. Multiple people may be selected within the Trace 

Control List by holding down the Ctrl key whilst clicking on the individuals within the list. 

 

Add Sel. Button: This option enables the individuals currently selected by the user within the 

geometry to be added directly to the Trace Control List, thereby enabling their evolving 

attributes to be included within the specified data output file. It is important to note that when 

the Trace Output Control dialogue box is displayed users will be unable to select regions within 

the geometry, and hence unable to identify individuals for inclusion within the Trace Control 

List. Any individuals to be included within the Trace Control List should therefore be selected 

by the user prior to opening the Trace Output Control dialogue box. 

 

All Option: If this option is selected then the selected attributes for all of the people within the 

geometry will be output to the specified data output file, as opposed to merely those within the 

Trace Control List. By default the All option is not selected.  

 

Movement Option: If this option is selected then the attribute values of an individual will be 

output to the specified data output file every time that individual moves. Additional attribute 

data is also outputted for each individual both at the start of the simulation and when they either 

expire or exit the structure. If this option is selected then the Interval value is ignored (see 
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below). By default the Movement option is not selected (i.e. data is output at regular time 

intervals). 

 

Interval Value: This option enables the user to define the regular time interval at which the 

selected attribute data for each individual will be output to the specified data file. This option 

is only relevant if the Movement option is disabled (see above). By default the selected attribute 

data for each individual is output at 10 second intervals. 

 

Person Attributes: This section enables the user to define which attributes are to be output for 

each selected individual within the specified data output file. To select any of the attributes 

listed, simply click the check box to the left of the required attribute.  

 

Hazards: This section enables the user to define which hazard attributes are to be output for 

each selected individual within the specified data output file. The effect of the various hazards 

on each individual (i.e. FIN, FIH, FIHr, FIHc etc.) can be output, enabling users to view the 

increasing toxic effect the environment had on each individual throughout the simulation. In 

addition, the actual hazard values (i.e. Temp, CO, CO2 etc.) that each individual was exposed 

to throughout the simulation can also be output. These hazard attributes are grouped and 

displayed according to their corresponding type. Users can toggle through the various hazard 

groups by clicking on the button at the bottom of the Hazards section. As the user toggles 

through these respective hazard groups the various hazard attributes associated with each given 

group are displayed. Similarly, the name of the button used to toggle through the hazard groups 

changes to display the name of the next hazard group (i.e. the hazard group that the user will 

progress to were they to press the button). Once again, to select any of the hazard attributes 

listed, simply click the check box to the left of the required attribute. 

 

Dialogue Controls: The Dialogue Controls are the main control buttons for the Trace Output 

Control dialogue box. Table 6-5 lists the controls and their purpose. 

 

Table 6-5: List of the dialogue controls for the Trace Output Control dialogue box. 

Command Purpose 

Save Saves the current Trace Control settings to a .INI file. This 

includes not only the status (i.e. selected/deselected) of each 

of the attributes, but also the data output settings and the 

Names of the individuals selected by the user whose 

attributes are to be output throughout the simulation. 

Load Loads a predefined set of Trace Control settings previously 

saved within a .INI file. 

OK Accepts any modifications made to dialogue box. 

Cancel Rejects any modifications made to the dialogue box. 

 

In addition to providing the ability to both add and remove multiple individuals to/from the 

Trace Control List via the Add Sel. and Remove buttons respectively (see above), 

buildingEXODUS also enables the tracing status of individuals to be viewed/modified directly 

from within the geometry window itself (i.e. without the need for the Trace Output Control 

dialogue box). In Simulation mode, the Trace status of individuals can be viewed by right 

clicking on an individual and then selecting the Person option from within their corresponding 

pop-up menu. Once selected, a second pop-up menu will then be displayed showing the Trace 

option (see Figure 6-29(a)). If the selected individual has not already been added to the Trace 

Control List then the Trace option within this pop-up menu will be unchecked, thereby 
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indicating that their corresponding attribute values will not be output to the specified data output 

file during the simulation (see Figure 6-29(a)). Conversely, if the selected individual has already 

been added to the Trace Control List then the Trace option will instead be checked, thereby 

indicating that their corresponding attribute values will be output to the specified data output 

file during the simulation (see Figure 6-29(b)). Selecting the Trace option within the pop-up 

menu therefore enables users to toggle the Trace status of the selected individual directly, and 

hence add/remove the individual to/from the Trace Control List without the need to open the 

Trace Output Control dialogue box. 

 

NOTE: 

Selecting the Trace option for an individual via their corresponding pop-up menu will 

automatically enable the Trace Control facility within buildingEXODUS. 

 

  

(a) (b) 

Figure 6-29: Controlling the Trace status of an individual via the pop-up menu. 

 

An example of the data output file generated using the Trace Control facility is shown below:  
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++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

 

Tracer file of Exodus.exo, with 4 People, Generated Fri Aug 30 11:59:50 2013 

 

 

             buildingEXODUS  V6.0.0.822  x86 

                          LEVEL: C 

                   Licence No: 1077807400 

                   Expires on: 7 May 2014 

                             CMS 

                   University of Greenwich 

 

 

               buildingEXODUS is a product of 

                          G.U.E.L. 

                       a subsidiary of 

                 the University of Greenwich 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

 

Output per every 10.00 seconds 

 

 

Trace of 2 

Person: 4 

Person: 2 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

 

   ID|Sim Time|Target      |Node        |Distance|     PET| 

+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

    4|    0.00|None        |141         |    0.00|    0.00| 

    2|    0.00|None        |186         |    0.00|    0.00| 

    4|   10.00|None        |141         |    0.00|    9.92| 

    2|   10.00|None        |186         |    0.00|    9.92| 

    4|   20.00|None        |141         |    0.00|   19.92| 

    2|   20.00|None        |186         |    0.00|   19.92| 

    4|   30.00|None        |176         |    1.21|   30.11| 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

 

Tracer file of Exodus.exo, with 4 People, Completed Fri Aug 30 11:59:51 2013 

 

 

Final Simulation Time 37.35 

 

Each data output file generated consists of seven main sections, detailing the simulation and the 

experiences of the selected individuals. The first section merely states the buildingEXODUS 

EXODUS geometry file (.EXO) from which the corresponding data output file was generated, 

the total number of people within the geometry and the time at which the data output file was 

generated (i.e. the time at which the simulation was commenced). The second section displays 

the standard header information, containing the version number of buildingEXODUS 

EXODUS from which the simulation was run, the level of the software (i.e. level A, B or C) 

and the dongle information, namely the licence number and corresponding expiry date. The 

third section states the chosen data output method, namely whether the attribute data for each 

selected individual is output at regular time intervals (i.e. Output per every 10.00 seconds) or 

alternatively every time the individual moves within the geometry (i.e. Output per nodal event 

change). The fourth section states the total number of individuals who were specified within 

the Trace Control List (i.e. the total number of individuals selected by the user whose attributes 

were required to be output throughout the simulation). Within this section the selected 

individuals are also listed, in each case stating both their corresponding unique Label number 

and Name (if defined). The fifth section represents the main part of the data output file, listing 

the values of the selected attributes for each individual throughout the simulation. As stated 

previously, this data will either be output for each individual at regular time intervals or 

alternatively every time the individual moves within the geometry, depending upon the output 

method selected by the user. The sixth section resembles closely the first section outlined 

previously. Once again, both the buildingEXODUS EXODUS geometry file (.EXO) from 
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which the corresponding data output file was generated and the total number of people within 

the geometry are stated. However, in contrast the time at which the data output file was 

completed is also given, as opposed to the time the file was initially generated as in section one. 

Utilising the times stated within sections one and six it is therefore possible for users to see the 

time the corresponding simulation was started and completed, and hence calculate the real time 

taken to complete the simulation. Finally the seventh section merely states the final simulation 

time of the evacuation from which the data output file was derived. 

 

Once generated, the attribute data contained within an output file can be loaded into any external 

spreadsheet software used for the production of graphs (i.e. Microsoft EXCEL). Once 

successfully loaded the data can then be sorted according to Person ID and Sim. Time, thereby 

enabling graphs of the evolution of each of the given attributes throughout the simulation to be 

generated for each individual. 

 

NOTE: 

When the Movement option is enabled the final node of each selected individual is outputted 

twice, namely when they both enter and exit the node. 

 

6.6.3 Hazard Options 

Shortcut: [RuleBase/Hazard Options]  
This option is only applicable in software level C.  Its purpose is to configure the toxicity sub-

model as described in the Theory Manual, Chapter 6.  When this option is selected, the dialogue 

box, as shown in Figure 6-30, is displayed.  Each group identified in Figure 6-30 is described 

in turn: 

 

(a) Hazard Model- This option is only valid in software level C.  When disabled, no toxicity 

or smoke interaction calculations are performed, the individuals are prevented from 

incurring FIN or FIH values (see the Theory Manual, Chapter 5) and the Agility and Mobility 

attributes are therefore not dependent upon FIN or smoke concentration. By default the 

Hazard model is switched off. 

 

(b) Heat Model - This configures the heat model used to calculate FIH values.  Either the 

Purser or Speitel heat model may be chosen by selecting the relevant option (see the Theory 

Manual, Chapter 5). By default the Purser model is selected. This section also controls the 

hyperventilation factor in the calculations for FIN.  One option may be selected from Purser 

(the Purser hyperventilation model is used) or 1 (there is no hyperventilation impact upon 

CO, only upon the intake of HCN, and FLD) - see the Theory Manual, Chapter 5. By default 

1 is selected. If the Person Heights option is enabled then the individual’s height attribute 

will determine the CFAST zone that the individual interacts with and will therefore have an 

impact on the toxicity level experienced. If this option is disabled then a default figure of 

1.7m is used. By default the Person Heights option is disabled. This feature does not apply 

to data imported from the SMARTFIRE model. 
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(c) FED Components - Any of the options in this section may be selected.  The only attributes 

directly determining incapacitation are FIN, FIH, FLD/FIC or FICO2 (see the Theory 

Manual).  The user may select which of these factors apply to the simulation - those options 

with a tick are included in the simulation. By default the FIN, FICO2 and FID components 

are enabled. If the Pain Threshold option is selected within the Rad Heat Flux attribute then 

the individual will be unable to continue evacuating once pain is experienced. If 

Incapacitation is enabled then the evacuee is able to evacuate until being completely 

incapacitated. If the User-Defined option is enabled then the user is able to supply a value 

for the Radiative Denominator, Dr, of the own. This can be entered in the Rad. Value edit 

box. By default the Pain Threshold option is enabled.  Finally, the user also has the option 

of specifying the Radiant Heat Threshold value, which by default is 1.7 KW/m2.  This 

defines the radiative heat value (KW/m2) above which radiative heat will start to affect the 

population (i.e. increase their corresponding FIHr and FIH values). Any radiative heat 

smaller than this threshold value is therefore assumed not to affect the agents.  It is important 

to note that in versions of buildingEXODUS prior to v6.3 the Radiation Threshold value 

was fixed internally, and hence users were not permitted to change it. 

 

(d) Feed Back - These control how the toxicity model affects the mobility of the evacuees.  

IRRITANT, SMOKE and FIN all affect both the Agility and Mobility attributes of an 

individual.  However, the selection of the first two attributes (i.e. IRRITANT and SMOKE) 

also affect how the irritant model is applied. This is described in some detail in the Theory 

Manual. If the SMOKE option is selected alone then the irritant toxins within the 

environment are assumed not to be modelled explicitly and the Jin ‘Irritant’ data–set is 

utilised. The Jin ‘irritant’ curve will then entirely determine the impact of the visual 

obscuration and the irritancy. If both the SMOKE and IRRITANT options are selected then 

the irritant toxins are assumed to be explicitly simulated (i.e. levels relating to the irritant 

gases are provided in the hazard scenario). The Jin ‘Non-Irritant’ curve (see the Theory 

Manual) will then be interrogated (to determine the visual obscuration provided by the 

smoke), as well as the irritant toxin levels within the environment to help determine an 

agent’s mobility. If the IRRITANT option alone is selected then the visual obscuration will 

not be considered and only the levels of the irritant toxins in the environment will be 

considered. If all are selected the factor which has the greatest effect on the mobility is 

selected (i.e. a Mobility Degradation Factor is calculated for each of the three effects and 

the one which is smallest is then used in the calculation of Mobility and hence also Travel 

Speed, see the Theory Manual). Similarly, if all are selected then the factor which has the 

greatest effect on the agility is also selected. However, in this case only the factors 

corresponding to exposure to narcotic gases (FIN) and irritant gases are considered. Hence 

the factor corresponding to exposure to non irritant gases is not considered. This is because 

non irritant smoke only causes visual obscuration. While this obscuration may affect an 

agent’s ability to move within a structure (i.e. affecting their Mobility and Travel Speed) it 

is felt unlikely to affect their ability to negotiate obstacles (i.e. their Agility). As a result, a 

Mobility Degradation Factor is calculated for each of the two effects (i.e. FIN and FIC) and 

the one which is smallest is then assumed to represent Agility Degradation Factor. The 

Agility Degradation Factor is then used in the calculation of Agility (see the Theory 

Manual). By default all of the Feed Back options are enabled. 
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(e) Response Overrides - When fire hazard concentrations exceed a certain level, individuals 

who have not started to egress, start to egress regardless of their individual response times.  

Only the Smoke, Radiative Flux and Temperature fire hazards may over-ride the response 

times.  The levels at which the override occurs for the Smoke and Temperature overrides 

may be altered by placing the cursor in the relevant box and modifying.  The default value 

for Temperature is 50C and the default value for Smoke is 0.1/m. The Radiative Flux 

override may be enabled by clicking on the relevant selection. If enabled this will represent 

the individual responding when the pain threshold has been reached (i.e. when an FIH of 

1.0 would have been reached had the Pain Threshold had been selected). If the Pain 

Threshold had actually been selected, then the Radiative Flux override will have no option. 

 

(f) Dialogue Buttons - The DEFAULT button returns all the dialogue box settings to their 

original values, as described in Table 6-6.  To retain any modifications to the dialogue box, 

select the OK button.  The CANCEL button closes the dialogue box and makes no 

modifications.  

 

 
Figure 6-30: The Hazard Control dialogue box for configuring the Hazard Sub-model. 

 

The default settings of the options outlined above are described in Table 6-6. 
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Table 6-6: Default values in Hazard Control dialogue box 

Group Item Default Explanation 

Heat Model 
Purser Yes Heat model used in FIH calculations 

Speitel No Alternative heat model for FIH calculations 

Person Heights Enabled No Default Person Height is used 

VCO2 
Purser Yes Purser Hyperventilation factor 

1 No No Hyperventilation factor 

VCO RMV 

Cap 

(lit/min) 

 70 

The maximum RMV rate used for the FIHCN and FLD 

components of the FIN calculation. This caps the 

hyperventilation component in response to CO. 

FED 

Components 

FIN Yes Switch for FIN calculations 

FIH Yes Switch for FIH calculations 

FICO2 Yes Switch for FICO2 calculations 

FLD & FIC No Switch for FLD/FIC calculation 

FIC=1 

Options 

 All 

Agents 

Exited 

Switch to determine under what conditions a simulation 

will terminate in relation to agents with FIC values >= 1 

(i.e. those escape impaired/immobilised as a result of 

instantaneous irritant exposure). 

Options below.  

(1) All Agents Exited indicates that a simulation will 

only terminate when no agents remain within the 

structure (i.e. all agents have either exited or died). If 

agents have become escape impaired/immobilised as a 

result of instantaneous irritant exposure, the simulation 

will therefore continue to run until either each 

immobilised agent has succumbed to the effects of heat 

or narcotic gases, or the defined maximum simulation 

time has been reached. 

(2) All Mobile Agents Exited indicates that a simulation 

will terminate once all the mobile agents have exited the 

structure.  Hence, the simulation will terminate even if 

agents immobilised as a result of instantaneous irritant 

exposure are still present with the structure. 

(3) Non Changing FED Values indicates that a 

simulation will terminate once all the mobile agents 

have exited the structure and the FED values (i.e. FIH or 

FLD) of any immobilised agents still in the structure are 

not increasing.   

Rad. Heat 

Flux 
Pain 

Threshold 

This defines the impact of radiative flux. Three options 

are available namely, Pain Threshold, Incapacitation 

and User Defined. By default the Pain Threshold option 

is selected since this represents a conservative lower 

estimate of the impact of radiative flux. 

Rad. Value 80.0 

Allows the user to define the Rad Value controlling the 

impact of radiative heat. This option is only available if 

the User Defined option has been selected within the 

Rad. Heat Flux attribute (see above). Values of 80.0 and 

1000.0 correspond to the Pain Threshold and 

Incapacitation effects respectively. 

Rad. Heat 

Threshold  
1.7 

This defines the radiative heat value (KW/m2) above 

which radiative heat will start to affect the population. 

Any radiative heat smaller than this threshold value is 

therefore assumed not to affect the agents (i.e. it will not 

increase their corresponding FIHr value). 
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Feedback 

FIN Yes 
Defines whether narcotic exposure i.e. FIN affects agent 

Agility, Mobility and Travel Speed. 

Smoke Yes 

Defines whether smoke exposure affects agent Agility, 

Mobility and Travel Speed. Note: Only irritant smoke 

affects an agent’s Agility. 

Irritant Yes 
Defines whether irritant exposure i.e. FIC affects agent 

Agility, Mobility and Travel Speed. 

Response  

Overrides 

Temperature 50C Temperature value that overrides response time 

Smoke 0.1 /m Smoke value that overrides response time 

Rad. Heat 

Flux 
Yes Radiative Flux response time override 

 

6.6.4 Behaviour Options 

Shortcut: [RuleBase/Behaviour Options]  
The settings relating to the evacuee behavioural response are gathered together in the Behaviour 

Control dialogue box (see Figure 6-31 and Figure 6-38). The behavioural settings are separated 

into five sections Route (see Section 6.6.4.1), Behaviour (see Section 6.6.4.2), Environment 

(see Section 6.6.4.3), Signage (see Section 6.6.4.4) and Lifts (see Section 6.6.4.5). These 

sections are now discussed. 
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a) Route tab b) Behaviour tab 

 
 

c) Environment tab d) Lifts tab 

Figure 6-31: Behaviour Control dialogue box, the a) Route, b) Behaviour, c) 

Environment and d) Lifts tabs. 
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NOTE: 

The user may wish to engineer a number of factors in addition to the behavioural options. These 

may include travel speeds, patience levels, etc. The user should be aware that although the 

option libraries control the behavioural actions, they do not impact upon individual attributes. 

 

6.6.4.1 Route tab 

This section relates to the numerous methods of describing the targets for evacuee movement. 

 

(i) Awareness Section 

 

 Local Familiarity (Default - OFF)  

 

If enabled, the evacuees select their target exit from their individual exit list (the Occupant Exit 

Knowledge) rather than moving according to the potential map system. Any redirection will 

also be made according to the occupant’s familiarity with the enclosure (see the Theory Manual, 

Section 7.1). If disabled, the evacuees will the Potential Map system.  

 

 All Main Exits (Default - OFF)  

A feature assisting in the use of Local Familiarity has been included. This enables the user to 

guarantee that each individual will be familiar with all of the main exits that are available within 

the geometry. This can be achieved by flagging the All Main Exits option in the Behaviour 

Control dialogue box, available off of the RuleBase menu in Simulation mode. 

 

(ii) Potential Section 

 

 Floor Potential Map (Default- OFF) 

This option allows the user to control the potentials generated on a floor by floor basis. With 

this option enabled each node that connects a floor to a level of lower potential becomes a 

“Floor Potential Node”. Floor Potential nodes can have their potential value adjusted to control 

the local potential map of a floor in a similar manner to an Attractor node. When a person steps 

on a Floor Potential node their next movement is to a connecting node on a floor nearer to an 

available exit. This then allows the movement of evacuees to be controlled according to the 

attractiveness of aspects of each floor rather than the overall attractiveness according to the 

location of the final exit point. This is better shown by an example. In Figure 6-32, the floor 

potential is enabled. The potential is then calculated on the upper floor with no reference to the 

attributes of the lower floor. In Figure 6-33, where the floor potential has been disabled, the 

potential map is calculated with reference to the location of the final exit point. 

 

NOTE: 

Floor Potential nodes are the nodes that connect a floor to a level of lower potential and act in 

a similar way to an Attractor node. 
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(a) (b) 

Figure 6-32: With Floor Potential Nodes enabled the potential map leads to the nodes 

connecting to the lower floor. 

 

  
(a) (b) 

Figure 6-33: The potential map with floor potential switched off (default). Note how the 

left connection on the upper floor is not used. 

 

NOTE: 

If the Floor Potential switch is disabled and then enabled after a simulation or potential map 

recalculation, the values at the Floor Potential nodes will need to be re-assigned by the user in 

Scenario mode. 

 

NOTE: 

Changes to the Floor Potential option will have no impact upon occupants with Target Exits or 

those that are using the Local Familiarity system. 

 

 Local Potential (Default - ON) 

This option is only applicable when a geometry contains Attractor/Discharge or Internal Exit 

nodes.  If switched OFF, the potential set on any Attractor nodes or on Internal Exit nodes are 

ignored, thus treating Internal Exit or Attractor/Discharge node combinations as normal free-

space nodes. These nodes can then only affect the results produced by influencing the flow rates 

allowed through a specific section of the geometry. It should be noted that once the potential 

attached to Attractor nodes and Internal exit nodes have been over-ridden, switching the Local 

Potential back ON again has no effect upon the nodes impact. To re-introduce the nodal 

influence the required potential must be re-assigned in Scenario mode. 

 

NOTE: 

Changes in the Local Potential will have no impact upon evacuees with Target Exits or those 

that are using the Local Familiarity system. 
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NOTE: 

If the Local Potential switch is disabled, the flow rate restrictions attributed to the Attractor / 

Discharge nodes or the Internal Exits will still have an impact upon the evacuee population. 

 

(iii) Route Management Section 

 

 Maintain Target Exit (Default – OFF) 

Individuals who have a target exit revert to the potential map if their patience expires (see the 

Theory Manual, Section 7.1).  If the Maintain Target Exit switch is enabled, this behaviour is 

overridden, i.e. allows the individuals with target exits to exhibit extreme behaviour. 

 

 Maintain Itinerary (Default - OFF) 

If enabled, individuals who have been attributed with an Itinerary List will attempt to fulfil their 

tasks, irrespective of the environmental conditions or whether they have exceeded their 

Patience setting (see the Theory Manual, Section 7.1). If disabled, it is possible for individuals 

to lose their P.I.L.  This option is of particular importance if pre-defined procedures are relied 

upon, as the evacuees can then be forced to follow a procedure irrespective of the conditions 

that they experience. 

 

 Transit Node Grouping (Default - OFF)  

Allows the user to group together adjacent transit nodes that connect equivalent levels / spaces 

enabling the occupant use of these nodes to be managed by the user or adaptively selected by 

the approaching occupants.  

 

6.6.4.2 Behaviour tab 

There are several sub-sections present on the Behaviour tab, each of which relates to specific 

aspects of the evacuation process. These are now described. 

 

(i) Initial Response Section 

 

 Milling (Default - OFF) 

When Milling is disabled, people will remain stationary prior to evacuation (i.e. until either 

their individual Response Time has elapsed or until it has been overridden). However, if enabled 

individuals will walk in apparently random directions prior to evacuation.  A restriction is 

placed upon the maximum distance that each person can move relative to their initial starting 

location.  This maximum distance is related to the Drive of each individual and is calculated by 

the following: 

 

Max Distance (m) = 1.0 + 9.0*Drive 

 

This is a relatively arbitrary function that provides a limit to the level of milling, whilst 

maintaining a variation within the population. 

 

To ensure that people do not exit the geometry (or move closer to an exit) whilst in the process 

of milling, thereby negatively affecting the validity of the results, a two metre milling exclusion 

zone is created around each external exit.  The speed at which people move during Milling is 

equivalent to their individual Fast Walk Rate.  It is important to note that the distance travelled 

by a person whilst milling is not included in their Dist. Trav. attribute.  Similarly when 

individuals encounter congestion during milling the waits that they experience are not included 

in their Cumulative Wait Time (CWT).   
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If Milling is not enabled, then as has already been stated, people will remain stationary prior to 

evacuation.  In instances where people’s starting locations are near doorways, the stationary 

nature of these individuals may act as an obstruction.  Such obstructions can result in reduced 

flow rates through doorways and therefore increased evacuation times.  In some extreme cases 

doorways may become completely inaccessible as a result of stationary occupants.  In both 

these cases the validity of the results will be affected.  However if Milling is enabled, the 

associated random movement of the people near these doorways enables others to pass.  As a 

result the doorways are free from obstruction.  Milling is also used since it enables a degree of 

variation in the starting position of each individual to be modelled between simulations.  

 

 Specified Response / Time (s) (Default - OFF / 0.0 seconds) 

When enabled, this option forces the entire population to ignore their Response Time attribute 

and evacuate at a user-defined time within the simulation.  This does not replace the Response 

Time attribute of the population.  Instead these are not considered and the individuals will only 

start to evacuate when the specified time is reached within the simulation.  By default the 

Specified Response time is set at 0.0 seconds.  This is equivalent to an Instant Response by the 

population, and forces all of them to evacuate on commencement of the simulation.  If then 

disabled, the population will respond according to their individual Response Times. 

 

 Zone Events (Default - OFF) 

This option allows the user to enable both the Obstacle and Response zones previously defined 

within Scenario mode.  

 

Enabling Obstacle zone events allows the Obstacle values of the connecting arcs within the 

zone to change throughout the simulation. Changes within the Obstacle value of each 

connecting arc within the zone are defined by the user specifying a series of Obstacle Zone 

Events comprising a list of Obstacle values and corresponding trigger times. The trigger times 

specify when changes in the associated zones connecting arcs Obstacle values should take 

place, while the Obstacle values specify the values that they are required to adopt at those times. 

The arc Obstacle values within each Obstacle Zone can be updated either in discrete steps or 

by using linear interpolation between adjacent values within the list. Arc Obstacle values will 

remain fixed throughout the simulation if the Zone Events flag is disabled. 

 

Enabling Response zone events allows an individual’s Response Time to be overridden by the 

time associated with the zone in which they start. If the time associated with the Response zone 

is smaller than the Response Time attribute of an individual, then the individual will instead 

adopt the zone response time in preference to their own. Conversely, if the time associated with 

the Response zone is greater than the Response Time attribute of an individual, then the 

individual will be unaffected by the Response zone and will continue to respond according to 

their own individual Response Time. Individuals not starting within a defined Response zone 

will similarly respond purely according to their own individual Response Time. No individuals 

will have their Response times overridden, and hence will all respond entirely according to the 

their own individual Response Times, if the Zone Events flag is disabled.  

 

NOTE: 

Response zone events will be overridden if a Specified Response has been set which occurs 

before the time associated with the zone in which an individual is located. 

 

(ii) Movement Section 
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 Natural Movement (Default - OFF) 

This option combines the previous effects of Avoid Pop Density and Angle of Movement: It 

affects the person’s likelihood of occupying a node by biasing locations that require the least 

change of direction from the individual’s current direction of movement, while maximizing the 

space around themselves. Therefore instead of individuals moving purely according to the 

potential map or the distance map, their movement is also governed by an attempt to maintain 

their direction of movement avoid areas of higher density. This produces a more 'natural' style 

of movement, reducing the level of zigzagging that can occur when moving purely according 

to the potential/distance map and preventing unnatural clumping of occupants where space is 

available nearby.  

 

 Extreme Behaviour (Default - OFF) 

When this option is disabled, the Extreme Behaviour regime is prevented from occurring (see 

the Theory Manual, Chapter 6).  If this is the case, the Patience attribute assigned to the 

evacuees is effectively ignored in all cases except seat jumping (see the Theory Manual). If 

enabled, the evacuee population may become Extreme if their Wait time exceeds their Patience 

attribute. This allows the evacuee more freedom in occupying nodal locations (see the Theory 

Manual). 

 

 Impatient (Default-OFF) 

When enabled, this option forces all of the evacuees to ignore their Patience attribute and 

assume a Patience level of zero. This may have an impact the behaviour exhibited by the 

individual, especially in relation to Extreme behaviour and to movement between available 

exits. This does not replace the Patience attribute of the evacuees. Instead the attribute is not 

considered and the evacuee population is considered impatient at all times. If the Impatient flag 

is then disabled, the evacuees will behave according to their individual Patience attribute. 

 

 Seat Jumping (Default - OFF) 

When disabled, this option prevents evacuees from leaping over seat rows.  Only travel within 

seat rows is permitted.  If enabled, evacuees may travel within or between seat rows. This option 

will have no impact in geometries without seat rows. 

 

 Wall Proximity (Default-OFF) 

This option allows the individual to prioritise their choice of node so that the likelihood of 

occupying a nodal location is biased according to its connectivity, i.e. the choice of a node will 

be biased against nodes of low connectivity compared to their adjacent nodes. Therefore, the 

avoidance of such nodes, where possible, results in the person avoiding locations that are in 

close proximity to the enclosure boundary e.g. walls. 

 

NOTE: 

This behaviour only applies to Free Space node movement. 
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(iii) Interactive Behaviour Section 

 

 Avoid Congestion (Default - OFF) 

This algorithm determines whether an individual will redirect away from a particular external 

exit due to the level of congestion around that exit (i.e. the exit towards which they are heading). 

The use of this function is dependent upon the user having generated Sign Visibility zones 

corresponding to the available exits establishing the information to which the evacuees have 

access. This is achieved firstly by generating appropriate exit signs (Geometry mode) at the exit 

locations and then by switching to Scenario mode, opening the Zone Editor dialogue box, 

setting the Zone Type to Visibility Signs and clicking the Calc. Viz. Signs button. This generates 

the Visibility Catchment Areas (VCA) of each available sign. Each of the zones associated with 

each of the signs within the geometry will then be displayed within the Zone Editor dialogue 

boxes corresponding Zone List  (see Figure 6-34). If the process of Visibility Sign zone 

generation is not completed prior to the simulation, then the adaptive exit selection will not take 

place, as it will only be enacted once the individual is able to ‘see’(i.e. falls within the visibility 

zone) their current exit through the presence of an exit sign.  

 

 
Figure 6-34: Demonstration of the Sign Visibility Zone of an exit sign using the Visibility 

Signs function. 

 

To enable the redirective behaviour the user must access the Behaviour Control dialogue box 

from the RuleBase menu in Simulation mode (see Figure 6-31). From here the Avoid Congestion 

option should be enabled. On running the simulation, the evacuees will not then simply move 

towards their current exit irrespective of the level of crowding around it, but will instead take 

into consideration the other options available to them according to the information at their 

disposal.    

 

 Social Response (Default- OFF) 

When this option is enabled, groups of individuals who share a common gene value will have 

the ability to communicate some basic information between themselves (see the Theory 

Manual). Individuals within 2m of each will be examined to determine whether they share a 

gene. The information that is shared includes a person’s awareness of the exits on board (their 

OEK) and the response time attribute. An individual’s awareness of the structure will be 
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augmented if omissions are evident through comparison with those that share a gene, who fall 

within a 2m radius of them. This will only occur if the Local Familiarity option is enabled. The 

response times of those ‘communicating’ will revert to the lowest Response Time detected. 

 

 Social Movement (Default- OFF) 

When this option is enabled, groups of individuals who share a common gene value will have 

the ability to communicate some basic information between them (see the Theory Manual). 

Individuals within 2m of each will be examined to determine whether they share a gene. The 

information that is shared includes a person’s awareness of the exits on board (their OEK), their 

itineraries (OIL), and the Response Time attribute. In addition, an attempt will be made by the 

group members to maintain close proximity by moderating their travel speeds (see the Theory 

Manual).  

 

 Conflict Times (Default Values- C1=0.5, C2=0.7, C3=0.8, C4=1.5) 

When conflicts occur for nodal locations during a simulation, all of the occupants involved in 

each conflict are awarded a time penalty.  The time penalty awarded to each occupant is 

randomly selected between two values and is dependent upon the difference in drive attributes 

(see the Theory Manual, Section 7.2).  When this option is selected from the Behaviour Control 

dialogue box, the Conflict Times dialogue box is presented, as shown in Figure 6-35.   

 

 
Figure 6-35: The dialogue box to modify conflict times 

 

Four values may be modified by the user by placing the cursor in the required box and 

modifying.  These values are C1, C2, C3 and C4. C1 and C2. These represent the upper and 

lower bounds for conflict times awarded to occupants whose drive attributes differ significantly 

(i.e. there is a clear winner to the conflict).  C3 and C4 represent the upper and lower bounds 

for conflict times awarded to occupants whose drive attributes are considered to be very close 

(i.e. closely matched and hence difficult to resolve). 

 

NOTE: 

It is extremely difficult to determine a set of conflict time penalties that are appropriate for all 

circumstances.  The default values used in EXODUS have been deemed to be reasonable 

through testing and have produced acceptable results during testing and validation.  Users 

should note that in some circumstances changes to these values may produce significant 

differences in model predictions.  

  

NOTE: 

Default conflict times should be modified with great care.  If, as part of a simulation or scenario, 

the conflict time penalties are altered, it is vital that these changes are noted in the 

documentation supporting the results.  

 

NOTE: 
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The default conflict times are appropriate for the default mesh spacing.  If a geometry is meshed 

with a spacing different to the default value, it may prove necessary to reassess and redefine 

the conflict times and travel speed distributions. This may prove necessary as changes to the 

mesh may impact the range of packing densities in heavily congested areas allowed by the 

model. 

 

(iv) Stair Behaviour Section 

 

 Spacing (Default – Staggered) 

This option controls behaviour exhibited on stairs.  When the Staggered option is selected, 

evacuees travelling on staircases will – wherever possible – avoid situations in which there are 

more than one evacuee per riser (see the Theory Manual).  On wider staircases individuals will 

attempt to maintain a nodal space between themselves and others sharing the same riser. When 

the Packed option is selected, all nodes across a riser may be occupied – the Theory Manual 

gives more details on staircase behaviour.  In both cases the individuals attempt to move in such 

a way so as to keep the node directly ahead of them empty.  

 

It should be noted the exact manner in which Staggered and Packed behavioural regimes 

influence performance can be modified on each Transit Node employed. This additional 

flexibility has been included to allow the user to account for different packing levels on different 

egress components. The default staggered effect was originally derived from the work of Pauls 

and Fruin [19,31] (see the Theory Manual). 

 

 Stair Edge Preference (Default - ON) 

This flag is included to aid the user in controlling stair flow rates more precisely and producing 

a qualitative change in the use of the staircase by attributing people with a preference for 

moving towards the edge of the stairs and using the handrails. It may be required to disable this 

option if the modeller desire faster flow rates. 

 

6.6.4.3 Environment tab 

This section relates to the evacuee response to a deteriorating environment. 

 

 Crawling (Default- ON) 

If this option is selected, occupants will crawl when the environmental conditions to which they 

are exposed exceeds given thresholds. The thresholds defining when an individual will 

commence crawling is dependent upon the options selected within the Hazard Control dialogue 

box (see Section 6.6.3). If both the FLD and FIC option (within the FED Components section) 

and the Irritant option (within the Feedback section) are enabled, individuals will be assumed 

to start crawling if either the smoke extinction coefficient to which they are exposed exceeds 

1.0/m or if the combined irritant gases generate an FIC value in excess of 0.3 (see the Theory 

Manual). If both the FLD and FIC option and Irritant option are not enabled individuals will 

conversely be assumed to start crawling if the smoke extinction coefficient to which they are 

exposed exceeds 0.5/m.  When an occupant is crawling, the travel speed adopted is the Crawl 

speed attribute and the hazards affecting the occupants are those stipulated at the lower height. 

By default the Crawling option is enabled. 
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 Smoke Stagger (Default-OFF) 

This option enables the inefficient movement through smoke, described in the Theory Manual. 

As the smoke worsens, so the ‘staggering’ movement of the occupant worsens. If disabled, the 

smoke will only be able to impact upon the occupant Agility, Mobility and Travel Speed, 

according to the selection of other options (see Section 6.6.3). 

 

 Redirection (Default-OFF) 

This option enables the occupant to have the capability of redirecting when confronted with a 

smoke-filled environment (see the Theory Manual). If enabled, the user is afforded a number 

of options concerning the exact data-set used to determine the occupant behaviour (see Figure 

6-36). One option is to make use of a User-Defined data-set allowing the user to provide their 

own data concerning the probability of occupant redirection given visibility levels. This is 

entered via the USER DEFINED REDIRECTION dialogue box, where the user is able to 

provide a maximum of eight data-points (see Figure 6-37). These data-points relate the 

likelihood of the occupant redirecting (in %) to the visibility (in m) afforded to them by the 

smoke barrier. 

 

 
Figure 6-36: The selection of the redirection data set. 

 

The model then calculates a linear fit between each of the data-points provided. For visibility 

values greater than the maximum value provided, the occupants are assumed not to redirect. 

The other options are to make use of the Bryan or Woods data or an average of the two data sets 

(see Chapter 5 and the Theory Manual for details). 

 

 

Figure 6-37: An example of how the user may define the likelihood of occupant 

redirection. 
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 Gender Influence (Default-ON) 

Enabling this option will only have an effect if the Redirection option is enabled. This will then 

introduce gender as a factor in occupant redirection so that female occupants are 25% more 

likely to redirect than male occupants (see the Theory Manual). 

 

 Visual Coefficient (Default-2.0) 

The Visual Coefficient is a dimensionless value used in the calculation of the visibility afforded 

to the occupant by a smoke-filled environment. The default position of 2.0 is taken from the 

work of Jin [17,18] and is considered a conservative estimate of the visual capability of the 

occupant population in smoke (see the Theory Manual). The user is able to adjust this figure, 

although it should be done with caution as this figure will influence both the extent of the 

occupant ‘staggering’ in a smoke-filled environment as well as their likelihood of redirection 

in response to a smoke barrier. 

 

6.6.4.4 Signage tab 

The items appearing on the Signage tab are determined by the selected option in the Signage 

System drop down box (see Figure 6-38). By default this is set to NONE and therefore the 

Signage tab will not provide any other information or items. The available options for the 

Signage System are Predictive, Empirical, User-Defined and None.  
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(a)     (b) 

Signage tab, where (a) Predictive or (b) Empirical options have been selected. 

     
(c)     (d) 

Signage tab, where (c) User-Defined or (d) None options have been selected. 

Figure 6-38: Behaviour Control dialogue box, the Signage tab 

 

The recommended model to use when simulating the interaction of agents with the signage 

system is the Empirical model. This is the only model based on actual data (see the Theory 

Manual). The options, settings and flags that become available based on the selected Signage 

System are shown in Table 6-7. Each one of these items is then described below. Note that as 

Table 6-7 suggests not all options are available at the same time. 
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Table 6-7: Signage Options 
Option Predictive Empirical User-Defined None 

Min Detection Probability   X  
 
 
 
 
 
 

N/A 

Max Detection Probability   X 

1st Sign Min Compliance Probability   X 

1st Sign Max Compliance Probability   X 

All Other Signs Compliance Probability   X 

Detection Probability X   

Compliance Probability X   

Visibility Probability: Sigmoid Function X X X 

Visibility Probability: User Value X X X 

Searching X X X 

Backtracking X X X 

Communication X X X 

EDBS X X X 

Searching [x EDBS] X X X 

Backtracking [x EDBS] X X X 

Failsafe [x EDBS] X X X 

 

 Min Detection Probability (Default - 30%) 

This value represents the minimum value of the probability range indicating whether a person 

that is within a VCA of a sign is attentive and will detect the sign receiving the information 

relayed by the sign. 

 

 Max Detection Probability (Default - 38%) 

This value represents the maximum value of the probability range indicating whether a person 

that is within a VCA of a sign is attentive and will detect the sign receiving the information 

relayed by the sign. 

 

 1st Sign Min Compliance Probability (Default - 94%) 

This value represents the minimum value of the probability range indicating whether a person 

that is within a VCA of a sign will comply and act on the information received from the sign. 

This probability only applies to the first sign the person encounters.  

 

 1st Sign Max Compliance Probability (Default - 97%) 

This value represents the maximum value of the probability range indicating whether a person 

that is within a VCA of a sign will comply and act on the information received from the sign. 

This probability only applies to the first sign the person encounters.  

 

 All Other Signs Compliance Probability (Default - 100%) 

This value represents the probability that a person that is within a VCA of a sign will comply 

and act on the information received from the sign. This probability applies to all signs a person 

encounters other than the first one.  

 

 Detection Probability (Default - 50%) 

This value represents the probability that a person that is within a VCA of a sign is attentive 

and will detect the sign receiving the information relayed by the sign 

 

 Compliance Probability (Default - 100%) 

This value represents the probability of a person complying and acting upon the information 

received from the sign.  
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 Visibility Probability: Sigmoid Function (Default - ON) 

This value represents the probability of a person that is within a VCA of a sign of seeing that 

sign. This probability depends on the angle of approach towards the sign. As the observation 

angle increases the probability of seeing the sign decreases in a sigmoid manner.  

 

 Visibility Probability: User Value (Default - 100%) 

This value represents the probability of a person that is within a VCA of a sign of seeing that 

sign. This probability is determined by a single user defined value.  

 

 Searching (Default - ON) 

This flag indicates whether a person who has received information from a sign will engage in 

searching behaviour. Searching occurs at a pre-defined travelling distance and during this 

period a person continues moving in the general direction of travel in anticipation of seeing 

their target or next sign. 

  
 Backtracking (Default - ON) 

This flag indicates whether a person who has completed the searching phase will engage in 

backtracking. Backtracking involves moving back towards the location where the person saw 

the last sign. From that location the person tries again to find the target or next sign. 

 

 Communication (Default - OFF) 

This flag specifies whether a person that is backtracking can receive information regarding the 

target that they are trying to reach from another person in the geometry.  

  

 EDBS (Default - 30m) 

The Expected Distance Between Signs value represents the distance within which the next sign 

in the signage chain should be expected to be seen.  

 

 Searching [x EDBS] (Default - 0.67 of EDBS) 

This value represents the distance that a person will have to travel for searching behaviour to 

start. This value is a multiplicative factor of EDBS. If an agent that has a Find via Signage task 

(i.e. follows signage system using the Agent Driven behaviour model, see the Theory Manual) 

reaches the direction node before walking a distance of 0.67xEDBS then this agent will engage 

in Searching behaviour moving in their general direction of travel. 

 

 Backtracking [x EDBS] (Default - 2.00 of EDBS) 

This value represents the distance that a person will travel before backtracking starts. This value 

is a multiplicative factor of EDBS. 

 

 Failsafe [x EDBS] (Default - 3.50 of EDBS) 

This value represents the distance that a person will have to travel before failsafe behaviour 

starts. This value is a multiplicative factor of EDBS. If Searching and Backtracking is disabled 

then Failsafe behaviour is initiated at 1.5xEDBS. If only Backtracking is disabled then Failsafe 

behaviour is initiated at 2.0xEDBS. 

 

Further information on these options can be found in the Theory Manual, Chapter 8. 
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6.6.4.5 Lifts tab 

This section relates to the use of lifts by agents within buildingEXODUS. 

 

(i) Lift Model Section 

 

Lift Evacuation (Default-OFF) 

This option defines whether the lift model will be enabled during a simulation. If this is set to 

OFF, then the lifts will not be enabled and all agents will use alternate methods to travel 

vertically. This will negate the influence of the remaining attributes in the Lift tab. This option 

must be set to ON in order for the lifts to be utilised. 

 

All Use Lifts (Default-OFF) 

This defines if agents which are on floors serviced by a lift will all initially choose to use a lift. 

Agents will only move towards lifts assigned a Shuttle Floor procedure if the agent’s initial 

floor is part of the lift’s sequence. Agents that are on a floor that is not serviced by a lift will 

start using the stairs for vertical movement and will continue to do so even if they reach a floor 

that is serviced by a lift. Similarly, Agents will only move towards lifts assigned a Sky Lobby 

procedure if the agent’s initial floor is part of the lift’s sequence or the floor in which the sky 

lobby is located falls between the agent’s initial floor and their exit (i.e. if an agent’s exit is 

located below them they will only consider moving down to a sky lobby, not up). Agents not 

meeting these criteria will use the stairs. 

 

If this attribute is set to OFF then the proportional system according to the floor number will 

be used (see Section 5.17.4).  If this attribute is set to ON, then all agents that are on floors that 

are serviced by a lift will initially choose to use a lift. However, this does not mean that these 

agents will use a lift as they might redirect away due to congestion or if their lift wait time 

expires.  

 

Lift Floor Based Potentials (Default-OFF) 

This defines how far the distance maps spread from each Lift Shaft Opening Transit node. If 

this is set to OFF, then the potential distance maps will spread throughout the entire geometry. 

This may take some time to calculate depending on the size of the geometry and the number of 

Lift Shaft Opening Transit nodes. This may be appropriate if agents are required to select a lift 

which is on another floor. If this is set to ON, then the potential distance map for each Lift Shaft 

Opening Transit node will only spread on the floor it is located. This should take less time 

compared to when the potential distance map spread throughout the entire geometry. This may 

be appropriate when agents only choose to use a lift that is on their current floor.   

 

Shuttle Floor Return (Default-OFF) 

This defines the ability of lifts assigned Shuttle Floor sequences to return to pick-up floors after 

they have been cleared (i.e. once all the agents waiting in the lift catchment area on the pick-up 

floor have been collected). 

 

If the Shuttle Floor Return option is disabled then once a given pick-up floor has been cleared 

the lift will then move onto the next pick-up/drop off pair within the sequence (see Chapter 5). 

Consequently, once a given pick-up floor has been cleared the lift will therefore not return to 

it, even if agents subsequently turn up on that floor hoping to catch the lift. In this case, the 

agents arriving within the catchment area of a lift on a floor already cleared will be deemed to 

have missed the lift and will therefore redirect to use the stairs. This represents the influence of 
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either dynamic signage or a communication system informing the agents that the lift has already 

serviced their floor and that they should use the stairs instead. This system prevents agents from 

waiting indefinitely for a lift that will not arrive. 

 

However, if the Shuttle Floor Return option is enabled then lifts assigned Shuttle Floor 

sequences can return to previously cleared floors. As a result, agents arriving within the 

catchment area of a lift on a previously cleared pick-up floor will not redirect to the stairs, but 

will instead commence waiting for the lift in the conventional manner. The pair of pick-up/drop 

floors corresponding to the previously cleared floor on which an agent has arrived will then be 

added back into the lifts Floor Requests list (see Chapter 5).  The lift will then return to the 

previously cleared floor in order to collect the agents waiting for the lift.  Once all the agents 

on that floor have then been collected the lift will then move onto the next pair of pick-up/drop 

off floors etc. Hence, when the Shuttle Floor Return option is enabled pairs of pick up/drop off 

floors can be both dynamically added (i.e. as agents arrive within the lift catchment areas of 

previously cleared floors) and removed (i.e. as all the agents waiting for the lift on a given pick-

up floor are collected) from lifts corresponding Floor Request lists throughout the simulation.  

 

NOTE: 

By default the Shuttle Floor Return option is disabled (i.e. lifts assigned Shuttle Floor sequences 

will not return to previously cleared floors). 

 

Sky Lobby Up Floors (Default-0) 

This defines how many floors up an agent is prepared to travel in order to reach a lift assigned 

a sky lobby lift (i.e. a lift assigned a Sky-lobby sequence, see Chapter 5). By default the Sky 

Lobby Up Floors variable is set to zero, thereby implying that agents are not prepared to move 

up in order to reach a sky lobby lift. As a result, an agent will only move towards a lift assigned 

a Sky lobby procedure if the agent’s initial floor is the same as the lift’s pick-up floor, or the 

floor on which the sky lobby is located (i.e. its pick-up floor) falls between the agent’s initial 

floor and their exit (i.e. if an agent’s exit is located below them they will only consider moving 

down to a sky lobby, not up). 

 

If the value of the Sky Lobby Up Floors variable is greater than zero then agents can additionally 

travel up to a sky lobby lift (i.e. in the opposite direction of travel to their nearest exit).  However 

agents can only do this if the number of floors they are required to traverse in or to reach the 

sky lobby lift is less than or equal to the value of the Sky Lobby Up Floors variable. In addition, 

agents will still only travel up to the sky lobby lift if the number of floors that they are required 

to traverse is less than the number of floors they would traverse in travelling down to either 

another sky lobby lift or an exit (i.e. agents will not travel up if there is an alternative down 

option that is closer (or as close) in terms of the number of floors they are required to traverse). 
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(ii) Lift Redirection Section 

 

Congestion Redirection (Default-OFF) 

For agents that initially choose to use a lift, this defines whether they will consider the 

congestion within the lift waiting areas and potentially cause them to redirect to the stairs. If 

this is set to ON, then agents will consider the congestion within the lift waiting area. Hence if 

the congestion level within the lift waiting area exceeds the corresponding Congestion 

Threshold value assigned to them (from the probability distribution for the respective floor in 

the Lift Usage Control dialogue box, see Section 5.17.4), they will abandon waiting for the lift 

and redirect towards the stairs.  Conversely, if this is set to OFF then those agents will not 

consider the congestion within the lift waiting area (i.e. they will use a lift irrespective of the 

congestion). 

 

Wait Redirection (Default-OFF) 

For agents that initially choose to use a lift, this defines whether they will consider how long 

they are prepared to wait to use a lift in the lift waiting areas and potentially cause them to 

redirect to the stairs. If this is set to ON then agents will consider the amount of time they have 

spent waiting for the lift within the lift waiting area. Hence if the total amount of time the agent 

has spent waiting within the lift waiting area exceeds the corresponding Wait Time value 

assigned to them (from the probability distribution for the respective floor in the Lift Usage 

Control dialogue box, see Section 5.17.4), they will abandon waiting for the lift and redirect 

towards the stairs. Conversely, if this is set to OFF then those agents will not consider the 

amount of time they have spent waiting within the lift waiting area (i.e. they will use a lift 

irrespective of the time it takes for the lift to arrive). 

 

Even Stair Redirection (Default-OFF) 

For agents that choose to redirect to the stairs after initially choosing to use a lift, this defines 

whether they will evenly use the stairs on their current floor. If this is set to ON then agents that 

redirect to the stairs from the lift will randomly select a stair to use on their current floor. Of 

the agents that do this, approximately an even number will use each of the available stairs. If 

this is set to OFF then agents will follow the potential map to the nearest exit (typically this 

will involve choosing to use the nearest stair). This assumes that the stairs on the current floor 

link to the exit floor and the potential map will guide agents to use the staircase down to the 

exit floor. This may lead to uneven usage of stairs with some stairs becoming disproportionally 

used if the potential of the path to the exit is not equal to the exit paths via other staircases. 

 

NOTE: 

If dog legged stairs are used then any landings must be defined as landing nodes for the even 

stair redirection behaviour to function correctly. 

 

(iii) Non-Lift Section 

Evenly Use Stairs (Default-OFF) 

For agents that choose to use the stairs instead of the lift at the beginning of a simulation, this 

defines whether they will evenly use the stairs on their current floor.  It is important to note that 

this requires stairs to be defined as Stair transit nodes as opposed to the now deprecated method 

of Stair nodes, see Appendix E). If this is set to ON then agents that choose to use the stairs 

instead of the lift will randomly select a stair. Of the agents that do this, approximately an even 

number should use each of the available stairs. If this is set to OFF then agents will follow the 
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potential map to the nearest exit (typically this will involve choosing to use the nearest stair). 

This may lead to uneven usage of stairs with some stairs becoming disproportionally used. 

 

6.6.4.6 Dialogue Buttons 

 

(i) Default 

Clicking this button will remove any changes made to the Rulebase via the Behaviour Control 

dialogue box and will return the attributes to their initial state.  

 

(ii) OK 

Clicking the OK button accepts the changes made to the Behaviour Control dialogue box and 

stores the changes for use in subsequent simulations. 

 

(iii) Cancel 

Clicking CANCEL ignores the changes made by the user to the Behaviour Control dialogue box 

and discards them so that they have no further impact upon any simulation.  

 

6.6.5 Option Libraries 

Shortcut: [RuleBase/Option Libraries]  
Because of the wide range of behavioural and scenario options available to the user, setting the 

simulation and behavioural options for a scenario may be time consuming.  In an effort to assist 

the user in setting options, the Option Library system has been developed.  This consists of a 

collection of pre-defined libraries of settings that specify the nature of the behavioural and 

environmental models implemented for various types of typical application (Table 6-8).  The 

specified settings cover four main types of simulation, Circulation, Default, Drill and 

Evacuation. 

 

NOTE: 

The option settings defined in the Option Library should only be used as a guide to the setting 

of simulation and behavioural options.  The Options Library is not intended to be a definitive 

description of the settings necessary in order to undertake a particular type of simulation. This 

is especially the case when using the pre-defined evacuation procedures, where great care 

should be exercised in the interaction between the two groups of behaviours. 

 

The setting libraries are intended to provide a useful starting point from which the user can 

refine the settings to best suit the intended application.  The Options Library includes settings 

for:  

(1) Evacuation: Used when attempting to represent an actual evacuation involving the 

existence of a fire hazard and a heightened state of evacuee motivation to evacuate. 

(2) Drill: Used when attempting to represent a controlled evacuation or experimental situation 

where volunteers are under instruction and there is no perceived risk.  

(3) Circulation: Used when attempting to represent normal circulation throughout a structure. 

No emergency is perceived and no hazard exists. 

(4) Default: Returns the model to its initial state, removing the majority of the behavioural 

options. 
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Table 6-8: Pre-defined Library Settings. 

 Evacuation Drill Circulation Default 

Route tab 

Local Familiarity X  X  

All Main Exits     

Floor Potential Map     

Local Potential  X X X 

Maintain Target Exit  X X  

Maintain Itinerary  X X  

Transit Node Grouping X X X X 

Behaviour tab 

Milling   X  

Specified Response  X   

Zone Events     

Natural Movement   X  

Extreme Behaviour X    

Impatient     

Seat Jumping X    

Wall Proximity   X  

Avoid Congestion     

Social Response   X  

Social Movement     

Stair Packing X    

Stair Edge Pref.    X 

Environment tab 

Crawling X X X X 

Smoke Stagger X    

Redirection     

Gender Influence X    

Signage tab 

Signage Visibility     

Lifts tab 

Lift Evacuation     

Hazard Options 

Hazard Model X    

 

NOTE: 

When the Hazard model is enabled, in the Evacuation library, all of the other options in the 

Hazard Control dialogue box are set to default position. This is considered appropriate for the 

modelling of evacuation behaviour. If the user wishes to alter these options they will be stored 

in an identical fashion to the other options highlighted above. 

 

These have been designed to represent five separate scenarios: the evacuation scenario, the drill 

scenario, the circulation scenario, default model starting position and user defined. These 

libraries are only suggestions concerning model settings.  The user may wish to use the settings 

as a starting point from which they can modify the settings to better suit their application.  The 

user may also wish to save the new settings as a new library option.  To select an Option Library 

setting, go to the RuleBase menu and select Option Libraries.  The pull down menu offers five 
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options (see Figure 6-39(a)). If one of these is selected by a left mouse click, a brief description 

of the rationale for the settings is displayed in the text window (see Figure 6-39(b)). If the OK 

button is selected the options are implemented, while if the CANCEL button is selected the 

behavioural and hazard options remain unaltered.  

 

  
(a) (b) 

Figure 6-39: (a) The OPTIONS LIBRARY dialogue box. (b) Example description of 

library selection 

 

The second option open to the user, is either to modify an existing library or to create an entirely 

new settings option for future use. These user-defined libraries can be created by the user 

initially selecting the desired options, as if preparing to run a simulation. Once the desired 

options have been selected, the user should select the Option Libraries option from the 

RuleBase menu. Once selected, the Options Library dialogue box is generated, with the User-

Defined option automatically selected. This is because the model has detected that changes have 

been made to the options set-up and that these changes may require saving.  A brief description 

of the rationale behind the settings can be made in the text window by left clicking the mouse 

over the window.  Users are strongly recommended to prepare such a description if new Options 

Library entries are too be made.  To store the options settings, the user must select the SAVE 

button and the file saving dialogue box is displayed, where the library is stored in an .ESO file. 

 

To load an existing user-defined .ESO file, simply click the LOAD button on the Options 

Library dialogue box and select the appropriate library. The model options will then 

automatically alter according to the instructions in the library selected. 

 

The Options Library system and their re-use should significantly reduce the amount of time the 

user spends engineering a simulation.  

 

In addition to all of the Behavioural Options selected, the nature of the procedure implemented 

within the simulations is included within the ESO file. This then allows the user to create the 

procedures in some detail and then run the simulations in Batch Mode. 

 

6.6.6 Itinerary Summary 

Shortcut: [RuleBase/Itinerary Summary] 
The Itinerary Summary function enables the user to display within the Data Window Output 

tab the complete list of tasks each occupant is required to undertake as defined within their 

corresponding Person Itinerary List (see Figure 6-40). The format of the Itinerary Summary is 

identical to the itinerary data generated within the simulation file (.SIM) and similarly echoed 

to the Data Window Output tab upon completion of a simulation (see Section 6.8.2). While the 

itinerary data within the simulation file is however only generated upon completion of a 
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simulation, thereby summarising each individuals entire task performance, in contrast the 

Itinerary Summary can be generated by the user at any time before, during or after a simulation. 

The Itinerary Summary therefore enables the user to view which tasks have been completed or 

failed and which tasks are yet to be undertaken by each individual at any given time. The 

Itinerary Summary lists each individuals Name and their complete task list, stating the nodal 

location of each task, its corresponding completion or failure (i.e. arrived or failed), the actual 

delay incurred by the individual in undertaking the task (if appropriate) and the range of delay 

times (i.e. minimum and maximum) as defined by the user. 

 

 
Figure 6-40: A Typical Itinerary Summary as displayed within the Data Window Output 

tab. 

 

6.7 Executing a Simulation 

There are three methods by which a simulation may be executed, Interactive, Batch Mode and 

Movie.  These methods allow varying degrees of user-interaction and control of the simulation.  

The primary method, termed Interactive, allows a simulation to be viewed as it is being 

executed (see Section 6.7.1).  This also allows the user to interact with the software, for 

example, objects such as doors may be interrogated and the simulation parameters may be 

modified.  Furthermore, a simulation just executed in this manner, may be replayed for further 

analysis (see Section 6.7.3) or saved to disk for later use (see Section 6.7.3). 

 

The second method of executing a simulation is Batch Mode.  This allows simulations to be 

conducted without any user interaction, and is most suited to performing large numbers of 

repeat simulations (see Section 6.7.2).  Using this method, the graphics of the simulation need 

not be viewed for increased speed of calculation.  

 

The third method of executing a simulation uses the Movie-Replay Facility.  In both Interactive 

and Batch Modes, it is possible to “record” a simulation, i.e. save it to disk, and replay it at a 

later time using either the Movie-Replay Facility (see Section 6.7.3) or the EXODUS Movie 

Player (see Appendix C). 

 

Each of the three methods will now be discussed. 

 

6.7.1 Interactively Running and Replaying A Simulation 

Shortcut: [Simulation/Play/Continue]  
To execute a simulation, select Simulation from the menu bar and the Play/Continue item from 

the pull-down menu (see Figure 6-2). Alternatively, press the PLAY button on the toolbar (see 

Figure 6-1).  Once a simulation is initiated, the individuals will attempt to evacuate.  As the 

evacuation is in progress, each individual can be seen to move until he is either incapacitated 

(due to fire hazards) or escapes.  Whilst in progress, a simulation may be controlled using the 

following functions: 
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1. Shortcut: [Simulation/Pause]  
Pause - This control allows the simulation to be suspended at the current point.  This is 

especially useful when highly detailed analysis of a simulation is required.  To pause a 

simulation, select Simulation from the menu bar and the Pause item from the pull-down 

menu (see Figure 6-2). Alternatively, press the PAUSE button on the toolbar (see Figure 

6-1).  To continue the simulation, select Simulation from the menu bar and the 

Play/Continue item from the pull-down menu (see Figure 6-2). Alternatively, press the 

PLAY button on the toolbar (see Figure 6-1). 

 

2. Shortcut: [Simulation/Step]  
Step - This control allows the simulation to complete one cycle, this is equivalent to 1/6 of 

a second in simulation time.  The step function will only work when the simulation has been 

paused.  The step function is equivalent to rapidly pressing the PAUSE, PLAY and PAUSE 

buttons.  This function is especially useful when highly detailed analysis of a simulation is 

required.  To step through a simulation, first pause the simulation, (described above), and 

then press the STEP button on the toolbar (see Figure 6-1). To continually step through the 

simulation, the STEP button should be kept in the depressed position. This will then move 

through the simulation continually, although still at a reduced rate, allowing the user to 

examine the simulation in detail. 

 

3. Shortcut: [Simulation/Replay]  
Replay - This control allows the simulation to be exactly replayed to the current point in 

the simulation. Due to the inherent randomness built into some decision rules, it is not 

possible to exactly repeat a buildingEXODUS simulation by simply resetting and restarting 

the simulation. However, by using the replay function, an exact copy of the previous 

simulation can be replayed. A simulation is replayed to the current position of the 

simulation, thus a simulation must be finished to replay the entire simulation.  To replay a 

simulation, first either allow the simulation finish (to replay the entire simulation) or pause 

the simulation.  Then select Simulation from the menu bar and the Replay item from the 

pull-down menu (see Figure 6-2). Alternatively, press the REPLAY button on the toolbar 

(see Figure 6-1). 

 

4. Shortcut: [Simulation/Reset]  
Reset - This control resets a simulation as if simulation mode had just been entered.  The 

reset function may be accessed at any point to cancel the simulation.  To re-enter any of the 

other modes of operation (e.g. scenario mode) the current simulation must be reset.  When 

a simulation is reset, all individuals are moved back to their original locations.  To reset a 

simulation, select Simulation from the menu bar and the Reset item from the pull-down 

menu (see Figure 6-2). Alternatively, press the RESET button on the toolbar (see Figure 

6-1). 
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6.7.2 Batch Mode Processing 

Shortcut: [Geometry/Tools/Batch] 
The Batch Mode processing capability in buildingEXODUS allows a number of simulations to 

be performed without any user interaction.  This facility is most useful whenever a large number 

of simulations must be executed, for example when performing a sensitivity analysis.  The only 

user interaction required to operate this facility is to identify the cases to be run, the number of 

runs and the various options for each run.   

 

NOTE: 

The cases to be executed in Batch Mode must be set-up prior to entering Batch Mode. 

 

Another advantage of Batch Mode processing is speed.  By default, the batch mode does not 

display any graphics, and is therefore quicker than running the simulation interactively.  

Chapter 1 gives some examples of the increase in speed when using this method. 

 

TIP: 

Batch Mode processing may be a means by which a reduction in the runtime of very large cases 

can be achieved. 

 

To access the BATCH MODE dialogue box, a “clean” session of buildingEXODUS must be 

started (i.e. no geometry). This is either available immediately the model has been started or 

after a new case has been selected (the New option from the File menu in GEOMETRY mode).  

In this state, to access the Batch Mode dialogue box, select Tools from the menu bar and the 

Batch item from the pull-down menu. Figure6-41 depicts the BATCH MODE dialogue box. 

 

 
Figure6-41: The Batch Mode dialogue box  
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The dialogue box is utilised by placing commands and options into the command area by using 

the command buttons and the option library selection.  Once the list of commands is complete, 

clicking the EXEC (execute) button will then start the Batch. 

 

NOTE: 

If the user wishes to implement user-defined option libraries during Batch Mode operation, 

then they must be created prior to their inclusion in any Batch Mode process.  

 

The following list outlines the areas in the dialogue box highlighted in Figure6-41. 

 

1. Command Area: This area displays all the commands issued by the user for the job to 

follow.  Note that this area is directly accessible by the user, but only by using the 

controls in the dialogue box. 

 

2. Command Buttons: These are the principle commands that may be issued by the user.  

Table 6-9 lists the available commands with a brief explanation of each one.  Each time 

one of the command buttons is clicked, it appears in the Command Area. 

 

Table 6-9: List of commands available in the batch mode dialogue box 

Command Purpose 

Load Geometry Loads a geometry 

Load Population Loads a population into a geometry 

Delete Population Removes a population from a geometry 

Rand. Pop Randomises the locations of the population 

Rand. Seat Randomises the locations of the seated population. 

Swap Loc. 

Randomly swaps each person’s starting location with that of 

another member of the population whilst maintaining the 

overall starting locations of the population. 

Swap Seats 

Randomly swaps each seated persons starting location with that 

of another member of the seated population whilst maintaining 

the overall starting locations of the population. 

Run Executes a simulation once 

Run X Times 
Executes a simulation X times (user prompted to enter the 

number of times) 

Data Output 

Options 
Controls the output generated to the simulation files. 

Tracer Output 

Options 
Loads a previously saved tracer option file. 

IO Location 

Allows the user to specify the location  (i.e. drive and folder) of 

the generated output or input files. This only effects the batch 

commands which follow this statement. 

 

3. Option Libraries: Option Libraries allow the user to control the behavioural and 

environmental conditions activated during the simulations. This is performed in the 

same manner as if the options were accessed during SIMULATION mode from the 

RuleBase menu (see Section 6.6.5). The user is able to load in one of the option libraries 

that are provided (Circulation, Default, Drill or Evacuation) or define one of their own. 

As noted previously, this will have to be done prior to starting the batch mode process. 

 

4. Cursor: The cursor represents the point at which the commands are entered into the 

command list.  By default this is at the bottom of the list, but may be moved using the 

Cursor Controls. 
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5. Cursor Controls: The cursor controls allow the cursor to be moved up and down the 

list and the current item to be deleted.  This allows the list to be modified/corrected at 

any point. 

 

6. Halt on Error: If this option is selected, the batch mode process will halt if an error 

occurs with the simulation, otherwise it will attempt to continue to process.  It is 

recommended that this option be selected at all times.  

 

7. Display Option: By default, the batch process does not display the graphics as this 

greatly reduces the time taken to perform a simulation.  However, if this option is 

selected, the graphics are displayed.  Note that this option may be selected/de-selected 

at will whilst the batch process is in progress (although the response may be a little 

slow). 

 

8. Movie-Replay File Option: If the Movie-Replay File Option is selected, a Movie-

Replay File is produced for each completed simulation.  This is useful, as runs requiring 

further inspection may be investigated. It should be noted that Movie-Replay Files can 

be large in size and may slow the batch process down.  

 

9. Abort: At any point during the batch process, clicking the ABORT button will halt the 

batch process. 

 

10. Dialogue Controls: The Dialogue Controls are the main control buttons for the batch 

process.  Table 6-10 lists the controls available and their purpose. 

 

Table 6-10: List of dialogue controls for the batch mode dialogue box 

Command Purpose 

Save Saves the list of commands for future use (saves as a “.EBF” file) 

Load Loads a previously saved command list 

Cancel Closes the batch mode dialogue box and returns to buildingEXODUS 

Exec Executes the list of commands 

 

11. Full Path Option: When this option is enabled buildingEXODUS inserts the full path 

name of any file to be loaded. This option is useful when loading files which do not all 

reside in the same folder. 

 

NOTE: 

When performing batch-mode simulations, an indication of the progress of the current 

simulation is shown with a "% done" indicator next to the Abort button. 

 

6.7.3 Replaying Movie-Replay Files And Movie Files In Simulation Mode 

To view either a Movie-Replay (.RUX) File or a Movie (.EMX) File, the geometry used to 

generate the file must first be loaded.  If the geometry corresponding to the Movie-

Replay/Movie File is not loaded, the results are meaningless. 

 

When the geometry has loaded, put buildingEXODUS into SIMULATION mode.  To load a 

Run/Movie File for the geometry, select Simulation from the menu bar, the Replay File option 

and the Load item from the pull-down menu (see Figure 6-2). This process is described in more 

detail in Section 6.4.6.3. 
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6.8 Simulation Output 

There are many ways to examine the output from a buildingEXODUS simulation.  In broad 

terms, these may be categorised into three areas: Graphical, Text-based and Object 

interrogation. Graphical output refers essentially to the graphics displayed in the 

buildingEXODUS application, such as the individual’s movement and the graphs (see Section 

6.8.1).  Text-based output may be produced from either interactive or batch mode simulations 

and allow a more thorough analysis of overall simulation results in a third-party package, such 

as Microsoft EXCEL (see Section 6.8.2 and the Application Manual, Chapter 6).  Finally, object 

interrogation allows the user to directly examine the attributes of the buildingEXODUS objects 

(individuals, doors etc.) whilst the simulation is running.  This allows a highly detailed analysis 

of localised events (see Section 6.8.3). Finally, when analysing results from multiple 

simulations the analysis can be difficult and time consuming.  To aid in this process a set of 

tools have been provided.  These tools are referred to as askEXODUS.  A description of 

askEXODUS can be found in the Application Manual, Chapter 7 and within the askEXODUS 

User Guide. 

 

6.8.1 Graphical Output 

Within the buildingEXODUS application, there are several windows that contain information 

that may be regarded as output, the geometry window(s), the Exit Lists sub-window, the Graph 

window(s) and the Output window (Figure6-42).  The Geometry and Graph windows may be 

manipulated as any other window in the Windows environment, e.g. minimised, maximised, 

etc. and each is accessible either from its icon or the Window menu.  Each of the window types 

will be explained in more detail. Depending on the options selected the user may also have 

access to the Navigation window which will appear along the left-hand edge of the screen and 

will allow the user to move between objects within the geometry relatively easily. 
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Figure6-42: buildingEXODUS in Simulation Mode 

 

1. Geometry Window: This window contains the enclosure under investigation.  In multi-

storey buildings, one geometry window may be used per floor, i.e. several geometry 

windows. In this (these) window(s), the individual movement through the enclosure may be 

viewed.  The Geometry window(s) also contains all of the exits, etc. that may be interrogated 

(see Section 6.8.3). 

 

2. Exit List: The Exit List appears underneath the primary (first) Geometry window.   It lists 

all the exits used during the simulation, and all the individuals evacuating via each exit.  As 

the individuals successfully evacuate, their icons appear next to the previous person using 

the same exit.  In a similar manner, all individuals incapacitated, line up against the 

mortuary icon.  All the icons in the exit sub-window (exits and individuals) may be 

interrogated as normal (see Section 6.8.3). 

 

3. Graph Window: As each exit in a simulation is used for the first time, a new graph window 

for the exit is constructed.  As well as these individual exit graphs, there is also the Main 

Graph, which is essentially the sum of all the individual graphs.  All the graphs by default 

show the total number of individuals out over time.  For the individual exit graphs, this 
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represents only the evacuees passing through each exit, whereas the main graph represents 

the evacuees through all the exits. 

 

The two types of graphs may be easily distinguished.  The individual exit graphs are 

displayed as connected data points, each data point representing an evacuee using the exit 

(see Figure6-43(a)), whereas the main graph is displayed as a solid line through each point 

(see Figure6-43(b)).  Furthermore, when a simulation is reset, the individual exit graphs are 

wiped clean in preparation for the next simulation.  In contrast, the main graph shows the 

curves for the five most recent simulations and annotates the run number with a colour and 

number, (see Figure6-43(b)), e.g. first run is red and labelled 1, etc.  To clear the main 

graph, first select the Clear option within the Edit menu, and then select the Main Graph 

option from within the Clear submenu. This can only be selected after a simulation has been 

reset. 

 

  
(a) (b) 

Figure6-43: Graph windows in buildingEXODUS, (a) the individual exit graph and (b) 

the main graph 

 

The final graph that is produced by buildingEXODUS is called “All Exits”.  This works in 

precisely the same manner as the individual exit graphs, but is a sum of all the exits used, 

as in the main graph. 

 

All the graphs discussed in this section have referred to cumulative exit graphs, i.e. the 

number of evacuees out over time.  Each of these graphs may also be modified to display a 

flow-rate graph, i.e. the number of people out over a specified time period, measured in 

evacuees per second.  This type of graph allows an easier interpretation of when an exit is 

not performing at optimal capacity.  To change one of the graphs to a flow-rate display, first 

select the graph window.  The menu bar will now change to show two options, STATUS and 

WINDOW.  Select Timespan from the Status menu to change the selected graph to a flow-

rate display.  To modify the period of time over which the flow-rate is measured, select the 

Set Timespan item from the Status menu.  The default time period to measure the flow-rate 

is 5.0 seconds. In addition to the graphs demonstrating data relating to the usage of External 

exits, graphs will also be generated relating to each Internal Exit, Census Region, Census 

Line and Compartment Zone.  These will be identical to those representing External exits. 

These may be accessed in a number of ways: by right clicking on the External Exit, Internal 

Exit, Census Line or Census Region, via the Navigation window or from the Window menu.  

 

4. Output Window: All ASCII output from buildingEXODUS appears in the Output sub-

window at the end of each simulation, underneath the Geometry window.  The user may 
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also be prompted to save the data as a simulation file for later use (see Section 6.8.2).  The 

data given in the output window is configured in the DATA OUTPUT CONTROL dialogue 

box (see Section 6.6.1).   Section 6.8.2 discusses buildingEXODUS ASCII output in more 

detail.  It should be noted that all of the data in an output window can be copied onto the 

Windows clipboard using the standard Windows copy function. The data within the Output 

window can also be cleared by the user. To clear the Output window, first select the Clear 

option within the Edit menu, and then select the Data Window option from within the Clear 

submenu. 

 

6.8.2 buildingEXODUS ASCII Output 

All the ASCII output from buildingEXODUS is directed to the Output window.  It is possible 

to save all the information appearing in the Output Window in a Simulation File (.SIM).  The 

option to Generate and Save the ASCII output in this manner is given in the DATA OUTPUT 

CONTROL dialogue box.   

 

The Simulation File consists of a number of sections, the header information, input parameter 

summaries, individual evacuee results, exit performance summary, Attractor node/ Internal 

Exit / Census Region / Transit Node / Census Line summary, and finally, graph data.  Each of 

these areas will be discussed in turn. 

 

1) Header information: the header information displays the licence and run time information. 

This includes information related to the geometry (i.e. *.exo) file run, the number of people 

within the simulation, the time/date the simulation was started, the time the simulation took 

to run, the simulation seed used to generate the results, the version of the buildingEXODUS 

software used to run the simulation, the software level, the licence number and the current 

expiry date of the dongle used to run buildingEXODUS. An example of this can be found 

below: 

 

 
 

2) Input Parameter Summaries: by using the DATA OUTPUT CONTROL dialogue box (see 

Section 6.6.1), it is possible to configure the output to summarise the INPUT PARAMETERS 

for the simulation.  This is particularly useful when executing many simulations where it is 

difficult to keep track of the varying input and the behavioural and environmental options 

selected.  There are four summaries that are available, as described in Section 6.6.1. The 

example output shown below details the Hazard, Fire Scenario, Population and 

Behavioural summaries. 
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NOTE: 

The Fire Scenario summary includes details concerning the use of imported data files (i.e. 

CFAST/SMARTFIRE) and their location. 

 

 
HAZARD OPTIONS 

 
FIRE SCENARIO DETAILS 

 
POPULATION PARAMETERS 

 

 
BEHAVIOURAL OPTIONS 
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3) Individual Occupant Results: each evacuee is listed in the order of evacuation (defined 

by the Pos attribute.  In the example below, a limited number of attributes are displayed for 

the 10 evacuees in the simulation.  It can be seen that the Personal Elapse Time (PET) of 

the first and last evacuees out corresponds with those values in the header file. 

 

 
 

Numerous other attributes may be displayed. These are determined via the DATA OUTPUT 

OPTIONS dialogue box (see Section 6.6.1(e)). 

 

4) Exit performance: in this section each exit is listed with performance data, detailing the 

number of occupants out, the times for the first and last occupants out, and the unit flow 

rate.  Two measures of evacuation efficiency are also given, called OPS (Optimal 

Performance Statistic) and MNS (Mean Non-flow Statistic).   In addition, the total No Flow 

Time is provided. 

 

OPS is measured from 0.0 to 1.0, lower values indicating more efficient evacuation.  OPS is 

defined by the equation : 

     

 

𝑂𝑃𝑆 =  
∑ 𝑇𝐸𝑇−𝐸𝐸𝑇𝑖

𝑛
𝑖=1

(𝑛−1)∗𝑇𝐸𝑇
                                      (1) 

 

Where, 

 n = number of exits used in evacuation 

 EETn = Exit Evacuation Time (time last person out) of Exit n (seconds) 

 TET = Total Evacuation Time (seconds) = max[EET] 

 

An OPS value of 0 signifies a well-balanced evacuation, i.e. all exits completing at the same 

time, while an OPS value of 1 indicates a poor evacuation with at least one exit not attracting 

any occupants. 

 

In the example below, the OPS value for the simulation was 0.187, generally values <0.1 are 

considered efficient, thus this simulation would be considered somewhat less than efficient.  As 

the size and complexity of a geometry (and also potentially the population size) increases, it 

becomes increasingly difficult to minimise the OPS value. 
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Door performances :- 
 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
 

 Exit_3    Number Out:    4  First exit:   3.14 (s) Last :  30.91 (s) Avg PPM :   1.27 

 Flow Time:   27.77 (s) No Flow Time:   2.77 (s) MNS :   1.00 (%) 
 Unit Flow Rate (occ/m/s):   1.20   1.40  

 

 Exit_2    Number Out:    1  First exit:  23.28 (s) Last :  23.28 (s) Avg PPM :   1.27 
 Flow Time:   27.77 (s) No Flow Time:   2.77 (s) MNS :   1.00 (%) 

 Unit Flow Rate (occ/m/s):   1.33   1.33  

 
 Exit_1    Number Out:    5  First exit:   7.95 (s) Last :  27.68 (s) Avg PPM :   1.27 

 Flow Time:   27.77 (s) No Flow Time:   2.77 (s) MNS :   1.00 (%) 

 Unit Flow Rate (occ/m/s):   1.33   1.33  
 

 

OPS = 0.187 

 

NOTE: 

The OPS facility only includes data concerning exits that have at least one occupant passing 

through it during the simulation. In simulations where an exit (or exits) has been entirely 

ignored by the occupants, those exits are not included in the OPS calculation.  In such 

situations, the evacuation may be considered to be inefficient from an exit usage view point, 

however the OPS measure will not reflect this.  

 

While the OPS is a useful measure of optimal performance it only provides performance 

information at one point in time, i.e. at the end of the evacuation.  As such, OPS provides no 

insight into how the evacuation has progressed. To overcome this deficiency another measure 

has been developed to complement OPS, which is known as the Mean Non-flow Statistic or 

MNS. The MNS has been designed to take account of exit performance over the course of the 

evacuation.  The MNS provides a measure of the amount of time that each exit is not in use 

during an evacuation, i.e. when there is no person negotiating the exit.  The MNS may be 

determined for each exit or averaged over all the exits and used as a measure of overall 

evacuation efficiency.  

 

The formulation of the MNS for an exit is as follows: 

 

 

𝑀𝑁𝑆𝑖  =  𝑇𝑁𝐹𝑖 𝑇𝐹𝑇𝑖⁄                                        (2) 
 

 

Where,  

MNSi = Mean non-flow time for exit “i”, 

 

TNFi = total time (seconds) exit “i” is in non-flow conditions, i.e. where no person is              

negotiating the exit,  

 

TFTi = Total Flow Time of exit “i” (seconds) given by EETi - EFTi  

i.e. time last person leaves exit “i” – time first person leaves exit “i”. 

 

The TNFi requires an estimation of the end time of occupant n (i.e. time to leave exit) and the 

start time of occupant n+1 (i.e. time to enter exit). The TNFi for exit i is the total time during a 

simulation in which the External exit node is completely unoccupied.  All of the time periods 

in which the exit is unoccupied are then added to eventually produce the Total Non-Flow Time 
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for a particular exit. If a queue continually exists at an exit throughout the simulation, the non-

flow time for the duration of the queue passage is zero.  

 

For an exit to be deemed that it is not in use (unoccupied) the period of time between occupant 

arrivals must be greater than the maximum delay caused be by the flow attributed to the door 

plus the maximum conflict delay that an occupant could experience for the simulation. This 

prevents the exit recording an unused exit where an occupant is delayed due to congestion 

around the exit. 

 

The MNS is then converted into a percentage by multiplying the current MNS figure by 100.  

In addition to the MNS, the TNF is also presented in the output as the No Flow Time (seconds).  

As can be seen in the example above, the MNS and TNF is presented for each exit.  

 

The formulation of the MNS for a building is as follows: 

 

 

𝑀𝑁𝑆 =  
∑ 𝑀𝑁𝑆𝑖

𝑛
𝑖=1

𝑛
                                      (3) 

 

 

where, 

MNS is the mean non-flow time for the building, 

n is the number of active exits during the evacuation. 

 

The advantage of the MNS is that it better targets potential problem areas encountered during 

an evacuation.  

 

The MNS must be less than 100%. An evacuation in which MNS = 0 indicates that all the exits 

achieved a continuous throughput throughout the evacuation without a breakdown in flow. This 

can only be achieved with an optimal (or perfect) distribution and behaviour of occupants. 

 

An evacuation in which MNS is large indicates that there was a poor distribution of occupants 

between the available exits. A MNS of 10.0 suggests that on average the exits were not in use 

for 10% of the achieved flow time. 

 

A MNS value greater than zero is sub-optimal indicating that the evacuation time can be 

improved by achieving a better distribution of occupants between the exits and/or a better flow 

of occupants to the exit. 
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Figure 6-44: Implications of the OPS and MNS figures generated for a simulation. 

 

While it is unlikely that a structure will achieve a MNS = 0, near optimal performance will be 

marked by very low values of MNS. Selecting an acceptable value for MNS is somewhat 

arbitrary. For the purposes of this report we will consider MNS values less than or equal to 

10.0% are considered as being optimal. 

 

An ideal evacuation would have OPS = 0.0 and MNS = 0.0. It is however possible to find cases 

in which OPS is in the optimal range while MNS is large.  This would suggest that while the 

exits were balanced in the final stages of the evacuation, during the evacuation, an exit or exits 

where not being used efficiently. This would suggest that changes in procedural design, exit 

location or occupant familiarity could be implemented to improve the evacuation performance 

(see Figure 6-44). 

 

5) Attractor Node Data: For each Attractor node in the geometry, a summary of the 

parameters defining the node is produced.  In the example shown below, two attractor nodes 

labelled as 107 and 108 can be seen.  In both cases, the UFR on these nodes represent a 

free-flow condition (very high UFR) through 0.5m of exit each (i.e. 1m in total).  Finally, 

the potential is set at 100 for both nodes. 

 
Attractors :- 
 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

 
 Label:  107 UFR Min 999.00 Max 999.00 Width 0.50 Potential 100.00 

 Label:  108 UFR Min 999.00 Max 999.00 Width 0.50 Potential 100.00 
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6) Internal Exits and Census Points: For each Internal Exit or Census Region in the 

geometry, a summary of the parameters defining the node is produced. In the example below 

the Internal Exit labelled InDoor_1 can be seen. In this case, the HMSO flow rate has been 

applied (i.e. 1.33 occ/m/s). The potential has not been adjusted. Two Census Regions have 

been created providing information concerning the times, the number of evacuees and flow 

rates at the specific place. 

 

 
 

7) Transit Nodes: Once the simulation has been completed data is generated describing the 

performance of the transit nodes. This data is echoed to the simulation file (*.sim) associated 

with that particular run, as well as to the screen. This data relates to the capacity of the 

Transit Node, its dimensions (i.e. length and width etc.), number of lanes, the number of 

people that traversed the Transit Node, the time of the first and last arrival, the average flow 

rate (in persons per minute) number of people that used it and  the time that the transit node 

was in use once it had started being used,  
Transit Nodes performances :- 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

Stair:  Staircase_1     MaxCapacity  6  Length 1.61 (m) Width 0.70 (m) Lanes  1  

 Number Through:   30  First On:   6.86 (s) Last On:  56.78 (s) Avg PPM :  36.06 Flow Time:  

49.92 (s) 

Stair:  Staircase_2     MaxCapacity  6  Length 1.61 (m) Width 0.70 (m) Lanes  1  

 Number Through:   30  First On:   3.39 (s) Last On:  52.71 (s) Avg PPM :  36.49 Flow Time:  

49.32 (s) 

End of Transit Nodes data 

 

8) Census Lines : For each Census Line in the geometry, a summary of the parameters 

defining the node is produced. In the example below a Census Line has been created 

providing information concerning the times, the number of evacuees, the nature of the 

parameters associated with the Census Line and flow rates at the specific place. 

 
 

9) Local familiarity and Itinerary details: The Occupant Exit Knowledge for each 

individual (i.e. the exits with which each person is familiar) can be detailed. These will only 

have an impact upon the simulation if the Local Familiarity system is used. Also, each of 

the tasks that the occupant is expected to complete (held within the Occupant Itinerary List) 

are listed, with the potential delay and the actual delay experienced. If the occupant is not 

able to complete their tasks, then those tasks ignored will be flagged as ‘failed’. The evacuee 

Familiarity (OEK) and Itinerary Lists are displayed in a separate list. The identity of the 

evacuees can be cross-referenced using the Pos number. This represents the order in which 

the evacuees evacuated. This coincides with the Pos number associated with the list of other 

evacuee attributes. The Fam. attribute is proceeded by the Title attribute of the exits with 

which the evacuee is familiar. The OIL attribute is proceeded by the title of the nodal 
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locations in the evacuee's itinerary list and the associated delay times.  The delay represents 

the actual delay incurred while the delay R represents the range of possible (i.e. minimum 

and maximum) delay times at that location. 

 

 
Occupant Familiarity and Itineraries 

10) Congestion data: Once a simulation has been completed data is generated describing each 

significant area of congestion experienced within the building. Significant congestion is 

defined as any area whose population densities continuously exceed 4 people/m2 for longer 

than 10% of the overall simulation time. This data is echoed to the simulation file (*.sim) 

associated with that particular run, as well as to the screen. For each significant area of 

congestion experienced data is produced detailing the floor on which the congestion 

occurred, its exact location within that floor in the form of X and Y co-ordinates and the 

duration of the longest continuous period of congestion at that location expressed both in 

seconds and as a percentage of the Total Evacuation Time (TET). It is important to note that 

this Congestion data will only be generated if the user has previously selected the Generate 

Data option within the Contour sub-menu prior to running the simulation (see Section 

6.5.3.7). Having identified an area of congestion within a given deck via its X and Y co-

ordinates users can then easily jump to the corresponding location within the building by 

utilising the Find Node XY function (see Chapter 3). An example of the data produced is 

shown below. 
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11) Signage data: In this section buildingEXODUS provides information regarding the 

performance of the signage system. The information is split in three sections 

 

a) General signage performance data such as number of people that used each sign, number 

of times the signage system was used, number of times occupants gave up and didn’t follow 

the signs. 

b) Signage statistics relevant to the whole simulation such as the number of people that used 

at least one sign, the average evacuation time of those who used or saw a sign. 

c) Signage statistics relevant to an individual’s experience such as the signs that each 

individual used.  

 

An example of the data produced is shown below. 

 

 
 

12) Lift data: In this section buildingEXODUS provides information regarding the lift system 

and associated agent interaction. An example of this can be seen in Figure 7-45. The 

information is split into two sections: 

 

a) Lift Performances section displays for each lift, the total number of agents that used the 

lift, total number of trips made, total travel distance, average travel distance per trip and 

the last out time (i.e. the time the last agent alighted the lift). 
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b) Lift Agent Interaction section displays each instance of when an agent interacted with a 

lift. The Lift field states the name of the lift that the agent interacted with. The 

Interaction field states how an agent interacted with a lift (LFT=Lift user, 

LCR=Redirect due to congestion, LWR=Redirect due to wait time, MLR= Redirect due 

to missing a lift). If an agent redirected to the stairs (i.e. LCR, LWR or MLR) then the 

details of their interaction are stored in the first lift in the transit node group e.g. Lift1. 

The Agent ID field defines the Label of the agent who interacted with the lift, while the 

Start Node field defines the Label of the node on which they started the simulation.  The 

Start Floor field defines what floor the agent initially started on. The Board Floor field 

defines what floor an agent boarded a lift (these maybe different for sky lobby cases). 

The Alight Floor field defines what floor an agent exited a lift. The Start field defines 

what time the agent entered into the lift waiting area. The End field defines what time 

the agent decided to leave the lift waiting area i.e. decided to board a lift or decided to 

redirect to the stairs (it does not represent the time that the agent actually boards the  

lift). The LWT field defines the Lift Wait Time and represents how long an agent has 

waited to use a lift (i.e. the End time minus the Start time). The LTT field defines the 

Lift Travel Time and indicates the total time in seconds that an agent spent travelling in 

the lift to their destination floor (i.e. Alight Floor). 

 

 
Figure 7-45: Example lift output 

 

13) Floor Path data: In this section buildingEXODUS provides information regarding the 

evacuation experiences of agents separated according to their starting floor.  Two separate 

tables are generated as part of this output, an example of which is presented below. 

 

The first table states for each floor both the total number of agents initially located on that 

floor, as well as the minimum, maximum and average PET’s and CWT’s of those agents.  In 

addition, for each floor a CWT Ratio is also provided, giving an indication of the proportion 

of the evacuation time that agents initially located on that floor spent waiting in congestion.  

In each case, the CWT Ratio for a given floor is calculated based on the floors corresponding 

Avg. PET and Avg. CWT (i.e. CWT Ratio = Avg. CWT/Avg. PET). 

 

The second table provides data on the experiences of agents separated according to their start 

floor.  The average amount of time agents initially located on a given floor spent on each of 

the floors within the structure is provided (i.e. T), as is the average wait time of those agents 
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(i.e. W) and the corresponding wait to time ratio (i.e. W/T).  Hence in the example shown 

below, agents originating from Floor_0 spent on average 64.19 seconds on Floor_0 itself, 

experiencing an average wait time of 38.37 seconds.  In contrast, these agents spent no time 

on Floor_1 (i.e. 0.0 seconds), and consequently also experienced no wait times on this floor.  

Similarly, agents initially located on Floor_1 spent on average 126.86 seconds on Floor_1 

and only 37.53 seconds on Floor_0.  These agents also experienced average wait times of 

102.62 seconds on Floor_1 and only 5.60 seconds on Floor_0. 

 

 
 

14) Graph data: Essentially, all of the graphs drawn automatically by buildingEXODUS (see 

Section 6.8.1) can output their data in ASCII format for use in third-party software, such as 

Microsoft EXCEL.  Two types of graph data are available as output, evacuation curve data 

and flow rate data.  The former simply lists the total number of evacuees which have 

evacuated and a continuous time axis, whereas the latter gives time periods and the number 

of successful evacuees in each period.  This data can be generated for External and Internal 

Exits, Census Regions, Census Lines and Compartment Zones. The External LSA data can 

be generated for the whole simulation and/or on a per External LSA basis. In the case of 

Compartment Zones, three types of graph can be generated, namely a graph of the Arrival 

of individuals within the zone - Per Zone (Arr.), a graph of the Departure of individuals 

from the zone - Per Zone (Dep.) and finally a graph of the number of individuals present 

within the zone - Per Zone (Pop.). In all cases, the graph data generated is particularly 

suitable for external spreadsheet software used for the production of graphs.  An example 

of each case is shown in Figure 6-46a and Figure 6-46b. 

 
Cumulative Simulation 
++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 

0.0 0 
0.5 0 

..... 

27.5 8 
28.0 9 

...... 

31.0 10 
 

Time Span Simulation 

++++++++++++++++++++++++++++++++++++++++++++++++++++++++++ 
0.0-3.0 0 

......... 

21.0-24.0 4 
......... 

30.0-33.0 1 
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(a) (b) 

Figure 6-46: Graphs produced from buildingEXODUS output data, (a) evacuation curve 

(b) flow rate graph 

 

All the data referred to above is only concerned with successful evacuees, i.e. it does not 

consider fatalities.  Fatalities can only be generated in level C of buildingEXODUS.  Data 

output in these situations is identical to that just described for successful evacuees, but labelled 

as Mortuary Results. 

 

TIP: 

Simply viewing the output data produced by buildingEXODUS may not explain certain 

evacuation dynamics.  It may often be necessary to interrogate individual evacuees and exits to 

explain certain results. Furthermore, following the evacuation interactively can often be very 

revealing in itself. 

 

If the output files are saved to disk, by default they are given the extension “.SIM”.  The output 

parameters specified by the user in the DATA OUTPUT OPTIONS dialogue box (see Section 

6.6.1, part a) are saved into a .INI file (by default called TABLE.INI), so a consistency between 

buildingEXODUS sessions is maintained.  When using Batch Mode, the parameters produced 

in the .SIM files, correspond to those in the.INI file. These options may be altered via the DATA 

OUTPUT OPTIONS dialogue box and will then take effect on any subsequent simulations. 

 

In both Batch Mode and SIMULATION Mode, the names of .SIM files are generated 

automatically according to the following convention: 

 

 filenameXYZ.sim 

 

where  filename = the filename of the geometry being run (max 132 characters) 

 XYZ = the simulation identifier  (AAA, AAB, AAC etc. - ZZZ) 

 

Thus, the same case may be run 17576 times i.e. 26*26*26 (AAA, AAB, AAC, etc. to ZZZ).  

When this limit is reached, the last simulation file, i.e. ZZZ file, will be overwritten. Thus, if 

more than 17576 repetitions of the same case are required, it is advised to save the case with a 

different name and run both. 
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6.8.3 Interrogating Objects 

During the simulation process, the attributes for many objects in buildingEXODUS may be 

changing, for example the distance travelled attribute for each evacuee increases.  At any point 

during a simulation, an object may be interrogated - i.e. the attributes for the object may be 

examined.  To interrogate any object, the object must be double-clicked.  After the object has 

been selected, the dialogue box for the object is presented which shows the current values of 

the attributes for the selected objects.  Often it is easier to pause the simulation (see Section 

6.7.1), and then interrogate the object, as the simulation may progress rapidly.  If the simulation 

is not paused, any displayed attributes are updated with every cycle of the software, i.e. they 

are dynamic.  For example, it is possible to see the distance travelled attribute increase for a 

selected evacuee throughout a simulation. 

 

The three main objects that the user may wish to interrogate are Exits, Nodes and Occupants. 

 

NOTE: 

Any object may be interrogated at any time.  The values of dynamic attributes are lost when a 

simulation is reset. 

 

1. Interrogating Exits  

To interrogate an external exit, double-click the required exit to produce the dialogue box 

shown in Figure6-47.  All the attributes displayed reflect the current state of the exit, for 

example in Figure6-47 the exit is open and active.  Other information may be displayed by 

clicking one of the buttons described below: 

 

 
Figure6-47: Exit dialogue box in SIMULATION MODE 

 

(a)  GASES Button - this button displays a dialogue box showing the current levels of fire 

hazards at the exit - see Figure6-48.  Note that this facility is only useful in software level C.  

 

(b)  TIMES Button (Exits only) - this button displays several items of information, as outlined 

in Figure6-49.  The Event Times fields display the list of opening and closing times defined 

by the user in Scenario mode (see Section 5.7.2), in the example shown in Figure6-49, the 

first event occurs at 10.0 seconds (in case illustrated the exit opens).  Note that neither of 

these fields are dynamic.  The other fields, No. Out, Time, First, Last and PPM are all 

dynamic.  The No. Out field displays the total number of evacuees using the exit point.  The 
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Time and Last fields display the time at which the last evacuee egressed successfully using 

the exit point, the First field displays the time at which the first evacuee used the exit point, 

and finally, the PPM field indicates the current flow rate in persons per minute. 

 

 

 

 

 

Figure6-48: GASES dialogue box  Figure6-49: EDIT DOOR TIMES 

dialogue box  

 

(c)  LOCATE Button - this button displays the starting locations of all the evacuees using an 

exit point by drawing an outline around the starting node.  A simple example is shown in 

Figure6-50.  If the Person Select option is switched on, double-clicking one of the starting 

locations whilst highlighted in this manner, retrieves the dialogue box for the evacuee 

starting at that location.  This allows the evacuees using an exit point to be easily traced and 

interrogated. 

 

(d)  LABEL Button - this button functions only in conjunction with the LOCATE button.  It 

places a number above the starting location of each evacuee, reflecting the order in which 

the evacuees escaped.  An example of this function is shown in Figure6-51.  In this case, the 

example from Figure6-50 is taken, but as the numbers displayed are quite small, a portion 

of the geometry has been zoomed in. 

 
 

Figure6-50: Example of Locate function Figure6-51: Example of Label function 

 

2. Interrogating Nodes 

To interrogate a node, the node must be double-clicked to produce the relevant dialogue box. 

Most of the attributes in the dialogue box are static, the only ones that may change are the 

Collapsed attribute and the Gases attribute.  The Collapsed attribute is only valid for Seat nodes 

and reflects the status of a seat, and hence may only change when travel over seat backs occurs.  

The GASES button produces the GASES dialogue box as shown in Figure6-48.  The values in 

this box simply display the values of any fire hazards that may be present on the node.  Note 

that the GASES button is only useful in software level C. 



Chapter 6 - Executing A Simulation 

© 2017 University of Greenwich 449 

 

3. Interrogating Occupants  

Shortcut: [Edit/Select/People Select]  
To interrogate an individual, the individual must be double-clicked.  If the Person Select option 

is NOT enabled, the dialogue box for the node occupied by the person is produced.  In this case, 

the PERSON button on the bottom of the dialogue box will produce the PERSON dialogue box. 

To directly produce the PERSON dialogue box when double-clicking, the Person Select option 

must be enabled.  To enable the Person Select option, first select Edit from the menu bar, the 

Select item from the pull-down menu and then the People Select option from within the Select 

submenu (see Figure 6-2). Alternatively, press the PERSON SELECT button on the toolbar (see 

Figure 6-1).  Three buttons are provided on the dialogue box to enable access to the dynamic 

attributes of the selected individual: 

 

(i.) ATTRIB - produces the Attributes dialogue box showing all the main attributes for the 

individual (see Figure 6-52(a)).  The dynamic attributes in this box are listed and 

explained in Table 6-11.  All the remaining attributes are static and defined in 

POPULATION mode. 

 

(ii.) GASES - produces the Gases dialogue box showing the current fire hazard values being 

experienced by the individual (see Figure 6-52a), and also displays the hazard effect 

attributes (see the Theory Manual). 

 

(iii.) PATH - highlights the path taken by the individual to their current point or to the exit 

used if the individual has escaped.  An example of this function is shown in Figure 6-53. 

 

 
(a) 

 

 
(b) 

Figure 6-52: Dialogue boxes for individuals, (a) from the ATTRIB button, (b) from 

the GASES button 

 

 
Figure 6-53: Example of the Path function 
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Table 6-11: Dynamic attributes for an individual available using ATTRIB button  

Note: * indicates only dynamic in level C 

Attribute Units Explanation 

Physical 

Mobility* - Reflects physical ability of individual  

T. Speed m/s Current Travel Speed (terrain dependant) 

Agility* - Reflects the ability of an individual to overcome obstacles 

Psychological 

Drive - 
Reflects the assertiveness of an individual, which is used as a 

basis for conflict resolution 

Patience s 

Reflects the amount of time an individual is prepared to wait 

before considering or attempting an alternative action (i.e. stop 

queuing)  

Response s Reflects the individuals pre-evacuation movement time 

Gene - 
Is used to define the group to which an individual is currently 

affiliated  

Experiential 

PET s Personal Elapsed Time - time spent in simulation to current time. 

Dist. Trav. m Distance travelled  from starting location 

Dist. Rem. m Remaining distance to nearest Target/exit 

Wait s Current time spent waiting  

CWT s Cumulative Waiting Time  

Stance* - Either Crawling or Standing 

Hazard Effect Attributes 

FIH* - Reflects level of incapacitation due to heat  

FIN* - Reflects level of incapacitation  due to narcotic gases  

 

6.9 Help Menu 

Shortcut: [Help/] 

 

6.9.1 User Guide 

Shortcut: [Help/User Guide] 

This refers the user to the interactive User Guide in CHM format provided with the 

buildingEXODUS model. 
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6.9.2 Key 

Shortcut: [Help/Key] 

This provides a number of scales relating to the buildingEXODUS graphical interface. 

 

6.9.2.1 Temperature/Smoke/Population Density Contour Scale 

Shortcut: [Help/Key/Contours] 

To assist in the understanding of the contour tools (described in Section 6.5.3) the scales used 

in the contours are described in Figure 6-54. This dialogue box is available from Key sub-menu 

from the Help menu. 

 

 
Figure 6-54: The scales for the Population Density, Smoke and Temperature levels. 

 

It should be noted that the colour scheme used is continuous, so that the differences in colour 

displayed on the screen will be far more subtle (representing far smaller differences in the 

measured quantities) than are represented in the scale. This is to simplify the dialogue box 

described in Figure 6-54. 

 

The Population Density is measure in persons/nodal connection. The maximum achievable 

population density within buildingEXODUS approximates 4 persons/m2 if the nodal mesh was 

constructed using the Physical Dist tool (see Chapter 3). 
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6.9.2.2 Population Appearance 

Shortcut: [Help/Key/People] 

This facility is provided to allow the user quick reference of the colouring system used in 

Simulation mode, when the Person Shape is selected. This appearance relates to the Age and 

Gender of the individual (see Figure 6-55). 

 

 
Figure 6-55: The Key provided describing the appearance of the population, relating to 

their age and gender. 

 

6.9.3 Node Tips 

Shortcut: [Help/Node Tips] 

A tool is available to provide additional information on the attributes of individual objects. If 

the Node Tips option is selected from the Help menu, then when the pointer is moved across an 

object, basic information will appear in relation to that object. The nature of this information 

will change according to the object over which the pointer is located (see Figure 6-56). 

 

 
Figure 6-56: The appearance of node tips. 
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6.9.4 About 

Shortcut: [Help/About] 

This provides details concerning the exact version and licence details of the model in use (see 

Figure 6-57). 

 

 
Figure 6-57: The About dialogue box 

 

6.10 Summary 

By following this chapter, the user should now be able to construct a geometry (GEOMETRY 

mode), populate the geometry (POPULATION mode), create a scenario (SCENARIO mode) 

and finally execute a simulation (SIMULATION mode).  In the Application Manual, a range of 

more advanced techniques are discussed and guidelines suggested for the correct use of 

buildingEXODUS. 
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APPENDIX A: QUICK REFERENCE GUIDE 
 

A.1  Toolbar Buttons 

 

Table A-1: Toolbar buttons 

AVAILABLE IN ALL MODES 

Button Name Menu Equivalent Explanation 

 
Abort N/A Cancels the current process.  Should be used with caution. 

 
Mode Back Edit – Goto - X Goes back one mode, X = mode required 

 
Mode Advance Edit – Goto - X Goes forward one mode, X = mode required 

 
New File – New 

Starts a new buildingEXODUS File.  If the current work has 

not been saved, the user will be prompted to save the work. 

 
Open File -  Open Opens an existing buildingEXODUS file 

 
Save File - Save Saves the current buildingEXODUS file 

 
Zoom In View – Zoom - In Allows the user to zoom in on part of a geometry 

 
Zoom Out View – Zoom - Out Allows the user to zoom out on a geometry 

 
Zoom Reset 

View - Zoom - 

Reset 
Allows the user to reset the zoom on a geometry 

 
Redraw* View – Redraw Redraws the current screen image 

 
Boundary* View – Boundary Toggles between Boundary mode and the nodal view. 

 
Undo* Edit - Undo Allows the user to undo last task performed 
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AVAILABLE IN GEOMETRY MODE 

Button Name 
Menu 

Equivalent 
Explanation 

 
Free Space Node 

Tools – Generate - 

Node Creates Default Nodes 

 
Stair Transit Node 

Tools – Generate – 
Transit Node 

Creates a Stair Transit Node. Escalators, Travelators, 

Corridors and Metered Gates can then in turn be created 

by simply redefining the Node Type of the Transit Node. 

 
Seat Node 

Tools – Generate - 

Node Creates Seat Nodes  

 
Door Node 

Tools – Generate – 
External Exit Creates External Exits 

 
Arc 

Tools – Generate –

Arc Creates Arcs Between Nodes 

 
Select 

Edit – Select – 

Rubber Band Select 
Allows User to Select buildingEXODUS Objects 

 Object Lock Edit–Object Lock Allows the user to enable/disable the movement of objects 

 Node Snap 
Edit – Node Align - 

Snap 
Allows the user to enable/disable the node snap facility 

 Cut* Edit-Cut 
Allows the user to remove an item ready to be pasted 

elsewhere 

 Copy* Edit-Copy 
Allows the user to duplicate an item ready to be pasted 

elsewhere 

 
Paste* Edit-Paste Allows the user to paste an item stored in memory 

 
Line* 

Tools – Generate –

Line Allows the user to generate a line on screen 

 
Polygon* 

Tools – Generate –
Polygon Allows the user to generate a polygon boundary 

 
Text* 

Tools – Generate –
Text Label Allows the user to generate a text label 

 

AVAILABLE IN POPULATION MODE 

Button Name Menu Equivalent Explanation 

 
Occupant 

Tools – Person - 

Location 
Creates a single occupant. 

 
Panel Populate Tools - Panel Populate Creates a population using panel builder. 

 
Select 

Occupants 

Edit - Select – People 

Select 
Selects occupants only i.e. not nodes. 

 

AVAILABLE IN SCENARIO MODE 

Button Name Menu Equivalent Explanation 

 
Add Zone 

Tools – Zone - Add 

Zone 
Creates hazard zones. 

 
Zone Editor 

Tools – Zone - Edit 

Zone 
Edits hazard zones. 

 
Hazard Editor Tools - Hazard Creates/Edits hazard definitions. 

 
Edit Scenario Tools – Scenario Creates/Edits scenario definitions. 
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AVAILABLE IN SIMULATION MODE 

Button Name Menu Equivalent Explanation 

 
Reset Simulation - Reset Resets a simulation 

 
Play Simulation - Play/Continue Starts/Continues a simulation 

 
Step - Advances simulation one step 

 
Pause Simulation - Pause Pauses simulation 

 
Replay Simulation - Replay Replays simulation to current point 

 
Occupant Select Edit - Select – People Select Selects occupants i.e. NOT nodes 

 
Person Shape* View – Shape -Person  

Changes appearance to person shape 

view 

 Block Shape*  View - Shape – Block 
Changes appearance to block shape 

view 

 
Arrow* View - Shape - Arrow 

Changes appearance to arrow shape 

view 

 
Pop. Density* 

View – Contour – Pop. 

Density 
Displays population density contours 

 
Potential Map* 

View – Contour – Potential 

Map 

Displays the spread of the potential 

map 

 
Potential Route 

Map* 

View – Contour – Pot Route 

Map 

Displays the spread of the potential 

map and the direction of movement at 

all nodal locations 

 
Footfall* View – Contour – Footfall Displays the footfall contour 

 
Temperature* 

View – Contour – 

Temperature 
Displays the temperature contour 

 
Smoke* View – Contour – Smoke Displays the smoke contour 

 Congestion* 
View – Contour –

Congestion 
Displays the congestion contour 

 
VR* Simulation–VR Save Generates a VR output file. 

 
Data Output* Rulebase-Data Output 

Options 

Allows the user to control the data 

output from the simulation 

 
Hazard Control* Rulebase–Hazard Options Allows the user to control the impact 

of the hazard upon the population 

 
Behaviour Control* Rulebase–Behaviour 

Options 

Allows the user to manipulate the 

behavioural options applied 

 
Options Library* Rulebase- Options Library Allows the user to manipulate and 

save a library of the options selected 
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A.2 building-EXODUS menu structure 

 

A.2.1 Geometry Mode 

 

 

 

 

 

 

 
 

 

A.2.2 Population Mode 
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A.2.3 Scenario Mode 

 

 

 

 
 

A.2.4 Simulation Mode 
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A.3 Node Types 

 

Table A-2: List of Node types available in building-EXODUS 

Node Name Colour Purpose 

 
Free Space Green Models free space 

 
Boundary Brown Models free space but forces occupants to use walk speed 

 
Seat Red Models seats 

 
Stair Green Models one lane on one riser of a staircase 

 

Discharge 

Node 
Blue 

Used in conjunction with Attractor nodes to manipulate 

occupant movement internal exits 

 

Attractor 

Node 
Cyan 

Used in conjunction with Discharge nodes to manipulate 

occupant movement internal exits 

 
Landing Green Models free space on staircase landings 

 

Census 

Region 
Black 

Does not impact upon occupant behaviour, but enables 

extraction of occupant flow data. 

 
Internal Exit Red 

Models internal exits, enabling restrictions upon flow, biasing 

of potential routes and the exit availability. 

 
Source Grey 

Generates occupants of user defined populations with user 

defined itineraries over user defined time periods 

 
Redirection Purple 

Redirection nodes are decision points that allow the inclusion 

of sub-itineraries into circulating individuals during the 

simulation Used in conjunction with Source nodes.  

 
Direction Purple 

Restricts occupant movement by restricting flow to a single 

user defined direction. 

 
External Exit 

Red/ 

Green 

Models external exits, enabling restrictions upon flow, biasing 

of potential routes, exit use and the exit availability. 

 

A.4 Occupant Colours 

Table A-3 indicates the colour of the person silhouette icons in terms of the Head and Shoulders.  

Table A-4 indicates the colour when using Arrows or Squares. 

 

Table A-3: Person Silhouette Icon Colours 

Gender Age Head Colour Shoulder Colour 

Male < 30 Blue Light Blue 

Male 30 - 50 Blue Orange 

Male > 50 Blue Dark Green 

Female < 30 Pink Light Blue 

Female 30 - 50 Pink Orange 

Female > 50 Pink Dark Green 

 

Table A-4: Square Person Icon Colours 

Age Icon Colour 

< 30 Light Blue 

30 - 50 Orange 

> 50 Dark Green 
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APPENDIX B: OBJECT DEFAULTS 
 

B.1 Node Defaults 

 

Attribute Units Default Value 

Title - Freespace1 

Label - 1 

Type - Free-Space 

Upper/Lower Temperature oC 20 

Upper/Lower HCN ppm 0 

Upper/Lower CO ppm 0 

Upper/Lower CO2 % 0 

Upper/Lower O2 % 21 

Upper/Lower Smoke l/m 0 

Upper/Lower Radiative Flux kW/m2 0 

Upper/Lower HCL ppm 0 

Upper/Lower HBr ppm 0 

Upper/Lower HF ppm 0 

Upper/Lower SO2 ppm 0 

Upper/Lower NO2 ppm 0 

Upper/Lower CH2CHO (Acrolein) ppm 0 

Upper/Lower HCHO (Formaldehyde) ppm 0 
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B.2 Door Defaults 

 

Attribute Units Default Value 

Title - Door 

Label - 1 

Door Type - Standard 

Unit Flow Rate occs/m/s 1.33 

Active - Yes 

Usage - Main 

Status - Open 

Potential - 100 

Attractiveness - 100 

Event Times s - 

Upper/Lower Temperature oC 20 

Upper/Lower HCN ppm 0 

Upper/Lower CO ppm 0 

Upper/Lower CO2 % 0 

Upper/Lower O2 % 21 

Upper/Lower Smoke /m 0 

Upper/Lower Radiative Flux kW/m2 0 

Upper/Lower HCL ppm 0 

Upper/Lower HBr ppm 0 

Upper/Lower HF ppm 0 

Upper/Lower SO2 ppm 0 

Upper/Lower NO2 ppm 0 

Upper/Lower CH2CHO (Acrolein) ppm 0 

Upper/Lower HCHO (Formaldehyde) ppm 0 

 

B.3 Arc Defaults 

 

Attribute Units Default Value 

Label - 1 

Length m 0.5 

Obstacle - 0 
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B.4 Person defaults 

 

  Generation Method 

Attribute Units Single Random  Panels 

Age Years 25 20 - 60 17 - 80 

Weight KG 80 40 - 90 40 - 90 

Height m 1.8 From equation  

(see the Theory 

Manual, Section 3.1) 

1.5 - 2.0 

Gender - Male Male-Female Male-Female 

Response Time seconds 0.0 0 - 30 0 - 30 

Mobility - 1.0 1.0 1.0 

Agility - 5 3 - 7 [male] : 3 - 7 

[female] : 2 - 5 

Fast Walk metres/second 1.5 0.8 - 1.5 1.2 - 1.5 

Walk metres/second 1.35 90% * fast walk 90% * fast walk 

Crawl metres/second 0.3 20% * fast walk 20% * fast walk 

Leap metres/second 1.2 80% * fast walk 80% * fast walk 

Up Stair metres/second 0.67 See below See below 

Down Stair metres/second 1.01 See below See below 

Up Escalator metres/second 0.71 0.32 - 1.51 0.32 - 1.51 

Down Escalator metres/second 0.82 0.38 - 1.67 0.38 - 1.67 

RMV litre/minute See below See below See below 

PID - 30 5 - 45 5 - 45 

Patience seconds 1000 1000 1 - 5 

Drive - 10    [male] : 5 - 15 

[female] : 1 - 10 

   [male] : 5 - 15 

[female] : 1 - 10 

Familiarity  Nearest 

Exit 

Nearest Exit Nearest Exit 

Itinerary - NULL NULL NULL 

Gene - 0 0 0 

 

Default stair travel rate as derived from Fruin [19] 

Gender Age (years) Down avg (m/s) Up avg (m/s) 

Male <30 1.01 0.67 

Female <30 0.755 0.635 

Male 30 - 50 0.86 0.63 

Female 30 - 50 0.665 0.59 

Male >50 0.67 0.51 

Female >50 0.595 0.485 
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Default RMV values for males and females used by buildingEXODUS 

Activity Male RMV (l/min) Female RMV (l/min) 

Rest 8.5 7.65 

Light 25.0 22.5 

Heavy 50.0 45.0 

 

B.5 Signage – Visibility Termination Distance Defaults 

 

Model Use Sign Type Maximum Visibility Distance 

NFPA 
Full level of 

lighting 
Reflective 30.0m per 15.2cm of letter height 

BS 5499-

4:2000 

Full level of 

lighting 

Reflective 13.2m per 6.6cm of graphical symbol height 

Self 

illuminating 
15.2m per 6.6cm of graphical symbol height 

BS 5499-

4:1999 

Mains failure, 

emergency 

lighting 

available 

Reflective 
6.6m per 6.6cm of sign height excluding 

white border 

Self 

illuminating 

13.2m per 6.6cm of sign height excluding 

white border 

User defined User specific N/A 
User specifies maximum visibility distance 

in metres 
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APPENDIX C: THE EXODUS MOVIE PLAYER UTILITY 
 

C.1 Introduction 

The EXODUS Movie Player Utility (MPU) is a separate utility distributed with 

buildingEXODUS.  It allows Simulation Files and Movie Files to be viewed, independent of 

the buildingEXODUS software, i.e. it can be used on any compatible platform.  When viewing 

Simulation Files, the MPU allows the user to interrogate buildingEXODUS objects as if in 

Simulation mode.  When viewing Movie Files, the speed of playback may be increased by an 

arbitrary factor. 

 

C.2 Licensing Information 

The MPU may be distributed to third parties, free of charge.  The latest version of the 

buildingEXODUS player (MPU) can be downloaded from the following link: 

 

http://fseg.gre.ac.uk/exodus/restricted-area/exodus-users 
 

However, in order to access this page users will first need to register by sending an email to 

that effect to exodus@gre.ac.uk. 

 

Two versions of the player are available for download, namely the 32bit and 64bit versions. 

 

buildingEXODUSplayer_32bit-Setup.msi – used on 32bit Windows operating system 

buildingEXODUSplayer_64bit-Setup.msi – used on 64bit Windows operating system 

 

Once downloaded, the MPU may then be installed by running the corresponding installation 

file and following the on-screen instructions. 

 

C.3 User Manual 

The EXODUS MPU works in a similar manner to the buildingEXODUS Simulation mode.  

Wherever possible, the user interface has been kept identical in order to minimise confusion. 

 

There are two steps required to use the EXODUS MPU.  First the geometry for the original 

simulation must be loaded.  This is accomplished by selecting the Open item from the File 

menu.  Secondly, the Play button must be pressed.  When pressed, a dialogue box will appear 

asking for the simulation file to be loaded.  If a Simulation File is loaded, i.e. a .RUX or .RUN 

file, the MPU will simply pause the simulation and await the Play button to be pressed.  If a 

Movie File is loaded, an extra dialogue appears, prompting the user for the play back factor.  If 

this factor is entered as “1”, then the playback will occur at normal speed.  If “2” is entered, 

then the playback will skip two buildingEXODUS time-steps, and so on. 

 

It should be noted that the user is at liberty to interrogate objects as in the Simulation mode in 

buildingEXODUS. 

 

If the Reset button is pressed, the current Simulation/Movie File is lost and requires re-loading. 

 

http://fseg.gre.ac.uk/exodus/restricted-area/exodus-users
mailto:exodus@gre.ac.uk
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APPENDIX D: FILE TYPES USED AND GENERATED WITHIN 

THE buildingEXODUS MODEL. 
 

Table D-5: File types used by buildingEXODUS. 

FILE TYPE USAGE NOTE 
EXO EXODUS GEOMETRY FILE 

(BINARY) 

DEFAULT buildingEXODUS 

GEOMETRY FILE. 
MTA EXODUS GEOMETRY FILE 

(ASCII).  

CAN BE TRANSPORTED BETWEEN 

PLATFORMS. 
EGX EXODUS BOUNDARY 

INFORMATION FILE (BINARY) 

INTERNAL REPRESENTATION OF 

GEOMETRY BOUNDARY. 
EGM EXODUS BOUNDARY 

INFORMATION FILE (ASCII) 

INTERNAL REPRESENTATION OF 

GEOMETRY BOUNDARY. MAY BE 

TRANSPORTED BETWEEN 

PLATFORMS. 
SFE EXODUS SCRIPT FILE (ASCII). STORES A LIST OF EXODUS 

COMMANDS TO CONFIGURE AND 

RUN SCENARIOS 
EMX EXODUS MOVIE FILE (BINARY) ALLOW CONTROL OVER THE 

SPEED OF THE MOVIE PLAYBACK 
RUX EXODUS RUN FILE (BINARY) ALLOW INTERROGATION OF 

OBJECTS 
EMV EXODUS MOVIE FILE (ASCII) ALLOW CONTROL OVER THE 

SPEED OF THE MOVIE PLAYBACK 
RUN EXODUS RUN FILE (ASCII) ALLOW INTERROGATION OF 

OBJECTS 
VRG VIRTUAL REALITY GEOMETRY 

FILE (ASCII) 

REQUIRED TO REPRODUCE 

GEOMETRY IN VIRTUAL REALITY 

ENVIRONMENT 
VRS VIRTUAL REALITY SCENARIO 

FILE (ASCII) 

REQUIRED TO REPRODUCE 

POPULATION AND MOVEMENT IN 

VIRTUAL REALITY ENVIRONMENT 
ESO EXODUS SIMULATION OPTIONS 

(ASCII) 

USED TO CONTROL THE MODEL 

PERFORMANCE 
POP EXODUS POPULATION FILES 

(ASCII) 

DESCRIBES POPULATION DETAILS 

FOR RE-GENERATION OF 

OCCUPANTS 
PAN EXODUS POPULATION PANEL 

FILES 

(ASCII) 

DESCRIBES POPULATION PANEL 

DETAILS 

INI EXODUS DATA OUTPUT 

OPTIONS FILE (ASCII) 

STORES THE DATA OUTPUT 

OPTIONS USED TO CONFIGURE THE 

FORMAT OF THE SIMULATION FILE 

(.SIM) 
SIM SIMULATION OUTPUT FILE 

(ASCII) 

CONTAINS RESULTS OF 

SIMULATION IN TEXT FORMAT 
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OUT SIMULATION TRACE OUTPUT 

FILE (ASCII) 

CONTAINS RESULTS OF TRACED 

AGENTS WITHIN THE SIMULATION 
EPF EXPORTED POPULATION 

(ASCII) 

STORES A GENERATED 

POPULATION 
HI CFAST HISTORY FILE 

(BINARY) 

GENERATED BY CFAST. IMPORTED 

INTO buildingEXODUS  
DAT SMARTFIRE DATA FILE 

(ASCII) 

GENERATED BY SMARTFIRE. 

IMPORTED INTO buildingEXODUS 
EHF EXODUS HAZARD FILE 

(BINARY) 

EXODUS BINARY HAZARD FILE. 

IMPORTED INTO buildingEXODUS 
SCE FIRE SCENARIO (BINARY) ALLOWS THE USER TO EXPORT 

THE HAZARD, ZONES AND 

SCENARIOS FROM AN EXO FILE 
SCN EXODUS HAZARD SCENARIO 

FILE (ASCII) 

STORES EXODUS HAZARD FILE 

SCENARIO. IMPORTED INTO 

buildingEXODUS 
DXF IMPORTED CAD FILE 

(ASCII) 

GENERATED BY AUTOCAD 13/14. 

IMPORTED INTO buildingEXODUS.  

DAT RESPONSE CURVE DATA (ASCII) ALLOWS THE USER TO EXPORT 

AND IMPORT RESPONSE CURVES 

EBF EXODUS BATCH FILE (ASCII) STORES THE BATCH FILE 

COMMANDS USED TO RUN 

MULTIPLE SIMULATIONS 
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APPENDIX E: DEPRECATED FUNCTIONALITY  
 

E.1 Introduction 

This Appendix describes the way a user can create staircases using stair nodes instead of transit 

nodes, together with various options for linking floors. These approaches are still available 

within the latest version of buildingEXODUS, but have been superseded by more efficient and 

less error-prone approaches. For staircases it is now recommended that transit nodes are used. 

For floor connections, it is now recommended that the stair transit nodes are connected to the 

various floors using the auto-connect approach; auto-connect is described within this appendix, 

but for node based stairs.  

 

The previous functionality remains within buildingEXODUS in order to provide the user with 

maximum flexibility when creating models. 

 

E.2 Node Based Staircases 

To create a staircase the staircase tool must be selected. To accomplish this, hold down the 

SHIFT key and then press the Stair button on the toolbar (see Chapter 3). 

 

The position of the staircase may now be defined by dragging a bounding box using the mouse.  

When the mouse button is released, the Stair dialogue box will appear (see Figure E-1). 

 

 
Figure E-1: Stair dialogue box 

 

The attributes available in the dialogue box must be adjusted appropriately to define the size of 

the staircase. The following list describes the purpose of each option available in the staircase 

dialogue box. 

 

 Width (default value - defined by bounding box m) - the width of the staircase is initially 

defined by the defining box.  This value represents the largest amount of physical space 

available for the staircase (metres). 

 

 Drop (default value - 3.0m) - this is the amount of vertical space the staircase has to cover 

between floors (metres).  This value is divided by the riser height to give the number of 

risers (nodes in the vertical direction) for the staircase. 
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 Lane Width (default value - 0.76m) - this is the amount of width required by each person 

using the staircase.  The default value of 0.76m takes into account increased body sway and 

is based on the value suggested by Fruin[19]. 

 

 Direction (default value - UP) - by default stair nodes going upwards in the geometry 

window reflect staircases that also go upward. 

 

NOTE: 

The length of the staircase is calculated using the riser height and depth available in the 

Advanced dialogue box. 

 

The ADVANCED button in the Stair dialogue box gives access to additional attributes, as shown 

in Figure E-2. 

 

 
Figure E-2: Advanced staircase attributes 

 

 Hand Rails - the presence of handrails must be registered with buildingEXODUS.  If centre 

handrails are present, all the arcs in the centre of the staircase should be removed after the 

staircase has been generated. Handrails also have an effect on effective width calculations 

(see the Theory Manual, Section 7.2.3.8). 

 

Hand-Rail (default value - no) - indicates presence of handrails 

Size - (default value - 0.0m if not present, 0.10m if present) - indicates width of handrail 

each side of staircase 

 

Eff Width (default value - no) - indicates use of effective width model 

Size - (default value 0.0m if not used, 0.15m if used and handrails not present, 0.0875m 

if used and handrails present) - indicates size of effective width model to be used (see 

the Theory Manual, Section 7.2.3.8) 

 

 Riser Height (default value - 0.17m) - this is the height of each riser.  This is used to 

calculate the number of nodes assigned to the staircase 

 

 Riser Depth (default value - 0.27m) - this is the depth of each tread.  This is used to 

calculate the arc lengths between each riser. 

 

The staircase is created after the OK button is pressed on the STAIR dialogue box.  Note that 

the arcs linking the staircase to the main geometry are not automatically created.  In order 

to aid this process, a dialogue box is displayed to remind the user to connect the staircase to the 
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main geometry and the default arc length is changed to the correct length.  An automatic system 

of connecting staircase has been incorporated since version 4.03 which greatly simplifies this 

task. 

 

 
Figure E-3: Stair nodes required to model different lane widths 

 

When using staircases in buildingEXODUS to link multiple floors, several factors need to be 

considered, (1) number of risers, (2) landings and (3) the potential map /distance map (used in 

conjunction with Target exits, Pre-defined evacuation procedures and the Local Familiarity 

system). 

 

(1) Each riser in buildingEXODUS is modelled as a separate node, one node per lane width 

across each riser. Figure E-3 illustrates this concept.  In most cases, the number of nodes 

required to model a staircase will exceed the space available in the geometry window, if the 

geometry has been extracted from a DXF file.  In this case, it is advisable to construct the 

staircase in a separate geometry window, and connecting it to all the relevant floors.  This 

technique should also be used when staircases exceed 1 floor in vertical space.  Figure E-4 

and Figure E-5 demonstrate an example of this technique. This may result in problems with 

the VR 

 

(2) Landings - It is suggested that each portion of the staircase separated by landings is 

constructed separately to ensure the correct dimensions.  Figure E-5b shows an example 

where a landing may occur in a staircase. It is particularly important for the VR output that 

landings are represented using Landing nodes rather than free-space nodes. 

 

(3) The potential map/distance map treats stair nodes as normal free space nodes.  A 

disadvantage with this method occurs if more precise control is required over the potential 

map on upper floors.  As the distance from an exit increases, e.g. by going up floors, it is 

increasingly difficult to control the potential map on each floor.  To remedy this situation, 

Attractor / Discharge nodes should be used at the junction of each staircase and each upper 

floor.  This allows the potential to be easily controlled on each floor, as if each were a 

separate entity.  Figure E-5 demonstrates how this may be accomplished. 

 

The diagram shown in Figure E-4 is a hypothetical two-storey geometry, addressing all three 

issues listed above.  In this case, the staircase runs from the middle of the upper floor, down to 

the middle of the second floor.  Figure E-4 shows this geometry from a side view and a plan 

view.  In Figure E-5, the same geometry is shown, but in this case its implementation in 

buildingEXODUS is depicted.  The numbers indicate which nodes are linked together.   
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In this case, the number of nodes required to model the staircase would not fit into the space 

allowed by the stairwell.  For this reason, a separate staircase is created with connecting links 

from the internal exit on the “TOP” floor (labelled 1 and 2) to the top of the staircase (stair 

nodes 1 and 2), and another set of connecting links from the bottom of the staircase (stair nodes 

3 and 4) to the free space nodes on the “GROUND” floor (labelled 3 and 4).  Two possible 

separate staircases are shown in this figure, in (a) the staircase is one contiguous object, whereas 

in (b), the staircase is broken up by a landing.  The width of the free space nodes (and hence 

the arc lengths) on the landing reflect the width of the stair nodes (i.e. 0.76m) while the distance 

between the landing nodes reflects the space available on the landing.  

 

It can also be seen that the top of the staircase in both cases is connected to an Attractor / 

Discharge nodal pairing on the “TOP” floor.  This facilitates more control over the potential 

map on the “TOP” floor, as the potential on the Attractor nodes can be set in SCENARIO mode. 

Alternatively the user may wish to use the Floor Potential feature (described in Chapter 6). 

While the Floor Potential feature allows the user to control the spread of ‘attractiveness’ of 

individual staircases in relation to each other, they are not able to cap the flow rate at the top/foot 

of the stairs (possibly indicating the presence of a door). If the capping is not required, then the 

use of the Floor Potential system may be simpler.  

 

 
Figure E-4: Side and Top views of a hypothetical two-storey geometry 

 

 
Figure E-5: Diagram showing a buildingEXODUS implementation of the hypothetical 

two-floor geometry 
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NOTE: 

If single stair nodes are generated, the Physical Dist. Option will not be affected. 

 

NOTE: 

Care should be taken when connecting staircases to floors within the geometry. The length of 

the arcs connecting the staircase to a floor should always be re-examined after creation to 

confirm that they are appropriate.   

 

E.3 Options for Connecting Floors 

The following approaches can all be used to connect floors. However, unless there is a good 

reason, it is recommended that the auto-connect approach is adopted. 

 

E.3.1 The Original Floor Connection Method 

Shortcut: [Tools/Construction/Level Con] 

Linking two levels using the Original method is a fully manual process which requires the user 

to ensure that the connecting arcs are of the appropriate length. The length of the connecting 

arcs are calculated manually and are based on the nodal connectivity of the structure. Figure 

E-6 below shows a typical dual lane staircase, the free space nodes to which the staircase is to 

be connected and the corresponding distances (i.e. arc lengths) between the respective nodes. It 

can clearly be seen that within this geometry the free space nodes are positioned at regular 0.500 

metre intervals, while the staircase itself assumes a lane width of 0.700 metres and a step length 

of 0.323 metres.  

 

By default all staircases generated within buildingEXODUS are automatically snapped to the 

underlying nodal grid. This ensures that the stair nodes are displayed at regular intervals (i.e. 

0.500 metres) irrespective of the length of their corresponding arcs, and hence that they do not 

typically assume their actual physical positions within the geometry. This is clearly evident in 

Figure E-6 where nodes within adjacent staircase lanes are located 0.700 metres apart while 

appearing identically separated to the free space nodes that are located 0.500 metres apart.  

 

Staircases within buildingEXODUS are displayed in this manner for purely cosmetic reasons, 

and it is worth stating that snapping staircase nodes to the underlying nodal grid in this manner 

in no way affects the behaviour of the people. The distance travelled by each person within the 

geometry is based solely on the lengths of the arcs between the nodes over which they travel, 

and not on the distances between the nodes as displayed within the geometry window. 

 

Despite improving the overall cosmetic appearance of the geometry, the snapping of staircases 

to the nodal grid in the manner outlined above can lead to confusion when it comes to correctly 

connecting them. Since the length of each arc connecting a stair node to a conventional free 

space node should be equivalent to the actual physical distance between the two points, users 

are therefore required to consider the physical positions of the nodes prior to connection. 
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NOTE: 

It is not necessary for users to move all staircase nodes to their actual physical positions within 

the geometry prior to connecting them to free space nodes.  It is however required that the user 

takes account of their corresponding positions when calculating the required arc lengths. 

 

Displayed in Figure E-7 is the same staircase outlined previously in Figure E-6 with the 

individual nodes moved to reflect their physical positions within the geometry. Also depicted 

in Figure E-7 is the required connectivity between the staircase and the four free space nodes 

to which the staircase is to be connected. Since in this instance the staircase is located centrally 

between the four evenly spaced connected nodes it therefore follows that the associated 

connectivity will be symmetrical, and hence that the connectivity of each stair node will merely 

be a mirror of the other. This can clearly be seen in Figure E-7 where arcs of equivalent length 

have been identically coloured for clarity. As a result of this symmetry, correctly connecting 

the staircase shown in Figure E-7 requires the calculation of only three arc lengths indicated by 

the red, yellow and blue lines. 

 

 
Figure E-6: Connecting a 0.7 lane width 

staircase to free space nodes 

 
Figure E-7: Stair nodes moved to their 

physical positions. 

 

NOTE: 

In all the calculations used to determine appropriate arc lengths for connecting stairs to free-

space nodes, it is essential that the appropriate free-space node width, stair lane width and step 

length is used.  If the user has changed the default values for these parameters this must be 

reflected in the calculations for the connecting arcs. 

 

Calculating the length of each coloured line (i.e. arc) shown in Figure E-7 can be achieved by 

further analysing the basic connectivity of the structure. In each case the knowledge of the 

positions of the nodes and their associated distances from one another can be used to generate 

right-angled triangles from which the required arc lengths can be calculated. Figure E-8 below 

shows the right-angled triangle formed by the top-left hand side of the staircase, a connected 

node and the intersection between the staircase lane and the row of connected free space nodes. 

In this instance it can clearly be seen that the hypotenuse of the triangle represents the unknown 

distance (i.e. the required arc length), while the right hand side of the triangle is equivalent to 

the step length of the staircase (i.e. 0.323 metres). In contrast, the length of the top of the triangle 

is equivalent to the distance between the free space nodes (i.e. 0.500 metres) minus the resulting 

overhang from the stairs. In this instance the lanes of the staircase were assumed to be 0.700 

metres apart, while conversely the connected free space nodes were assumed to be 0.500 metres 

apart. As a result, the distance between the staircase nodes exceeded that of the corresponding 

free space nodes by 0.200 metres, resulting in the staircase overhanging each side of the 
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connected nodes by 0.100 metres. As a consequence of this overhang the length of the top of 

the triangle is therefore equivalent to 0.400 metres (i.e. 0.500 – 0.100 = 0.400 metres). Utilising 

the known distances of the triangle and employing Pythagoras theorem enables the unknown 

side of the triangle to be calculated. Depicted in Figure E-9 is the triangle, complete with the 

previously unknown side calculated as being equal to 0.514 metres. 

 

 
Figure E-8: The red connection 

between the staircase and the free space 

nodes. 

 
Figure E-9: The red triangle formed by 

the staircase and the free space nodes. 

 

Another right-angled triangle can also be constructed in order to calculate the length of the arc 

represented by the yellow line in Figure E-7. Figure E-10 below shows the right-angled triangle 

once again formed by the top-left hand side of the staircase, a connected node and the 

intersection between the staircase lane and the row of connected free space nodes. Once again 

it can clearly be seen that the hypotenuse of the triangle represents the unknown distance (i.e. 

the required arc length), while the left hand side of the triangle is equivalent to the step length 

of the staircase (i.e. 0.323 metres). It can also be seen that the length of the top of the triangle 

is equivalent to the staircase overhang (i.e. 0.100 metres). Once again, utilising the known 

distances of the triangle and employing Pythagoras theorem enables the unknown side of the 

triangle to be calculated. Figure E-11 below shows the triangle, complete with the previously 

unknown side calculated as being equal to 0.338 metres. 

 

 
Figure E-10: The yellow connection 

between the staircase and the free space 

nodes. 

 
Figure E-11: The yellow triangle 

formed by the staircase and the free 

space nodes. 
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Another right-angled triangle can similarly be constructed in order to calculate the length of the 

final required arc represented by the blue line in Figure E-7. Figure E-13 below shows the right-

angled triangle once again formed by the top-left hand side of the staircase, a connected node 

and the intersection between the staircase lane and the row of connected free space nodes. Once 

again it can clearly be seen that the hypotenuse of the triangle represents the unknown distance 

(i.e. the required arc length), while the left hand side of the triangle is equivalent to the step 

length of the staircase (i.e. 0.323 metres). It can also be seen that the length of the top of the 

triangle is equivalent to the distance between the free space nodes plus the resulting overhang 

from the stairs (i.e. 0.500 + 0.100 = 0.600 metres). Once again, utilising the known distances 

of the triangle and employing Pythagoras theorem enables the unknown side of the triangle to 

be calculated. Figure E-13 below shows the triangle, complete with the previously unknown 

side calculated as being equal to 0.681 metres. 

 

 
Figure E-12: The blue connection 

between the staircase and the free space 

nodes. 

 
Figure E-13: The blue triangle formed 

by the staircase and the free space nodes. 

 

Having calculated the length of the required arcs the user can then set about connecting the 

staircase. The link is accomplished in the following way: First select Tools from the menu bar, 

the Construction sub-menu and then the Level Con item from the pull-down menu (see Chapter 

3). Then select the first node where the link should start from on the first level.  At this point 

the cursor will change shape to, indicating that a second node must be selected to complete the 

link.  Move to the window containing the second level and select the terminal node. Having 

successfully established a connection between the two nodes users are then required to 

manually change its length to the corresponding distance calculated previously, since by default 

the length of all newly generated arcs will be equivalent to the default arc length. The length of 

any given arc can be modified in the conventional manner via the Arc dialogue box, which can 

be accessed by simply double clicking with the left mouse button on the respective arc. 

 

NOTE: 

Linking levels is a difficult concept to master.  It is suggested that Tutorial 3 in the Application 

Manual be followed carefully. 

 

Levels will usually be linked to each other via staircases.  At the linking point, it is good practice 

to place an Attractor/Discharge Node pair, as this allows the potential map to be controlled on 

each level.  

 

The Level Con option essentially links two geometry windows together.  It is a device for 

transporting evacuees from one geometry window to another. The actual link in 

buildingEXODUS between floors is accomplished through the use of staircases. 
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NOTE: 

For geometries that are intended for use in VR animations, it is recommended that the staircase 

is built within the window including the lowest connected floor. 

 

E.3.2 The Floor Connection Method Using Floor Links 

The alternative manual method of connecting floors in buildingEXODUS is via the use of Floor 

Links.  This functionality was introduced in v4.03 as a means to simplify the process of linking 

floors to staircases.  While the Auto Connect option is the preferred option for linking floors, 

the Floor Link method has also been enhanced from v4.05 with an automatic generation feature.   

 

When using the Floor Links method, nodes within different geometry windows are not directly 

connected to one another, but are instead connected via a pair or Floor Links.  This pair of Floor 

Links are distributed between the two windows being linked, with one link being placed in each 

of the respective geometry windows.  Nodes are then connected directly to the Floor Link within 

their respective window, and hence a connection between nodes in different windows can be 

established.  These additional objects are used to simplify the visual appearance of the 

connectivity between the floors and provide the user with ready access to the connecting arcs. 

 

Floor Links connecting different geometry windows can be generated either manually or 

automatically.  Each of these alternative means of generating Floor Links will now be outlined. 

 

E.3.3 Manually Generating Floor Links 

In order to connect different geometry windows (i.e. provide a connection between two floors) 

a pair of Floor Links are required, one for each of the respective windows.  Each pair of Floor 

Links comprise both a “Primary” and a “Secondary” link.  The only difference between these 

“Primary” and “Secondary” links is the order in which they were generated, with the “Primary” 

link, as the name suggests, being generated first.  Any other ordering related to the links (e.g. 

which of the links is on the upper or lower floors, etc.) is deemed irrelevant.  When the user 

generates a “Secondary” link, this new link is automatically associated with the first available 

(i.e. unassociated) “Primary” link. If there are no “Primary” links for a “Secondary” link to be 

associated with, the “Secondary” link will automatically be reclassified, and will therefore 

become a new “Primary” link instead.  The association of Primary and Secondary links in the 

manner defined above represent the relationship between the two floors on which they appear. 

Nodes within each of these floors can be connected to these links, thereby establishing a 

connection between the two floors.  Primary and Secondary links that are associated are 

identifiable by the fact that they share the same Link number. 

 

Floor Links can be generated by selecting the Tools from the menu bar, the Generate sub-menu 

and then either the Primary Link or Secondary Link item from the pull-down menu (see Chapter 

3).  Once created, the association between the links will be evident by double-clicking on either 

of the Floor Link objects (i.e. either of the pair in the two floor windows), see Figure E-14(b). 

In addition to displaying the floors involved in the association, a number of other attributes are 

evident. 

 

Once an associated set of Floor Links has been generated the user can then start to associate the 

appropriate nodes with the link. That is, now that a connection between the two floors has been 

established, the nodes on each of these floors involved in this connection and their connectivity 

to each other can be established. This action is simpler than using the Original method as the 
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user does not have to switch between windows.  These connections then represent the nodes on 

that particular floor that are involved in the connection. The arcs leading from these nodes 

determine the levels of connectivity of each of these nodes. The way this is displayed on the 

screen is determined by the Attribute selections of the Floor Link that are described later. The 

generation of the arcs is performed by selecting the  button (or Arc from the Tools menu via 

the Generate sub-menu).  After this has been completed, each time an arc is dragged between 

the Link object (see Figure E-14(a)) and a node within the geometry a new Link Connection 

appears within the Link Object. Each of the connections will appear as differently coloured 

squares.  

 

NOTE: 

The user must allow the Floor Links objects to be selectable before the object attributes can be 

edited. This can be achieved by double-clicking on the  button or selecting the Gra. Control 

Option from the View menu via the Display sub-menu and enabling the selectability of the Floor 

Links. 

 

 

 

 

 

 

 
(a) (b) 

Figure E-14: (a) The Link Object, and (b) the Link dialogue box. 

 

There are two views available to the user while this process is conducted. Firstly in Arc 

(Connection) view, the arcs connecting the nodes of one floor to a link are displayed. This is 

particularly useful for creating the initial connectivity between each of the floors and the 

associated Link object, as well as when viewing the simulation running, as it entails less clutter 

on the screen. In the alternative view, Node (Construction) view the user is able to concentrate 

on the connectivity according to the nodes involved, rather than their connectivity to the Link 

objects involved. This is particularly useful when constructing the connectivity on a nodal basis 

(e.g. which nodes on floor 1 are connected to which nodes on floor 2). In this view a small 

network describing all of the nodes involved in connection appears within the Link objects 

selected, effectively representing the connections as they would appear if they were in the same 

window (in reality, this small network appears within the Link object itself).  This view is 

particularly useful when constructing the connectivity between the nodes involved. For 

instance, if a staircase is to be connected, then the exact connectivity between the nodes in the 

staircase (assumed to be in Floor A) will need to be determined with those nodes involved in 

Floor B. This may involve nodes being connected to several additional nodes on the other floor 

(e.g. full connectivity). 

 

NOTE: 
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When in Node view the user should take care when manipulating the nodes within the small 

network, as the operations will affect the actual nodes that this ‘virtual’ network represents.; 

e.g. deleting one of the nodes in the small network will be reflected in the original geometry. 

 

Each of these views have their own uses and the user may wish to toggle between them 

according to their wishes. This can be achieved by double-clicking on a Link object and altering 

the Lnk Style attribute according to the wishes of the user, between the Node and the Arc view 

(see Figure E-14(b)).  

 

These two views will now be discussed in more detail, with accompanying examples. 

 

(i)Arc View 

In this view, the information within the Link object refers solely to the connections between 

individual nodes. No information is provided regarding the configuration of these connections 

(e.g. whether a single node is connected to a number of other nodes). Each of the stubs within 

the Link object represent a connection between a node on the adjoining floor and the target 

floor (no other information is provided). The user then may trace this connection through 

examining the colour of the ‘stubs’ in the Primary link, matching this up to the same coloured 

stub in the Secondary Link and then examining the nodes that are then connected (see Figure 

E-15). In effect, the stub is simply a placeholder of a connection between a single arc connection 

that spans two windows. 

 

 
Figure E-15: A schematic of the Arc view. 

 

A brief example may clarify the appearance of the Arc view. Let us assume that the Link objects 

have been created in the appropriate windows. The user can then start to associate arcs. First 

the arc must be generated connecting the Link object to the geometry (by selecting Arc generate 

from the toolbar). 
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Figure E-16: The Arc View of a connection between a floor and a Link Object. 

 

A node within the geometry, which is to be associated to the Link object, should be identified 

and the user should then drag an arc from this node to the Floor Link. The user should then 

repeat this process for all the connections that are required on that floor. For example, in Figure 

E-16, it is apparent that each of the nodes involved are connected to two other nodes on the 

other floor, requiring two connections each to the Link object, generating four Arc Stubs.  The 

changes in the Link Object that has been connected (let us assume that this is the Primary Link 

Object) will be reflected in the Secondary Link Object, on the other associated floor. From 

Figure E-17, the number of Arc stubs can be seen to be reflected in both the Primary and 

Secondary links. 

 

 
Figure E-17: How the objects appear on the two associated floors. 

 

The user then turns their attention to the other floor. To connect the nodes on the other window 

to the stubs which have appeared representing the connectivity of the other floor involved, the 

user first drags an arc between the required nodes and the stubs on the Link object that 

represents the connections, as was performed previously. It should be remembered that in this 

view the stubs can only be connected to a single node as they only reflect a single arc spanning 

across two floors/windows. The Link object will then be complete (see Figure E-18). 

 

 
Figure E-18: Both Link objects completed. 
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The eventual connectivity between the floors is reflected in Figure E-19. It can be seen that 

each node has two arcs between it and the other floor. The red line in this diagram signifies the 

process performed by the Link Objects. 

 

  
(a) (b) 

Figure E-19: (a) Connectivity between floors as described by the Floor Links (b) The 

final connectivity produced 

 

The information that can be extracted from the stubs evolves according to the state of progress 

of the user. If only a one sided connection has been connected (e.g. the arcs from one floor to a 

Primary or Secondary link has been completed) then double-clicking on one of the stubs inside 

the link object will provide information on the arc connection. At this stage, clicking on the 

connecting arcs will provide the same information. If both the Primary and the Secondary links 

have been connected, then performing the same act will provide a short cut to gaining 

information on the node attached to arcs visible. At this stage, clicking on the connecting arcs 

will still provide information relating to the connecting arcs. 

 

(ii) Node View 

In node view the information presented on screen relates to the configuration of the connectivity 

between the two floors. The stubs within the link object describe the connectivity between the 

nodes that are connected to the link object as if they appeared in the same window; i.e. they 

reflect the exact connection between the nodes involved. In essence, within Node view the stubs 

represent the nodes involved instead of the arcs that link the floors. The arcs connecting these 

nodes can be manipulated as if they were in a standard window within buildingEXODUS. 

During the initial stages of this process the two modes appear similar, with the stubs appearing 

according to the connections between the first floor connected and the first Link object. Once 

connections have been made to the second floor, differences appear. In Node view, the stubs 

inside the Link objects actually reflect the connectivity between the appropriate node within the 

two floors rather than simply the unassigned arcs used to connect them (see Figure E-20).  
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Figure E-20: Schematic of the Node View. 

 

This mode is particularly useful for determining the exact connectivity between individual 

nodes, rather than simply between floors. A brief example may clarify the appearance of the 

Node view. Let us assume that the Floor Links have been created as in the previous example, 

so that a primary and secondary link exists on each of the relevant floors and that the Node view 

has been selected for each of the Link objects. Two arcs are then dragged from each of the 

primary and secondary links (with no reference to the newly generated stubs). There should 

now be four unconnected stubs in each of the Link objects, two of which are connected to the 

adjacent floor. At this stage each of the link objects are connected to the adjacent floor but are 

not connected to each other (see Figure E-21).  

 

 
Figure E-21: Newly ‘connected’ link objects. 

 

The user may now act directly on the connectivity of these nodes. Arcs may be dragged between 

the nodes that now appear as stubs within one of the link objects, as these now represent the 

nodes that have been connected to the link objects across the two screens. Let us assume in this 

instance that the user wishes the nodes to be fully connected. Therefore each node needs to be 

connected to the two nodes opposite it (see Figure E-22(a)). The appearance of this network 

now represents the connectivity of the nodes across the floors (see Figure E-22(b)). 
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(a) (b) 

Figure E-22: (a) Nodes have now been connected (b) meaning of network within the 

Link object. 

 

To compare what this connection would look like using the Arc representation, the user should 

double-click on each Link object and alter the Lnk Style attribute appropriately. It is apparent 

from Figure E-23 that although there are the same number of arcs and the connectivity is the 

same the nature of the connectivity is expressed less clearly using this method. 

 

 
Figure E-23: The example used as it would appear using the Arc view. 

 

As in the Arc view, clicking on the stubs and other objects within the Link object allows access 

to information. The stubs inside the Link objects provide information related to the nodes that 

they represent while the arcs connecting them to each other provide information on the actual 

arcs connecting the nodes (the arcs connecting the geometry to the Link are purely to indicate 

the connectivity of the Link and have no physical distance associated). This representation 

makes it very simple to edit the size of the arcs as well as keeping track on both the connectivity 

and the arcs that have already been edited. 

 

The use of these viewpoints are only a suggestion as the user may have their preference. 

Whichever view is selected, this feature will require some use to master. However it is believed 

that it now provides an intuitive and less intricate method of connecting between floors than 

the method previously used in the EXODUS suite of models.  

 

(iii) Other Link Features 

The user has some control over the appearance of the Link objects. Firstly, the user may alter 

the name of the Link objects to something more descriptive than the one provided. This can be 

done by double-clicking on a Link Object and then replacing the text in the Title attribute with 

the text that is desired. It should be noted that once this has been completed that the title of the 

associated link (either primary or secondary) will be updated. 

 

Another feature of the Link object that can be manipulated is the location of the ‘stubs’ in 

relation to the Link object itself. This may affect the clarity of the appearance of the object and 

will depend on the location of the object in relation to the geometry. By default the ‘stubs’ will 

appear at the bottom of the Link object. If, as in Figure E-24(a), this is not appropriate, then the 

user may double-click on the link object and edit the Direction attribute. By doing so, the 
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location of the stubs (and the associated network of arcs) may be altered as the user desires (see 

Figure E-24(b,c)).  

 

 
  

 (a) (b) (c) 

Figure E-24: (a) Original view (b) Link Object dialogue box accessed to alter Direction 

(c) Impact of this change 

 

Once created, aspects of the Link object may be deleted in the standard manner (i.e. they may 

be selected and from the associated dialogue box, the user may then click on the DELETE 

button). 

 

E.3.4 Automatically Generating Floor Links 

As well as the ability to generate Floor Links manually, there is also an automatic generation 

facility.  The automatic generation of Floor Links, as the name suggests, is considerably easier 

than the manual method detailed previously, although it is not necessarily as systematic and 

requires the user to drag arcs between windows.   

 

To initiate the automatic generation of Floor Links the user is first required to connect the 

desired nodes within the two different geometry windows via a conventional arc.  To achieve 

this, the user must first enable arc generation by selecting either the  button, or alternatively 

selecting Tools from the menu bar, Generate from the sub-menu and the Arc item from the pull 

down menu.  Having done this the desired nodes can then be connected in the conventional 

manner by first clicking and holding down the left mouse button on the node representing the 

start of the desired link within one window, and while holding the left mouse button down, then 

moving the pointer over the node representing the end of the link in the other window.  

Releasing the left mouse button over this node will then establish the link between the two 

nodes and result in the nodes being automatically connected via a pair of Floor Links, one Floor 

Link being placed in each of respective geometry windows (see Figure E-25). 
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Figure E-25: The automatically generated pair of Floor Links connecting nodes in 

different windows. 

 

By default the generated Floor Links will display the associated connection between the nodes 

in the Arc view.  Each Floor Link will be placed in close proximity to the node to which it is 

directly connected, irrespective of the existing nodes within the window.  In many cases, as in 

Figure E-25 shown above, this may result in the Floor Links being placed directly on top of 

existing nodes within the geometry.  Since this obscures the Floor Links and their associated 

connectivity users may therefore be required to relocate the links to clear areas within their 

respective windows.  In order to achieve this the user must ensure both that Floor Link objects 

are selectable and that the Object Lock is disabled.  The selectability of Floor Links is controlled 

within the Display Control Dialogue box obtained either by double-clicking on the  button, 

or alternatively by selecting View from the menu bar, Display from the sub-menu and Gra. 

Control Options from the resulting pull down menu.   

 

In contrast, the Object Lock is disabled by ensuring that the Object Lock item within the Edit 

menu remains un-checked.  It is important to note that relocating the Floor Links in the manner 

detailed above in no way affects the behaviour of the evacuees during the simulation and is 

undertaken purely to aid the user in the visualisation of the connections between windows.  

Having relocated Floor Links the user may also choose to alter the Direction attribute of each 

Floor Link to further improve the overall cosmetic appearance of the links.  Figure E-26 below 

shows the same geometry as that detailed previously in Figure E-25 after the relocation of the 

two Floor Links. 

 

 
Figure E-26: The relocated automatically generated pair of Floor Links. 

 

Having established a link between two nodes in different windows the same technique can then 

be applied to connect further nodes within the same windows.  The format of these further 

connections will however vary depending upon both the nodes being connected as well as the 
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existing connections between the two geometry windows.  While the initial connection between 

the two windows resulted in the generation of a new pair of Floor Links, further connections 

may forego the generation of additional Floor Links in favour of utilising those that currently 

already exist.  Establishing a connection between different geometry windows will only result 

in the generation of new floors links if the attempted connection is not directly adjacent to an 

existing connection between the same windows.  Connections which are directly adjacent to 

existing connections will instead result in the connection being defined via the Floor Links used 

as part of the existing connection.   

 

To demonstrate this more clearly, let us consider extending the geometry detailed in Figure 

E-26 to include an additional connection between the nodes directly above those connected 

previously.  Since the new connection between these two geometry windows involves nodes 

directly adjacent to (i.e. connected to) nodes already used to connect the two windows no new 

Floor Links are created.  Instead the new connection between these windows is defined via the 

Floor Links used as part of the adjacent connection (i.e. Link0).  Figure E-27 below shows the 

effect of connecting the geometry windows in the manner defined previously.  

 

 
Figure E-27: Additional connections added to the existing Floor Links. 

 

In contrast, Figure E-28 below shows the geometry detailed in Figure E-26 extended still further 

to include an additional connection between the geometry windows, this time not adjacent to 

an existing connection between the two windows.  This lack of adjacency to an existing 

connection results in the new connection being established via a completely new pair of Floor 

Links.  Once again, one Floor Link is placed in each window, in close proximity to the node to 

which it is directly connected.  The association between pairs of Floor Links in different 

windows is clearly evident by virtue of them having the same name. 

 

 
Figure E-28: Additional Floor Links created as a result of connecting further nodes. 

 

By checking the adjacencies of connections between windows in this manner 

buildingEXODUS ensures that connections within close proximity are grouped, thereby 
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simplifying the various links that exist between windows and hence aiding the user in 

understanding the connectivity of the structure. 

 

E.3.5 Auto Connecting Staircases 

The manual generation of arcs that connect stair nodes and free space nodes can be difficult for 

the user to perform correctly. This is mainly due to the differences in nodal spaces and arc 

lengths of the stair nodes and free space nodes. Typically free space nodes have a spacing of 

around 0.5 metres whereas staircase nodes have a lane spacing of 0.7 metres and a travel 

distance between treads of approximately 0.3 metres. Hence, when connecting stair nodes to 

adjacent free space nodes the calculation of the correct arc lengths can be both time consuming 

and error prone (see Figure E-29). This problem can be made worse by having the nodes in 

question in different windows. To aid the user in this task an automatic arc connection function 

has been developed.  

 

TIP: 

Even though the Auto Connect option may be used, it is recommended that the user check the 

lengths of the generated arcs to ensure that they are appropriate.  

 

 
Figure E-29: Correct arc lengths when 

connecting a 0.7 lane width staircase to 

free space nodes 

 
Figure E-30: Stair Nodes moved to their 

physical positions to demonstrate nodal 

spacing and hence the arc lengths in 

Figure E-29 

 

When connecting the staircase nodes to adjacent free space nodes the user should first select 

the base (i.e. the foot of the stair) or upper nodes of the staircase they wish to connect 

(depending on whether they are connecting the top or bottom of the staircase). Then, while 

pressing the CTRL key, select the free space nodes they wish to connect as shown in Figure 

E-31. Once the free space nodes have been selected the user then selects Auto Connect from the 

Tools menu then Stairs from this submenu (see Figure E-32). 
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Figure E-31: Selecting nodes to be 

connected 

 
Figure E-32: Auto Connect stairs menu 

 

Before the Auto Connect function can commence it has to be established whether it has ordered 

the sets of nodes to connect correctly. Two nodes are highlighted, one free space node and one 

stair node. The user is then asked to confirm that the nodes are on the same side of the staircase 

(see Figure E-33). This is to ensure that the user is content that they have identified the location 

and connectivity of the nodes correctly. For example, that the nodes are both on the left or both 

on the right of the staircase. If this is correct the user should confirm this by selecting “Yes”. 

However, if the nodes are on opposite sides (one to the right and one to the left) the user should 

select “No”.  

 

 
Figure E-33: Checking nodes match up in the right order 

 

An initial calculation will then be performed in order to establish the staircase’s lane width, 

travel distance between treads and the free space nodal spacing. A dialogue box will then be 

displayed (see Figure E-34), which allows the user to alter these values before the Auto Stair 

Connect function starts. This should only be attempted if the user is not content with the values 

produced. Once the dimensions have been established the user can then click on the Enter 

button and the required arcs will be generated (see Figure E-35). However, if the user selects 

Cancel (see Figure E-34) then the Auto Connect stairs operation will be terminated. 
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Figure E-34: Arc length control dialogue 

box 

Figure E-35: The results after the auto 

stair connect operation has been applied. 

 

The Auto Stair Connect function assumes that the nodes to be connected to the staircase are 

aligned with the middle of the staircases. For instance, if four free-space nodes were originally 

selected and then the staircase, it would be aligned as shown in Figure E-35, with the central 

axes of the selected free-space and staircase nodes aligned.  

 

Where a user wishes to connect a staircase to the edge of a room, difficulties may arise as there 

may not be sufficient space for this assumption to be made and to accurately represent the 

connectivity of the staircase. This is a relatively rare situation but a method is required to 

compensate for the potential error that might arise. This problem is illustrated below in Figure 

E-36. In the left hand image the set of selected free-space nodes are such that they have their 

central axis to the right of the staircase. The model assumes that the axes should be aligned and 

therefore the calculations will be made on the assumption that the staircases are actually 

positioned as shown in the rand-hand figure. Although in most cases this may be fine, if the 

staircase abuts the external wall, this may not accurately reflect the configuration of the 

structure. 

 

 
Figure E-36: The automatic alignment of the central axes assumed with the automated 

stair connection. 

 

To compensate for this ‘correction’, the user can generate extra dummy nodes to ensure that 

the arc lengths used are correct (see Figure E-37 and Figure E-38). In Figure E-38 an extra node 

has been included. These dummy nodes should be included in the original set of nodes selected 
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(see Figure E-39). The stair and free-space nodes (including the dummy node) should then be 

connected using the Auto Connect Stair facility (see Figure E-40). Once the arcs have been 

generated the user will then need to delete the additional dummy node(s) (see Figure E-42). 

The final mesh then produced will then accurately reflect the desired configuration of the 

structure. 

 

 
Figure E-37: Staircase to be connected 

at edge of a room. 

 
Figure E-38: Adding dummy node to 

allow the auto stair connect function to 

calculate the correct arc lengths. 

 

 
Figure E-39: Selecting the nodes. 

 

 

 

 

 

 
Figure E-40: Confirming the staircase 

dimensions. 
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Figure E-41: The arc that are 

automatically generated. 

 
Figure E-42: The final mesh once the 

dummy node has been deleted. 

 

 
Figure E-43: How a staircase, near to the edge of a room, should probably 

connected. 

 

The use of the Auto Connect Stairs function is exactly the same whether the nodes to be 

connected are in the same or a different geometry window. However, if the nodes are in a 

different geometry window a Floor Link will also be auto generated. For example, in Figure 

E-44 a connection between a dog-legged staircase (right of Figure E-44) is to be connected to 

another floor and geometry window (left of Figure E-44). The user selects the two sets of nodes 

and as in the above section runs the Auto Connect Stairs function. The new arcs and Floor Links 

that are generated are shown in Figure E-45.  
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Figure E-44: Selecting nodes to be connected between two windows in exodus 

 

 
Figure E-45: The arcs and Floor Links generated by auto connect stairs 

 

The Floor Links, that are generated, are positioned automatically and the user may wish to move 

them to a more convenient location once generated. To do this the user should check that Floor 

Link selection is enabled, (see Chapter 3), and that Object Lock is disabled. The user can then 

simply select each Floor Link and move them to a better location. 
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E.4 Gate Unit Flow Rate For Door Flow Rate Type 

A Gate Flow Rate option on internal doors is now deprecated. This was a method by which the 

user can enter a flow rate specified in occupants per second rather than the standard unit flow 

rates which are in occupants per metre per a second (occ/m/s), (see Figure E-46). This is 

particularly useful if the component being traversed restricts the flow in a manner that is 

independent of its size. 

 

  
(a) (b) 

Figure E-46: (a) Internal Door Dialogue with a standard door type Unit Flow Rate. (b) 

Internal Door Dialogue with the new Gate Unit Flow Rate. Note that the units are now 

in occ/s and not occ/m/s as before. 

 

As mentioned previously, this type of restriction is particularly useful when the barrier to the 

individual’s movement is not necessarily dependent upon the exact width of the component but 

is instead more dependent upon the nature of the component (e.g. a ticket barrier). 
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APPENDIX F: SFE SCRIPT CONTROL FILES  
 

F.1 Introduction 

The Script Control File for EXODUS (SFE) allows the user to produce a command file (i.e. a 

script file) to control basic EXODUS functionality. This allows the expert user higher and easier 

control over the setting up of a model as well as the conditions present during the simulation. 

For instance, the user can run multiple simulations using different geometries, stop them at 

predetermined points and save the output data into a file, modify behaviours and scenario 

conditions - all without needing to interact with the graphical interface. For expert users, this 

could reduce the time spent interacting with the model. It is recommended that only expert users 

attempt this - the user should be familiar with the impact of applying certain commands prior 

to using the SFE approach. The graphical interface allows the user to become familiar with the 

impact that certain commands have on the simulation conditions.  

 

The SFE approach allows the user to quickly easily group and setup a number of different 

models utilising a number of different scenarios, by configuring the files used and the 

simulation switches employed. This is achieved by allowing the user to set the appropriate 

switches, or loading up existing option library files (e.g. ESO files). In addition, the SFE file 

also allows the user to halt the simulation and collect results at that point, and (if desirable) 

modify the conditions before recommencing the simulation. This is particularly useful in 

manipulating the environmental conditions or the procedures being employed (e.g. occupant 

itineraries) and investigating their impact on the results produced. 

 

F.2 Creating an SFE file 

The SFE file is a simple ASCII-based file that can be produced using any basic editor (e.g. 

Windows Notepad). It is formed from a series of simple commands, each of which is placed on 

a new line of the file. The commands either operate in isolation, or require a set of parameters 

or variables that control the impact and functionality of the command. 

 

The SFE file allows users to manually load, configure, run and end (if required) multiple runs 

under different scenario conditions. These instructions include the geometry that needs to be 

loaded, the population, Rulebase flags, the initial status of the geometry, output options etc. As 

such these commands configure the initial development of the simulation.  

 

These commands can be employed by explicitly stating the set of commands needed, or loading 

in existing standard buildingEXODUS files; for instance, files describing the output options 

(the default filename used is table.ini, although the user can save the output to any *.ini file). 

The relevant files are listed later in this document. 

 

It is good practice to include commands in the same order as they are addressed in the standard 

interface; i.e. geometry, population, scenario and simulation. This is not compulsory, and may 

not always be possible; however, by following this order the omission of key commands may 

be more apparent to the user.  

 

The most basic example of an SFE file is shown in Figure F-47. This shows the loading of an 

existing file (using the LoadGeom command) and then the running of this file using the 

RunSimulation command. It should be noted that the '#' symbol indicates a comment. 
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# Basic Example 

LoadGeom Example.exo 

RunSimulation 

Figure F-47: A basic SFE file. 

 

This text would be entered into a text editor (i.e. Notepad) and then saved as an SFE file for 

importing into the buildingEXODUS model.   

 

F.3 Using the SFE file 

The SFE files can be used to modify the structure, the population the environmental conditions, 

the simulation switches and the output produced in relation to the EXODUS model. As such 

SFE files can be used to configure each of the EXODUS modes.  

 

The SFE files can be employed in two ways. This depends on whether an EXO geometry has 

first been loaded into the model and the SFE file is used to run this geometry, or whether the 

SFE is responsible for loading everything including the geometry.  

 

If the SFE file is responsible for loading everything including the geometry (i.e. responsible for 

all four EXODUS modes), the SFE file can be loaded up from the File menu in Geometry Mode.  

This can be achieved by selecting Open from the File menu, then selecting the SFE extension 

from the File name drop down list (see Figure F-48). This approach will allow the user to 

manipulate all aspects of the simulation, including the geometry being employed. 

 

  
Figure F-48: Opening SFE file from File menu. 

 

Alternatively, the user may already have a base geometry (EXO file) that they use for a range 

of different scenarios, that they then load in the normal manner during Geometry Mode. The 

SFE file can then make use of this EXO file, rather than having to load in a new EXO file. This 

allows the user to work on the EXO file in the traditional manner (modifying it, etc.) before 

using the SFE file to configure and run the simulations (in a manner simulation to Batch Mode). 

Once the geometry is loaded, the user should then go to the Tools menu, select the Geometry 

option, and then the Import command (Tools>Geometry>Import).  
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Figure F-49: Opening SFE file from Tools menu. 

 

buildingEXODUS also allows the user to drag and drop SFE files into model directly from a 

folder (e.g. from Windows Explorer), as an alternative to using the toolbar menus. Therefore, 

the user can pick up the desired SFE file, drag it into the Geometry Window, and the model will 

then execute the commands. The model will automatically determine whether a geometry is 

pre-loaded or whether one is included in the SFE file. 

 

In addition to loading SFE commands in text files as outlined previously, buildingEXODUS 

also provides a command line interface to enable the user to directly type SFE commands, 

thereby controlling specific aspects of the scenario to be run. To display the command line 

interface the user can either a) select View from the menu bar, Interface from the menu and the 

Command Line option from the resulting submenu, or b) right click the mouse button while the 

cursor is over the tool bar. This can be achieved in any mode (i.e. geometry, population, scenario 

or simulation). This will display a pop-up menu from which users should then select the 

Command Line option (see Figure F-50(a)). Selecting this option will then in turn display the 

Command Input dialogue box (see Figure F-50(b)). This dialogue box enables individual SFE 

commands to be entered by the user in the correct format. Upon clicking the return key the SFE 

command on that line will be executed and hence the geometry, population, configuration, 

output etc. will be modified accordingly. This approach is useful when the user wants to 

perform complex manipulation of the geometry but does not wish to create an SFE file. 

Similarly, the use of the command line is useful when the user wants to test the effect of specific 

commands before incorporating them into an SFE file. 

 

 
 

(a) (b) 

Figure F-50: (a) Opening the command line dialogue box, (b) The Command Input 

dialogue box showing a demonstration command. 
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F.4 SFE Commands 

This section provides an overview of the SFE commands currently available. A listing of the 

use of these commands is provided, followed by several examples to demonstrate the manner 

in which they can be employed.  

 

The SFE commands are used in one of the following ways: standalone with no parameters and 

additional information provided to configure the command or with parameters where either a 

single or multiple parameters are provided to configure the functionality or impact of the 

command. Depending on the command used these parameters can be either compulsory or 

optional. The manner in which each command is used is identified using the notation shown in 

Table F-6. 

 

Table F-6 : Notation 
Command Parameters required to enact the command 
< ... > This follows the command and is used to denote variables and alternative 

values, where the provision of one alternative is compulsory.   
( ... ) This follows the command and identifies modifiers that are optional; i.e. the 

command will function without these modifiers, however the user may wish 

to specify the impact of the command through the provision of additional 

information. 
{ ... } This follows the command and indicates that part of the description between 

the braces may be repeated as many times as necessary; i.e. that the 

command may act on several different objects or require several pieces of 

information to function properly. 
.../... Used in conjunction with the < ... > command. This separates the range 

of viable options, one of which must be provided by the user.  

 

F.5 General Operational Commands 

These are general commands that enable the initial setting up of the model and the appearance 

of the model to be modified (see Table F-7). 

  



Appendix F – SFE Files 

 

© 2017 University of Greenwich 516 

 

Table F-7 : General Commands 
Command Summary 

# Comment statement. 

HideExodus Switches off the EXODUS user interface. 

ShowExodus Switches on the EXODUS user interface. 

IOLocation <folder> 

 

Sets the current folder/directory. 
IOLocation P:\ScriptTest\Results 

LoadGeom <File.exo/File.mta> Loads an EXODUS geometry exo or mta. 

LoadGeom SquareNoPop.exo 

Shutdown Shuts down EXODUS. 

ContinueSimulation (<Time>) Continues the simulation for the specified time in 

seconds. If the parameter time is not specified the 

simulation is run to completion.  

ContinueSimulation 120 

EndSimulation Terminates the current simulation. 

ResetSimulation Resets the current simulation. 

RunSimulation (<Time>) This represents the basic instruction to commence 

the simulation process. Run the simulation for the 

specified time (in seconds). If the parameter time 

is not specified the simulation is run to completion. 

This command needs to be employed each time the 

simulation is to be run.  

RunSimulation 300 

DumpResults Generates a simulation output file (*.sim) 

containing the results for the last run simulation.  

This can be used if either the user initially stated 

that the generation and saving of the results was 

not required, or alternatively if the simulation was 

being run from replay file (i.e. since replay files do 

not by default generate simulation output files). 

 

F.6 Geometry Commands 

Table F-8 describes the commands that enable the user to manipulate and configure the 

geometry prior to the commencement of the simulation. 
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Table F-8 : Geometry Commands 
Command Summary 

ExternalDoor 

<DoorID/Name><Setting> 

Sets the Status and Active attributes of an external 

door at the start of a simulation. As within the 

buildingEXODUS graphical interface, Setting can 

be OPEN, CLOSED, OFF, ACTIVE or 

INACTIVE. The order of doors can be established 

from Navigation Window in EXODUS. The first 

door in the geometry has ID 1.  

ExternalDoor Door_1 Off 

InternalDoor 

<DoorID/Name><Setting> 

Sets the Status and Active attributes of an internal 

door at the start of a simulation. The door can be 

identified by either its name or ID (ID 1 is first door 

in geometry). Setting can be open, closed, off, 

forward, reverse, active, inactive. 

InternalDoor IntDoor_1 On 

SetPotExtDoor 

<DoorID/Name><PotVal> 

Sets the potential value of an external door at the 

start of a simulation. The door order can be 

established from Navigation Window in EXODUS. 

The first door in the geometry has ID 1. 

Alternatively, the door name can be used to 

identify the door in question. 

SetPotExtDoor Door_1 105 

SetPotIntDoor 

<DoorID/Name><PotVal> 

Sets the potential value of an internal door at the 

start of a simulation. The door can be identified by 

either by the door name or the door ID. 

SetPotIntDoor InDoor_1 107 

ZoneDeleteArcs <ZoneName> Deletes the arcs within the selected zone. 

ZoneDeleteArcs Zone_1 

ZoneDeleteNodes <ZoneName> Deletes a set of nodes within a zone. 

ZoneDeleteNodes Zone_1 

 

F.7 Population and Itinerary Commands. 

Table F-9 describes the commands than enable the user to manipulate and configure the 

population prior to the commencement of the simulation. 
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Table F-9 : Population Commands 
Command Summary 

ClearGlobalItineraries Deletes all current global itineraries; i.e. those that 

would be applied to a population or sub-population 

rather than those associated to specific individuals. 

DeletePop (<FloorID/FloorName>) Delete people on selected floor. If no 

FloorID/FloorName is defined the entire 

population will be deleted from the geometry. 

DeletePop Floor_1 

LoadPop 

<File>(<FloorID><PopSize>) 

Loads a population definition file into first position 

within the Panel Populations list (i.e. becomes 

UserDefault population). If a FloorID and PopSize 

is specified (with Floor 0 representing the ground 

floor) it generates the specified number of people 

on that floor. Otherwise the population will be 

distributed throughout the geometry. File types can 

be either POP, EPB or EPF. Note: FloorID and 

PopSize should not be used with either a EPB or 

EPF file. 

LoadPop SquareAA16.epb 

LoadZonePop 

<File><ZoneID/ZoneName><PopSize> 

Loads a population definition file into first position 

within the Panel Populations list (i.e. becomes  

UserDefault population). Generates a population 

of a given size, using the specified population file, 

in the given zone. The file type should only be a 

POP file. 
LoadZonePop SquareAA20.pop Zone_1 100 

Population <Population_Name> Selects a population from the Panel Populations 

list. This population will then be used when using 

the ZonePop and CreatePerson commands (see 

below). 

Population Default_Crew 

ZonePop 

<ZoneID/ZoneName><PopSize> 

Generates a population of a given size in the 

specified zone, using the currently selected 

population. If no population has been selected (i.e. 

via the Population command, see above), the first 

population within the Panel Populations list (i.e. 

the UserDefault population) will be used. 

ZonePop Zone_1 50 

CreatePerson Generates a person from the currently selected 

population (see Population command). If no 

population is selected prior to the generation of an 

individual the person will be assumed to be a 

default person. Once a person has been created all 

subsequent commands related to the attributes of 

individuals will be assumed to relate to this person. 

See Table F-10 and Table F-11 for a list of 

available commands. It is important to note that 

once a person has been created they will still need 

to be located within the geometry. This can either 

be achieved via the ZoneRandLocate command 

(see below) or by manually assigning their start 

node (see NodeOccupied command). 
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ZoneRandLocate <ZoneID/ZoneName> Randomly locates the currently selected individual 

within the defined zone. The currently selected 

individual is defined either via the CreatePerson, 

AssignPerson or AssignPersonAt commands.  

ZoneRandLocate Zone_1 

ExportPop <file> File types can be either POP, EPB or EPF. This can 

be performed before, during or after the simulation 

has completed, depending on the other commands 

used. If the export file type is POP then the 

population exported corresponds to the currently 

selected population (see Population command). If 

no population has been selected prior to exporting 

the exported population corresponds to the  

UserDefault population (i.e. the first population 

within the Panel Populations list). 

ExportPop Pop1200.epb 

AssignResponseCurve 

<Distribution_Name><All/Zone> 

(<ZoneID/ZoneName>) 

Assigns a given response distribution to the entire 

population or selected individuals. The name of the 

distribution corresponds to the name of a 

distribution within the Distribution Curve list in 

Population mode (see Chapter 4). This distribution 

can then be assigned to everybody within  the 

geometry. Alternatively the distribution can be 

assigned to all individuals within a user defined 

zone. 

AssignResponseCurve 

Default_Day All 

 

The user is able to modify the attributes of individuals or sub-populations in specifically defined 

areas. Table F-10 describes the commands that enable the user to specify whose attributes are 

being manipulated, while Table F-11 describes the attributes that are accessible within the SFE 

file and Table F-12 the tasks that can be assigned. It should be noted that attributes can only be 

modified at the individual level; i.e. following the CreatePerson, AssignPerson and 

AssignPersonAt commands. 
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Table F-10 : Assigning the attributes of a population associated with a particular 

location or area. 
Command Summary 

AssignPerson <ID/Name> Identifies a person that will be affected by 

subsequent commands. The instructions following 

this command will assign attributes to a single 

person (see below). It is important that the user 

brackets the attributes as indicated; however, only 

the attributes that are to be modified need be stated 

in the command. See Tables I-5 and I-6 for a list of 

available commands. 

AssignPerson 1 

AssignPersonAt 

<X><Y><FloorID/Name> 

Identifies a person that will be affected by 

subsequent commands. The instructions following 

this command will assign attributes to a single 

person (see below). It is important that the user 

brackets the attributes as indicated; however, only 

the attributes that are to modified need be stated in 

the command. See Tables I-5 and I-6 for a list of 

available commands. 

AssignPersonAt 23 47 Floor_2 

AssignZone <ID/Name> Identifies a zone that will be affected by 

subsequent commands. The instructions following 

this command will assign attributes to people in the 

specified zone.  Available commands are shown in 

Table F-12. Note commands in Table F-11 cannot 

be used in conjunction with this command. 

AssignZone Zone1 

AssignPoly 

<FloorID/Name>{<X><Y>} 

Identifies a polygon that will be affected by 

subsequent commands. A minimum of three sets of 

co-ordinates are required to define the polygon. 

The instructions following this command will 

assign attributes to people in a polygon region. 

Available commands are shown in Table F-12. 

Note commands in Table F-11 cannot be used in 

conjunction with this command. 
AssignPoly Floor_2 10 5 20 7 30 21 50 7 

AssignRedirectionNode 

<NodeID/NodeName> 

Identifies a redirection node which is to be 

modified. The following commands will assign 

attributes to this redirection node. Available 

command are shown in Table F-12. Note 

commands in Table F-11 cannot be used in 

conjunction with this command. 

AssignRedirectionNode Red_12 

 

Table F-11 lists the individual attributes that can be modified. The attributes that the user wishes 

to modify are listed after the CreatePerson, AssignPerson and AssignPersonAt 

commands.  
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Table F-11 : Attributes that can be modified, along with the format required: </> 

options available; n integer; n.n real number to one decimal place, s string. 
Assign Physical Attributes 

Gender <Male/Female> 

Age n 

Weight n.n 

Height n.n 

Mobility n.n 

Agility n.n 

Response n.n  

Patience n 

Drive n.n 

Gene n  

Name s 

NodeOccupied n 

Assign Travel Speed Attributes 

CrawlRate  n.n 

FastWalkRate n.n 

WalkRate n.n  

LeapRate  n.n 

StUpRate  n.n 

StDownRate  n.n 

UpEscalatorRate  n.n 

DownEscalatorRate  n.n 

Assign Toxicity Attributes 

PID n.n 

WalkRMV n.n 

HCL_Conc n.n 

HBr_Conc n.n 

HF_Conc n.n 

SO2_Conc n.n 

NO2_Conc n.n 

CH2CHO_Conc n.n 

HCHO_Conc n.n 

Iother_Conc n.n 

RestRMV  n.n 

FastWalkRMV n.n 

HCL_dose  n.n 

HBr_dose  n.n 

HF_dose n.n 

SO2_dose n.n 

NO2_dose n.n 

CH2CHO_dose n.n 

HCHO_dose n.n 

Iother_dose n.n 

 

Table F-12 lists the tasks that can be assigned. The tasks that the user wishes to assign are listed 

after the CreatePerson, AssignPerson, AssignPersonAt, AssignZone, 

AssignPoly or AssignRedirectionNode commands.  

 

Table F-12 : Tasks that can be assigned and modified. 
Command Summary 

ActDelay <nodeID/Name> 

<delaymin> <delaymax> 

Specifies that a person(s) should target the given 

node (using either the ID or the node name) and 

once reached experience a random delay between 

the minimum and maximum values indicated (in 

seconds). 

ActDelay Node_453 10 120 

ActDelayZone <nodeID/Name> 

<delaymin> <delaymax> 

Specifies that person(s) should target the node 

identified. The model associates this node with an 

existing zone, in which the node is located. Once  

reached or when they have encountered congestion 

within the compartment zone within which the 

node located, they will experience a random delay 

between the minimum and maximum values 

indicated (in seconds) 

ActDelayZoneName <ZoneID/Name> 

<delaymin> <delaymax>  

Specifies that person(s) should target the node 

(centrally located in zone as calculated by the 

model) in the specified zone and once reached 

experience a random delay between the minimum 

and maximum values indicated (in seconds). 
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ActWait <nodeID/Name>  

<range> <time> 

Specifies that person(s) should target the given 

node and once within the range (in metres) given 

wait until the simulation time has reached the 

designated time (in seconds). 

ActWait Node_43 10 120 

ActWaitZone <nodeID/Name> 

<range> <time> 

Specifies that person(s) should target the node 

identified. The model associates this node with an 

existing zone, in which the node is located. Once 

within the specified range (in metres) of the node, 

or when they have encountered congestion within 

the compartment zone within which the node 

located, they will remain until the time specified 

(in seconds). 

ActWaitZoneName <ZoneID/Name> 

<range> <time> 

Specifies that person(s) should target the node 

(centrally located in zone as calculated by the 

model) in the specified zone and wait there until 

the simulation time has reached the designated 

time (in seconds). 

ActWaitZoneNode <ZoneID/Name> 

 <nodeID/Name> <range> <time> 

Specifies that person(s) should target the specified 

node within the specified zone and wait there until 

the simulation time has reached the designated 

time (in seconds). 

ActWayPoint 

<nodeID/Name><range> 

Sends a person to a particular location (indicated 

by either the node ID or node name). They are 

deemed to have reached that location when they 

fall within the range specified (in metres). 

ActWayPoint Node_32 5 

ActCollectPerson <nodeID/Name> 

<Gene_ID> <Size> 

Specifies that a person(s) should target the given 

node (using either the ID or the node name) in 

order to collect an individual located on it. Once at 

the node the person will wait until the required 

number of people specified within the Size 

attribute have arrived. This number comprises both 

the person on the nodal target and ALL people 

with associated ActCollectPerson tasks targeting 

the node. Once the required number of people have 

arrived at the node they are all then assigned the 

specified Gene_ID value. 

ActDropOffPerson <nodeID/Name> Once a person has collected an individual via the 

ActCollectPerson task (see above), the individual 

can then be dropped off at a given location by 

specifying the target node (using either the ID or 

the node name). 

ActCoordinatedDelay  

<nodeID/Name> <delaymin>  

<delaymax> <Size> 

Specifies that a person(s) should target the given 

node (using either the ID or the node name). Once 

at the node the person will wait until the required 

number of people specified within the Size 

attribute have arrived. This number comprises 

ALL people with associated ActCoordinatedDelay 

tasks targeting the node. Once the required number 

of people have arrived at the node they all then 

experience a random delay between the minimum 

and maximum values indicated (in seconds). 
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ActLiftBank <nodeID/Name> 

<WaitTime> 

<CongestionThreshold> 

Specifies that a person should target the given node 

(using either the ID or the node name) in order to 

board a lift. The node defined should only ever be 

a Lift Shaft Opening transit node. On reaching the 

catchment area for the transit node group of lifts of 

which the defined Lift Shaft Opening transit node 

is a member, the individual first checks to see if 

both a lift within the group is still servicing the 

given floor and that the congestion level within the 

catchment area is less than their defined 

CongestionThreshold value (occ/m2). If either 

condition is not met then the occupant will drop the 

Lift Bank task. If both conditions are met however 

the occupant will start waiting for a lift. This 

results in a Lift Wait task being automatically 

assigned to the occupant. 

ActRemoveFromSim Specifies that a person will be removed from the 

simulation. This is equivalent to the Remove task 

described in Chapter 4. 

ActDiscount Specifies that a person will no longer be recorded 

as being active in the simulation in the output 

associated with the rest of the population. This is 

equivalent to the Discount task described in 

Chapter 4. 

ActItinerary <Itinid/Itinname> The itinerary is appended to the person’s task. This 

itinerary would need to have been created in the 

loaded EXO file; it would not be able to be saved 

independently. This can then be referred to using 

the id/name, matches up with the name/id used in 

the Itinerary Window in Population Mode. 

ActItinerary Itin_Secure 

ClearItinerary Clears the itineraries of the population / location / 

person indicated. 

 

For instance, in the following example, the occupants of a pre-defined zone (Zone1) have their 

current itineraries removed, while Person 1 has their attributes modified and and a simple task 

inserted. 
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Table F-13 : Assignation Example. 
# Assignation Example 

. 

. 

. 

# Select zone in which people will be modified 

AssignZone Zone1 

# Clear itineraries of people in Zone 1 

ClearItinerary 

# Select individual that will be modified 

AssignPerson 1 

# Modify the response time and fast walk rate of Person 1 

Response 30 

FastWalkRate 1.0 

# Make those in Zone 1 head towards Door_2, and on reaching this 

door delay for between 0 and 10 seconds 

ActWayPoint Door_2 0 10 

. 

. 

. 

 

F.8 Hazard and Zone Commands. 

Table F-14 and Table F-15 describe the commands that enable the user to manipulate and 

configure the zones and hazards prior to the commencement of the simulation. 

 

Table F-14 : Hazard Commands 
Command Summary 

ClearAllHazards Removes all currently defined hazards 

AutoLinkHazards Auto links hazards to associated zones. (see 

comments below) 

LoadCFASTHaz <File.hi> Imports CFAST hazard file. 

LoadCFASTHaz armchair.hi 

LoadHazardFile <File.ehf> Imports an EXODUS hazard file. 

LoadHazardFile armchair.ehf 

LoadSmartFireHaz <File.dat> Imports Smartfire hazard data. 

LoadSmartFireHaz armchair.dat 

 

Table F-15 : Zone Commands 
Command Summary 

MakeZone <ZoneID/ZoneName> 

<floorID/Name>{<X><Y>} 

Generates a new Zone based on a polygon defined 

by a list of X,Y coordinates. 
MakeZone Zone_6 Floor_2 10 0 0 0 0 10  

ZoneRemove <ZoneID/ZoneName> Deletes a zone from the geometry 
ZoneRemove Zone_1 

ZoneDelete  

<ZoneID/ZoneName> 

Deletes a zone from the geometry and deletes all 

its associated nodes 
ZoneDelete Zone_1 

 

When the AutoLinkHazards command is used, the buildingEXODUS model automatically 

clears all the existing associations present and automatically generates a new scenario for each 

zone and hazard association. By default the zones and hazards are associated in the order that 

they were created. Hence, the first zone created (and hence the first zone in the zone list) will 

automatically be associated with the first hazard created (and hence the first hazard in the hazard 
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list) etc. If a different number of zones and hazards are present then the number of new scenarios 

automatically created will be equal to the larger of the two lists. In this instance, the list (i.e. 

zones or hazards) with the fewest number of elements will the therefore have undefined 

elements in some of the generated scenario components. If the user wishes to manually 

associate hazards and zones, they should do this within building EXODUS. 

 

F.9 Simulation Commands. 

The key simulation commands typically available in buildingEXODUS are primarily available 

through loading files into the model through the SFE file. These relate to ESO files (that 

configure the Rulebase options), and INI files (that configure the output options). 

 

Table F-16 : Simulation Commands 
Command Summary 

LoadESO <filename.eso> Load an EXODUS scenario specification (eso) 

file. This enables the Rulebase options saved in 

Simulation Mode to be imported, allowing access 

to the range of environmental, behavioural, and 

procedural switches. 

LoadESO HazardEnable.eso 

LoadOutputOptions 

<filename.ini> 

Allows the user to load a pre-defined INI file to 

describe the data output format. This will have 

been previously exported using the Save button in 

the Data Control Output dialogue box in 

Simulation Mode. 

LoadOutputOptions scen1.ini 

LoadTraceTable 

<filename.ini> 

Allows the user to load previously defined trace 

control settings, in the form of an INI file. This 

enables users to output the selected attributes for 

user-defined groups of individuals throughout the 

simulation.  

LoadTraceTable trac1.ini 

F.10 File Manipulation 

As mentioned, the SFE file is able to import/export existing buildingEXODUS files to enable 

a broader set of commands to be accessed. The files that can be loaded into buildingEXODUS 

are shown in Table F-17 

 

Table F-17 : File Types 
File Type Summary 

ESO Sets the RuleBase Options 

EPB /EPF / POP Imports a Population 

EXO / MTA Imports the Geometry 

EPB / RUX Loads a replay file 

INI Imports Data Output Options 

HI / DAT / EHF Imports hazard conditions 

SIM SIM files are the standard output file produced by buildingEXODUS. These 

are produced in the same manner using SFE files. 

 

F.11 SFE File Examples 

Several examples are provided to demonstrate how these commands are used. In Example 1 

(see Table F-18), an EXO is loaded that already has six zones defined. These are then 

automatically linked to those loaded in from the DAT file. Finally, an ESO file is loaded to 

configure the behavioural switches selected, and then the simulation is run for 300 seconds. 
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Table F-18 : Loading Example . 
# Load geometry 

LoadGeom JunkNohazards.exo 

# Load fire data 

LoadSmartfireHaz data_6_zone_part1to6seconds.dat 

# Link data with existing zones 

AutoLinkHazards 

# Load scenario file setting behavioural response 

LoadESO HazardEnable.eso 

# Run simulation for 300 seconds 

RunSimulation 300 

 

In Example 2 a geometry and population are loaded, the directory in which the model will be 

working is defined, the simulation runs for 20 seconds and then exports the population (see 

Table F-19). 

 

Table F-19 : Loading / Running Example. 
# Load geometry, population and run the simulation 

# for 20 seconds then export population  

# Load geometry 

LoadGeom SquareNoPop.exo 

# Load population 

LoadPop SquareAA16.epb 

# Identify directory for file access 

IOLocation P:\ScriptTest\Results 

# Run simulation for 20 seconds 

RunSimulation 20 

# Export population locations on completion of simulation 

ExportPop Pop1200.epb 

 

In Example 3 the script in Example 2 has been extended to include instructions to redirect 

people in Zone1 and Zone2 to exit Door_2 (see Table F-20). It is assumed that the zones referred 

to have already been created. 
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Table F-20 : Zone Example. 
# Load geometry, population and run the simulation  

# for 20 seconds then export population and wait for  

# instructions 

LoadGeom SquareNoPop.exo 

LoadPop SquareAA16.epb 

IOLocation P:\ScriptTest\Results 

RunSimulation 20 

ExportPop Pop1200.epb 

# Additional commands appended below 

# Redirect people in Zone1 and Zone2 to Door_2 

# Identify previously created zone 

AssignZone Zone1 

# Delete existing itineraries 

ClearItinerary 

# Assign itineraries to Zone 1 population 

ActWayPoint Door_2 0 0 

# Identify previously created zone 

AssignZone Zone2 

# Delete existing itineraries 

ClearItinerary 

# Assign itineraries to Zone 2 population 

ActWayPoint Door_2 0 0 

ContinueSimulation 

Shutdown 
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